The following information is for FCC compliance of Class A devices: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case users will be required to correct the interference at their own expense.

The following information is for FCC compliance of Class B devices: The equipment described in this manual generates and may radiate radio-frequency energy. If it is not installed in accordance with Cisco’s installation instructions, it may cause interference with radio and television reception. This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in part 15 of the FCC rules. These specifications are designed to provide reasonable protection against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation.

Modifying the equipment without Cisco’s written authorization may result in the equipment no longer complying with FCC requirements for Class A or Class B digital devices. In that event, your right to use the equipment may be limited by FCC regulations, and you may be required to correct any interference to radio or television communications at your own expense.

You can determine whether your equipment is causing interference by turning it off. If the interference stops, it was probably caused by the Cisco equipment or one of its peripheral devices. If the equipment causes interference to radio or television reception, try to correct the interference by using one or more of the following measures:

- Turn the television or radio antenna until the interference stops.
- Move the equipment to one side or the other of the television or radio.
- Move the equipment farther away from the television or radio.

- Plug the equipment into an outlet that is on a different circuit from the television or radio. (That is, make certain the equipment and the television or radio are on circuits controlled by different circuit breakers or fuses.)

Modifications to this product not authorized by Cisco Systems, Inc. could void the FCC approval and negate your authority to operate the product.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

CCVP, the Cisco logo, and the Cisco Square Bridge logo are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn is a service mark of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX, Catalyst, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity, Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, Follow Me Browsing, FormShare, Gigabit, HomeLink, Internet Quotient, IOS, iPhone, IP/TV, iQ, Expertise, the iQ logo, iQ Net Readiness Scorecard, iQuick Study, LightStream, Linksys, MeetingPlace, MGX, Networking Academy, Network Registrar, Packet, PIX, ProConnect, ScriptShare, SMARTnet, StackWise, The Fastest Way to Increase Your Internet Quotient, and TransPath are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (0705R)
Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0

August 2005

CONTENTS

About this Guide lxv
Revision History lxv
Document Objectives lxvi
Audience lxvi
Document Organization lxvi
Related Documentation lxvii
Document Conventions lxviii
Where to Find Safety and Warning Information lxxiv
Obtaining Documentation lxxiv
Cisco.com lxxiv
Product Documentation DVD lxxiv
Cisco Optical Networking Product Documentation CD-ROM lxxv
Ordering Documentation lxxv
Documentation Feedback lxxv
Cisco Product Security Overview lxxv
Reporting Security Problems in Cisco Products lxxvi
Obtaining Technical Assistance lxxvi
Cisco Technical Support & Documentation Website lxxvii
Submitting a Service Request lxxvii
Definitions of Service Request Severity lxxvii
Obtaining Additional Publications and Information lxxviii

CHAPTER 1 Install the Shelf and Common Control Cards 1-1
Before You Begin 1-1
Required Tools and Equipment (ANSI) 1-3
Cisco-Supplied Materials (ANSI) 1-3
User-Supplied Materials (ANSI) 1-3
Tools Needed (ANSI) 1-4
Test Equipment (ANSI) 1-4
Required Tools and Equipment (ETSI) 1-4
Cisco-Supplied Equipment (ETSI) 1-4
User-Supplied Equipment (ETSI) 1-5
Tools Needed (ETSI) 1-5
Test Equipment (ETSI) 1-6
NTP- G1 Unpack and Inspect the Shelf Assembly 1-6
DLP- G1 Unpack and Verify the Shelf Assembly 1-6
DLP- G2 Inspect the Shelf Assembly 1-7
NTP- G2 Install the Shelf Assembly 1-8
DLP- G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only) 1-10
DLP- G4 Install the External Brackets and Air Filter (ANSI Only) 1-11
DLP- G5 Mount the Shelf Assembly in a Rack (One Person) 1-13
DLP- G6 Mount the Shelf Assembly in a Rack (Two People) 1-15
DLP- G7 Mount Multiple Shelf Assemblies in a Rack 1-16
DLP- G8 Install the Air Ramp 1-19
NTP- G3 Open and Remove the Front Door 1-20
DLP- G9 Open the Front Cabinet Compartment (Door) 1-20
DLP- G10 Remove the Front Door 1-21
NTP- G4 Open and Remove the FMEC Cover (ETSI Only) 1-23
DLP- G11 Open the FMEC Cover 1-24
DLP- G12 Remove the FMEC Cover 1-25
NTP- G5 Remove the Backplane Covers (ANSI Only) 1-26
DLP- G13 Remove the Lower Backplane Cover 1-26
DLP- G14 Remove the Backplane Sheet Metal Cover 1-27
NTP- G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only) 1-28
NTP- G7 Install the Power and Ground 1-30
DLP- G15 Connect the Office Ground to the ONS 15454 ETSI 1-32
DLP- G16 Connect the Office Ground to the ONS 15454 ANSI 1-34
DLP- G17 Connect Office Power to the ONS 15454 ETSI 1-35
DLP- G18 Connect Office Power to the ONS 15454 ANSI 1-37
DLP- G19 Turn On and Verify Office Power 1-39
NTP- G8 Install the Fan-Tray Assembly 1-40
NTP- G9 Install the Alarm Expansion Panel (ANSI Only) 1-44
NTP- G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections 1-47
DLP- G20 Install Alarm Wires on the MIC-A/P (ETSI Only) 1-48
DLP- G21 Install Timing Wires on the MIC-C/T/P (ETSI Only) 1-51
DLP- G22 Install LAN Wires on the MIC-C/T/P (ETSI Only) 1-52
DLP- G23 Install Alarm Wires on the Backplane (ANSI Only) 1-53
DLP- G24 Install Timing Wires on the Backplane (ANSI Only) 1-55
DLP- G25 Install LAN Wires on the Backplane (ANSI Only) 1-56
DLP- G26 Install the TL1 Craft Interface (ANSI Only) 1-57
NTP- G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only) 1-58
Connect the PC and Log into the GUI  2-1

Before You Begin  2-1

NTP- G17 Set Up Computer for CTC  2-2
  DLP- G37 Run the CTC Installation Wizard for Windows  2-3
  DLP- G38 Run the CTC Installation Wizard for UNIX  2-6

NTP- G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454  2-9
  DLP- G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses  2-11
  DLP- G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol  2-13
  DLP- G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection  2-16
  DLP- G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454  2-19

NTP- G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454  2-21
  DLP- G43 Disable Proxy Service Using Internet Explorer (Windows)  2-22
  DLP- G44 Disable Proxy Service Using Netscape (Windows and UNIX)  2-22

NTP- G20 Set Up a Remote Access Connection to the ONS 15454  2-23

NTP- G21 Log into the ONS 15454 GUI  2-24
  DLP- G46 Log into CTC  2-25
  DLP- G47 Install Public-Key Security Certificate  2-28
  DLP- G48 Create Login Node Groups  2-28
  DLP- G49 Add a Node to the Current Session or Login Group  2-30
  DLP- G50 Delete a Node from the Current Session or Login Group  2-30
DLP- G51 Delete a Node from a Specified Login Node Group  2-31
DLP- G52 Change the JRE Version  2-31
DLP- G53 Configure the CTC Alerts Dialog Box for Automatic Popup  2-32

CHAPTER 3

Turn Up a Node  3-1

Before You Begin  3-1

NTP- G139 Verify Cisco MetroPlanner Reports and Files  3-3
NTP- G22 Verify Common Card Installation  3-4
NTP- G23 Create Users and Assign Security  3-5
  DLP- G54 Create a New User on a Single Node  3-6
  DLP- G55 Create a New User on Multiple Nodes  3-7
NTP- G24 Set Up Name, Date, Time, and Contact Information  3-8
NTP- G25 Set Power Monitor Thresholds  3-10

NTP- G26 Set Up CTC Network Access  3-11
  DLP- G56 Provision IP Settings  3-12
  DLP- G57 Set the IP Address, Default Router, and Network Mask Using the LCD  3-15
  DLP- G264 Enable Node Security Mode  3-17
  DLP- G58 Create a Static Route  3-18
  DLP- G59 Set Up or Change Open Shortest Path First Protocol  3-19
  DLP- G60 Set Up or Change Routing Information Protocol  3-22
NTP- G27 Set Up the ONS 15454 for Firewall Access  3-23
  DLP- G61 Provision the IIOP Listener Port on the ONS 15454  3-24
  DLP- G62 Provision the IIOP Listener Port on the CTC Computer  3-25

NTP- G132 Provision OSI  3-25
  DLP- G283 Provision OSI Routing Mode  3-27
  DLP- G284 Provision the TARP Operating Parameters  3-28
  DLP- G285 Add a Static TID to NSAP Entry to the TARP Data Cache  3-30
  DLP- G287 Add a TARP Manual Adjacency Table Entry  3-31
  DLP- G288 Provision OSI Routers  3-31
  DLP- G289 Provision Additional Manual Area Addresses  3-32
  DLP- G290 Enable the OSI Subnet on the LAN Interface  3-33
  DLP- G291 Create an IP-Over-CLNS Tunnel  3-34

NTP- G28 Set Up SNMP  3-35
NTP- G29 Preprovision a Slot  3-37
NTP- G30 Install the DWDM Cards  3-39
NTP- G31 Install the DWDM Dispersion Compensating Units  3-41
NTP- G32 Install the Transponder and Muxponder Cards  3-43
  DLP- G63 Install an SFP or XFP  3-45
Perform Node Acceptance Tests  4-1

Before You Begin  4-1

NTP- G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test  4-2
DLP- G268 Provision TXP_MR_2.5G Cards for Acceptance Testing  4-4

NTP- G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test  4-5

NTP- G43 Perform the ROADM Node Acceptance Test  4-8
DLP- G310 Verify ROADM Node Pass-Through Channels  4-12
DLP- G311 Verify the East ROADM Add/Drop Channels  4-16
DLP- G312 Verify the West ROADM Add/Drop Channels  4-18

NTP- G44 Perform the Anti-ASE Hub Node Acceptance Test  4-20

NTP- G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test  4-23
CHAPTER 5

Provision Transponder and Muxponder Cards 5-1

Before You Begin 5-1

NTP- G128 Manage Pluggable Port Modules 5-2

DLP- G277 Provision a Multirate PPM 5-3

DLP- G274 Verify Topologies for ETR_CLO and ISC Services 5-4

DLP- G278 Provision the Optical Line Rate 5-6

DLP- G279 Change the Optical Line Rate 5-8

DLP- G280 Delete a PPM 5-8

NTP- G33 Create a Y-Cable Protection Group 5-10

NTP- G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards 5-12
DLP- G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards 5-13
DLP- G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards 5-14
DLP- G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards 5-17
DLP- G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads 5-19
DLP- G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy 5-21
DLP- G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds 5-24
DLP- G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA Thresholds 5-25
DLP- G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards 5-27
NTP- G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-31
DLP- G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-32
DLP- G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-34
DLP- G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-36
DLP- G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-38
DLP- G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-39
DLP- G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds 5-41
DLP- G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA Thresholds 5-43
DLP- G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-44
NTP- G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-48
DLP- G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-49
DLP- G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-50
DLP- G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-53
DLP- G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH Payloads 5-54
DLP- G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads 5-56
DLP- G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-57
DLP- G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA Thresholds 5-58
DLP- G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-62
NTP- G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-65
DLP- G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-66
DLP- G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-67
DLP- G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-69
DLP- G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-71
DLP- G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-73
DLP- G240 Change MXP_MR_2.5G and MXPP_MR_2.5G Card Line Threshold Settings for SONET or SDH Payloads 5-74
DLP- G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads 5-77
DLP- G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-79
DLP- G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds 5-80

**Turn Up Network** 6-1
Before You Begin 6-1
NTP- G51 Verify DWDM Node Turn-Up 6-2
NTP- G52 Verify Node-to-Node Connections 6-3
NTP- G53 Set Up Timing 6-4
  DLP- G95 Set Up External or Line Timing 6-4
  DLP- G96 Set Up Internal Timing 6-7
NTP- G54 Provision and Verify a DWDM Network 6-8
  DLP- G99 Create a Provisionable Patchcord 6-11
NTP- G56 Verify the OSNR 6-12
NTP- G142 Perform a Protection Switch Test 6-13
NTP- G57 Create a Logical Network Map 6-15

**Create Channels and Circuits** 7-1
Before You Begin 7-1
NTP- G58 Locate and View Optical Channel Network Connections 7-2
  DLP- G100 Search for Optical Channel Network Connections 7-2
  DLP- G101 View Optical Channel Network Connection Information 7-3
  DLP- G102 Filter the Display of Optical Channel Network Connections 7-7
  DLP- G103 View Optical Channel Network Connections on a Span 7-8
NTP- G59 Create and Delete Optical Channel Network Connections 7-9
  DLP- G104 Assign a Name to a Port 7-10
  DLP- G105 Provision DWDM Optical Channel Network Connections 7-10
  DLP- G106 Delete Optical Channel Network Connections 7-12
NTP- G60 Create Overhead Circuits 7-13
  DLP- G76 Provision GCC Terminations 7-14
CHAPTER 8

Manage Alarms 8-1

Before You Begin 8-1

NTP- G63 Document Existing Provisioning 8-2
  DLP- G113 Print CTC Data 8-2
  DLP- G114 Export CTC Data 8-4

NTP- G64 View Alarms, History, Events, and Conditions 8-6
  DLP- G115 View Alarms 8-6
  DLP- G116 View Alarm or Event History 8-8
  DLP- G117 Change the Maximum Number of Session Entries for Alarm History 8-9
  DLP- G118 Display Alarms and Conditions Using Time Zone 8-11
  DLP- G119 Synchronize Alarms 8-11
  DLP- G120 View Conditions 8-12

NTP- G65 Delete Cleared Alarms from Display 8-13

NTP- G66 View Alarm-Affected Circuits 8-14

NTP- G67 View Alarm Counts on the LCD for a Node, Slot, or Port 8-15

NTP- G68 Create, Download, and Assign Alarm Severity Profiles 8-16
  DLP- G121 Create a New or Cloned Alarm Severity Profile 8-17
  DLP- G122 Download an Alarm Severity Profile 8-20
  DLP- G123 Apply Alarm Profiles to Ports 8-21
  DLP- G124 Apply Alarm Profiles to Cards and Nodes 8-23
  DLP- G125 Delete Alarm Severity Profiles 8-23

NTP- G69 Enable, Modify, or Disable Alarm Severity Filtering 8-25
  DLP- G126 Enable Alarm Filtering 8-25
  DLP- G127 Modify Alarm, Condition, and History Filtering Parameters 8-26
  DLP- G128 Disable Alarm Filtering 8-28

NTP- G70 Suppress Alarms or Discontinue Alarm Suppression 8-29
  DLP- G129 Suppress Alarm Reporting 8-29
## Monitor Performance 9-1

### Before You Begin 9-1

<table>
<thead>
<tr>
<th>NTP-</th>
<th>G73 Change the PM Display 9-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLP-</td>
<td>G131 Refresh PM Counts at 15-Minute Intervals 9-2</td>
</tr>
<tr>
<td>DLP-</td>
<td>G132 Refresh PM Counts at One-Day Intervals 9-3</td>
</tr>
<tr>
<td>DLP-</td>
<td>G133 View Near-End PM Counts 9-4</td>
</tr>
<tr>
<td>DLP-</td>
<td>G134 View Far-End PM Counts 9-5</td>
</tr>
<tr>
<td>DLP-</td>
<td>G135 Reset Current PM Counts 9-6</td>
</tr>
<tr>
<td>DLP-</td>
<td>G136 Clear Selected PM Counts 9-7</td>
</tr>
<tr>
<td>DLP-</td>
<td>G137 Set Auto-Refresh Interval for Displayed PM Counts 9-8</td>
</tr>
<tr>
<td>DLP-</td>
<td>G138 Refresh PM Counts for a Different Port 9-9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NTP-</th>
<th>G74 Monitor DWDM Card Performance 9-9</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLP-</td>
<td>G139 View Optical Service Channel PM Parameters 9-10</td>
</tr>
<tr>
<td>DLP-</td>
<td>G140 View Optical Amplifier Power Statistics 9-12</td>
</tr>
<tr>
<td>DLP-</td>
<td>G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards 9-13</td>
</tr>
<tr>
<td>DLP-</td>
<td>G276 View 4-Channel Multiplexer/Demultiplexer Optical Power Statistics 9-15</td>
</tr>
<tr>
<td>DLP-</td>
<td>G142 View Channel Optical Add/Drop Multiplexer Power Statistics 9-16</td>
</tr>
<tr>
<td>DLP-</td>
<td>G143 View Band Optical Add/Drop Multiplexer Power Statistics 9-18</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NTP-</th>
<th>G75 Monitor Transponder and Muxponder Performance 9-19</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLP-</td>
<td>G144 Enable or Disable OTN ITU-T G.709 Performance Monitoring 9-20</td>
</tr>
<tr>
<td>DLP-</td>
<td>G145 Enable or Disable OTN FEC Performance Monitoring 9-21</td>
</tr>
<tr>
<td>DLP-</td>
<td>G146 View Optics PM Parameters 9-22</td>
</tr>
<tr>
<td>DLP-</td>
<td>G147 View Payload PM Parameters 9-23</td>
</tr>
<tr>
<td>DLP-</td>
<td>G148 View OTN PM Parameters 9-25</td>
</tr>
<tr>
<td>DLP-</td>
<td>G149 View Payload Statistics PM Parameters 9-27</td>
</tr>
<tr>
<td>DLP-</td>
<td>G150 View Payload Utilization PM Parameters 9-28</td>
</tr>
<tr>
<td>DLP-</td>
<td>G151 View Payload History PM Parameters 9-30</td>
</tr>
<tr>
<td>DLP-</td>
<td>G152 View Payload SONET PM Parameters 9-31</td>
</tr>
</tbody>
</table>

## Manage the Node 10-1

### Before You Begin 10-1

<table>
<thead>
<tr>
<th>NTP-</th>
<th>G76 Verify Optical Span Loss Using CTC 10-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP-</td>
<td>G77 Manage Automatic Power Control 10-3</td>
</tr>
<tr>
<td>DLP-</td>
<td>G157 Disable Automatic Power Control 10-4</td>
</tr>
</tbody>
</table>
Contents

Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0

August 2005

DLP- G158 Enable Automatic Power Control 10-4
DLP- G159 Refresh Automatic Power Control Information 10-5

NTP- G78 View ROADM Node Power Equalization 10-5
NTP- G80 Change Node Management Information 10-6
DLP- G160 Change the Node Name, Date, Time, and Contact Information 10-7
DLP- G161 Change the Login Legal Disclaimer 10-8

NTP- G134 Modify OSI Provisioning 10-9
DLP- G284 Modify the TARP Operating Parameters 10-10
DLP- G285 Add a Static TID to NSAP Entry to the TARP Data Cache 10-12
DLP- G286 Remove a Static TID to NSAP Entry from the TARP Data Cache 10-12
DLP- G287 Add a TARP Manual Adjacency Table Entry 10-13
DLP- G292 Remove a TARP Manual Adjacency Table Entry 10-13
DLP- G293 Change the OSI Routing Mode 10-14
DLP- G294 Edit the OSI Router Configuration 10-15
DLP- G295 Edit the OSI Subnetwork Point of Attachment 10-16
DLP- G296 Edit an IP-Over-CLNS Tunnel 10-17
DLP- G297 Delete an IP-Over-CLNS Tunnel 10-18

NTP- G81 Change CTC Network Access 10-18
DLP- G162 Change IP Settings 10-19
DLP- G265 Lock Node Security 10-20
DLP- G266 Modify Backplane Port IP Settings 10-21
DLP- G267 Disable Node Security Mode 10-22
DLP- G163 Modify a Static Route 10-23
DLP- G164 Delete a Static Route 10-24
DLP- G165 Disable OSPF 10-24
DLP- G166 Delete a Proxy Tunnel 10-25
DLP- G167 Delete a Firewall Tunnel 10-25

NTP- G82 Customize the CTC Network View 10-26
DLP- G168 Change the Network View Background Color 10-26
DLP- G169 Change the Default Network View Background Map 10-27
DLP- G170 Apply a Custom Network View Background Map 10-28
DLP- G171 Create Domain Icons 10-28
DLP- G172 Manage Domain Icons 10-29
DLP- G173 Enable Dialog Box Do-Not-Display Option 10-30
DLP- G174 Switch Between TDM and DWDM Network Views 10-31

NTP- G83 Modify or Delete Card Protection Settings 10-31
DLP- G175 Modify a Y-Cable Protection Group 10-32
DLP- G176 Modify a Splitter Protection Group 10-33
DLP- G177 Delete a Y-Cable Protection Group 10-33
Contents

NTP- G84 Initiate and Clear Y-Cable and Splitter External Switching Commands 10-34
DLP- G178 Apply a Manual Y-Cable or Splitter Protection Switch 10-35
DLP- G179 Apply a Force Y-Cable or Splitter Protection Switch 10-35
DLP- G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch 10-36
DLP- G181 Apply a Lock-On 10-37
DLP- G182 Apply a Lockout 10-37
DLP- G183 Clear a Lock-On or Lockout 10-38
NTP- G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords 10-39
DLP- G184 Change a GCC Termination 10-40
DLP- G185 Delete a GCC Termination 10-40
DLP- G186 Delete an OSC Termination 10-41
DLP- G187 Delete a Provisionable Patchcord 10-42
NTP- G86 Convert a Pass-Through Connection to an Add/Drop Connection 10-42
NTP- G87 Change Node Timing Parameters 10-44
NTP- G88 Modify Users and Change Security 10-45
DLP- G188 Change Security Policy for a Single Node 10-46
DLP- G189 Change Security Policy for Multiple Nodes 10-47
DLP- G317 Change Node Access and PM Clearing Privilege 10-49
DLP- G191 Change User Password and Security Level on a Single Node 10-50
DLP- G192 Change User Password and Security Level for Multiple Nodes 10-51
DLP- G193 Delete a User From a Single Node 10-52
DLP- G194 Delete a User From Multiple Nodes 10-52
DLP- G195 Log Out a User on a Single Node 10-53
DLP- G196 Log Out a User on Multiple Nodes 10-54
DLP- G281 Configure the Node for RADIUS Authentication 10-55
DLP- G282 View and Terminate Active Logins 10-57
NTP- G131 Convert DWDM Nodes to Hybrid Nodes 10-58
NTP- G89 Change SNMP Settings 10-61
DLP- G197 Modify SNMP Trap Destinations 10-61
DLP- G198 Delete SNMP Trap Destinations 10-62

Chapter 11 Change DWDM Card Settings 11-1
Before You Begin 11-1
NTP- G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds 11-2
DLP- G199 Change the OSCM and OSC-CSM Optical Service Channel Settings 11-2
DLP- G200 Change the OSCM and OSC-CSM Optical Service Channel Thresholds 11-5
DLP- G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards 11-6
DLP- G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings 11-8
DLP- G203 Change the OSCM and OSC-CSM ALS Maintenance Settings 11-10
Contents

NTP- G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds 11-12
DLP- G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers 11-12
DLP- G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers 11-14
DLP- G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers 11-16
DLP- G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers 11-18
DLP- G322 Change the OPT-BST ALS Maintenance Settings 11-22
NTP- G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds 11-23
DLP- G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards 11-24
DLP- G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards 11-26
DLP- G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards 11-27
DLP- G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards 11-30
NTP- G93 Modify the 32WSS Thresholds and Settings 11-33
DLP- G212 Change Optical Channel Parameters for the 32WSS Card 11-33
DLP- G213 Change the 32WSS Optical Channel Thresholds 11-36
DLP- G214 Change Optical Line Parameters for the 32WSS Card 11-39
DLP- G215 Change the 32WSS Card Optical Line Thresholds 11-40
NTP- G101 Modify Alarm Interface Controller—International Settings 11-42
DLP- G245 Change External Alarms Using the AIC-I Card 11-42
DLP- G246 Change External Controls Using the AIC-I Card 11-43
DLP- G247 Change AIC-I Card Orderwire Settings 11-44
NTP- G102 Change Card Service State 11-45

CHAPTER 12
Add and Remove Cards and Nodes 12-1

Before You Begin 12-1
NTP- G107 Remove and Replace DWDM Cards 12-1
DLP- G254 Place OPT-BST and OPT-PRE Ports Out of Service 12-3
DLP- G318 Place OPT-BST and OPT-PRE Ports In Service 12-4
NTP- G127 Add an AD-xC-xx.x Card to an OADM Node 12-5
NTP- G129 Add a DWDM Node 12-7
NTP- G130 Remove a DWDM Node 12-9

CHAPTER 13
Maintain the Node 13-1

Before You Begin 13-1
NTP- G103 Back Up the Database 13-2
NTP- G104 Restore the Database 13-3
NTP- G105 Restore the Node to Factory Configuration 13-4
DLP- G248 Use the Reinitialization Tool to Clear the Database and Upload Software (Windows)  13-5
DLP- G249 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX)  13-7
NTP- G133 View and Manage OSI Information  13-9
DLP- G298 View IS-IS Routing Information Base  13-9
DLP- G299 View ES-IS Routing Information Base  13-10
DLP- G300 Manage the TARP Data Cache  13-11
NTP- G106 Reset Cards Using CTC  13-12
DLP- G250 Reset the TCC2/TCC2P Card  13-12
DLP- G251 Reset DWDM Cards Using CTC  13-13
NTP- G108 Viewing the Audit Trail Records  13-14
NTP- G109 Off-Load the Audit Trail Record  13-16
NTP- G110 Off-Load the Diagnostics File  13-17
NTP- G112 Change the Node Timing Reference  13-17
DLP- G259 Manual or Force Switch the Node Timing Reference  13-18
DLP- G260 Clear a Manual or Force Switch on a Node Timing Reference  13-19
NTP- G113 View the ONS 15454 Timing Report  13-19
NTP- G114 Inspect, Clean, and Replace the Air Filter  13-22
NTP- G115 Clean Fiber Connectors  13-25
DLP- G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes  13-26
DLP- G262 Clean Fiber Connectors with CLETOP  13-27
DLP- G263 Clean the Fiber Adapters  13-27
NTP- G40 Replace the Front Door  13-28
NTP- G116 Replace the Fan-Tray Assembly  13-31
NTP- G117 Replace the ANSI Shelf Alarm Interface Panel  13-36
NTP- G118 Replace the ANSI Shelf Plastic Lower Backplane Cover  13-40
NTP- G135 Edit Network Element Defaults  13-42
NTP- G136 Import Network Element Defaults  13-43
NTP- G137 Export Network Element Defaults  13-44

CHAPTER 14

Power Down a Node  14-1
NTP- G119 Power Down the Node  14-1

CHAPTER 15

Shelf Hardware Reference  15-1
15.1 Overview  15-2
15.1.1 Cisco ONS 15454 ANSI  15-2
15.1.2 Cisco ONS 15454 ETSI  15-2
15.2 ONS 15454 ANSI Rack Installation 15-3
   15.2.1 Reversible Mounting Bracket 15-4
   15.2.2 Mounting a Single Node 15-5
   15.2.3 Mounting Multiple Nodes 15-5
   15.2.4 ONS 15454 ANSI Bay Assembly 15-6
15.3 ONS 15454 ETSI Rack Installation 15-6
   15.3.1 Mounting a Single Node 15-7
   15.3.2 Mounting Multiple Nodes 15-8
15.4 FlexLayer and Y-Cable Protection 15-9
   15.4.1 FlexLayer Modules 15-10
   15.4.2 Y-Cable Protection Module 15-13
15.5 Typical DWDM Rack Layouts 15-17
15.6 Front Door 15-19
15.7 ONS 15454 ANSI Backplane Covers 15-26
   15.7.1 Lower Backplane Cover 15-27
   15.7.2 Rear Cover 15-28
   15.7.3 Alarm Interface Panel 15-29
   15.7.4 Alarm Interface Panel Replacement 15-29
15.8 ONS 15454 ETSI Front Mount Electrical Connection 15-30
15.9 ONS 15454 ANSI Alarm Expansion Panel 15-30
15.10 Filler Card 15-35
15.11 Cable Routing and Management 15-36
   15.11.1 Fiber Management 15-37
   15.11.2 Fiber Management Using the Patch-Panel Tray 15-39
   15.11.3 Fiber Management Using the Fiber-Storage Tray 15-39
   15.11.4 Fiber Management Using the Optional ANSI Tie-Down Bar 15-40
15.12 Fan-Tray Assembly 15-41
   15.12.1 Fan Speed and Power Requirements 15-42
   15.12.2 Fan Failure 15-43
   15.12.3 Air Filter 15-43
15.13 Power and Ground Description 15-43
   15.13.1 ONS 15454 ANSI Power and Ground 15-43
   15.13.2 ONS 15454 ETSI Power and Ground 15-44
15.14 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections 15-44
   15.14.1 Alarm Contact Connections 15-45
   15.14.2 Timing Connections 15-46
   15.14.3 LAN Connections 15-47
   15.14.4 TL1 Craft Interface Installation 15-47
15.15 Cards and Slots 15-48
  15.15.1 Card Slot Requirements 15-49
  15.15.2 Card Replacement 15-50
15.16 Ferrites (ANSI Only) 15-50

CHAPTER 16

Card Reference 16-1

16.1 Card Overview 16-2
  16.1.1 Common Control Cards 16-2
  16.1.2 Front Mount Electrical Connections (ETSI only) 16-2
  16.1.3 DWDM Cards 16-2
  16.1.4 Transponder and Muxponder Cards 16-3
  16.1.5 Card Summary 16-3
  16.1.6 Card Compatibility 16-5
  16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes 16-6
  16.1.8 DWDM Card Channel Allocation Plan 16-8
16.2 Common Control Cards 16-9
  16.2.1 TCC2 Card 16-10
    16.2.1.1 TCC2 Functionality 16-11
    16.2.1.2 Redundant TCC2 Card Installation 16-12
    16.2.1.3 TCC2 Card-Level Indicators 16-12
    16.2.1.4 Network-Level Indicators 16-12
  16.2.2 TCC2P Card 16-13
    16.2.3 TCC2P Functionality 16-15
      16.2.3.1 Redundant TCC2P Card Installation 16-15
      16.2.3.2 TCC2P Card-Level Indicators 16-16
      16.2.3.3 Network-Level Indicators 16-16
  16.2.4 AIC-I Card 16-16
    16.2.4.1 AIC-I Card-Level Indicators 16-17
    16.2.4.2 External Alarms and Controls 16-18
    16.2.4.3 Orderwire 16-19
    16.2.4.4 Power Monitoring 16-20
    16.2.4.5 User Data Channel 16-20
    16.2.4.6 Data Communications Channel 16-21
16.3 Front Mount Electrical Connections 16-21
  16.3.1 MIC-A/P FMEC 16-21
  16.3.2 MIC-C/T/P FMEC 16-24
16.4 Optical Service Channel Cards 16-25
  16.4.1 OSCM Card 16-26
    16.4.1.1 Power Monitoring 16-28
16.4.1.2 OSCM Card-Level Indicators 16-29
16.4.1.3 OSCM Port-Level Indicators 16-29
16.4.2 OSC-CSM Card 16-29
  16.4.2.1 Power Monitoring 16-33
  16.4.2.2 OSC-CSM Card-Level Indicators 16-34
  16.4.2.3 OSC-CSM Port-Level Indicators 16-34
16.5 Optical Amplifier Cards 16-34
  16.5.1 OPT-PRE Amplifier 16-35
    16.5.1.1 Power Monitoring 16-37
    16.5.1.2 OPT-PRE Amplifier Card-Level Indicators 16-38
    16.5.1.3 OPT-PRE Port-Level Indicators 16-38
  16.5.2 OPT-BST Amplifier Card 16-38
    16.5.2.1 Power Monitoring 16-40
    16.5.2.2 OPT-BST Amplifier Card-Level Indicators 16-41
    16.5.2.3 OPT-BST Port-Level Indicators 16-41
  16.5.3 OPT-BST-E Amplifier Card 16-41
    16.5.3.1 Power Monitoring 16-44
    16.5.3.2 OPT-BST-E Amplifier Card-Level Indicators 16-45
    16.5.3.3 OPT-BST-E Port-Level Indicators 16-45
16.6 Multiplexer and Demultiplexer Cards 16-45
  16.6.1 32MUX-O Card 16-45
    16.6.1.1 Channel Plan 16-47
    16.6.1.2 Power Monitoring 16-49
    16.6.1.3 32MUX-O Card-Level Indicators 16-49
    16.6.1.4 32MUX-O Port-Level Indicators 16-49
  16.6.2 32DMX-O Card 16-49
    16.6.2.1 Power Monitoring 16-51
    16.6.2.2 32DMX-O Card-Level Indicators 16-52
    16.6.2.3 32DMX-O Port-Level Indicators 16-52
  16.6.3 32DMX Card 16-52
    16.6.3.1 ROADM 16-54
    16.6.3.2 Power Monitoring 16-55
    16.6.3.3 32DMX Card-Level Indicators 16-55
    16.6.3.4 32DMX Port-Level Indicators 16-55
  16.6.4 4MD-xx.x Card 16-55
    16.6.4.1 Wavelength Pairs 16-58
    16.6.4.2 Power Monitoring 16-58
    16.6.4.3 4MD-xx.x Card-Level Indicators 16-58
    16.6.4.4 4MD-xx.x Port-Level Indicators 16-59
16.7 Optical Add/Drop Multiplexer Cards 16-59
16.7.1 AD-1C-xx.x Card 16-59
  16.7.1.1 Power Monitoring 16-61
  16.7.1.2 AD-1C-xx.x Card-Level Indicators 16-62
  16.7.1.3 AD-1C-xx.x Port-Level Indicators 16-62
16.7.2 AD-2C-xx.x Card 16-62
  16.7.2.1 Wavelength Pairs 16-64
  16.7.2.2 Power Monitoring 16-65
  16.7.2.3 AD-2C-xx.x Card-Level Indicators 16-65
  16.7.2.4 AD-2C-xx.x Port-Level Indicators 16-66
16.7.3 AD-4C-xx.x Card 16-66
  16.7.3.1 Wavelength Pairs 16-68
  16.7.3.2 Power Monitoring 16-69
  16.7.3.3 AD-4C-xx.x Card-Level Indicators 16-69
  16.7.3.4 AD-4C-xx.x Port-Level Indicators 16-70
16.7.4 AD-1B-xx.x Card 16-70
  16.7.4.1 Power Monitoring 16-72
  16.7.4.2 AD-1B-xx.x Card-Level Indicators 16-73
  16.7.4.3 AD-1B-xx.x Port-Level Indicators 16-73
16.7.5 AD-4B-xx.x Card 16-73
  16.7.5.1 Power Monitoring 16-75
  16.7.5.2 AD-4B-xx.x Card-Level Indicators 16-76
  16.7.5.3 AD-4B-xx.x Port-Level Indicators 16-76
16.7.6 32WSS Card 16-76
  16.7.6.1 Power Monitoring 16-81
  16.7.6.2 32WSS Card-Level Indicators 16-81
  16.7.6.3 32WSS Port-Level Indicators 16-81
16.8 Transponder and Muxponder Cards 16-82
16.8.1 TXP_MR_10G Card 16-82
  16.8.1.1 Y-Cable Protection 16-83
  16.8.1.2 Automatic Laser Shutdown 16-83
  16.8.1.3 TXP_MR_10G Card-Level Indicators 16-84
  16.8.1.4 TXP_MR_10G Port-Level Indicators 16-84
16.8.2 TXP_MR_10E Card 16-84
  16.8.2.1 Key Features 16-85
  16.8.2.2 Faceplate and Block Diagram 16-85
  16.8.2.3 Client Interface 16-86
  16.8.2.4 DWDM Trunk Interface 16-86
  16.8.2.5 Y-Cable Protection 16-86
  16.8.2.6 Enhanced FEC (E-FEC) Feature 16-87
16.8.2.7 FEC and E-FEC Modes 16-87
16.8.2.8 Client-to-Trunk Mapping 16-87
16.8.2.9 Automatic Laser Shutdown 16-87
16.8.2.10 TXP_MR_10E Card-Level Indicators 16-88
16.8.2.11 TXP_MR_10E Port-Level Indicators 16-88
16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards 16-88
  16.8.3.1 Faceplate 16-90
  16.8.3.2 Block Diagram 16-91
  16.8.3.3 Y-Cable Protection 16-92
  16.8.3.4 Splitter Protection 16-93
  16.8.3.5 Automatic Laser Shutdown 16-93
  16.8.3.6 TXP_MR_2.5G and TXPP_MR_2.5G Safety Labels 16-93
  16.8.3.7 TXP_MR_2.5G and TXPP_MR_2.5G Card-Level Indicators 16-94
  16.8.3.8 TXP_MR_2.5G and TXPP_MR_2.5G Port-Level Indicators 16-95
16.8.4 MXP_2.5G_10G Card 16-95
  16.8.4.1 Y-Cable Protection 16-98
  16.8.4.2 Automatic Laser Shutdown 16-98
  16.8.4.3 Timing Synchronization 16-98
  16.8.4.4 MXP_2.5G_10G Card-Level Indicators 16-99
  16.8.4.5 MXP_2.5G_10G Port-Level Indicators 16-99
16.8.5 MXP_2.5G_10E Card 16-99
  16.8.5.1 Key Features 16-100
  16.8.5.2 Faceplate 16-101
  16.8.5.3 Client Interfaces 16-102
  16.8.5.4 DWDM Interface 16-102
  16.8.5.5 Multiplexing Function 16-102
  16.8.5.6 Timing Synchronization 16-103
  16.8.5.7 Y-Cable Protection 16-103
  16.8.5.8 Enhanced FEC (E-FEC) Capability 16-103
  16.8.5.9 FEC and E-FEC Modes 16-104
  16.8.5.10 SONET/SDH Overhead Byte Processing 16-104
  16.8.5.11 Client Interface Monitoring 16-104
  16.8.5.12 Wavelength Identification 16-104
  16.8.5.13 Automatic Laser Shutdown 16-105
  16.8.5.14 Jitter 16-105
  16.8.5.15 Lamp Test 16-106
  16.8.5.16 Onboard Traffic Generation 16-106
  16.8.5.17 MXP_2.5G_10E Card-Level Indicators 16-106
  16.8.5.18 MXP_2.5G_10E Port-Level Indicators 16-106
16.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards 16-106
18.2.1 Hubbed Rings 18-2
18.2.2 Multihubbed Rings 18-2
18.2.3 Any-to-Any Rings 18-3
18.2.4 Meshed Rings 18-4
18.2.5 Linear Configurations 18-5
18.2.6 Single-Span Link 18-6
18.3 Optical Performance 18-6
18.3.1 Optical Performance for Rings and Linear Networks with OADM Nodes 18-8
18.3.2 Optical Performance for Linear Networks Without OADM Nodes 18-10
18.3.3 Optical Performance for ROADM Rings and Linear Networks 18-12
18.3.4 Optical Performance for Single-Span Networks 18-16
18.4 Automatic Power Control 18-18
18.4.1 APC at the Amplifier Card Level 18-18
18.4.2 APC at the Node and Network Levels 18-19
18.4.3 Managing APC 18-20
18.5 ROADM Power Equalization Monitoring 18-22
18.6 Span Loss Verification 18-23
18.7 Network Optical Safety—Automatic Laser Shutdown 18-24
18.7.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST/OPT-BST-E Cards 18-24
18.7.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards 18-26
18.8 Network-Level Gain—Tilt Management of Optical Amplifiers 18-28
18.8.1 Gain Tilt Control at the Card Level 18-29
18.8.2 System Level Gain Tilt Control 18-31
  18.8.2.1 System Gain Tilt Compensation Without ROADM Nodes 18-31
  18.8.2.2 System Gain Tilt Compensation With ROADM Nodes 18-33

CHAPTER 19

CTC Operation Reference 19-1
19.1 CTC Software Delivery Methods 19-1
  19.1.1 CTC Software Installed on the TCC2/TCC2P Card 19-1
  19.1.2 CTC Software Installed on the PC or UNIX Workstation 19-3
19.2 CTC Installation Overview 19-3
19.3 PC and UNIX Workstation Requirements 19-4
19.4 ONS 15454 Connections 19-6
19.5 CTC Window 19-7
  19.5.1 Node View 19-7
    19.5.1.1 CTC Card Colors 19-7
    19.5.1.2 Node View Card Shortcuts 19-10
    19.5.1.3 Node View Tabs 19-10
19.5.2 Network View  19-11
19.5.3 Card View  19-12
19.6 TCC2/TCC2P Card Reset  19-14
19.7 TCC2/TCC2P Card Database  19-15
19.8 Software Revert  19-15

CHAPTER 20
Security Reference  20-1
20.1 User IDs and Security Levels  20-1
20.2 User Privileges and Policies  20-2
  20.2.1 User Privileges by CTC Task  20-2
  20.2.2 Security Policies  20-6
    20.2.2.1 Idle User Timeout  20-6
    20.2.2.2 User Password, Login, and Access Policies  20-7
20.3 Audit Trail  20-7
  20.3.1 Audit Trail Log Entries  20-7
  20.3.2 Audit Trail Capacities  20-8
20.4 RADIUS Security  20-8
  20.4.1 RADIUS Authentication  20-9
  20.4.2 Shared Secrets  20-9

CHAPTER 21
Timing Reference  21-1
21.1 Node Timing Parameters  21-1
21.2 Network Timing  21-2
21.3 Synchronization Status Messaging  21-3

CHAPTER 22
Management Connectivity Reference  22-1
22.1 IP Networking Overview  22-1
22.2 IP Addressing Scenarios  22-2
  22.2.1 Scenario 1: CTC and ONS 15454s on Same Subnet  22-2
  22.2.2 Scenario 2: CTC and ONS 15454s Connected to a Router  22-3
  22.2.3 Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway  22-4
  22.2.4 Scenario 4: Default Gateway on CTC Computer  22-7
  22.2.5 Scenario 5: Using Static Routes to Connect to LANs  22-8
  22.2.6 Scenario 6: Using OSPF  22-10
  22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server  22-12
  22.2.8 Scenario 8: Dual GNEs on a Subnet  22-17
  22.2.9 Scenario 9: IP Addressing with Secure Mode Enabled  22-19
22.3 Provisionable Patchcords  22-21
22.4 Routing Table  22-23
22.5 External Firewalls  22-25
22.6 Open GNE  22-26
22.7 TCP/IP and OSI Networking  22-29

CHAPTER 23

Alarm Management Reference  23-1

23.1 Overview  23-1
23.2 Alarm Counts on the LCD for a Node, Slot, or Port  23-2
23.3 Alarm Display  23-2
   23.3.1 Viewing Alarms by Time Zone  23-2
   23.3.2 Controlling Alarm Display  23-3
   23.3.3 Filtering Alarms  23-3
   23.3.4 Conditions Tab  23-3
   23.3.5 Controlling the Conditions Display  23-4
      23.3.5.1 Retrieving and Displaying Conditions  23-4
      23.3.5.2 Conditions Column Descriptions  23-4
      23.3.5.3 Filtering Conditions  23-5
   23.3.6 Viewing History  23-5
      23.3.6.1 History Column Descriptions  23-6
      23.3.6.2 Retrieving and Displaying Alarm and Condition History  23-7
23.4 Alarm Severities  23-7
23.5 Alarm Profiles  23-7
   23.5.1 Creating and Modifying Alarm Profiles  23-8
   23.5.2 Alarm Profile Buttons  23-9
   23.5.3 Alarm Profile Editing  23-10
   23.5.4 Alarm Severity Options  23-10
   23.5.5 Row Display Options  23-10
   23.5.6 Applying Alarm Profiles  23-11
23.6 Alarm Suppression  23-11
23.7 External Alarms and Controls  23-12
   23.7.1 External Alarms  23-12
   23.7.2 External Controls  23-13
   23.7.3 Virtual Wires  23-13

APPENDIX A

CTC Information and Shortcuts  A-1

A.1 Display Node, Card, and Network Views  A-1
   A.1.1 Node Icons on the Network View Map  A-2
A.2 Manage the CTC Window  A-4
A.2.1 CTC Menu and Toolbar Options A-4
A.2.2 CTC Mouse Options A-8
A.2.3 Node View Shortcuts A-10
A.2.4 Network View Tasks A-10
A.2.5 Table Display Options A-11
A.3 Equipment Inventory A-12

APPENDIX B

Hardware Specifications B-1
B.1 Shelf Specifications B-1
  B.1.1 Bandwidth B-1
  B.1.2 Configurations B-1
  B.1.3 Cisco Transport Controller B-2
  B.1.4 External LAN Interface B-2
  B.1.5 TL1 Craft Interface B-2
  B.1.6 Modem Interface B-2
  B.1.7 Alarm Interface B-2
  B.1.8 EIA Interface (ANSI only) B-3
  B.1.9 BITS Interface (ANSI only) B-3
  B.1.10 System Timing B-3
  B.1.11 System Power B-3
  B.1.12 System Environmental Specifications B-4
  B.1.13 Dimensions B-4
B.2 General Card Specifications B-4
  B.2.1 Power B-5
  B.2.2 Temperature B-6
B.3 Common Control Card Specifications B-7
  B.3.1 TCC2 Card Specifications B-7
  B.3.2 TCC2P Card Specifications B-8
  B.3.3 AIC-I Card Specifications B-9
  B.3.4 AEP Specifications (ANSI only) B-10
  B.3.5 MIC-A/P FMEC Specifications (ETSI only) B-11
  B.3.6 MIC-C/T/P FMEC Specifications (ETSI only) B-12
B.4 DWDM Card Specifications B-13
  B.4.1 OSCM Card Specifications B-13
  B.4.2 OSC-CSM Card Specifications B-14
  B.4.3 OPT-PRE Amplifier Card Specifications B-14
  B.4.4 OPT-BST Amplifier Card Specifications B-15
  B.4.5 OPT-BST-E Amplifier Card Specifications B-16
  B.4.6 32MUX-O Card Specifications B-17
Figure 3-1 Cisco MetroPlanner Shelf Layout  3-4
Figure 3-2 Selecting the IP Address Option  3-15
Figure 3-3 Changing the IP Address  3-15
Figure 3-4 Selecting the Save Configuration Option  3-16
Figure 3-5 Saving and Rebooting the TCC2/TCC2P  3-16
Figure 3-6 Nodes Behind a Firewall  3-23
Figure 3-7 CTC Computer and ONS 15454 Nodes Residing Behind Firewalls  3-24
Figure 3-8 Creating an SNMP Trap  3-36
Figure 3-9 Cisco MetroPlanner Internal Connections Table  3-49
Figure 3-10 Fibering OSC Terminations—Hub Node with OSCM Cards  3-52
Figure 3-11 Fibering a Hub Node  3-55
Figure 3-12 Fibering a Line Amplifier Node  3-59
Figure 3-13 Fibering an OSC Regeneration Node  3-61
Figure 3-14 Fibering an Amplified OADM Node  3-65
Figure 3-15 Fibering a Passive OADM Node  3-67
Figure 3-16 Fibering an ROADM Node  3-70
Figure 3-17 Using the Patch-Panel Latches to Slide the Patch Panel Away from the Tray  3-75
Figure 3-18 MPO Cable  3-76
Figure 3-19 Rear View of the Patch Panel  3-77
Figure 3-20 Top View of the Patch-Panel Bar  3-77
Figure 3-21 Front View of the Patch Panel  3-78
Figure 3-22 OSC Terminations Area  3-85
Figure 5-1 Single-Span Topology  5-4
Figure 5-2 Point-to-Point Topology  5-4
Figure 5-3 Hubs with No Line Amplifiers  5-5
Figure 5-4 Hubs with Line Amplifiers  5-5
Figure 5-5 Creating a Y-Cable Protection Group  5-11
Figure 6-1 Maintenance > Protection Tabs  6-14
Figure 8-1 Selecting CTC Data For Print  8-3
Figure 8-2 Selecting CTC Data For Export  8-4
Figure 8-3 CTC Preferences Dialog Box  8-10
Figure 8-4 Shelf LCD Panel  8-15
Figure 8-5 Store Profiles Dialog Box  8-19
Figure 8-6 AD-1C Card Alarm Profile  8-22
Figure 8-7 Select Node/Profile Combination For Delete Dialog Box  8-24
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-8</td>
<td>Alarm Filter Dialog Box General Tab</td>
<td>8-26</td>
</tr>
<tr>
<td>8-9</td>
<td>Alarm Filter Dialog Box Conditions Tab</td>
<td>8-27</td>
</tr>
<tr>
<td>8-10</td>
<td>Provisioning External Alarms on the AIC-I Card</td>
<td>8-33</td>
</tr>
<tr>
<td>9-1</td>
<td>OC3 Line Tab in the Optical Service Channel Card View Performance Window</td>
<td>9-11</td>
</tr>
<tr>
<td>9-2</td>
<td>Optical Line Tab in the Optical Amplifier Card View Performance Window</td>
<td>9-12</td>
</tr>
<tr>
<td>9-3</td>
<td>Optical Channel Tab in the Multiplexer/Demultiplexer Card View Performance Window</td>
<td>9-14</td>
</tr>
<tr>
<td>9-4</td>
<td>Optical Channel Tab in the 4MD-xx.x Card View Performance Window</td>
<td>9-15</td>
</tr>
<tr>
<td>9-5</td>
<td>Optical Line Tab in the Channel Filter OADM Card View Performance Window</td>
<td>9-17</td>
</tr>
<tr>
<td>9-6</td>
<td>Viewing Optics Performance Monitoring Information</td>
<td>9-23</td>
</tr>
<tr>
<td>9-7</td>
<td>Viewing Payload Performance Monitoring Information</td>
<td>9-24</td>
</tr>
<tr>
<td>9-8</td>
<td>Viewing OTN ITU-T G.709 Performance Monitoring Information</td>
<td>9-25</td>
</tr>
<tr>
<td>9-9</td>
<td>Viewing OTN FEC Performance Monitoring Information</td>
<td>9-26</td>
</tr>
<tr>
<td>9-10</td>
<td>Statistics Tab on the Card View Performance Window</td>
<td>9-27</td>
</tr>
<tr>
<td>9-11</td>
<td>Utilization Tab on the Card View Performance Window</td>
<td>9-29</td>
</tr>
<tr>
<td>9-12</td>
<td>History Tab on the Card View Performance Window</td>
<td>9-30</td>
</tr>
<tr>
<td>9-13</td>
<td>SONET PM Tab on the Card View Performance Window</td>
<td>9-32</td>
</tr>
<tr>
<td>10-1</td>
<td>Equalized ROADM Power Example</td>
<td>10-6</td>
</tr>
<tr>
<td>10-2</td>
<td>RADIUS Server Tab</td>
<td>10-56</td>
</tr>
<tr>
<td>10-3</td>
<td>Create RADIUS Server Entry Window</td>
<td>10-56</td>
</tr>
<tr>
<td>13-1</td>
<td>Restoring the Database—In-Process Notification</td>
<td>13-3</td>
</tr>
<tr>
<td>13-2</td>
<td>Reinitialization Tool</td>
<td>13-6</td>
</tr>
<tr>
<td>13-3</td>
<td>Viewing the Audit Trail Records</td>
<td>13-15</td>
</tr>
<tr>
<td>13-4</td>
<td>ANSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)</td>
<td>13-23</td>
</tr>
<tr>
<td>13-5</td>
<td>ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)</td>
<td>13-24</td>
</tr>
<tr>
<td>13-6</td>
<td>Installing the Door Ground Strap Retrofit Kit</td>
<td>13-29</td>
</tr>
<tr>
<td>13-7</td>
<td>Shelf Assembly with Door Ground Strap Retrofit Kit Installed</td>
<td>13-30</td>
</tr>
<tr>
<td>13-8</td>
<td>Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)</td>
<td>13-34</td>
</tr>
<tr>
<td>13-9</td>
<td>Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ETSI)</td>
<td>13-35</td>
</tr>
<tr>
<td>13-10</td>
<td>Find the MAC Address</td>
<td>13-37</td>
</tr>
<tr>
<td>13-11</td>
<td>Lower Backplane Cover</td>
<td>13-37</td>
</tr>
<tr>
<td>13-12</td>
<td>Repairing Circuits</td>
<td>13-39</td>
</tr>
<tr>
<td>13-13</td>
<td>Recording the Old MAC Address Before Replacing the AIP</td>
<td>13-39</td>
</tr>
<tr>
<td>13-14</td>
<td>Circuit Repair Information</td>
<td>13-40</td>
</tr>
<tr>
<td>13-15</td>
<td>Attaching Plastic Lower Backplane Cover</td>
<td>13-41</td>
</tr>
<tr>
<td>15-1</td>
<td>Cisco ONS 15454 ANSI Dimensions</td>
<td>15-4</td>
</tr>
</tbody>
</table>
Figure 15-2  Mounting an ONS 15454 ANSI Shelf in a Rack  15-5
Figure 15-3  ONS 15454 ETSI Dimensions  15-7
Figure 15-4  Mounting an ONS 15454 ETSI Shelf in a Rack  15-8
Figure 15-5  Three-Shelf ONS 15454 ETSI Bay Assembly  15-9
Figure 15-6  Two-Channel Add/Drop FlexLayer Module Block Diagram  15-11
Figure 15-7  ONS 15454 Two-Channel Optical Add/Drop FlexLayer Module  15-12
Figure 15-8  Two-Channel Drop Component Connector Mapping and Labeling  15-12
Figure 15-9  Two-Channel Add Component Connector Mapping and Labeling  15-13
Figure 15-10 Typical Y-Cable Protection Module Configuration  15-13
Figure 15-11 1:2 Splitter and 2:1 Coupler (Y-Cable Protection) Module Block Diagram  15-14
Figure 15-12 ONS 15454 Y-Cable Protection FlexLayer Module (Single-Mode)  15-14
Figure 15-13 ONS 15454 Y-Cable Protection FlexLayer Module (Multimode)  15-15
Figure 15-14 Y-Cable Protection Component Connector Mapping and Labeling  15-15
Figure 15-15 Typical DWDM Equipment Layout in an ONS 15454 ANSI Rack  15-18
Figure 15-16 The ONS 15454 Front Door  15-19
Figure 15-17 Cisco ONS 15454 ANSI Deep Door  15-20
Figure 15-18 ONS 15454 ANSI Front Door Ground Strap  15-21
Figure 15-19 Removing the ONS 15454 ANSI Front Door  15-22
Figure 15-20 Removing the ONS 15454 ETSI Front Door  15-23
Figure 15-21 ONS 15454 ANSI Front-Door Erasable Label  15-24
Figure 15-22 ONS 15454 ETSI Front-Door Erasable Label  15-25
Figure 15-23 Laser Warning on the ONS 15454 ANSI Front-Door Label  15-25
Figure 15-24 Laser Warning on the ONS 15454 ETSI Front-Door Label  15-26
Figure 15-25 Backplane Covers  15-27
Figure 15-26 Removing the Lower Backplane Cover  15-27
Figure 15-27 Backplane Attachment for Cover  15-28
Figure 15-28 Installing the Plastic Rear Cover with Spacers  15-29
Figure 15-29 AEP Printed Circuit Board Assembly  15-31
Figure 15-30 AEP Block Diagram  15-31
Figure 15-31 AEP Wire-Wrap Connections to Backplane Pins  15-32
Figure 15-32 Alarm Input Circuit Diagram  15-33
Figure 15-33 Alarm Output Circuit Diagram  15-34
Figure 15-34 Filler Card Faceplate  15-36
Figure 15-35 Managing Cables on the Front Panel  15-37
Figure 15-36 Fiber Capacity  15-38
Figure 16-28  32DMX-O Block Diagram  16-51
Figure 16-29  32DMX-O Optical Module Functional Block Diagram  16-51
Figure 16-30  32DMX Faceplate and Ports  16-53
Figure 16-31  32DMX Block Diagram  16-54
Figure 16-32  32DMX Optical Module Functional Block Diagram  16-54
Figure 16-33  4MD-xx.x Faceplate  16-56
Figure 16-34  4MD-xx.x Block Diagram  16-57
Figure 16-35  4MD-xx.x Optical Module Functional Block Diagram  16-57
Figure 16-36  AD-1C-xx.x Faceplate  16-60
Figure 16-37  AD-1C-xx.x Block Diagram  16-61
Figure 16-38  AD-1C-xx.x Optical Module Functional Block Diagram  16-61
Figure 16-39  AD-2C-xx.x Faceplate  16-63
Figure 16-40  AD-2C-xx.x Block Diagram  16-64
Figure 16-41  AD-2C-xx.x Optical Module Functional Block Diagram  16-64
Figure 16-42  AD-4C-xx.x Faceplate  16-67
Figure 16-43  AD-4C-xx.x Block Diagram  16-68
Figure 16-44  AD-4C-xx.x Optical Module Functional Block Diagram  16-68
Figure 16-45  AD-1B-xx.x Faceplate  16-71
Figure 16-46  AD-1B-xx.x Block Diagram  16-72
Figure 16-47  AD-1B-xx.x Optical Module Functional Block Diagram  16-72
Figure 16-48  AD-4B-xx.x Faceplate  16-74
Figure 16-49  AD-4B-xx.x Block Diagram  16-75
Figure 16-50  AD-4B-xx.x Optical Module Functional Block Diagram  16-75
Figure 16-51  32WSS Faceplate and Ports  16-78
Figure 16-52  32WSS Block Diagram  16-79
Figure 16-53  32WSS Optical Block Diagram  16-80
Figure 16-54  TXP_MR_10G Faceplate and Block Diagram  16-83
Figure 16-55  TXP_MR_10E Faceplate and Block Diagram  16-85
Figure 16-56  TXP_MR_2.5G and TXPP_MR_2.5G Faceplates  16-91
Figure 16-57  TXP_MR_2.5G and TXPP_MR_2.5G Block Diagram  16-92
Figure 16-58  Laser Radiation Warning—Hazard Level Label  16-93
Figure 16-59  Laser Radiation Warning—Laser Source Connector Label  16-94
Figure 16-60  FDA Compliance Statement Label  16-94
Figure 16-61  Electrical Energy Hazard Label  16-94
Figure 16-62  MXP_2.5G_10G Faceplate  16-97
Figure 16-63  MXP_2.5G_10G Card Block Diagram  16-98
Figure 16-64  MXP_2.5G_10E Faceplate  16-101
Figure 16-65  MXP_2.5G_10E Block Diagram  16-102
Figure 16-66  MXP_MR_2.5G and MXPP_MR_2.5G Faceplates  16-110
Figure 16-67  MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram  16-111
Figure 16-68  Laser Radiation Warning—Hazard Level Label  16-112
Figure 16-69  Laser Radiation Warning—Laser Source Connector Label  16-112
Figure 16-70  FDA Compliance Statement Label  16-112
Figure 16-71  Electrical Energy Hazard Label  16-113
Figure 16-72  Y-Cable Protection  16-115
Figure 16-73  Splitter Protection  16-116
Figure 16-74  Mylar Tab SFP  16-119
Figure 16-75  Actuator/Button SFP  16-119
Figure 16-76  Bail Clasp SFP  16-119
Figure 16-77  Bail Clasp XFP (Unlatched)  16-120
Figure 16-78  Bail Clasp XFP (Latched)  16-120
Figure 17-1  Hub Node Configuration Example  17-2
Figure 17-2  Hub Node Channel Flow Example  17-3
Figure 17-3  Terminal Node Configuration Example  17-4
Figure 17-4  Amplified OADM Node Configuration Example  17-5
Figure 17-5  Amplified OADM Node Channel Flow Example  17-6
Figure 17-6  Passive OADM Node Configuration Example  17-7
Figure 17-7  Passive OADM Node Channel Flow Example  17-7
Figure 17-8  ROADM Node with BST-PRE, OPT-BST, and 32DMX Cards Installed  17-8
Figure 17-9  ROADM Node with BST-PRE, OPT-BST, and 32DMX-O Cards Installed  17-9
Figure 17-10  ROADM Optical Signal Flow Example  17-10
Figure 17-11  Anti-ASE Node Channel Flow Example  17-11
Figure 17-12  Line Amplifier Node Configuration Example  17-12
Figure 17-13  OSC Regeneration Line Node Configuration Example  17-13
Figure 17-14  OSC Regeneration Line Node Flow  17-13
Figure 17-15  Double Terminal Protection Configuration  17-15
Figure 17-16  1+1 Protected Single-Span Link with Hub Nodes  17-16
Figure 17-17  1+1 Protected Single-Span Link with Active OADM Nodes  17-17
Figure 17-18  1+1 Protected Single-Span Link with Passive OADM Nodes  17-18
Figure 17-19  Scalable Terminal Channel Flow Example  17-20
Figure 19-6  Network in CTC Network View  19-11
Figure 19-7  CTC Card View Showing a 32DMX-O Card  19-13
Figure 21-1  ONS 15454 Timing Example  21-3
Figure 22-1  Scenario 1: CTC and ONS 15454s on Same Subnet (ANSI and ETSI)  22-3
Figure 22-2  Scenario 2: CTC and ONS 15454s Connected to Router (ANSI and ETSI)  22-4
Figure 22-3  Scenario 3: Using Proxy ARP (ANSI and ETSI)  22-6
Figure 22-4  Scenario 3: Using Proxy ARP with Static Routing (ANSI and ETSI)  22-7
Figure 22-5  Scenario 4: Default Gateway on a CTC Computer (ANSI and ETSI)  22-8
Figure 22-6  Scenario 5: Static Route With One CTC Computer Used as a Destination (ANSI and ETSI)  22-9
Figure 22-7  Scenario 5: Static Route With Multiple LAN Destinations (ANSI and ETSI)  22-10
Figure 22-8  Scenario 6: OSPF Enabled (ANSI and ETSI)  22-11
Figure 22-9  Scenario 6: OSPF Not Enabled (ANSI and ETSI)  22-12
Figure 22-10  Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI and ETSI)  22-14
Figure 22-11  Scenario 7: ONS 15454 Proxy Server with GNEs and ENEs on Different Subnets (ANSI and ETSI)  22-15
Figure 22-12  Scenario 7: ONS 15454 Proxy Server With ENEs on Multiple Rings (ANSI and ETSI)  22-16
Figure 22-13  Scenario 8: Dual GNEs on the Same Subnet (ANSI and ETSI)  22-18
Figure 22-14  Scenario 8: Dual GNEs on Different Subnets (ANSI and ETSI)  22-19
Figure 22-15  Scenario 9: ONS 15454 GNE and ENEs on the Same Subnet with Secure Mode Enabled  22-20
Figure 22-16  Scenario 9: ONS 15454 GNE and ENEs on Different Subnets with Secure Mode Enabled  22-21
Figure 22-17  Proxy and Firewall Tunnels for Foreign Terminations  22-28
Figure 22-18  Foreign Node Connection to an ENE Ethernet Port  22-29
Figure 22-19  OSI/MSTP Scenario 1  22-30
Figure 22-20  OSI/MSTP Scenario 2  22-31
Figure 22-21  OSI/MSTP Scenario 3  22-32
Figure 22-22  OSI/IP Scenario 4  22-33
Figure 23-1  Shelf LCD Panel  23-2
Figure 23-2  Network View Alarm Profiles Window  23-8
Figure 23-3  OPT-BST Card Alarm Profiles  23-11
Figure 23-4  External Alarms and Controls Using a Virtual Wire  23-14
Table 1-1  Pin Connection of the Power FMECs  1-36
Table 1-2  Pin Assignments for the AEP  1-47
Table 1-3  Alarm Pin Assignments  1-49
Table 1-4  MIC-C/T/P Clock Connector Pin Assignment  1-51
Table 1-5  LAN Pin Assignments  1-52
Table 1-6  External Timing Pin Assignments for BITS  1-55
Table 1-7  LAN Pin Assignments for the ONS 15454 ANSI Shelf  1-57
Table 1-8  Craft Interface Pin Assignments  1-58
Table 1-9  Alarm Input Pin Assignments  1-59
Table 1-10  Alarm Output Pin Assignments  1-60
Table 1-11  ONS 15xxx FlexLayer Hardware Part Numbers  1-69
Table 1-12  ONS 15454 ETSI Shelf Installation Task Summary  1-76
Table 1-13  ONS 15454 ANSI Shelf Installation Task Summary  1-76
Table 2-1  CTC Computer Setup for Local Craft Connections to the ONS 15454  2-9
Table 3-1  Cisco MetroPlanner Node Setup Information and Files  3-3
Table 3-2  LED Behavior During TCC2/TCC2P Reboot  3-14
Table 3-3  CTC Add Card Menu for DWDM Cards  3-37
Table 3-4  Cable Connections for Y-Cable Protection of First Client Signal  3-79
Table 3-5  Cable Connections for Y-Cable Protection of a Second Client Signal  3-80
Table 4-1  TXP_MR_2.5G Card Wavelengths and Part Numbers  4-4
Table 4-2  32WSS Ports and Wavelengths Test Checklist  4-9
Table 5-1  PPM Port Types  5-7
Table 5-2  Protection Types  5-10
Table 5-3  TXP_MR-10G and TXP_MR_10E Card Settings  5-13
Table 5-4  TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings  5-15
Table 5-5  TXP_MR_10G and TXP_MR_10E Transponder Card Section Trace Settings  5-18
Table 5-6  TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings  5-19
Table 5-7  TXP_MR_10G and TXP_MR_10GE LAN Phy Variables  5-21
Table 5-8  TXP_MR_10G and TXP_MR_10E Trunk Port TCA Thresholds  5-24
Table 5-9  TXP_MR_10G and TXP_MR_10E Trunk Port Alarm Thresholds  5-25
Table 5-10  TXP_MR_10E and TXP_MR_10G Card Client Interface TCA Thresholds  5-26
Table 5-11  TXP_MR_10E and TXP_MR_10G Card Client Interface Alarm Thresholds  5-26
Table 5-12  TXP_MR_10G and TXP_MR_10E Transponder Card OTN Lines Settings  5-27
Table 5-13  TXP_MR_10G and TXP_MR_10E Transponder Card ITU-T G.709 Threshold Settings  5-28
Table 5-14  TXP_MR_10G and TXP_MR_10E Transponder Card FEC Threshold Settings  5-29
Table 5-15  TXP_MR_10G and TXP_MR_10E Transponder Card Trail Trace Identifier Settings  5-30
Table 5-16  MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Settings  5-33
Table 5-17  MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings  5-34
Table 5-18  TXP_MR_10G and MXP_MR_10E Card Section Trace Settings  5-37
Table 5-19  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trunk Settings  5-38
Table 5-20  MXP_2.5G_10G and MXP_2.5G_10E Card Line Threshold Settings  5-40
Table 5-21  MXP_2.5G_10G and MXP_2.5G_10E Trunk Port TCA Thresholds  5-42
Table 5-22  MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm Thresholds  5-42
Table 5-23  MXP_2.5G_10G and MXP_2.5G_10E Card Client Interface TCA Thresholds  5-43
Table 5-24  MXP_2.5G_10G and MXP_2.5G_10E Card Client Interface Alarm Thresholds  5-44
Table 5-25  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Line OTN Settings  5-45
Table 5-26  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card ITU-T G.709 Threshold Settings  5-45
Table 5-27  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card FEC Threshold Settings  5-46
Table 5-28  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings  5-46
Table 5-29  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings  5-49
Table 5-30  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings  5-51
Table 5-31  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace Settings  5-53
Table 5-32  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads  5-55
Table 5-33  TXP_MR_2.5G and TXPP_MR_2.5G Card 1G Ethernet and 1G FC/FICON Thresholds  5-56
Table 5-34  TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port TCA Thresholds  5-58
Table 5-35  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds  5-59
Table 5-36  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds  5-60
Table 5-37  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card OTN Line Settings  5-62
Table 5-38  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card ITU-T G.709 Threshold Settings  5-63
Table 5-39  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card FEC Threshold Settings  5-63
Table 5-40  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier Settings  5-63
Table 5-41  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Settings  5-66
Table 5-42  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Client Service Tab Settings  5-67
Table 5-43  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension Settings  5-70
Table 5-44  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line SONET or SDH Tab Settings  5-72
Table 5-45  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Section Trace Tab Settings  5-74
Table 5-46  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings  5-75
Table 5-47  MXP_MR_2.5G and MXPP_MR_2.5G Card 1G Ethernet or 1G FC/FICON Variables  5-77
Table 5-48  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface TCA Thresholds  5-80
Table 5-49  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface Alarm Thresholds  5-81
Table 7-1  Circuit Protection Types  7-5
Table 7-2  Cisco ONS 15454 Circuit Status  7-6
Table 7-3  OCHNC Channels  7-11
Table 8-1  Alarm Column Descriptions  8-6
Table 8-2  Color Codes for Alarms and Condition Severities  8-7
Table 9-1  Channel OADM Optical Line Ports  9-17
Table 9-2  Channel OADM Optical Line Ports  9-18
Table 9-3  Band OADM Optical Line Ports  9-18
Table 9-4  Band OADM Optical Line Ports  9-19
Table 10-1  HTML Commands for the Legal Disclaimer  10-8
Table 10-2  Managing Domains  10-29
Table 11-1  OSCM Card OC-3 Settings  11-3
Table 11-2  OSCM and OSC-CSM Cards SONET Threshold Settings  11-5
Table 11-3  OSCM and OSC-CSM Card Optical Line Parameter Settings  11-6
Table 11-4  OSCM and OSC-CSM Cards Optical Channel Warning Thresholds Settings  11-8
Table 11-5  OSCM and OSC-CSM Cards Optical Channel Alarm Thresholds Settings  11-9
Table 11-6  OSC-CSM and OSCM Maintenance Settings  11-11
Table 11-7  OPT-PRE and OPT-BST Amplifier Optical Line Settings  11-13
Table 11-8  OPT-PRE and OPT-BST Card Optical Channel Warning Thresholds Settings  11-14
Table 11-9  OPT-PRE and OPT-BST Card Optical Channel Alarm Threshold Settings  11-15
Table 11-10  OPT-PRE and OPT-BST Optical Amplifier Line Settings  11-16
Table 11-11  OPT-PRE and OPT-BST Card Amplifier Line Warning Threshold Settings  11-18
Table 11-12  OPT-PRE and OPT-BST Card Amplifier Line Alarm Threshold Settings  11-19
Table 11-13  OPT-BST Maintenance Settings  11-22
Table 11-14  Multiplexer and Demultiplexer Card Optical Line Settings  11-24
Table 11-15  Multiplexer and Demultiplexer Card Amplifier Line Warning Threshold Settings  11-26
Table 11-16  Multiplexer and Demultiplexer Amplifier Line Alarm Threshold Settings  11-27
Table 11-17  Multiplexer and Demultiplexer Card Optical Channel Settings  11-28
Table 11-18  Multiplexer and Demultiplexer Card Optical Channel Warning Threshold Settings  11-30
Table 11-19  Multiplexer and Demultiplexer Card Optical Channel Alarm Threshold Settings  11-31
Table 11-20  32WSS Optical Channel Parameter Settings  11-34
Table 11-21  32WSS Optical Channel Warning Threshold Settings  11-36
Table 11-22  32WSS Optical Channel Alarm Threshold Settings  11-37
Table 11-23  32WSS Optical Line Parameter Settings  11-39
Table 11-24  32WSS Optical Channel Warning Threshold Settings  11-41
Table 11-25  32WSS Optical Channel Alarm Threshold Settings  11-41
Table 13-1 Audit Trail Column Definitions  13-15
Table 13-2 ONS 15454 Timing Report  13-20
Table 13-3 Incompatibility Alarms for ONS 15454 ANSI  13-31
Table 13-4 Incompatibility Alarms for ONS 15454 ETSI  13-32
Table 15-1 ONS 15454 100-GHz Channel Plan  15-10
Table 15-2 Protection A (TXP Cards 1 and 2) Port Mapping: Combiner from DWDM  15-15
Table 15-3 Protection A (TXP Cards 1 and 2) Port Mapping: Splitter to DWDM  15-16
Table 15-4 Protection B (TXP Cards 3 and 4) Port Mapping: Combiner from DWDM  15-16
Table 15-5 Protection B (TXP Cards 3 and 4) Port Mapping: Splitter to DWDM  15-16
Table 15-6 Pin Assignments for the AEP  15-32
Table 15-7 Alarm Input Pin Association  15-33
Table 15-8 Pin Association for Alarm Output Pins  15-34
Table 15-9 ANSI Fiber Channel Capacity (One Side of the Shelf)  15-38
Table 15-10 ETSI Fiber Channel Capacity (One Side of the Shelf)  15-38
Table 15-11 Fiber-Storage Tray Capacity  15-40
Table 15-12 Fan Tray Assembly Power Requirements  15-42
Table 15-13 BITS External Timing Pin Assignments  15-46
Table 15-14 LAN Pin Assignments  15-47
Table 15-15 Craft Interface Pin Assignments  15-47
Table 15-16 Slot and Card Symbols  15-50
Table 16-1 DWDM and Client Cards for the ONS 15454  16-3
Table 16-2 DWDM and Client Card CTC Software Release Compatibility  16-5
Table 16-3 ONS 15454 Card Interfaces Assigned to Input Power Classes  16-6
Table 16-4 10-Gbps Interface Optical Performance  16-7
Table 16-5 2.5-Gbps Interface Optical Performance  16-8
Table 16-6 DWDM Channel Allocation Plan  16-9
Table 16-7 TCC2 Card-Level Indicators  16-12
Table 16-8 TCC2 Network-Level Indicators  16-13
<table>
<thead>
<tr>
<th>Table 16-9</th>
<th>TCC2P Card-Level Indicators</th>
<th>16-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 16-10</td>
<td>TCC2P Network-Level Indicators</td>
<td>16-16</td>
</tr>
<tr>
<td>Table 16-11</td>
<td>AIC-I Card-Level Indicators</td>
<td>16-17</td>
</tr>
<tr>
<td>Table 16-12</td>
<td>Orderwire Pin Assignments</td>
<td>16-20</td>
</tr>
<tr>
<td>Table 16-13</td>
<td>UDC Pin Assignments</td>
<td>16-20</td>
</tr>
<tr>
<td>Table 16-14</td>
<td>DCC Pin Assignments</td>
<td>16-21</td>
</tr>
<tr>
<td>Table 16-15</td>
<td>Alarm Interface Pinouts on the MIC-A/P DB-62 Connector</td>
<td>16-22</td>
</tr>
<tr>
<td>Table 16-16</td>
<td>OSCM VOA Port Calibration</td>
<td>16-28</td>
</tr>
<tr>
<td>Table 16-17</td>
<td>OSCM Card-Level Indicators</td>
<td>16-29</td>
</tr>
<tr>
<td>Table 16-18</td>
<td>OSC-CSM Port Calibration</td>
<td>16-34</td>
</tr>
<tr>
<td>Table 16-19</td>
<td>OSC-CSM Card-Level Indicators</td>
<td>16-34</td>
</tr>
<tr>
<td>Table 16-20</td>
<td>OPT-PRE Port Calibration</td>
<td>16-37</td>
</tr>
<tr>
<td>Table 16-21</td>
<td>OPT-PRE Amplifier Card-Level Indicators</td>
<td>16-38</td>
</tr>
<tr>
<td>Table 16-22</td>
<td>OPT-BST Port Calibration</td>
<td>16-40</td>
</tr>
<tr>
<td>Table 16-23</td>
<td>OPT-BST Card-Level Indicators</td>
<td>16-41</td>
</tr>
<tr>
<td>Table 16-24</td>
<td>OPT-BST-E Port Calibration</td>
<td>16-44</td>
</tr>
<tr>
<td>Table 16-25</td>
<td>OPT-BST-E Card-Level Indicators</td>
<td>16-45</td>
</tr>
<tr>
<td>Table 16-26</td>
<td>32MUX-O Channel Plan</td>
<td>16-48</td>
</tr>
<tr>
<td>Table 16-27</td>
<td>32MUX-O Port Calibration</td>
<td>16-49</td>
</tr>
<tr>
<td>Table 16-28</td>
<td>32MUX-O Card-Level Indicators</td>
<td>16-49</td>
</tr>
<tr>
<td>Table 16-29</td>
<td>32DMX-O Port Calibration</td>
<td>16-51</td>
</tr>
<tr>
<td>Table 16-30</td>
<td>32DMX-O Card-Level Indicators</td>
<td>16-52</td>
</tr>
<tr>
<td>Table 16-31</td>
<td>32DMX Port Calibration</td>
<td>16-55</td>
</tr>
<tr>
<td>Table 16-32</td>
<td>32DMX Card-Level Indicators</td>
<td>16-55</td>
</tr>
<tr>
<td>Table 16-33</td>
<td>4MD-xx.x Channel Sets</td>
<td>16-58</td>
</tr>
<tr>
<td>Table 16-34</td>
<td>4MD-xx.x Port Calibration</td>
<td>16-58</td>
</tr>
<tr>
<td>Table 16-35</td>
<td>4MD-xx.x Card-Level Indicators</td>
<td>16-59</td>
</tr>
<tr>
<td>Table 16-36</td>
<td>AD-1C-xx.x Port Calibration</td>
<td>16-61</td>
</tr>
<tr>
<td>Table 16-37</td>
<td>AD-1C-xx.x Card-Level Indicators</td>
<td>16-62</td>
</tr>
<tr>
<td>Table 16-38</td>
<td>AD-2C-xx.x Channel Pairs</td>
<td>16-65</td>
</tr>
<tr>
<td>Table 16-39</td>
<td>AD-2C-xx.x Port Calibration</td>
<td>16-65</td>
</tr>
<tr>
<td>Table 16-40</td>
<td>AD-2C-xx.x Card-Level Indicators</td>
<td>16-66</td>
</tr>
<tr>
<td>Table 16-41</td>
<td>AD-4C-xx.x Channel Sets</td>
<td>16-69</td>
</tr>
<tr>
<td>Table 16-42</td>
<td>AD-4C-xx.x Port Calibration</td>
<td>16-69</td>
</tr>
<tr>
<td>Table 16-43</td>
<td>AD-4C-xx.x Card-Level Indicators</td>
<td>16-69</td>
</tr>
<tr>
<td>Table Number</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>16-44</td>
<td>AD-1B-xx.x Port Calibration</td>
<td>16-72</td>
</tr>
<tr>
<td>16-45</td>
<td>AD-1B-xx.x Card-Level Indicators</td>
<td>16-73</td>
</tr>
<tr>
<td>16-46</td>
<td>AD-4B-xx.x Port Calibration</td>
<td>16-76</td>
</tr>
<tr>
<td>16-47</td>
<td>AD-4B-xx.x Card-Level Indicators</td>
<td>16-76</td>
</tr>
<tr>
<td>16-48</td>
<td>32WSS Port Calibration</td>
<td>16-81</td>
</tr>
<tr>
<td>16-49</td>
<td>32WSS Card-Level Indicators</td>
<td>16-81</td>
</tr>
<tr>
<td>16-50</td>
<td>TXP_MR_10G Card-Level Indicators</td>
<td>16-84</td>
</tr>
<tr>
<td>16-51</td>
<td>TXP_MR_10G Port-Level Indicators</td>
<td>16-84</td>
</tr>
<tr>
<td>16-52</td>
<td>TXP_MR_10E Card-Level Indicators</td>
<td>16-88</td>
</tr>
<tr>
<td>16-53</td>
<td>TXP_MR_10E Port-Level Indicators</td>
<td>16-88</td>
</tr>
<tr>
<td>16-54</td>
<td>2R and 3R Mode and ITU-T G.709 Compliance by Client Interface</td>
<td>16-89</td>
</tr>
<tr>
<td>16-55</td>
<td>Trunk Bit Rates With ITU-T G.709 Enabled</td>
<td>16-90</td>
</tr>
<tr>
<td>16-56</td>
<td>TXP_MR_2.5G and TXP_MR_2.5G Card-Level Indicators</td>
<td>16-95</td>
</tr>
<tr>
<td>16-57</td>
<td>TXP_MR_2.5G and TXP_MR_2.5G Port-Level Indicators</td>
<td>16-95</td>
</tr>
<tr>
<td>16-58</td>
<td>MXP_2.5G_10G Card-Level Indicators</td>
<td>16-99</td>
</tr>
<tr>
<td>16-59</td>
<td>MXP_2.5G_10G Port-Level Indicators</td>
<td>16-99</td>
</tr>
<tr>
<td>16-60</td>
<td>MXP_2.5G_10E Trunk Wavelength</td>
<td>16-104</td>
</tr>
<tr>
<td>16-61</td>
<td>MXP_2.5G_10E Card-Level Indicators</td>
<td>16-106</td>
</tr>
<tr>
<td>16-62</td>
<td>MXP_2.5G_10E Port-Level Indicators</td>
<td>16-106</td>
</tr>
<tr>
<td>16-63</td>
<td>Card Versions</td>
<td>16-107</td>
</tr>
<tr>
<td>16-64</td>
<td>MXP_MR_2.5G and MXPP_MR_2.5G Client Interface Data Rates and Encapsulation</td>
<td>16-108</td>
</tr>
<tr>
<td>16-65</td>
<td>Client Data Rates and Ports</td>
<td>16-108</td>
</tr>
<tr>
<td>16-66</td>
<td>MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators</td>
<td>16-113</td>
</tr>
<tr>
<td>16-67</td>
<td>MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators</td>
<td>16-113</td>
</tr>
<tr>
<td>16-68</td>
<td>Termination Modes</td>
<td>16-117</td>
</tr>
<tr>
<td>16-69</td>
<td>SFP/XFP Card Compatibility</td>
<td>16-118</td>
</tr>
<tr>
<td>17-1</td>
<td>Typical AD Configurations for Scalable Terminal Nodes</td>
<td>17-19</td>
</tr>
<tr>
<td>17-2</td>
<td>ANS Parameters</td>
<td>17-32</td>
</tr>
<tr>
<td>17-3</td>
<td>ANS-WDM &gt; Provisioning Subtab Parameters</td>
<td>17-34</td>
</tr>
<tr>
<td>17-4</td>
<td>ANS Parameters By Node Type</td>
<td>17-36</td>
</tr>
<tr>
<td>17-5</td>
<td>ANS Parameters Summary</td>
<td>17-39</td>
</tr>
<tr>
<td>18-1</td>
<td>Supported Topologies and Node Types</td>
<td>18-7</td>
</tr>
<tr>
<td>18-2</td>
<td>ONS 15454 Client Card Classes</td>
<td>18-7</td>
</tr>
<tr>
<td>18-3</td>
<td>Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber</td>
<td>18-8</td>
</tr>
<tr>
<td>18-4</td>
<td>Span Loss for 16-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber</td>
<td>18-9</td>
</tr>
</tbody>
</table>
Table 18-5  Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using TW-RS Fiber  18-9
Table 18-6  Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using E-LEAF Fiber  18-10
Table 18-7  Span Loss for 32-Channel Linear Networks without OADM Nodes Using SMF Fiber  18-10
Table 18-8  Span Loss for 32-Channel Linear Networks without OADM Nodes Using TW-RS Fiber  18-11
Table 18-9  Span Loss for 32-Channel Linear Networks without OADM Nodes Using E-LEAF Fiber  18-11
Table 18-10  Span Loss for 16-Channel Linear Networks without OADM Nodes Using SMF Fiber  18-12
Table 18-11  Span Loss for Eight-Channel Linear Networks without OADM Nodes Using SMF Fiber  18-12
Table 18-12  Span Loss for 32-Channel Linear or Ring Networks with all ROADM Nodes Using SMF Fiber  18-13
Table 18-13  Span Loss for 32-Channel Ring and Linear Networks with ROADM and OADM Nodes Using SMF Fiber  18-13
Table 18-14  Pass/Fail Criteria for 32-Channel, Eight-Node ROADM Rings Using SMF Fiber  18-14
Table 18-15  Pass/Fail Criteria for 32-Channel, 16-Node ROADM Rings Using SMF Fiber  18-15
Table 18-16  Span Loss for Single-Span Link with Eight Channels  18-16
Table 18-17  Span Loss for Single-Span Link with 16 Channels  18-16
Table 18-18  Span Loss for Single-Span Link with AD-1C-xx.x Cards, OPT-PRE Amplifiers, and OPT-BST/OPT-BST-E Amplifiers  18-17
Table 18-19  Span Loss for Single-Span Link with One Channel and OPT-BST Amplifiers  18-17
Table 18-20  Span Loss for Single-Span Link with One Channel, OPT-BST/OPT-BST-E Amplifiers, OPT-PRE Amplifiers, and ONS 15216 FlexLayer Filters  18-17
Table 18-21  APC-Managed Parameters  18-21
Table 18-22  Flat Output Gain Range Limits  18-31
Table 19-1  JRE Compatibility  19-4
Table 19-2  Computer Requirements for CTC  19-5
Table 19-3  ONS 15454 Connection Methods  19-6
Table 19-4  Node View Card Colors  19-7
Table 19-5  Node View FMEC Color  19-8
Table 19-6  Node View Card Statuses  19-8
Table 19-7  Node View Card Port Colors and Service States  19-9
Table 19-8  Node View Tabs and Subtabs  19-10
Table 19-9  DCC Colors Indicating State in Network View  19-11
Table 19-10  Node Status Shown in Network View  19-12
Table 19-11  Network View Tabs and Subtabs  19-12
Table 19-12  Card View Tabs and Subtabs  19-13
Table 20-1  ONS 15454 Security Levels—Node View  20-2
Table 20-2  ONS 15454 Security Levels—Network View  20-5
Table 20-3  ONS 15454 Default User Idle Times  20-6
Table 20-4  Audit Trail Window Columns  20-8
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 20-5</td>
<td>Shared Secret Character Groups</td>
</tr>
<tr>
<td>Table 21-1</td>
<td>SSM Generation 1 Message Set</td>
</tr>
<tr>
<td>Table 21-2</td>
<td>SSM Generation 2 Message Set</td>
</tr>
<tr>
<td>Table 22-1</td>
<td>General ONS 15454 IP Troubleshooting Checklist</td>
</tr>
<tr>
<td>Table 22-2</td>
<td>ONS 15454 Gateway and End NE Settings</td>
</tr>
<tr>
<td>Table 22-3</td>
<td>Proxy Server Firewall Filtering Rules</td>
</tr>
<tr>
<td>Table 22-4</td>
<td>Proxy Server Firewall Filtering Rules When Packet Addressed to ONS 15454</td>
</tr>
<tr>
<td>Table 22-5</td>
<td>Cisco ONS 15454 Client/Trunk Card Combinations for Provisionable Patchcords</td>
</tr>
<tr>
<td>Table 22-6</td>
<td>Cisco ONS 15454 Client/Client Card Combinations for Provisionable Patchcords</td>
</tr>
<tr>
<td>Table 22-7</td>
<td>Cisco ONS 15454 Trunk/Trunk Card Combinations for Provisionable Patchcords</td>
</tr>
<tr>
<td>Table 22-8</td>
<td>Sample Routing Table Entries</td>
</tr>
<tr>
<td>Table 22-9</td>
<td>Ports Used by the TCC2/TCC2P</td>
</tr>
<tr>
<td>Table 23-1</td>
<td>Alarm Display</td>
</tr>
<tr>
<td>Table 23-2</td>
<td>Conditions Display</td>
</tr>
<tr>
<td>Table 23-3</td>
<td>Conditions Column Description</td>
</tr>
<tr>
<td>Table 23-4</td>
<td>History Column Description</td>
</tr>
<tr>
<td>Table 23-5</td>
<td>Alarm Profile Buttons</td>
</tr>
<tr>
<td>Table 23-6</td>
<td>Alarm Profile Editing Options</td>
</tr>
<tr>
<td>Table A-1</td>
<td>Change CTC Views</td>
</tr>
<tr>
<td>Table A-2</td>
<td>Description of Node Icons on Network View Map</td>
</tr>
<tr>
<td>Table A-3</td>
<td>CTC Menu and Toolbar Options</td>
</tr>
<tr>
<td>Table A-4</td>
<td>CTC Window Mouse Shortcuts</td>
</tr>
<tr>
<td>Table A-5</td>
<td>Node View Card-Related Shortcuts</td>
</tr>
<tr>
<td>Table A-6</td>
<td>Network Management Tasks in Network View</td>
</tr>
<tr>
<td>Table A-7</td>
<td>Table Display Options</td>
</tr>
<tr>
<td>Table B-1</td>
<td>Individual Card Power Requirements</td>
</tr>
<tr>
<td>Table B-2</td>
<td>Card Temperature Ranges and Product Names</td>
</tr>
<tr>
<td>Table B-3</td>
<td>32MUX-O Optical Specifications</td>
</tr>
<tr>
<td>Table B-4</td>
<td>32DMX-O Optical Specifications</td>
</tr>
<tr>
<td>Table B-5</td>
<td>32DMX Optical Specifications</td>
</tr>
<tr>
<td>Table B-6</td>
<td>32DMX Channel Plan</td>
</tr>
<tr>
<td>Table B-7</td>
<td>4MD-xx.x Optical Specifications</td>
</tr>
<tr>
<td>Table B-8</td>
<td>AD-1C-xx.x Card Optical Specifications</td>
</tr>
<tr>
<td>Table B-9</td>
<td>AD-2C-xx.x Card Optical Specifications</td>
</tr>
<tr>
<td>Table B-10</td>
<td>AD-4C-xx.x Optical Specifications</td>
</tr>
<tr>
<td>Table B-11</td>
<td>AD-1B-xx.x Channel Allocation Plan by Band</td>
</tr>
<tr>
<td>Table B-12</td>
<td>AD-1B-xx.x Optical Specifications</td>
</tr>
<tr>
<td>Table B-13</td>
<td>AD-1B-xx.x Transmit and Receive Dropped Band Wavelength Ranges</td>
</tr>
<tr>
<td>Table B-14</td>
<td>AD-4B-xx.x Channel Allocation Plan by Band</td>
</tr>
<tr>
<td>Table B-15</td>
<td>AD-4B-xx.x Optical Specifications</td>
</tr>
<tr>
<td>Table B-16</td>
<td>AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges</td>
</tr>
<tr>
<td>Table B-17</td>
<td>32WSS Optical Specifications</td>
</tr>
<tr>
<td>Table B-18</td>
<td>32WSS Channel Plan</td>
</tr>
<tr>
<td>Table B-19</td>
<td>TXP_MR_2.5G/TXPP_MR_2.5G Receiver Trunk Side Specifications</td>
</tr>
<tr>
<td>Table B-20</td>
<td>MXP_MR_2.5G/MXPP_MR_2.5G Receiver Trunk Side Specifications</td>
</tr>
<tr>
<td>Table B-21</td>
<td>MXP_2.5G_10E Receiver Trunk Side Specifications</td>
</tr>
<tr>
<td>Table B-22</td>
<td>TXP_MR_10E Receiver Trunk Side Specifications</td>
</tr>
<tr>
<td>Table B-23</td>
<td>SFP Specifications</td>
</tr>
<tr>
<td>Table B-24</td>
<td>Single-Mode Fiber SFP Port Cabling Specifications</td>
</tr>
<tr>
<td>Table B-25</td>
<td>Multimode Fiber SFP Port Cabling Specifications</td>
</tr>
<tr>
<td>Table B-26</td>
<td>XFP Specifications</td>
</tr>
<tr>
<td>Table B-27</td>
<td>Single-Mode Fiber XFP Port Cabling Specifications</td>
</tr>
<tr>
<td>Table C-1</td>
<td>ONS 15454 Service State Primary States and Primary State Qualifiers</td>
</tr>
<tr>
<td>Table C-2</td>
<td>ONS 15454 Secondary States</td>
</tr>
<tr>
<td>Table C-3</td>
<td>ONS 15454 Administrative States</td>
</tr>
<tr>
<td>Table C-4</td>
<td>ONS 15454 Optical Unit Service State Transitions</td>
</tr>
<tr>
<td>Table C-5</td>
<td>ONS 15454 Optical Payload Port Service State Transitions</td>
</tr>
<tr>
<td>Table C-6</td>
<td>ONS 15454 OSC Port Service State Transitions</td>
</tr>
<tr>
<td>Table C-7</td>
<td>ONS 15454 OCHNC Service State Transitions</td>
</tr>
<tr>
<td>Table C-8</td>
<td>ONS 15454 Transponder/Muxponder Card Service State Transitions</td>
</tr>
<tr>
<td>Table C-9</td>
<td>ONS 15454 Transponder/Muxponder Port Service State Transitions</td>
</tr>
<tr>
<td>Table D-1</td>
<td>MXP_2.5G_10E Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-2</td>
<td>MXP_2.5G_10G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-3</td>
<td>MXP_MR_2.5G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-4</td>
<td>MXPP_MR_2.5G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-5</td>
<td>TXP_MR_10E Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-6</td>
<td>TXP_MR_10G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-7</td>
<td>TXP_MR_2.5G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-8</td>
<td>TXPP_MR_2.5G Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-9</td>
<td>OSCM Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-10</td>
<td>OSC-CSM Card Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-11</td>
<td>Node Default Settings (ANSI)</td>
</tr>
<tr>
<td>Table D-12</td>
<td>CTC default settings (ANSI)</td>
</tr>
<tr>
<td>Table D-13</td>
<td>MXP_2.5G_10G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-14</td>
<td>MXP_2.5G_10E Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-15</td>
<td>MXP_MR_2.5G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-16</td>
<td>MXPP_MR_2.5G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-17</td>
<td>TXP_MR_10E Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-18</td>
<td>TXP_MR_10G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-19</td>
<td>TXP_MR_2.5G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-20</td>
<td>TXPP-MR-2.5G Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-21</td>
<td>OSCM Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-22</td>
<td>OSC-CSM Card Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-23</td>
<td>Node Default Settings (ETSI)</td>
</tr>
<tr>
<td>Table D-24</td>
<td>Time Zones (ANSI and ETSI )</td>
</tr>
<tr>
<td>Table D-25</td>
<td>CTC Default Settings (ETSI)</td>
</tr>
</tbody>
</table>
Install the Shelf and Common Control Cards 1-1

NTP-G1 Unpack and Inspect the Shelf Assembly 1-6
NTP-G2 Install the Shelf Assembly 1-8
NTP-G3 Open and Remove the Front Door 1-20
NTP-G4 Open and Remove the FMEC Cover (ETSI Only) 1-23
NTP-G5 Remove the Backplane Covers (ANSI Only) 1-26
NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only) 1-28
NTP-G7 Install the Power and Ground 1-30
NTP-G8 Install the Fan-Tray Assembly 1-40
NTP-G9 Install the Alarm Expansion Panel (ANSI Only) 1-44
NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections 1-47
NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only) 1-58
NTP-G12 Install and Close the FMEC Cover (ETSI Only) 1-63
NTP-G13 Install the Rear Cover (ANSI Only) 1-64
NTP-G14 Install DWDM Equipment 1-66
NTP-G15 Install the Common Control Cards 1-71
NTP-G16 Perform the Shelf Installation Acceptance Test 1-76

Connect the PC and Log into the GUI 2-1

NTP-G17 Set Up Computer for CTC 2-2
NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454 2-9
NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454 2-21
NTP-G20 Set Up a Remote Access Connection to the ONS 15454 2-23
NTP-G21 Log into the ONS 15454 GUI 2-24

Turn Up a Node 3-1

NTP-G139 Verify Cisco MetroPlanner Reports and Files 3-3
NTP-G22 Verify Common Card Installation 3-4
NTP-G23 Create Users and Assign Security 3-5
NTP-G24 Set Up Name, Date, Time, and Contact Information 3-8
NTP-G25 Set Power Monitor Thresholds 3-10
NTP-G26 Set Up CTC Network Access 3-11
NTP-G27 Set Up the ONS 15454 for Firewall Access 3-23
Procedures

NTP-G132 Provision OSI 3-25
NTP-G28 Set Up SNMP 3-35
NTP-G29 Preprovision a Slot 3-37
NTP-G30 Install the DWDM Cards 3-39
NTP-G31 Install the DWDM Dispersion Compensating Units 3-41
NTP-G32 Install the Transponder and Muxponder Cards 3-43
NTP-G123 Install the Filler Cards 3-47
NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs 3-48
NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, or ROADM Node and the Transponder Cards 3-72
NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules 3-79
NTP-G36 Calculate Cable Connections 3-80
NTP-G138 Import a Cisco MetroPlanner Configuration File 3-82
NTP-G37 Run Automatic Node Setup 3-83
NTP-G38 Provision OSC Terminations 3-84
NTP-G39 Verify OSCM and OSC-CSM Transmit Power 3-86

Perform Node Acceptance Tests 4-1
NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test 4-2
NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test 4-5
NTP-G43 Perform the ROADM Node Acceptance Test 4-8
NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test 4-20
NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test 4-23
NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test 4-26
NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test 4-30
NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards 4-34
NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM Cards 4-36
NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM Cards 4-38

Provision Transponder and Muxponder Cards 5-1
NTP-G128 Manage Pluggable Port Modules 5-2
NTP-G33 Create a Y-Cable Protection Group 5-10
NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards 5-12
NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-31
NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-48
NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-65

Turn Up Network 6-1
NTP-G51 Verify DWDM Node Turn-Up 6-2
NTP-G52 Verify Node-to-Node Connections 6-3
NTP-G53 Set Up Timing 6-4
NTP-G54 Provision and Verify a DWDM Network 6-8
NTP-G56 Verify the OSNR 6-12
NTP-G142 Perform a Protection Switch Test 6-13
NTP-G57 Create a Logical Network Map 6-15

Create Channels and Circuits 7-1
NTP-G58 Locate and View Optical Channel Network Connections 7-2
NTP-G59 Create and Delete Optical Channel Network Connections 7-9
NTP-G60 Create Overhead Circuits 7-13
NTP-G61 Modify and Delete Overhead Circuits 7-21
NTP-G62 Create a J0 Section Trace 7-23

Manage Alarms 8-1
NTP-G63 Document Existing Provisioning 8-2
NTP-G64 View Alarms, History, Events, and Conditions 8-6
NTP-G65 Delete Cleared Alarms from Display 8-13
NTP-G66 View Alarm-Affected Circuits 8-14
NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port 8-15
NTP-G68 Create, Download, and Assign Alarm Severity Profiles 8-16
NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering 8-25
NTP-G70 Suppress Alarms or Discontinue Alarm Suppression 8-29
NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card 8-32

Monitor Performance 9-1
NTP-G73 Change the PM Display 9-2
NTP-G74 Monitor DWDM Card Performance 9-9
NTP-G75 Monitor Transponder and Muxponder Performance 9-19

Manage the Node 10-1
NTP-G76 Verify Optical Span Loss Using CTC 10-2
NTP-G77 Manage Automatic Power Control 10-3
NTP-G78 View ROADM Node Power Equalization 10-5
NTP-G80 Change Node Management Information 10-6
NTP-G134 Modify OSI Provisioning 10-9
NTP-G81 Change CTC Network Access 10-18
NTP-G82 Customize the CTC Network View 10-26
NTP-G83 Modify or Delete Card Protection Settings 10-31
NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands 10-34
NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords 10-39
NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection 10-42
NTP-G87 Change Node Timing Parameters 10-44
NTP-G88 Modify Users and Change Security 10-45
NTP-G131 Convert DWDM Nodes to Hybrid Nodes 10-58
NTP-G89 Change SNMP Settings 10-61

Change DWDM Card Settings 11-1
NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds 11-2
NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds 11-12
NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds 11-23
NTP-G93 Modify the 32WSS Thresholds and Settings 11-33
NTP-G101 Modify Alarm Interface Controller–International Settings 11-42
NTP-G102 Change Card Service State 11-45

Add and Remove Cards and Nodes 12-1
NTP-G107 Remove and Replace DWDM Cards 12-1
NTP-G127 Add an AD-xC-xx.x Card to an OADM Node 12-5
NTP-G129 Add a DWDM Node 12-7
NTP-G130 Remove a DWDM Node 12-9

Maintain the Node 13-1
NTP-G103 Back Up the Database 13-2
NTP-G104 Restore the Database 13-3
NTP-G105 Restore the Node to Factory Configuration 13-4
NTP-G133 View and Manage OSI Information 13-9
NTP-G106 Reset Cards Using CTC 13-12
NTP-G108 Viewing the Audit Trail Records 13-14
NTP-G109 Off-Load the Audit Trail Record 13-16
NTP-G110 Off-Load the Diagnostics File 13-17
NTP-G112 Change the Node Timing Reference 13-17
NTP-G113 View the ONS 15454 Timing Report 13-19
NTP-G114 Inspect, Clean, and Replace the Air Filter 13-22
NTP-G115 Clean Fiber Connectors 13-25
NTP-G40 Replace the Front Door 13-28
NTP-G116 Replace the Fan-Tray Assembly 13-31
NTP-G117 Replace the ANSI Shelf Alarm Interface Panel 13-36
NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover 13-40
NTP-G135 Edit Network Element Defaults 13-42
NTP-G136 Import Network Element Defaults 13-43
NTP-G137 Export Network Element Defaults 13-44

Power Down a Node 14-1
NTP-G119 Power Down the Node 14-1

Shelf Hardware Reference 15-1

Card Reference 16-1

Node Reference 17-1

Network Reference 18-1

CTC Operation Reference 19-1

Security Reference 20-1

Timing Reference 21-1

Management Connectivity Reference 22-1

Alarm Management Reference 23-1
DLP-G1 Unpack and Verify the Shelf Assembly 1-6
DLP-G2 Inspect the Shelf Assembly 1-7
DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only) 1-10
DLP-G4 Install the External Brackets and Air Filter (ANSI Only) 1-11
DLP-G5 Mount the Shelf Assembly in a Rack (One Person) 1-13
DLP-G6 Mount the Shelf Assembly in a Rack (Two People) 1-15
DLP-G7 Mount Multiple Shelf Assemblies in a Rack 1-16
DLP-G8 Install the Air Ramp 1-19
DLP-G9 Open the Front Cabinet Compartment (Door) 1-20
DLP-G10 Remove the Front Door 1-21
DLP-G11 Open the FMEC Cover 1-24
DLP-G12 Remove the FMEC Cover 1-25
DLP-G13 Remove the Lower Backplane Cover 1-26
DLP-G14 Remove the Backplane Sheet Metal Cover 1-27
DLP-G15 Connect the Office Ground to the ONS 15454 ETSI 1-32
DLP-G16 Connect the Office Ground to the ONS 15454 ANSI 1-34
DLP-G17 Connect Office Power to the ONS 15454 ETSI 1-35
DLP-G18 Connect Office Power to the ONS 15454 ANSI 1-37
DLP-G19 Turn On and Verify Office Power 1-39
DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only) 1-48
DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only) 1-51
DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only) 1-52
DLP-G23 Install Alarm Wires on the Backplane (ANSI Only) 1-53
DLP-G24 Install Timing Wires on the Backplane (ANSI Only) 1-55
DLP-G25 Install LAN Wires on the Backplane (ANSI Only) 1-56
DLP-G26 Install the TL1 Craft Interface (ANSI Only) 1-57
DLP-G27 Install the DCU Shelf Assembly 1-67
DLP-G28 Install the Fiber Patch-Panel Tray 1-67
DLP-G29 Install the Fiber-Storage Tray 1-68
DLP-G30 Install the FlexLayer Shelf 1-68
DLP-G31 Install the FlexLayer Modules 1-69
DLP-G32 Install the Y-Cable Protection Modules 1-70
DLP-G33 Install the TCC2 or TCC2P Card 1-72
DLP-G34 Install the AIC-I Card 1-75
DLP-G35 Inspect the Shelf Installation and Connections 1-77
DLP-G36 Measure Voltage 1-78
DLP-G37 Run the CTC Installation Wizard for Windows 2-3
DLP-G38 Run the CTC Installation Wizard for UNIX 2-6
DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses 2-11
DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol 2-13
DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection 2-16
DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454 2-19
DLP-G43 Disable Proxy Service Using Internet Explorer (Windows) 2-22
DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX) 2-22
DLP-G46 Log into CTC 2-25
DLP-G47 Install Public-Key Security Certificate 2-28
DLP-G48 Create Login Node Groups 2-28
DLP-G49 Add a Node to the Current Session or Login Group 2-30
DLP-G50 Delete a Node from the Current Session or Login Group 2-30
DLP-G51 Delete a Node from a Specified Login Node Group 2-31
DLP-G52 Change the JRE Version 2-31
DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup 2-32
DLP-G54 Create a New User on a Single Node 3-6
DLP-G55 Create a New User on Multiple Nodes 3-7
DLP-G56 Provision IP Settings 3-12
DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD 3-15
DLP-G264 Enable Node Security Mode 3-17
DLP-G58 Create a Static Route 3-18
DLP-G59 Set Up or Change Open Shortest Path First Protocol 3-19
DLP-G60 Set Up or Change Routing Information Protocol 3-22
DLP-G61 Provision the IIOP Listener Port on the ONS 15454 3-24
DLP-G62 Provision the IIOP Listener Port on the CTC Computer 3-25
DLP-G283 Provision OSI Routing Mode 3-27
DLP-G284 Provision the TARP Operating Parameters 3-28
DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache 3-30
DLP-G287 Add a TARP Manual Adjacency Table Entry 3-31
DLP-G288 Provision OSI Routers 3-31
DLP-G289 Provision Additional Manual Area Addresses 3-32
DLP-G290 Enable the OSI Subnet on the LAN Interface 3-33
DLP-G291 Create an IP-Over-CLNS Tunnel 3-34
DLP-G273 Preprovision an SFP or XFP Slot 3-46
DLP-G274 Remove an SFP or XFP Slot 3-47
DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two Adjacent Nodes 3-51
DLP-G66 Install Fiber-Optic Cables for a Hub Node 3-54
DLP-G67 Install Fiber-Optic Cables for a Terminal Node 3-56
DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node 3-58
DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node 3-60
DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node 3-63
DLP-G71 Install Fiber-Optic Cables for an ROADM Node 3-68
DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Patch Panel 3-74
DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel 3-78
DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing 4-4
DLP-G310 Verify ROADM Node Pass-Through Channels 4-12
DLP-G311 Verify the East ROADM Add/Drop Channels 4-16
DLP-G312 Verify the West ROADM Add/Drop Channels 4-18
DLP-G78 Verify the 32MUX-O Power 4-40
DLP-G79 Verify the OPT-BST Amplifier Laser and Power 4-40
DLP-G80 Verify the OPT-PRE Amplifier Laser and Power 4-41
DLP-G269 Verify the 32DMX-O Power 4-42
DLP-G270 Verify the 32DMX Power 4-42
DLP-G82 Verify the OSC-CSM Power 4-43
DLP-G83 Verify the OSC-CSM Power on OADM Nodes 4-43
DLP-G84 Verify the OSC-CSM Incoming Power 4-44
DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM Cards 4-44
DLP-G86 Verify Express Channel Connections on an OADM Node with OSC-CSM Cards 4-46
DLP-G87 Verify the AD-xB-xx.x Output Express Power 4-47
DLP-G88 Verify the AD-xC-xx.x Output Express Power 4-47
DLP-G271 Verify the AD-xC-xx.x Output Common Power 4-48
DLP-G272 Verify the AD-xB-xx.x Output Common Power 4-48
DLP-G89 Verify OADM Node Pass-Through Channel Connections 4-49
DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power 4-50
DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection 4-51
DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power 4-52
DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards 4-53
DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Cards 4-56
DLP-G277 Provision a Multirate PPM 5-3
DLP-G274 Verify Topologies for ETR_CLO and ISC Services 5-4
DLP-G278 Provision the Optical Line Rate 5-6
DLP-G279 Change the Optical Line Rate 5-6
DLP-G280 Delete a PPM 5-8
DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards 5-13
DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards 5-14
DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards 5-17
DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads 5-19
DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy 5-19
DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy 5-21
DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds 5-24
DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA Thresholds 5-25
DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards 5-27
DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-32
DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-34
DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-36
DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-38
DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-39
DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds 5-41
DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA Thresholds 5-43
DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards 5-44
DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-49
DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-50
DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-53
DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH Payloads 5-54
DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads 5-56
DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-57
DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA Thresholds 5-58
DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards 5-62
DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-66
DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-67
DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-69
DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-71
DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards 5-73
DLP-G240 Change MXP_MR_2.5G and MXPP_MR_2.5G Card Line Threshold Settings for SONET or SDH Payloads 5-74
DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads 5-77
DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds 5-79
DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds 5-80
DLP-G95 Set Up External or Line Timing 6-4
DLP-G96 Set Up Internal Timing 6-7
DLP-G99 Create a Provisionable Patchcord 6-11
DLP-G100 Search for Optical Channel Network Connections 7-2
DLP-G101 View Optical Channel Network Connection Information 7-3
DLP-G102 Filter the Display of Optical Channel Network Connections 7-7
DLP-G103 View Optical Channel Network Connections on a Span 7-8
DLP-G104 Assign a Name to a Port 7-10
DLP-G105 Provision DWDM Optical Channel Network Connections 7-10
DLP-G106 Delete Optical Channel Network Connections 7-12
DLP-G76 Provision GCC Terminations 7-14
DLP-G97 Provision a Proxy Tunnel 7-15
DLP-G98 Provision a Firewall Tunnel 7-16
DLP-G107 Create an IP-Encapsulated Tunnel 7-17
DLP-G108 Change the Service State for a Port 7-18
DLP-G109 Provision Orderwire 7-19
DLP-G110 Create a User Data Channel Circuit 7-20
DLP-G111 Repair an IP Tunnel 7-21
DLP-G112 Delete Overhead Circuits 7-22
DLP-G113 Print CTC Data 8-2
DLP-G148 View OTN PM Parameters 9-25
DLP-G149 View Payload Statistics PM Parameters 9-27
DLP-G150 View Payload Utilization PM Parameters 9-28
DLP-G151 View Payload History PM Parameters 9-30
DLP-G152 View Payload SONET PM Parameters 9-31
DLP-G157 Disable Automatic Power Control 10-4
DLP-G158 Enable Automatic Power Control 10-4
DLP-G159 Refresh Automatic Power Control Information 10-5
DLP-G160 Change the Node Name, Date, Time, and Contact Information 10-7
DLP-G161 Change the Login Legal Disclaimer 10-8
DLP-G284 Modify the TARP Operating Parameters 10-10
DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache 10-12
DLP-G286 Remove a Static TID to NSAP Entry from the TARP Data Cache 10-12
DLP-G287 Add a TARP Manual Adjacency Table Entry 10-13
DLP-G292 Remove a TARP Manual Adjacency Table Entry 10-13
DLP-G293 Change the OSI Routing Mode 10-14
DLP-G294 Edit the OSI Router Configuration 10-15
DLP-G295 Edit the OSI Subnetwork Point of Attachment 10-16
DLP-G296 Edit an IP-Over-CLNS Tunnel 10-17
DLP-G297 Delete an IP-Over-CLNS Tunnel 10-18
DLP-G162 Change IP Settings 10-19
DLP-G265 Lock Node Security 10-20
DLP-G266 Modify Backplane Port IP Settings 10-21
DLP-G267 Disable Node Security Mode 10-22
DLP-G163 Modify a Static Route 10-23
DLP-G164 Delete a Static Route 10-24
DLP-G165 Disable OSPF 10-24
DLP-G166 Delete a Proxy Tunnel 10-25
DLP-G167 Delete a Firewall Tunnel 10-25
DLP-G168 Change the Network View Background Color 10-26
DLP-G169 Change the Default Network View Background Map 10-27
DLP-G170 Apply a Custom Network View Background Map 10-28
DLP-G171 Create Domain Icons 10-28
DLP-G172 Manage Domain Icons 10-29
DLP-G173 Enable Dialog Box Do-Not-Display Option 10-30
DLP-G174 Switch Between TDM and DWDM Network Views 10-31
DLP-G175 Modify a Y-Cable Protection Group 10-32
DLP-G176 Modify a Splitter Protection Group 10-33
DLP-G177 Delete a Y-Cable Protection Group 10-33
DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch 10-35
DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch 10-35
DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch 10-36
DLP-G181 Apply a Lock-On 10-37
DLP-G182 Apply a Lockout 10-37
DLP-G183 Clear a Lock-On or Lockout 10-38
DLP-G184 Change a GCC Termination 10-40
DLP-G185 Delete a GCC Termination 10-40
DLP-G186 Delete an OSC Termination 10-41
DLP-G187 Delete a Provisionable Patchcord 10-42
DLP-G188 Change Security Policy for a Single Node 10-46
DLP-G189 Change Security Policy for Multiple Nodes 10-47
DLP-G317 Change Node Access and PM Clearing Privilege 10-49
DLP-G191 Change User Password and Security Level on a Single Node 10-50
DLP-G192 Change User Password and Security Level for Multiple Nodes 10-51
DLP-G193 Delete a User From a Single Node 10-52
DLP-G194 Delete a User From Multiple Nodes 10-52
DLP-G195 Log Out a User on a Single Node 10-53
DLP-G196 Log Out a User on Multiple Nodes 10-54
DLP-G281 Configure the Node for RADIUS Authentication 10-55
DLP-G282 View and Terminate Active Logins 10-57
DLP-G197 Modify SNMP Trap Destinations 10-61
DLP-G198 Delete SNMP Trap Destinations 10-62
DLP-G199 Change the OSCM and OSC-CSM Optical Service Channel Settings 11-2
DLP-G200 Change the OSCM and OSC-CSM Optical Service Channel Thresholds 11-5
DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards 11-6
DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings 11-8
DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings 11-10
DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers 11-12
DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers 11-14
DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers 11-16
DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers  11-18
DLP-G22 Change the OPT-BST ALS Maintenance Settings  11-22
DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards  11-24
DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards  11-26
DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards  11-27
DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards  11-30
DLP-G212 Change Optical Channel Parameters for the 32WSS Card  11-33
DLP-G213 Change the 32WSS Optical Channel Thresholds  11-36
DLP-G214 Change Optical Line Parameters for the 32WSS Card  11-39
DLP-G215 Change the 32WSS Card Optical Line Thresholds  11-40
DLP-G245 Change External Alarms Using the AIC-I Card  11-42
DLP-G246 Change External Controls Using the AIC-I Card  11-43
DLP-G247 Change AIC-I Card Orderwire Settings  11-44
DLP-G254 Place OPT-BST and OPT-PRE Ports Out of Service  12-3
DLP-G318 Place OPT-BST and OPT-PRE Ports In Service  12-4
DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload Software (Windows)  13-5
DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX)  13-7
DLP-G298 View IS-IS Routing Information Base  13-9
DLP-G299 View ES-IS Routing Information Base  13-10
DLP-G300 Manage the TARP Data Cache  13-11
DLP-G250 Reset the TCC2/TCC2P Card  13-12
DLP-G251 Reset DWDM Cards Using CTC  13-13
DLP-G259 Manual or Force Switch the Node Timing Reference  13-18
DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference  13-19
DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes  13-26
DLP-G262 Clean Fiber Connectors with CLETOP  13-27
DLP-G263 Clean the Fiber Adapters  13-27
About this Guide

This section explains the objectives, intended audience, and organization of this publication and describes the conventions that convey instructions and other information.

Note

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path protection feature, which may be used in any topological network configuration. Cisco does not recommend using its path protection feature in any particular topological network configuration.

Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/23/2007</td>
<td>Revision History Table added for the first time</td>
</tr>
<tr>
<td>09/05/2007</td>
<td>Updated About this Guide chapter</td>
</tr>
</tbody>
</table>

This section provides the following information:

- Document Objectives
- Audience
- Document Organization
- Related Documentation
- Document Conventions
- Where to Find Safety and Warning Information
- Obtaining Documentation
- Documentation Feedback
- Cisco Product Security Overview
- Obtaining Technical Assistance
- Obtaining Additional Publications and Information
Document Objectives

This document explains installation, turn up, provisioning, and maintenance for Cisco ONS 15454 dense wavelength division (DWDM) systems. Use this document in conjunction with the appropriate publications listed in the Related Documentation section.

Audience

To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and preferably have experience as a telecommunications technician.

Document Organization

The Cisco ONS 15454 DWDM Installation and Operations Guide, Release 4.7 is organized into the following chapters:

- Chapter 1, “Install the Shelf and Common Control Cards” provides procedures for installing Cisco ONS 15454 ANSI and ETSI shelves and common control cards including the TCC2 and AIC/AIC-I.
- Chapter 2, “Connect the PC and Log into the GUI” includes procedures to install the Cisco Transport Controller (CTC), set up a computer for different connection types, and log into the Cisco ONS 15454.
- Chapter 3, “Turn Up a Node” provides procedures for node turn up and DWDM card installation.
- Chapter 4, “Perform Node Acceptance Tests” provides acceptance tests for each DWDM node type.
- Chapter 5, “Provision Transponder and Muxponder Cards” explains how to change transmission settings and provision pluggable port modules (PPMs) for transponder (TXP) and muxponder (MXP) cards.
- Chapter 6, “Turn Up Network” explains how to turn up and test a DWDM network.
- Chapter 7, “Create Channels and Circuits” explains how to create DWDM optical channel network connections (OCHNCs) and overhead circuits.
- Chapter 8, “Manage Alarms” explains how to document existing node data, view and delete alarms, view alarm-affected circuits and LCD alarm counts, manage alarm profiles, filter alarms, suppress alarms, and provision external alarms.
- Chapter 9, “Monitor Performance” provides procedures to change the performance monitoring (PM) display, monitor performance, and manage remote monitoring (RMON) thresholds.
- Chapter 10, “Manage the Node” explains how to modify node provisioning for the Cisco ONS 15454 and perform common management tasks such as monitoring the DWDM automatic power control and span loss values.
- Chapter 11, “Change DWDM Card Settings” explains how to change line, performance monitoring (PM), and threshold settings on Cisco ONS 15454 cards.
- Chapter 12, “Add and Remove Cards and Nodes” explains how to add and remove DWDM cards and nodes.
- Chapter 13, “Maintain the Node” provides hardware and software maintenance procedures for the Cisco ONS 15454, including procedures for editing, importing, and exporting network element defaults.
- Chapter 14, “Power Down a Node” explains how to shut down an ONS 15454.
- Chapter 15, “Shelf Hardware Reference” includes descriptions of the rack, backplane, FMECs, ferrites, power and ground, fan-tray assembly, air filter, card slots, cables, cable connectors, and cable routing.
- Chapter 16, “Card Reference” provides descriptions of the common control, transponder/muxponder, and DWDM cards as well as small-form factor pluggables (SFPs).
- Chapter 17, “Node Reference” explains the ONS 15454DWDM node types that are available for the ONS 15454. The chapter also explains the DWDM automatic power control, ROADM power equalization, span loss verification, and automatic node setup functions.
- Chapter 18, “Network Reference” explains the ONS 15454 DWDM network applications and topologies.
- Chapter 19, “CTC Operation Reference” includes information about CTC installation, the CTC window, computer requirements, software versions, and database reset and revert.
- Chapter 20, “Security Reference” describes user security, security privileges and policies, the audit trail, and RADIUS authentication.
- Chapter 21, “Timing Reference” describes node and network timing.
- Chapter 22, “Management Connectivity Reference” includes Open System Interconnection (OSI) protocol suites, IP addressing scenarios, and information about provisionable patchcords, open GNE, and external firewalls.
- Appendix A, “CTC Information and Shortcuts” describes the CTC views, menus options, tool options, shortcuts, table display options, and shelf inventory data.
- Appendix B, “Hardware Specifications” contains hardware and software specifications for the ONS 15454 ANSI and ETSI shelf assemblies and cards.
- Appendix C, “DWDM Administrative and Service States” describes the state model for Cisco ONS 15454 DWDM cards, optical payload ports, out-of-band optical supervision channel (OSC) ports, optical channel network connections (OCHNC), and transponder/muxponder cards and ports.
- Appendix D, “Network Element Defaults” describes and lists card, node, and CTC level network element (NE) defaults. To edit, import, or export NE defaults, see Chapter 13, “Maintain the Node.”

Related Documentation

Use the Cisco ONS 15454 DWDM Installation and Operations Guide in conjunction with the following referenced publications:

- Cisco ONS 15454 Troubleshooting Guide, Release 6.0
- Cisco ONS 15454 SDH Troubleshooting Guide, Release 6.0
- Cisco ONS SONET TL1 Command Guide, Release 6.0
- Cisco ONS SONET TL1 Reference Guide, Release 6.0
- Cisco ONS 15454 SDH TL1 Command Guide, Release 6.0
- Cisco ONS 15454 SDH TL1 Reference Guide, Release 6.0
- Release Notes for Cisco ONS 15454 Release 6.0
- Release Notes for Cisco ONS 15454 SDH Release 6.0
# Document Conventions

This publication uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Commands and keywords in body text.</td>
</tr>
<tr>
<td><code>italic</code></td>
<td>Command input that is supplied by the user.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Keywords or arguments that appear within square brackets are optional.</td>
</tr>
<tr>
<td><code>{ x \mid x \mid x }</code></td>
<td>A choice of keywords (represented by x) appears in braces separated by vertical bars. The user must select one.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>The control key. For example, where Ctrl + D is written, hold down the Control key while pressing the D key.</td>
</tr>
<tr>
<td><code>screen font</code></td>
<td>Examples of information displayed on the screen.</td>
</tr>
<tr>
<td>**boldface ** <code>screen font</code></td>
<td>Examples of information that the user must enter.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Command parameters that must be replaced by module-specific codes.</td>
</tr>
</tbody>
</table>

### Note
Means *reader take note*. Notes contain helpful suggestions or references to material not covered in the document.

### Caution
Means *reader be careful*. In this situation, the user might do something that could result in equipment damage or loss of data.
**Warning**

**IMPORTANT SAFETY INSTRUCTIONS**

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with standard practices for preventing accidents. Use the statement number provided at the end of each warning to locate its translation in the translated safety warnings that accompanied this device. Statement 1071

**SAVE THESE INSTRUCTIONS**

**Waarschuwing**

**BELANGRIJKE VEILIGHEIDSINSTRUCTIES**

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij elektrische schakelingen betrokken risico’s en dient u op de hoogte te zijn van de standaard praktijken om ongelukken te voorkomen. Gebruik het nummer van de verklaring onderaan de waarschuwing als u een vertaling van de waarschuwing die bij het apparaat wordt geleverd, wilt raadplegen.

**BEWAAR DEZE INSTRUCTIES**

**Varoitus**

**TÄRKEITÄ TURVALLISUUSOHJEITA**

Tämä varoituserkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia vammoja. Ennen kuin käsittelet laitteistoa, huomioi sähköpiirien käsittelemiseen liittyvät riskit ja tutustu onnettomuuksien yleisiin ehkäisytapoihin. Turvallisuusvaroitusten käänökset löytyvät laitteesteen mukana toimitetuilla käännettynä turvallisuusvaroitusten jokasta varoitusten lopussa näkyvien lausuntonumeroiden avulla.

**SÄILYTÄ NÄMÄ OHJEET**

**Attention**

**IMPORTANTES INFORMATIONS DE SÉCURITÉ**


**CONSERVEZ CES INFORMATIONS**

**Warnung**

**WICHTIGE SICHERHEITSHINWEISE**


**BEWAHREN SIE DIESE HINWEISE GUT AUF.**
Avvertenza  IMPORTANTI ISTRUZIONI SULLA SICUREZZA

Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe causare infortuni alle persone. Prima di intervenire su qualsiasi apparecchiatura, occorre essere al corrente dei pericoli relativi ai circuiti elettrici e conoscere le procedure standard per la prevenzione di incidenti. Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza per individuare le traduzioni delle avvertenze riportate in questo documento.

CONSERVARE QUESTE ISTRUZIONI
About this Guide

Document Conventions

**Figyelem**

**FONTOS BIZTONSÁGI ELOÍRÁSOK**

Ez a figyelemzezo jel veszélyre utal. Sérülésveszélyt rejtó helyzetben van. Mielőtt bármely berendezésen munkát végezte, legyen figyelemmel az elektromos áramkörök okozta kockázatokra, és ismerkedjen meg a szokásos balesetvédelmi eljárásokkal. A kiadványban szereplő figyelemzetezek fordítása a készülékhez mellékel biztonsági figyelemzetekek között található; a fordítás az egyes figyelemzetekek végén látható szám alapján kereshető meg.

**ORIZZE MEG EZEKET AZ UTASÍTÁSOKAT!**

**Предупреждение**

**ВАЖНЫЕ ИНСТРУКЦИИ ПО СОБЛЮДЕНИЮ ТЕХНИКИ БЕЗОПАСНОСТИ**

Этот символ предупреждения обозначает опасность. То есть имеет место ситуация, в которой следует опасаться телесных повреждений. Перед эксплуатацией оборудования выяснив, каким опасностям может подвергаться пользователь при использовании электрических цепей, и ознакомьтесь с правилами техники безопасности для предотвращения возможных несчастных случаев. Воспользуйтесь номером заявления, приведенным в конце каждого предупреждения, чтобы найти его переведенный вариант в переводе предупреждений по безопасности, прилагаемом к данному устройству.

**СОХРАНИТЕ ЭТИ ИНСТРУКЦИИ**

**警告**

**重要的安全性说明**

此警告符号代表危险。您正处于可能受到严重伤害的工作环境中。在您使用设备开始工作之前，必须充分意识到触电的危险，并熟练掌握防止事故发生的标准工作程序。请根据每项警告结尾提供的声明号码来找到此设备的安全性警告说明的翻译文本。

请保存这些安全性说明。

**警告**

**安全上の重要な注意事項**

「危険」の意味です。人身事故を予防するための注意事項が記述されています。装置の取り扱い作業を行うときは、電気回路の危険性に注意し、一般的な事故防止策に留意してください。警告の各国語版は、各注意事項の番号を基に、装置に付属の「Translated Safety Warnings」を参照してください。

これらの注意事項を保管しておいてください。

**주의**

**중요 안전 지침**

이 경고 기호는 위험을 나타냅니다. 작업자가 신체 부상을 입을 수 있는 위험한 환경에 있습니다. 장비에 작업을 수행하기 전에 장비의 위험성을 숙지하고 표준 작업 관례를 숙지하여 사고를 방지하십시오. 각 경고의 마지막 부분에 있는 경고문 번호를 참조하여 이 장치와 함께 제공되는 번역된 안전 경고문에서 해당 번역문을 찾으십시오.

이 지시 사항을 보관하십시오.
Document Conventions

Aviso  INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você se encontra em uma situação em que há risco de lesões corporais. Antes de trabalhar com qualquer equipamento, esteja ciente dos riscos que envolvem os circuitos elétricos e familiarize-se com as práticas padrão de prevenção de acidentes. Use o número da declaração fornecido ao final de cada aviso para localizar sua tradução nos avisos de segurança traduzidos que acompanham o dispositivo.

GUARDE ESTAS INSTRUÇÕES

Advarsel  VIGTIGE SIKKERHEDSANVISNINGER


GEM DISSE ANVISNINGER

Upozorenje  VAŽNE SIGURNOSNE NAPOMENE

Ovaj simbol upozorenja predstavlja opasnost. Nalazite se u situaciji koja može prouzročiti tjelesne ozljede. Prije rada s bilo kojim uređajem, morate razumjeti opasnosti vezane uz električne sklopove, te biti upoznati sa standardnim načinima izbjegavanja nesreća. U prevedenim sigurnosnim upozorenjima, priloženima uz uređaj, možete prema broju koji se nalazi uz pojedino upozorenje pronaći i njegov prijevod.

SAČUVAJTE OVE UPUTE

Upozornění  DŮLEŽITÉ BEZPEČNOSTNÍ POKYNY

Tento upozorňující symbol označuje nebezpečí. Jste v situaci, která by mohla způsobit nebezpečí úrazu. Před prací na jakémkoli vybavení si uvědomte nebezpečí související s elektrickými obvydy a seznáme se se standardními opatřeními pro předcházení úrazům. Podle čísla na konci každého upozornění vyhledejte jeho překlad v přeložených bezpečnostních upozorněních, která jsou přiložena k zařízení.

USCHOVEJTE TYTO POKYNY
About this Guide

ΣΗΜΑΝΤΙΚΕΣ ΟΔΗΓΙΕΣ ΑΣΦΑΛΕΙΑΣ

 automáticamente σύμβολο σημαίνει κίνδυνο. Βρίσκετε σε κατάσταση που μπορεί να προκαλέσει τραυματισμό. Πριν εργασθείτε σε οποιαδήποτε εξοπλισμό, να έχετε υπόψη σας τους κίνδυνους που σχετίζονται με τα ηλεκτρικά κυκλώματα και να έχετε εξοικειωθεί με τις συνήθεις πρακτικές για την αποφυγή ατυχημάτων. Χρησιμοποιήστε τον αριθμό δήλωσης που παρέχεται στο τέλος κάθε προειδοποίησης, για να εντοπίσετε τη μετάφραση της στις μεταφρασμένες προειδοποιήσεις ασφαλείας που συνοδεύουν τη συσκευή.

ΦΥΛΑΞΤΕ ΑΥΤΕΣ ΤΙΣ ΟΔΗΓΙΕΣ

hoarotk pointing shosvat

Στοιχεία Σπάνια βέβαια δεν είναι η κατάσταση. Αυτό το σύμβολο σημαίνει κίνδυνο. Βρίσκετε σε κατάσταση που μπορεί να προκαλέσει τραυματισμό. Πριν εργασθείτε σε οποιαδήποτε εξοπλισμό, να έχετε υπόψη σας τους κίνδυνους που σχετίζονται με τα ηλεκτρικά κυκλώματα και να έχετε εξοικειωθεί με τις συνήθεις πρακτικές για την αποφυγή ατυχημάτων. Χρησιμοποιήστε τον αριθμό δήλωσης που παρέχεται στο τέλος κάθε προειδοποίησης, για να εντοπίσετε τη μετάφραση της στις μεταφρασμένες προειδοποιήσεις ασφαλείας που συνοδεύουν τη συσκευή.

Opmoena

WAŻNI BEZBEDNOSNI NAPASTVIJA

Symbol to przedupredvaše znací nenasnost. Se naogate so situacija, kjer je mogoče po predizvika teleni povredit. Preda radite so opremo, bidevate svesi z rizikotv, ki postoi kaj elektricnikih kol in treba v poznate standardne postopki za sprehvaže na nesrečni slajch. Iskoristite to goroj na isajavato, kot se naogajo na kraj na sekoj predupredvava, da je najdete nigeriot period vo prevoditele bezbednosi predupredvavno, da se isporoči so urodd. ČUVAJTE GYK OMILE NAPASTVIJA

Ostrzenie

WAŻNE INSTRUKCJE DOTYCZĄCE BEZPIECZEŃSTWA

Ten symbol ostrzenia oznacza niebezpieczeństwo. Zachodzi sytuacja, która może powodować obrażenia ciała. Przed przystąpieniem do praca przy urządzeniach należy zapoznać się z zagrożeniami związanymi z układami elektrycznymi oraz ze standardowymi środkami zapobiegania wypadkom. Na końcu każdego ostrzenia podano numer, na podstawie którego można odszukać tłumaczenie tego ostrzenia w dołączonym do urządzenia dokumentacji z tłumaczeniami ostrzeżeń.

NINIEJSZE INSTRUKCJE NALEŻY ZACHOWAĆ

Upozornenie

DÔLEŽITÉ BEZPEČNOSTNÉ POKYNY

Tento varovný symbol označuje nebezpečenstvo. Nachádzáte sa v situácii s nebezpečenstvom úrazu. Pred prácou na akomkoľvek vybavení si uvedomte nebezpečenstvo súvisiace s elektrickými obvodmi a oboznámte sa so štandardnými opatreniami na predchádzanie úrazom. Podľa číslu na konci každého upozornenia vyhľadajte jeho preklad v preložených bezpečnostných upozorneniach, ktoré sú priložené k zariadeniu.

USCHOVAJTE SI TENTO NÁVOD
Where to Find Safety and Warning Information

For safety and warning information, refer to the Cisco Optical Transport Products Safety and Compliance Information document that accompanied the product. This publication describes the international agency compliance and safety information for the Cisco ONS 15xxx systems. It also includes translations of the safety warnings that appear in the ONS 15xxx system documentation.

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several ways to obtain technical assistance and other technical resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport
You can access the Cisco website at this URL:
http://www.cisco.com
You can access international Cisco websites at this URL:

Product Documentation DVD

Cisco documentation and additional literature are available in the Product Documentation DVD package, which may have shipped with your product. The Product Documentation DVD is updated regularly and may be more current than printed documentation.

The Product Documentation DVD is a comprehensive library of technical product documentation on portable media. The DVD enables you to access multiple versions of hardware and software installation, configuration, and command guides for Cisco products and to view technical documentation in HTML. With the DVD, you have access to the same documentation that is found on the Cisco website without being connected to the Internet. Certain products also have .pdf versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com users (Cisco direct customers) can order a Product Documentation DVD (product number DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace.

Cisco Ordering tool:
Cisco Marketplace:
http://www.cisco.com/go/marketplace/
Cisco Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is available in a CD-ROM package that ships with your product. The Optical Networking Product Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Ordering Documentation

Beginning June 30, 2005, registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Cisco will continue to support documentation orders using the Ordering tool:

- Registered Cisco.com users (Cisco direct customers) can order documentation from the Ordering tool:
- Instructions for ordering documentation using the Ordering tool are at this URL:
- Nonregistered Cisco.com users can order documentation through a local account representative by calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in North America, by calling 1 800 553-NETS (6387).

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by completing the online feedback form that appears with the technical documents on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

About this Guide

Obtaining Technical Assistance

From this site, you can perform these tasks:

- Report security vulnerabilities in Cisco products.
- Obtain assistance with security incidents that involve Cisco products.
- Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:


Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally before we release them, and we strive to correct all vulnerabilities quickly. If you think that you might have identified a vulnerability in a Cisco product, contact PSIRT:

- Emergencies—security-alert@cisco.com
  An emergency is either a condition in which a system is under active attack or a condition for which a severe and urgent security vulnerability should be reported. All other conditions are considered nonemergencies.
- Nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

- 1 877 228-7302
- 1 408 525-6532

Tip

We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive information that you send to Cisco. PSIRT can work from encrypted information that is compatible with PGP versions 2.x through 8.x.

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page at this URL:


The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco Technical Support & Documentation website on Cisco.com features extensive online support resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact your reseller.
Cisco Technical Support & Documentation Website

The Cisco Technical Support & Documentation website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:


**Note**

Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & Documentation website by clicking the **Tools & Resources** link under Documentation & Tools. Choose **Cisco Product Identification Tool** from the Alphabetical Index drop-down list, or click the **Cisco Product Identification Tool** link under Alerts & RMAs. The CPI tool offers three search options: by product ID or model name; by tree view; or for certain products, by copying and pasting `show` command output. Search results show an illustration of your product with the serial number label location highlighted. Locate the serial number label on your product and record the information before placing a service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool provides recommended solutions. If your issue is not resolved using the recommended resources, your service request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.
Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your business operation are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL:
  http://www.cisco.com/go/marketplace/
- Cisco Press publishes a wide range of general networking, training and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL:
  http://www.ciscopress.com
- Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and networking investments. Each quarter, Packet delivers coverage of the latest industry trends, technology breakthroughs, and Cisco products and solutions, as well as network deployment and troubleshooting tips, configuration examples, customer case studies, certification and training information, and links to scores of in-depth online resources. You can access Packet magazine at this URL:
  http://www.cisco.com/packet
- iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies learn how they can use technology to increase revenue, streamline their business, and expand services. The publication identifies the challenges facing these companies and the technologies to help solve them, using real-world case studies and business strategies to help readers make sound technology investment decisions. You can access iQ Magazine at this URL:
  http://www.cisco.com/go/iqmagazine
  or view the digital edition at this URL:
  http://ciscoiq.texterity.com/ciscoiq/sample/
- Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the Internet Protocol Journal at this URL:
  http://www.cisco.com/ipj
- Networking products offered by Cisco Systems, as well as customer support services, can be obtained at this URL:
• Networking Professionals Connection is an interactive website for networking professionals to share questions, suggestions, and information about networking products and technologies with Cisco experts and other networking professionals. Join a discussion at this URL:
  http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view current offerings at this URL:
Install the Shelf and Common Control Cards

This chapter explains how to install the Cisco ONS 15454 ETSI and Cisco ONS 15454 ANSI shelf assemblies. Where procedures differ for the two shelf types, the procedure will indicate “ANSI only” or “ETSI only.” For a summary of the tools and equipment required for installation, see the “Required Tools and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” section on page 1-3.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). Read the installation procedures and precautions before you install the ONS 15454 ANSI or ONS 15454 ETSI and connect the power source.

1. NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6—Complete this procedure before continuing with the “NTP-G2 Install the Shelf Assembly” procedure on page 1-8.
2. NTP-G2 Install the Shelf Assembly, page 1-8—Complete this procedure to install the shelf assembly in a rack.
3. NTP-G3 Open and Remove the Front Door, page 1-20—Complete this procedure to access the equipment before continuing with other procedures in this chapter.
4. NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23—Complete this procedure to access the electrical facility connection assembly (EFCA) for the front mount electrical connections (FMECs) before continuing with other procedures in this chapter.
5. NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26—Complete this procedure to access the backplane before continuing with other procedures.
6. NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28—Complete this procedure to install the MIC-A/P and MIC-T/C/P FMECs, which are required for power supply as well as alarm, timing, and LAN connections.
7. NTP-G7 Install the Power and Ground, page 1-30—Complete this procedure before continuing with the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.
8. NTP-G8 Install the Fan-Tray Assembly, page 1-40—Complete this procedure to install the fan-tray assembly in the shelf.
9. **NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44**—Complete this procedure if you are planning to install the Alarm Interface Controller–International (AIC-I) card and want to increase the number of alarm contacts provided by the AIC-I card.


11. **NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-58**—Complete this procedure to connect an external wire-wrap panel to the alarm expansion panel (AEP).

12. **NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-63**—Complete this procedure to install the FMEC cover.

13. **NTP-G13 Install the Rear Cover (ANSI Only), page 1-64**—Complete this procedure as needed to install the rear cover after you have finished servicing the backplane.


15. **NTP-G15 Install the Common Control Cards, page 1-71**—Complete this procedure to install the TCC2/TCC2P card and the AIC-I card.

16. **NTP-G16 Perform the Shelf Installation Acceptance Test, page 1-76**—Complete this procedure to determine if you have correctly completed all other procedures in the chapter.

---

**Warning**

Installation of the equipment must comply with local and national electrical codes. Statement 1074

Warning

This equipment must be installed and maintained by service personnel as defined by AS/NZS 3260. Incorrectly connecting this equipment to a general-purpose outlet could be hazardous. The telecommunications lines must be disconnected 1) before unplugging the main power connector or 2) while the housing is open, or both. Statement 1043

Warning

This unit is intended for installation in restricted access areas. A restricted access area can be accessed only through the use of a special tool, lock and key, or other means of security. Statement 1017

Warning

Ultimate disposal of this product should be handled according to all national laws and regulations. Statement 1040

Warning

A readily accessible two-poled disconnect device must be incorporated in the fixed wiring. Statement 1022

**Note**

The ONS 15454 is suitable for mounting on concrete or other noncombustible surfaces only.

**Note**

In this chapter, “shelf assembly” refers to the steel enclosure that holds cards and connects power, and “node” refers to the entire hardware and software system.
Required Tools and Equipment (ANSI)

You need the following tools and equipment to install and test the ONS 15454 ANSI shelf assembly.

Cisco-Supplied Materials (ANSI)

The following materials are required and are shipped with the ONS 15454 ANSI shelf (wrapped in plastic). The number in parentheses gives the quantity of the item included in the package.

- #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX) (8)
- #12-24 x 3/4 socket set screws (48-1003-XX) (2)
- T-handle #12-24 hex tool for set screws (1)
- ESD wrist strap with 1.8 m (6 ft) coil cable (1)
- Tie wraps (10)
- Pinned hex (Allen) key for front door (1)
- Spacers (50-1193-XX) (4)
- Spacer mounting brackets (2)
- Sheet metal backplane cover (installed) (1)
- External (bottom) brackets for the fan-tray air filter
- Standoff kit (53-0795-XX):
  - Plastic fiber management guides (2)
  - Fan filter bracket screws (53-48-0003) (6)

User-Supplied Materials (ANSI)

The following materials and tools are required but are not supplied with the ONS 15454 ANSI:

- One or more of the following equipment racks:
  - 19-inch ANSI Standard (Telcordia GR-63-CORE) (482.6 mm) rack; total width 22 inches (558.8 mm)
  - 23-inch ANSI Standard (Telcordia GR-63-CORE) (584.2 mm) rack; total width 26 inches (660.4 mm)
- Fuse panel
- Power cable (from fuse and alarm panel to assembly), #10AWG, copper conductors, 194 degrees Fahrenheit (90 degrees Celsius)
- Ground cable #6AWG stranded
- Alarm cable pairs for all alarm connections, #22 or #24 AWG (0.51 mm² or 0.64 mm²), solid tinned
- 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair T1-type
- Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical (OC-N) cards
- Shielded coaxial cable terminated with SMB or BNC connectors for DS-3 cards
**Required Tools and Equipment (ETSI)**

- Shielded ABAM cable terminated with AMP Champ connectors or unterminated for DS1N-14 cards with #22 or #24 AWG (0.51 mm² or 0.64 mm²) ground wire (typically about two ft [61 cm] in length)
- 6-pair #29 AWG double-shielded cable
- Tie wraps and/or lacing cord
- Labels
- Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for #10 AWG copper conductors

**Tools Needed (ANSI)**

The following tools are needed to install an ONS 15454 ANSI:

- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Wire wrapper
- Wire cutters
- Wire strippers
- Crimp tool
- BNC insertion tool

**Test Equipment (ANSI)**

The following test equipment is needed to install an ONS 15454:

- Voltmeter
- Optical power meter (for use with fiber optics only)
- BER tester, DS-1 and DS-3

**Required Tools and Equipment (ETSI)**

You need the following tools and equipment to install and test the ONS 15454 ETSI shelf assembly.

**Cisco-Supplied Equipment (ETSI)**

These materials are required for installation and are supplied with the ONS 15454 ETSI. The shipped quantity of each item is in parentheses.

- Double-hole grounding lug for ground connection with a wire receptacle to accommodate the recommended 13.3 mm² (#6 AWG) multistrand copper wire (1)
- M4 x 8 mm pan-head Phillips screws (2)
- M6 x 20 mm socket set screws (2)
- M6 x 20 mm pan-head Phillips screws (8)
- Tie wraps 0.125-inch (3.2 mm) W x 6.0-inch (152 mm) L (24)
Required Tools and Equipment (ETSI)

- ESD wrist strap (disposable) (1)
- Pinned Allen key for front door (1)
- Hex key 3-mm long arm (1)
- Bottom brackets for the fan-tray air filter
- Cable assembly, Ethernet, RJ-45 (1)
- Power cable (from fuse and alarm panel to MIC-A/P and MIC-C/T/P) (2)

Caution
Only use the power cables that are designed to be used with ONS 15454 ETSI. They are sold separately.

User-Supplied Equipment (ETSI)

The following materials and tools are required for installation but are not supplied with the ONS 15454 ETSI:

- Equipment rack (ETSI rack, 2200 mm [86.6 inch] H x 600 mm [23.6 inch] W x 300 mm [11.8 inch] D)
- Fuse and alarm panel
- Copper ground cable 13.3-mm² (#6 AWG) stranded, specified for up to 90 degrees Celsius (194 degrees Fahrenheit)
- Alarm cable pairs for all alarm connections, 0.51 mm² or 0.64 mm² (#22 or #24 AWG), solid-tinned
- Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical cards
- Coaxial cable terminated with 1.0/2.3 miniature coax connectors for FMEC cards
- DB-37 cable
- Shielded building integrated timing supply (BITS) clock coaxial cable terminated with 1.0/2.3 miniature coax connectors
- Labels

Note
Ring runs are not provided by Cisco and can hinder side-by-side shelf installation where space is limited.

Tools Needed (ETSI)

To install the ONS 15454 ETSI, you need the following tools.

- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Video fiber connector inspection instrument
- CLETOP cleaning cassette
- Crimping tool—This tool must be large enough to accommodate the girth of the grounding lug when you crimp the grounding cable into the lug.
- Wire stripping tool
To install the ONS 15454 ETSI, you need the following test equipment.

- Voltmeter
- Power meter (only for use with fiber optics)
- Bit error rate (BER) tester for E1-N-14, E1-42, E3-12, DS3i-N-12, STM1E-12, and FMEC cards

**NTP-G1 Unpack and Inspect the Shelf Assembly**

**Purpose**
This procedure explains how to unpack the ONS 15454 shelf assemblies and verify their contents.

**Tools/Equipment**
Pinned hex (Allen) key for front door

**Prerequisite Procedures**
None

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

**Step 1**
Complete the “DLP-G1 Unpack and Verify the Shelf Assembly” task on page 1-6.

**Step 2**
Complete the “DLP-G2 Inspect the Shelf Assembly” task on page 1-7.

**Step 3**
Continue with the “NTP-G1 Unpack and Inspect the Shelf Assembly” procedure on page 1-6.

Stop. You have completed this procedure.

**DLP-G1 Unpack and Verify the Shelf Assembly**

**Purpose**
This task removes the shelf assembly from the package.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

**Step 1**
When you receive the ONS 15454 system equipment at the installation site, open the top of the box. The Cisco Systems logo designates the top of the box.

**Step 2**
Remove the foam inserts from the box. The box contains the ONS 15454 shelf (wrapped in plastic) and a smaller box of items needed for installation.

**Step 3**
To remove the shelf, grasp both rings of the shelf removal strap and slowly lift the shelf out of the box.

**Step 4**
Open the smaller box of installation materials, and verify that you have all items listed in the “Required Tools and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” section on page 1-3.
DLP-G2 Inspect the Shelf Assembly

Purpose
This task verifies that all parts of the shelf assembly are in good condition.

Tools/Equipment
Pinned hex (Allen) key for front door

Prerequisite Procedures
DLP-G1 Unpack and Verify the Shelf Assembly, page 1-6

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

Step 1
Open the shelf using the pinned hex key. For more information, see the “DLP-G9 Open the Front Cabinet Compartment (Door)” task on page 1-20.

Step 2
Verify the following:
• The pins are not bent or broken.
• The frame is not bent.

Step 3
If the pins are bent or broken, or the frame is bent, call your Cisco sales engineer for a replacement.

Step 4
Close the front door before installing.

Step 5
Return to your originating procedure (NTP).
NTP-G2 Install the Shelf Assembly

Purpose
This procedure reverses the mounting bracket and mounts shelf assemblies in a rack.

Tools/Equipment
#2 Phillips screwdriver
Medium slot-head screwdriver
Small slot-head screwdriver
Pinned hex tool

ETSI only:
Two M6 x 20 socket set screws
Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:
Two #12-24 x 3/4 set screws (48-1003-XX)
Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX)

Prerequisite Procedures
NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

Warning
Stability hazard. The rack stabilizing mechanism must be in place, or the rack must be bolted to the floor before you slide the unit out for servicing. Failure to stabilize the rack can cause the rack to tip over. Statement 1048

Warning
This product requires short-circuit (overcurrent) protection, to be provided as part of the building installation. Install only in accordance with national and local wiring regulations. Statement 1045

Warning
To prevent the system from overheating, do not operate it in an area that exceeds the maximum recommended ambient temperature of: 45°C (113°F). Statement 1047

Warning
Take care when connecting units to the supply circuit so that wiring is not overloaded. Statement 1018
Warning To prevent bodily injury when mounting or servicing this unit in a rack, you must take special precautions to ensure that the system remains stable. The following guidelines are provided to ensure your safety:

- This unit should be mounted at the bottom of the rack if it is the only unit in the rack.
- When mounting this unit in a partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack.
- If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.

Statement 1006

Warning To prevent airflow restriction, allow at least 1 inch (25.4 mm) of clearance around the ventilation openings.

Warning The ONS 15454 must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to allow airflow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) provides this spacing and should not be modified in any way.

Note The shelf, the air ramp, and the E1-75/120 conversion panel ship with the ETSI mounting brackets installed as needed for installation in an ETSI rack. If you want to install the node in a 19-inch (482.6-mm) rack, the ETSI mounting brackets of the shelf and the air ramp need to be replaced with the 19-inch (482.6-mm) mounting brackets that shipped in the ship kit.

Step 1 (ANSI shelves only.) Complete the “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 if you need to convert from a 23-inch (584.2 mm) to a 19-inch (482.6 mm) rack.

Step 2 (ANSI shelves only.) To install the air filter on the bottom of the shelf rather than below the fan-tray assembly, complete the “DLP-G4 Install the External Brackets and Air Filter (ANSI Only)” task on page 1-11.

Step 3 Complete the necessary rack mount task as applicable:

- DLP-G5 Mount the Shelf Assembly in a Rack (One Person), page 1-13
- DLP-G6 Mount the Shelf Assembly in a Rack (Two People), page 1-15
- DLP-G7 Mount Multiple Shelf Assemblies in a Rack, page 1-16
- DLP-G8 Install the Air Ramp, page 1-19

Step 4 Continue with the “NTP-G3 Open and Remove the Front Door” procedure on page 1-20.

Stop. You have completed this procedure.
DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)

Purpose
This task installs the mounting bracket to convert a 23-inch (584.2 mm) rack to a 19-inch (482.6-mm) rack. This task applies to ONS 15454 ANSI shelves only.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Caution
Use only the fastening hardware provided with the ONS 15454 ANSI to prevent loosening, deterioration, and electromechanical corrosion of the hardware and joined material.

Caution
When mounting the ONS 15454 in a frame with a nonconductive coating (such as paint, lacquer, or enamel) either use the thread-forming screws provided with the ONS 15454 ANSI ship kit, or remove the coating from the threads to ensure electrical continuity.

Step 1
Remove the screws that attach the mounting bracket to the side of the shelf assembly.

Step 2
Flip the detached mounting bracket upside down.
Text imprinted on the mounting bracket will now also be upside down.

Step 3
Place the widest side of the mounting bracket flush against the shelf assembly (see Figure 1-1). The narrow side of the mounting bracket should be towards the front of the shelf assembly. Text imprinted on the mounting bracket should be visible and upside down.

Step 4
Align the mounting bracket screw holes against the shelf assembly screw holes.

Step 5
Insert the screws that were removed in Step 1 and tighten them.

Step 6
Repeat the task for the mounting bracket on the opposite side.
Step 7    Return to your originating procedure (NTP).

DLP-G4 Install the External Brackets and Air Filter (ANSI Only)

Purpose     This task installs the external brackets and air filter on the bottom of the shelf rather than below the fan-tray assembly. Installing the external brackets and air filter on the bottom of the shelf enables access to the air filter without removing the fan-tray assembly. This task applies to the ONS 15454 ANSI shelf only.

Tools/Equipment     #2 Phillips screwdriver
                       Medium slot-head screwdriver
                       Small slot-head screwdriver

Prerequisite Procedures     DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only), page 1-10, if applicable

Required/As Needed     As needed

Onsite/Remote     Onsite

Security Level     None

Note     If you choose not to install the brackets, install the air filter by sliding it into the compartment at the bottom of the shelf assembly. Each time you remove and reinstall the air filter in the future, you must first remove the fan-tray assembly. Do not install an air filter in both filter locations on any shelf assembly.
Step 1  With the fan-tray assembly removed, place the ONS 15454 facedown on a flat surface.

Note Although the filter will work if it is installed with either side facing up, Cisco recommends that you install it with the metal bracing facing up to preserve the surface of the filter.

Step 2  Locate the three screw holes that run along the left and right sides of the bottom of the shelf assembly.

Step 3  Secure each bracket to the bottom of the shelf assembly using the screws (48-0003) provided in the backplane standoff kit (53-0795-XX).

Each bracket has a filter stopper and a flange on one end. Make sure to attach the brackets with the stoppers and flanges facing the rear of the shelf assembly (the top, if the ONS 15454 is facedown during installation).

Figure 1-2 illustrates bottom bracket installation. If you do not use the brackets, in the future you must remove the fan-tray assembly before removing the air filter. The brackets enable you to clean and replace the air filter without removing the fan-tray assembly.

Figure 1-2  Installing the External Brackets

Step 4  Slide the air filter into the shelf assembly.

Step 5  Return to your originating procedure (NTP).
DLP-G5 Mount the Shelf Assembly in a Rack (One Person)

Purpose: This task allows one person to mount the shelf assembly in a rack.

Tools/Equipment:
- Pinned hex tool
- # 2 Phillips screwdriver
- ETSI only:
  - Two M6 x 20 socket set screws
  - Eight M6 x 20 pan-head Phillips mounting screws
- ANSI only:
  - Two #12-24 x 3/4 set screws (48-1003-XX)
  - Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX)

Prerequisite Procedures: NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed: As needed

Onsite/Remote: Onsite

Security Level: None

Note: The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm (1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in the rack.

Step 1: Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and alarm panel is not present, you must install one according to manufacturer instructions:
- (ETSI only) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.
- (ANSI only) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) is required.
- (ANSI only) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf minimum) is required.

Step 2: Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches [482.6 mm]).
Figure 1-3 shows the rack-mounting position for the ONS 15454 ETSI.

**Figure 1-3  **Mounting an ONS 15454 ETSI in a Rack

---

**Step 3** Using the hex tool that shipped with the assembly, install the two temporary set screws into the holes that will not be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting brackets.

**Step 4** Lift the shelf assembly to the desired position in the rack and set it on the screws.

**Step 5** Align the screw holes on the mounting brackets with the mounting holes in the rack.

**Step 6** Using the Phillips screwdriver, install one mounting screw in each side of the assembly.

**Step 7** When the shelf assembly is secured to the rack, install the remaining mounting screws.

---

**Note** Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

**Step 8** Using the hex tool, remove the temporary set screws.

**Step 9** Return to your originating procedure (NTP).
DLP-G6 Mount the Shelf Assembly in a Rack (Two People)

Purpose
This task allows two people to mount the shelf assembly in a rack.

Tools/Equipment
- Pinned hex tool
- #2 Phillips screwdriver
- ETSI only:
  - Two M6 x 20 socket set screws
  - Eight M6 x 20 pan-head Phillips mounting screws
- ANSI only:
  - Two #12-24 x 3/4 set screws (48-1003-XX)
  - Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX)

Prerequisite Procedures
- NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm (1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in the rack.

Note
The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment must not vent heat upward into the ONS 15454.

Step 1
Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and alarm panel is not present, you must install one according to manufacturer’s instructions:
- (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.
- (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) is required.
- (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf minimum) is required.

Step 2
Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches [482.6 mm]).

Step 3
Using the hex tool that shipped with the assembly, install the two set screws into the holes that will not be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting brackets.
DLP-G7 Mount Multiple Shelf Assemblies in a Rack

Step 4 Lift the shelf assembly to the desired position in the rack.
Step 5 Align the screw holes on the mounting brackets with the mounting holes in the rack.
Step 6 Have one person hold the shelf assembly in place while the other person uses the Phillips screwdriver to install one mounting screw in each side of the assembly.
Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws.

Note Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

Step 8 Use the hex tool to remove the temporary set screws.
Step 9 Return to your originating procedure (NTP).

Purpose This task installs multiple shelves in a rack.
Tools/Equipment Pinned hex tool
#2 Phillips screwdriver
ETSI only:
Two M6 x 20 socket set screws (per shelf)
Eight M6 x 20 pan-head Phillips mounting screws (per shelf)
ANSI only:
Two #12-24 x 3/4 set screws (48-1003-XX) (per shelf)
Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX) (per shelf)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6
Required/As Needed As needed
Onsite/Remote Onsite
Security Level None

Note A standard ETSI rack can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm (1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space for air flow. When using third-party equipment above the ONS 15454 ETSI, provide a minimum of 25 mm (1 inch) between the third-party unit and the bottom of the ONS 15454 ETSI. The third-party equipment must not vent heat upward into the ONS 15454 ETSI.
The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment must not vent heat upward into the ONS 15454.

Step 1  Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and alarm panel is not present, you must install one according to manufacturer’s instructions:

- (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.
- (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) is required.
- (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf minimum) is required.

Step 2  Mount the first shelf assembly in the bottom of the rack using the “DLP-G5 Mount the Shelf Assembly in a Rack (One Person)” task on page 1-13 or the “DLP-G6 Mount the Shelf Assembly in a Rack (Two People)” task on page 1-15.
Figure 1-4 shows a three-shelf ONS 15454 ETSI bay assembly.

**Figure 1-4** Three-Shelf ONS 15454 ETSI (15454 SDH) Bay Assembly

---

**Step 3** (ETSI only.) Mount the air ramp above the ONS 15454 ETSI.

The air ramp is needed if you install more than one ONS 15454 ETSI shelf in a rack. To ensure that the air ramp is secure, use one or two M6 mounting screws for each side of the shelf assembly. **Figure 1-5** shows how to mount an air ramp in the rack.
DLP-G8 Install the Air Ramp

Purpose
Use this task to install the air ramp.

Tools/Equipment
#2 Phillips screwdriver

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
The air ramp requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the RMU space specified in your site plan. See the “15.5 Typical DWDM Rack Layouts” section on page 15-17 for more information about air ramp placement.

Step 2
Verify that the mounting brackets attached to the unit are correct for your rack size. Complete the “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as required.
Step 3  Align the chassis with the rack mounting screw holes; insert and tighten the four screws.

Step 4  Return to your originating procedure (NTP).

---

**NTP-G3 Open and Remove the Front Door**

**Purpose**
This procedure opens and removes the front door to access the equipment.

**Tools/Equipment**
Open-end wrench
Pinned hex (Allen) key

**Prerequisite Procedures**
NTP-G2 Install the Shelf Assembly, page 1-8

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

---

Step 1  Complete the “DLP-G9 Open the Front Cabinet Compartment (Door)” task on page 1-20.

Step 2  Complete the “DLP-G10 Remove the Front Door” task on page 1-21.

Step 3  If you are using an ETSI shelf, continue with the “NTP-G4 Open and Remove the FMEC Cover (ETSI Only)” procedure on page 1-23. If you are using an ANSI shelf, continue with the “NTP-G5 Remove the Backplane Covers (ANSI Only)” procedure on page 1-26.

Stop. You have completed this procedure.

---

**DLP-G9 Open the Front Cabinet Compartment (Door)**

**Purpose**
This task opens the front door.

**Tools/Equipment**
Pinned hex (Allen) key

**Prerequisite Procedures**
NTP-G2 Install the Shelf Assembly, page 1-8

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Note**
The ONS 15454 shelf assembly has an ESD plug input and is shipped with an ESD wrist strap. The ESD plug input is located on the outside of the shelf assembly on the right side. It is labeled “ESD” on the top and bottom. Always wear an ESD wrist strap and connect the strap to the ESD plug when working on the ONS 15454.

---

Step 1  Open the front door lock.

The ONS 15454 shelf assembly comes with a pinned hex key for locking and unlocking the front door. Turn the key counterclockwise to unlock the door and clockwise to lock it. Figure 1-6 illustrates the front door of the ANSI shelf.
Step 2  
Press the door button to release the latch. A button on the right side of the shelf assembly releases the door.

Step 3  
Swing the door open.

Step 4  
Return to your originating procedure (NTP).

**DLP-G10 Remove the Front Door**

**Purpose**
This task removes the front cabinet compartment door.

**Tools/Equipment**
Open-end wrench

**Prerequisite Procedures**
DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

**Step 1**  
For ONS 15454 ETSI shelves:

- Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer.
b. Remove the ground wire from the shelf.

c. Hold the door at the top left corner and remove the door from its hinges (Figure 1-7).

*Figure 1-7 Removing the ONS 15454 ETSI Front Door*

---

**Step 2** For ONS 15454 ANSI shelves:

a. To remove the door ground strap, perform the following:
   
   - To detach the ground strap from the front door, loosen the #6 Kepnut (49-0600-01) using the open-end wrench. Detach the end of the ground strap terminal lug (72-3622-01) from the male stud on the inside of the door.
   
   - To detach the other end of the ground strap from the longer screw on the fiber guide, loosen the #4 Kepnut (49-0337-01) on the terminal lug using the open-end wrench. Remove the terminal lug and lock washer.

b. Lift the door from its hinges at the top left corner of the door (Figure 1-8).
NTP-G4 Open and Remove the FMEC Cover (ETSI Only)

**Purpose**
This procedure opens and removes the FMEC cover on the ONS 15454 ETSI. The ONS 15454 ETSI has a screw-in panel over the EFCA. The FMEC cover protects the FMEC cards.

**Tools/Equipment**
Medium slot-head screwdriver

**Prerequisite Procedures**
NTP-G2 Install the Shelf Assembly, page 1-8

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Step 1**
Complete the “DLP-G11 Open the FMEC Cover” task on page 1-24.

**Step 2**
Complete the “DLP-G12 Remove the FMEC Cover” task on page 1-25.

---

Figure 1-8   Removing the ONS 15454 ANSI Front Door
DLP-G11 Open the FMEC Cover

Purpose

This task opens the FMEC cover. The FMEC cover must be opened to install the MIC-A/P and the MIC-C/T/P.

Tools/Equipment

Medium slot-head screwdriver

Prerequisite Procedures

DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None

Step 1

Unscrew the screws on the FMEC cover (Figure 1-9).

Figure 1-9 Unscrewing the FMEC Cover

Step 2

Use the handles to pull the cover forward.

Step 3

Return to your originating procedure (NTP).

Step 3

Continue with the “NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)” procedure on page 1-28.

Stop. You have completed this procedure.
DLP-G12 Remove the FMEC Cover

Purpose
This task removes the FMEC cover in order to install the MIC-A/P and the MIC-C/T/P.

Tools/Equipment
Medium slot-head screwdriver

Prerequisite Procedures
DLP-G11 Open the FMEC Cover, page 1-24

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer.

Step 2
Remove the ground wire from the left side of the shelf.

Step 3
Pull the right side of the hinge-locking spring (Figure 1-10).

Figure 1-10 Removing the ONS 15454 FMEC Cover

Step 4
Detach the cover from the pin of the hinge.

Step 5
Remove the cover carefully from the left pin of the hinge.

Step 6
Return to your originating procedure (NTP).
NTP-G5 Remove the Backplane Covers (ANSI Only)

Purpose
This procedure describes how to access the ONS 15454 ANSI backplane by removing the covers. The backplane has two sheet metal covers (one on either side) and a lower backplane cover at the bottom.

Tools/Equipment
#2 Phillips screwdriver
Medium slot-head screwdriver
Small slot-head screwdriver

Prerequisite Procedures
NTP-G2 Install the Shelf Assembly, page 1-8
NTP-G3 Open and Remove the Front Door, page 1-20

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

---

Step 1
Complete the “DLP-G13 Remove the Lower Backplane Cover” task on page 1-26.

Step 2
Complete the “DLP-G14 Remove the Backplane Sheet Metal Cover” task on page 1-27.

Step 3
Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure.

DLP-G13 Remove the Lower Backplane Cover

Purpose
This task removes the lower backplane cover of the ONS 15454 ANSI shelf assembly.

Tools/Equipment
#2 Phillips screwdriver
Medium slot-head screwdriver
Small slot-head screwdriver

Prerequisite Procedures
None

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

---

Step 1
Unscrew the five retaining screws that hold the cover in place (Figure 1-11).
DLP-G14 Remove the Backplane Sheet Metal Cover

Purpose
This task removes the backplane sheet metal cover that is installed on the rear of the 15454 ANSI shelf.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

Prerequisite Procedures
DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

Step 1
To remove the backplane sheet metal cover, loosen the five screws that secure it to the ONS 15454 ANSI shelf and pull it away from the shelf assembly (Figure 1-11 on page 1-27).

Step 2
Loosen the nine perimeter screws that hold the backplane sheet metal cover(s) in place.

Step 3
Lift the panel by the bottom to remove it from the shelf assembly.
NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)

Purpose
This procedure installs the MIC-A/P and the MIC-T/C/P, which are a type of FMEC installed in the EFCA. The EFCA is located at the top of the ONS 15454 ETSI shelf. It provides connection for installing power, external alarms, timing input and output, and craft interface terminals. This procedure applies to the ETSI shelf only.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- FMEC cards (the MIC-A/P and MIC-T/C/P)

Prerequisite Procedures
NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed
- Required

Onsite/Remote
- Onsite

Security Level
- None

Caution
Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Warning
Voltage is present on the backplane when the system is operating. To reduce risk of an electric shock, keep hands and fingers out of the power supply bays and backplane areas. Statement 166

Note
The ONS 15454 ETSI EFCA has 12 FMEC slots numbered sequentially from left to right beginning with Slot 18. Slots 18 to 22 and 25 to 29 provide electrical connections for the corresponding slots, so they are unnecessary in dense wave division multiplexing (DWDM) applications.

Step 1
Ensure you are installing the FMECs in the correct slot:
- FMEC Slot 23 supports the MIC-A/P.
  The MIC-A/P card provides connection for the BATTERY B input, one of the two possible redundant power supply inputs. It also provides connection for eight alarm outputs (coming from the TCC2/TCC2P card), sixteen alarm inputs, and four configurable alarm inputs/outputs.
- FMEC Slot 24 supports the MIC-C/T/P.
  The MIC-C/T/P card provides connection for the BATTERY A input, one of the two possible redundant power supply inputs. It also provides connection for system management serial port, system management LAN port, and system timing inputs and outputs.
Step 2  Hold the FMEC by the faceplate.

Step 3  Slide the FMEC along the guide rails into the desired FMEC slot or slots.

Step 4  Push the FMEC gently into the connector. The ONS 15454 ETSI FMECs plug into electrical connectors on the back panel of the shelf assembly when the screws are tightened. Figure 1-12 shows FMEC installation.

Figure 1-12    Installing FMECs on the ONS 15454 ETSI

Step 5  Tighten the screws.

Step 6  Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure.
NTP-G7 Install the Power and Ground

**Purpose**
This procedure installs power feeds and grounds the ONS 15454.

**Tools/Equipment**
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Screws
- (ETSI only.) Power cable (from fuse panel to MIC-A/P and to MIC-C/T/P), shipped with the ONS 15454 ETSI
- (ANSI only.) Power cable (from fuse and alarm panel to assembly), #10 AWG, copper conductors, 194 degrees F [90 degrees C]
- Ground cable 13.3-mm² (#6 AWG) stranded
- (ETSI only.) Two-hole grounding lug, shipped with the ONS 15454 ETSI
- Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for 5.26-mm² (#10 AWG) copper conductors
- (ANSI only.) Wire wrapper
- Wire cutters
- Wire strippers
- Crimp tool
- Fuse panel

**Prerequisite Procedures**
- (ETSI) NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23
- (ETSI) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28
- (ANSI) NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

**Required/As Needed**
- **Onsite/Remote**: Onsite
- **Security Level**: None

**Warning**
Before performing any of the following procedures, ensure that power is removed from the DC circuit.

Statement 1003

**Warning**
This equipment is intended to be grounded. Ensure that the host is connected to earth ground during normal use.

Statement 39

**Warning**
Use copper conductors only.

Statement 1025

**Warning**
Connect the unit only to DC power source that complies with the safety extra-low voltage (SELV) requirements in IEC 60950 based safety standards.

Statement 1033
Warning
This product requires short-circuit (overcurrent) protection, to be provided as part of the building installation. Install only in accordance with national and local wiring regulations. Statement 1045

Warning
A readily accessible two-poled disconnect device must be incorporated in the fixed wiring. Statement 1022

Warning
This unit might have more than one power supply connection. All connections must be removed to de-energize the unit. Statement 1028

Caution
Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Step 1
Verify that the correct fuse and alarm panel is installed in the top mounting space:
- (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed. If not, install one according to manufacturer’s instructions.
- (ANSI only.) If you have the 15454-SA-ANSI or 15454-SA-HD shelf, a 100-A fuse panel (30-A fuse per shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.
- (ANSI only.) If you have the 15454-SA-NEBS3 shelf, a standard 80-A fuse panel (20-A fuse per shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.

Step 2
Depending on your type of shelf, complete the “DLP-G15 Connect the Office Ground to the ONS 15454 ETSI” task on page 1-32 or the “DLP-G16 Connect the Office Ground to the ONS 15454 ANSI” task on page 1-34.

Step 3
Depending on your shelf, complete the “DLP-G17 Connect Office Power to the ONS 15454 ETSI” task on page 1-35 or the “DLP-G18 Connect Office Power to the ONS 15454 ANSI” task on page 1-37.

Step 4
Complete the “DLP-G19 Turn On and Verify Office Power” task on page 1-39.

Step 5
Continue with the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.

Stop. You have completed this procedure.
DLP-G15 Connect the Office Ground to the ONS 15454 ETSI

Purpose  This task connects ground to the ONS 15454 ETSI shelf.

Tools/Equipment  2-hole grounding lug, included in the installation kit
                2 Phillips head, M6 (metric) machine screws with locking washers, included in the installation kit
                Grounding wire—Use 13.3-mm² (#6 AWG) copper wire.
                #2 Phillips screwdriver
                Crimping tool—This tool must be large enough to accommodate the girth of the grounding lug when you crimp the grounding cable into the lug.
                Wire stripping tool

Prerequisite Procedures  DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed  Required

Onsite/Remote  Onsite

Security Level  None

Warning  This equipment must be grounded. Never defeat the ground conductor or operate the equipment in the absence of a suitably installed ground conductor. Contact the appropriate electrical inspection authority or an electrician if you are uncertain that suitable grounding is available. Statement 1024

Step 1  Use a wire-stripping tool to remove approximately 0.75 inch (19 mm) of the covering from the end of the grounding wire.

Step 2  Insert the stripped end of the grounding wire into the open-end of the grounding lug.

Step 3  Use the crimping tool to secure the grounding wire in two different places in the grounding lug.

Step 4  Locate the grounding receptacle on the side panel of the shelf (Figure 1-13).

Step 5  Place the grounding lug against the grounding receptacle on the side panel of the shelf.

Step 6  Insert one of the screws through the locking washer and through the hole in the grounding lug. Insert the screw into the threaded holes on the right side of the shelf. Ensure that the grounding lug does not interfere with other system hardware or rack equipment.

Step 7  Repeat Step 6 with the second screw.

Step 8  Prepare the other end of the grounding wire and connect it to an appropriate grounding point in your site to ensure adequate earth ground for the shelf.
Step 9  Return to your originating procedure (NTP).
DLP-G16 Connect the Office Ground to the ONS 15454 ANSI

Purpose
This task connects ground to the ONS 15454 ANSI shelf.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Screws
- Power cable (from fuse and alarm panel to assembly), #10 AWG, copper conductors, 194 degrees F [90 degrees C])
- Ground cable #6 AWG stranded
- Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for #10 AWG copper conductors

Prerequisite Procedures
DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed
- Required

Onsite/Remote
- Onsite

Security Level
- None

---

Step 1
Verify that the office ground cable (#6 AWG stranded) is connected to the top of the bay according to local site practice.

Step 2
Attach one end of the shelf ground cable (#10 AWG) to the right side of the backplane ground nut. See Figure 1-14 for the location of the ground on the backplane.

Note
When terminating a frame ground, use the Kepnut provided with the ONS 15454 and tighten it to a torque specification of 31 in-lb. The Kepnut provides a frame ground connection that minimizes the possibility of loosening caused by rotation during installation and maintenance activity. The type of prevention the kep nut provides for the frame ground connection is inherently provided by the terminal block for battery and battery return connections.

Figure 1-14  Ground Location on the Backplane

---

Step 3
Attach the other end of the shelf ground cable to the bay.

Step 4
Return to your originating procedure (NTP).
DLP-G17 Connect Office Power to the ONS 15454 ETSI

**Purpose**
This task connects power to the ONS 15454 ETSI shelf.

**Tools/Equipment**
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Wire wrapper
- Wire cutters
- Wire strippers
- Crimp tool
- Fuse panel
- Power cable (from fuse and alarm panel to assembly), 5.26-mm² (#10 AWG), copper conductors, 194°F [90°C])
- Ground cable 13.3-mm² (#6 AWG) stranded
- Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for 5.26-mm² (#10 AWG) copper conductors

**Prerequisite Procedures**
DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32

**Required/As Needed**

- **Required**
  - Onsite/Remote: Onsite

**Security Level**
None

---

**Warning**
When installing or replacing the unit, the ground connection must always be made first and disconnected last. Statement 1046

---

**Caution**
Do not apply power to the ONS 15454 ETSI until you complete all installation steps and check the continuity of the –48 VDC battery and battery return.

---

**Note**
No more than 2 m (7 ft) of the power supply cable should be exposed between the equipment and the fiber-storage tray.

---

**Note**
Only use listed compression-type connectors when terminating the battery, battery return, and ground conductors. Connectors must be suitable for copper conductors.

---

**Caution**
When terminating power, return, and frame ground, do not use soldering lug connectors, screwless (push-in) connectors, quick-connect connectors, or other friction-fit connectors.
DLP-G17 Connect Office Power to the ONS 15454 ETSI

**Note**
If the system loses power or if both TCC2/TCC2P cards are reset, you must reset the ONS 15454 ETSI clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the clock, see the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8.

---

**Step 1**
Verify that the MIC-A/P FMEC is installed in Slot 23 and the MIC-C/T/P FMEC is installed in Slot 24 of the EFCA.

**Step 2**
Attach the connector on the end of the power cable to the power FMEC.

**Step 3**
Tighten the screws of the connector on the power cable.

**Step 4**
Connect the power cable to the fuse panel or power source. Use the pin connections in Table 1-1. The conductor (green with yellow stripes) is used for secondary grounding such as grounding to the rack.

**Table 1-1 Pin Connection of the Power FMECs**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Cable Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Battery return</td>
<td>Black</td>
</tr>
<tr>
<td>A2</td>
<td>–48 V battery</td>
<td>Red</td>
</tr>
<tr>
<td>A3</td>
<td>Ground</td>
<td>Green with yellow stripes</td>
</tr>
</tbody>
</table>

**Step 5**
Return to your originating procedure (NTP).
Chapter 1      Install the Shelf and Common Control Cards

DLP-G18 Connect Office Power to the ONS 15454 ANSI

Purpose
This task connects power to the ONS 15454 ANSI shelf.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Wire wrapper
- Wire cutters
- Wire strippers
- Crimp tool
- Fuse panel
- Power cable (from fuse and alarm panel to assembly), #10 AWG, copper conductors, 194 degrees F [90 degrees C])
- Ground cable #6 AWG stranded
- Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for #10 AWG copper conductors

Prerequisite Procedures
DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-34

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

Warning
When installing or replacing the unit, the ground connection must always be made first and disconnected last. Statement 1046

Note
The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE Issue 3.

Note
If the system loses power or both TCC2/TCC2P cards are reset and the system is not provisioned to get the time from a Network Time Protocol/Simple Network Time Protocol (NTP/SNTP) server, you must reset the ONS 15454 clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the clock, see the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8.
If you are using the TCC2/TCC2P cards, the system clock will run for up to three hours. In this case, no action would be required.

Step 1
Connect the office power according to the fuse panel engineering specifications.

Step 2
Measure and cut the cables as needed to reach the ONS 15454 from the fuse panel. Figure 1-15 shows the ONS 15454 power terminals.

Step 3
Dress the power according to local site practice.
Step 4  Remove or loosen the #8 power terminal screws on the ONS 15454. To avoid confusion, label the cables connected to the BAT1/RET1 (A) power terminals as 1, and the cables connected to the BAT2/RET2 (B) power terminals as 2.

Note  Use only pressure terminal connectors, such as ring and fork types, when terminating the battery, battery return, and frame ground conductors.

Caution  Before you make any crimp connections, coat all bare conductors (battery, battery return, and frame ground) with an appropriate antioxidant compound. Bring all unplated connectors, braided strap, and bus bars to a bright finish, then coat with an antioxidant before you connect them. You do not need to prepare tinned, solder-plated, or silver-plated connectors and other plated connection surfaces, but always keep them clean and free of contaminants.

Caution  When terminating power, return, and frame ground, do not use soldering lug, screwless (push-in) connectors, quick-connect, or other friction-fit connectors.

Step 5  Strip 1/2 inch (12.7 mm) of insulation from all power cables that you will use.

Step 6  Crimp the lugs onto the ends of all power leads.

Note  When terminating battery and battery return connections as shown in Figure 1-15, follow a torque specification of 10 in-lb.
Step 7  Terminate the return 1 lead to the RET1 backplane terminal. Use oxidation-prevention grease to keep the connections noncorrosive.

Step 8  Terminate the negative 1 lead to the negative BAT1 backplane power terminal. Use oxidation prevention grease to keep connections noncorrosive.

Step 9  If you use redundant power leads, terminate the return 2 lead to the positive RET2 terminal on the ONS 15454. Terminate the negative 2 lead to the negative BAT2 terminal on the ONS 15454. Use oxidation-preventative grease to keep connections noncorrosive.

Step 10  Route the cables out below the power terminals using the plastic cable clamp, as shown in Figure 1-15 on page 1-38.

Step 11  Return to your originating procedure (NTP).

**DLP-G19 Turn On and Verify Office Power**

**Purpose**
This task measures the power to verify correct power and returns for the ONS 15454 shelf.

**Tools/Equipment**
Voltmeter

**Prerequisite Procedures**
- DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32
- DLP-G17 Connect Office Power to the ONS 15454 ETSI, page 1-35
- DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-34
- DLP-G18 Connect Office Power to the ONS 15454 ANSI, page 1-37

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

⚠️ **Caution**
Do not apply power to the shelf assembly until you complete all installation steps.

**Step 1**
Using a voltmeter, verify the office battery and ground at the following points on the fuse and alarm panel:

a. To verify the power, place the black test lead of the voltmeter to the frame ground. Place the red test lead on the A-side connection and verify that it is between –40.5 VDC and –57 VDC. Place the red test lead on the B-side connection and verify that it is between –40.5 VDC and –57 VDC.

**Note**
The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum voltages required to power the chassis.

b. To verify the ground, place the black test lead of the voltmeter to the frame ground. Place the red test lead on the A-side return ground and verify that no voltage is present. Place the red test lead on the B-side return ground and verify that no voltage is present.

**Step 2**
Complete one of the following to power up the node:
- If you are using a 80-A fuse panel, insert a 20-A fuse into the fuse position according to site practice.
If you are using a 100-A fuse panel, insert a 30-A fuse into the fuse position according to site practice.

**Step 3**
Using a voltmeter, verify the ONS 15454 shelf for –48 VDC battery and ground:

a. To verify the A-side of the shelf, place the black lead of the voltmeter to the frame ground. Place the red test lead to the BAT1 (A-side battery connection) red cable. Verify that it reads between –40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET1 (A-side return ground) black cable and verify that no voltage is present.

| Note | The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum voltages required to power the chassis. |

b. To verify the B-side of the shelf, place the black test lead of the voltmeter to the frame ground. Place the red test lead to the BAT2 (B-side battery connection) red cable. Verify that it reads between –40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET2 (B-side return ground) black cable and verify that no voltage is present.

**Step 4**
Return to your originating procedure (NTP).

---

**NTP-G8 Install the Fan-Tray Assembly**

**Purpose**
This procedure installs the fan-tray assembly.

**Tools/Equipment**
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

**Prerequisite Procedures**
- NTP-G3 Open and Remove the Front Door, page 1-20
- NTP-G7 Install the Power and Ground, page 1-30

**Required/As Needed**

- Required
- Onsite/Remote: Onsite
- Security Level: None

**Caution**
Do not operate an ONS 15454 without a fan-tray air filter. A fan-tray air filter is mandatory, except for ONS 15454 ANSI applications in an outside plant cabinet.

**Note**
Error messages appear on the TCC2/TCC2P card, the fan-tray LED, and in Cisco Transport Controller (CTC) when the fan-tray assembly is removed from the shelf or when one fan is not working.

**Note**
If you are installing the ONS 15454 in an outside plant cabinet, remove the air filter to provide maximum cooling capabilities and to comply with Telcordia GR-487-CORE.
Chapter 1      Install the Shelf and Common Control Cards

NTP-G8 Install the Fan-Tray Assembly

Caution
You must place the edge of the air filter flush against the front of the fan-tray assembly compartment when installing the fan tray on top of the filter. Failure to do so could result in damage to the filter, the fan tray, or both.

Caution
Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or the connectors on the back panel of the shelf assembly.

Note
To install the fan-tray assembly, it is not necessary to move any of the fiber-storage facilities.

Step 1
Install the air filter. The air filter can be installed internally between the fan tray and shelf assembly, or externally by mounting the air filter bracket on the bottom of the shelf assembly. Slide the air filter into the bracket.

Step 2
Install the fan-tray assembly. Figure 1-16 shows the fan-tray assembly location on the ONS 15454 ETSI. Figure 1-17 shows the fan-tray assembly location on the ONS 15454 ANSI.

- For the ONS 15454 ETSI shelf, press and hold the locks on the outer edges as you slide the fan-tray assembly into the shelf assembly.
- For the ONS 15454 ANSI shelf, slide the fan-tray assembly into the shelf.

The electrical plug at the rear of the tray should plug into the corresponding receptacle on the assembly.

Caution
Do not force a fan-tray assembly into place. This can damage the connectors on the fan-tray assembly and/or the connectors on the back panel of the shelf assembly.
Figure 1-16 Installing the Fan-Tray Assembly on the ONS 15454 ETSI
Step 3  To verify that the tray has plugged into the assembly, look at the fan tray and listen to determine that the fans are running.

Step 4  If you want to install an alarm expansion panel on the ONS 15454 ANSI shelf, continue with the “NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44. Otherwise, continue with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-47.

Stop. You have completed this procedure.
NTP-G9 Install the Alarm Expansion Panel (ANSI Only)

Purpose
This procedure installs an AEP onto the 15454-SA-ANSI or 15454-SA-HD shelf backplane. The AEP provides alarm contacts (32 inputs, 16 outputs) in addition to the 16 provided by the AIC-I card. Typically, the AEP is preinstalled when ordered with the ONS 15454; however, the AEP can be ordered separately. The AIC-I card must be installed before you can provision the alarm contacts enabled by the AEP.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver
- Wire wrapper
- 6-pair #29 AWG double-shielded cable
- Standoffs (4)

Prerequisite Procedures
DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
The AIC-I card provides direct alarm contacts (external alarm inputs and external control outputs). In the ANSI shelf, these AIC-I alarm contacts are routed through the backplane to wire-wrap pins accessible from the back of the shelf. When you install an AEP, the direct AIC-I alarm contacts cannot be used. Only the AEP alarm contacts can be used.

Step 1
Remove the two backplane screws. Replace the two screws with standoffs. Insert the longer standoff on the left, and the shorter standoff on the right (Figure 1-18).
Figure 1-18  Replace Backplane Screws with Standoffs

Step 2  Attach the remaining two standoffs on either side of the backplane (Figure 1-19).
Step 3  Position the AEP board over the standoffs.
Step 4 Insert and tighten three screws to secure the AEP to the backplane.

Step 5 Connect the AEP cable to the backplane and AEP:
   a. Connect the 10 colored wires to the wire-wrap pins on the backplane. Figure 1-20 shows where the cable wires are connected. Table 1-2 shows AEP and AIC-I signals that each wire carries
   b. Plug the other end of the AEP cable into AEP connector port. The brown pin is on the top.

Figure 1-20 AEP Wire-Wrap Connections to Backplane Pins
Table 1-2  Pin Assignments for the AEP

<table>
<thead>
<tr>
<th>AEP Cable Wire</th>
<th>Backplane Pin</th>
<th>AIC-I Signal</th>
<th>AEP Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>A1</td>
<td>GND</td>
<td>AEP_GND</td>
</tr>
<tr>
<td>White</td>
<td>A2</td>
<td>AE_+5</td>
<td>AEP_+5</td>
</tr>
<tr>
<td>Slate</td>
<td>A3</td>
<td>VBAT−</td>
<td>VBAT−</td>
</tr>
<tr>
<td>Violet</td>
<td>A4</td>
<td>VB+</td>
<td>VB+</td>
</tr>
<tr>
<td>Blue</td>
<td>A5</td>
<td>AE_CLK_P</td>
<td>AE_CLK_P</td>
</tr>
<tr>
<td>Green</td>
<td>A6</td>
<td>AE_CLK_N</td>
<td>AE_CLK_N</td>
</tr>
<tr>
<td>Yellow</td>
<td>A7</td>
<td>AE_DIN_P</td>
<td>AE_DOUT_P</td>
</tr>
<tr>
<td>Orange</td>
<td>A8</td>
<td>AE_DIN_N</td>
<td>AE_DOUT_N</td>
</tr>
<tr>
<td>Red</td>
<td>A9</td>
<td>AE_DOUT_P</td>
<td>AE_DIN_P</td>
</tr>
<tr>
<td>Brown</td>
<td>A10</td>
<td>AE_DOUT_N</td>
<td>AE_DIN_N</td>
</tr>
</tbody>
</table>

**Step 6**  Continue with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-47.

Stop. You have completed this procedure.

---

**NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections**

**Purpose**  This procedure installs alarm, timing, LAN, and craft wires on the ONS 15454 shelf. These wires are attached to the MIC FMECs on the ETSI shelf and attached to the backplane on the ANSI shelf.

**Tools/Equipment**  Connectors according to function
- Twisted 0.51 mm² or 0.64 mm² (#22 or #24 AWG) shielded wires for LAN or craft
- 75-ohm coaxial cable with 1.0/2.3 miniature coax connector
- 0.51 mm² or 0.64 mm² (#22 or #24 AWG) alarm wires

**Prerequisite Procedures**  (ETSI only.) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28
(ANSI only.) NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite

**Security Level**  None

**Caution**  Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.
Step 1  For an ONS 15454 ETSI shelf, complete the following tasks as necessary:

- Complete the “DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 if you want to provision external alarms and/or controls with the AIC-I card.
- Complete the “DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)” task on page 1-51 if you are provisioning external timing.
- Complete the “DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)” task on page 1-52 to create an external LAN connection. LAN wires or the LAN port on the TCC2/TCC2P card are necessary to create an external LAN connection.

Step 2  For an ONS 15454 ANSI shelf, complete the following tasks as necessary:

- Complete the “DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 if you are using an AIC or AIC-I card and are not using an AEP.
- Complete the “DLP-G24 Install Timing Wires on the Backplane (ANSI Only)” task on page 1-55 if you are provisioning external timing.
- Complete the “DLP-G25 Install LAN Wires on the Backplane (ANSI Only)” task on page 1-56 to create an external LAN connection. LAN wires or the LAN port on the TCC2/TCC2P card are necessary to create an external LAN connection.
- Complete the “DLP-G26 Install the TL1 Craft Interface (ANSI Only)” task on page 1-57 to access TL1 using the craft interface. Craft wires or the EIA/TIA-232 port on the TCC2/TCC2P card are required to access TL1.

Stop. You have completed this procedure.

DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)

| Purpose | This task installs alarm cables on the MIC-A/P on the ONS 15454 ETSI so that you can provision external (environmental) alarms and controls with the AIC-I card. |
| Tools/Equipment | DB-62 connector  
0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires |
| Prerequisite Procedures | NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28 |
| Required/As Needed | As needed |
| Onsite/Remote | Onsite |
| Security Level | None |

Step 1  Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires, connect the alarm and control wires on the appropriate pins of the DB-62 connector. The pin connectors, signal names, and functions are listed in Table 1-3.
### Table 1-3 Alarm Pin Assignments

<table>
<thead>
<tr>
<th>DB-62 Pin Connector</th>
<th>Signal Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALMCUTOFF–</td>
<td>Alarm cutoff</td>
</tr>
<tr>
<td>2</td>
<td>ALMCUTOFF+</td>
<td>Alarm cutoff</td>
</tr>
<tr>
<td>3</td>
<td>ALMINP0–</td>
<td>Alarm input pair number 1</td>
</tr>
<tr>
<td>4</td>
<td>ALMINP0+</td>
<td>Alarm input pair number 1</td>
</tr>
<tr>
<td>5</td>
<td>ALMINP1–</td>
<td>Alarm input pair number 2</td>
</tr>
<tr>
<td>6</td>
<td>ALMINP1+</td>
<td>Alarm input pair number 2</td>
</tr>
<tr>
<td>7</td>
<td>ALMINP2–</td>
<td>Alarm input pair number 3</td>
</tr>
<tr>
<td>8</td>
<td>ALMINP2+</td>
<td>Alarm input pair number 3</td>
</tr>
<tr>
<td>9</td>
<td>ALMINP3–</td>
<td>Alarm input pair number 4</td>
</tr>
<tr>
<td>10</td>
<td>ALMINP3+</td>
<td>Alarm input pair number 4</td>
</tr>
<tr>
<td>11</td>
<td>EXALM0–</td>
<td>Extra alarm 0</td>
</tr>
<tr>
<td>12</td>
<td>EXALM0+</td>
<td>Extra alarm 0</td>
</tr>
<tr>
<td>13</td>
<td>FGND</td>
<td>Ground</td>
</tr>
<tr>
<td>14</td>
<td>EXALM1–</td>
<td>Extra alarm 1</td>
</tr>
<tr>
<td>15</td>
<td>EXALM1+</td>
<td>Extra alarm 1</td>
</tr>
<tr>
<td>16</td>
<td>EXALM2–</td>
<td>Extra alarm 2</td>
</tr>
<tr>
<td>17</td>
<td>EXALM2+</td>
<td>Extra alarm 2</td>
</tr>
<tr>
<td>18</td>
<td>EXALM3–</td>
<td>Extra alarm 3</td>
</tr>
<tr>
<td>19</td>
<td>EXALM3+</td>
<td>Extra alarm 3</td>
</tr>
<tr>
<td>20</td>
<td>EXALM4–</td>
<td>Extra alarm 4</td>
</tr>
<tr>
<td>21</td>
<td>EXALM4+</td>
<td>Extra alarm 4</td>
</tr>
<tr>
<td>22</td>
<td>EXALM5–</td>
<td>Extra alarm 5</td>
</tr>
<tr>
<td>23</td>
<td>EXALM5+</td>
<td>Extra alarm 5</td>
</tr>
<tr>
<td>24</td>
<td>EXALM6–</td>
<td>Extra alarm 6</td>
</tr>
<tr>
<td>25</td>
<td>EXALM6+</td>
<td>Extra alarm 6</td>
</tr>
<tr>
<td>26</td>
<td>FGND</td>
<td>Ground</td>
</tr>
<tr>
<td>27</td>
<td>EXALM7–</td>
<td>Extra alarm 7</td>
</tr>
<tr>
<td>28</td>
<td>EXALM7+</td>
<td>Extra alarm 7</td>
</tr>
<tr>
<td>29</td>
<td>EXALM8–</td>
<td>Extra alarm 8</td>
</tr>
<tr>
<td>30</td>
<td>EXALM8+</td>
<td>Extra alarm 8</td>
</tr>
<tr>
<td>31</td>
<td>EXALM9–</td>
<td>Extra alarm 9</td>
</tr>
<tr>
<td>32</td>
<td>EXALM9+</td>
<td>Extra alarm 9</td>
</tr>
<tr>
<td>33</td>
<td>EXALM10–</td>
<td>Extra alarm 10</td>
</tr>
<tr>
<td>34</td>
<td>EXALM10+</td>
<td>Extra alarm 10</td>
</tr>
<tr>
<td>35</td>
<td>EXALM11–</td>
<td>Extra alarm 11</td>
</tr>
<tr>
<td>36</td>
<td>EXALM11+</td>
<td>Extra alarm 11</td>
</tr>
</tbody>
</table>
Table 1-3  
Alarm Pin Assignments (continued)

<table>
<thead>
<tr>
<th>DB-62 Pin Connector</th>
<th>Signal Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>37</td>
<td>ALMOUP0–</td>
<td>Normally open output pair number 1</td>
</tr>
<tr>
<td>38</td>
<td>ALMOUP0+</td>
<td>Normally open output pair number 1</td>
</tr>
<tr>
<td>39</td>
<td>FGND</td>
<td>Ground</td>
</tr>
<tr>
<td>40</td>
<td>ALMOUP1–</td>
<td>Normally open output pair number 2</td>
</tr>
<tr>
<td>41</td>
<td>ALMOUP1+</td>
<td>Normally open output pair number 2</td>
</tr>
<tr>
<td>42</td>
<td>ALMOUP2–</td>
<td>Normally open output pair number 3</td>
</tr>
<tr>
<td>43</td>
<td>ALMOUP2+</td>
<td>Normally open output pair number 3</td>
</tr>
<tr>
<td>44</td>
<td>ALMOUP3–</td>
<td>Normally open output pair number 4</td>
</tr>
<tr>
<td>45</td>
<td>ALMOUP3+</td>
<td>Normally open output pair number 4</td>
</tr>
<tr>
<td>46</td>
<td>AUDALM0–</td>
<td>Normally open minor audible alarm</td>
</tr>
<tr>
<td>47</td>
<td>AUDALM0+</td>
<td>Normally open minor audible alarm</td>
</tr>
<tr>
<td>48</td>
<td>AUDALM1–</td>
<td>Normally open major audible alarm</td>
</tr>
<tr>
<td>49</td>
<td>AUDALM1+</td>
<td>Normally open major audible alarm</td>
</tr>
<tr>
<td>50</td>
<td>AUDALM2–</td>
<td>Normally open critical audible alarm</td>
</tr>
<tr>
<td>51</td>
<td>AUDALM2+</td>
<td>Normally open critical audible alarm</td>
</tr>
<tr>
<td>52</td>
<td>FGND</td>
<td>Ground</td>
</tr>
<tr>
<td>53</td>
<td>AUDALM3–</td>
<td>Normally open remote audible alarm</td>
</tr>
<tr>
<td>54</td>
<td>AUDALM3+</td>
<td>Normally open remote audible alarm</td>
</tr>
<tr>
<td>55</td>
<td>VISALM0–</td>
<td>Normally open minor visible alarm</td>
</tr>
<tr>
<td>56</td>
<td>VISALM0+</td>
<td>Normally open minor visible alarm</td>
</tr>
<tr>
<td>57</td>
<td>VISALM1–</td>
<td>Normally open major visible alarm</td>
</tr>
<tr>
<td>58</td>
<td>VISALM1+</td>
<td>Normally open major visible alarm</td>
</tr>
<tr>
<td>59</td>
<td>VISALM2–</td>
<td>Normally open minor visible alarm</td>
</tr>
<tr>
<td>60</td>
<td>VISALM2+</td>
<td>Normally open minor visible alarm</td>
</tr>
<tr>
<td>61</td>
<td>VISALM3–</td>
<td>Normally open minor visible alarm</td>
</tr>
<tr>
<td>62</td>
<td>VISALM3+</td>
<td>Normally open minor visible alarm</td>
</tr>
</tbody>
</table>

Step 2: Connect the other end of the alarm and control wires according to local site practice.

Step 3: Connect the DB-62 connector to the ALARM IN/OUT connector on the MIC-A/P faceplate.

Step 4: Tighten the screws of the connector on the alarm cable.

Step 5: Return to your originating procedure (NTP).
DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)

Purpose
This task installs the timing cables on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment
75-ohm coaxial cable with a 1.0/2.3 miniature coax connector on the MIC-C/T/P side

Prerequisite Procedures
NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
Using coaxial cable with 1.0/2.3 miniature coax connectors, connect the clock cable to the appropriate connector on the faceplate of the MIC-C/T/P.

Step 2
Gently push the cable with the 1.0/2.3 miniature coax connector down until the cable connector slides into the 1.0/2.3 miniature coax connector on the faceplate with a click.

The MIC-C/T/P provides 1.0/2.3 miniature coax connectors that are used for timing input and output. The top connectors are for “A” (BITS-1) timing, and the bottom connectors are for “B” (BITS-2) timing. In each case, the left connector is the input and the right connector is the output. The input connectors for timing provide a 75-ohm termination. System cables are available that can convert timing clocks from 75 ohms to 100/120 ohms. Table 1-4 shows MIC-C/T/P pin assignments.

Table 1-4 MIC-C/T/P Clock Connector Pin Assignment

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN 1</td>
<td>Input from external device</td>
</tr>
<tr>
<td>OUT 1</td>
<td>Output to external device</td>
</tr>
<tr>
<td>IN 2</td>
<td>Input from external device</td>
</tr>
<tr>
<td>OUT 2</td>
<td>Output to external device</td>
</tr>
</tbody>
</table>

A high-impedance option (> 3 kilo-ohms or greater) is possible through a jumper on the MIC-C/T/P FMEC. You can change the top timing input to high impedance by removing the jumper on P3 of the MIC-C/T/P FMEC. You can change the bottom timing input to high impedance by removing the jumper on P2 on the MIC-C/T/P FMEC.

Note
Refer to ITU-T G.813 for rules about provisioning timing references.

Step 3
Connect the other end of the cable to the external source of the timing signal according to Table 1-4.

Step 4
Repeat Step 3 for each cable that is required.

Step 5
Return to your originating procedure (NTP).
DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)

Purpose
This task installs the LAN wires on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment
Standard CAT-5 UTP Ethernet cable (straight-through for data terminating equipment [DTE] or cross-over for data circuit-terminating equipment [DCE])
or
RJ-45 connector
Crimping tool for RJ-45 connector
0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire, preferably CAT-5 UTP

Prerequisite Procedures
NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
Rather than using the LAN connection port on the MIC-C/T/P, you can use the LAN connection port on the TCC2/TCC2P card if preferred. Use either the MIC-C/T/P connection or the TCC2/TCC2P card connection. You cannot use the LAN connection port on the MIC-C/T/P and the LAN connection port on the TCC2/TCC2P card simultaneously; however, it is possible for you to make a direct connection from a computer to the LAN connection port on the TCC2/TCC2P card while the LAN connection port on the MIC-C/T/P is in use as long as the computer connected directly to the TCC2/TCC2P card is not connected to a LAN.

Step 1
Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire or CAT-5 UTP Ethernet cable, connect the wires to the RJ-45 connector according to Table 1-5.

Table 1-5 LAN Pin Assignments

<table>
<thead>
<tr>
<th>LAN</th>
<th>RJ-45 Pin</th>
<th>RJ-45 Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN 1 Connecting to DCE¹ (a hub or switch)</td>
<td>1</td>
<td>3</td>
<td>PNMSRX+ white/green</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>6</td>
<td>PNMSRX− green</td>
</tr>
<tr>
<td>Cross-over Ethernet cable</td>
<td>3</td>
<td>1</td>
<td>PNMSTX white/orange</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>4</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>5</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>2</td>
<td>PNMSTX− orange</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>7</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>8</td>
<td>—</td>
</tr>
</tbody>
</table>
Step 2  

Return to your originating procedure (NTP).

---

DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)

Purpose  
This task installs alarm wires on the backplane so that you can provision external (environmental) alarms and controls with the AIC or AIC-I card. If you are using the AEP, do not perform this task.

Tools/Equipment  
Wire wrapper  
#22 or #24 AWG (0.51 mm² or 0.64 mm²) wires  
100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair T1-type

Prerequisite Procedures  
NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed  
As needed

Onsite/Remote  
Onsite

Security Level  
None

Step 1  
Using 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²) twisted-pair T1-type wires, wrap the alarm wires on the appropriate wire-wrap pins according to local site practice. Ground the shield of the BITS Input cable at the BITS end. For BITS Output, wrap the ground shield of the BITS cable to the frame ground pin (FG1) located below the column of BITS pins.

Figure 1-21 shows alarm pin assignments for the AIC-I in the Release 3.4 or higher ONS 15454 backplane, and Figure 1-22 calls out the external alarm pins on that backplane.
### Figure 1-21  Cisco ONS 15454 Backplane Pinouts (Release 3.4 or Later)

<table>
<thead>
<tr>
<th>Field</th>
<th>Pin</th>
<th>Function</th>
<th>Field</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITS</td>
<td>A1</td>
<td>BITS Output 2 negative (–)</td>
<td>ENVIR</td>
<td>A1</td>
<td>Normally open output pair number 1</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>BITS Output 2 positive (+)</td>
<td>ALARMS</td>
<td>B1</td>
<td>Normally open output pair number 2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>BITS Input 2 negative (–)</td>
<td>IN/OUT</td>
<td>B2</td>
<td>Normally open output pair number 3</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>BITS Input 2 positive (+)</td>
<td></td>
<td>A3</td>
<td>Normally open output pair number 4</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>BITS Output 1 negative (–)</td>
<td></td>
<td>A4</td>
<td>Normally open output pair number 5</td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>BITS Output 1 positive (+)</td>
<td></td>
<td>A5</td>
<td>Normally open output pair number 6</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>BITS Input 1 negative (–)</td>
<td></td>
<td>A6</td>
<td>Normally open output pair number 7</td>
</tr>
<tr>
<td></td>
<td>B4</td>
<td>BITS Input 1 positive (+)</td>
<td></td>
<td>A7</td>
<td>Normally open output pair number 8</td>
</tr>
<tr>
<td>LAN</td>
<td>A1</td>
<td>Connecting to a hub, or switch</td>
<td>LOCAL</td>
<td>A1</td>
<td>Alarm output pair number 1: Remote audible alarm.</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>Connecting to a PC/Workstation or router</td>
<td>ALARMS AUD</td>
<td>B1</td>
<td>Alarm output pair number 2: Critical audible alarm.</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>RJ-45 pin 2 TX–</td>
<td></td>
<td>A2</td>
<td>Alarm output pair number 3: Major audible alarm.</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>RJ-45 pin 1 TX+</td>
<td></td>
<td>A3</td>
<td>Alarm output pair number 4: Minor audible alarm.</td>
</tr>
<tr>
<td>ENVIR</td>
<td>A1</td>
<td>Alarm input pair number 1: Reports closure on connected wires.</td>
<td>VIS</td>
<td>A1</td>
<td>Alarm output pair number 1: Remote visual alarm.</td>
</tr>
<tr>
<td>ALARMS</td>
<td>B1</td>
<td>Alarm input pair number 2: Reports closure on connected wires.</td>
<td></td>
<td>A2</td>
<td>Alarm output pair number 2: Critical visual alarm.</td>
</tr>
<tr>
<td>IN</td>
<td>A2</td>
<td>Alarm input pair number 3: Reports closure on connected wires.</td>
<td></td>
<td>A3</td>
<td>Alarm output pair number 3: Major visual alarm.</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>Alarm input pair number 4: Reports closure on connected wires.</td>
<td></td>
<td>A4</td>
<td>Alarm output pair number 4: Minor visual alarm.</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>Alarm input pair number 5: Reports closure on connected wires.</td>
<td></td>
<td>B4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>Alarm input pair number 6: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>Alarm input pair number 7: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B4</td>
<td>Alarm input pair number 8: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>Alarm input pair number 9: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td>Alarm input pair number 10: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>Alarm input pair number 11: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B6</td>
<td>Alarm input pair number 12: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A7</td>
<td>Alarm input pair number 13: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B7</td>
<td>Alarm input pair number 14: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A8</td>
<td>Alarm input pair number 15: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B8</td>
<td>Alarm input pair number 16: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A9</td>
<td>Alarm input pair number 17: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B9</td>
<td>Alarm input pair number 18: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A10</td>
<td>Alarm input pair number 19: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B10</td>
<td>Alarm input pair number 20: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A11</td>
<td></td>
<td>Alarm input pair number 21: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B11</td>
<td></td>
<td>Alarm input pair number 22: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A12</td>
<td></td>
<td>Alarm input pair number 23: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B12</td>
<td></td>
<td>Alarm input pair number 24: Reports closure on connected wires.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you are using an AIC-I card, contacts provisioned as OUT are 1-4. Contacts provisioned as IN are 13-16.
Figure 1-22  Highlighted Environmental Alarms

Note  The X.25, Modem, and TBOS pin fields are not active on either pin field.

Step 2  Return to your originating procedure (NTP).

DLP-G24 Install Timing Wires on the Backplane (ANSI Only)

Purpose  This task installs the BITS timing wires on the ONS 15454 ANSI backplane.

Tools/Equipment  Wire wrapper

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair T1-type

Prerequisite Procedures  NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed  As needed

Onsite/Remote  Onsite

Security Level  None

Step 1  Using 100-ohm shielded BITS clock cable #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair T1-type, wrap the clock wires on the appropriate wire-wrap pins according to local site practice.

Ground the shield of the BITS input cable at the BITS end. For BITS output, wrap the ground shield of the BITS cable to the frame ground pin (FG1) located beneath the column of BITS pins. Table 1-6 lists the pin assignments for the BITS timing pin fields.

<table>
<thead>
<tr>
<th>BITS Pin</th>
<th>Tip/Ring</th>
<th>CTC/TL1 Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>ring</td>
<td>BITS-1</td>
<td>Input from BITS device 1</td>
</tr>
<tr>
<td>B4</td>
<td>tip</td>
<td>BITS-1</td>
<td>Input from BITS device 1</td>
</tr>
<tr>
<td>A3</td>
<td>ring</td>
<td>BITS-1</td>
<td>Output to external device 1</td>
</tr>
<tr>
<td>B3</td>
<td>tip</td>
<td>BITS-1</td>
<td>Output to external device 1</td>
</tr>
<tr>
<td>A2</td>
<td>ring</td>
<td>BITS-2</td>
<td>Input from BITS device 2</td>
</tr>
<tr>
<td>B2</td>
<td>tip</td>
<td>BITS-2</td>
<td>Input from BITS device 2</td>
</tr>
</tbody>
</table>
DLP-G25 Install LAN Wires on the Backplane (ANSI Only)

Purpose
This task installs the LAN wires on the ONS 15454 ANSI backplane.

Tools/Equipment
- Wire wrapper
- #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, preferably CAT-5 UTP

Step 1
Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire or CAT-5 UTP Ethernet cable, wrap the wires on the appropriate wire-wrap pins according to local site practice.

Caution
Cross talk might result if both receive (Rx) and transmit (Tx) pins connect on the same twisted pair of wires from the CAT-5 cable. The two Tx pins need to be on one twisted pair, and the two Rx pins need to be on another twisted pair.

A frame ground pin is located beneath each pin field (FG2 for the LAN pin field). Wrap the ground shield of the LAN interface cable to the frame ground pin. Table 1-7 shows the LAN pin assignments.

Table 1-6 External Timing Pin Assignments for BITS (continued)

<table>
<thead>
<tr>
<th>BITS Pin</th>
<th>Tip/Ring</th>
<th>CTC/TL1 Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>ring</td>
<td>BITS-2</td>
<td>Output to external device 2</td>
</tr>
<tr>
<td>B1</td>
<td>tip</td>
<td>BITS-2</td>
<td>Output to external device 2</td>
</tr>
</tbody>
</table>

Note
For more detailed information about timing, see Chapter 20, “Security Reference.” To set up system timing, see the “NTP-G53 Set Up Timing” procedure on page 6-4.
### Table 1-7  
**LAN Pin Assignments for the ONS 15454 ANSI Shelf**

<table>
<thead>
<tr>
<th>Pin Field</th>
<th>Backplane Pins</th>
<th>RJ-45 Pins</th>
<th>Function/Color</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LAN 1</strong> Connecting to data circuit-terminating equipment (DCE) (a hub or switch); the ONS 15454 is a DCE</td>
<td>B2 1</td>
<td>TX+ white/green</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A2 2</td>
<td>TX– green</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B1 3</td>
<td>RX+ white/orange</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1 6</td>
<td>RX– orange</td>
<td></td>
</tr>
<tr>
<td><strong>LAN 1</strong> Connecting to data terminal equipment (DTE) (a PC/workstation or router)</td>
<td>B1 1</td>
<td>RX+ white/green</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1 2</td>
<td>RX– green</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B2 3</td>
<td>TX+ white/orange</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A2 6</td>
<td>TX– orange</td>
<td></td>
</tr>
</tbody>
</table>

**Note**: The TCC2/TCC2P does not support Ethernet polarity detection. If your Ethernet connection has incorrect polarity (this can only occur with cables that have the receive wire pairs flipped), a “Lan Connection Polarity Reversed” condition is raised. This condition usually occurs during an upgrade or initial node deployment. To correct the situation, ensure that your Ethernet cable has the correct mapping of the wire-wrap pins.

**Step 2**: Return to your originating procedure (NTP).

---

### DLP-G26 Install the TL1 Craft Interface (ANSI Only)

**Purpose**: This task installs the TL1 craft interface on the ONS 15454 ANSI shelf using the craft backplane pins. You can also use a LAN cable connected to the TCC2/TCC2P EIA/TIA-232 port to access a TL1 craft interface.

**Tools/Equipment**: Wire wrapper  
#22 or #24 AWG (0.51 mm² or 0.64 mm²) alarm wires

**Prerequisite Procedures**: NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

**Required/As Needed**: As needed

**Onsite/Remote**: Onsite

**Security Level**: None

**Note**: Rather than using the craft pins, you can use a LAN cable connected to the TCC2/TCC2P EIA/TIA-232 port to access a TL1 craft interface.

**Step 1**: Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, wrap the craft interface wires on the appropriate wire-wrap pins according to local site practice.

**Step 2**: Wrap the ground shield of the craft interface cable to the frame-ground pin.
Wrap the ground wire of your computer cable to pin A3 on the craft pin field. Table 1-8 shows the pin assignments for the CRAFT pin field.

**Note** You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2/TCC2P card simultaneously. Using a combination prevents access to the node or causes a loss in connectivity.

### Table 1-8 Craft Interface Pin Assignments

<table>
<thead>
<tr>
<th>Pin Field</th>
<th>Contact</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Craft</td>
<td>A1</td>
<td>Receive</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>Transmit</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>DTR</td>
</tr>
</tbody>
</table>

**Step 3** Return to your originating procedure (NTP).

---

### NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only)

**Purpose**

This procedure connects an external wire-wrap panel to the ONS 15454 ANSI AEP to provide the physical alarm contacts for the AEP.

**Tools/Equipment**

External wire-wrap panel

**Prerequisite Procedures**

NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite

**Security Level**

None

**Step 1**

Position the lower cover over the AEP. Make sure that the AEP AMP Champ connectors protrude through the cutouts in the lower cover (Figure 1-23).
### Step 2
Insert and tighten the eight screws to secure the AEP cover to the AEP.

### Step 3
Connect the cables from the external wire-wrap panel to the AMP Champ connectors on the AEP. Table 1-9 lists the alarm input pin assignments.

#### Table 1-9  Alarm Input Pin Assignments

<table>
<thead>
<tr>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALARM_IN_1−</td>
<td>27</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>28</td>
<td>ALARM_IN_2−</td>
</tr>
<tr>
<td>3</td>
<td>ALARM_IN_3−</td>
<td>29</td>
<td>ALARM_IN_4−</td>
</tr>
<tr>
<td>4</td>
<td>ALARM_IN_5−</td>
<td>30</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>31</td>
<td>ALARM_IN_6−</td>
</tr>
<tr>
<td>6</td>
<td>ALARM_IN_7−</td>
<td>32</td>
<td>ALARM_IN_8−</td>
</tr>
<tr>
<td>7</td>
<td>ALARM_IN_9−</td>
<td>33</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>34</td>
<td>ALARM_IN_10−</td>
</tr>
<tr>
<td>9</td>
<td>ALARM_IN_11−</td>
<td>35</td>
<td>ALARM_IN_12−</td>
</tr>
<tr>
<td>10</td>
<td>ALARM_IN_13−</td>
<td>36</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>GND</td>
<td>37</td>
<td>ALARM_IN_14−</td>
</tr>
<tr>
<td>12</td>
<td>ALARM_IN_15−</td>
<td>38</td>
<td>ALARM_IN_16−</td>
</tr>
</tbody>
</table>
### Table 1-9  Alarm Input Pin Assignments (continued)

<table>
<thead>
<tr>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>ALARM_IN_17–</td>
<td>39</td>
<td>GND</td>
</tr>
<tr>
<td>14</td>
<td>GND</td>
<td>40</td>
<td>ALARM_IN_18–</td>
</tr>
<tr>
<td>15</td>
<td>ALARM_IN_19–</td>
<td>41</td>
<td>ALARM_IN_20–</td>
</tr>
<tr>
<td>16</td>
<td>ALARM_IN_21–</td>
<td>42</td>
<td>GND</td>
</tr>
<tr>
<td>17</td>
<td>GND</td>
<td>43</td>
<td>ALARM_IN_22–</td>
</tr>
<tr>
<td>18</td>
<td>ALARM_IN_23–</td>
<td>44</td>
<td>ALARM_IN_24–</td>
</tr>
<tr>
<td>19</td>
<td>ALARM_IN_25–</td>
<td>45</td>
<td>GND</td>
</tr>
<tr>
<td>20</td>
<td>GND</td>
<td>46</td>
<td>ALARM_IN_26–</td>
</tr>
<tr>
<td>21</td>
<td>ALARM_IN_27–</td>
<td>47</td>
<td>ALARM_IN_28–</td>
</tr>
<tr>
<td>22</td>
<td>ALARM_IN_29–</td>
<td>48</td>
<td>GND</td>
</tr>
<tr>
<td>23</td>
<td>GND</td>
<td>49</td>
<td>ALARM_IN_30–</td>
</tr>
<tr>
<td>24</td>
<td>ALARM_IN_31–</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>25</td>
<td>ALARM_IN_+</td>
<td>51</td>
<td>GND1</td>
</tr>
<tr>
<td>26</td>
<td>ALARM_IN_0-</td>
<td>52</td>
<td>GND2</td>
</tr>
</tbody>
</table>

Table 1-10 lists the alarm output (external control) pin assignments.

### Table 1-10  Alarm Output Pin Assignments

<table>
<thead>
<tr>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
<td>27</td>
<td>COM_0</td>
</tr>
<tr>
<td>2</td>
<td>COM_1</td>
<td>28</td>
<td>—</td>
</tr>
<tr>
<td>3</td>
<td>NO_1</td>
<td>29</td>
<td>NO_2</td>
</tr>
<tr>
<td>4</td>
<td>—</td>
<td>30</td>
<td>COM_2</td>
</tr>
<tr>
<td>5</td>
<td>COM_3</td>
<td>31</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>NO_3</td>
<td>32</td>
<td>NO_4</td>
</tr>
<tr>
<td>7</td>
<td>—</td>
<td>33</td>
<td>COM_4</td>
</tr>
<tr>
<td>8</td>
<td>COM_5</td>
<td>34</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>NO_5</td>
<td>35</td>
<td>NO_6</td>
</tr>
<tr>
<td>10</td>
<td>—</td>
<td>36</td>
<td>COM_6</td>
</tr>
<tr>
<td>11</td>
<td>COM_7</td>
<td>37</td>
<td>—</td>
</tr>
<tr>
<td>12</td>
<td>NO_7</td>
<td>38</td>
<td>NO_8</td>
</tr>
<tr>
<td>13</td>
<td>—</td>
<td>39</td>
<td>COM_8</td>
</tr>
<tr>
<td>14</td>
<td>COM_9</td>
<td>40</td>
<td>—</td>
</tr>
<tr>
<td>15</td>
<td>NO_9</td>
<td>41</td>
<td>NO_10</td>
</tr>
<tr>
<td>16</td>
<td>—</td>
<td>42</td>
<td>COM_10</td>
</tr>
<tr>
<td>17</td>
<td>COM_11</td>
<td>43</td>
<td>—</td>
</tr>
</tbody>
</table>
Table 1-10  Alarm Output Pin Assignments (continued)

<table>
<thead>
<tr>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
<th>AMP Champ Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>NO_11</td>
<td>44</td>
<td>NO_12</td>
</tr>
<tr>
<td>19</td>
<td>—</td>
<td>45</td>
<td>COM_12</td>
</tr>
<tr>
<td>20</td>
<td>COM_13</td>
<td>46</td>
<td>—</td>
</tr>
<tr>
<td>21</td>
<td>NO_13</td>
<td>47</td>
<td>NO_14</td>
</tr>
<tr>
<td>22</td>
<td>—</td>
<td>48</td>
<td>COM_14</td>
</tr>
<tr>
<td>23</td>
<td>COM_15</td>
<td>49</td>
<td>—</td>
</tr>
<tr>
<td>24</td>
<td>NO_15</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>25</td>
<td>—</td>
<td>51</td>
<td>GND1</td>
</tr>
<tr>
<td>26</td>
<td>NO_0</td>
<td>52</td>
<td>GND2</td>
</tr>
</tbody>
</table>

Figure 1-24 illustrates the alarm input connectors.

Figure 1-24  Alarm Input Connector
Figure 1-25 illustrates the alarm output connectors.

**Figure 1-25  Alarm Output Connector**

| Connector Type | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 |
| COM_1          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_1           |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_3          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_3           |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_5          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_5           |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_7          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_7           |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_9          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_9           |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_11         |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_11          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_13         |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_13          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| COM_15         |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| NO_15          |   |   |   | XREF=7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |

Step 4  Continue with the “NTP-G12 Install and Close the FMEC Cover (ETSI Only)” procedure on page 1-63 as needed.

Stop. You have completed this procedure.
NTP-G12 Install and Close the FMEC Cover (ETSI Only)

Purpose
This procedure installs and closes the ONS 15454 ETSI FMEC cover.

Tools/Equipment
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

Prerequisite Procedures
NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
None

---

Step 1
Insert the cover carefully onto the left pin of the hinge (Figure 1-26).

Step 2
Move the cover to the right side towards the right pin of the hinge.

Step 3
Pull the right side of the hinge-locking spring (Figure 1-26). Push the cover onto the right pin until the spring snaps into place.

Figure 1-26  ONS 15454 ETSI FMEC Cover

Step 4
Attach the ground wire to the shelf.

Step 5
Attach the washer and nut.

Step 6
Attach the cover to the shelf using the screws on the top of the cover.
NTP-G13 Install the Rear Cover (ANSI Only)

**Purpose**
The following procedure explains how to install the rear cover on an ONS 15454 ANSI shelf.

**Tools/Equipment**
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

**Prerequisite Procedures**
- NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

**Required/As Needed**
- **Required**

**Onsite/Remote**
- Onsite

**Security Level**
- None

**Step 1**
Locate the three screws that run vertically along on each side of the backplane (Figure 1-27).

![Backplane Attachment for the Rear Cover](image)

**Tip**
Only six screws (three on each side) line up with the screw slots on the mounting brackets, making the screws easy to locate.
Step 2   Loosen the top and bottom screws on one edge of the backplane to provide room to slide the mounting brackets into place using the U-shaped screw slots on each end.

Step 3   Slide one of the mounting brackets into place and tighten the screws.

Step 4   Repeat Steps 2 and 3 for the second mounting bracket.

Step 5   Attach the cover by hanging it from the mounting screws on the back of the mounting brackets and pulling it down until it fits snugly into place.

   Figure 1-28 shows rear cover installation using spacers.

   Figure 1-28   Installing the Rear Cover with Spacers

Step 6   Continue with the “NTP-G14 Install DWDM Equipment” procedure on page 1-66.

Stop. You have completed this procedure.
NTP-G14 Install DWDM Equipment

Purpose
This procedure installs the optional DWDM assemblies.

Tools/Equipment
#2 Phillips screwdriver
Crimping tool (large enough for #10 to #14 AWG)
#14 AWG wire

Prerequisite Procedures
NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
Complete the “DLP-G27 Install the DCU Shelf Assembly” task on page 1-67 as needed.

Step 2
Complete the “DLP-G28 Install the Fiber Patch-Panel Tray” task on page 1-67 as needed.

Step 3
Complete the “DLP-G29 Install the Fiber-Storage Tray” task on page 1-68 as needed.

Step 4
Complete the “DLP-G8 Install the Air Ramp” task on page 1-19 as needed.

Step 5
Complete the “DLP-G30 Install the FlexLayer Shelf” task on page 1-68 as needed.

Note
Procedures for installing FlexLayer hardware in this chapter require that you have a network plan calculated for your DWDM network with Cisco MetroPlanner, Release 2.5. MetroPlanner is a DWDM planning tool that is available through your Cisco account representative. MetroPlanner prepares a shelf plan for each network node and calculates the power and attenuation levels for the DWDM cards installed in the node. For information about Cisco MetroPlanner, refer to the Cisco MetroPlanner DWDM Operations Guide, Release 2.5.

Step 6
Complete the “DLP-G31 Install the FlexLayer Modules” task on page 1-69 as needed.

Step 7
Complete the “DLP-G32 Install the Y-Cable Protection Modules” task on page 1-70 as needed.

Stop. You have completed this procedure.
DLP-G27 Install the DCU Shelf Assembly

Purpose
If you are installing dispersion compensation modules, use this task to install the Dispersion Compensation Unit (DCU) chassis.

Tools/Equipment
#2 Phillips screwdriver
Crimping tool
#14 AWG wire and lug

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
The DCU chassis requires 1 rack unit (RU) in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the RMU space specified in your site plan. See the “15.5 Typical DWDM Rack Layouts” section on page 15-17 for common site layout plans.

Step 2
Two sets of mounting brackets are included with the DCU mounting kit, one set each for 19-inch (482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of brackets for your rack. Change the brackets as required.

Step 3
Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the four screws.

Step 4
Connect a frame ground to the ground terminal provided on either side of the chassis. Use minimum #14 AWG wire.

Step 5
Return to your originating procedure (NTP).

DLP-G28 Install the Fiber Patch-Panel Tray

Purpose
This task installs the fiber patch-panel tray.

Tools/Equipment
#2 Phillips screwdriver

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
The fiber patch-panel tray requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the RMU space specified in your site plan. See the “15.5 Typical DWDM Rack Layouts” section on page 15-17 for common site configurations.

Step 2
Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as required.
DLP-G29 Install the Fiber-Storage Tray

**Purpose**
This task installs the fiber-storage tray. The fiber-storage tray stores slack fiber-optic cable.

**Tools/Equipment**
- #2 Phillips screwdriver

**Prerequisite Procedures**
- None

**Required/As Needed**
- As needed

**Onsite/Remote**
- Onsite

**Security Level**
- None

**Step 1**
The fiber-storage tray requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the RMU space specified in your site plan. See the “15.5 Typical DWDM Rack Layouts” section on page 15-17 for common site configurations.

**Step 2**
Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as required.

**Step 3**
Align the chassis with the rack mounting hole, insert the screws (4), and tighten.

**Step 4**
Return to your originating procedure (NTP).

DLP-G30 Install the FlexLayer Shelf

**Purpose**
This task installs the FlexLayer shelf. Perform this task if you are installing any FlexLayer modules.

**Tools/Equipment**
- #2 Phillips screwdriver
- FlexLayer shelf assembly (15216-FL-SA)

**Prerequisite Procedures**
- None

**Required/As Needed**
- As needed

**Onsite/Remote**
- Onsite

**Security Level**
- None

**Step 1**
The FlexLayer shelf requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the RMU space specified in your site plan. Refer to Chapter 15, “Shelf Hardware Reference” for typical DWDM site layout plans.

**Step 2**
A set of mounting brackets are included with the FlexLayer mounting kit, one set each for 19-inch (482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of brackets for your rack. Change the brackets as required.
Step 3 Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the three screws.

Step 4 Repeat this task as necessary for each FlexLayer shelf assembly you want to install.

Step 5 Return to your originating procedure (NTP).

---

**DLP-G31 Install the FlexLayer Modules**

**Purpose**

This task installs the FlexLayer modules in the FlexLayer shelf assembly. You can only install two-channel FlexLayer modules.

**Tools/Equipment**

- #2 Phillips screwdriver
- FlexLayer modules

**Prerequisite Procedures**

None

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite

**Security Level**

None

---

**Step 1** Determine the FlexLayer modules that you want to install in the FlexLayer shelf. The FlexLayer shelf can house up to four Add/Drop FlexLayer modules or four Y-cable splitter modules. Table 1-11 lists the two-channel FlexLayer modules and part numbers. Refer to Chapter 15, “Shelf Hardware Reference” for more information about FlexLayer modules.

**Table 1-11 ONS 15xxx FlexLayer Hardware Part Numbers**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15216-FLB-2-31.1=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1530.33 and 1531.12</td>
</tr>
<tr>
<td>15216-FLB-2-32.6=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1531.90 and 1532.68</td>
</tr>
<tr>
<td>15216-FLB-2-35.0=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1534.25 and 1535.04</td>
</tr>
<tr>
<td>15216-FLB-2-36.6=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1535.82 and 1536.61</td>
</tr>
<tr>
<td>15216-FLB-2-38.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1538.19 and 1538.98</td>
</tr>
<tr>
<td>15216-FLB-2-40.5=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1539.77 and 1540.56</td>
</tr>
<tr>
<td>15216-FLB-2-42.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1542.14 and 1542.94</td>
</tr>
<tr>
<td>15216-FLB-2-44.5=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1543.73 and 1544.53</td>
</tr>
<tr>
<td>15216-FLB-2-46.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1546.12 and 1546.92</td>
</tr>
<tr>
<td>15216-FLB-2-48.5=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1547.72 and 1548.51</td>
</tr>
<tr>
<td>15216-FLB-2-50.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1550.12 and 1550.92</td>
</tr>
<tr>
<td>15216-FLB-2-52.5=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1551.72 and 1552.52</td>
</tr>
<tr>
<td>15216-FLB-2-54.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1554.13 and 1554.94</td>
</tr>
<tr>
<td>15216-FLB-2-56.5=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1555.75 and 1556.55</td>
</tr>
<tr>
<td>15216-FLB-2-58.9=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1558.17 and 1558.98</td>
</tr>
<tr>
<td>15216-FLB-2-60.6=</td>
<td>ITU-100 GHz 2 Ch, FlexMod - 1559.79 and 1560.61</td>
</tr>
</tbody>
</table>
Step 2  Insert the appropriate module into the FlexLayer shelf assembly.

*Note*  FlexLayer modules are not listed in generated Cisco MetroPlanner 2.5 site plans.

Step 3  Use a Phillips screwdriver to install the two accompanying screws.  
*Figure 1-29* shows the FlexLayer shelf assembly and how the FlexLayer modules can be installed.

*Figure 1-29  ONS 15xxx FlexLayer Shelf Assembly*

![FlexLayer Shelf Assembly Diagram]

Step 4  Repeat this task as necessary for each FlexLayer module you want to install.

Step 5  Return to your originating procedure (NTP).

**DLP-G32 Install the Y-Cable Protection Modules**

**Purpose**  This task installs the Y-cable protection modules in the FlexLayer shelf assembly.

**Tools/Equipment**

- #2 Phillips screwdriver
- Y-Cable modules:
  - Multi-Mode Y Cable Protection FlexMod: 15216-CS-MM-Y=
  - Single-Mode Y Cable Protection FlexMod: 15216-CS-SM-Y=

**Prerequisite Procedures**  None

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite

**Security Level**  None

Step 1  Determine the Y-cable modules that you want to install in the FlexLayer shelf.
Step 2  Insert the appropriate Y-cable module into the FlexLayer shelf assembly. Use a Phillips screwdriver to install the two accompanying screws.

Step 3  Repeat this task as necessary for each Y-cable module you want to install (Figure 15-12 on page 15-14).

Step 4  Return to your originating procedure (NTP).

---

**NTP-G15 Install the Common Control Cards**

**Purpose**
This procedure describes how to install the common control cards.

**Tools/Equipment**
- Redundant TCC2/TCC2P cards
- AIC-I card (optional)

**Prerequisite Procedures**
- NTP-G2 Install the Shelf Assembly, page 1-8
- NTP-G14 Install DWDM Equipment, page 1-66

**Required/As Needed**
- Required

**Onsite/Remote**
- Onsite

**Security Level**
- Provisioning or higher

---

**Warning**
During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

---

**Caution**
Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside to edge of the shelf assembly.

---

**Note**
If protective clips are installed on the backplane connectors of the cards, remove the clips before installing the cards.

---

**Note**
If you install a card incorrectly, the FAIL LED flashes continuously.

---

**Step 1**
Complete the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-72.

**Note**
If you install the wrong card in a slot, see the “NTP-G107 Remove and Replace DWDM Cards” procedure on page 12-1.

---

**Step 2**
Complete the “DLP-G34 Install the AIC-I Card” task on page 1-75, if necessary.

---

**Step 3**
Continue with the “NTP-G16 Perform the Shelf Installation Acceptance Test” procedure on page 1-76.
DLP-G33 Install the TCC2 or TCC2P Card

**Purpose**
This task installs redundant TCC2/TCC2P cards. The first card you install in the ONS 15454 must be a TCC2/TCC2P card, and it must initialize before you install any cross-connect or traffic cards.

**Tools/Equipment**
Two TCC2/TCC2P cards

**Prerequisite Procedures**
None

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Caution**
Do not remove a TCC2/TCC2P card during the software transfer process, which is indicated by alternate flashing FAIL and ACT/STBY LEDs. Removing a TCC2/TCC2P during the software transfer process will corrupt the system memory.

**Note**
Allow each card to boot completely before installing the next card.

---

**Step 1**
Open the latches/ejectors of the first TCC2/TCC2P card that you will install.

**Step 2**
Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the receptacle at the back of the slot (Slot 7 or 11).

**Note**
In Step 4 you will be instructed to watch the LED activity (sequence) on the front of the TCC2/TCC2P card. This activity begins immediately after you close the latches in Step 3.

---

**Step 3**
Verify that the card is inserted correctly and close the latches/ejectors on the card.

**Note**
It is possible to close the latches/ejectors when the card is not completely plugged into the back panel of the shelf assembly. Ensure that you cannot insert the card any farther.

---

If you insert a card into a slot provisioned for a different card, all LEDs turn off.

**Step 4**
As needed, go to Step a to verify the LED activity on the TCC2 card. For the TCC2P card, go to Step b.

a. For the TCC2 card:
   - All LEDs turn on for about 5 seconds. The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the green ACO LED turn on for about 10 seconds.
   - The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds.
   - The red FAIL LED blinks for about 10 seconds. (If both TCC2 cards are installed, this LED blinks on the other TCC2 card, as well.)
   - The red FAIL LED turns on for about 5 seconds.
   - Both green PWR LEDs turn on for 5 seconds. The PWR LEDs then turn red for 2 to 3 minutes before going to steady green.

b. For the TCC2P card:
While the PWR LEDs are red, the ACT/STBY, MJ, and MN LEDs turn on, followed by the SNYC LED.

The boot up process is complete when the PWR LEDs turn green and the ACT/STBY remains on. (The ACT/STBY LED will be green if this is the first TCC2 card installed, and amber if this is the second TCC2 card installed.)

**Note**
It might take up to 4 minutes for the A and B power alarms to clear.

**Note**
Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the Alarms tab.

**Note**
If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while the TCC2 card initializes. The alarm should clear after the card completely boots.

**Note**
If the FAIL LED is on continuously, see the tip below about the TCC2 card automatic upload.

b. For the TCC2P card:

- All LEDs turn on briefly. The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the green ACO LED turn on for about 10 seconds.
- The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds.
- The red FAIL LED blinks for about 10 seconds. (If both TCC2 cards are installed, this LED blinks on the other TCC2 card as well.)
- The red FAIL LED turns on for about 5 seconds.
- The red FAIL LED blinks for about 5 seconds and then becomes solid.
- All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off for about 10 seconds.
- Both green PWR LEDs turn on for 5 seconds. The PWR LEDs then turn red for 2 to 3 minutes before going to steady green.
- The yellow ACT/STBY turns on and the PWR LEDs turn red for 2 to 3 minutes. (The Sync LED may be green at this time.)
- The yellow ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to turn on while the DCC processor boots.)

**Note**
It might take up to 3 minutes for the A and B power alarms to clear.

**Note**
Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the Alarms tab.
Chapter 1  Install the Shelf and Common Control Cards

DLP-G33 Install the TCC2 or TCC2P Card

Note
If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while the TCC2P card initializes. The alarm should clear after the card completely boots.

Note
If the FAIL LED is on continuously, see the tip in Step 8 about the TCC2P card automatic upload.

Step 5
Verify that the ACT/STBY LED is green if this is the first powered-up TCC2/TCC2P card installed, or yellow for standby if this is the second powered-up TCC2/TCC2P. The IP address, temperature of the node, and time of day appear on the LCD. The default time and date is 12:00 AM, January 1, 1970.

Step 6
The LCD cycles through the IP address, node name, and software version. Verify that the correct software version displays on the LCD.

Step 7
If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the correct software version, refer to your next level of technical support, upgrade the software, or remove the TCC2/TCC2P card and install a replacement card.

Refer to the release-specific software upgrade document to replace the software. To exchange the TCC2/TCC2P card, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 8
Repeat Steps 1 through 7 for the redundant TCC2/TCC2P card If both TCC2/TCC2P cards are already installed, proceed to Step 9.

Tip
If you install a standby TCC2/TCC2P card that has a different software version than the active TCC card, the newly installed standby TCC2/TCC2P card automatically copies the software version from the active TCC2/TCC2P card. You do not need to do anything in this situation. However, the loading TCC2/TCC2P card does not boot up in the normal manner. When the standby card is first inserted, the LEDs follow most of the normal bootup sequence. After the red FAIL LED turns on for about 5 seconds, the FAIL LED and the ACT/STBY LED begin to flash alternately for up to 30 minutes while the new software loads onto the active TCC2/TCC2P card. After loading the new software, the upgraded TCC2/TCC2P card’s LEDs repeat the appropriate bootup sequence, and the amber ACT/STBY LED turns on.

Note
If you insert a card into a slot provisioned for a different card, all LEDs turn off.

Note
Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the Alarms tab.

Step 9
Return to your originating procedure (NTP).
# DLP-G34 Install the AIC-I Card

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task installs the AIC-I card. The AIC-I card provides connections for external alarms and controls (environmental alarms).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>AIC-I card</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G33 Install the TCC2 or TCC2P Card, page 1-72</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite</td>
</tr>
<tr>
<td>Security Level</td>
<td>None</td>
</tr>
</tbody>
</table>

Note: When installing cards, allow each card to boot completely before installing the next card.

### Step 1
Open the latches/ejectors on the card.

### Step 2
Use the latches/ejectors to firmly slide the card along the guide rails in Slot 9 until the card plugs into the receptacle at the back of the slot.

### Step 3
Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note: It is possible to close the latches/ejectors when the card is not completely plugged into the backplane. Ensure that you cannot insert the card any further.

### Step 4
Verify the following:

- The red FAIL LED turns on for 1 second, then blinks for up to 5 seconds.
- The PWR A and PWR B LEDs become red and the two INPUT/OUTPUT LEDs become green for approximately 3 seconds.
- The PWR A LED turns green, the INPUT/OUTPUT LEDs turn off, and the ACT LED turns on.

Note: It might take up to 3 minutes for the PWR A and PWR B LEDs to update.

Note: If the red FAIL LED does not turn on, check the power.

Note: If you insert a card into a slot provisioned for a different card, no LEDs turn on.

Note: If the red FAIL LED is on continuously or the LEDs act erratically, the card is not installed properly. Remove the card and repeat Steps 1 to 4.

### Step 5
Return to your originating procedure (NTP).
NTP-G16 Perform the Shelf Installation Acceptance Test

**Purpose**  
Use this procedure to perform a shelf installation acceptance test for the ONS 15454 ETSI and ONS 15454 ANSI.

**Tools/Equipment**  
Voltmeter

Oval and/or block ferrites

**Prerequisite Procedures**  
Applicable procedures in Chapter 1, “Install the Shelf and Common Control Cards”

**Required/As Needed**  
Required

**Onsite/Remote**  
Onsite

**Security Level**  
None

---

**Step 1**  
If you installed an ONS 15454 ETSI shelf, complete Table 1-12 by verifying that each applicable procedure was completed.

<table>
<thead>
<tr>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6</td>
<td></td>
</tr>
<tr>
<td>NTP-G2 Install the Shelf Assembly, page 1-8</td>
<td></td>
</tr>
<tr>
<td>NTP-G3 Open and Remove the Front Door, page 1-20</td>
<td></td>
</tr>
<tr>
<td>NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23</td>
<td></td>
</tr>
<tr>
<td>NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-28</td>
<td></td>
</tr>
<tr>
<td>NTP-G7 Install the Power and Ground, page 1-30</td>
<td></td>
</tr>
<tr>
<td>NTP-G8 Install the Fan-Tray Assembly, page 1-40</td>
<td></td>
</tr>
<tr>
<td>NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-47</td>
<td></td>
</tr>
<tr>
<td>NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-63</td>
<td></td>
</tr>
<tr>
<td>NTP-G14 Install DWDM Equipment, page 1-66</td>
<td></td>
</tr>
<tr>
<td>NTP-G15 Install the Common Control Cards, page 1-71</td>
<td></td>
</tr>
</tbody>
</table>

**Step 2**  
If you installed an ONS 15454 ANSI shelf, complete Table 1-13 by verifying that each applicable procedure was completed.

<table>
<thead>
<tr>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6</td>
<td></td>
</tr>
<tr>
<td>NTP-G2 Install the Shelf Assembly, page 1-8</td>
<td></td>
</tr>
<tr>
<td>NTP-G3 Open and Remove the Front Door, page 1-20</td>
<td></td>
</tr>
<tr>
<td>NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26</td>
<td></td>
</tr>
<tr>
<td>NTP-G7 Install the Power and Ground, page 1-30</td>
<td></td>
</tr>
</tbody>
</table>
Table 1-13  ONS 15454 ANSI Shelf Installation Task Summary (continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP-G8 Install the Fan-Tray Assembly, page 1-40</td>
<td></td>
</tr>
<tr>
<td>NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44</td>
<td></td>
</tr>
<tr>
<td>NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-47</td>
<td></td>
</tr>
<tr>
<td>NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-58</td>
<td></td>
</tr>
<tr>
<td>NTP-G13 Install the Rear Cover (ANSI Only), page 1-64</td>
<td></td>
</tr>
<tr>
<td>NTP-G14 Install DWDM Equipment, page 1-66</td>
<td></td>
</tr>
<tr>
<td>NTP-G15 Install the Common Control Cards, page 1-71</td>
<td></td>
</tr>
</tbody>
</table>

Step 3  Complete the “DLP-G35 Inspect the Shelf Installation and Connections” task on page 1-77.
Step 4  Complete the “DLP-G36 Measure Voltage” task on page 1-78.
Step 5  Continue with Chapter 2, “Connect the PC and Log into the GUI.”

Stop. You have completed this procedure.

DLP-G35 Inspect the Shelf Installation and Connections

Purpose  Use this task to inspect the shelf installation and connections and verify that everything is installed and connected properly.

Tools/Equipment  None
Prerequisite Procedures  None
Required/As Needed  Required
Onsite/Remote  Onsite
Security Level  None

Step 1  Make sure all external wiring connections on the backplane (i.e. power, ground, alarms, etc.) are secure. If a wire or cable is loose, return to the appropriate procedure in this chapter to correct it.
Step 2  (ETSI only) To check that the FMEC cover is seated correctly, verify that it can be easily closed without disturbing cables.
Step 3  Return to your originating procedure (NTP).
DLP-G36 Measure Voltage

**Purpose**
Use this task to measure the power to verify correct power and returns.

**Tools/Equipment**
Voltmeter

**Prerequisite Procedures**
None

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Step 1**
Using a voltmeter, verify the office ground and power:

a. Place the black lead (positive) on the frame ground on the bay. Hold it there while completing Step b.

b. Place the red lead (negative) on the fuse power points on the third-party power distribution panel to verify that they read between –40.5 VDC and –57 VDC (power) and 0 (return ground).

**Step 2**
Using a voltmeter, verify the shelf ground and power wiring:

a. Place the black lead (positive) on the RET1 and the red lead on the BAT1 point. Verify a reading between –40.5 VDC and –57 VDC. If there is no voltage, check the following and correct if necessary:
   - Battery and ground are reversed to the shelf.
   - Battery is open or missing.
   - Return is open or missing.

**Step 3**
Repeat Step 1 and Step 2 for the RET2 and BAT2 of the redundant power supply input.

**Step 4**
Return to your originating procedure (NTP).
Connect the PC and Log into the GUI

This chapter explains how to connect PCs and workstations to the Cisco ONS 15454 and how to log into Cisco Transport Controller (CTC) software, which is the ONS 15454 Operation, Administration, Maintenance and Provisioning (OAM&P) user interface. Procedures for connecting to the ONS 15454 ANSI using TL1 are provided in the *Cisco ONS SONET TL1 Command Guide*. Procedures for connecting to the ONS 15454 ETSI using TL1 are provided in the *Cisco ONS 15454 SDH TL1 Command Guide*.

**Note**
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. **NTP-G17 Set Up Computer for CTC, page 2-2**—Complete this procedure if your PC or workstation has never been connected to an ONS 15454.
2. **NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9**—Complete this procedure to set up your computer for an onsite craft connection to the ONS 15454.
3. **NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21**—Complete this procedure to set up your computer to connect to the ONS 15454 using a corporate LAN.
4. **NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23**—Complete this procedure to set up your computer for remote modem access to the ONS 15454.
5. **NTP-G21 Log into the ONS 15454 GUI, page 2-24**—Complete this procedure to log into CTC.
NTP-G17 Set Up Computer for CTC

Purpose
This procedure configures your PC or UNIX workstation to run CTC.

Tools/Equipment
Cisco ONS 15454 Release 6.0 software CD

Prerequisite Procedures
Chapter 15, “Shelf Hardware Reference”

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
None

Note
If you will log into nodes running CTC software earlier than Software Release 4.6, uninstall Java Runtime Environment (JRE) 1.4.2 and reinstall JRE 1.3.1_2. To run Software R4.7, R5.0, or R6.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Step 1
If your computer does not have an appropriate browser installed, complete the following:

- To install Netscape 7.x, download the browser from the following site: http://channels.netscape.com/ns/browsers/default.jsp
- To install Internet Explorer 6.x on a PC, download the browser from the following site: http://www.microsoft.com

Step 2
If your computer is a Windows PC, complete the “DLP-G37 Run the CTC Installation Wizard for Windows” task on page 2-3, then go to Step 4.

Step 3
If your computer is a UNIX workstation, complete the “DLP-G38 Run the CTC Installation Wizard for UNIX” task on page 2-6.

Step 4
When your PC or workstation is set up, continue with the setup procedure appropriate to your network:

- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21
- NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23

Note
Cisco recommends that you configure your browser to disable the caching of user IDs/passwords on computers used to access Cisco optical equipment.

In Internet Explorer, choose Tools > Internet Options > Content. Click Auto Complete and uncheck the User names and passwords on forms option.

In Netscape 7.0, choose Edit > Preferences > Privacy & Security > Forms and uncheck the option to save form data. For passwords, choose Edit > Preferences > Privacy & Security > Passwords and uncheck the option to remember passwords. Note that passwords can be stored in an encrypted format. Netscape versions earlier than 6.0 do not cache user IDs and passwords.

Stop. You have completed this procedure.
## DLP-G37 Run the CTC Installation Wizard for Windows

**Purpose**
This task installs the CTC online user manuals, Acrobat Reader 6.0.1, JRE 1.4.2, and the CTC JAR files. JRE 1.4.2 is required to run Release 6.0. Preinstalling the CTC JAR files saves time at initial login. If the JAR files are not installed, they are downloaded from the TCC2/TCC2P card the first time you log in.

**Tools/Equipment**
Cisco ONS 15454 Release 6.0 software CD

**Prerequisite Procedures**
None

**Required/As Needed**
This task is required if you will use a Windows computer to run CTC and if any one of the following is true:
- JRE 1.4.2 is not installed.
- CTC online user manuals are not installed and are needed.
- CTC JAR files are not installed and needed.

**Onsite/Remote**
Onsite or remote

**Security Level**
None

---

### Note
If you will log into nodes running CTC software earlier than Software Release 4.6, uninstall JRE 1.4.2 and reinstall JRE 1.3.1_2. To run Software R4.7, R5.0, or R6.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

### Note
JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x.

---

**Step 1**
Verify that your computer has the following:
- Processor—Pentium III, 700 Mhz or faster
- RAM—384 MB recommended, 512 MB optimum
- Hard drive—20 GB hard drive recommended with at least 50 MB of space available
- Operating system—Windows 98 (1st and 2nd editions), Windows NT 4.0 (with Service Pack 6a), Windows 2000 (with Service Pack 3), or Windows XP Home

If your operating system is Windows NT 4.0, verify that Service Pack 6a or later is installed. From the Start menu, choose **Programs > Administrative Tools > Windows NT Diagnostics** and check the service pack on the Version tab of the Windows NT Diagnostics dialog box. If Service Pack 6a or later is not installed, do not continue. Install Service Pack 6a following the computer upgrade procedures for your site.

### Note
Processor and RAM requirements are guidelines. CTC performance is faster if your computer has a faster processor and more RAM.

**Step 2**
Insert the Cisco ONS 15454 Release 6.0 software CD into your computer CD drive. The installation program begins running automatically. If it does not start, navigate to the CD directory and double-click setup.exe.
The Cisco Transport Controller Installation Wizard displays the components that will be installed on your computer:

- Java Runtime Environment 1.4.2
- Acrobat Reader 6.0.1
- Online User Manuals
- CTC JAR files

**Step 3** Click **Next**.

**Step 4** Complete one of the following:

- Click **Typical** to install both the Java Runtime Environment and online user manuals. If you already have JRE 1.4.2 installed on your computer, choose **Custom**.
- Click **Custom** if you want to install either the JRE or the online user manuals. By default, Acrobat Reader and the online user manuals are selected.

**Step 5** Click **Next**.

**Step 6** Complete the following, as applicable:

- If you selected Typical in **Step 4**, skip this step and continue with **Step 7**.
- If you selected Custom in **Step 4**, check the CTC component that you want to install and click **Next**.
  - If you selected Online User Manuals, continue with **Step 7**.
  - If you did not select Online User Manuals, continue with **Step 9**.

**Step 7** The directory where the installation wizard will install the CTC online user manuals appears. The default is C:\Program Files\Cisco\CTC\Documentation.

- If you want to change the CTC online user manuals directory, type the new directory path in the Directory Name field, or click **Browse** to navigate to the directory.
- If you do not want to change the directory, skip this step.

**Step 8** Click **Next**.

**Step 9** Review the components that will be installed. If you want to change the components, complete one of the following. If not, proceed to **Step 10**.

- If you selected Typical in **Step 4**, click **Back** twice to return to the installation setup type page. Choose **Custom** and repeat **Steps 5** through **8**.
- If you selected Custom in **Step 4**, click **Back** once or twice (depending on the components selected) until the component selection page appears. Repeat **Steps 6** through **8**.

**Step 10** Click **Next**. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom in **Step 4** and did not check Java Runtime Environment 1.4.2, continue with **Step 12**.

**Step 11** To install the JRE, complete the following:

a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and choose one of the following:

  - I accept the terms of the license agreement—Accepts the license agreement. Continue with **Step b**.
  - I do not accept the terms of the license agreement—Disables the Next button on the Java 2 Runtime Environment License Agreement dialog box. Click **Cancel** to return to the CTC installation wizard. CTC will not install the JRE. Continue with **Step 12**.
b. Click Next.

c. Choose one of the following:
   - Click Typical to install all JRE features. If you select Typical, the JRE version installed will automatically become the default JRE version for your browsers.
   - Click Custom if you want to select the components to install and select the browsers that will use the JRE version.

d. Click Next.

e. If you selected Typical, continue with Step h. If you selected Custom, click the drop-down list for each program feature that you want to install and choose the desired setting. The program features include:
   - Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European languages.
   - Support for Additional Languages—Adds support for non-European languages.
   - Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management capabilities.

   The drop-down list options for each program feature include:
   - This feature will be installed on the local hard drive—Installs the selected feature.
   - This feature and all subfeatures will be installed on the local hard drive—Installs the selected feature and all subfeatures.
   - Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime Environment).

   To modify the directory where the JRE version is installed, click Change, navigate to the desired directory, and click OK.

f. Click Next.


g. In the Browser Registration dialog box, check the browsers that you want to register with the Java Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both browser check boxes unchecked.

h. Click Next.

i. Click Finish.

Note If you are uninstalling the JRE, click Remove.
Step 13  Click Finish.
Step 14  Return to your originating procedure (NTP).

DLP-G38 Run the CTC Installation Wizard for UNIX

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task installs the CTC online user manuals, Acrobat 6.0.1, and JRE 1.4.2 on UNIX workstations, as necessary. JRE 1.4.2 is required to run Release 6.0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>Cisco ONS 15454 Release 6.0 software CD</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>None</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>This task is required if you will use a UNIX workstation to run CTC and any of the following are true:</td>
</tr>
<tr>
<td></td>
<td>• JRE 1.4.2 is not installed.</td>
</tr>
<tr>
<td></td>
<td>• CTC online user manuals are not installed and are needed.</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>None</td>
</tr>
</tbody>
</table>

Note  If you will log into nodes running CTC software earlier than Software R4.6, uninstall JRE 1.4.2 and reinstall JRE 1.3.1_2. To run Software R4.7, R5.0, or R6.0, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Note  JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x.

Step 1  Verify that your computer has the following:

• RAM—384 MB recommended, 512 MB optimum
• Hard drive—20 GB hard drive recommended with at least 50 MB of space available
• Operating system—Solaris 8 or 9

Note  These requirements are guidelines. CTC performance is faster if your computer has a faster processor and more RAM.

Step 2  Change the directory. Type:

```
cd /cdrom/cdrom0/
```

Step 3  From the techdoc454 CD directory, type:

```
./setup.bat
```

The Cisco Transport Controller Installation Wizard displays the components that will be installed on your computer:

• Java Runtime Environment 1.4.2
• Acrobat Reader 6.0.1
• Online User Manuals
• CTC JAR files

Step 4  Click **Next**.

Step 5  Complete one of the following:
• Click **Typical** to install both the Java Runtime Environment and online user manuals. If you already have JRE 1.4.2 installed on your computer, choose **Custom**.
• Click **Custom** if you want to install either the JRE or the online user manuals.

Step 6  Click **Next**.

Step 7  Complete the following, as applicable:
• If you selected Typical in **Step 5**, continue with **Step 8**.
• If you selected Custom in **Step 5**, check the CTC component that you want to install and click **Next**.
  – If you selected Online User Manuals, continue with **Step 8**.
  – If you did not select Online User Manuals, continue with **Step 10**.

Step 8  The directory where the installation wizard will install the CTC online user manuals appears. The default is `/usr/doc/ctc`.
• If you want to change the CTC online user manuals directory, type the new directory path in the Directory Name field, or click **Browse** to navigate to the directory.
• If you do not want to change the CTC online user manuals directory, skip this step.

Step 9  Click **Next**.

Step 10  Review the components that will be installed.
• If you selected Typical in **Step 5**, click **Back** twice to return to the installation setup type page. Choose **Custom** and repeat Steps 6 through 9.
• If you selected Custom in **Step 5**, click **Back** once or twice (depending on the components selected) until you reach the component selection page and check the desired components. Repeat Steps 7 through 9.

Step 11  Click **Next**. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom in **Step 4** and did not check Java Runtime Environment 1.4.2, continue with **Step 13**.

Step 12  To install the JRE, complete the following:
  a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and choose one of the following:
    • I accept the terms of the license agreement—Accepts the license agreement. Continue with **Step b**.
    • I do not accept the terms of the license agreement—Disables the Next button on the Java 2 Runtime Environment License Agreement dialog box. Click **Cancel** to return to the CTC installation wizard. CTC will not install the JRE. Continue with **Step 13**.
  
  **Note**  If JRE 1.4.2 is already installed on your computer, the License Agreement dialog box does not appear. You must click Next and then choose Modify to change the JRE installation or Remove to uninstall the JRE. If you choose Modify and click Next, continue with **Step e**. If you choose Remove and click Next, continue with **Step i**.

b. Click **Next**.
c. Choose one of the following:
   - Click **Typical** to install all JRE features. If you select Typical, the JRE version installed will automatically become the default JRE version for your browsers.
   - Click **Custom** if you want to select the components to install and select the browsers that will use the JRE version.

d. Click **Next**.

e. If you selected Typical, continue with Step i. If you selected Custom, click the drop-down list for each program feature that you want to install and choose the desired setting. The program features include:
   - Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European languages.
   - Support for Additional Languages—Adds support for non-European languages.
   - Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management capabilities.

   The drop-down list options for each program feature include:
   - This feature will be installed on the local hard drive—Installs the selected feature.
   - This feature and all subfeatures will be installed on the local hard drive—Installs the selected feature and all subfeatures.
   - Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime Environment).

   To modify the directory where the JRE version is installed, click **Change**, navigate to the desired directory, and click **OK**.

f. Click **Next**.

g. In the Browser Registration dialog box, check the browsers that you want to register with the Java Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both browser check boxes unchecked.

   **Note** Setting the JRE version as the default for these browsers might cause problems with these browsers.

h. Click **Next**.

i. Click **Finish**.

   **Note** If you are uninstalling the JRE, click **Remove**.

**Step 13** In the Cisco Transport Controller Installation Wizard, click **Next**. The online user manuals are installed.

**Step 14** Click **Finish**.

   **Note** Be sure to record the names of the directories you choose for JRE and the online user manuals.

**Step 15** Return to your originating procedure (NTP).
NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454

Purpose
This procedure explains how to set up a PC running Windows or a Solaris workstation for an onsite local craft connection to the ONS 15454.

Tools/Equipment
Network interface card (NIC), also referred to as an Ethernet card
Straight-through (CAT-5) LAN cable

Prerequisite Procedures
NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
None

Step 1
Complete one of the CTC computer setup tasks shown in Table 2-1 based on your CTC connection environment.

<table>
<thead>
<tr>
<th>CTC Connection Environment</th>
<th>CTC Computer Setup Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are connecting from a Windows PC.</td>
<td>DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses, page 2-11</td>
</tr>
<tr>
<td>All nodes that you will access run software earlier than Release 3.3.</td>
<td></td>
</tr>
<tr>
<td>You will connect to one ONS 15454.</td>
<td></td>
</tr>
<tr>
<td>You need to access non-ONS 15454 applications such as ping and tracert (trace route).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>You are connecting from a Windows PC.</td>
<td>DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol, page 2-13</td>
</tr>
<tr>
<td>The CTC computer is provisioned for Dynamic Host Configuration Protocol (DHCP).</td>
<td></td>
</tr>
<tr>
<td>The ONS 15454 has DHCP forwarding enabled.</td>
<td></td>
</tr>
<tr>
<td>The ONS 15454 is connected to a DHCP server.</td>
<td></td>
</tr>
</tbody>
</table>
| Note The ONS 15454 does not provide IP addresses. If DHCP is enabled, it passes DCHP requests to an external DHCP server. | Note Do not use this task for initial node turn-up. Use the task only if DHCP forwarding is enabled on the ONS 15454. By default, DHCP is not enabled. To enable it, see the “NTP-G26 Set Up CTC Network Access” procedure on page 3-11.
Step 2  
Connect a straight-through CAT-5 LAN cable from the PC or Solaris workstation NIC to one of the following:
- RJ-45 (LAN) port on the active or standby TCC2/TCC2P card
- RJ-45 (LAN) port on a hub or switch to which the ONS 15454 is physically connected

**Note**  
For instructions on crimping your own straight-through (CAT-5) LAN cables, refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide*.

**Note**  
For initial shelf turn-up, you should connect your PC directly to the LAN port on the TCC2/TCC2P card of the ONS 15454.

Step 3  
After setting up your CTC computer, continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-24 as needed.

Stop. You have completed this procedure.
DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses

**Purpose**
This task sets up your computer for a local craft connection to the ONS 15454 when:
- You will access nodes running software releases earlier than Software Release 3.3.
- You will connect to one ONS 15454; if you will connect to multiple ONS 15454s, you might need to reconfigure your computer’s IP settings each time you connect to an ONS 15454.
- You need to use non-ONS 15454 applications such as ping and tracert (trace route).

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G17 Set Up Computer for CTC, page 2-2

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Step 1**
Verify the operating system that is installed on your computer:

a. From the Windows Start menu, choose *Settings > Control Panel*.

b. In the Control Panel window, double-click the *System* icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

**Step 2**
According to the Windows operating system installed on your computer, perform one of the following steps:
- For Windows 98, complete Step 3.
- For Windows NT 4.0, complete Step 4.
- For Windows 2000, complete Step 5.
- For Windows XP, complete Step 6.

**Step 3**
If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose *Settings > Control Panel*.

b. In the Control Panel dialog box, click the *Network* icon.

c. In the Network dialog box, choose *TCP/IP* for your NIC card, then click *Properties*.

d. In the TCP/IP Properties dialog box, click the *DNS Configuration* tab and choose *Disable DNS*.

e. Click the *WINS Configuration* tab and choose *Disable WINS Resolution*.

f. Click the *IP Address* tab.

g. In the IP Address window, click *Specify an IP address*.

h. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address except for the last octet. The last octet must be 1 or 3 through 254. This IP address appears on the LCD unless its display is suppressed during node provisioning.
DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses

Chapter 2: Connect the PC and Log into the GUI

**DLP-G39** Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is **255.255.255.0** (24 bit).

j. Click **OK**.

k. In the TCP/IP dialog box, click the **Gateway** tab.

l. In the New Gateway field, type the ONS 15454 IP address. Click **Add**.

m. Verify that the IP address appears in the Installed Gateways field, then click **OK**.

n. When the prompt to restart your PC appears, click **Yes**.

o. Proceed to **Step 7**.

**Step 4** If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the **Network** icon.

c. In the Network dialog box, click the **Protocols** tab, choose TCP/IP Protocol, then click **Properties**.

d. Click the **IP Address** tab.

e. In the IP Address window, click **Specify an IP address**.

f. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

g. In the Subnet Mask field, type **255.255.255.0**.

h. Click **Advanced**.

i. In the Gateways List, click **Add**. The TCP/IP Gateway Address dialog box appears.

j. Type the ONS 15454 IP address in the Gateway Address field.

k. Click **Add**.

l. Click **OK**.

m. Click **Apply**.

n. In some cases, Windows NT 4.0 prompts you to reboot your PC. If you receive this prompt, click **Yes**.

o. Proceed to **Step 7**.

**Step 5** If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > Local Area Connection.

b. In the Local Area Connection Status dialog box, click **Properties**.

c. On the General tab, choose Internet Protocol (TCP/IP), then click **Properties**.

d. Click **Use the following IP address**.

e. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

f. In the Subnet Mask field, type **255.255.255.0**.

g. In the Default Gateway field, type the ONS 15454 IP address.

h. Click **OK**.

i. In the Local Area Connection Properties dialog box, click **OK**.
### Chapter 2      Connect the PC and Log into the GUI

#### DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol

**Step 6**
If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP configuration:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>From the Windows Start menu, choose <strong>Control Panel &gt; Network Connections</strong>.</td>
</tr>
<tr>
<td>b.</td>
<td>From the Network Connections dialog box, click the <strong>Local Area Connection</strong> icon.</td>
</tr>
<tr>
<td>c.</td>
<td>From the Local Area Connection Properties dialog box, choose <strong>Internet Protocol (TCP/IP)</strong>, then click <strong>Properties</strong>.</td>
</tr>
<tr>
<td>d.</td>
<td>In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.</td>
</tr>
<tr>
<td>e.</td>
<td>In the Subnet Mask field, type <strong>255.255.255.0</strong>.</td>
</tr>
<tr>
<td>f.</td>
<td>In the Default Gateway field, type the ONS 15454 IP address.</td>
</tr>
<tr>
<td>g.</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>h.</td>
<td>In the Local Area Connection Properties dialog box, click <strong>OK</strong>.</td>
</tr>
<tr>
<td>i.</td>
<td>In the Local Area Connection Status dialog box, click <strong>Close</strong>.</td>
</tr>
</tbody>
</table>

**Step 7**
Return to your originating procedure (NTP).

---

**DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol**

**Purpose**
This task sets up your computer for craft connection to the ONS 15454 using DHCP.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G17 Set Up Computer for CTC, page 2-2
- NTP-G26 Set Up CTC Network Access, page 3-11

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Note**
Do not use this task for initial node turn-up. Use the task only if DHCP forwarding is enabled on the ONS 15454. By default, DHCP is not enabled. To enable it, see the “NTP-G26 Set Up CTC Network Access” procedure on page 3-11.

---

**Note**
The ONS 15454 does not provide the IP addresses. If DHCP forwarding is enabled, it passes DHCP requests to an external DHCP server.
Step 1  Verify the operating system that is installed on your computer:
   a. From the Windows Start menu, choose **Settings > Control Panel**.
   b. In the Control Panel window, double-click the **System** icon.
   c. On the General tab of the System Settings window, verify that the Windows operating system is one of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2  According to the Windows operating system installed on your computer, perform one of the following steps:
   - For Windows 98, complete Step 3.
   - For Windows NT 4.0, complete Step 4.
   - For Windows 2000, complete Step 5.
   - For Windows XP, complete Step 6.

Step 3  If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP configuration:
   a. From the Windows Start menu, choose **Settings > Control Panel**.
   b. In the Control Panel dialog box, click the **Network** icon.
   c. In the Network dialog box, select **TCP/IP** for your NIC, then click **Properties**.
   d. In the TCP/IP Properties dialog box, click the **DNS Configuration** tab and choose **Disable DNS**.
   e. Click the **WINS Configuration** tab and choose **Disable WINS Resolution**.
   f. Click the **IP Address** tab.
   g. In the IP Address window, click **Obtain an IP address automatically**.
   h. Click **OK**.
   i. When the prompt to restart your PC appears, click **Yes**.
   j. Proceed to Step 7.

Step 4  If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP configuration:
   a. From the Windows Start menu, choose **Settings > Control Panel**.
   b. In the Control Panel dialog box, click the **Network** icon.
   c. In the Network dialog box, click the **Protocols** tab, choose **TCP/IP Protocol**, then click **Properties**.
   d. Click the **IP Address** tab.
   e. In the IP Address window, click **Obtain an IP address from a DHCP server**.
   f. Click **OK**.
   g. Click **Apply**.
   h. If Windows prompts you to restart your PC, click **Yes**.
   i. Proceed to Step 7.

Step 5  If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP configuration:
   a. From the Windows Start menu, choose **Settings > Network and Dial-up Connections > Local Area Connection**.
   b. In the Local Area Connection Status dialog box, click **Properties**.
Chapter 2      Connect the PC and Log into the GUI

DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol

Step 6  If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

b. In the Network Connections dialog box, click Local Area Connection.

c. In the Local Area Connection Status dialog box, click Properties.

d. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

e. Click Obtain an IP address from a DHCP server.

f. Click OK.

g. In the Local Area Connection Properties dialog box, click OK.

h. Proceed to Step 7.

Step 7  Return to your originating procedure (NTP).

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Obtain an IP address from a DHCP server.

e. Click OK.

f. In the Local Area Connection Properties dialog box, click OK.

g. In the Local Area Connection Status dialog box, click Close.

h. Proceed to Step 7.
DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection

Purpose

This task sets up your computer for local craft connection to the ONS 15454 when:

- If you are using an ANSI shelf, you will connect to the ONS 15454 Ethernet port or backplane LAN pins either directly or through a hub.
- If you are using an ETSI shelf, you will connect to the ONS 15454 Ethernet port or the RJ-45 jack on the MIC-C/T/P FMEC either directly or through a hub.
- All nodes that you will access are running Software R3.3 or later.
- You will connect to multiple ONS 15454s and do not want to reconfigure your IP address each time.
- You do not need to access non-ONS 15454 applications such as ping and tracert (trace route).

Tools/Equipment

None

Prerequisite Procedures

NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

None

Step 1

Verify the operating system that is installed on your computer:

a. From the Windows Start menu, choose Settings > Control Panel.

Note

In Windows XP, you can select Control Panel directly from the Start menu. Make sure you are in Classic View before continuing with this procedure.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2

According to the Windows operating system installed on your computer, perform one of the following steps:

- For Windows 98, complete Step 3.
- For Windows NT 4.0, complete Step 4.
- For Windows 2000, complete Step 5.
- For Windows XP, complete Step 6.

Step 3

If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your NIC, then click Properties.
Chapter 2 Connect the PC and Log into the GUI

DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection

Step 2 f. In the TCP/IP Properties dialog box, click the **DNS Configuration** tab and choose **Disable DNS**.

e. Click the **Wins Configuration** tab and choose **Disable Wins Resolution**.

f. Click the **IP Address** tab.

g. In the IP Address window, click **Specify an IP address**.

h. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated on the LCD of the ONS 15454. The default IP address is 192.1.0.2.

\[\text{**Note**} \quad \text{You can suppress the LCD IP address display using CTC. For more information, see the “DLP-G162 Change IP Settings” task on page 10-19.}\]

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is **255.255.255.0** (24 bit).

j. Click **OK**.

k. In the TCP/IP dialog box, click the **Gateway** tab.

l. In the New Gateway field, type the address entered in Step h. Click **Add**.

m. Verify that the IP address appears in the Installed Gateways field, then click **OK**.

n. When the prompt to restart your PC appears, click **Yes**.

o. Proceed to **Step 7**.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose **Settings > Control Panel**.

b. In the Control Panel dialog box, click the **Network** icon.

c. In the Network dialog box, click the **Protocols** tab, choose **TCP/IP Protocol**, then click **Properties**.

d. Click the **IP Address** tab.

e. In the IP Address window, click **Specify an IP address**.

f. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated on the LCD of the ONS 15454. The default IP address is 192.1.0.2.

\[\text{**Note**} \quad \text{You can suppress the LCD IP address display using CTC. For more information, see the “DLP-G162 Change IP Settings” task on page 10-19.}\]

g. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is **255.255.255.0** (24 bit).

h. Click **Advanced**.

i. In the Gateways List, click **Add**. The TCP/IP Gateway Address dialog box appears.

j. Type the IP address entered in Step f in the Gateway Address field.

k. Click **Add**.

l. Click **OK**.

m. Click **Apply**.

n. Reboot your PC.
Step 5
If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated on the LCD of the ONS 15454. The default IP address is 192.1.0.2.

Note: You can suppress the LCD IP address display using CTC. For more information, see the “DLP-G162 Change IP Settings” task on page 10-19.

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 255.255.255.0 (24 bit).

g. Type the IP address entered in Step e in the Gateway Address field.

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.

k. Proceed to Step 7.

Step 6
If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note: If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon to select it. Right-click and select Properties.

c. From the Local Area Connection Properties dialog box, click on Internet Protocol (TCP/IP) to select it, then click Properties.

d. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated on the LCD of the ONS 15454. The default IP address is 192.1.0.2.

e. Select the Use the Following IP Address: radio button.

Note: You can suppress the LCD IP address display using CTC. For more information, see the “DLP-G162 Change IP Settings” task on page 10-19.

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 255.255.255.0 (24 bit).

g. Type the IP address entered in Step d in the Gateway Address field.

h. Click OK.
DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454

Purpose
This task sets up a Solaris workstation for a craft connection to the ONS 15454.

Tools/Equipment
None

Prerequisite Procedures
NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

---

**Step 1**
Log into the workstation as the root user.

**Step 2**
Check to see if the interface is plumbed by typing:

```
# ifconfig device
```

For example:

```
# ifconfig hme1
```

- If the interface is plumbed, a message similar to the following appears:

  hme1:flags=1000842<BROADCAST,RUNNING,MULTICAST,IPv4>mtu 1500 index 2 inet 0.0.0.0 netmask 0

  If a message similar to this one appears, go to Step 4.

- If the interface is not plumbed, a message similar to the following appears:

  ifconfig: status: SIOCGLIFFLAGS: hme1: no such interface.

  If a message similar to this one appears, go to Step 3.

**Step 3**
Plumb the interface by typing:

```
# ifconfig device plumb
```

For example:

```
# ifconfig hme1 plumb
```

**Step 4**
Configure the IP address on the interface by typing:

```
# ifconfig interface ip-address netmask netmask up
```

For example:

```
# ifconfig hme0 192.1.0.3 netmask 255.255.255.0 up
```

**Note**
Enter an IP address that is identical to the ONS 15454 IP address except for the last octet. The last octet must be 1 or 3 through 254.
Step 5  In the Subnet Mask field, type **255.255.255.0**. Skip this step if you checked Craft Access Only on the Provisioning > Network > General > Gateway Settings tab.

Step 6  Test the connection:

a.  Start Netscape Navigator.

b.  Enter the ONS 15454 IP address in the web address (URL) field. If the connection is established, a Java Console window, CTC caching messages, and the Cisco Transport Controller Login dialog box appear. If this occurs, go to Step 2 of the “DLP-G46 Log into CTC” task on page 2-25 to complete the login. If the Login dialog box does not appear, complete Steps c and d.

c.  At the prompt, type:

   ping **ONS-15454-IP-address**

   For example, to connect to an ONS 15454 with a default IP address of 192.1.0.2, type:

   ping 192.1.0.2

   If your workstation is connected to the ONS 15454, the following message appears:

   IP-address is alive

   **Note**  Skip this step if you checked the Craft Access Only check box on the Provisioning > Network > General > Gateway Settings tab.

d.  If CTC is not responding, a “no answer from x.x.x.x” message appears. Verify the IP and subnet mask information. Check that the cables connecting the workstation to the ONS 15454 are securely attached. Check the link status by typing:

   # ndd -set /dev/device instance 0

   # ndd -get /dev/device link_status

   A result of “1” means the link is up. A result of “0” means the link is down.

   **Note**  Check the man page for ndd. For example, type: # man ndd.

Step 7  Return to your originating procedure (NTP).
NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454

Purpose
This procedure sets up your computer to access the ONS 15454 through a corporate LAN.

Tools/Equipment
NIC, also referred to as an Ethernet card
Straight-through (CAT-5) LAN cable

Prerequisite Procedures
- NTP-G17 Set Up Computer for CTC, page 2-2
- The ONS 15454 must be provisioned for LAN connectivity, including IP address, subnet mask, default gateway.
- The ONS 15454 must be physically connected to the corporate LAN.
- The CTC computer must be connected to the corporate LAN that has connectivity to the ONS 15454.

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
None

Step 1
If your computer is already connected to the corporate LAN, go to Step 3. If you changed your computer’s network settings for craft access to the ONS 15454, change the settings back to the corporate LAN access settings. This generally means:

- Set the IP Address on the TCP/IP dialog box back to Obtain an IP address automatically (Windows 98) or Obtain an IP address from a DHCP server (Windows NT 4.0, 2000, or XP).
- If your LAN requires that Domain Name System (DNS) or Windows Internet Naming Service (WINS) be enabled, change the setting on the DNS Configuration or WINS Configuration tab of the TCP/IP dialog box.

Step 2
Connect a straight-through (CAT-5) LAN cable from the PC or Solaris workstation NIC card to a corporate LAN port.

Step 3
If your computer is connected to a proxy server, disable proxy service or add the ONS 15454 nodes as exceptions. To disable proxy service, complete one of the following tasks, depending on the web browser that you use:

- DLP-G43 Disable Proxy Service Using Internet Explorer (Windows), page 2-22
- DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX), page 2-22

Step 4
Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-24.

Stop. You have completed this procedure.
DLP-G43 Disable Proxy Service Using Internet Explorer (Windows)

**Purpose**
This task disables proxy service for PCs running Internet Explorer.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G17 Set Up Computer for CTC, page 2-2

**Required/As Needed**
Required if your computer is connected to a network computer proxy server and your browser is Internet Explorer.

**Onsite/Remote**
Onsite or remote

**Security Level**
None

---

**Step 1**
From the Start menu, select **Settings > Control Panel**.

*Note*
If your computer is running Windows XP, you can select Control Panel directly from the Start menu. Make sure that you are in Classic View before continuing with this procedure.

**Step 2**
In the Control Panel window, choose **Internet Options**.

**Step 3**
In the Internet Properties dialog box, click **Connections > LAN Settings**.

**Step 4**
In the LAN Settings dialog box, complete one of the following tasks:
- Uncheck **Use a proxy server** to disable the service.
- Leave **Use a proxy server** selected and click **Advanced**. In the Proxy Setting dialog box under Exceptions, enter the IP addresses of ONS 15454 nodes that you will access. Separate each address with a semicolon. You can insert an asterisk (*) for the host number to include all the ONS 15454s on your network. Click **OK** to close each open dialog box.

**Step 5**
Return to your originating procedure (NTP).

DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX)

**Purpose**
This task disables proxy service for PCs and UNIX workstations running Netscape.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G17 Set Up Computer for CTC, page 2-2

**Required/As Needed**
Required if your computer is connected to a network computer proxy server and your browser is Netscape.

**Onsite/Remote**
Onsite or remote

**Security Level**
None

---

**Step 1**
Open Netscape.

**Step 2**
From the Edit menu, choose **Preferences**.

**Step 3**
In the Preferences dialog box under Category, choose **Advanced > Proxies**.
Step 4  On the right side of the Preferences dialog box under Proxies, perform one of the following options:

- Choose **Direct connection to the Internet** to bypass the proxy server.
- Choose **Manual proxy configuration** to add exceptions to the proxy server, then click **View**. In the Manual Proxy Configuration dialog box under Exceptions, enter the IP addresses of the ONS 15454 nodes that you will access. Separate each address with a comma. Click **OK** to close each open dialog box.

Step 5  Return to your originating procedure (NTP).

---

**NTP-G20 Set Up a Remote Access Connection to the ONS 15454**

**Purpose**  
This procedure connects the CTC computer to an ONS 15454 using a LAN modem. To complete this procedure:

- A modem must be connected to the ONS 15454.
- The modem must be provisioned for ONS 15454. To run CTC, the modem must be provisioned for Ethernet access.

**Tools/Equipment**  
Modem and modem documentation

**Prerequisite Procedures**  
NTP-G17 Set Up Computer for CTC, page 2-2

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite

**Security Level**  
None

---

**Step 1**  
Connect the modem to the RJ-45 (LAN) port on the TCC2/TCC2P card, to the LAN pins on the ONS 15454 backplane (ANSI only), or to the RJ-45 jack on the MIC-C/T/P FMEC (ETSI only).

**Step 2**  
While referring to the modem documentation, complete the following tasks to provision the modem for the ONS 15454:

- For CTC access, set the modem for Ethernet access.
- Assign an IP address to the modem that is on the same subnet as the ONS 15454.
- The IP address the modem assigns to the CTC computer must be on the same subnet as the modem and the ONS 15454.

**Note**  
For assistance on provisioning specific modems, contact the Cisco Technical Assistance Center (Cisco TAC). See the “Obtaining Technical Assistance” section on page lxxvi as needed.

**Step 3**  
Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-24.

Stop. You have completed this procedure.
NTP-G21 Log into the ONS 15454 GUI

Purpose
This procedure logs into CTC, the graphical user interface (GUI) software used to manage the ONS 15454. This procedure includes optional node login tasks.

Tools/Equipment
None

Prerequisite Procedures
NTP-G17 Set Up Computer for CTC, page 2-2
One of the following procedures:
- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21
- NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25.

Note
For information about navigating in CTC, see Appendix A, “CTC Information and Shortcuts.”

Step 2 As needed, complete the “DLP-G48 Create Login Node Groups” task on page 2-28. Login node groups allow you to manage nodes that are not connected to the login node through a data communications channel (DCC).

Step 3 As needed, complete the “DLP-G49 Add a Node to the Current Session or Login Group” task on page 2-30.

Step 4 As needed, complete the “DLP-G50 Delete a Node from the Current Session or Login Group” task on page 2-30.

Step 5 As needed, complete the “DLP-G51 Delete a Node from a Specified Login Node Group” task on page 2-31.

Step 6 As needed, complete the “DLP-G52 Change the JRE Version” task on page 2-31.

Step 7 As needed, complete the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-32.

Stop. You have completed this procedure.
**DLP-G46 Log into CTC**

**Purpose**
This task logs into CTC.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G17 Set Up Computer for CTC, page 2-2

One of the following procedures:
- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21
- NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-23

**Required/As Needed**
Required

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Note**
For information about CTC views and navigation, see Appendix A, “CTC Information and Shortcuts.”

---

**Step 1**
From the computer connected to the ONS 15454, start Netscape (PC or UNIX) or Internet Explorer (PC only):

- If you are using a PC, launch Netscape or Internet Explorer from the Windows Start menu or a shortcut icon.
- If you are using UNIX, launch Netscape from the command line by typing one of the following:
  - To install Netscape colors for Netscape use, type:
    ```sh
    # netscape -install
    ```
  - To limit Netscape to 32 colors so that if the requested color is not available, Netscape chooses the closest color option, type:
    ```sh
    netscape -ncols 32
    ```

**Note**
CTC requires a full 24-color palette to run properly. When using color-intensive applications such as Netscape in UNIX, it is possible that UNIX might run out of colors to use for CTC. The `-install` and `-ncols 32` command line options limit the number of colors that Netscape uses.

---

**Step 2**
In the Netscape or Internet Explorer web address (URL) field, enter the ONS 15454 IP address. For initial setup, this is the default IP address, 192.1.0.2. (This IP address appears on the LCD. You can suppress the LCD IP address display using CTC after you log in. For more information, see the “DLP-G162 Change IP Settings” task on page 10-19.)

**Step 3**
Press Enter.
Note: If you are logging into ONS 15454 nodes in an operation network that are running different releases of CTC software, log into the node running the most recent release. If you log into a node running an older release, you will receive an INCOMPATIBLE-SW alarm for each node in the network running a new release, and CTC will not be able to manage these nodes. To check the software version of a node, select About CTC from the CTC Help menu. This will display the ONS 15454 software version for each node visible on the network view. If the node is not visible, the software version can be read from the LCD display. To resolve an alarm, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 4
If a Java Plug-in Security Warning dialog box appears, complete the “DLP-G47 Install Public-Key Security Certificate” task on page 2-28 to install the public-key security certificate required by Software Release 4.1 and later.

After you complete the security certificate dialog box (or if the certificate is already installed), a Java Console window displays the CTC file download status. The web browser displays information about your Java and system environments. If this is the first login, CTC caching messages appear while CTC files are downloaded to your computer. The first time you connect to an ONS 15454, this process can take several minutes. After the download, the CTC Login dialog box appears (Figure 2-1).

Figure 2-1 Logging into CTC

Note: When the CTC Login dialog box appears, it might be minimized.

Step 5
In the Login dialog box, type a user name and password (both are case sensitive). For initial setup, type the user name CISCO15 and the password otbu+1.
Chapter 2      Connect the PC and Log into the GUI

**Note**  
The CISCO15 user is provided with every ONS 15454. CISCO15 has Superuser privileges, so you can create other users. You must create another Superuser before you can delete the CISCO15 user. CISCO15 is delivered with the otbu+1 password. To change the password for CISCO15, click the Provisioning > Security tabs after you log in and change the password. To set up ONS 15454 users and assign security, go to the “NTP-G23 Create Users and Assign Security” procedure on page 3-5. Additional information about security is provided in the “20.1 User IDs and Security Levels” section on page 20-1.

**Step 6**  
Each time you log into an ONS 15454, you can make selections about the following login options:

- **Node Name**—Displays the IP address entered in the web browser and a drop-down list of previously entered ONS 15454 IP addresses. You can select any ONS 15454 on the list for the login, or you can enter the IP address (or node name) of any new node where you want to log in.
- **Additional Nodes**—Displays a list of current login node groups. To create a login node group or add additional groups, see the “DLP-G48 Create Login Node Groups” task on page 2-28.
- **Disable Network Discovery**—Check this box to view only the ONS 15454 (and login node group members, if any) entered in the Node Name field. Nodes linked to this node through DCCs are not discovered and will not appear in CTC network view. Using this option can decrease the CTC startup time in networks with many DCC-connected nodes, and can reduce memory consumption.
- **Disable Circuit Management**—Check this box to disable discovery of existing circuits. Using this option can decrease the CTC initialization time in networks with many existing circuits and reduce memory consumption. This option does not prevent the creation and management of new circuits.

**Step 7**  
Click **Login**.

If the login is successful, the CTC window appears. From here, you can navigate to other CTC views to provision and manage the ONS 15454. If you need to turn up the shelf for the first time, see Chapter 3, “Turn Up a Node.” If login problems occur, refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide*.

**Step 8**  
Return to your originating procedure (NTP).
DLP-G47 Install Public-Key Security Certificate

Purpose
This task installs the ITU Recommendation X.509 public-key security certificate. The public-key certificate is required to run Software Release 4.1 or later.

Tools/Equipment
None

Prerequisite Procedures
This task is performed during the “DLP-G46 Log into CTC” task on page 2-25. You cannot perform it outside of this task.

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
If the Java Plug-in Security Warning dialog box appears, choose one of the following options:

Note
The Java Plug-in Security Warning dialog box options that appear depend on the JRE version you are using. If you installed JRE 1.4.2, you will see the following options: Yes, No, Always, and More Details. If you are using JRE 1.3.1_02, you will see the following options (shown in parentheses in the following list): Grant This Session, Deny, Grant Always, and View Certificate.

- Yes (Grant This Session)—Installs the public-key certificate to your PC only for the current session. After the session is ended, the certificate is deleted. This dialog box will appear the next time you log into the ONS 15454.
- No (Deny)—Denies permission to install the certificate. If you choose this option, you cannot log into the ONS 15454.
- Always (Grant Always)—Installs the public-key certificate and does not delete it after the session is over. Cisco recommends this option.
- More Details (View Certificate)—Allows you to view the public-key security certificate.

Step 2
Return to your originating procedure (NTP).

DLP-G48 Create Login Node Groups

Purpose
This task creates a login node group to display ONS 15454s that have an IP connection but not a DCC connection to the login node.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
From the Edit menu in node view, choose Preferences.
Step 2  Click **Login Node Group** and **Create Group**.

Step 3  Enter a name for the group in the Create Login Group Name dialog box. Click **OK**.

Step 4  In the Members area, type the IP address (or node name) of a node you want to add to the group. Click **Add**. Repeat this step for each node that you want to add to the group.

Step 5  Click **OK**.

The next time you log into an ONS 15454, the login node group will be available in the Additional Nodes list of the Login dialog box. For example, in **Figure 2-2**, a login node group is created that contains the IP addresses for Nodes 1, 4, and 5. During login, if you choose this group from the Additional Nodes list and Disable Network Discovery is not selected, all nodes in the figure appear. If the login group and Disable Network Discovery are both selected, only Nodes 1, 4, and 5 appear. You can create as many login node groups as you need. The groups are stored in the CTC preferences file and are not visible to other users.

**Figure 2-2   Login Node Group**

<table>
<thead>
<tr>
<th>Laptop PC</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laptop PC</td>
<td>192.168.106.100</td>
</tr>
<tr>
<td>LAN/WAN (Ethernet)</td>
<td></td>
</tr>
<tr>
<td>Node 1</td>
<td>192.168.106.143</td>
</tr>
<tr>
<td>Node 4</td>
<td>192.168.105.119</td>
</tr>
<tr>
<td>Node 5</td>
<td>192.168.104.109</td>
</tr>
<tr>
<td>Node 2</td>
<td>192.168.103.199</td>
</tr>
<tr>
<td>Node 3</td>
<td>192.168.103.199</td>
</tr>
</tbody>
</table>

Step 6  Return to your originating procedure (NTP).
**DLP-G49 Add a Node to the Current Session or Login Group**

**Purpose**
This task adds a node to the current CTC session or login node group.

**Tools**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
From the CTC File menu, click **Add Node**.

**Step 2**
In the Add Node dialog box, enter the node name (or IP address).

**Step 3**
If you want to add the node to the current login node group, check **Add to current login node group**. Otherwise, leave it unchecked.

**Note**
This check box is active only if you selected a login group when you logged into CTC.

**Step 4**
Click **OK**.

After a few seconds, the new node appears on the network view map.

**Step 5**
Return to your originating procedure (NTP).

---

**DLP-G50 Delete a Node from the Current Session or Login Group**

**Purpose**
This task removes a node from the current CTC session or login node group. To remove a node from a login node group that is not the current one, see “DLP-G51 Delete a Node from a Specified Login Node Group” task on page 2-31.

**Tools**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
From the View menu, choose **Go to Network View**.

**Step 2**
Click the node that you want to delete.

**Step 3**
From the CTC File menu, click **Delete Selected Node**.

After a few seconds, the node disappears from the network view map.

**Step 4**
Return to your originating procedure (NTP).
DLP-G51 Delete a Node from a Specified Login Node Group

Purpose
This task removes a node from a specified login node group. To remove a node from the current login node group, see the “DLP-G50 Delete a Node from the Current Session or Login Group” task on page 2-30.

Tools
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
From the CTC Edit menu, choose Preferences.

Step 2
In the Preferences dialog box, click the Login Node Groups tab.

Step 3
Click the login node group tab containing the node you want to remove.

Step 4
Click the node you want to remove, then click Remove.

Step 5
Click OK.

Step 6
Return to your originating procedure (NTP).

DLP-G52 Change the JRE Version

Purpose
This task changes the JRE version, which is useful if you would like to upgrade to a later JRE version from an earlier one without using the software or documentation CD. This does not affect the browser default version. After selecting the desired JRE version, you must exit CTC. The next time you log into a node, the new JRE version will be used.

Tools
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
This task is not used in Release 6.0 because only one JRE version is supported. This task is used in CTC releases that support multiple JRE versions.

Step 1
From the Edit menu, choose Preferences.

Step 2
Click the JRE tab. The JRE tab shows the current JRE version and the recommended version.

Step 3
Click the Browse button and navigate to the JRE directory on your computer.

Step 4
Choose the JRE version.

Step 5
Click OK.
DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup

**Purpose**
This task sets up the CTC Alerts dialog box to open for all alerts, for circuit deletion errors only, or never. The CTC Alerts dialog box displays network disconnection, Send-PDIP inconsistency, circuit deletion status, condition retrieval errors, and software download failure.

**Tools**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
Click the CTC Alerts toolbar icon.

**Step 2**
In the CTC Alerts dialog box, choose one of the following:
- All alerts—Sets the CTC Alerts dialog box to open automatically for all notifications.
- Error alerts only—Sets the CTC Alerts dialog box to open automatically for circuit deletion errors only.
- Never—Sets the CTC Alerts dialog box to never open automatically.

**Step 3**
Click Close.

**Step 4**
Return to your originating procedure (NTP).
Turn Up a Node

This chapter explains how to provision a single Cisco ONS 15454 dense wavelength division multiplexing (DWDM) node and turn it up for service, including node name, date and time, timing references, network attributes such as IP address and default router, users and user security, card installation, and DWDM connections.

Note

Procedures in this chapter require that you have a network plan calculated for your DWDM network with Cisco MetroPlanner, Release 2.5. Cisco MetroPlanner is a DWDM planning tool that is available from your Cisco account representative. Cisco MetroPlanner prepares a shelf plan for each network node and calculates the power and attenuation levels for the DWDM cards installed in the node. For information about Cisco MetroPlanner, contact your Cisco account representative. For instructions on using Cisco MetroPlanner, refer to the Cisco MetroPlanner DWDM Installation and Operations Guide, Release 2.5.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI (ONS 15454) and ETSI (ONS 15454 SDH) shelf assemblies.

Before You Begin

This section lists the non-trouble procedures (NTPs) that you need to complete to turn up a DWDM node. Turn to a procedure for applicable detailed level procedures (DLPs).

1. NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3—Complete this procedure first.
2. NTP-G22 Verify Common Card Installation, page 3-4—Complete this procedure next.
3. NTP-G23 Create Users and Assign Security, page 3-5—Complete this procedure to create Cisco Transport Controller (CTC) users and assign their security levels.
4. NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-8—Continue with this procedure to set the node name, date, time, location, and contact information.
5. NTP-G25 Set Power Monitor Thresholds, page 3-10—Continue with this procedure to set the node battery power thresholds.
6. NTP-G26 Set Up CTC Network Access, page 3-11—Continue with this procedure to provision the IP address, default router, subnet mask, and network configuration settings.
Before You Begin

6. NTP-G27 Set Up the ONS 15454 for Firewall Access, page 3-23—Continue with this procedure to provision the IP address, default router, subnet mask, and network configuration settings.

7. NTP-G132 Provision OSI, page 3-25—Continue with this procedure if the ONS 15454 will be installed in networks with third-party, Open Systems Interconnection (OSI)-based network elements (NEs).

8. NTP-G28 Set Up SNMP, page 3-35—Complete this procedure if Simple Network Management Protocol (SNMP) will be used for network monitoring.

9. NTP-G29 Preprovision a Slot, page 3-37—Complete this procedure to preprovision the ONS 15454 slots.

10. NTP-G30 Install the DWDM Cards, page 3-39—Complete this procedure to install the DWDM cards, including the OSCM, OSC-CSM, 32WSS, OPT-BST, OPT-PRE, 32-MUX-O, 32-DMX-O, and 32DMX.

11. NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-41—Complete this procedure to install a dispersion compensating unit (DCU).

12. NTP-G32 Install the Transponder and Muxponder Cards, page 3-43—Complete this procedure to install transponder (TXP) and muxponder (MXP) cards.

13. NTP-G123 Install the Filler Cards, page 3-47—Complete this procedure to install ONS 15454 filler cards.

14. NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-48—Complete this procedure, as needed, to install the fiber-optic cables on the DWDM cards.

15. NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, or ROADDM Node and the Transponder Cards, page 3-72—Complete this procedure, as needed, to connect TXP cards to a terminal, hub, or reconfigurable optical add/drop multiplexing (ROADM) node.

16. NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules, page 3-79—Complete this procedure, as needed, to connect fiber-optic cables to Y-cable modules from TXP cards and the client signal.

17. NTP-G36 Calculate Cable Connections, page 3-80—Complete this procedure to calculate the DWDM cable connections.

18. NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-82—Complete this procedure next.


20. NTP-G38 Provision OSC Terminations, page 3-84—Complete this procedure next.

21. NTP-G39 Verify OSCM and OSC-CSM Transmit Power, page 3-86—Complete this procedure next.
NTP-G139 Verify Cisco MetroPlanner Reports and Files

**Purpose**
This procedure verifies that you have the Cisco MetroPlanner reports and files needed to turn up the node.

**Tools/Equipment**
None

**Prerequisite Procedures**
Chapter 1, “Install the Shelf and Common Control Cards”

**Required/As Needed**
Required

**Onsite/Remote**
Onsite

**Security Level**
Retrieve or higher

---

### Step 1
Verify that you have the Cisco MetroPlanner reports and files shown in Table 3-1 for the node you will provision. The reports and files can be provided in one of the following options:

- If you have Cisco MetroPlanner, verify that you have the electronic network design plan from which you can generate the reports in Cisco MetroPlanner. For information about generating the reports, refer to the *Cisco MetroPlanner DWDM Operations Guide*.

- If you do not have Cisco MetroPlanner, you must have printouts of all reports listed in Table 3-1 except the Assisted Configuration Setup file. Assisted Configuration Setup is an electronic file that will be imported into CTC. You must be able to access it from the CTC computer used to provision the node.

### Table 3-1 Cisco MetroPlanner Node Setup Information and Files

<table>
<thead>
<tr>
<th>Source</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shelf layout</td>
<td>Table or JPG file</td>
<td>Cisco MetroPlanner provides a shelf layout (Figure 3-1) showing the cards that should be installed in each ONS 15454 slot. Cisco MetroPlanner can export this as a table, “Layout Table [site name],” or as a JPG file with a user-defined name.</td>
</tr>
<tr>
<td>Installation Parameters</td>
<td>Table</td>
<td>Provides the target reference values for the variable optical attenuators (VOAs), output power, optical thresholds, and amplifier configuration parameters.</td>
</tr>
<tr>
<td>Internal Connections</td>
<td>Table</td>
<td>Identifies the patchcords that must be installed within the shelf.</td>
</tr>
<tr>
<td>Assisted Configuration Setup</td>
<td>TXT file</td>
<td>This is an electronic file with a TXT extension and a name corresponding to the node you are setting up. The file is imported into CTC where it configures the node parameters based on the network calculated by Cisco MetroPlanner.</td>
</tr>
<tr>
<td>Traffic Matrix</td>
<td>Table</td>
<td>Shows the traffic flow within the node. During node turn-up, this report is used to identify the location of Y-cable protection groups.</td>
</tr>
<tr>
<td>Cable list</td>
<td>Table or list</td>
<td>A list of cables needed to provision the node. The list can be derived from the Internal Connections table or from the Bill of Materials report prepared by Cisco MetroPlanner.</td>
</tr>
</tbody>
</table>
Step 2

Print Table 3-1 for reference. You will need information from the reports during node turn-up.

Stop. You have completed this procedure.

NTP-G22 Verify Common Card Installation

Purpose

This procedure verifies that the ONS 15454 node has two TCC2/TCC2P cards installed and is ready for turn-up.

Tools/Equipment

None

Prerequisite Procedures

Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

Retrieve or higher

Step 1

Verify that two TCC2/TCC2P cards are installed in Slots 7 and 11.

Step 2

Verify that the green ACT (active) LED is illuminated on one TCC2/TCC2P and the amber STBY (standby) LED is illuminated on the second TCC2/TCC2P.
Note: If the TCC2/TCC2P cards are not installed, or if their LEDs are not operating as described, do not continue. Repeat the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-72 or refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide to resolve installation problems before proceeding to Step 3.

Step 3 If Alarm Interface Controller–International (AIC-I) card is installed, verify that it is installed in Slot 9 and its ACT (active) LED displays a solid green light.

Step 4 Verify that the software release shown on the LCD matches the software release indicated in your site plan. If the release does not match, perform one of the following procedures:

- Perform a software upgrade using a Cisco ONS 15454 software CD. Refer to the release-specific software upgrade document.
- Replace the TCC2/TCC2P cards with cards containing the correct release.

Stop. You have completed this procedure.

NTP-G23 Create Users and Assign Security

Purpose: This procedure creates ONS 15454 users and assigns their security levels.
Tools/Equipment: None
Prerequisite Procedures: NTP-G22 Verify Common Card Installation, page 3-4
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you need to create users. If you are already logged in, continue with Step 2.

Note: You must log in as a Superuser to create additional users. The CISCO15 user provided with each ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one ONS 15454.

Step 2 Complete the “DLP-G54 Create a New User on a Single Node” task on page 3-6 or the “DLP-G55 Create a New User on Multiple Nodes” task on page 3-7 as needed.

Note: You must add the same user name and password to each node a user will access.

Step 3 If you want to modify the security policy settings, including password aging and idle user timeout policies, complete the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

Stop. You have completed this procedure.
DLP-G54 Create a New User on a Single Node

Purpose
This task creates a new user for one ONS 15454.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
In node view, click the Provisioning > Security > Users tabs.

Step 2
In the Users window, click Create.

Step 3
In the Create User dialog box, enter the following:

- Name—Type the user name. The name must be a minimum of six and a maximum of 20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 6 to 10 characters.

- Password—Type the user password. The password must be a minimum of six and a maximum of 20 alphanumeric (a-z, A-Z, 0-9) and special (+, #,% characters, where at least two characters are non alphabetic and at least one character is a special character. For TL1 compatibility, the password must be 6 to 10 characters.

  Note
  The password must not contain the user name.

- Confirm Password—Type the password again to confirm it.

- Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, PROVISIONING, or SUPERUSER. See the “20.1 User IDs and Security Levels” section on page 20-1 for information about the capabilities provided with each level.

  Note
  Each security level has a different idle time. The idle time is the length of time that CTC can remain idle before the password must be reentered. The defaults are: Retrieve user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. To change the idle times, see the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

Step 4
Click OK.

Step 5
Return to your originating procedure (NTP).
DLP-G55 Create a New User on Multiple Nodes

Purpose
This task adds a new user to multiple ONS 15454 nodes.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Note
All nodes where you want to add users must be accessible in network view.

Step 1
From the View menu, choose Go to Network View.

Step 2
Click the Provisioning > Security > Users tabs.

Step 3
In the Users window, click Create.

Step 4
In the Create User dialog box, enter the following:

- Name—Type the user name. The name must be a minimum of six and a maximum of 20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 6 to 10 characters.

- Password—Type the user password. The password must be a minimum of six and a maximum of 20 alphanumeric (a-z, A-Z, 0-9) and special (+, #, %) characters, where at least two characters are non alphabetic and at least one character is a special character. For TL1 compatibility, the password must be 6 to 10 characters. The password must not contain the user name.

- Confirm Password—Type the password again to confirm it.

- Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, PROVISIONING, or SUPERUSER. Refer to the “20.1 User IDs and Security Levels” section on page 20-1 for information about the capabilities provided with each level.

Note
Each security level has a different idle time. The idle time is the length of time that CTC can remain idle before it locks up and the password must be reentered. The defaults are: Retrieve user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. To change the idle times, refer to the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

Step 5
In the Select Applicable Nodes area, deselect any nodes where you do not want to add the user (all network nodes are selected by default).

Step 6
Click OK.

Step 7
In the User Creation Results dialog box, verify that the user was added to all the nodes chosen in Step 5. If not, click OK and repeat Steps 2 through 6. If the user was added to all nodes, click OK and continue with the next step.

Step 8
Return to your originating procedure (NTP).
NTP-G24 Set Up Name, Date, Time, and Contact Information

Purpose
This procedure provisions identification information for the node, including the node name, a contact name and phone number, the location of the node, and the date, time, and time zone.

Tools/Equipment
None

Prerequisite Procedures
NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 for the node you will turn up. If you are already logged in, continue with Step 2.

Step 2
In node view, click the Provisioning > General tabs.

Step 3
Enter the following information in the fields listed:

- Node Name—Type a name for the node. For TL1 compliance, names must begin with an alpha character and have no more than 20 alphanumeric (a-z, A-Z, 0-9) characters.
  
  Note
  To avoid errors when you import the Cisco MetroPlanner configuration file in the “NTP-G138 Import a Cisco MetroPlanner Configuration File” task on page 3-82, the CTC node name and the Cisco MetroPlanner site name should be the same or at least easy to identify.

- Contact—Type the name of the node contact person and the phone number, up to 255 characters (optional).

- Latitude—(Optional) Enter the node latitude: N (north) or S (south), degrees, and minutes.

- Longitude—(Optional) Enter the node longitude: E (east) or W (west), degrees, and minutes.

  CTC uses the latitude and longitude to position ONS 15454 icons on the network view map. To convert a coordinate in degrees to degrees and minutes, multiply the number after the decimal by 60. For example, the latitude 38.250739 converts to 38 degrees, 15 minutes (0.250739 x 60 = 15.0443, rounded to the nearest whole number).

- Description—Type a description of the node. The description can be a maximum of 255 characters.

- Use NTP/SNTP Server—When checked, CTC uses a Network Time Protocol (NTP) or Simple Network Time Protocol (SNTP) server to set the date and time of the node.

  If you do not use an SNTP or NTP server, complete the Date and Time fields. The ONS 15454 will use these fields for alarm dates and times. By default, CTC displays all alarms in the CTC computer time zone for consistency. To change the display to the node time zone, complete the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-11.

  Note
  Using an NTP or SNTP server ensures that all ONS 15454 network nodes use the same date and time reference. The server synchronizes the node’s time after power outages or software upgrades.
If you check the Use NTP/SNTP Server check box, type the IP address of one of the following:

- An NTP/SNTP server connected to the ONS 15454
- Another ONS 15454 with NTP/SNTP enabled that is connected to the ONS 15454

If you check gateway network element (GNE) for the ONS 15454 SOCKS proxy server (see “DLP-G56 Provision IP Settings” task on page 3-12), external ONS 15454 nodes must reference the gateway ONS 15454 for NTP/SNTP timing. For more information about the ONS 15454 gateway settings, see Chapter 22, “Management Connectivity Reference.”

**Caution**

If you reference another ONS 15454 for the NTP/SNTP server, make sure the second ONS 15454 references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing loop by having two ONS 15454 nodes reference each other).

- Date—If Use NTP/SNTP Server is not checked, type the current date in the format m/d/yyyy, for example, September 24, 2002 is 9/24/2002.
- Time—If Use NTP/SNTP Server is not checked, type the current time in the format hh:mm:ss, for example, 11:24:58. The ONS 15454 uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.
- Time Zone—Click the field and choose a city within your time zone from the drop-down list. The list displays the 80 World Time Zones from –11 through 0 (GMT) to +14. Continental United States time zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07:00 (Mountain), and GMT-08:00 (Pacific).
- Use Daylight Savings Time—Check this check box if the time zone that you chose is using Daylight Savings Time.
- Insert AIS-V on STS-1 SD-P—Not used in DWDM networks.
- SD-P BER—Not used in DWDM networks.

**Step 4**  Click **Apply**.

**Step 5**  In the confirmation dialog box, click **Yes**.

**Step 6**  Review the node information. If you need to make corrections, repeat Steps 3 through 5 to enter the corrections. If the information is correct, continue with the “NTP-G25 Set Power Monitor Thresholds” procedure on page 3-10.

Stop. You have completed this procedure.
NTP-G25 Set Power Monitor Thresholds

**Purpose**
This procedure provisions extreme high, extreme low, and low input battery power thresholds within a –48 VDC environment. When the thresholds are crossed, the TCC2/TCC2P generates warning alarms in CTC. For ONS 15454 power specifications, see Appendix B, “Hardware Specifications.”

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G22 Verify Common Card Installation, page 3-4

**Required/As Needed**
Required

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Caution**
The default battery power thresholds are normally not changed. Threshold changes should only be performed at the direction of your site administrator.

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 for the node you will set up. If you are already logged in, continue with Step 2.

**Step 2**
In node view, click the **Provisioning > General > Power Monitor** tabs.

**Step 3**
To change the extreme low battery voltage threshold in 0.5 VDC increments, choose a voltage from the ELWBATVGVdc drop-down list.

**Step 4**
To change the low battery voltage threshold in 0.5 VDC increments, choose a voltage from the LWBATVGVdc drop-down list.

**Step 5**
To change the high battery voltage threshold in 0.5 VDC increments, choose a voltage from the HIBATVGVdc drop-down list.

**Step 6**
To change the extreme high battery voltage threshold in 0.5 VDC increments, choose a voltage from the EHIBATVGVdc drop-down list.

**Step 7**
Click **Apply**.

*Stop*. You have completed this procedure.
NTP-G26 Set Up CTC Network Access

Purpose
This procedure provisions network access for a node, including its subnet mask, default router, Dynamic Host Configuration Protocol (DHCP) server, Internet Inter-Orb Protocol (IIOP) listener port, gateway settings, static routes, Open Shortest Path First (OSPF) protocol, and Routing Information Protocol (RIP).

Tools/Equipment
None

Prerequisite Procedures
NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
Complete the “DLP-G56 Provision IP Settings” task on page 3-12 to provision the ONS 15454 IP address, subnet mask, default router, DHCP server, IIOP listener port, and SOCKS proxy server settings.

Tip
If you cannot log into the node, you can change its IP address, default router, and network mask by using the LCD on the ONS 15454 fan-tray assembly (unless LCD provisioning is suppressed). See the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD” task on page 3-15 for instructions. However, you cannot use the LCD to provision any other network settings.

Step 3
If TCC2P cards are installed and you want to turn on the ONS 15454 secure mode, which allows two IP addresses to be provisioned for the node, complete the “DLP-G264 Enable Node Security Mode” task on page 3-17.

Note
Secure mode is not available if TCC2 cards are installed.

Step 4
If static routes are needed, complete the “DLP-G58 Create a Static Route” task on page 3-18. For more information about static routes, see Chapter 22, “Management Connectivity Reference.”

Step 5
If the ONS 15454 is connected to a LAN or WAN that uses OSPF and you want to share routing information between the LAN/WAN and the ONS network, complete the “DLP-G59 Set Up or Change Open Shortest Path First Protocol” task on page 3-19.

Step 6
If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-G60 Set Up or Change Routing Information Protocol” task on page 3-22.

Stop. You have completed this procedure.
DLP-G56 Provision IP Settings

Purpose
This task provisions IP settings, which includes the IP address, default router, DHCP access, firewall access, and SOCKS proxy server settings for an ONS 15454 node.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Superuser

Caution
All network changes should be approved by your network (or LAN) administrator.

Step 1
In node view, click the Provisioning > Network > General tabs.

Step 2
Complete the following information in the fields listed:

- **IP Address**—Type the IP address assigned to the ONS 15454 node.
- **Suppress CTC IP Display**—Check this check box if you want to prevent the node IP address from being displayed in CTC to users with Provisioning, Maintenance, or Retrieve security levels. (The IP address suppression is not applied to users with Superuser security level.)
- **LCD IP Display**—Choose one of the following:
  - Allow Configuration—Displays the node IP address on the LCD and allows users to change the IP settings using the LCD. This option enables the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD” task on page 3-15.
  - Display Only—Displays the node IP address on the LCD but does not allow users to change the IP address using the LCD.
  - Suppress Display—Suppresses the node IP address display on the LCD.
- **Default Router**—If the ONS 15454 is connected to a LAN, enter the IP address of the default router. The default router forwards packets to network devices that the ONS 15454 cannot directly access. This field is ignored if any of the following are true:
  - The ONS 15454 is not connected to a LAN.
  - SOCKS proxy server is enabled and the ONS 15454 is provisioned as an end network element (ENE).
  - OSPF is enabled on both the ONS 15454 and the LAN where the ONS 15454 is connected.
- **Forward DHCP Request To**—Check this check box to enable DHCP. Also, enter the DHCP server IP address in the Request To field. Unchecked is the default. If you will enable any of the gateway settings to implement the ONS 15454 SOCKS proxy server features, leave this field blank.

Note
If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it does not act as a DHCP server.

- **MAC Address**—(Display only) Displays the ONS 15454 IEEE 802 MAC address.
- Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is the same for all ONS 15454 nodes in the same subnet.

- TCC CORBA (IIOP) Listener Port—Sets the ONS 15454 IIOP listener port used for communication between the ONS 15454 and CTC computers. This field is generally not changed unless the ONS 15454 resides behind a firewall that requires a different port. See the “NTP-G27 Set Up the ONS 15454 for Firewall Access” procedure on page 3-23 for more information.

- Gateway Settings—Provisions the ONS 15454 SOCKS proxy server features. (SOCKS is a standard proxy protocol for IP-based applications.) Do not change these options until you review the “22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server” section on page 22-12. In SOCKS proxy server networks, the ONS 15454 is either an ENE, a GNE, or a proxy-only server. Provisioning must be consistent for each NE type.

- Enable SOCKS proxy server on port—If checked, the ONS 15454 serves as a proxy for connections between CTC clients and ONS 15454 nodes that are connected by data communications channels (DCCs) to the proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes through the proxy node. The CTC client does not require IP connectivity to the DCC-connected nodes, only to the proxy ONS 15454. If the Enable SOCKS proxy server on port check box is unchecked, the node does not proxy for any CTC clients. When this box is checked, you can provision one of the following options:
  - External Network Element (ENE)—Choose this option when the ONS 15454 is not connected to a LAN but has DCC connections to other ONS nodes. A CTC computer connected to the ENE through the TCC2/TCC2P TCP/IP (craft) port can manage nodes that have DCC connections to the ENE. However, the CTC computer does not have direct IP connectivity to these nodes or to any LAN/WAN that those nodes might be connected to.
  - Gateway Network Element (GNE)—Choose this option when the ONS 15454 is connected to a LAN and has DCC connections to other nodes. A CTC computer connected to the LAN can manage all nodes that have DCC connections to the GNE, but the CTC computer does not have direct IP connectivity to them. The GNE option isolates the LAN from the DCC network so that IP traffic originating from the DCC-connected nodes and any CTC computers connected to them is prevented from reaching the LAN.
  - SOCKS Proxy-Only—Choose this option when the ONS 15454 is connected to a LAN and the LAN is separated from the node by a firewall. The SOCKS Proxy Only option is the same as the GNE option, except that the SOCKS Proxy Only option does not isolate the DCC network from the LAN.

Step 3  Click Apply.

Step 4  Click Yes in the confirmation dialog box.

Both TCC2/TCC2P cards reboot, one at a time. During this time (approximately 5 minutes), the active and standby TCC2/TCC2P card LEDs go through the cycle shown in Table 3-2. Eventually, a “Lost node connection, switching to network view” message appears.
Table 3-2  LED Behavior During TCC2/TCC2P Reboot

<table>
<thead>
<tr>
<th>Reboot Activity</th>
<th>Active TCC2/TCC2P LEDs</th>
<th>Standby TCC2/TCC2P LEDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory test (1 to 2 minutes).</td>
<td></td>
<td>2. FAIL LED: Solid red.</td>
</tr>
<tr>
<td>If an AIC or AIC-I card is installed, AIC FAIL and alarm LEDs light up briefly when the AIC is updated. The standby TCC2/TCC2P becomes the active TCC2/TCC2P.</td>
<td></td>
<td>3. All LEDs on except ACT/STBY.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. CRIT turns off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. MAJ and MIN turn off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. REM, SYNC, and ACO turn off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. All LEDs (except A&amp;B PWR) turn off (1 to 2 minutes).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. ACT/STBY: Solid yellow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10. ACT/STBY: Solid green.</td>
</tr>
<tr>
<td>Memory test (1 to 2 minutes).</td>
<td>1. All LEDs: Turn off (1 to 2 minutes). CTC displays “Lost node connection, switching to network view” message.</td>
<td>ACT/STBY: Solid green.</td>
</tr>
<tr>
<td>TCC2/TCC2P updated with new network information.</td>
<td></td>
<td>2. FAIL LED: Solid red.</td>
</tr>
<tr>
<td>The active TCC2/TCC2P becomes the standby TCC2/TCC2P.</td>
<td></td>
<td>3. FAIL LED: Flashing red.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. All LEDs on except ACT/STBY.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. CRIT turns off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. MAJ and MIN turn off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. REM, SYNC, and ACO turn off; all LEDs are off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. ACT/STBY: Solid yellow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9. ACT/STBY: Flashing yellow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10. ACT/STBY: Solid yellow.</td>
</tr>
</tbody>
</table>

**Step 5**  Click OK. The network view appears. The node icon appears in gray, during which time you cannot access the node.

**Step 6**  Double-click the node icon when it becomes green.

**Step 7**  Return to your originating procedure (NTP).
DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD

**Purpose**
This task changes the ONS 15454 IP address, default router, and network mask using the LCD on the fan-tray assembly. Use this task if you cannot log into CTC.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G33 Install the TCC2 or TCC2P Card, page 1-72

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Note**
You cannot perform this task if the LCD IP Display field on the node view Provisioning > Network tab is set to Display Only or Suppress Display. See the “DLP-G56 Provision IP Settings” task on page 3-12 to view or change the LCD IP Display field.

---

**Note**
The LCD reverts to normal display mode after 5 seconds of button inactivity.

**Step 1**
On the ONS 15454 front panel, repeatedly press the **Slot** button until Node appears on the LCD.

**Step 2**
Repeatedly press the **Port** button until the following displays:
- To change the node IP address, Status=IpAddress (Figure 3-2)
- To change the node network mask, Status=Net Mask
- To change the default router IP address, Status=Default Rtr

![Figure 3-2 Selecting the IP Address Option](image)

**Step 3**
Press the **Status** button to display the node IP address (Figure 3-3), the node subnet mask length, or the default router IP address.

![Figure 3-3 Changing the IP Address](image)

**Step 4**
Push the **Slot** button to move to the digit of the IP address or subnet mask that you want to change. The selected digit flashes.
Tip  The Slot, Status, and Port button positions correspond to the positions of the commands shown on the LCD. For example, in Figure 3-3, you press the Slot button to invoke the Next command and the Port button to invoke the Done command.

Step 5  Press the Port button to cycle the IP address or subnet mask to the correct digit.

Step 6  When the change is complete, press the Status button to return to the Node menu.

Step 7  Repeatedly press the Port button until the Save Configuration option appears (Figure 3-4).

Data 3-4  Selecting the Save Configuration Option

Step 8  Press the Status button to choose the Save Configuration option.
A Save and REBOOT message appears (Figure 3-5).

Data 3-5  Saving and Rebooting the TCC2/TCC2P

Step 9  Press the Slot button to apply the new IP address configuration or press Port to cancel the configuration. Saving the new configuration causes the TCC2/TCC2P cards to reboot. During the reboot, a “Saving Changes - TCC Reset” message displays on the LCD. The LCD returns to the normal alternating display after the TCC2/TCC2P reboot is complete.

Note  The IP address and default router must be on the same subnet. If not, you cannot apply the configuration.

Step 10  Return to your originating procedure (NTP).
DLP-G264 Enable Node Security Mode

Purpose

This task enables the ONS 15454 security mode. When security mode is enabled, two IP addresses are assigned to the node. One address is assigned to the backplane LAN port and the other to the TCC2P RJ-45 TCP/IP (LAN) port.

Tools/Equipment

TCC2P cards must be installed.

Prerequisite Procedures

NTP-G103 Back Up the Database, page 13-2
DLP-G46 Log into CTC, page 2-25

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Note

This task requires TCC2P cards. The security mode options described in this task will not appear in CTC if TCC2 cards are installed.

Caution

The IP address assigned to the TCC2P LAN port must reside on a different subnet from the backplane LAN port and the ONS 15454 default router. Verify that the new TCC2P IP address meets this requirement and is compatible with ONE 15454 network IP addresses.

Note

The node will reboot after you complete this task, causing a temporary disconnection between the CTC computer and the node.

Step 1

Click the Provisioning > Security > Data Comm tabs.

Step 2

Click Change Mode.

Step 3

Review the information on the Change Secure Mode wizard page, then click Next.

Step 4

On the TCC Ethernet Port page, enter the IP address and subnet mask for the TCC2P LAN (TCP/IP) port. The IP address cannot reside on the same subnet as the backplane LAN port, nor the ONS 15454 default router.

Step 5

Click Next.

Step 6

On the Backplane Ethernet Port page, modify the backplane IP address, subnet mask, and default router, if needed. (You normally do not modify these fields if no ONS 15454 network changes have occurred.)

Step 7

Click Next.

Step 8

On the SOCKS Proxy Server Settings page, choose one of the following options:

- External Network Element (ENE)—If selected, the CTC computer is only visible to the ONS 15454 to which the CTC computer is connected. The computer is not visible to the DCC-connected nodes. In addition, firewall is enabled, which means that the node prevents IP traffic from being routed between the DCC and the LAN port.
- Gateway Network Element (GNE)—If selected, the CTC computer is visible to other DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the LAN port.
Step 9  Click Finish.  
Within the next 30 to 40 seconds, the TCC2Ps reboot. CTC switches to network view, and the CTC Alerts dialog box appears. In network view, the node changes to grey and a DISCONNECTED condition appears.

Step 10  In the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This might take several minutes.)

Step 11  After the DISCONNECTED condition clears, complete the following steps to suppress the backplane IP address from display in CTC and the LCD. If you do not want to suppress the backplane IP address display, continue with Step 12.
   a.  Display the node in node view.
   b.  Click the Provisioning > Security > Data Comm tabs.
   c.  In the LCD IP Setting field, choose Suppress Display. This removes the IP address from display on the ONS 15454 LCD.
   d.  Check the Suppress CTC IP Address check box. This removes the IP address from display in the CTC information area and from the Provisioning > Security > Data Comm tab.
   e.  Click Apply.

Note  After you turn on secure mode, the TCC2P IP address becomes the node IP address.

Step 12  Return to your originating procedure (NTP).

DLP-G58 Create a Static Route

Purpose  This task creates a static route to establish CTC connectivity to a computer on another network. This task is performed when one of the following conditions exists:
   •  CTC computers on one subnet need to connect to ONS 15454 nodes that are connected by a router to ONS 15454 nodes residing on another subnet. OSPF is not enabled and the External Network Element gateway setting is not checked.
   •  You need to enable multiple CTC sessions among ONS 15454 nodes residing on the same subnet and the External Network Element gateway setting is not enabled.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed.

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher
Chapter 3  Turn Up a Node

DLP-G59 Set Up or Change Open Shortest Path First Protocol

**Step 1**  In node view, click the **Provisioning > Network** tabs.

**Step 2**  Click the **Static Routing** tab. Click **Create**.

**Step 3**  In the Create Static Route dialog box, enter the following:

- **Destination**—Enter the IP address of the computer running CTC. To limit access to one computer, enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

- **Mask**—Enter a subnet mask. If the destination is a host route (that is, one CTC computer), enter a 32-bit subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask accordingly, for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a subnet mask of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

- **Next Hop**—Enter the IP address of the router port or the node IP address if the CTC computer is connected to the node directly.

- **Cost**—Enter the number of hops between the ONS 15454 and the computer.

**Step 4**  Click **OK**. Verify that the static route appears in the Static Route window.

**Note**  Static route networking examples are provided in Chapter 22, “Management Connectivity Reference.”

**Step 5**  Return to your originating procedure (NTP).

---

**DLP-G59 Set Up or Change Open Shortest Path First Protocol**

**Purpose**  This task enables the OSPF routing protocol on the ONS 15454. Perform this task if you want to include the ONS 15454 in OSPF-enabled networks

**Tools/Equipment**  None

**Prerequisite Procedures**  DLP-G46 Log into CTC, page 2-25

You will need the OSPF Area ID, Hello and Dead intervals, and authentication key (if OSPF authentication is enabled) provisioned on the router to which the ONS 15454 is connected.

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Provisioning or higher

**Step 1**  In node view, click the **Provisioning > Network > OSPF** tabs.

**Step 2**  On the top left side of the OSPF pane, complete the following:

- **DCC/GCC OSPF Area ID Table**—In dotted decimal format, enter the number that identifies the ONS 15454 nodes as a unique OSPF area ID. The Area ID can be any number between 000.000.000.000 and 255.255.255.255, but must be unique to the LAN OSPF area.
DLP-G59 Set Up or Change Open Shortest Path First Protocol

Chapter 3 Turn Up a Node

• SDCC Metric—This value is normally unchanged. It sets a cost for sending packets across the Section DCC, which is used by OSPF routers to calculate the shortest path. This value should always be higher than the LAN metric. The default SDCC metric is 100.

• LDCC Metric—Sets a cost for sending packets across the Line DCC. This value should always be lower than the SDCC metric. The default LDCC metric is 33. It is usually not changed.

Step 3 In the OSPF on LAN area, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to OSPF routers on the LAN. Enable this field on ONS 15454 nodes that directly connect to OSPF routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:
   • Type—Choose Simple Password.
   • Enter Authentication Key—Enter the password.
   • Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings.

The OSPF priority and interval defaults are the defaults most commonly used by OSPF routers. Verify that these defaults match the ones used by the OSPF router where the ONS 15454 is connected.

• Router Priority—Selects the designated router for a subnet.

• Hello Interval (sec)—Sets the number of seconds between OSPF hello packet advertisements sent by OSPF routers. Ten seconds is the default.

• Dead Interval—Sets the number of seconds that will pass while an OSPF router’s packets are not visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Indicates the service speed. One second is the default.

• Retransmit Interval (sec)—Sets the time that will elapse before a packet is resent. Five seconds is the default.

• LAN Metric—Sets a cost for sending packets across the LAN. This value should always be lower than the SDCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note  Area range tables consolidate the information that is outside an OSPF area border. One ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table on this node points the router to the other nodes that reside within the ONS 15454 OSPF area.

a. Under OSPF Area Range Table, click Create.

b. In the Create Area Range dialog box, enter the following:
• Range Address—Enter the area IP address for the ONS 15454 nodes that reside within the OSPF area. For example, if the ONS 15454 OSPF area includes nodes with IP addresses 10.10.20.100, 10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 10.10.0.0.

• Range Area ID—Enter the OSPF area ID for the ONS 15454 nodes. This is either the ID in the DCC OSPF Area ID field or the ID in the Area ID for LAN Port field.

• Mask Length—Enter the subnet mask length. In the Range Address example, this is 16.

• Advertise—Check if you want to advertise the OSPF range table.

c. Click **OK**.

**Step 7** All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected to Area 0, use the following steps to create a virtual link table that will provide the disconnected area with a logical path to Area 0:

a. Under OSPF Virtual Link Table, click **Create**.

b. In the Create Virtual Link dialog box, complete the following fields. OSPF settings must match OSPF settings for the ONS 15454 OSPF area:

• Neighbor—The router ID of the Area 0 router.

• Transit Delay (sec)—The service speed. One second is the default.

• Hello Int (sec)—The number of seconds between OSPF hello packet advertisements sent by OSPF routers. Ten seconds is the default.

• Auth Type—if the router where the ONS 15454 is connected uses authentication, choose **Simple Password**. Otherwise, choose **No Authentication**.

• Retransmit Int (sec)—Sets the time that will elapse before a packet is resent. Five seconds is the default.

• Dead Int (sec)—Sets the number of seconds that will pass while an OSPF router’s packets are not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click **OK**.

**Step 8** After entering ONS 15454 OSPF area data, click **Apply**.

If you changed the Area ID, the TCC2/TCC2P cards reset, one at a time. The reset takes approximately 10 to 15 minutes. **Table 3-2 on page 3-14** shows the LED behavior during the TCC2/TCC2P reset.

**Step 9** Return to your originating procedure (NTP).
DLP-G60 Set Up or Change Routing Information Protocol

Purpose
This task enables RIP on the ONS 15454. Perform this task if you want to include the ONS 15454 in RIP-enabled networks.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
You need to create a static route to the router adjacent to the ONS 15454 for the ONS 15454 to communicate its routing information to non-DCC-connected nodes.

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

---

Step 1
In node view, click the Provisioning > Network > RIP tabs.

Step 2
Check the RIP Active check box if you are activating RIP.

Step 3
Choose either RIP Version 1 or RIP Version 2 from the drop-down list, depending on which version is supported in your network.

Step 4
Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number of hops.

Step 5
By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires authentication, complete the following steps. If not, continue with Step 6.
   a. Click the No Authentication button.
   b. In the Edit Authentication Key dialog box, complete the following:
      • Type—Choose Simple Password.
      • Enter Authentication Key—Enter the password.
      • Confirm Authentication Key—Enter the same password to confirm it.
   c. Click OK.
   The authentication button label changes to Simple Password.

Step 6
If you want to complete an address summary, complete the following steps. If not, continue with Step 7. Complete the address summary only if the ONS 15454 is a gateway NE with multiple external ONS 15454 NEs attached with IP addresses in different subnets.
   a. In the RIP Address Summary area, click Create.
   b. In the Create Address Summary dialog box, complete the following:
      • Summary Address—Enter the summary IP address.
      • Mask Length—Enter the subnet mask length using the up and down arrows.
      • Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.
   c. Click OK.

Step 7
Return to your originating procedure (NTP).
NTP-G27 Set Up the ONS 15454 for Firewall Access

Purpose
This procedure provisions ONS 15454 nodes and CTC computers for access through firewalls.

Tools/Equipment
IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures
NTP-G22 Verify Common Card Installation, page 3-4

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Log into a node that is behind the firewall. See the “DLP-G46 Log into CTC” task on page 2-25 for instructions. If you are already logged in, continue with Step 2.

Step 2
Complete the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 3-24. Figure 3-6 shows ONS 15454 nodes in a protected network and the CTC computer in an external network. For the computer to access the ONS 15454 nodes, you must provision the IIOP listener port specified by your firewall administrator on the ONS 15454.

Figure 3-6   Nodes Behind a Firewall

Step 3
If the CTC computer resides behind a firewall, complete the “DLP-G62 Provision the IIOP Listener Port on the CTC Computer” task on page 3-25. Figure 3-7 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the ONS 15454, you must provision the IIOP port on the CTC computer and on the ONS 15454.
DLP-G61 Provision the IIOP Listener Port on the ONS 15454

Purpose
This task sets the IIOP listener port on the ONS 15454, which enables you to access ONS 15454 nodes that reside behind a firewall.

Tools/Equipment
IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
If the Enable SOCKS proxy server on port 1080 check box is checked, CTC will use port 1080 and ignore the configured IIOP port setting. If the check box is subsequently unchecked, the configured IIOP listener port will be used.

Step 1
In node view, click the Provisioning > Network > General tabs.

Step 2
In the TCC CORBA (IIOP) Listener Port area, choose a listener port option:
- Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454 nodes on the same side of the firewall or if no firewall is used (default). This option can be used for access through a firewall if Port 57790 is open.
- Standard Constant—Uses Port 683, the CORBA default port number.
- Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall administrator.

Step 3
Click Apply.

Step 4
When the Change Network Configuration message appears, click Yes.

Step 5
Both ONS 15454 TCC2/TCC2P cards reboot, one at a time. The reboot takes approximately 15 minutes.

Step 6
Return to your originating procedure (NTP).
DLP-G62 Provision the IIOP Listener Port on the CTC Computer

**Purpose**
This task selects the IIOP listener port on CTC and must be completed if the computer running CTC resides behind a firewall.

**Tools/Equipment**
IIOP listener port number from LAN or firewall administrator.

**Prerequisite Procedures**
- NTP-G22 Verify Common Card Installation, page 3-4
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed.

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
From the Edit menu, choose Preferences.

**Step 2**
In the Preferences dialog box, click the Firewall tab.

**Step 3**
In the CTC CORBA (IIOP) Listener Port area, choose a listener port option:

- Default - Variable—Use to connect to ONS 15454 nodes from within a firewall or if no firewall is used (default).
- Standard Constant—Use Port 683, the CORBA default port number.
- Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator.

**Step 4**
Click Apply. A warning appears telling you that the port change will apply during the next CTC login.

**Step 5**
Click OK.

**Step 6**
In the Preferences dialog box, click OK.

**Step 7**
To access the ONS 15454 using the IIOP port, log out of CTC then log back in. (To log out, choose Exit from the File menu).

**Step 8**
Return to your originating procedure (NTP).

---

**NTP-G132 Provision OSI**

**Purpose**
This procedure provisions the ONS 15454 so it can be networked with other vendor NEs that use the OSI protocol stack for data communications network (DCN) communications. This procedure provisions the TID Address Resolution Protocol (TARP), OSI routers, manual area addresses, subnetwork points of attachment, and IP-over-OSI tunnels.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G15 Install the Common Control Cards, page 1-71

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher
Caution

This procedure requires an understanding of OSI protocols, parameters, and functions. Before you begin, review the OSI reference sections in Chapter 22, “Management Connectivity Reference.”

Caution

Do not begin this procedure until you know the role of the ONS 15454 within the OSI and IP network.

Note

This procedure requires provisioning of non-ONS equipment including routers and third party NEs. Do not begin until you have the capability to complete that provisioning.

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the OSI routing mode. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the following tasks:

- DLP-G283 Provision OSI Routing Mode, page 3-27—Complete this task first.
- DLP-G284 Provision the TARP Operating Parameters, page 3-28—Complete this task second.
- DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache, page 3-30—Complete this task as needed.
- DLP-G287 Add a TARP Manual Adjacency Table Entry, page 3-31—Complete this task as needed.
- DLP-G288 Provision OSI Routers, page 3-31—Complete this task as needed.
- DLP-G289 Provision Additional Manual Area Addresses, page 3-32—Complete this task as needed.
- DLP-G290 Enable the OSI Subnet on the LAN Interface, page 3-33—Complete this task as needed.
- DLP-G291 Create an IP-Over-CLNS Tunnel, page 3-34—Complete this task as needed.

Stop. You have completed this procedure.
DLP-G283 Provision OSI Routing Mode

**Purpose**
This task provisions the OSI routing mode. Complete this task when the ONS 15454 is connected to networks with third party NEs that use the OSI protocol stack for DCN communication.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G15 Install the Common Control Cards, page 1-71
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

⚠️ **Caution**
Do not complete this task until you confirm the role of the node within the network. It will be either an ES, IS Level 1, or IS Level 1/Level 2. This decision must be carefully considered. For additional information about OSI provisioning, refer to the “Management Network Connectivity” chapter of the Cisco ONS 15454 Reference Manual.

⚠️ **Caution**
Link State Protocol (LSP) buffers must be the same at all NEs within the network, or loss of visibility might occur. Do not modify the LSP buffers unless you confirm that all NEs within the OSI have the same buffer size.

⚠️ **Caution**
LSP buffer sizes cannot be greater than the LAP-D maximum transmission unit (MTU) size within the OSI area.

🔍 **Note**
For ONS 15454 nodes, three virtual routers can be provisioned. The node primary Network Service Access Point (NSAP) address is also the Router 1 primary manual area address. To edit the primary NSAP, you must edit the Router 1 primary manual area address. After you enable Router 1 on the Routers subtab, the Change Primary Area Address button is available to edit the address.

---

**Step 1**
In node view, click the **Provisioning > OSI** tabs.

**Step 2**
Choose a routing mode:

- **End System**—The ONS 15454 performs OSI end system (ES) functions and relies upon an intermediate system (IS) for communication with nodes that reside within its OSI area.

  📝 **Note**
The End System routing mode is not available if more than one virtual router is enabled.

- **Intermediate System Level 1**—The ONS 15454 performs OSI IS functions. It communicates with IS and ES nodes that reside within its OSI area. It depends upon an IS L1/L2 node to communicate with IS and ES nodes that reside outside its OSI area.
Intermediate System Level 1/Level 2—The ONS 15454 performs IS functions. It communicates with IS and ES nodes that reside within its OSI area. It also communicates with IS L1/L2 nodes that reside in other OSI areas. Before choosing this option, verify the following:

- The node is connected to another IS Level 1/Level 2 node that resides in a different OSI area.
- The node is connected to all nodes within its area that are provisioned as IS L1/L2.

Step 3 If needed, change the LSP data buffers:

- L1 LSP Buffer Size—Adjusts the Level 1 link state PDU buffer size. The default is 512. It should not be changed.
- L2 LSP Buffer Size—Adjusts the Level 2 link state PDU buffer size. The default is 512. It should not be changed.

Step 4 Return to your originating procedure (NTP).

DLP-G284 Provision the TARP Operating Parameters

Purpose

This task provisions the TARP operating parameters including TARP protocol data unit (PDU) propagation, timers, and loop detection buffer (LDB).

Tools/Equipment

None

Prerequisite procedures

DLP-G46 Log into CTC, page 2-25

Required/As needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Step 1 In node view, click the Provisioning > OSI > TARP > Config tabs.

Step 2 Provision the following parameters, as needed:

- TARP PDUs L1 Propagation—If checked (default), TARP Type 1 PDUs that are received by the node and are not excluded by the LDB are propagated to other NEs within the Level 1 OSI area. (Type 1 PDUs request a protocol address that matches a target identifier [TID] within a Level 1 routing area.) The propagation does not occur if the NE is the target of the Type 1 PDU, and PDUs are not propagated to the NE from which the PDU was received.

Note The TARP PDUs L1 Propagation parameter is not used when the Node Routing Area (on the Provisioning > OSI > Main Setup tab) is set to End System.

- TARP PDUs L2 Propagation—If checked (default), TARP Type 2 PDUs that are received by the node and are not excluded by the LDB are propagated to other NEs within the Level 2 OSI areas. (Type 2 PDUs request a protocol address that matches a TID within a Level 2 routing area.) The propagation occurs if the NE is not the target of the Type 2 PDU, and PDUs are not propagated to the NE from which the PDU was received.

Note The TARP PDUs L2 Propagation parameter is only used when the Node Routing Area is provisioned to Intermediate System Level 1/Level 2.
TARP PDUs Origination—If checked (default), the node performs all TARP origination functions including:

- TID to NSAP resolution requests (originate TARP Type 1 and Type 2 PDUs)
- NSAP to TID requests (originate Type 5 PDUs)
- TARP address changes (originate Type 4 PDUs)

Note: TARP Echo and NSAP to TID are not supported.

TARP Data Cache—If checked (default), the node maintains a TARP data cache (TDC). The TDC is a database of TID to NSAP pairs created from TARP Type 3 PDUs received by the node and modified by TARP Type 4 PDUs (TID to NSAP updates or corrections). TARP 3 PDUs are responses to Type 1 and Type 2 PDUs. The TDC can also be populated with static entries entered on the TARP > Static TDC tab.

Note: This parameter is only used when the TARP PDUs Origination parameter is enabled.

L2 TARP Data Cache—If checked (default), the TIDs and NSAPs of NEs originating Type 2 requests are added to the TDC before the node propagates the requests to other NEs.

Note: The TARP Data Cache parameter is designed for Intermediate System Level 1/Level 2 nodes that are connected to other Intermediate System Level 1/Level 2 nodes. Enabling the parameter for Intermediate System Level 1 nodes is not recommended.

LDB—If checked (default), enables the TARP loop detection buffer. The LDB prevents TARP PDUs from being sent more than once on the same subnet.

Note: The LDP parameter is not used if the Node Routing Mode is provisioned to End System or if the TARP PDUs L1 Propagation parameter is not enabled.

LAN TARP Storm Suppression—If checked (default), enables TARP storm suppression. This function prevents redundant TARP PDUs from being unnecessarily propagated across the LAN network.

Send Type 4 PDU on Startup—If checked, a TARP Type 4 PDU is originated during the initial ONS 15454 startup. Type 4 PDUs indicate that a TID or NSAP change has occurred at the NE. (The default setting is not enabled.)

Type 4 PDU Delay—Sets the amount of time that will pass before the Type 4 PDU is generated when Send Type 4 PDU on Startup is enabled. 60 seconds is the default. The range is 0 to 255 seconds.

Note: The Send Type 4 PDU on Startup and Type 4 PDU Delay parameters are not used if TARP PDUs Origination is not enabled.

LDB Entry—Sets the TARP loop detection buffer timer. The loop detection buffer time is assigned to each LDB entry for which the TARP sequence number (tar-seq) is zero. The default is 5 minutes. The range is 1 to 10 minutes.
DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache

**Purpose**
This task adds a static TID to NSAP entry to the TDC. The static entries are required for NEs that do not support TARP and are similar to static routes. For a specific TID, you must force a specific NSAP.

**Tools/Equipment**
None

**Prerequisite procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioner or higher

---

- **Step 1**
  In node view, click the **Provisioning > OSI > TARP > Static TDC** tabs.

- **Step 2**
  Click **Add Static Entry**.

- **Step 3**
  In the Add Static Entry dialog box, enter the following:
  - **TID**—Enter the TID of the NE. (For ONS nodes, the TID is the Node Name parameter on the node view Provisioning > General tab.)
  - **NSAP**—Enter the OSI NSAP address in the NSAP field or, if preferred, click **Use Mask** and enter the address in the Masked NSAP Entry dialog box.

- **Step 4**
  Click **OK** to close the Masked NSAP Entry dialog box, if used, and then click **OK** to close the Add Static Entry dialog box.

- **Step 5**
  Return to your originating procedure (NTP).
DLP-G287 Add a TARP Manual Adjacency Table Entry

**Purpose**
This task adds an entry to the TARP manual adjacency table (MAT). Entries are added to the MAT when the ONS 15454 must communicate across routers or NEs that lack TARP capability.

**Tools/Equipment**
None

**Prerequisite procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
In node view, click the **Provisioning > OSI > TARP > MAT** tabs.

**Step 2**
Click **Add**.

**Step 3**
In the Add TARP Manual Adjacency Table Entry dialog box, enter the following:
- **Level**—Sets the TARP Type Code that will be sent:
  - **Level 1**—Indicates that the adjacency is within the same area as the current node. The entry generates Type 1 PDUs.
  - **Level 2**—Indicates that the adjacency is in a different area than the current node. The entry generates Type 2 PDUs.
- **NSAP**—Enter the OSI NSAP address in the NSAP field or, if preferred, click **Use Mask** and enter the address in the Masked NSAP Entry dialog box.

**Step 4**
Click **OK** to close the Masked NSAP Entry dialog box, if used, and then click **OK** to close the Add Static Entry dialog box.

**Step 5**
Return to your originating procedure (NTP).

DLP-G288 Provision OSI Routers

**Purpose**
This task enables an OSI router and edits its primary manual area address.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G22 Verify Common Card Installation, page 3-4
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Note**
Router 1 must be enabled before you can enable and edit the primary manual area addresses for Routers 2 and 3.
Note
The Router 1 manual area address, System ID, and Selector “00” create the node NSAP address. Changing the Router 1 manual area address changes the node’s NSAP address.

Note
The System ID for Router 1 is the node MAC address. The System IDs for Routers 2 and 3 are created by adding 1 and 2 respectively to the Router 1 System ID. You cannot edit the System IDs.

Step 1
Click the Provisioning > OSI > Routers > Setup tabs.

Step 2
Chose the router you want provision and click Edit. The OSI Router Editor dialog box appears.

Step 3
In the OSI Router Editor dialog box:
   a. Check Enable Router to enable the router and make its primary area address available for editing.
   b. Click the manual area address, then click Edit.
   c. In the Edit Manual Area Address dialog box, edit the primary area address in the Area Address field. If you prefer, click Use Mask and enter the edits in the Masked NSAP Entry dialog box. The address (hexadecimal format) can be 8 to 24 alphanumeric characters (0–9, a–f) in length.
   d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Edit Manual Area Address, and OSI Router Editor.

Step 4
Return to your originating procedure (NTP).

DLP-G289 Provision Additional Manual Area Addresses

Purpose
This task provisions the OSI manual area addresses. One primary area and two additional manual areas can be created for each virtual router.

Tools/Equipment
None

Prerequisite Procedures
NTP-G22 Verify Common Card Installation, page 3-4
DLP-G288 Provision OSI Routers, page 3-31
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Click the Provisioning > OSI > Routers > Setup tabs.

Step 2
Chose the router where you want provision an additional manual area address and click Edit. The OSI Router Editor dialog box appears.

Step 3
In the OSI Router Editor dialog box:
   a. Check Enable Router to enable the router and make its primary area address available for editing.
   b. Click the manual area address, then click Add.
c. In the Add Manual Area Address dialog box, enter the primary area address in the Area Address field. If you prefer, click Use Mask and enter the address in the Masked NSAP Entry dialog box. The address (hexadecimal format) can be 2 to 24 alphanumeric characters (0–9, a–f) in length.

d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Add Manual Area Address, and OSI Router Editor.

Step 4 Return to your originating procedure (NTP).

DLP-G290 Enable the OSI Subnet on the LAN Interface

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task enables the OSI subnetwork point of attachment on the LAN interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
</tbody>
</table>
| Prerequisite Procedures | NTP-G22 Verify Common Card Installation, page 3-4  
DLP-G46 Log into CTC, page 2-25 |
| Required/As Needed | As needed |
| Onsite/Remote | Onsite or remote |
| Security Level | Provisioning or higher |

Note OSI subnetwork points of attachment are enabled on DCCs when you create DCCs. See the “NTP-G38 Provision OSC Terminations” procedure on page 3-84 and the “DLP-G76 Provision GCC Terminations” task on page 7-14.

Note The OSI subnetwork point of attachment cannot be enabled for the LAN interface if the OSI routing mode is set to ES.

Note If Secure Mode is on, the OSI Subnet is enabled on the backplane LAN port, not the front TCC2P port.

Step 1 Click the Provisioning > OSI > Routers > Subnet tabs.
Step 2 Click Enable LAN Subnet.
Step 3 In the Enable LAN Subnet dialog box, complete the following fields:

- ESH—Sets the End System Hello (ESH) propagation frequency. End system NEs transmit ESHs to inform other ESs and ISs about the NSAPs it serves. The default is 10 seconds. The range is 10 to 1000 seconds.
- ISH—Sets the Intermediate System Hello (ISH) PDU propagation frequency. Intermediate system NEs send ISHs to other ESs and ISs to inform them about the IS NEs it serves. The default is 10 seconds. The range is 10 to 1000 seconds.
- IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default is 3 seconds. The range is 1 to 600 seconds.
- IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost to calculate the shortest routing path. The default IS-IS cost for LAN subnets is 20. It normally should not be changed.

- DIS Priority—Sets the designated intermediate system (DIS) priority. In IS-IS networks, one router is elected to serve as the DIS (LAN subnets only). Cisco router DIS priority is 64. For the ONS 15454 LAN subnet, the default DIS priority is 63. It normally should not be changed.

**Step 4** Click **OK**.

**Step 5** Return to your originating procedure (NTP).

---

**DLP-G291 Create an IP-Over-CLNS Tunnel**

**Purpose**
This task creates an IP-over-Connectionless Network Service (CLNS) tunnel to allow ONS 15454 nodes to communicate across equipment and networks that use the OSI protocol stack.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G22 Verify Common Card Installation, page 3-4
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Caution**
IP-over-CLNS tunnels require two endpoints. You will create one point on an ONS 15454. The other endpoint is generally provisioned on non-ONS equipment including routers and other vendor NEs. Before you begin, verify that you have the capability to create an OSI-over-CLNS tunnel on the other equipment location.

**Step 1** Click the **Provisioning > OSI > Tunnels** tabs.

**Step 2** Click **Create**.

**Step 3** In the Create IP Over OSI Tunnel dialog box, complete the following fields:

- **Tunnel Type**—Choose a tunnel type:
  - Cisco—Creates the proprietary Cisco IP tunnel. Cisco IP tunnels add the CLNS header to the IP packets.
  - GRE—Creates a Generic Routing Encapsulation tunnel. GRE tunnels add the CLNS header and a GRE header to the IP packets.

The Cisco proprietary tunnel is slightly more efficient than the GRE tunnel because it does not add the GRE header to each IP packet. The two tunnel types are not compatible. Most Cisco routers support the Cisco IP tunnel, while only a few support both GRE and Cisco IP tunnels. You generally should create Cisco IP tunnels if you are tunneling between two Cisco routers or between a Cisco router and an ONS node.
Always verify that the IP-over-CLNS tunnel type you choose is supported by the equipment at the other end of the tunnel.

- **IP Address**—Enter the IP address of the IP-over-CLNS tunnel destination.
- **IP Mask**—Enter the IP address subnet mask of the IP-over-CLNS destination.
- **OSPF Metric**—Enter the OSPF metric for sending packets across the IP-over-CLNS tunnel. The OSPF metric, or cost, is used by OSPF routers to calculate the shortest path. The default is 110. Normally, it is not be changed unless you are creating multiple tunnel routes and want to prioritize routing by assigning different metrics.
- **NSAP Address**—Enter the destination NE or OSI router NSAP address.

**Step 4** Click OK.

**Step 5** Provision the other tunnel end point using the documentation provided by the manufacturer of the third party vendor NE.

**Step 6** Return to your originating procedure (NTP).

## NTP-G28 Set Up SNMP

**Purpose**

This procedure provisions the SNMP parameters so that you can use SNMP management software with the ONS 15454.

**Tools/Equipment**

None

**Prerequisite Procedures**

NTP-G22 Verify Common Card Installation, page 3-4

**Required/As Needed**

Required if SNMP is used at your installation.

**Onsite/Remote**

Onsite or remote

**Security Level**

Provisioning or higher

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to set up SNMP. If you are already logged in, continue with Step 2.

**Step 2** In node view, click the Provisioning > SNMP tabs.

**Step 3** In the Trap Destinations area, click Create.

**Step 4** Complete the following in the Create SNMP Trap Destination dialog box (Figure 3-8):

- **Destination IP Address**—Type the IP address of your network management system (NMS). If the node you are logged into is an ENE, set the destination address to the GNE.

- **Community**—Type the SNMP community name. For a description of SNMP community names, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

**Note**

The community name is a form of authentication and access control. The community name assigned to the ONS 15454 is case-sensitive and must match the community name of the NMS.
• UDP Port—The default User Datagram Protocol (UDP) port for SNMP is 162. If the node is an ENE in a SOCKS proxy server network, the UDP port must be set to the GNE’s SNMP relay port, which is 391.

• Trap Version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine which version to use.

Figure 3-8 Creating an SNMP Trap

Step 5 Click OK. The node IP address of the node where you provisioned the new trap destination appears in the Trap Destinations area.

Step 6 Click the node IP address in the Trap Destinations area. Verify the SNMP information that appears in the Selected Destination list.

Step 7 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets check box. If this box is not checked, SET requests are rejected.

Step 8 If you want to set up the SNMP proxy feature to allow network management, message reporting, and performance statistic retrieval across ONS firewalls, click the Enable SNMP Proxy check box located on the SNMP tab.

Note The ONS firewall proxy feature only operates on nodes running Software Release 4.6 and later. Using this feature effectively breaches the ONS firewall to exchange management information.

For more information about the SNMP proxy feature, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 9 Click Apply.

Step 10 If you are setting up SNMP proxies, you can set up to three relays that send SNMP trap error counts back to NE for each trap destination address:

a. Click the first trap destination IP address. The address and its community name appear in the Destination fields.

b. Enter up to three SNMP Proxy relay addresses and community names in the fields for Relay A, Relay B, and Relay C.

Note The community names specified for each relay node must match one of the provisioned SNMP community names in the NE.

Note The SNMP proxy directs SNMP traps from this node through IpA to IpB to IpC to the trap destination. Ensure that you enter the IP addresses in the correct order so that this sequence runs correctly.
Step 11  Click Apply.

Stop. You have completed this procedure.

NTP-G29 Preprovision a Slot

Purpose This procedure preprovisions the ONS 15454 slots in CTC based upon the Cisco MetroPlanner shelf layout prepared for your site. Preprovisioning the slots ensures that the physical cards are installed in the slots anticipated by the parameters contained in the Cisco MetroPlanner Assisted Configuration Setup that will be imported into CTC.

Tools/Equipment Cisco MetroPlanner shelf layout or JPG file.

Prerequisite Procedures Chapter 2, “Connect the PC and Log into the GUI”

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will preprovision the slots. If you are already logged in, continue with Step 2.

Step 2 In CTC node view, right-click an empty slot where you will install a card.

Step 3 From the Add Card shortcut menu, choose the card type that will be installed based on the Cisco MetroPlanner shelf layout (see Table 3-1 on page 3-3). Only cards that can be installed in the slot appear in the Add Card shortcut menu. The 32WSS, 32-MUX-O, and 32-DMX-O require two vacant slots, or they will not appear in the menu. Table 3-3 shows the Add Card shortcut menu items, submenu items, and the card groups and menu options/cards that they reference.

Table 3-3  CTC Add Card Menu for DWDM Cards

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>nXP</td>
<td>MXPP_MR_10E</td>
<td>MXPP_MR_10E</td>
</tr>
<tr>
<td></td>
<td>MXP_MR_10E</td>
<td>MXP_MR_10E</td>
</tr>
<tr>
<td></td>
<td>MXP_MR_10G</td>
<td>MXP_MR_10G</td>
</tr>
<tr>
<td></td>
<td>MXP_MR_2.5G</td>
<td>MXP_MR_2.5G</td>
</tr>
<tr>
<td></td>
<td>TXPP_MR_2.5G</td>
<td>TXPP_MR_2.5G</td>
</tr>
<tr>
<td></td>
<td>TXP_MR_10E</td>
<td>TXP_MR_10E</td>
</tr>
<tr>
<td></td>
<td>TXP_MR_10G</td>
<td>TXP_MR_10G</td>
</tr>
<tr>
<td></td>
<td>TXP_MR_2.5G</td>
<td>TXP_MR_2.5G</td>
</tr>
</tbody>
</table>
### Step 4

Repeat Step 3 until all the cards shown in the Cisco MetroPlanner shelf layout are provisioned in CTC.

Stop. **You have completed this procedure.**
**NTP-G30 Install the DWDM Cards**

**Purpose**
This procedure describes how to install DWDM cards (OPT-PRE, OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, OSCM, and OSC-CSM).

**Tools/Equipment**
- Cisco MetroPlanner shelf layout
- The following cards, as required by your site plan: OPT-PRE, OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, OSCM, and OSC-CSM cards (as applicable)
- The ONS 15454 NE defaults file if the node will use custom NE defaults

**Prerequisite Procedures**
- NTP-G15 Install the Common Control Cards, page 1-71
- NTP-G14 Install DWDM Equipment, page 1-66
- NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

**Required/As Needed**
- As needed
- Onsite
- Provisioning or higher

**Warning**
During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

**Warning**
Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

**Warning**
Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do not view directly with optical instruments. Viewing the laser output with certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye hazard. Statement 1056

**Caution**
Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

**Note**
Complies with the US Federal Drug Administration Code of Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001.

**Note**
If protective clips are installed on the backplane connectors of the cards, remove the clips before installing the cards.
Note
If you install a card incorrectly, the FAIL LED flashes continuously.

Step 1
If the node requires a custom NE default settings to be installed on the node, complete the “NTP-G136 Import Network Element Defaults” procedure on page 13-43. If not, continue with Step 2.

Caution
Custom NE defaults, if required, must be installed before you install the DWDM cards.

Step 2
Display the Cisco MetroPlanner shelf layout (see Table 3-1 on page 3-3).

Step 3
Remove the DWDM card from its packaging, then remove the protective caps from the backplane connectors.

Step 4
Open the card latches/ejectors.

Step 5
Use the latches/ejectors to firmly slide the card along the slot guide rails until the card plugs into the receptacle at the back of the slot.

Step 6
Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note
It is possible to close the latches/ejectors when the card is not completely plugged into the backplane. Ensure that you cannot insert the card any further.

The following LED activity will occur:
- The FAIL LED turns on for approximately 35 seconds. During this time, the ACT LED will cycle through various states, and then extinguish.
- The FAIL LED blinks for approximately 40 seconds.
- All LEDs turn on and then turn off within 5 seconds.
- If new software is being downloaded to the card, the ACT and SF LEDs blink for 20 seconds to 5 minutes, depending on the card type.
- The ACT LED turns on.
- The signal fail (SF) LED might persist until all card ports connect to their far-end counterparts and a signal is present.

Step 7
If the card does not boot up properly, or the LED activity does not mirror the activity in Step 6, check the following:
- When a physical card type does not match the type of card provisioned for that slot in CTC, the card might not boot. If a DWDM card does not boot, open CTC and ensure that the slot is not provisioned for a different card type before assuming that the card is faulty.
- If the red FAIL LED does not turn on, check the power.
- If you insert a card into a slot provisioned for a different card, all LEDs turn off.
- If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed. Remove the card and repeat Steps 3 to 6. If the card does not boot up properly the second time, it might be defective. Contact your next level of support.
Chapter 3      Turn Up a Node

NTP-G31 Install the DWDM Dispersion Compensating Units

Note

The DWDM node type is determined by the cards that are installed. For example, if two 32DMX-O and two 32MUX-O cards are installed but no AD-xC-xx.x or AD-xB-xx.x cards are installed, CTC considers the node a hub node. However, if one 32DMX-O and one 32MUX-O card are installed with no AD-xC-xx.x or AD-xB-xx.x cards, CTC considers the node a terminal node. For more information, refer to Chapter 16, “Card Reference.”

Step 8

Repeat Steps 3 through 7 until all the DWDM cards are installed in the node.

Step 9

If OPT-PRE cards are installed, complete one of the following steps for each OPT-PRE card based upon the Cisco MetroPlanner shelf layout. If OPT-PRE cards are not installed, you have completed this procedure.

- If the Cisco MetroPlanner shelf layout does not include DCUs, install a 4-dB attenuator with a tolerance of +/-1 dB between the OPT-PRE DC TX and RX ports for each OPT-PRE installed in the shelf.
- If the shelf layout includes DCUs, complete the “NTP-G31 Install the DWDM Dispersion Compensating Units” procedure on page 3-41 for each side of the shelf that requires a DCU.

Stop. You have completed this procedure.

NTP-G31 Install the DWDM Dispersion Compensating Units

Purpose

This procedure describes how to install the dispersion compensating units (DCU-xx.x) for DWDM shelves.

Tools/Equipment

DCU-xx.x cards

Prerequisite Procedures

NTP-G15 Install the Common Control Cards, page 1-71
NTP-G14 Install DWDM Equipment, page 1-66
NTP-G30 Install the DWDM Cards, page 3-39
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Provisioning or higher

Warning

Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do not view directly with optical instruments. Viewing the laser output with certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye hazard. Statement 1056

Caution

Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.
Complies with the US Federal Drug Administration Code of Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001.

If protective clips are installed on the backplane connectors of the DCUs, remove the clips before installing the units.

**Step 1** Pull the DCU latch inward with your finger.

**Step 2** Firmly slide the DCU along the guide rails until the card plugs into the receptacle at the back of the horizontal dispersion compensating card slot at the top of the shelf.

The west DCU is commonly installed on the left side and the east DCU is commonly installed on the right side.

Double-check the placement of the DCU(s) with your Cisco MetroPlanner shelf layout. If you install the wrong DCU in a slot, remove the DCU and install the correct one.

**Step 3** Release the finger latch.

It is possible to close the latch when the DCU is not completely plugged into the backplane. Ensure that you cannot insert the DCU any further.

**Step 4** Verify that the DCU is engaged with the backplane by grasping and gently pulling the card handle. If the card does not move, it is fully installed. If it moves, repeat Steps 2 and 3.

**Stop. You have completed this procedure.**
NTP-G32 Install the Transponder and Muxponder Cards

Purpose
This procedure describes how to install the ONS 15454 TXP and MXP cards.

Tools/Equipment
TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, and MXPP_MR_2.5G cards (as applicable)

Prerequisite Procedures
NTP-G15 Install the Common Control Cards, page 1-71
NTP-G14 Install DWDM Equipment, page 1-66
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Warning
During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning
Class 1 laser product. Statement 1008

Warning
Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do not view directly with optical instruments. Viewing the laser output with certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye hazard. Statement 1056

Caution
Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note
Complies with the US Federal Drug Administration Code of Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001.

Note
If protective clips are installed on the backplane connectors of the cards, remove the clips before installing the cards.

Note
If you install a card incorrectly, the FAIL LED flashes continuously.

Step 1
Display Cisco MetroPlanner shelf layout (see Table 3-1 on page 3-3) for the node where you will install the TXP and MXP cards.
Step 2 Remove the TXP or MXP card from its packaging, then remove the protective clips from the backplane connectors.

Step 3 Open the card latches/ejectors.

Step 4 Use the latches/ejectors to firmly slide the TXP or MXP card along the guide rails until the card plugs into the receptacle at the back of the slot designated by the Cisco MetroPlanner shelf layout.

Note If you install the wrong card in a slot, complete the “NTP-G107 Remove and Replace DWDM Cards” procedure on page 12-1.

Step 5 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches and ejectors when the card is not completely plugged into the backplane. Ensure that you cannot insert the card any further.

The following LED activity will occur:

- The red FAIL LED turns on for approximately 30 seconds. During this time, the ACT LED will cycle through various states, and then extinguish.
- The red FAIL LED blinks for approximately 45 seconds.
- All LEDs blink once and turn off for approximately 10 seconds while the ACT and SF LEDs cycle through various stages.
- The ACT or ACT/STBY LED turns on. The SF LED might persist until all card ports connect to their far-end counterparts and a signal is present.

Note Until a TXP or MXP is provisioned, the card is in the standby condition and the ACT/STBY LED remains amber in color.

Step 6 If the card does not boot up properly, or the LED activity does not mirror Step 5, check the following:

- When a physical card type does not match the type of card provisioned for that slot in CTC, the card might not boot. If a TXP or MXP card does not boot, open CTC and ensure that the slot is not provisioned for a different card type before assuming that the card is faulty.
- If the red FAIL LED does not turn on, check the power.
- If you insert a card into a slot provisioned for a different card, all LEDs turn off.
- If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed properly. Remove the card and repeat Steps 3 to 5.

Step 7 If the TXP or MXP requires a Small Form-factor Pluggable (SFP or XFP) connector, complete one of the following tasks:

- DLP-G63 Install an SFP or XFP, page 3-45—Complete this task to install the physical SFP or XFP into the TXP or MXP.
- DLP-G273 Preprovision an SFP or XFP Slot, page 3-46—(Optional) Complete this task if you do not have the physical SFP or XFP and wish to preprovision the SFP or XFP slot. If you preprovision a multirate SFP or XFP, complete the “DLP-G278 Provision the Optical Line Rate” task on page 5-6.
Chapter 3      Turn Up a Node

Note Provisionable port modules (PPMs) determine how the SFPs and XFPs are used in CTC. PPM provisioning procedures are provided in Chapter 5, “Provision Transponder and Muxponder Cards.”

Step 8 If you need to remove an SFP or XFP, complete the “DLP-G64 Remove an SFP or XFP” task on page 3-47.

Note You will provision the TXP and MXP cards after you complete all node turn-up procedures. TXP and MXP provisioning procedures are provided in Chapter 5, “Provision Transponder and Muxponder Cards.”

Note Until a TXP or MXP is provisioned, the card is in the standby condition and the ACT/STBY LED remains amber in color.

Stop. You have completed this procedure.

DLP-G63 Install an SFP or XFP

Purpose This task installs SFP/XFPs into TXP and MXP cards. SFP/XFPs provide a fiber interface to the card.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
DLP-G273 Preprovision an SFP or XFP Slot, page 3-46

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Note SFPs and XFPs are generically called PPMs in CTC. After installing the SFP/XFP, multirate PPMs (PPMs that provide OC-3 or OC-12 line rates) must be provisioned in CTC. See the “DLP-G277 Provision a Multirate PPM” task on page 5-3.

Step 1 Verify that the SFP/XFP is correct for your network and TXP or MXP card (see Table 16-69 on page 16-118). Check that you are installing compatible SFP/XFPs, for example, SX to SX or LX/LH to LX/LH.

Step 2 Install the SFP/XFP:
- For a mylar tab SFP/XFP: Slide the SFP/XFP into the slot.
- For an actuator/button SFP/XFP: Slide the SFP/XFP all the way into the slot until you hear a click.
- For a bail clasp SFP/XFP: Latch (flip upwards) the bail clasp before inserting the SFP/XFP into the slot and then slide it into the slot.
DLP-G273 Preprovision an SFP or XFP Slot

Purpose
This procedure provisions SFP/XFPs, which connect fiber to TXP and MXP cards. SFP/XFPs are referred to as PPMs in CTC.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the TXP or MXP card where you want to provision PPM settings.

Step 2
Click the Provisioning > Pluggable Port Modules tabs.

Step 3
In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4
In the Create PPM dialog box, complete the following:
- PPM—Choose the slot number where the SFP/XFP is installed from the drop-down list.
- PPM Type—Choose the number of ports supported by your SFP/XFP from the drop-down list. The drop-down list displays the number of PPMs that are available for provisioning. If only one port is supported, PPM (1 port) is the only option.

Step 5
Click OK. The newly created port appears in the Pluggable Port Modules pane. The row in the Pluggable Port Modules pane turns light blue. The Actual Equipment Type column remains blank until the actual SFP/XFP is installed. After the SFP/XFP is installed, the row in the pane turns white and the Actual Equipment Type column shows the equipment name.

Step 6
Verify that the PPM appears in the list in the Pluggable Port Modules pane. If it does not, repeat Steps 3 through 5.

Step 7
Repeat the task to provision a second PPM, if needed. If not, continue with Step 8.

Step 8
Click OK.

Step 9
Return to your originating procedure (NTP).
DLP-G64 Remove an SFP or XFP

**Purpose**
This task removes SFP/XFPs from TXP and MXP cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G32 Install the Transponder and Muxponder Cards, page 3-43

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

---

**Note**
This task removes the SFP/XFP hardware. To delete the provisioning for an SFP/XFP, see the “DLP-G280 Delete a PPM” procedure on page 5-8.

---

**Step 1**
If a fiber is connected, disconnect the network fiber cable from the Gigabit Interface Converter (GBIC) SC-type connector or the SFP/XFP LC-type connector.

**Step 2**
Release the SFP/XFP from the slot by performing one of the following actions (depending which latch is on the SFP/XFP):

- For a mylar tab SFP/XFP: Pull out the mylar tab.
- For an actuator/button SFP/XFP: Press the actuator/button.
- For a bail clasp SFP/XFP: Unlatch the bail clasp and swing it downward.

**Step 3**
Slide the SFP/XFP out of the slot.

**Step 4**
Return to your originating procedure (NTP).

---

NTP-G123 Install the Filler Cards

**Purpose**
This procedure explains how to install the filler cards (blank faceplates) in any unused traffic or AIC-I card slots (Slots 1 through 6, 9, and 11 through 17). The filler card aids in maintaining proper air flow and EMI requirements and is detected by CTC in Software Release 6.0 and higher.

**Tools/Equipment**
Filler cards (Cisco P/N 15454-FILLER)

**Prerequisite Procedures**
NTP-G30 Install the DWDM Cards, page 3-39
NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-41
NTP-G32 Install the Transponder and Muxponder Cards, page 3-43

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None
Warning  Blank faceplates (filler panels) serve three important functions: they prevent exposure to hazardous voltages and currents inside the chassis; they contain electromagnetic interference (EMI) that might disrupt other equipment; and they direct the flow of cooling air through the chassis. Do not operate the system unless all cards and faceplates are in place. Statement 156

Caution  Always use the supplied electrostatic discharge (ESD) wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower right outside edge of the shelf assembly and ensure the shelf assembly is properly grounded.

Step 1  Open the card ejectors.
Step 2  Slide the card along the guide rails into the correct slot.
Step 3  Close the ejectors.
Step 4  Repeat for any remaining unused card slots.
Stop. You have completed this procedure.

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

Purpose  This procedure installs the fiber-optic cables to DWDM cards and dispersion compensating units.
Tools/Equipment  Fiber-optic cables
Cisco MetroPlanner Internal Connections table
Prerequisite Procedures  NTP-G30 Install the DWDM Cards, page 3-39
NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-41 (as applicable)
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3
Required/As Needed  As needed
Onsite/Remote  Onsite
Security Level  None

Warning  Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Note  Complies with the US Federal Drug Administration Code of Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001.

Note  In this procedure, you will generally connect fibers in an east-to-west or west-to-east pattern. “West” refers to cards and ports in Slots 1 through 8. “East” refers to cards and ports installed in Slots 10 through 17.
Step 1 View the Cisco MetroPlanner Internal Connections table. Figure 3-9 shows an example.

**Figure 3-9 Cisco MetroPlanner Internal Connections Table**

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Site</th>
<th>Position-1</th>
<th>Port ID-1</th>
<th>Port Label-1</th>
<th>Attenuator</th>
<th>Patchcord Type</th>
<th>Position-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-01</td>
<td>Rack#1</td>
<td>Main Shelf 2</td>
<td>Slot 2</td>
<td>Slot 2</td>
<td>Rack#1 Main Shelf 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15454-02</td>
<td>Rack#1</td>
<td>Main Shelf 2</td>
<td>Slot 2</td>
<td>Slot 2</td>
<td>Rack#1 Main Shelf 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15454-03</td>
<td>Rack#1</td>
<td>Main Shelf 2</td>
<td>Slot 2</td>
<td>Slot 2</td>
<td>Rack#1 Main Shelf 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 2 Review the Cisco MetroPlanner Internal Connections table for the node that you are provisioning. The table identifies the patchcords that you must cable by their endpoints. Position 1 identifies the fiber start point; Position 2 indicates the fiber endpoint. The patchcord endpoints are identified by site, slot, and port. Information provided by the Internal Connections table includes:

- **Site**—The DWDM network site number for the node where you are provisioning the internal connections.
- **IP Address**—The node IP address.
- **Position-1**—The first position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to Slot 2 in the main shelf of Rack 1. Refer to the Cisco MetroPlanner Site Dialog window for rack and shelf names and locations.
- **Unit-1**—The ONS 15454 DWDM card (unit) that is installed in the first position slot.
- **Port#-1**—The port identifier shown in the CTC for the first Position-1 connection.
- **Port ID-1**—The port identifier shown in TL1 for the Position-1 connection.
- **Port Label-1**—The name of the physical port printed on the card’s front plate and shown in CTC card view for the Position-1 connection.
- **Attenuator**—Indicates whether attenuation is required.
- **Patchcord Type**—Indicates the level of attenuation that is required, if needed.
- **Position-2**—The second position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to Slot 2 in the main shelf of Rack 1. Refer to the Cisco MetroPlanner Site Dialog window for rack and shelf names and locations.
NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

Unit-2—The ONS 15454 DWDM card (unit) that is installed in the Position-2 slot.
Port #2—The port identifier shown in CTC for the first Position-2 connection.
Port ID-2—The port identifier shown in TL1 for the Position-2 connection.
Port Label-2—The name of the physical port printed on the card’s front plate and shown in CTC card view for the Position-2 connection.
Manually Set—Indicates whether you must create the connection manually in CTC. A Yes appearing in this column means that you must create the connection manually.

Caution
Failure to create the required manual connections will prevent the node from turning up properly.

Step 3
Verify that fibers are available to complete the connections shown in the Internal Connections table.

Step 4
Complete the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 for all fiber connections, even new fiber. Dust particles can degrade performance. Put caps on any fiber connectors that are not used.

Step 5
If you will not perform node acceptance tests for this site, complete the “DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two Adjacent Nodes” task on page 3-51. Otherwise, continue with Step 6.

Step 6
On the front of the fiber-storage tray (usually installed below the node you are fibering), push the tabs on the left and right sides inward to release the lock on the tray.

Step 7
Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 8
Open the fold-down door that at the bottom of the shelf assembly to expose the cable-routing channel (Figure 15-35 on page 15-37).

Step 9
Using the Cisco MetroPlanner Internal Connection table, install the fiber-optic cables. Steps provided in the following tasks can be used as general guidelines; however, the fiber-optic cabling at your site will probably differ from the examples shown in the tasks.

- DLP-G66 Install Fiber-Optic Cables for a Hub Node, page 3-54
- DLP-G67 Install Fiber-Optic Cables for a Terminal Node, page 3-56
- DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node, page 3-58
- DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node, page 3-60
- DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node, page 3-63
- DLP-G71 Install Fiber-Optic Cables for an ROADM Node, page 3-68

Step 10
To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure.
DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two Adjacent Nodes

Purpose

This task explains how to install fiber-optic cables for optical to enable the optical service channel (OSC) link termination between two adjacent DWDM nodes.

Tools

Fiber-optic cables
Cisco MetroPlanner Internal Connections table

Prerequisite Procedures

NTP-G115 Clean Fiber Connectors, page 13-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

None

Note

If you will perform the node acceptance tests in Chapter 4, “Perform Node Acceptance Tests,” you can perform this task after node acceptance testing is complete.

Note

Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1

Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing OSC connections. Before you begin the OSC connections, read the following rules:

- The OPT-BST and the OSC-CSM are the only cards that directly interface with the line (span) fiber.
- The OSCM only carries optical service channels, not DWDM channels.
- The OSCM and the OSC-CSM cannot both be installed on the same side of the shelf (east or west). You can have different cards on each side, for example an OSCM on the west side and an OSC-CSM on the east side.
- When an OPT-BST and an OSC-CSM are both used on the same side of the node, the OPT-BST combines the supervision channel with the DWDM channels and the OSC-CSM acts as an OSCM; it does not carry DWDM traffic.
- If an OPT-BST and OSCM card are installed on the east side, the east OPT-BST OSC RX port is connected to the east OSCM TX port, and the east OPT-BST OSC TX port is connected to the east OSCM RX port.
- If you have an OPT-BST and OSC-CSM card are installed on the east side, the east OPT-BST OSC RX port is connected to the east OSC-CSM LINE TX port, and the east OPT-BST OSC TX port is connected to the east OSC-CSM LINE RX port.
- If an OPT-BST and OSCM card are installed on the west side, The west OPT-BST OSC TX port is connected to the west OSCM RX port, and the west OPT-BST OSC RX port is connected to the west OSCM TX port.
- If an OPT-BST and OSC-CSM card are installed on the west side, the west OPT-BST OSC TX port is connected to the west OSC-CSM LINE RX port, and the west OPT-BST OSC RX port is connected to the west OSC-CSM LINE TX port.

Figure 3-10 shows an example of OSC fibering for a hub node with OSCM cards installed.
Install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.

**Figure 3-10** Fibering OSC Terminations—Hub Node with OSCM Cards
Step 2  Plug one end of a fiber into the west OPT-BST or OSC-CSM LINE TX connector.

Step 3  Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)

Step 4  Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

Caution  When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 5  Plug the other end of the fiber cable into the adjacent node east OPT-BST or OSC-CSM LINE RX connector. Repeat in the other direction (east to west, TX to RX). Always connect the west line ports to the adjacent node east line ports.

Note  Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

Step 6  If OSCM cards are not installed, continue with Step 7. If OSCM cards are installed on both sides of the shelf, complete Steps a through d. If an OSCM is installed on the west side of the shelf, but not the east side, complete Steps a and b only. If the OSCM is installed on the east side of the shelf but not the west, complete Steps c and d only.

a. Plug one end of a fiber into the west OPT-BST OSC RX connector and the other end into west OSCM OSC TX connector.

b. Plug another fiber into the west OSCM OSC RX connector and the other end to the west OPT-BST OSC TX connector.

c. Plug one end of a fiber into the east OPT-BST OSC RX connector and the other end into the east OSCM OSC TX connector.

d. Plug another fiber into the east OSCM OSC RX connector and the other end to the east OPT-BST OSC TX connector.

Step 7  Repeat Steps 2 and 6 at each node in the network. If this is the final node, continue with Step 8.

Step 8  Return to your originating procedure (NTP).
DLP-G66 Install Fiber-Optic Cables for a Hub Node

Purpose
This task installs fiber-optic cables on a hub node DWDM shelf.

Tools
Fiber-optic cables

Prerequisite Procedures
NTP-G115 Clean Fiber Connectors, page 13-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1
Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin hub node connections, read the following rules:

- The west OPT-BST or OSC-CSM card common (COM) TX port is connected to the west OPT-PRE COM RX port or the west 32DMX-O COM RX port.
- The west OPT-PRE COM TX port is connected to the west 32DMX-O COM RX port.
- The west 32MUX-O COM TX port is connected to the west OPT-BST or west OSC-CSM COM RX port.
- The east 32MUX-O COM TX port is connected to the east OPT-BST or east OSC-CSM COM RX port.
- The east OPT-BST or east OSC-CSM COM TX port is connected to the east OPT-PRE COM RX port or the east 32DMX-O COM RX port.
- The east OPT-PRE COM TX port is connected to the east 32DMX-O COM RX port.

Figure 3-11 shows an example of a hub node with cabling. In the example, OSCM cards are installed. If OSC-CSM are installed, they are usually installed in Slots 1 and 17.

Note
Figure 3-11 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.
Figure 3-11 Fibering a Hub Node

1. West DCU TX to west OPT-PRE DC RX
2. West DCU RX to west OPT-PRE DC TX
3. West OPT-BST COM TX to west OPT-PRE COM RX
4. West OPT-BST COM RX to west 32MUX-O COM TX
5. West OPT-PRE COM TX to west 32DMX-O COM RX
6. East 32DMX-O COM RX to east OPT-PRE COM TX
7. East 32MUX-O COM TX to east OPT-BST COM RX
8. East OPT-PRE COM RX to east OPT-BST COM TX
9. East DCU TX to east OPT-PRE DC RX
10. East DCU RX to east OPT-PRE DC TX
Step 2 Plug one end of the fiber cable into the desired RX port.

Step 3 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)

Step 4 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 6 Route the fiber cable out either side of the fiber-storage tray as necessary.

Step 7 Plug the other end of the cable into the desired TX port.

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

Step 8 Repeat 2 through 7 until you have connected the nodes according to the site plan.

Step 9 Return to your originating procedure (NTP).

DLP-G67 Install Fiber-Optic Cables for a Terminal Node

Purpose This task installs fiber-optic cables on a terminal node DWDM shelf.

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 13-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin terminal node connections, read the following rules:
A terminal site has only one side (as compared to a hub node, which has two sides). The terminal side can be either east or west.

- The terminal side OPT-BST or OSC-CSM card COM TX port is connected to the terminal side OPT-PRE COM RX port or the 32DMX-O COM RX port.
- The terminal side OPT-PRE COM TX port is connected to the terminal side 32DMX-O COM RX port.
- The terminal side 32MUX-O COM TX port is connected to the terminal side OPT-BST or OSC-CSM COM RX port.

**Step 2** Plug one fiber cable end into the desired RX port.

**Step 3** Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)

**Step 4** Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

**Step 5** As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).

**Caution** When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

**Step 6** Route the fiber cable out either side of the fiber-storage tray as necessary.

**Step 7** Plug the other end of the cable into the desired TX port.

**Note** Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

**Step 8** Repeat 2 through 7 until you have connected the nodes according to the site plan.

**Step 9** Return to your originating procedure (NTP).
DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node

**Purpose**
This task installs fiber-optic cables on a line amplifier node in a DWDM shelf.

**Tools**
Fiber-optic cables

**Prerequisite Procedures**
NTP-G115 Clean Fiber Connectors, page 13-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Note**
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

---

**Step 1**
Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin the line amplifier node connections, read the following rules:

- Line amplifier node layout allows all combinations of OPT-PRE and OPT-BST and allows you to use asymmetrical card choices in west-to-east and east-to-west configurations. For a given line direction, you can configure the four following possibilities:
  - Only preamplification (OPT-PRE)
  - Only booster amplification (OPT-BST)
  - Both preamplification and booster amplification (where a line amplifier node has amplification in at least one direction)
  - Neither preamplification nor booster amplification

- If a west OPT-PRE card is installed:
  - The west OSC-CSM or OPT-BST COM TX is connected to the west OPT-PRE COM RX port.
  - The west OPT-PRE COM TX port is connected to the east OSC-CSM or OPT-BST COM RX port.

- If a west OPT-PRE card is not installed, the west OSC-CSM or the OPT-BST COM TX port is connected to the east OSC-CSM or OPT-BST COM RX port.

- If an east OPT-PRE card is installed:
  - The east OSC-CSM or OPT-BST COM TX port is connected to the east OPT-PRE COM RX port.
  - The east OPT-PRE COM TX port is connected to the west OSC-CSM or OPT-BST COM RX port.

- If an east OPT-PRE card is not installed, the east OSC-CSM or OPT-BST COM TX port is connected to the west OSC-CSM or OPT-BST COM RX port.

**Figure 3-12** shows an example of a line amplifier node with cabling.

**Note**
Figure 3-12 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.
Figure 3-12  Fibering a Line Amplifier Node

1. West DCU TX to west OPT-PRE DC RX
2. West DCU RX to west OPT-PRE DC TX
3. West OPT-BST COM TX to west OPT-PRE COM RX
4. West OPT-PRE COM TX to east OPT-BST COM RX
5. West OPT-BST COM RX to east OPT-PRE COM TX
6. West OPT-BST COM RX to east OPT-PRE COM TX
7. East DCU TX to east OPT-PRE DC RX
8. East DCU RX to east OPT-PRE DC TX

1. If a DCU is not installed, a 4-dB attenuator loop, +/- 1dB must be installed between the OPT-PRE DC ports.
**DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node**

**Purpose**
This task installs fiber-optic cables on an OSC regeneration node in a DWDM shelf.

**Tools**
Fiber-optic cables

**Prerequisite Procedures**
- NTP-G115 Clean Fiber Connectors, page 13-25
- NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

**Note**
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

**Step 1**
Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin OSC regeneration node connections, read the following rules:

- The west OSC-CSM COM TX port connects to the east OSC-CSM COM RX port.
- The west OSC-CSM COM RX port connects to the east OSC-CSM COM TX port.
Slots 2 through 5 and 12 through 16 can be used for TXP and MXP cards. Figure 3-13 shows an example of an OSC regeneration node with cabling.

**Note** Figure 3-13 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.

**Figure 3-13** Fibering an OSC Regeneration Node
DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>West OSC-CSM LINE RX to east OSC-CSM or OPT-BST LINE TX on adjacent node</td>
</tr>
<tr>
<td>2</td>
<td>West OSC-CSM LINE TX to east OSC-CSM or OPT-BST LINE RX on adjacent node</td>
</tr>
<tr>
<td>3</td>
<td>West OSC-CSM COM TX to east OSC-CSM COM RX</td>
</tr>
<tr>
<td>4</td>
<td>West OSC-CSM COM RX to east OSC-CSM COM TX</td>
</tr>
<tr>
<td>5</td>
<td>East OSC-CSM LINE RX to west OSC-CSM or OPT-BST LINE TX on adjacent node</td>
</tr>
<tr>
<td>6</td>
<td>East OSC-CSM LINE TX to west OSC-CSM or OPT-BST LINE RX on adjacent node</td>
</tr>
</tbody>
</table>

**Step 2:** Plug one end of the fiber cable into the desired RX port.

**Step 3:** Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of OSCM, OPT-PRE, and OPT-BST cards.)

**Step 4:** Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

**Step 5:** As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).

**Caution:** When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

**Step 6:** Route the fiber cable out either side of the fiber-storage tray as necessary.

**Step 7:** Plug the other end of the cable into the desired TX port.

**Note:** Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

**Step 8:** Repeat 2 through 7 until you have connected the nodes according to the site plan.

**Step 9:** Return to your originating procedure (NTP).
DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node

Purpose
This task gives instructions, rules, and examples for installing fiber-optic cables on an amplified or passive optical add/drop multiplexing (OADM) node in a DWDM shelf.

Tools
Fiber-optic cables

Prerequisite Procedures
- NTP-G115 Clean Fiber Connectors, page 13-25
- NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Note
Amplified OADM nodes contain OPT-PRE cards and/or OPT-BST cards. Passive OADM nodes do not. Both contain add/drop channel or band cards.

Step 1
Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin connecting fiber-optic cabling for amplified or passive OADM nodes, read the following rules for all OADM connections:

- The two sides of the OADM node do not need to be symmetrical. On each side, Cisco MetroPlanner can create one of the following four configurations:
  - OPT-BST and OPT-PRE
  - OSC-CSM and OPT-PRE
  - Only OSC-CSM
  - Only OPT-BST

Step 2
Consult the following rules for OADM node express path cabled connections:

- TX ports should only be connected to RX ports.
- EXP ports are connected only to COM ports in between AD-xC-xx.x or AD-xB-xx.x cards that all belong to the east side (that is, they are daisy-chained).
- EXP ports are connected only to COM ports in between AD-xC-xx.x or AD-xB-xx.x cards that all belong to the west side (that is, they are daisy-chained).
- The EXP port of the last AD-xC-xx.x or AD-xB-xx.x card on the west side is connected to the EXP port of the first AD-xC-xx.x or AD-xB-xx.x card on the east side.
- The OPT-BST COM RX port is connected to the nearest (in slot position) AD-xC-xx.x or AD-xB-xx.x COM TX port.
- The OPT-PRE COM TX port is connected to the nearest (in slot position) AD-xC-xx.x or AD-xB-xx.x COM RX port.
- If OADM cards are located in adjacent slots, the TCC2/TCC2P card assumes they are connected in a daisy-chain between the EXP ports and COM ports as noted previously.
Step 3 Consult the following rules for OADM node add/drop path cabled connections:

- AD-xB-xx.x add/drop (RX or TX) ports are only connected to the following ports:
  - 4MD-xx.x COM TX or 4MD-xx.x COM RX ports
  - Another AD-xB-xx.x add/drop port (a pass-through configuration)
- An AD-xB-xx.x add/drop band port is only connected to a 4MD-xx.x card belonging to the same band.
- For each specific AD-xB, the add and drop ports for that band card are connected to the COM TX and COM RX ports of the same 4MD-xx.x card.
- The AD-xB-xx.x and 4MD-xx.x cards are located in the same side (the connected ports will all have the same line direction).

Step 4 Consult the following rules for OADM node pass-through path cabled connections:

- Pass-through connections are only established between add and drop ports on the same band or channel and same line direction.
- Only connect AD-xC-xx.x or AD-xB-xx.x add/drop ports to other AD-xC-xx.x or AD-xB-xx.x add/drop ports (as pass-through configurations).
- An add (RX) port is only connected to a drop (TX) port.
- Only connect 4MD-xx.x client input/output ports to other 4MD-xx.x client input/output ports.
- A west AD-xB-xx.x drop (TX) port is connected to the corresponding west 4MD-xx.x COM RX port.
- A west AD-xB-xx.x add (RX) port is connected to the corresponding west 4MD-xx.x COM TX port.
- An east AD-xB-xx.x drop (TX) port is connected to the corresponding east 4MD-xx.x COM RX port.
- An east AD-xB-xx.x add (RX) port is connected to the corresponding east 4MD-xx.x COM TX port.

Figure 3-14 shows an example of an amplified OADM node with AD-1C-xx.x cards installed.

---

**Note**  
Figure 3-14 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.
DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node

Figure 3-14  Fibering an Amplified OADM Node

<p>| | | | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>West DCU TX to west OPT-PRE DC RX&lt;sup&gt;1&lt;/sup&gt;</td>
<td>9</td>
<td>West AD-1C-xx.x EXP RX to east AD-1C-xx.x EXP TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>West DCU RX to west OPT-PRE DC TX&lt;sup&gt;1&lt;/sup&gt;</td>
<td>10</td>
<td>East TXP_MR_2.5G DWDM RX to east AD-1C-xx.x (15xx.xx) TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>West OPT-BST COM TX to west OPT-PRE COM RX</td>
<td>11</td>
<td>East TXP_MR_2.5G DWDM TX to east AD-1C-xx.x (15xx.xx) RX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>West OPT-BST COM RX to west AD-1C-xx.x COM TX</td>
<td>12</td>
<td>East AD-1C-xx.x COM RX to OPT-PRE COM TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>West OPT-PRE COM TX to west AD-1C-xx.x COM RX</td>
<td>13</td>
<td>East AD-1C-xx.x COM TX to OPT-BST COM RX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>West AD-1C-xx.x (15xx.xx) RX to west TXP_MR_2.5G DWDM TX</td>
<td>14</td>
<td>East OPT-PRE COM RX to east OPT-BST COM TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>West AD-1C-xx.x (15xx.xx) TX to west TXP_MR_2.5G DWDM RX</td>
<td>15</td>
<td>East DCU TX to east OPT-PRE DC RX¹</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>West AD-1C-xx.x EXP TX to east AD-1C-xx.x EXP RX</td>
<td>16</td>
<td>East DCU RX to east OPT-PRE DC TX¹</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹. If a DCU is not installed, a 4-dB attenuator loop, +/1 dB must be installed between the OPT-PRE DC ports.

---

**Figure 3-15** shows an example of a passive OADM node with two AD-1C-xx.x cards installed.

**Note**  
*Figure 3-15* is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.
**Figure 3-15  Fibering a Passive OADM Node**

Step 5  Plug one end of the fiber cable into the RX port.

Step 6  Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)
Step 7  Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

Step 8  As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).

Caution  When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 9  Route the fiber cable out either side of the fiber-storage tray as necessary.

Step 10  Plug the other end of the cable into the TX port.

Note  Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

Step 11  Repeat 5 through 10 until you have connected the nodes according to the site plan.

Step 12  Return to your originating procedure (NTP).

DLP-G71 Install Fiber-Optic Cables for an ROADM Node

Purpose  This task gives instructions, rules, and examples for installing fiber-optic cables on an ROADM node in a DWDM shelf.

Tools  Fiber-optic cables

Prerequisite Procedures  NTP-G115 Clean Fiber Connectors, page 13-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed  As needed

Onsite/Remote  Onsite

Security Level  None

Note  Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Note  To avoid errors, connect fiber-optic cable in fiber connections so that the farthest slot to the right represents the east port, and the farthest slot to the left represents the west port. Inter-shelf, line side connections (connections that span between adjacent sites), should be made such that fiber connected to an east port on one node connects into the west port on an adjacent node.

Step 1  Refer to the Cisco MetroPlanner Internal Connections table (see Table 3-1 on page 3-3) for your site when completing connections. Before you begin connecting fiber-optic cabling for ROADM nodes, read and understand the following rules:
The west OPT-BST or OSC-CSM COM TX port is connected to the west OPT-PRE COM RX port.
The west OPT-PRE COM TX port is connected to the west 32WSS COM RX port.
The west OPT-BST or OSC-CSM COM RX port is connected to the west 32WSS COM TX port.
The west OPT-BST (if installed) OSC TX port is connected to the west OSCM RX port.
The west OPT-BST (if installed) OSC RX port is connected to the west OSCM TX port.
The west 32WSS EXP TX port is connected to the east 32WSS EXP RX port.
The west 32WSS EXP RX port is connected to the east 32WSS EXP TX port.
The west 32WSS DROP TX port is connected to the west 32DMX COM RX port.
The east OPT-BST or OSC-CSM COM TX port is connected to the east OPT-PRE COM RX port.
The east OPT-PRE COM TX port is connected to the east 32WSS COM RX port.
The east OPT-BST or OSC-CSM COM RX port is connected to the east 32WSS COM TX port.
The east OPT-BST (if installed) OSC TX port is connected to the east OSCM RX port.
The east OPT-BST (if installed) OSC RX port is connected to the east OSCM TX port.
The east 32WSS DROP TX port is connected to the east 32DMX COM RX port.

Figure 3-16 shows an example of an amplified ROADM node with cabling.

Note  Figure 3-16 is an example. Always install fiber-optic cables based on the Cisco MetroPlanner Internal Connections table for your site.
Figure 3-16 Fibering an ROADM Node

1. West DCU TX to west OPT-PRE DC RX
2. West DCU RX to west OPT-PRE DC TX
3. West OPT-BST COM TX to west OPT-PRE COM RX
4. West 32WSS COM TX to west OPT-BST COM RX
5. West 32WSS EXP RX to east 32WSS EXP TX
6. East 32DMX COM RX to east 32WSS DROP TX
7. East 32WSS COM RX to east OPT-PRE COM TX
8. West 32WSS EXP RX to east 32WSS EXP TX
9. East 32DMX COM RX to east 32WSS DROP TX
10. East 32WSS COM RX to east OPT-PRE COM TX
11. East 32WSS COM TX to east OPT-BST COM RX
12. East 32WSS COM RX to east OPT-PRE COM TX
13. East 32WSS COM TX to east OPT-BST COM RX
14. East 32WSS COM RX to east OPT-PRE COM TX

Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0

Chapter 3 Turn Up a Node
### Step 2
Plug one end of the fiber into the desired RX port.

### Step 3
Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips are factory-attached to the faceplates of 32WSS, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards.)

### Step 4
Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf assembly, as necessary (Figure 15-35 on page 15-37).

### Step 5
As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).  

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>West 32WSS COM RX to west OPT-PRE COM TX</td>
</tr>
<tr>
<td>6</td>
<td>West 32DMX COM RX to west 32WSS DROP TX</td>
</tr>
<tr>
<td>7</td>
<td>West 32WSS EXP TX to east 32WSS EXP RX</td>
</tr>
<tr>
<td>12</td>
<td>East OPT-BST COM TX to east OPT-PRE COM RX</td>
</tr>
<tr>
<td>13</td>
<td>East DCU RX to east OPT-PRE DC TX&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>14</td>
<td>East DCU TX to east OPT-PRE DC RX&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

1. If a DCU is not installed, a 4-dB attenuator loop, +/- 1 dB must be installed between the OPT-PRE DC ports.

### Caution
When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

### Step 6
Route the fiber cable out either side of the fiber-storage tray as necessary.

### Step 7
Plug the other end of the cable into the correct TX port.

### Note
Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision OSC Terminations” procedure on page 3-84) if transmit and receive fibers are not connected correctly. For example, an RX port is connected to another RX port or a TX port is connected to another TX port.

### Step 8
Repeat 2 through 7 until you have connected the node(s) according to the site plan.

### Step 9
Return to your originating procedure (NTP).
**NTP-G140 Install Fiber-Optic Cables Between a Terminal, Hub, or ROADM Node and the Transponder Cards**

**Purpose**
This procedure routes fiber-optic cables from 32MUX-O, 32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node to the patch panel, and from the patch panel to TXP/MXP cards.

**Tools/Equipment**
The following node types require the following equipment. The cards and patch panels should already be installed before you begin this procedure.

**Terminal node:**
- One 32DMX-O card
- One 32MUX-O card
- One patch panel
- Eight MPO cables: fiber-optic cables, terminated on one end with one multifiber push-on (MPO) connector and on the other end with eight LC-type connectors

**Hub node:**
- Two 32DMX-O cards
- Two 2MUX-O cards
- Two patch panels
- Sixteen MPO cables: fiber-optic cables, terminated on one end with one MPO connector and on the other end with eight LC-type connectors

**ROADM node:**
- Two 32WSS cards
- Two 32DMX cards
- Two patch panels
- Sixteen MPO cables: fiber-optic cables, terminated on one end with one MPO connector and on the other end with eight LC-type connectors

**Fiber-optic cables, terminated with a single LC-type connector on each end**

**Prerequisite Procedures**
- DLP-G28 Install the Fiber Patch-Panel Tray, page 1-67
- DLP-G29 Install the Fiber-Storage Tray, page 1-68
- NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-48

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

**Step 1**
On the front of the patch-panel tray, push the tabs on the left and right sides inward to release the lock on the tray.
Step 2  Pull the patch-panel tray away from the shelf until it is fully opened. To install fiber-optic cables between a hub, terminal, or ROADM node and the TXP/MXP cards, perform the following tasks:

- DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Patch Panel, page 3-74
- DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel, page 3-78

Step 3  To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure.
DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Patch Panel

Purpose
This task describes how to route fiber-optic cables from 32MUX-O, 32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node to the patch panel.

Tools/Equipment
The following node types require the following equipment. The cards and patch panels should already be installed before you begin this procedure.

Terminal node:
• One 32DMX-O card
• One 32MUX-O card
• One Patch panel
• Eight MPO cables: fiber-optic cables, terminated on one end with one multifiber push-on (MPO) connector and on the other end with eight LC-type connectors

Hub node:
• Two 32DMX-O cards
• Two 32MUX-O cards
• Two patch panels
• Sixteen MPO cables: fiber-optic cables, terminated on one end with one multifiber push-on (MPO) connector and on the other end with eight LC-type connectors

ROADM node:
• Two 32WSS cards
• Two 32DMX cards
• Two patch panels
• Sixteen MPO cables: fiber-optic cables, terminated on one end with one multifiber push-on (MPO) connector and on the other end with eight LC-type connectors

Prerequisite Procedures
NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-48

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Note
For a ROADM or hub node, two patch panels will be used, one for the east side and one for the west. The east side 32WSS/32DMX card will connect to the east patch panel. The west side 32WSS/32DMX card will connect to the west patch panel.

Step 4
Choose either the east or west side of the shelf to cable the 32MUX-O and 32DMX-O cards (or the 32WSS and 32DMX cards for an ROADM node).
Step 5  On the patch panel, pull up firmly on the two latches and use them to slide the patch panel up until it snaps in place above the tray (Figure 3-17).

![Figure 3-17 Using the Patch-Panel Latches to Slide the Patch Panel Away from the Tray](image)

Step 6  At the 32WSS or 32MUX-O card in the node, plug the MPO connector of an MPO cable (Figure 3-18) into the top Add RX (30.3–36.6) port of the card. If you are connecting to the next MPO cable, plug it into the MPO connector below the previous MPO cable.
**Step 7**  
Route the MPO cable slack through the patch-panel tray as necessary.

**Caution**  
When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the patch-panel tray, make sure that adequate cable slack remains.

**Step 8**  
While facing the front of the patch panel, at the rear of the patch panel, plug the eight LC-connector fan-out cables on the MPO cable into their corresponding connectors on the bottom row of the patch panel. You should plug the fan-out cables from left to right (as you face the patch panel), following the numbers tagged (1 through 8) on the cables.

*Figure 3-19* shows the patch-panel connectors from the rear of the patch-panel tray. *Figure 3-20* shows the assigned wavelengths for each port on the patch panel, as indicated at the top of the patch-panel bar. The numbers on the patch-panel bar correspond to a wavelength on the ITU grid.
Figure 3-19  Rear View of the Patch Panel

DEMUX connectors (TX port [drop] from the 32DMX or 32DMX-O cards)

Figure 3-20  Top View of the Patch-Panel Bar

<table>
<thead>
<tr>
<th>CLIENT</th>
<th>CLIENT</th>
<th>CLIENT</th>
<th>CLIENT</th>
</tr>
</thead>
</table>

Step 9  As necessary, repeat Steps 6 through 8 for the remaining three Add Rx ports on the 32WSS or MUX-O card, until all 32 connectors on the bottom row of the rear of the patch panel are connected.

Step 10  At the adjacent 32DMX or DMX-O card in that side of the shelf, plug the MPO connector of an MPO cable into the top ADD RX (30.3-36.6) port of the 32DMX or DMX-O card. If you are connecting to the next MPO cable, plug it into the MPO connector below the previous MPO cable.

Step 11  Route the MPO cable slack through the patch-panel tray as necessary.

Caution  When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 12  While facing the front of the patch panel, at the rear of the patch panel, plug the eight LC-connector fan-out cables on the MPO cable into their corresponding connectors on the top row of the patch panel. You should plug the fan-out cables from left to right (as you face the patch panel), following the numbers tagged (1 through 8) on the cables.

Step 13  As necessary, repeat Steps 10 through 12 for the remaining three Add Rx ports on the 32DMX card, until all 24 connectors on the top row of the rear of the patch panel are connected.

Step 14  For a hub or ROADM node, repeat Steps 5 through 13 to cable the other side of the shelf to the second patch panel. For a terminal node, go to Step 15.

Step 15  Return to your originating procedure (NTP).
DLP-G316 Install Fiber-Optic Cables from a TXP/MXP Node to the Patch Panel

Purpose
This task describes how to route fiber-optic cables from the patch panel to TXP/MXP cards in a transponder/muxponder shelf.

Tools/Equipment
- TXP/MXP card(s)
- Fiber-optic cable(s)

Prerequisite Procedures
NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-48

Required/As Needed
- As needed

Onsite/Remote
- Onsite

Security Level
- None

Step 1
At the appropriate TXP/MXP card, plug a fiber-optic cable into the TX port of the DWDM connector.

Step 2
As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray (Figure 15-38 on page 15-40).

Caution
When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3
On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the bottom row that corresponds to the wavelength to which the TXP/MXP port is tuned. (See Figure 3-20 on page 3-77 for a view of the wavelengths assigned to the patch-panel connectors).

Figure 3-21 shows the patch-panel connectors from the front of the patch-panel tray.

Step 4
Plug a fiber-optic cable into the RX port of the DWDM connector on that TXP/MXP card.

Step 5
On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the top row that corresponds to the wavelength to which the TXP/MXP port is tuned.

Step 6
Repeat Steps 1 through 5 for all of the TXP/MXP cards that you want to connect to this patch panel.

Step 7
Return to your originating procedure (NTP).
NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules

**Purpose**
This procedure installs and routes fiber-optic cables from the client signal to the Y-cable protection module (single mode or multimode), and from the Y-cable module to the transponder node. Using one Y-cable protection module, you can protect one client signal with two TXP/MXP cards, and two client signals with four TXP/MXP cards.

**Tools/Equipment**
Fiber-optic cables

**Prerequisite Procedures**
- DLP-G32 Install the Y-Cable Protection Modules, page 1-70
- NTP-G32 Install the Transponder and Muxponder Cards, page 3-43

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Note**
See the “15.4 FlexLayer and Y-Cable Protection” section on page 15-9 for more information about Y-cable protection.

**Step 1**
Install fiber-optic cables between the TXP/MXP cards and the Y-cable module, and between the client device(s) and the Y-cable module. As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray as you install cables between the Y-cable module and the TXP/MXP cards (Figure 15-38 on page 15-40).

**Caution**
When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must be equal to or greater than the minimum radius that is recommended in your site specifications. As you route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

To protect one client signal, connect the fiber-optic cables according to either Table 3-4 or Table 3-5. To protect two client signals using a single Y-cable module, connect the cables according to both Table 3-4 and Table 3-5.

**Table 3-4 Cable Connections for Y-Cable Protection of First Client Signal**

<table>
<thead>
<tr>
<th>From</th>
<th>To (Y-Cable Port Number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1 TX port</td>
<td>10</td>
</tr>
<tr>
<td>Client 1 RX port</td>
<td>5</td>
</tr>
<tr>
<td>TXP/MXP 1 TX port</td>
<td>1</td>
</tr>
<tr>
<td>TXP/MXP 1 RX port</td>
<td>2</td>
</tr>
<tr>
<td>TXP/MXP 2TX port</td>
<td>6</td>
</tr>
<tr>
<td>TXP/MXP 2RX port</td>
<td>7</td>
</tr>
</tbody>
</table>
NTP-G36 Calculate Cable Connections

Table 3-5  Cable Connections for Y-Cable Protection of a Second Client Signal

<table>
<thead>
<tr>
<th>From</th>
<th>To (Y-Cable Port Number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 2 TX port</td>
<td>12</td>
</tr>
<tr>
<td>Client 2 RX port</td>
<td>11</td>
</tr>
<tr>
<td>TXP/MXP 3 TX port</td>
<td>3</td>
</tr>
<tr>
<td>TXP/MXP 3 RX port</td>
<td>4</td>
</tr>
<tr>
<td>TXP/MXP 4 TX port</td>
<td>8</td>
</tr>
<tr>
<td>TXP/MXP 4 RX port</td>
<td>9</td>
</tr>
</tbody>
</table>

Stop. You have completed this procedure.

NTP-G36 Calculate Cable Connections

Purpose
This procedure verifies the cards that are installed in the shelf and calculates the connections that should be provisioned for them.

Tools/Equipment
- Cisco MetroPlanner shelf layout
- Cisco MetroPlanner Internal Connections table

Prerequisite Procedures
- NTP-G22 Verify Common Card Installation, page 3-4
- NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed
- Required

Onsite/Remote
- Onsite or remote

Security Level
- Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the DWDM cable connections. If you are already logged in, continue with Step 2.

Step 2
Click the Provisioning > WDM-ANS > Connections tabs.

Step 3
Click Calculate Connections.

CTC verifies that the cards installed in the ONS 15454 shelf are compatible and will operate together as a valid DWDM node configuration. Furthermore, based on the cards installed or preprovisioned, CTC calculates the intra-shelf patchcords that are expected to be installed. If the cards are not compatible or are missing, for example, if an OPT-BST is installed but an OSCM card is not installed, the calculate connections function generates an error.

Note
The connections calculation is not based on the Cisco MetroPlanner shelf layout. Calculations are based on the cards that are physically installed. If the Cisco MetroPlanner shelf layout calls for a hub node but OADM cards are installed, CTC calculates connections based on the cards expected for an OADM node.
Chapter 3      Turn Up a Node

DLP-G72 Create a DWDM Connection

Step 4   If no errors were generated, continue with Step 5. If errors appear, verify that the cards installed in the shelf match the Cisco MetroPlanner shelf layout. If the wrong cards are installed or are missing, install the correct cards following the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.

Step 5   Verify that the connections in the CTC Connections tab match the connections in the Cisco MetroPlanner Internal Connections table. The CTC Connections tab will not show OPT-PRE DCUs, connections, span connections, or connections between TXP and MXP cards and the DWDM cards.

Step 6   Complete the “DLP-G72 Create a DWDM Connection” task on page 3-81 for any connections that require manual provisioning. (Connections that require manual creation are indicated by a “Yes” in the Cisco MetroPlanner Internal Connections table Manually Set column.) If you need to delete a connection, complete the “DLP-G73 Delete a DWDM Connection” task on page 3-82.

Note Although CTC calculates most DWDM connections automatically, some connections cannot be calculated because of the DWDM card type and position. You must create these connections manually. For example, connections related to optical bypass circuits must be manually provisioned.

Stop. You have completed this procedure.

DLP-G72 Create a DWDM Connection

Purpose   This task creates a DWDM connection manually when CTC is unable to calculate the connections automatically.

Tools/Equipment   None

Prerequisite Procedures   DLP-G46 Log into CTC, page 2-25

Required/As Needed   Required

Onsite/Remote   Onsite or remote

Security Level   Superuser

Step 1   In node view, click the Provisioning > WDM-ANS > Connections tabs.

Step 2   Click Create.

Step 3   In the Create Optical Link dialog box, choose the From and To slots and ports from the drop-down lists.

Step 4   If the connection is unidirectional, uncheck the bidirectional check box.

Step 5   Click OK. The new connection appears in the Connections table, but its State is Uncommitted.

Step 6   Click the new connection in the table. Click Commit. The connection state changes to Connected.

Step 7   If you need to create additional connections, repeat Steps 2 through 6 for each new connection. If not, continue with Step 8.

Step 8   Return to your originating procedure (NTP).
DLP-G73 Delete a DWDM Connection

**Purpose**: This task deletes a DWDM connection.

**Tools/Equipment**: None

**Prerequisite Procedures**: DLP-G46 Log into CTC, page 2-25

**Required/As Needed**: Required

**Onsite/Remote**: Onsite or remote

**Security Level**: Superuser

**Step 1**
In node view, click the Provisioning > WDM-ANS > Connection tabs.

**Step 2**
Click the connection you want to delete.

**Step 3**
Click Delete, then click Yes.

**Step 4**
Return to your originating procedure (NTP).

---

**NTP-G138 Import a Cisco MetroPlanner Configuration File**

**Purpose**: This task imports the Cisco MetroPlanner Assisted Configuration Setup file into a node to configure the node automatically.

**Tools/Equipment**: A Cisco MetroPlanner Assisted Configuration Setup file prepared for the node must be available on a local or network drive

Cisco MetroPlanner Installation Parameters

**Prerequisite Procedures**: NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

**Required/As Needed**: Required

**Onsite/Remote**: Onsite or remote

**Security Level**: Superuser

**Caution**: Importing the correct Cisco MetroPlanner configuration file is very important. Verify that have the correct MetroPlanner configuration file for your node before you begin this task. The file will have the same name as the node name in Cisco MetroPlanner.

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to import the file.

If you are already logged in, continue with Step 2.

**Step 2**
In CTC node view, click the Provisioning > WDM-ANS > Provisioning tabs.

**Step 3**
Click Import. The Import NE Update From File dialog box appears.

**Step 4**
Enter the path to the Assisted Configuration Setup file (see Table 3-1 on page 3-3), or click Browse and navigate to the configuration file using the Open dialog box.

**Step 5**
Click OK.

**Step 6**
Click OK on the import confirmation dialog box.
The Import NE Update From File dialog box closes, and the MetroPlanner configuration settings are imported.

**Step 7** Verify that the imported parameters are correct according to the printout of the MetroPlanner parameters file, then click **Apply**.

Stop. You have completed this procedure.

---

## NTP-G37 Run Automatic Node Setup

**Purpose**

This procedure runs the CTC DWDM ANS function. ANS adjusts the values of the variable optical attenuators (VOAs) to equalize the per-channel power at the amplifier level.

**Tools/Equipment**

The Cisco MetroPlanner Installation Parameters file

**Prerequisite Procedures**

NTP-G36 Calculate Cable Connections, page 3-80

NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-82

NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

**Required/As Needed**

Required

Onsite/Remote

Onsite or remote

Security Level

Superuser

---

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to run ANS. If you are already logged in, continue with **Step 2**.

**Step 2** Referring to the Cisco MetroPlanner Installation Parameters (see Table 3-1 on page 3-3), identify the parameters that have a Yes in the Manually Set column. If there are no parameters that have a Yes in the Manually Set column, continue with **Step 6**.

**Step 3** In CTC, display the card where the parameter is to be provisioned in card view.

**Step 4** Enter the specified Calibration parameter from the Cisco MetroPlanner Installation Parameters table. Click **Apply**.

**Step 5** Repeat Steps 2 through 4 for all parameters in the Cisco MetroPlanner Installation Parameters table that display Yes in the Manually Set field.

**Step 6** Change to node view.

**Step 7** Click the Provisioning > WDM-ANS > Port Status tabs.

**Step 8** Click **Launch ANS**.

**Step 9** In the Apply Launch ANS dialog box, click **Yes**.

**Step 10** In the Launch ANS confirmation dialog box, click **OK**.

**Step 11** Verify that one of the following statuses appears in the Link Status column for all ports:

- **Success - Changed**—The parameter setpoint was recalculated successfully.
- **Success - Unchanged**—The parameter setpoint did not need recalculation.
- **Not Applicable**—The parameter setpoint does not apply to this node type.

If one of the following statuses is shown, complete the provided instructions:
NTP-G38 Provision OSC Terminations

- **Fail - Out of Range**—The calculated setpoint is outside the expected range. Repeat the “NTP-G36 Calculate Cable Connections” procedure on page 3-80 to verify that all connections were provisioned correctly, paying attention to connections that require manual provisioning.

  **Note**  
  The Fail - Out of Range condition must be cleared before proceeding. Contact your next level of support if you are unable to clear this status.

- **Fail - Port in IS State**—The parameter could not be calculated because the port is in service. This status should normally not appear at this point in node turn-up. If it does, display the card in card view, change the port administrative state to OOS,DSL-B (ANSI) or Locked,disabled (ETSI), and repeat Steps 6 through 11.

Stop. You have completed this procedure.

NTP-G38 Provision OSC Terminations

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure provisions the OSC terminations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>NTP-G138 Import a Cisco MetroPlanner Configuration File, page 3-82</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>Required</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

**Step 1**  
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the OSC terminations. If you are already logged in, continue with Step 2.

**Step 2**  
In node view, click the **Provisioning > Comm Channels > OSC** tabs.

**Step 3**  
In the OSC Terminations area, click **Create** (Figure 3-22).
Step 4 In the Create OSC Terminations dialog box, choose the ports where you want to create the OSC termination. To select more than one port, press the Shift key (to select a range of ports) or the Ctrl key (to select multiple individual ports). Click OK.

Note OSC on the DWDM node uses a separate OC3/STM1 channel to transport the SDCC, which is used for ONS 15454 DCC terminations.

Step 5 In the Layer 3 area, perform one of the following:

- Check only the IP box if the LDCC is between the ONS 15454 and another ONS node, and only ONS nodes reside on the network. The LDCC will use Point-to-Point Protocol (PPP).
- Check both the IP and OSI boxes if the LDCC is between the ONS 15454 and another ONS node, and third party NEs that use the OSI protocol stack are on the same network. The LDCC will use PPP.

Step 6 If you checked OSI, complete the following steps. If you checked only IP, continue with Step 7.

a. Click Next.

b. Provision the following fields:
   - Router—Choose the OSI router.
   - ESH—Set the ESH propagation frequency. End system NEs transmit ESHs to inform other ESs and ISs about the NSAPs they serve. The default is 10 seconds. The range is 10 to 1000 seconds.
Step 7 Click **Finish**. Ports are automatically placed in service. Until network OSC connections between adjacent nodes are created, the following alarms might appear:

- SDCC Termination Failure alarm on the OSCM or OSC-CSM card
- LOS-P alarm on the OC-3 port (Port 1) on the OSCM or OSC-CSM card
- OPWR-LFAIL alarm on the OPT-BST or OSC-CSM card

**Note** After the OSC termination is created, the line ports are placed in service and span power levels are checked.

Stop. You have completed this procedure.

---

## NTP-G39 Verify OSCM and OSC-CSM Transmit Power

### Purpose
This procedure verifies the transmit power of the ONS 15454 OSCM and the OSC-CSM cards.

### Tools/Equipment
None

### Prerequisite Procedures
NTP-G37 Run Automatic Node Setup, page 3-83

### Required/As Needed
Required

### Onsite/Remote
Onsite or remote

### Security Level
Superuser

### Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to verify the OSCM or OSC-CSM transmit power. If you are already logged in, continue with **Step 2**.

### Step 2
In the node view shelf graphic, double-click the west OSCM or OSC-CSM card.

### Step 3
Click the **Maintenance > ALS** tabs.

### Step 4
From the ALS Mode drop-down list, choose **Disable**. Click **Apply**.

### Step 5
If a second OSC-CSM or OSCM card is installed, repeat Steps 2 through 4 on the second card. If not, or if you have completed the steps, continue with **Step 6**.

### Step 6
Complete one of the following tasks, depending on whether you are checking an OSC-CSM or OSCM card:

- DLP-G313 Verify OSC-CSM Transmit Power, page 3-87
- DLP-G314 Verify OSCM Transmit Power, page 3-89
Step 7  Display the OSC-CSM or OSCM in card view.
Step 8  Click the Maintenance > ALS tabs.
Step 9  From the ALS Mode drop-down list, choose AutoRestart. Click Apply.
Step 10 If a second OSC-CSM or OSCM card is installed, repeat Steps 6 through 9 on the second card.
Stop. You have completed this procedure.

DLP-G313 Verify OSC-CSM Transmit Power

Purpose  This procedure verifies the transmit power of the OSC-CSM card.
Tools/Equipment  None
Prerequisite Procedures  “DLP-G46 Log into CTC” task on page 2-25
Required/As Needed  Required
Onsite/Remote  Onsite or remote
Security Level  Superuser

Note  Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1  Display the OSC-CSM card in card view.
Step 2  Click the Provisioning > Optical Line > Parameters tabs.
Step 3  Locate the Power parameter for Port 7, then record the value: _______. If an OPT-PRE card is installed in the same side of the shelf as the OSC-CSM, continue with Step 4. If not, continue with Step 7.
Step 4  Change to node view, then click the Provisioning > WDM-ANS tabs.
Step 5  Record the amplifier working mode value from one of the following:
For OSC-CSM cards installed on the east side:
   a. In the Selector window on the left, expand the East Side parameters tree view.
   b. Expand the RX category.
   c. Expand the Amplifier category, then highlight Working Mode.
For OSC-CSM cards installed on the west side:
   a. In the Selector window on the left, expand the West Side parameters tree view.
   b. Expand the RX category.
   c. Expand the Amplifier category, then highlight Working Mode.
   d. Record the WestSide.Rx.Amplifier.Working Mode parameter displayed in the right pane.
Step 6  If the value recorded in Step 5 is Control Gain, continue with Step 7. If the value recorded in Step 5 is Control Power, verify that the value recorded in Step 3 is equal to –1.5 dBm +/- 0.5 dBm. If so, continue with Step 9. If not, complete the following steps:

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI Off. If so, continue with Step b. If not, click the cell and choose Off from the drop-down list. Click Apply, then click Yes.

b. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.

c. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

d. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

e. Repeat Steps 3 through 6. If the power level is still not within the specified range, contact your next level of support.

Step 7  In node view, click the Provisioning > WDM-ANS tabs. Complete the following steps to obtain the east and west add/drop power values:

a. If an OSC-CSM card is not installed on the east side, continue with Step e. If an OSC-CSM card is installed on the east side, in the Selector window on the left, expand the East Side parameters tree view.

b. Expand the TX category.

c. Expand the Power category, then highlight Add&Drop - Output Power.


e. If an OSC-CSM card is not installed on the west side, continue with Step 8. If an OSC-CSM card is installed on the west side, in the Selector window on the left, expand the West Side parameters tree view.

f. Expand the TX category.

g. Expand the Power category, then highlight Add&Drop - Output Power.

h. View the WestSide.Tx.Power.Add&Drop - Output Power parameter displayed in the right pane.

Step 8  Verify that the power value recorded in Step 3 is equal to the value recorded in Step 7 or –6.5 dBm, whichever is less (+/- 0.5 dBm). If the power level is not within this range, complete the following steps. Otherwise, continue with Step 9.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI Off. If not, click the cell and choose Off from the drop-down list. Click Apply, then click Yes.

b. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.

c. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.

d. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

e. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

f. Repeat Steps 3 through 8. If the power level is still not within the specified range, contact your next level of support.

Step 9  Return to your originating procedure (NTP).
DLP-G314 Verify OSCM Transmit Power

**Purpose**  
This procedure verifies the transmit power of the OSCM card.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
“DLP-G46 Log into CTC” task on page 2-25

**Required/As Needed**  
Required

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Superuser

**Note**  
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

---

**Step 1**  
Display the OSCM card in card view.

**Step 2**  
Click the **Provisioning > Optical Line > Parameters** tabs.

**Step 3**  
Record the Port 3 Power value: _____. If an OPT-PRE card is installed in the same side of the shelf as the OSCM, continue with Step 4. If not, verify that the value is equal to –5 dBm +/– 0.5 dBm. If so, continue with Step 7. If not, continue with Step 6, Substep a.

**Step 4**  
Change to node view, then click the **Provisioning > WDM-ANS** tabs.

**Step 5**  
Record the amplifier working mode value from one of the following:

For OSCM cards installed on the east side:

a. In the Selector window on the left, expand the East Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight **Working Mode**.


For OSCM cards installed on the west side:

a. In the Selector window on the left, expand the West Side parameters tree view.

b. Expand the RX category.

c. Expand the Amplifier category, then highlight **Working Mode**.

d. Record the WestSide.Rx.Amplifier.Working Mode parameter displayed in the right pane.

**Step 6**  
If the working mode recorded in Step 5 is Control Gain, verify that the value recorded in Step 3 is equal to –5 dBm +/– 0.5 dBm. If the value recorded in Step 5 is Control Power, verify that the value recorded in Step 3 is equal to 0.5 dBm, +/– 0.5 dBm. If the power level is not within this range, complete the following steps. Otherwise, continue with Step 7.

a. Click the **Maintenance > ALS** tabs. Verify that the ALS Command is set to OSRI Off. If not, click the cell and choose **Off** from the drop-down list. Click **Apply**, then click **Yes**.

b. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.

c. Complete the following procedures:

   - Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.
   - Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.
– Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

d. Repeat Steps 3 through 6. If the power level is still not within the specified range, contact your next level of support.

**Step 7** Return to your originating procedure (NTP).
Perform Node Acceptance Tests

This chapter provides test procedures to verify that the cards installed in the ONS 15454 are performing correctly. The procedures are optional.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI (SONET) and ETSI (SDH) shelf assemblies.

Before You Begin

This section lists the non-trouble procedures (NTPs) that you need to complete to validate a dense wavelength division multiplexing (DWDM) node. Turn to a procedure for applicable detailed level procedures (DLPs).

1. NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test, page 4-2—Complete this procedure to test terminal and hub nodes with 32MUX-O and 32DMX-O cards installed.

2. NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test, page 4-5—Complete this procedure to test terminal nodes with 32WSS and 32DMX cards installed.

3. NTP-G43 Perform the ROADM Node Acceptance Test, page 4-8—Complete this procedure to test reconfigurable optical add/drop multiplexing (ROADM) nodes.

4. NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test, page 4-20—Complete this procedure to test anti-amplified spontaneous emission (anti-ASE) hub nodes.

5. NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test, page 4-23—Complete this procedure to test line amplifier nodes with OSCM cards installed on both the east and west sides of the shelf.

6. NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test, page 4-26—Complete this procedure to test line amplifier nodes with OSC-CSM cards installed on both the east and west sides of the shelf.

7. NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test, page 4-30—Complete this procedure to test line amplifier nodes with OSCM and OSC-CSM cards installed.

8. NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards, page 4-34—Complete this procedure to test optical add/drop multiplexing (OADM) nodes with OSCM cards installed on both the east and west sides of the shelf.
9. NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM Cards, page 4-36—Complete this procedure to test OADM nodes with OSC-CSM and OPT-BST cards installed on both the east and west sides of the shelf.

10. NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM Cards, page 4-38—Complete this procedure to test OADM nodes with OSC-CSM cards installed on both the east and west sides of the shelf and no OPT-BST cards.

NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test

**Purpose**
This procedure tests a DWDM terminal or hub node with 32MUX-O and 32DMX-O cards.

**Tools/Equipment**
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)
An optical power meter or optical spectrum analyzer
2 bulk attenuators (10 dB) with LC connectors

**Prerequisite Procedures**
Chapter 3, “Turn Up a Node”

**Required/As Needed**
Required
Onsite/Remote
Onsite
Security Level
Superuser

**Note**
This procedure tests the west side of hub nodes first, then the east side. If you are testing a terminal node, apply instructions for the west side of the hub node to the terminal side (east or west) of the terminal node.

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the hub or terminal node that you want to test. If you are already logged in, continue with Step 2.

**Step 2**
From the View menu, choose Go to Network View.

**Step 3**
Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

**Note**
If optical service channel (OSC) terminations are created, there will be two alarms, one for low power on the OPT-BST card, and the other an OSC channel alarm.

**Step 4**
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.
Chapter 4 Perform Node Acceptance Tests

NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test

Step 5
Create a physical loopback on the west (or terminal) OPT-BST amplifier by using a patchcord with 10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note
An SDCC Termination Failure alarm will appear due to the OSC signal loopback.

Step 6
Verify that the OSC link becomes active on the west OSCM or OSC-CSM card. (The OSC termination must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Step 7
Set the tunable laser or the TXP_MR_2.5G card to the first wavelength (1530.33 nm) of the 100-GHz ITU-T grid. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 8
Connect the tunable laser transmitter or TXP_MR_2.5G card DWDM TX port to the CHAN RX 01 port on the west (or terminal) 32MUX-O card using the available patch panel.

Step 9
Display the west (or terminal) 32MUX-O card in card view.

Step 10
Click the Provisioning > Optical Chn > Parameters tabs.

Step 11
Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 12
Verify that the Port 1 power level reaches the provisioned VOA Power Ref setpoint.

Note
The tunable laser minimum output optical power (Pout) must be 6 dBm. If the output power is lower than the specified value, the 32MUX-O card might not reach the provisioned setpoint.

Step 13
If an OPT-BST card is installed, complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 on the west (or terminal) OPT-BST to ensure that the amplifier is working properly.

Step 14
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 on the west (or terminal) OPT-PRE to ensure that the amplifier is working properly.

Step 15
Restore the default IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state to the 32MUX-O port that was changed to OOS,MT (ANSI) or Locked,maintenance (ETSI) in Step 11.

Step 16
Repeat Steps 7 through 15 for the remaining 32 wavelengths of the 100-Ghz grid to verify the correct behavior of all variable optical attenuators (VOAs) inside the 32MUX-O card.

Step 17
Remove the loopback created in Step 5.

Step 18
If the node is a hub node, repeat Steps 5 through 17 for the east side cards.

Step 19
Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

Step 20
Click the Alarms tab.
   a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.
   b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Stop. You have completed this procedure.
DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing

Purpose
This procedure provisions a TXP_MR_2.5G card for acceptance testing when a tunable laser is not available.

Tools/Equipment
Eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)

Prerequisite Procedures
NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-48

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Superuser

Table 4-1 TXP_MR_2.5G Card Wavelengths and Part Numbers

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Wavelengths</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-MR-L1-30.3</td>
<td>1530.33–1532.68</td>
</tr>
<tr>
<td>15454-MR-L1-34.2</td>
<td>1534.25–536.61</td>
</tr>
<tr>
<td>15454-MR-L1-38.1</td>
<td>1538.19–1540.56</td>
</tr>
<tr>
<td>15454-MR-L1-42.1</td>
<td>1542.14–1544.53</td>
</tr>
<tr>
<td>15454-MR-L1-46.1</td>
<td>1546.12–1548.51</td>
</tr>
<tr>
<td>15454-MR-L1-50.1</td>
<td>1550.12–1552.52</td>
</tr>
<tr>
<td>15454-MR-L1-54.1</td>
<td>1554.13–1556.55</td>
</tr>
<tr>
<td>15454-MR-L1-58.1</td>
<td>1558.17–1560.61</td>
</tr>
</tbody>
</table>

Step 1
If you have installed and verified the TXP_MR_2.5G cards, continue with Step 3. If you have not installed the TXP cards, verify that you have TXP_MR_2.5G cards for every wavelength that you will test. Table 4-1 lists the TXP_MR_2.5G part numbers and wavelengths.

Step 2
Install each TXP card using the “NTP-G32 Install the Transponder and Muxponder Cards” procedure on page 3-43. If there are not enough open slots to install all the cards at one time, you can perform the acceptance tests one TXP at a time. However, you will need to uninstall and install the TXP cards for the wavelengths being tested.

Step 3
Display the TXP_MR_2.5G for the first wavelength you are testing (see Table 4-1) in card view.

Step 4
Click the Provisioning > Line > [Service Type] tabs.

Step 5
Click the Admin State column for the trunk port and choose OOS,Disable (ANSI) or Unlocked,disable (ETSI) from the drop-down list.

Step 6
Click Apply, then click Yes.

Step 7
Click the Provisioning > Card tabs.

Step 8
In the Wavelength field, choose the first wavelength required by the acceptance test.

Step 9
Click Apply.

Step 10
Click the Provisioning > Line > [Service Type] tabs.
Chapter 4  Perform Node Acceptance Tests

NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test

Step 11  Click the Admin State column for the trunk port and choose **OOS,Maintenance** (ANSI) or **Unlocked,Maintenance** (ETSI) from the drop-down list.

Step 12  Click **Apply**, then click **Yes**.

Step 13  Connect a power meter to the DWDM TX port. Verify that the output power falls within –4.5 dBm and 1 dBm. If it does not fall within this range, replace the card or contact your next level of support.

Step 14  Repeat Steps 3 through 13 for all the installed TXP cards.

Step 15  Return to your originating procedure (NTP).

---

**NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test**

**Purpose**  This procedure tests a DWDM terminal node with 32WSS and 32DMX cards installed.

**Tools/Equipment**  A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)

An optical power meter or optical spectrum analyzer

1 bulk attenuator (10 dB) with LC connectors

**Prerequisite Procedures**  Chapter 3, “Turn Up a Node”

**Required/As Needed**  Required

**Onsite/Remote**  Onsite

**Security Level**  Superuser

---

**Note**  This procedure creates an optical loopback on the OPT-BST line. An optical signal is sent from the 32WSS input (add) to the OPT-BST common RX and back out the OPT-BST TX line. The OPT-BST line receives the looped signal from the OPT-BST TX. It then passes the signal to the OPT-BST common TX and into the OPT-PRE common RX. The OPT-PRE sends the signal to the 32DMX. The optical signal from the tunable laser or TXP_MR_2.5G must pass successfully through the 32WSS and out the 32DMX.

---

**Step 1**  Complete the “DLP-G46 Log into CTC” task on page 2-25 at the hub or terminal node that you want to test. If you are already logged in, continue with Step 2.

**Step 2**  Display the terminal node in node view.

**Step 3**  Click the **Alarms** tab.

- **a.** Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

- **b.** Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.
Note If OSC terminations are created, an OSC channel alarm will appear.

Step 4 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, or if errors (indicated in red) appear, delete the OSC channels and complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83. Provision the OSC channels when complete.

Step 5 Create a physical loopback on the OPT-BST, OCSM, or OSC-CSM by using a patchcord with 10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note An SDCC Termination Failure alarm will appear due to the OSC signal loopback. This is observed as an alarm on Port 1 of the OCSM or OSC-CSM card.

Step 6 Wait 90 seconds, then verify that the OSC link is active on the west OCSM or OSC-CSM card by observing whether or not the loss of signal (LOS) alarm on the OCSM or OSC-CSM (and the OPT-BST card, if present) clears. (The OSC termination must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 8.
   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength you will test, then continue with Step 9.

Step 8 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1, if needed.

Step 9 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the CHAN RX 01 port on the 32WSS card using the available patch panel.

Note The tunable laser minimum output optical power (Pout) must be –6 dBm. If the output power is lower than –6 dBm, the 32WSS card might not reach the provisioned setpoint.

Step 10 Display the 32WSS card in card view.

Step 11 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the optical connector number that carries the wavelengths you will test. Refer to Table 4-2 on page 4-9, if needed.

Step 12 Click the Admin State table cell for the Add port carrying the tested wavelength, then choose OOS,MT (for ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the tested wavelength is 1530.33 (shown as 1530.3), you would click the Port 1 Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list.

Step 13 Change the Admin State of the pass-through (PT) port corresponding to the port in Step 8 to OOS,MT (ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 (shown as 1530.3), you would click the Port 33 Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list. Refer to Table 4-2 on page 4-9, if needed. Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the optical connector number that carries the wavelength under test.

Step 14 Click Apply, then click Yes.

Step 15 Click the Maintenance tab.
Step 16  For Channel #1, change Operating Mode to **Add Drop**.

Step 17  Click **Apply**, then click **Yes**.

Step 18  Click the **Provisioning > Optical Chn > Parameters** tabs.

Step 19  Verify that the actual power coming from the tunable laser or TXP_MR_2.5G card shown under the Power column is equal to the specified VOA Power Ref power shown in the same row.

Step 20  Click the **Optical Line** tab.

Step 21  Verify that the TX COM port (#67) has the same power as the VOA Power Ref setpoint in Step 19. This verifies that the optical signal is traveling correctly through the WSS card.

Step 22  Verify that the Port 1 power level reaches the provisioned VOA Power Ref setpoint.

Step 23  If an OPT-BST card is installed, complete the “**DLP-G79 Verify the OPT-BST Amplifier Laser and Power**” task on page 4-40 on the OPT-BST to ensure that the amplifier is working properly.

Step 24  Complete the “**DLP-G80 Verify the OPT-PRE Amplifier Laser and Power**” task on page 4-41 on the OPT-PRE to ensure that the amplifier is working properly.

Step 25  Complete the “**DLP-G269 Verify the 32DMX-O Power**” task on page 4-42 or “**DLP-G270 Verify the 32DMX Power**” task on page 4-42 to verify that the 32DMX-O or 32DMX card is powered correctly.

Step 26  Complete the “**NTP-G37 Run Automatic Node Setup**” procedure on page 3-83 to restore the original configuration.

Step 27  Click the **Maintenance** tab.

Step 28  For the circuit (channel) under test, click the **Operating Mode** table cell and choose **Not Assigned** from the drop-down list.

Step 29  Click **Apply**, then **Yes**.

Step 30  Click the **Provisioning > Optical Chn: Optical Connector** tabs.

Step 31  Click the **Admin State** table cell. Choose **IS,AINS** (ANSI) or **Unlocked,AutomaticInService** (ETSI) from the drop-down list for all ports that were changed to **OOS,MT** or **Locked,Maintenance**.

Step 32  Repeat Steps 7 through 31 for the remaining 31 wavelengths of the 100-Ghz grid to verify the correct behavior of all VOAs inside the 32WSS card.

Step 33  Restore the default administrative states to the OPT-BST, OPT-PRE, and 32DMX ports that were changed to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) in Step 12. Remove the loopback created in Step 5.

Step 34  Complete the “**NTP-G37 Run Automatic Node Setup**” procedure on page 3-83 to restore the original configuration.

Step 35  Click the **Alarms** tab.

a. Verify that the alarm filter is not on. See the “**DLP-G128 Disable Alarm Filtering**” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.

**Stop. You have completed this procedure.**
NTP-G43 Perform the ROADM Node Acceptance Test

Purpose
The ROADM node acceptance test verifies that the node is operating properly before you connect it to the network. The test verifies that each add/drop and pass-through port on the 32WSS and 32DMX card operates properly and verifies the operation of the amplifiers. The test also checks the power levels at each transmit and receive port to ensure that power loss in the cabling is within tolerance.

Tools/Equipment
A tunable laser or eight TXP cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)
An optical power meter or optical spectrum analyzer
2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node”

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Note
Because the node is isolated and no line-side fibers are connected during the test, the power levels going into the line-side components will not be the same as a real network setup. Therefore, if the ROADM shelf does not contain OPT-BST and OPT-PRE amplifiers on both the east and west sides, you must lower the OPT-PRE power thresholds so that it turns on properly. At the end of the test, you will run automatic node setup to configure the node with the correct parameters for the network acceptance test.

Step 1
Make a copy of Table 4-2 and place it in a convenient location for reference throughout this procedure. The table shows the 32WSS ports and the wavelengths assigned to them. The 32 wavelengths are divided among four physical MPO connectors on the 32WSS card. Each MPO connector is assigned eight wavelengths. In CTC, the MPO connector appears in the card view Provisioning > Optical Connector tab. Each Optical Connector subtab represents an MPO connector. Ports 1 through 32 are the receive (RX) ports; Ports 33 through 64 are the PT ports.
Table 4-2  32WSS Ports and Wavelengths Test Checklist

<table>
<thead>
<tr>
<th>32WSS Provisioning Subtab</th>
<th>Port #</th>
<th>Wavelength</th>
<th>Tested PT</th>
<th>Tested Add/Drop West</th>
<th>Tested Add/Drop East</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optical Chn:</td>
<td>RX 1, PT 33</td>
<td>1530.33</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Connector 1</td>
<td>RX 2, PT 34</td>
<td>1531.12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 3, PT 35</td>
<td>1531.90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 4, PT 36</td>
<td>1532.68</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 5, PT 37</td>
<td>1534.25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 6, PT 38</td>
<td>1535.04</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 7, PT 39</td>
<td>1535.82</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 8, PT 40</td>
<td>1536.61</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Chn:</td>
<td>RX 9, PT 41</td>
<td>1538.19</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Connector 2</td>
<td>RX 10, PT 42</td>
<td>1538.98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 11, PT 43</td>
<td>1539.77</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 12, PT 44</td>
<td>1540.56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 13, PT 45</td>
<td>1542.14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 14, PT 46</td>
<td>1542.94</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 15, PT 47</td>
<td>1543.73</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 16, PT 48</td>
<td>1544.53</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Chn:</td>
<td>RX 17, PT 49</td>
<td>1546.12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Connector 3</td>
<td>RX 18, PT 50</td>
<td>1546.92</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 19, PT 51</td>
<td>1547.72</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 20, PT 52</td>
<td>1548.51</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 21, PT 53</td>
<td>1550.12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 22, PT 54</td>
<td>1550.92</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 23, PT 55</td>
<td>1551.72</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 24, PT 56</td>
<td>1552.52</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Chn:</td>
<td>RX 25, PT 57</td>
<td>1554.13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical Connector 4</td>
<td>RX 26, PT 58</td>
<td>1554.94</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 27, PT 59</td>
<td>1555.75</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 28, PT 60</td>
<td>1556.55</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 29, PT 61</td>
<td>1558.17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 30, PT 62</td>
<td>1558.98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 31, PT 63</td>
<td>1559.79</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RX 32, PT 64</td>
<td>1560.61</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Step 2**  Complete the “DLP-G46 Log into CTC” task on page 2-25 at the ROADM node that you want to test. If you are already logged in, continue with **Step 3**.
**NTP-G43 Perform the ROADM Node Acceptance Test**

**Step 3**
Display the ROADM node in node view.

**Step 4**
Click the **Alarms** tab.

- a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

- b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.

**Note**
The OSC terminations created during node turn-up will generate two alarms for each side of the shelf, one for LOS on the OPT-BST card, and the other an LOS alarm on the OSC-CSM or OSCM card.

**Step 5**
In node view, click the **Provisioning > WDM-ANS > Port Status** tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the following steps:

- a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.

- b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

- c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

**Step 6**
Display the east 32WSS in card view.

**Step 7**
Click the **Provisioning > Optical Chn Optical Connector [n] > Parameters** tabs, where n = the optical connector number that carries the wavelengths you will test. Refer to Table 4-2 on page 4-9, if needed.

**Step 8**
Click the **Admin State** table cell for the Add port carrying the tested wavelength, then choose **OOS,MT** (for ANSI) or **Locked,maintenance** (ETSI) from the drop-down list. For example, if the tested wavelength is 1530.33 (shown as 1530.3), you would click the Port 1 Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list.

**Step 9**
Change the Admin State of the PT port corresponding to the port in Step 8 to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI). For example, if the tested wavelength is 1530.33 (shown as 1530.3), you would click the Port 33 Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list. Refer to Table 4-2 on page 4-9, if needed.

**Step 10**
Click **Apply**, then click **Yes** to confirm.

**Step 11**
Repeat Steps 7 through 10 for all wavelengths that you will test.

**Step 12**
Display the west 32WSS in card view.

**Step 13**
Repeat Steps 7 through 10 for the west 32WSS card.

**Step 14**
Display the east 32DMX or 32DMX-O in card view and complete the following steps:

For a 32DMX card:

- a. Choose the **Provisioning > Optical Line > Parameters** tabs.

- b. For Port 33, click the **Admin State** table cell and choose **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) from the drop-down list.

- c. Click **Apply**, then click **Yes** to confirm.
For a 32DMX-O card:

a. Choose **Provisioning > Optical Chn > Parameters** tabs.

b. For each wavelength being tested, click the **Admin State** table cell and choose **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) from the drop-down list.

c. Click **Apply**, then click **Yes** to confirm.

**Step 15**
Repeat **Step 14** for the west 32DMX or 32DMX-O card.

**Step 16**
Complete the “**DLP-G310 Verify ROADM Node Pass-Through Channels**” task on page 4-12.

**Step 17**
Complete the following tasks for channels that will be added or dropped on the node:

- **DLP-G311 Verify the East ROADM Add/Drop Channels**, page 4-16
- **DLP-G312 Verify the West ROADM Add/Drop Channels**, page 4-18

**Step 18**
Display the east 32WSS in card view.

**Step 19**
Click the **Provisioning > Optical Chn Optical Connector [n] > Parameters** tabs, where n = the optical connector number that carries the wavelengths you tested.

**Step 20**
Click the **Admin State** table cell then choose **IS,AINS** (for ANSI) or **Unlocked,AutomaticInService** (ETSI) from the drop-down list for all ports that were changed to OOS,MT or Locked,Maintenance.

**Step 21**
Click **Apply**.

**Step 22**
Repeat Steps 19 and 21 for all the ports that are **OOS,MT** or **Locked,maintenance** on the east 32WSS card.

**Step 23**
Display the west 32WSS in card view.

**Step 24**
Repeat Steps 19 through 21 for all ports on the west 32WSS card.

**Step 25**
Display the east 32DMX in card view.

**Step 26**
Choose the **Provisioning > Optical Line > Parameters** tabs.

**Step 27**
For Port 33, click the **Admin State** table cell and choose **IS,AINS** (ANSI) or **Unlocked,AutomaticInService** (ETSI) from the drop-down list.

**Step 28**
Click **Apply**.

**Step 29**
Display the west 32DMX card in card view.

**Step 30**
Repeat Steps 26 through 28 for the west 32DMX card.

**Step 31**
Delete both OSC channels using the “**DLP-G186 Delete an OSC Termination**” task on page 10-41.

**Step 32**
Complete the “**NTP-G37 Run Automatic Node Setup**” procedure on page 3-83.

**Step 33**
Create the two OSC channels using the “**NTP-G38 Provision OSC Terminations**” procedure on page 3-84.

**Step 34**
Click the **Alarms** tab.

a. Verify that the alarm filter is not on. See the “**DLP-G128 Disable Alarm Filtering**” task on page 8-28 as necessary.

b. Verify that no equipment failure alarms appear on the node. If alarms appear, investigate and resolve them before continuing. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.

**Stop. You have completed this procedure.**
DLP-G310 Verify ROADM Node Pass-Through Channels

Purpose

This task verifies the signal flow through a ROADM node for pass-through channels. Configuring a channel pass-through mode means that the channel passes through both 32WSS cards. The channel passes through the first 32WSS from the COM RX port to the EXP TX port. In the second 32WSS, the channel goes from the EXP RX port to the COM TX port. The channel is not terminated inside the node.

Tools/Equipment

A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)
An optical power meter or optical spectrum analyzer
2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures

“DLP-G46 Log into CTC” task on page 2-25

Step 1

Create a physical loopback on the west OPT-BST or OSC-CSM by connecting the LINE TX port to its LINE RX port. For OPT-BST cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM cards do not require attenuation.)

Caution

Failure to use proper attenuation might damage equipment.

Step 2

If an OPT-PRE amplifier is installed on the west side (where the physical loopback was created), perform the following steps. If not, continue with Step 3.

a. Display the OPT-PRE card in card view, then click the Provisioning > Optical Line > Optics Thresholds tabs.

b. Under Types, click Alarm, then click Refresh. The alarm thresholds for the OPT-PRE will appear.

c. Double click the Power Failure Low table cell for Port 1 (1-Line-2-1 RX) and delete the current value.

d. Type a new value of −30. Press Enter on your computer, then click Apply in the CTC window.

e. If an OPT-PRE is installed on the east side, complete Steps a through d for the east OPT-PRE. If an OPT-PRE is not installed on the east side, continue with Step 3.

Step 3

Wait 2 to 3 minutes, then in node view click the Alarms tab. Verify that the LOS alarms on the west OSCM or OSC-CSM card, and the OPT-BST card have cleared. The clearing of the LOS alarms indicates that the OSC link is active on the west side.

Note

An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4

Display the west 32WSS card in card view.

Step 5

Click the Maintenance tab.
Step 6  For each wavelength that you will test, click the table cell under Operating Mode and choose **Pass Through** from the drop-down list.

Step 7  Click **Apply**, then click **Yes** to confirm.

Step 8  Display the east 32WSS card in card view.

Step 9  Repeat Steps 5 through 7 for the east 32WSS card.

Step 10 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 11.
   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength you will test, then continue with Step 12.

Step 11 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1, if needed.

Step 12 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OPT-BST or OSC-CSM LINE RX port. If an east OPT-PRE is installed, insert a 10-dB attenuator on the fiber coming from the TXP_MR_2.5G card.

**Caution**  Failure to use proper attenuation might damage equipment.

Step 13 If an east OPT-PRE card is installed, complete the following steps. If not, continue with Step 14.
   a. Display the east OPT-PRE in card view.
   b. Click the **Provisioning > Optical Line > Parameters** tabs.
   c. Locate the Power parameter for Port 1. Record the value.
   d. Display the east OPT-BST or OSC-CSM card in card view.
   e. Click the **Provisioning > Optical Line > Parameters** tabs.
   f. Locate the Power value for Port 2 (if an OPT-BST) or Port 3 (if an OSC-CSM). Verify that the value matches the power recorded in Step c, +/- 1.5 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the OPT-PRE card and the OPT-BST or OSC-CSM card.
   g. Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41.

Step 14 Verify the east 32WSS to OPT-BST, OPT-PRE, or OSC-CSM cable connection:
   a. Display the east 32WSS in card view.
   b. Click the **Provisioning > Optical Line > Parameters** tabs.
   c. Locate the Port 68 Power parameter. Record the value.
   d. If an east OPT-PRE is installed, display it in card view, and complete Step e. If not, continue with Step f.
   e. Click the **Provisioning > Opt.Ampli.Line > Parameters** tabs and read the Total Output Power value for Port 2, then continue with Step i.
   f. If an east OPT-BST card is installed, display it in card view, and complete Step g. If not, continue with Step h.
   g. Click the **Provisioning > Opt.Ampli.Line > Parameters** tabs and read the Power value for Port 3, then continue with Step i.
h. Display the east OSC-CSM card in card view, click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2, then continue with Step i.

i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/- 1.5 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the 32WSS card and the OPT-PRE, OPT-BST, or OSC-CSM card.

**Step 15** Verify the EXPRESS cable connection between the two 32WSS cards:

a. Display the east 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 Power parameter. Record the value.

a. Display the west 32WSS in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power value for Port 66. Verify that the value matches the power recorded in Step c, +/- 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the 32WSS cards.

**Step 16** Display the west 32WSS card in card view.

**Step 17** Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

**Step 18** Wait approximately 60 seconds, then locate the Power and VOA Power Ref parameters for the tested PT port. Verify that the Power value is equal to the VOA Power Ref value, +/- 1.5 dBm.

**Step 19** If an OPT-BST card is installed on the east side, complete the following steps. If not, continue with Step 20.

a. Display the east OPT-BST in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 Power parameter. Record the value.

d. Display the east 32WSS in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 67. Verify that the value matches the power recorded in Step c, +/- 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the OPT-BST and 32WSS cards.

g. Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40.

**Step 20** If a west OPT-PRE card is installed, complete the following steps. If not, continue with Step 14.

a. Display the west OPT-PRE in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1. Record the value.

d. Display the west OPT-BST or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 2 (if an OPT-BST) or Port 3 (if an OSC-CSM). Verify that the value matches the power recorded in Step c, +/- 1.5 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the OPT-PRE card and the OPT-BST or OSC-CSM card.

g. Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41.
Step 21 Verify the west 32WSS card to OPT-BST, OPT-PRE, or OSC-CSM card cable connection:
   a. Display the west 32WSS in card view.
   b. Click the Provisioning > Optical Line > Parameters tabs.
   c. Locate the Port 68 Power parameter. Record the value.
   d. If an west OPT-PRE is installed, display it in card view, and complete Step e. If not, continue with Step f.
   e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power value for Port 2, then continue with Step i.
   f. If an west OPT-BST card is installed, display it in card view, and complete Step g. If not, continue with Step h.
   g. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 3, then continue with Step i.
   h. Display the west OSC-CSM card in card view, click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 2, then continue with Step i.
   i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/-1.5 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the 32WSS card and the OPT-PRE, OPT-BST or OSC-CSM card.

Step 22 Verify the EXPRESS cable connection between the two 32WSS cards:
   a. Display the west 32WSS in card view.
   b. Click the Provisioning > Optical Line > Parameters tabs.
   c. Locate the Port 65 Power parameter. Record the value.
   a. Display the east 32WSS in card view.
   b. Click the Provisioning > Optical Line > Parameters tabs.
   c. Locate the Power value for Port 66. Verify that the value matches the power recorded in Step c, +/-1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the 32WSS cards.

Step 23 Display the east 32WSS card in card view.

Step 24 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 25 Wait approximately 60 seconds, then locate the Power and VOA Power Ref parameters for the tested PT port. Verify that the Power value is equal to the VOA Power Ref value, +/-1.5 dBm. If the Power value is not equal to the VOA Power Ref value +/-1.5 dBm, check your connections and clean the fibers from the 32WSS card to the patch panel and from the patch panel to the TXP card using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. Then, repeat Step 24. If this does not change the power value, consult your next level of support.

Step 26 If an OPT-BST card is installed on the east side, complete the following steps. If not, continue with Step 27.
   a. Display the east OPT-BST in card view.
   b. Click the Provisioning > Optical Line > Parameters tabs.
   c. Locate the Port 1 Power parameter. Record the value.
   d. Display the east 32WSS in card view.
   e. Click the Provisioning > Optical Line > Parameters tabs.
Chapter 4 Perform Node Acceptance Tests

DLP-G311 Verify the East ROADM Add/Drop Channels

f. Locate the Power value for Port 67. Verify that the value matches the power recorded in Step c, +/-1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 to clean the fiber connection between the OPT-BST and 32WSS cards.

g. Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40.

Step 27 Repeat Steps 10 through 26 for the remaining wavelengths to be tested. If you have tested all the wavelengths, continue with Step 28.

Step 28 Display the east 32WSS card in card view.

Step 29 Click the Maintenance tab.

Step 30 Under Operating Mode, click the table cell and choose Not Assigned from the drop-down list for all wavelengths.

Step 31 Click Apply, then click Yes to confirm.

Step 32 Display the west 32WSS in card view.

Step 33 Repeat Steps 29 through 31 for the west 32WSS card.

Step 34 Remove the TXP or tunable laser from the east OPT-BST or OSC-CSM line side TX and RX ports.

Step 35 Remove the loopback fiber from the line RX and TX in the west OPT-BST or OSC-CSM card.

Step 36 Return to your originating procedure (NTP).

DLP-G311 Verify the East ROADM Add/Drop Channels

Purpose This procedure verifies the signal flow through the east side of a ROADM node for add/drop channels.

Tools/Equipment A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4) An optical power meter or optical spectrum analyzer 2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-25

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser

Note Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Step 1 In node view, display the Alarms tab.

Step 2 Create a physical loopback on the east OPT-BST or OSC-CSM by connecting the LINE TX port to its LINE RX port. For OPT-BST cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM cards do not require attenuation.)

Caution Failure to use proper attenuation might damage equipment.
Step 3 Wait 2 to 3 minutes, then click the Alarms tab. Verify that the LOS alarm on the east OSCM or OSC-CSM, and the OPT-BST cards have cleared. The clearing of the LOS alarm indicates that the OSC link is active on the east side.

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 5.
   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength you are testing, then continue with Step 7.

Step 5 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

Step 6 If you are using a TXP_MR_2.5G card, connect the TX port to a power meter and record the output power.

Step 7 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east side fiber patch panel MUX port that corresponds to the east 32WSS card port carrying the tested wavelength.

Step 8 Connect the TXP_MR_2.5G DWDM RX port or the power meter RX port to the east side fiber patch panel DMX port that corresponds to the east 32DMX card port carrying the tested wavelength.

Step 9 Display the east 32WSS in card view.

Step 10 Click the Maintenance tab.

Step 11 For each wavelength that you will test, click the table cell under Operating Mode and choose Add Drop from the drop-down list.

Step 12 Click Apply, then click Yes to confirm.

Step 13 Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 14 Scroll to the right until you see the Power Add parameter. Verify that the Power Add value for the tested port is equal to the output power level of the tunable laser or TXP_MR_2.5G card (measured in Step 6), +/- 1 dBm.

Step 15 Display the east 32DMX card in card view.

Step 16 Click the Provisioning > Optical Chn > Parameters tab. Record the value under the Power parameter for the wavelength under test.

Step 17 Verify that the power value from Step 16 reaches the EastSide.Rx.Power.Add&Drop - Drop Power setpoint +/- 1 dBm. To view this setpoint:
   a. Go to node view and click the Provisioning > WDM-ANS > Provisioning tabs.
   b. In the Selector window on the left, expand the East Side parameters tree view.
   c. Expand the RX category.
   d. Expand the Power category, then highlight Add&Drop - Drop Power.

If the power values do not match (+/- 2 dBm), remove, clean, and replace each cable on the east side of the shelf. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.

Step 18 Display the TXP_MR_2.5G in card view.
DLP-G312 Verify the West ROADM Add/Drop Channels

Purpose
This procedure verifies the signal flow through the west side of a ROADM node for add/drop channels.

Tools/Equipment
- A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)
- An optical power meter or optical spectrum analyzer
- 2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
“DLP-G46 Log into CTC” task on page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Note
Throughout this task, west refers to Slots 1 through 8, and east refers to Slots 10 through 17.

Caution
Failure to use proper attenuation might damage equipment.

Step 1
In node view, display the Alarms tab.

Step 2
Create a physical loopback on the west OPT-BST or OSC-CSM by connecting a fiber with 10-dB bulk attenuator from the OPT-BST LINE TX port to its LINE RX port. For OPT-BST cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM cards do not require attenuation.)
Step 3  Wait 90 seconds, then click the Alarms tab. Verify that the LOS alarms on the west OSCM or OSC-CSM card and the OPT-BST card have cleared. The clearing of the LOS alarms indicates that the OSC link is active on the west side.

Note  An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

Step 4  If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 5.
  a.  Set the output power to a nominal value, such as –3 dBm.
  b.  Set the tuner to the wavelength you are testing, then continue with Step 7.

Step 5  If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1, if needed.

Step 6  If you are using a TXP_MR_2.5G card, connect the TX port to a power meter and record the output power.

Step 7  Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the west side fiber patch panel MUX port that corresponds to the west 32WSS card port carrying the tested wavelength.

Step 8  Connect the TXP_MR_2.5G DWDM RX port to the west side fiber patch panel DMX port that corresponds to the west 32DMX card port carrying the tested wavelength.

Step 9  Display the west 32WSS in card view.

Step 10  Click the Maintenance tab.

Step 11  For each wavelength that you will test, click the table cell under Operating Mode and choose Add Drop from the drop-down list.

Step 12  Click Apply, then click Yes to confirm.

Step 13  Click the Provisioning > Optical Chn Optical Connector [n] > Parameters tabs, where n = the connector number containing the wavelength you are testing. Refer to Table 4-2 on page 4-9, if needed.

Step 14  Scroll to the right until you see the Power Add parameter. Verify that the Power Add value for the tested port is equal to the output power level of the tunable laser or TXP_MR_2.5G card (measured in Step 6), +/- 1 dBm.

Step 15  Display the west 32DMX card in card view.

Step 16  Click the Provisioning > Optical Chn > Parameters tab. Record the value under the Power parameter for the wavelength under test.

Step 17  Verify that the power value from Step 16 reaches the WestSide.Rx.Power.Add&Drop - Drop Power setpoint, +/- 2 dBm. To view this setpoint:
  a.  Go to node view and click the Provisioning > WDM-ANS > Provisioning tabs.
  b.  In the Selector window on the left, expand the West Side parameters tree view.
  c.  Expand the RX category.
  d.  Expand the Power category, then highlight Add&Drop - Drop Power.
  e.  View the WestSide.Rx.Power.Add&Drop parameter on the right side of the pane.

If the power values do not match (+/- 2 dBm), remove, clean, and replace each cable on the west side of the shelf. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.

Step 18  Display the TXP_MR_2.5G in card view.
NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test

Purpose
This procedure tests an anti-ASE hub node.

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)
An optical power meter or optical spectrum analyzer
2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node.”

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2
From the View menu, choose Go to Network View.

Step 3
Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.
Chapter 4  Perform Node Acceptance Tests

NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test

---

**Note**
The OSC terminations created during node turn-up will generate two alarms for each side of the shelf: one for LOS on the OPT-BST card, and the other an LOS alarm on the OSC_CSM or OSCM card.

---

**Step 4**
In node view, click the **Provisioning > WDM-ANS > Port Status** tabs. Verify that all statuses under Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the following steps:

- **a.** Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.
- **b.** Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.
- **c.** Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

**Step 5**
From your Cisco MetroPlanner site configuration file, identify the dropped and added channels that are configured in pass-through mode in both directions.

---

**Note**
Configuring a channel pass-through mode means that the channel is dropped along one direction by a 32DMX-O (15xx.xx TX port) located on one side (west or east) of the shelf, and then added by a 32MUX-O (1522.22 RX port) on the opposite side of the shelf but in the same direction. The channel is not terminated inside the site.

---

**Step 6**
Create a loopback on the west OPT-BST amplifier by connecting a patchcord from the LINE TX port to the LINE RX port with a 10-dB bulk attenuator.

**Step 7**
Verify that the OSC link becomes active on the west OSCM or OSC-CSM card. (The OSC Termination must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

**Step 8**
For pass-through channels, continue with **Step 9**. For add and drop channels, continue with **Step 18**.

**Step 9**
Verify the first channel connection configured in pass-through mode in both directions:

- **a.** If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If you are using a TXP_MR_2.5G card, continue with **Step b.**
- **b.** Set the tunable laser or TXP_MR_2.5G card to a corresponding wavelength on the 100-GHz ITU-T grid. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.
- **c.** Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port of the east OPT-BST using a 10-dB bulk attenuator.

**Step 10**
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 for the east OPT-PRE amplifier.

**Step 11**
Complete the “DLP-G269 Verify the 32DMX-O Power” task on page 4-42 for the west 32MUX-O and 32DMX-O cards.

**Step 12**
Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the west OPT-BST amplifier.

**Step 13**
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 for the west OPT-PRE amplifier.

**Step 14**
Complete the “DLP-G269 Verify the 32DMX-O Power” task on page 4-42 for the west 32MUX-O and 32DMX-O cards.
Step 15 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the east OPT-BST amplifier.

Step 16 Repeat Steps 9 through 15 for the remaining wavelengths on the 100-GHz grid that are pass-through wavelengths.

Step 17 If you have add and drop channels, continue with Step 18 to verify the channels. If not, continue with Step 29.

Step 18 Set the tunable laser or TXP_MR_1.5G card to the first wavelength of the 100-GHz ITU-T grid that is not a pass-through wavelength. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 19 Connect the tunable laser or TXP_MR_1.5G card to the CHAN RX \textit{nn} port on the west 32MUX-O, where \textit{nn} is the first add or drop channel.

Step 20 Display the west 32MUX-O in card view.

Step 21 Click the Provisioning > Optical Chn > Parameters tabs.

Step 22 Change the Admin State of Port \textit{nn} to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23 Check that the power value on Port \textit{nn} reaches the provisioned setpoint (VOA Power Ref).

Step 24 Display the west 32DMX-O in card view.

Step 25 Click the Provisioning > Optical Chn > Parameters tabs.

Step 26 Change the Admin State of Port \textit{nn} to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 27 Check that the power value on Port \textit{nn} reaches the provisioned setpoint (VOA Power Ref).

Step 28 (Optional) Connect a power meter to the CHAN TX \textit{nn} port through the patch panel and verify that the physical optical power coming out of drop Port \textit{nn} on the west 32DMX-O is consistent with the value read on the meter within 0.5 dB.

Step 29 Repeat Steps 18 through 28 for the remaining wavelengths on the 100-GHz grid that are not pass-through wavelengths.

Step 30 Remove the loopback connection on the west OPT-BST.

Step 31 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

Step 32 Create a loopback on the east OPT-BST amplifier by connecting a patchcord from the LINE TX port to the LINE RX port with 10-dB bulk attenuator.

Step 33 Verify that the OSC link becomes active on the east OSCM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Step 34 Repeat 18 through 33 for the east side cards.

Step 35 Remove the loopback on the east OPT-BST.

Step 36 Restore the default administrative state (IS,AINS/Unlocked,automaticInService) on all the ports previously set to OOS,MT (ANSI) or Locked,maintenance (ETSI).

\textbf{Stop. You have completed this procedure.}
NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test

Purpose
This procedure tests a line amplifier node with OSCM cards installed on both the east and west sides of the shelf by looping a single wavelength through the shelf.

Tools/Equipment
- A tunable laser or one TXP_MR_2.5G card
- An optical power meter or optical spectrum analyzer
- 2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
- Chapter 3, “Turn Up a Node.”

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the acceptance test. If you are already logged in, continue with Step 3.

Step 2
If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4. If not, continue with Step 3.

Step 3
From the View menu, choose Go to Node View.

Step 4
Click the Alarms tab.
- Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.
- Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note
The OSC terminations created during node turn-up will generate two alarms for each side of the shelf, one for LOS on the OPT-BST card, and the other an LOS alarm on the OSC_CSM or OSCM card.

Step 5
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the following steps:
- Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.
- Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.
- Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Step 6
Create a loopback on the west OPT-BST by using a fiber with a 10-dB bulk attenuator to connect the LINE TX port to the LINE RX port.
Chapter 4 Perform Node Acceptance Tests

NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 8.
   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength under test, then continue with Step 9.

Step 8 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

Step 9 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port of the east OPT-BST using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage equipment.

Step 10 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the west OPT-BST and OSCM cards have cleared. The clearing of the LOS alarms indicates that the OSC link is active on the west side.

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback. An LOS-O alarm appears on the east OPT-BST card, and an LOS alarm appears on the east OSCM card.

If the alarms clear, continue with Step 11. If not, perform the following steps:
   a. Display the west OPT-BST card in card view.
   b. Click the Provisioning > Optical Line > Optics Thresholds tabs.
   c. Under Types, click Alarms, then click Refresh.
   d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to –30 dBm.
   e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to –40 dBm.
   f. Click Apply, and then Yes.
   g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the west OPT-BST card has cleared. If so, continue with Step 11. If not, disconnect the OSCM card from the OPT-BST.
   h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC RX port using a 10-dB bulk attenuator.
   i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the west OSCM card has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.

Step 11 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 12.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the west OPT-BST amplifier.

Step 13 If an OPT-PRE amplifier is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. It not, continue with continue with Step 14.
Chapter 4 Perform Node Acceptance Tests

NTP-G45 Perform the Line Amplifier Node with OSCM Cards Acceptance Test

Step 14 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the east OPT-BST amplifier.

Step 15 Disconnect the TXP or tunable laser from the east OPT-BST card.

Step 16 Remove the loopback on the west OPT-BST created in Step 6.

Step 17 Create a loopback on the east OPT-BST by connecting a patchcord from the LINE TX port to the LINE RX port with a 10-dB bulk attenuator.

Step 18 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 19.
   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength under test, then continue with Step 20.

Step 19 If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

Step 20 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port of the west OPT-BST using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage equipment.

Step 21 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east OPT-BST and OSCM cards have cleared. The clearing of the LOS alarms indicates that the OSC link is active on the east side.

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback. An LOS-O alarm appears on the west OPT-BST card, and an LOS alarm appears on the west OSCM card.

If the alarms clear, continue with Step 22. If not, perform the following steps:
   a. Display the east OPT-BST card in card view.
   b. Click the Provisioning > Optical Line > Optics Thresholds tabs.
   c. Under Types, click Alarms, then click Refresh.
   d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to –30 dBm.
   e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to –40 dBm.
   f. Click Apply, and then Yes.
   g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east OPT-BST card has cleared. If so, continue with Step 22. If not, disconnect the OSCM card from the OPT-BST.
   h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC RX port using a 10-dB bulk attenuator.
   i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the east OSCM card has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.
NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test

**Step 22** If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 23.

**Step 23** Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the east OPT-BST amplifier.

**Step 24** If an OPT-PRE amplifier is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 25.

**Step 25** Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the west OPT-BST amplifier.

**Step 26** Disconnect the TXP or tunable laser from the west OPT-BST card.

**Step 27** Remove the loopback on the west OPT-BST amplifier created in Step 6.

**Step 28** Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.

**Step 29** Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

**Step 30** Create the two OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Stop. You have completed this procedure.

---

NTP-G46 Perform the Line Amplifier Node with OSC-CSM Cards Acceptance Test

**Purpose**

This procedure tests a line amplifier node with OSC-CSM cards installed on both the east and west sides of the shelf by looping a single wavelength through the shelf.

**Tools/Equipment**

- A tunable laser or TXP_MR_2.5G card
- An optical power meter or optical spectrum analyzer
- 2 bulk attenuators (10 dB) with LC connectors

**Prerequisite Procedures**

Chapter 3, “Turn Up a Node.”

**Required/As Needed**

- Required

**Onsite/Remote**

- Onsite

**Security Level**

- Superuser

**Step 1**

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the acceptance test. If you are already logged in, continue with Step 3.

**Step 2**

If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4. If not, continue with Step 3.

**Step 3**

From the View menu, choose Go to Node View.

**Step 4**

Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.
b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note: The OSC terminations created during node turn-up will generate an LOS alarm on the OSC-CSM card.

**Step 5**
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

**Step 6**
Create a physical loopback on the west OSC-CSM by connecting the LINE TX port to the LINE RX port with a fiber and 10-dB bulk attenuator.

Caution: Failure to use proper attenuation might damage equipment.

**Step 7**
Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the west OSC-CSM card has cleared. The clearing of the LOS alarm indicates that the OSC link is active on the west side.

Note: An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, and an LOS alarm will appear for the east OSC-CSM, Port 1 (OSC).

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect using only the patchcord.

b. In node view, click the Alarms tab. If the LOS alarm on the west OSC-CSM card clears, continue with Step 8. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. Under Types, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to −30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to −40 dBm.

h. Click Apply, and then Yes.

i. In node view, click the Alarms tab. If the LOS alarm on the west OSC-CSM card clears, continue with Step 8. If not, replace the OSC-CSM card.
Step 8  If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 9.

   a. Set the output power to a nominal value, such as –3 dBm.
   b. Set the tuner to the wavelength under test, then continue with Step 10.

Step 9  If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

Step 10 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage equipment.

Step 11 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 12.

Step 12 Display the west OSC-CSM card in card view.

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

Step 14 If an OPT-PRE is installed on the west side of the shelf, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 15.

Step 15 Display the east OSC-CSM card in card view.

Step 16 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 2 Power value. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

Step 17 Disconnect the TXP or tunable laser from the east OSC-CSM card.

Step 18 Remove the physical loopback created on the west OSC-CSM card in Step 6.

Step 19 Create a loopback on the east OSC-CSM by connecting the LINE TX port with LINE RX port using a patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage equipment.

Step 20 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the east OSC-CSM card has cleared. The clearing of the LOS alarm indicates that the OSC link is active on the east side.

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback, and an LOS alarm will appear for the west OSC-CSM, Port 1 (OSC).

If the alarm clears, continue with Step 21. If not, perform the following steps:

   a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect using only the patchcord.
b. Wait 90 seconds then, in node view, click the **Alarms** tab. If the LOS alarm on the east OSC-CSM card clears, continue with Step 21. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the **Provisioning > Optical Line > Optics Thresholds** tabs.

e. Under Types, click **Alarm**, then click **Refresh**.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to –30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to –40 dBm.

h. Click **Apply**, and then **Yes**.

i. In node view, click the **Alarms** tab. If the LOS alarm on the east OSC-CSM card clears, continue with Step 21. If not, replace the OSC-CSM card.

### Step 21
If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 22.

a. Set the output power to a nominal value, such as –3 dBm.

b. Set the tuner to the wavelength under test, then continue with Step 23.

### Caution
Failure to use proper attenuation might damage equipment.

### Step 22
If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

### Step 23
Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the west OSC-CSM LINE RX port using a 10-dB bulk attenuator.

### Step 24
If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 25.

### Step 25
Display the east OSC-CSM card in card view.

### Step 26
Click the **Provisioning > Optical Line > Parameters** tabs. Locate the Port 3 Power value. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

### Step 27
If an OPT-PRE is installed on the east side of the shelf, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 for the east OPT-PRE amplifier. If not, continue with Step 28.

### Step 28
Display the west OSC-CSM card in card view.

### Step 29
Click the **Provisioning > Optical Line > Parameters** tabs and locate the Power value for Port 2. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

### Step 30
Disconnect the TXP or tunable laser from the west OSC-CSM card.

### Step 31
Remove the loopback created on the east OSC-CSM card in Step 6.

### Step 32
Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-41.
Step 33 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

Step 34 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Stop. You have completed this procedure.

NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test

Purpose
This procedure tests a line amplifier node with an OSC-CSM card installed on one side of the shelf and an OSCM card installed on the other.

Tools/Equipment
- A tunable laser or TXP_MR_2.5G card
- An optical power meter or optical spectrum analyzer
- 2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node.”

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_2.5G cards, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Node View.

Step 4 Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Note
The OSC terminations created during node turn-up will generate two alarms for each side of the shelf, one for LOS on the OPT-BST card, and the other an LOS alarm on the OSC_CSM or OSCM card.

Step 5 In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on page 10-41.
b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.
c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Step 6
Create a loopback on the OSC-CSM card by connecting the LINE TX port to the LINE RX port using a patchcord and 10-dB bulk attenuator.

⚠️ Caution
Failure to use proper attenuation might damage equipment.

Step 7
Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the OSC-CSM card has cleared. The clearing of the LOS alarm indicates that the OSC link is active for this side of the shelf.

✏️ Note
An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect using only the patchcord.
b. In node view, click the Alarms tab. If the LOS alarm on the OSC-CSM card clears, continue with Step 8. If not, continue with Step c.
c. Display the OSC-CSM card in card view.
d. Click the Provisioning > Optical Line > Optics Thresholds tabs.
e. Under Types, click Alarm, then click Refresh.
f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to –30 dBm.
g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to –40 dBm.
h. Click Apply, and then Yes.
i. In node view, click the Alarms tab. If the LOS alarm on the OSC-CSM card clears, continue with Step 21. If not, replace the OSC-CSM card.

Step 8
If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. If you are using a TXP_MR_2.5G card, continue with Step 9.

a. Set the output power to a nominal value, such as –3 dBm.
b. Set the tuner to the wavelength under test, then continue with Step 11.

Step 9
If you are using a TXP_MR_2.5G card, complete the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4 for the TXP containing the wavelength you will test. Refer to Table 4-1 on page 4-4, if needed.

Step 10
Measure the TXP output power by connecting the TXP DWDM TX port to a test meter. Record the results for future reference.

Step 11
Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the OPT-BST LINE RX port using a 10-dB bulk attenuator.

⚠️ Caution
Failure to use proper attenuation might damage equipment.
Step 12 Display the OPT-BST in card view.

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 2 (Out Com) is equal to the optical power from the tunable laser or TXP_MR_2.5G card (measured in Step 10) +/- 1 dBm.

Step 14 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 15.

Step 15 Display the OSC-CSM card in card view.

Step 16 Click the Provisioning > Optical Line > Parameters tabs and locate the Port 3 Power value. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

Step 17 If an OPT-PRE card is installed on the same side as the OSC-CSM, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 18.

Step 18 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the OPT-BST card.

Step 19 Disconnect the TXP or tunable laser from the OPT-BST card.

Step 20 Remove the loopback fiber on the OSC-CSM card.

Step 21 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-41.

Step 22 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

Step 23 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Step 24 Create a loopback on the OPT-BST card by connecting the LINE TX port with LINE RX port using a patchcord and 10-dB bulk attenuator.

Step 25 Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the OPT-BST and OSCM cards have cleared. The clearing of the LOS alarms indicates that the OSC link is active for this side of the shelf.

Note An SDCC Termination Failure alarm will continue to appear due to the OSC signal loopback.

If the alarms clear, continue with Step 26. If not, perform the following steps:

a. Display the OPT-BST card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. Under Types, click Alarms, then click Refresh.

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to –30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to –40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarms on the OPT-BST card has cleared. If so, continue with Step 25. If not, disconnect the OSCM card from the OPT-BST.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the OSC RX port using a 10-dB bulk attenuator.
NTP-G47 Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test

Chapter 4 Perform Node Acceptance Tests

Perform the Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance Test

i. Wait 90 seconds, then in node view click the Alarms tab. Verify that the LOS alarm on the OSCM card has cleared. If so, replace the OPT-BST card. If not, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.

Step 26 Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Step 27 If an OPT-PRE is installed on the same side of the shelf as the OSC-CSM, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 27.

Step 28 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the OPT-BST card.

Step 29 Display the OSC-CSM card in card view.

Step 30 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 3 (Out Com) is equal to the optical power from the tunable laser or TXP_MR_2.5G card (measured in Step 10) +/- 1 dBm.

Step 31 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If not, continue with Step 32.

Step 32 Disconnect the TXP or tunable laser from the OSC-CSM card.

Step 33 Remove the loopback fiber on the OPT-BST amplifier card.

Step 34 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task on page 10-41.

Step 35 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to restore the original configuration.

Step 36 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

Stop. You have completed this procedure.
NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards

Purpose
This procedure checks the integrity of all the optical connections inside an OADM node with OSCM cards installed on both the east and west sides of the shelf. Three connection types are tested:

- Express
- Pass-through
- Add/Drop

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)
An optical power meter or optical spectrum analyzer
Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node.”

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2
From the View menu, choose Go to Network View.

Step 3
Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 4
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

Step 5
Check your Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands (including four channels at 100 GHz) configured in pass-through mode in either direction.

Note
Configuring a band in pass-through mode means that the band is dropped in one direction by an AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card on the opposite side in the same direction. The band is not terminated inside the node.

Step 6
If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band pass-through connections are verified separately.

Step 7
Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added channels configured in pass-through mode in either direction.
Perform Node Acceptance Tests

NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards

Chapter 4

Note
Configuring a channel in pass-through mode means that the channel is dropped in one direction by an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8
If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Channel pass-through connections are verified separately.

Step 9
Create a loopback on the west OPT-BST by connecting the LINE TX port to the LINE RX port using a patchcord and 10-dB bulk attenuator.

Step 10
Verify that the OSC link becomes active on the west OSCM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.) If the OSC link becomes active, continue with Step 11. If the OSC link does not turn up, complete the following steps:

a. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds tabs and change the Port 4 opwrMin (minimum power) to –40 dBm.

b. Modify the COM TX Fail Low Threshold. Change the Port 2 opwrMin (minimum power) to –30 dBm.

c. If the OSC link turns up, continue with Step 11. If the OSC link is still down, disconnect the OSCM card from the OPT-BST.

d. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the OSC RX port using a 10-dB bulk attenuator.

e. If the OSC link turns up, replace the OPT-BST card. If the OSC link does not turn up, replace the OSCM card.

Note
Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11
If the node has express bands or channels, complete the “DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM Cards” task on page 4-44. If the node does not have express bands or channels, continue with Step 12.

Step 12
If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the “DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-49. If not, continue with Step 13.

Step 13
If connections have add/drop connections, complete the “DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards” task on page 4-53.

Stop. You have completed this procedure.
NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM Cards

Purpose
This procedure checks the integrity of all the optical connections inside an OADM node with OSC-CSM and OPT-BST cards installed on both the east and west sides of the shelf. Three connection types are tested:
- Express
- Pass-through
- Add/Drop

Tools/Equipment
- A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)
- An optical power meter or optical spectrum analyzer
- 2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node.”

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2
From the View menu, choose Go to Network View.

Step 3
Click the Alarms tab.

   a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

   b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 4
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

Step 5
Check the Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands (including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note
Configuring a band in pass-through mode means that the band is dropped in one direction by an AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card on the opposite side in the same direction. The band is not terminated inside the node.

Step 6
If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band pass-through connections are verified separately.

Step 7
Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added channels configured in pass-through mode in either direction.
Chapter 4  Perform Node Acceptance Tests

NTP-G49 Perform the OADM Active Node Acceptance Test on a Symmetric Node with OSC-CSM Cards

Step 8  If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Channel pass-through connections are verified separately.

Step 9  Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port using a patchcord and a 10-dB bulk attenuator.

Step 10  Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Note  Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11  If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link becomes active, continue with Step 11. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to –30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card.

Step 12  If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections on an OADM Node with OSC-CSM Cards” task on page 4-46. If the node does not have express bands or channels, continue with Step 13.

Step 13  If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the “DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-49. If not, continue with Step 14.

Step 14  If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Cards” task on page 4-56.

Stop. You have completed this procedure.
NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM Cards

Purpose
This procedure checks the integrity of all the optical connections inside an OADM node with OSC-CSM cards and no OPT-BST cards installed on the east and west sides of the shelf. Three connection types are tested:

- Express
- Pass-through
- Add/Drop

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1)
An optical power meter or optical spectrum analyzer
2 bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures
Chapter 3, “Turn Up a Node.”

Required/As Needed
Required

Onsite/Remote
Onsite

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2
From the View menu, choose Go to Network View.

Step 3
Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear indicating equipment failure or other hardware problems. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 4
In node view, click the Provisioning > WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83.

Step 5
Check the Cisco MetroPlanner site configuration file to verify the presence of a dropped or added bands (including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note
Configuring a band in pass-through mode means that the band is dropped in one direction by an AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB x.xx card on the opposite side in the same direction. The band is not terminated inside the node.

Step 6
If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band pass-through connections are verified separately.

Step 7
Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added channels configured in pass-through mode in either direction.
NTP-G50 Perform the OADM Passive Node Acceptance Test on a Symmetric Node with OSC-CSM Cards

Chapter 4  Perform Node Acceptance Tests

Step 8  If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Channel pass-through connections are verified separately.

Step 9  Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port using a patchcord and 10-dB bulk attenuator.

Step 10  Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Note  Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 11  If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to –30 dBm.

d. If the OSC link turns up, continue with Step 13. If it does not turn up, replace the OSC-CSM card.

Step 12  If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections on an OADM Node with OSC-CSM Cards” task on page 4-46. If the node does not have express bands or channels, continue with Step 12.

Step 13  If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the “DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-49. If not, continue with Step 14.

Step 14  If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Cards” task on page 4-56.

Stop. You have completed this procedure.

Note  Configuring a channel in pass-through mode means that the channel is dropped in one direction by an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC xx.xx card on the opposite side in the same direction. The channel is not terminated inside the node.
DLP-G78 Verify the 32MUX-O Power

Purpose: This task verifies 32MUX-O power.
Tools/Equipment: None
Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Step 1: Display the 32MUX-O in card view.
Step 2: Click the Provisioning > Optical Chn > Parameters tabs.
Step 3: Change the Admin State of the correspondent port to OOS,MT (ANSI) or Locked,maintenance (ETSI).
Step 4: Check that the power value on the port reaches the provisioned setpoint (VOA Power Ref).
Step 5: Return to your originating procedure (NTP).

DLP-G79 Verify the OPT-BST Amplifier Laser and Power

Purpose: This task verifies that the OPT-BST amplifier laser is on and provisioned to the correct power.
Tools/Equipment: None
Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Step 1: In node view, double-click the OPT-BST amplifier to display the card view.
Step 2: Click the Maintenance > ALS tabs. If the value in the Currently Shutdown field is NO, continue with Step 3. If not, complete the following steps:
   a. Check the optical safety remote interlock (OSRI) setting. If it is set to On, change it to Off and click Apply.
   b. Check the Currently Shutdown field. If it changes to NO, continue with Step 3. If not, contact your next level of support. The amplifier might need to be replaced.
Step 3: Click the Provisioning > Opt Ampli Line > Parameters tabs.
Step 4: Click Reset.
Step 5: Scroll to the right and locate the Signal Output Power parameter for Port 6. Verify that the Signal Output Power value is greater than or equal to 1.5 dBm.
   If the Signal Output Power is not greater than or equal to 1.5 dBm, do not continue. Begin troubleshooting or contact your next level of support.
DLP-G80 Verify the OPT-PRE Amplifier Laser and Power

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task verifies that the OPT-PRE amplifier laser is on and provisioned to the correct power.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

Step 1 In node view, double-click the OPT-PRE amplifier to display the card view.

Step 2 Click the Maintenance > ALS tabs.

Step 3 If the value shown in the Currently Shutdown field is NO, continue with Step 4. If not, complete the following steps:
   a. If the OSRI setting is set to ON, click the table cell and choose OFF from the drop-down list.
   b. Click Apply.

Step 4 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 5 Locate the Signal Output Power parameter for Port 2. Verify that the Signal Output Power value is greater than or equal to 1.5 dBm. If the optical power is greater than or equal to 1.5 dBm, continue with Step 6. If the optical power is less than 1.5 dBm, check your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25. If this does not change the power value, consult your next level of support.

Step 6 Scroll to the right to locate the DCU Insertion Loss parameter. Verify that the DCU Insertion Loss value is less than or equal to 10 dB.

Step 7 Return to your originating procedure (NTP).
DLP-G269 Verify the 32DMX-O Power

Purpose
This task verifies that the 32DMX-O card is provisioned to the correct power.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Display the 32DMX-O card in card view.

Step 2
Click the Provisioning > Optical Chn > Parameters tabs.

Step 3
Change the Admin State for the appropriate port to OOS,DSLB (ANSI) or Locked,disabled (ETSI).

Step 4
Verify that the VOA Power Ref reaches the provisioned setpoint.

Step 5
(Optional) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the physical optical power value coming from drop Port 1 on the west 32DMX-O card is consistent with the value read (the maximum allowed error is +/- 0.5 dBm).

Step 6
Return to your originating procedure (NTP).

DLP-G270 Verify the 32DMX Power

Purpose
This task verifies that the 32DMX card is provisioned to the correct power.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Display the 32DMX card in card view.

Step 2
Click the Provisioning > Optical Chn > Parameters tabs.

Step 3
Change the Admin State for Port 33 to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 4
Verify that the VOA Power Ref reaches the provisioned setpoint.

Step 5
(Optional) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the physical optical power value coming from drop Port 1 on the west 32DMX card is consistent with the value read (the maximum allowed error is +/- 1 dBm).

Step 6
Change the Admin State for Port 1 to OOS,DSLB (ANSI) or Locked,disabled (ETSI).

Step 7
Return to your originating procedure (NTP).
DLP-G82 Verify the OSC-CSM Power

**Purpose**
This task verifies the OSC-CSM card power.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
Display the OSC-CSM card in card view.

**Step 2**
Click the **Provisioning > Optical Line > Parameters** tabs.

**Step 3**
If an OPT-PRE is not installed on the same side of the shelf as the OSC-CSM, verify that the Port 3 Power value is higher than the default no-power value of –30 dBm. If the power is not higher than –30 dBm, contact your next level of support.

**Step 4**
Return to your originating procedure (NTP).

---

DLP-G83 Verify the OSC-CSM Power on OADM Nodes

**Purpose**
This task verifies the OSC-CSM card power on OADM nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
Display the OSC-CSM card in card view.

**Step 2**
Click the **Provisioning > Optical Line > Parameters** tabs.

**Step 3**
Verify that the Power value for Port 3 is higher than the default no-power value of –30 dBm. The calculated expected power value for Port 3 is:

\[ P_{out \ COM \ TX \ of \ last \ AD-xy-xx.x \ - \ IL02 \ OSC-CSM \ (COM \ RX > LINE \ TX) \ - \ 10 \ dB \ (bulk \ attenuator) \]

**Step 4**
Double-check the value.

**Note**
Actual output power is affected by many factors. Always consider the calculated expected power to be a general guideline and not a precise value.

**Step 5**
Return to your originating procedure (NTP).
DLP-G84 Verify the OSC-CSM Incoming Power

**Purpose**
This task verifies the OSC-CSM card incoming power.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G84 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
Display the OSC-CSM card in card view.

**Step 2**
Click the **Provisioning > Optical Line > Parameters** tabs.

**Step 3**
Verify that the Power value for Port 2 is higher than the default no-power value of –30 dBm. The calculated expected power value for Port 2 is:

\[ P_{\text{out COM TX of OPT-PRE}} = +2 \text{ dBm} \]

**Note**
Actual output power is affected by many factors. Always consider the calculated expected power to be a general guideline and not a precise value.

**Step 4**
Return to your originating procedure (NTP).

---

DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM Cards

**Purpose**
This task verifies the express channel connections during an OADM node acceptance test.

**Tools/Equipment**
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Superuser

---

**Step 1**
If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue with **Step 2**.

**Step 2**
Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the east OPT-BST LINE RX port.
Step 3  Based on the Cisco MetroPlanner site configuration file, tune the tunable laser of TXP_MR_2.5G card to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and AD-xC-xx.x cards on the east-to-west and west-to-east directions. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 4  If an OPT-PRE card is installed on the east side, insert a 10-dB bulk attenuator on the COM RX port and complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If an OPT-PRE card is not installed on the east side, continue with Step 5.

Step 5  If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x Output Express Power” task on page 4-47 for each east side card. If not, continue with Step 6.

Note  If AD-xB-xx.x and AD-xC-xx.x cards are both installed in one direction, the received express channels will run into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 6  If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x Output Express Power” task on page 4-47 for each east side card. If not, continue with Step 7.

Step 7  If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G271 Verify the AD-xC-xx.x Output Common Power” task on page 4-48 for each west side card. If not, continue with Step 8.

Step 8  If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G272 Verify the AD-xB-xx.x Output Common Power” task on page 4-48 for each west side card. If not, continue with Step 9.

Step 9  Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the OPT-BST installed on the east side.

Step 10  If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41. If an OPT-PRE card is not installed, continue with Step 11.

Step 11  Repeat Steps 5 through 8 for the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.

Step 12  Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 for the OPT-BST installed on the east side.

Step 13  Return to the originating procedure (NTP).
DLP-G86 Verify Express Channel Connections on an OADM Node with OSC-CSM Cards

Purpose
This task verifies the express channel connections during an OADM node acceptance test.

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Step 1
If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue with Step 2.

Step 2
Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the LINE RX port of the east OSC-CSM card.

Step 3
If an OPT-PRE amplifier card is installed on the east side, install a 10-dB bulk attenuator on the COM RX port.

Step 4
Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and AD-xC-xx.x cards on the east-to-west and west-to-east directions. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 5
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 for the OPT-PRE amplifier card installed on the west side.

Step 6
If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x Output Express Power” task on page 4-47 for each east side card. If not, continue with Step 7.

Note
If Ad-xB-xx.x and AD-xC cards are both installed in one direction, the received express channels will run into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 7
If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x Output Express Power” task on page 4-47 for each east side card. If not, continue with Step 8.

Step 8
If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G271 Verify the AD-xC-xx.x Output Common Power” task on page 4-48 for each west side card. If not, continue with Step 9.

Step 9
If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G272 Verify the AD-xB-xx.x Output Common Power” task on page 4-48 for each west side card. If not, continue with Step 10.

Step 10
Complete the “DLP-G83 Verify the OSC-CSM Power on OADM Nodes” task on page 4-43 for the OSC-CSM card installed on the west side.

Step 11
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 for the OPT-PRE card installed on the east side.

Step 12
Repeat Steps 6 through 9 for the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.
Step 13 Complete the “DLP-G83 Verify the OSC-CSM Power on OADM Nodes” task on page 4-43 for the OSC-CSM card installed on the west side.

Step 14 Return to your originating procedure (NTP).

---

**DLP-G87 Verify the AD-xB-xx.x Output Express Power**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task verifies the output express power of AD-xB-xx.x cards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

Step 1 Display the AD-xB-xx.x card in card view.
Step 2 Click the Provisioning > Optical Line > Parameters tabs.
Step 3 Change the Output Express port Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.
Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –28 dBm.
Step 5 Return to your originating procedure (NTP).

---

**DLP-G88 Verify the AD-xC-xx.x Output Express Power**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task verifies the output express power of the AD-xC-xx.x cards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

Step 1 Display the AD-xC-xx.x card in card view.
Step 2 Click the Provisioning > Optical Line > Parameters tabs.
Step 3 Change the Output Express port Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.
Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –30 dBm.
Step 5 Return to your originating procedure (NTP).
DLP-G271 Verify the AD-xC-xx.x Output Common Power

**Purpose**
This task verifies the output common power of the AD-xC-xx.x cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
Display the AD-xC-xx.x card in card view.

**Step 2**
Click the Provisioning > Optical Line > Parameters tabs.

**Step 3**
Verify that the Output Com port Power value is greater than the default no-power value of –30 dBm.

**Step 4**
Return to your originating procedure (NTP).

---

DLP-G272 Verify the AD-xB-xx.x Output Common Power

**Purpose**
This task verifies the output common power of the AD-xB-xx.x cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
Display the AD-xB-xx.x card in card view.

**Step 2**
Click the Provisioning > Optical Line > Parameters tabs.

**Step 3**
Verify that the Output Com port Power value is greater than the default no-power value of –28 dBm.

**Step 4**
Return to your originating procedure (NTP).
DLP-G89 Verify OADM Node Pass-Through Channel Connections

Purpose
This task verifies the pass-through channel connections during an OADM node acceptance test.

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Superuser

Step 1
Identify the first band connection configured in pass-through mode in both directions.

Step 2
Set the tunable laser or TXP_MR_2.5G card to the wavelength of the band to be tested. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 3
Complete the “DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power” task on page 4-50 for the first pass-through connection.

Step 4
(Optional) Complete one of the following:
- If OSCM cards are installed, connect a power meter to the east OPT-BST LINE TX port and verify that the east amplifier is turned on by the pass-through wavelength.
- If OSC-CSM cards are installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” task on page 4-44 for the east OSC-CSM card.

Step 5
Complete Steps 2 through 4 for all band connections configured in pass-through mode in both directions.

Step 6
If channel pass-through connections are not present, continue with Step 15. If channel pass-through connections are present, continue with one of the following steps:
- If the pass-through channel connections use an AD-xC-xx.x card, continue with Step 7.
- If the pass-through channel connections use a 4MD-xx.x card, continue with Step 11.

Step 7
Tune the tunable laser on a wavelength (1 of 4) belonging to the channel to be tested.

Step 8
Complete the “DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection” task on page 4-51 for the first pass-through connection.

Step 9
(Optional) Complete one of the following:
- If an OSCM card is installed, connect a power meter to LINE TX port on the front-pane and verify that the east OPT-BST amplifier is turned on by the pass-through wavelength.
- If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” task on page 4-44 for the east OSC-CSM card.

Step 10
If the pass-through connections use a 4-channel multiplexer/demultiplexer (4MD-xx.x), continue with Step 11. If not, continue with Step 15.

Step 11
Identify the first channel connection that is configured in pass-through mode using the 4MD-xx.x cards in both directions.

Step 12
Tune the tunable laser on the corresponding wavelength.

Step 13
Complete the “DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power” task on page 4-52.
Step 14  (Optional) Perform one of the following:
- If an OSCM card is installed, connect a power meter to LINE TX port on the card front panel and verify that the east OPT-BST amplifier is turned on by the pass-through wavelength.
- If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” task on page 4-44 for the east OSC-CSM card.

Step 15  Return to your originating procedure (NTP).

DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power

Purpose  This task verifies an AD-xB-xx.x pass-through connection.
Tools/Equipment  None
Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Superuser

Step 1  Verify the east AD-xB-xx.x band TX power:
  a. Display the east AD-xB-xx.x card in card view.
  b. Click the Provisioning > Optical Band > Parameters tabs.
  c. Change the Admin State of the BAND TX (east-to-west) port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.
  d. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 2  Verify the west AD-xB-xx.x card RX and TX power:
  a. Display the west AD-xB-xx.x card in card view.
  b. Click the Provisioning > Optical Band > Parameters tabs.
  c. Verify that the Power value of the BAND RX (east-to-west) port is higher than the default no-power value of –30 dBm.
  d. Change the Admin State of the BAND TX (west-to-east) port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.
  e. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 3  Verify the band RX port on the east AD-xB-xx.x card:
  a. Display the east AD-xB-xx.x card in card view.
  b. Click the Provisioning > Optical Band > Parameters tabs.
  c. Verify that the Power value of the BAND RX (west-to-east) port is higher than the default no-power value of –30 dBm.

Step 4  Return to your originating procedure (NTP).
DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection

Purpose
This task verifies an AD-xC-xx.x pass-through connection.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Verify the east AD-xC-xx.x channel TX power:

a. Display the east AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value for the CHAN TX port is higher than the default no-power value of –35 dBm.

d. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed along the drop path and needs to be activated in Step e.

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

f. Verify that the power value of the CHAN TX port is higher than the default no-power value of –35 dBm.

Step 2
Verify the channel power for the corresponding west AD-xC-xx.x card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value of the CHAN TX port is higher than the default no-power value of –35 dBm.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power Ref).

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

f. If the AD-xC-xx.x is an AD-4C-W card, a VOA (applying to all four channels) is installed along the drop path and needs to be activated in Step g.

g. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

h. Verify that the power value of the CHAN TX port is higher than the default no-power value of –35 dBm.

Step 3
Verify the east AD-xC-xx.x channel RX power:

a. Display the east AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) for the channel related to the wavelength selected on the tunable laser.
DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power

Purpose
This task verifies 4MD-xx.x pass-through connection.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Verify the TX band power on the related east AD-xB-xx.x card:

a. Display the east AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 2
Verify the TX power on the related east 4MD-xx.x (east-to-west) card:

a. Display the east 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of –35 dBm.

Step 3
Verify the RX band power on the west AD-xB-xx.x card (east-to-west):

a. Display the west Ad-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the BAND RX Power value is higher than the default no-power values of –30 dBm.

Step 4
Verify the west 4MD-xx.x (east-to-west):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power Ref).

Step 5
Verify the TX band power on the west AD-xB-xx.x (west-to-east):

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.
c. Change the Admin State of the BAND TX port to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) for the channel related to the wavelength selected on the tunable laser.

**Step 6** Verify the west 4MD-xx.x (west-to-east):

a. Display the west 4MD-xx.x card in card view.
b. Click the **Provisioning > Optical Chn > Parameters** tabs.
c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of –35 dBm.

**Step 7** Verify the east 4MD-xx.x (west-to-east):

a. Display the east 4MD-xx.x card in card view.
b. Click the **Provisioning > Optical Chn > Parameters** tabs.
c. Change the Admin State of the CHAN RX port to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) for the channel related to the wavelength selected on the tunable laser.
d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power Ref).

**Step 8** Return to your originating procedure (NTP).

---

**DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards**

**Purpose**

This task verifies the add and drop channel connections for an OADM node with OSCM cards installed.

**Tools/Equipment**

A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite

**Security Level**

Superuser

---

**Note**

In this task, you will verify add and drop connections in the following order: east-to-west add and west-to-east drop, Steps 1 through 15; west-to-east add and east-to-west drop, Steps 16 through 17.

---

**Step 1**

Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of the first west AD-xC-xx.x or west 4MD-xx.x card on the east-to-west direction. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

**Step 2**

Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the corresponding 15xx.x RX port (on the card front panel) of the west AD-xC-xx.x or 4MD-xx.x card.

**Step 3**

Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):

a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.
b. Click the **Provisioning > Optical Chn > Parameters** tabs.

c. Change the Admin State of the CHAN RX port to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) for the channel related to the wavelength chosen on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power Ref).

**Step 4**

Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-40 on the west OPT-BST amplifier to verify that the added wavelength turns on the laser.

**Step 5**

If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an AD-xC-xx.x card, move to Step 10.

**Step 6**

Verify the RX band port on the west AD-xB-xx.x card:

a. Display the west AD-xB-xx.x card in card view.

b. Click the **Provisioning > Optical Band > Parameters** tabs.

**Step 7**

Verify that the BAND RX Power value is higher than the default no-power values of –30 dBm.

**Step 8**

Verify band TX port on the west AD-xB-xx.x (west-to-east):

a. Display the west AD-xB-xx.x card in card view.

b. Click the **Provisioning > Optical Band > Parameters** tabs.

c. Change the Admin State of the BAND TX port to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of –30 dBm.

**Step 9**

Verify the west 4MD-xx.x card (west-to-east):

a. Display the west 4MD-xx.x card in card view.

b. Click the **Provisioning > Optical Chn > Parameters** tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of –30 dBm.

**Step 10**

Verify the west AD-xC-xx.x (west-to-east) card:

a. Display the west AD-xC-xx.x card in card view.

b. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed along the drop path and needs to be activated according to Step g.

c. Click the **Provisioning > Optical Chn > Parameters** tabs.

d. Verify that the Power value of the CHAN TX port is higher than the default no-power value of –35 dBm.

e. Display the east AD-xC-xx.x card in card view.

f. Click the **Provisioning > Optical Chn > Parameters** tabs.

g. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable laser or TXP_MR_2.5G card to **OOS,MT** (ANSI) or **Locked,maintenance** (ETSI). Click **Apply**.

h. Verify that the power value for the CHAN TX port is higher than the default no-power value of –35 dBm.

i. Perform the output power check.
Chapter 4  Perform Node Acceptance Tests

DLP-G33 Verify Add and Drop Connections on an OADM Node with OSCM Cards

Step 11  (Optional) Connect a power meter to the proper 15xx.x TX port on the front panel (the dual port compared with the port where the tunable laser or TXP_MR_2.5G card is connected). Verify that the physical optical power value from that port is consistent with the value displayed on the Provisioning > Optical Chn > Parameters tab for the proper CHAN TX power value, +/- 0.5 dB.

Step 12  Repeat Steps 8 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the east-to-west direction.

Step 13  Remove the loopback on the west OPT-BST amplifier and create a loopback on the east OPT-BST amplifier.

Step 14  Verify that the OSC link becomes active on the east OSCM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.) If the OSC link becomes active, continue with Step 15. If the OSC link does not become active, perform the following steps:

a. Modify the OSC Fail Low thresholds by clicking the Provisioning > Optical Line > Optics Thresholds tabs and changing the Port 2 opwrMin (minimum power) to –40 dBm.

b. If the OSC link turns up, continue with Step 15. If the OSC link remains down, disconnect the OSCM card from the OPT-BST.

c. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the OSC RX port using a 10-dB bulk attenuator.

d. If the OSC link turns up, replace the OPT-BST card. If the OSC link does not turn up, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.

Note  Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 15  Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x-E or 4MD-xx.x-E card on the west-to-east direction. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 16  Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the correspondent 15xx.x RX port (on the card front panel) of the east AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 17  Repeat Steps 3 through 15, applying the steps to the west-to-east direction.

Step 18  Remove the loopback connection and Restore the default administrative state (IS,AINS or Unlocked,automaticInService) on all the ports previously set to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 19  Launch Automatic Node Setup (ANS) to recover the correct node configuration.

Step 20  Return to your originating procedure (NTP).
DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Cards

Purpose
This task verifies the add and drop channel connections for an OADM node with OSC-CSM cards installed.

Tools/Equipment
A tunable laser or eight TXP_MR_2.5G cards covering the 32 C-band wavelengths (see Table 4-1 on page 4-4)

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Superuser

Note
In this task, you will verify add and drop connections in the following order: east-to-west and west-to-east drop: Steps 1 through 15; west-to-east add and east-to-west drop: Steps 16 through 17.

Step 1
Based on the Cisco MetroPlanner site configuration file, tune the tunable laser or TXP_MR_2.5G card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path of the first west AD-xC-xx.x or west 4MD-xx.x card on the east-to-west direction. Refer to the tunable laser manufacturer’s documentation or the “DLP-G268 Provision TXP_MR_2.5G Cards for Acceptance Testing” task on page 4-4.

Step 2
Connect the tunable laser transmitter or the TXP_MR_2.5G card DWDM TX port to the corresponding 15xx.x RX port (on the card front panel) of the west AD-xC-xx.x or 4MD-xx.x card.

Step 3
Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):
   a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.
   b. Click the Provisioning > Optical Chn > Parameters tabs.
   c. Change the Admin State of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) for the channel related to the wavelength selected on the tunable laser.
   d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power Ref).

Step 4
Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-41 on the west OPT-PRE amplifier to verify that the added wavelength turns on the laser.

Step 5
If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an AD-xC-xx.x card, move to Step 10.

Step 6
Verify the west AD-xB-xx.x:
   a. Display the west AD-xB-xx.x card in card view.
   b. Click the Provisioning > Optical Band > Parameters tabs.
   c. Change the Admin State of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance (ETSI) for the channel related to the wavelength selected on the tunable laser.
   d. Verify that the Power value of the BAND TX port is higher than the default no-power value of –30 dBm.

Step 7
Display the related AD-xB-xx.x card (west-to-east direction) in card view.
Step 8 Change the administrative state of the drop BAND TX port related to the wavelength selected on the tunable laser to OOS,MT.

Step 9 (Optional) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port compared with the port where the tunable laser is connected). Verify that the physical optical power value from that port is consistent with the value displayed on the Provisioning > Optical Chn > Parameters tab for the proper CHAN TX power value, +/- 0.5 dB.

Step 10 Verify the west AD-xC-xx.x (west-to-east) card:
   a. Display the west AD-xC-xx.x card in card view.
   b. Click the Provisioning > Optical Chn > Parameters tabs.
   c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of –35 dBm.
   d. Display the east AD-xC-xx.x card in card view.
   e. Click the Provisioning > Optical Chn > Parameters tabs.
   f. Verify that the power value for the CHAN TX port is higher than the default no-power value of –35 dBm.
   g. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed along the drop path and needs to be activated in Step h.
   h. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable laser to OOS,MT (ANSI) or Locked, maintenance (ETSI). Click Apply.
   i. Perform the output power check.

Step 11 (Optional) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port compared with the port where the tunable laser is connected). Verify that the physical optical power value from that port is consistent with the value on Provisioning > Optical Chn > Parameters tab for the proper CHAN TX power value, +/- 0.5 dB.

Step 12 Repeat Steps 8 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the east-to-west direction.

Step 13 Remove the loopback on the west OSC-CSM card.

Step 14 In node view, click the Provisioning > WDM-ANS > Port Status tabs.

Step 15 Click Launch ANS.

Step 16 Create a loopback on the east OSC-CSM card by connecting the OSC-CSM LINE RX and LINE TX ports using a patchcord and 10-dB bulk attenuator.

Step 17 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.)

Note Due to the OSC signal loopback, an SDCC Termination Failure alarm might be raised.

Step 18 If the OSC link becomes active, continue with Step 19. If the OSC link does not turn up, perform the following troubleshooting steps:
   a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link becomes active, continue with Step 19. If not, continue with Step b.
   b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.
c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to –30 dBm.

d. If the OSC link turns up, continue with Step 19. If it does not turn up, replace the OSC-CSM card.

Step 19
Check the site configuration file from Cisco MetroPlanner and identify the wavelength (belonging to the 100 Ghz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x-E or 4MD-xx.x-E card on the west-to-east direction.

Step 20
Connect the tunable laser to the correspondent 15xx.x RX port (on the card front panel) of the east AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 21
Repeat Steps 3 through 20, applying the steps to the west-to-east direction.

Step 22
Restore the default administrative state (IS,AINS/Unlocked,automaticInService) on all the ports previously set to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23
Launch ANS to recover the correct node configuration.

Step 24
Return to your originating procedure (NTP).
Provision Transponder and Muxponder Cards

This chapter explains how to provision transponder (TXP) and muxponder (MXP) cards. The provisioning must be performed before you provision the dense wavelength division multiplexing (DWDM) network and create circuits.

**Note**

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

**Before You Begin**

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide as necessary.

**Caution**

Provisioning TXPs and MXPs can be service affecting. You should make all changes during a scheduled maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. **NTP-G128 Manage Pluggable Port Modules, page 5-2**—Complete this procedure to provision a multirate pluggable port module (PPM), provision or change the optical line rate of a PPM, or delete a PPM. PPMs provide the fiber interface to the TXP and MXP cards. With the exception of the TXP_MR_10G card, all TXPs and MXP accept PPMs.

2. **NTP-G33 Create a Y-Cable Protection Group, page 5-10**—Complete this procedure, as needed, for TXP and MXP cards that will be protected with Y-cable protection.

3. **NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards, page 5-12**—As needed, complete this procedure to change the transmission settings for TXP_MR_10G and TXP_MR_10E cards.

4. **NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-31**—As needed, complete this procedure to change the transmission settings for MXP_2.5G_10G and MXP_2.5G_10E cards.

5. **NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_M_2.5G Cards, page 5-48**—As needed, complete this procedure to change the transmission settings for TXP_MR_2.5G and TXPP_MR_2.5G cards.
6. **NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-65**—As needed, complete this procedure to change the transmission settings for MXP_MR_2.5G and MXPP_MR_2.5G cards.

**NTP-G128 Manage Pluggable Port Modules**

**Purpose**
Complete this procedure to provision a multirate PPM, provision or change the optical line rate of a multirate PPM, or delete a PPM. If a single-rate PPM is installed, the PPM screen will autoprovion and no further steps are necessary.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G63 Install an SFP or XFP, page 3-45

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Note**
The hardware device that plugs into a TXP or MXP card faceplate to provide a fiber interface to the card is called a Small Form-factor Pluggable (SFP). In Cisco Transport Controller (CTC), SFPs are called PPMs.

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into an ONS 15454 on the network. If you are already logged in, continue with Step 2.

**Step 2**
Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no unexplained conditions appear on the network. If unexplained conditions appear, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

c. Complete the “DLP-G114 Export CTC Data” task on page 8-4 to export alarm and condition information.

**Step 3**
Complete the “DLP-G277 Provision a Multirate PPM” task on page 5-3. If you preprovisioned a multirate PPM (DLP-G273 Preprovision an SFP or XFP Slot, page 3-46), skip this step and continue with Step 4. Single-rate PPMs do not require provisioning.

**Step 4**
If you are provisioning an IBM External Time Reference – Control Link Oscillator (ETR_CLO) or InterSystem Coupling link (ISC) service on the PPM, complete “DLP-G274 Verify Topologies for ETR_CLO and ISC Services” task on page 5-4. Otherwise, continue with Step 5.

**Step 5**
Complete the “DLP-G278 Provision the Optical Line Rate” task on page 5-6 to assign a line rate to a TXP or MXP port.

**Step 6**
Complete the “DLP-G279 Change the Optical Line Rate” task on page 5-8 as needed. Table 5-1 on page 5-7 lists the available rates for each TXP and MXP card.

**Step 7**
Complete the “DLP-G280 Delete a PPM” task on page 5-8 as needed.

Stop. You have completed this procedure.
DLP-G277 Provision a Multirate PPM

Purpose
This task provisions a multirate PPM in CTC. If the PPM was preprovisioned using the “DLP-G273 Preprovision an SFP or XFP Slot” task on page 3-46, or the SFP or XFP is physically installed, this task is unnecessary unless the PPM has an Out-of-Service and Autonomous Management, Unassigned (OOS-AUMA,UAS) (ANSI) or unlocked-disabled, unassigned (ETSI) service state.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

---

Step 1
In node view, double-click the TXP or MXP card where you want to provision PPM settings.

Step 2
Click the Provisioning > Pluggable Port Modules tabs.

Step 3
In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4
In the Create PPM dialog box, complete the following:
- PPM—Choose the slot number where the SFP is installed from the drop-down list.
- PPM Type—Choose the number of ports supported by your SFP from the drop-down list. If only one port is supported, PPM (1 port) is the only option.

Note
The first port can be created only if the trunk is in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service state (ANSI) (or the Locked-enabled,disabled service state [ETSI]).

Step 5
Click OK. The newly created port appears on the Pluggable Port Modules area. The row on the Pluggable Port Modules area turns white and the Actual Equipment Type column lists the equipment name.

Step 6
Verify that the PPM appears in the list on the Pluggable Port Modules area. If it does not, repeat Steps 3 through 5.

Step 7
Repeat the task to provision a second PPM.

Step 8
Return to your originating procedure (NTP).
DLP-G274 Verify Topologies for ETR_CLO and ISC Services

**Purpose**
This task verifies that the DWDM network topology can support the IBM ETR_CLO and ISC services. These services cannot be provisioned on all DWDM topologies.

**Tools/Equipment**
Cisco MetroPlanner site plan.

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
Display your site plan in Cisco MetroPlanner.

**Step 2**
Verify that the topology where you plan to run the ETR_CLO or ISC service is one of the topologies that supports these services:

- Single span—Two terminal sites with no intermediate sites in between and the following cards installed:
  - 32MUX-O and 32DMX-O cards
  - 32WSS and 32DMX cards
  - 32WSS and 32-DMX-O cards

  Figure 5-1 shows a single-span topology as displayed in Cisco MetroPlanner.

  **Figure 5-1 Single-Span Topology**

- Point-to-Point—Two terminal sites with the following cards installed:
  - 32MUX-O and 32DMX-O cards
  - 32WSS and 32DMX cards
  - 32WSS and 32-DMX-O cards

  Line amplifiers can be installed between the terminal sites, but intermediate (traffic terminating) sites cannot be installed. Figure 5-2 shows a point-to-point topology as shown in Cisco MetroPlanner.

  **Figure 5-2 Point-to-Point Topology**
Two hubs—Two hub nodes in a ring with the following cards installed:

- 32MUX-O and 32DMX-O cards
- 32WSS and 32DMX cards
- 32WSS and 32-DMX-O cards

Line amplifiers can be installed between the hubs. Figure 5-3 shows two hub nodes with no line amplifier nodes installed. Figure 5-4 shows two hub nodes line amplifier nodes installed.

**Figure 5-3  Hubs with No Line Amplifiers**

**Figure 5-4  Hubs with Line Amplifiers**

**Step 3** Return to your originating procedure (NTP).
DLP-G278 Provision the Optical Line Rate

**Purpose**
This task provisions the line rate on a multirate PPM. Single-rate PPMs do not need to be provisioned.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G277 Provision a Multirate PPM, page 5-3
DLP-G274 Verify Topologies for ETR_CLO and ISC Services, page 5-4, if you are provisioning an ETR_CLO service.
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
Required

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, double-click the TXP or MXP card where you want to provision PPM ports. If the data rate you are provisioning is DV-6000, HDTV, ESCON, SDI/D1 Video, ISC-3, or ETR_CLO, complete the following steps. Otherwise, continue with **Step 2**.

   a. Click the **Provisioning > OTN > OTN Lines** tabs.
   b. In the G.709 OTN field, choose **Disable**.
   c. In the FEC field, choose **Disable**.
   d. Click **Apply**.

**Step 2**
Click the **Provisioning > Pluggable Port Modules** tabs.

**Step 3**
In the Pluggable Ports area, click **Create**. The Create Port dialog box appears.

**Step 4**
In the Create Port dialog box, complete the following:

   - **Port**—Choose the PPM number and port number from the drop-down list. The first number indicates the PPM and the second number indicates the port number on the PPM. For example, the first PPM with one port displays as 1-1 and the second PPM with one port displays as 2-1. The PPM number can be 1 to 4, but the port number is always 1.

   - **Port Type**—Choose the type of port from the drop-down list. The port type list displays the supported port rates on your PPM. See Table 5-1 for definitions of the supported rates on the TXP or MXP card.

**Step 5**
Click **OK**. The row on the Pluggable Ports area turns light blue until the actual SFP is installed, and then the row turns white.

**Step 6**
Repeat Steps 3 through 5 to configure the port rates as needed.
Table 5-1  

<table>
<thead>
<tr>
<th>Card</th>
<th>Port Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP_MR_2.5G and TXPP_MR_2.5G</td>
<td>• OC-3/STM1—155 Mbps</td>
</tr>
<tr>
<td></td>
<td>• OC-12/STM4—622 Mbps</td>
</tr>
<tr>
<td></td>
<td>• OC-48/STM16—2.48 Gbps</td>
</tr>
<tr>
<td></td>
<td>• ONE_GE—One Gigabit Ethernet 1.125 Gbps</td>
</tr>
<tr>
<td></td>
<td>• ESCON—Enterprise System Connection (IBM signal)</td>
</tr>
<tr>
<td></td>
<td>• DV6000—Proprietary signal from video vendor</td>
</tr>
<tr>
<td></td>
<td>• SDI_D1_VIDEO—Serial Digital Interface and Digital Video signal type 1</td>
</tr>
<tr>
<td></td>
<td>• HDTV—High Definition Television</td>
</tr>
<tr>
<td></td>
<td>• PASS-THRU—Not specified</td>
</tr>
<tr>
<td></td>
<td>• FC1G—Fibre Channel 1.06 Gbps</td>
</tr>
<tr>
<td></td>
<td>• FC2G—Fibre Channel 2.125 Gbps</td>
</tr>
<tr>
<td></td>
<td>• FICON1G—Fiber CON 1.06 Gbps (IBM signal)</td>
</tr>
<tr>
<td></td>
<td>• FICON2G—Fiber CON 2.125 Gbps (IBM signal)</td>
</tr>
<tr>
<td></td>
<td>• ETR_CLO—External Time Reference – Control Link Oscillator</td>
</tr>
<tr>
<td>MXP_2.5G_10G and MXP_2.5G_10E</td>
<td>• OC-48/STM16—2.48 Gbps</td>
</tr>
<tr>
<td>TXP_MR_10E</td>
<td>• OC-192/STM-64—10 Gbps</td>
</tr>
<tr>
<td></td>
<td>• 10G Ethernet LAN Phy—10 Gbps Ethernet</td>
</tr>
<tr>
<td></td>
<td>• 10G Fibre Channel—10 Gbps Fibre Channel</td>
</tr>
<tr>
<td>MXP_MR_2.5G and MXPP_MR_2.5G</td>
<td>• FC1G—Fibre Channel 1.06 Gbps</td>
</tr>
<tr>
<td></td>
<td>• FC2G—Fibre Channel 2.125 Gbps</td>
</tr>
<tr>
<td></td>
<td>• FICON1G—Fiber CON 1.06 Gbps (IBM signal)</td>
</tr>
<tr>
<td></td>
<td>• FICON2G—Fiber CON 2.125 Gbps (IBM signal)</td>
</tr>
<tr>
<td></td>
<td>• ONE_GE—One Gigabit Ethernet 1.125 Gbps</td>
</tr>
</tbody>
</table>

Note  The TXP_MR_10G card is the only TXP or MXP card that does not accept PPMs.

Step 7  Return to your originating procedure (NTP).
DLP-G279 Change the Optical Line Rate

Purpose: This task edits PPM port rates for the TXP and MXP cards. Perform this task if you want to change the port rate on a multirate PPM that is already provisioned.

Tools/Equipment: None

Prerequisite Procedures:
- DLP-G277 Provision a Multirate PPM, page 5-3
- DLP-G46 Log into CTC, page 2-25

Required/As Needed: As needed

Onsite/Remote: Onsite or remote

Security Level: Provisioning or higher

Step 1: In node view, double-click the TXP or MXP card where you want to edit the PPM port rate.
Step 2: Click the Provisioning > Pluggable Port Modules tabs.
Step 3: Click the port with the port rate you want to change in the Pluggable Ports area. The highlight changes to dark blue.
Step 4: Click Edit. The Edit Port Rate dialog box appears.
Step 5: In the Change To field, use the drop-down list to select the new port rate and click OK. Table 5-1 on page 5-7 lists the available rates.
Step 6: Click Yes in the Confirm Port Rate Change dialog box.
Step 7: Return to your originating procedure (NTP).

DLP-G280 Delete a PPM

Purpose: This task deletes PPM provisioning for SFPs or XFPs installed on TXP or MXP cards.

Tools/Equipment: None

Prerequisite Procedures:
- DLP-G46 Log into CTC, page 2-25
- DLP-G63 Install an SFP or XFP, page 3-45 or DLP-G273 Preprovision an SFP or XFP Slot, page 3-46

Required/As Needed: As needed

Onsite/Remote: Onsite or remote

Security Level: Provisioning or higher

Note: This task does not apply to the TXP_MR_10G card.

Step 1: In node view, double-click the TXP or MXP card where you want to delete PPM settings.
Step 2: Click the Provisioning > Pluggable Port Modules tabs.
Step 3  To delete a PPM and the associated ports:

Note  You cannot delete a port if the client is in the In Service and Normal (IS-NR) (ANSI) or Unlocked-enabled (ETSI) service state, is part of a protection group, has a generic communications channel (GCC) or data communications channel (DCC) in use, is used as a timing source, has circuits, or has overhead circuits. You can delete a port if the trunk is in service and the client is in the OOS-MA,DSBLD (ANSI)/Locked-enabled,disabled (ETSI) service state, with the exception of the last port. You can delete the last port only if the trunk is in a OOS-MA,DSBLD (ANSI)/Locked-enabled,disabled (ETSI) service state.

a. Click the PPM line that you want to delete that appears in the Pluggable Port Modules area. The highlight changes to dark blue.

b. Click Delete. The Delete PPM dialog box appears.

c. Click Yes. The PPM provisioning is removed from the Pluggable Port Modules area and the Pluggable Ports area.

Step 4  Verify that the PPM provisioning is deleted:

• CTC shows an empty slot after the PPM is deleted.

• If the SFP or XFP is physically present when you delete the PPM provisioning, CTC transitions to the deleted state, the ports (if any) are deleted, and the PPM is represented as a gray graphic in CTC. The SFP or XFP can be provisioned again in CTC, or the equipment can be removed, in which case the removal causes the graphic to disappear.

Step 5  If you need to remove the PPM hardware (the SFP or XFP), complete the “DLP-G64 Remove an SFP or XFP” task on page 3-47.

Step 6  Return to your originating procedure (NTP).
NTP-G33 Create a Y-Cable Protection Group

Purpose
This procedure creates a Y-cable protection group between the client ports of two transponder (TXP_MR_10G, TXP_MR_10E, or TXP_MR_2.5G) or two muxponder (MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G) cards. For additional information about Y-cable protection, see the “16.9.1 Y-Cable Protection” section on page 16-114.

Tools/Equipment
Installed TXP or MXP cards.
Cisco MetroPlanner Traffic Matrix

Prerequisite Procedures
NTP-G15 Install the Common Control Cards, page 1-71
NTP-G14 Install DWDM Equipment, page 1-66
DLP-G46 Log into CTC, page 2-25
NTP-G139 Verify Cisco MetroPlanner Reports and Files, page 3-3

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the ports are not in a Y-cable protection group.

Step 1
View the Cisco MetroPlanner Traffic Matrix (see Table 3-1 on page 3-3) for your site. Verify the TXP or MXP cards that need Y-cable protection groups. (Cards requiring Y-cable protection are indicated with “Y-Cable” in the Traffic Matrix table Protection Type column. Refer to the Cisco MetroPlanner DWDM Operations Guide for more information.)

Step 2
Verify that the TXP or MXP cards are installed according to the requirements specified in Table 5-2. This table describes the protection types available in the ONS 15454 for DWDM client cards.

Table 5-2 Protection Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Cards</th>
<th>Description and Installation Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y-cable</td>
<td>MXP_2.5_10G, TXP_MR_10G, TXP_MR_2.5G</td>
<td>Pairs a working transponder or muxponder card/port with a protect transponder or muxponder card/port. The protect port must be on a different card than the working port and it must be the same card type as the working port. The working and protect port numbers must be the same, that is, Port 1 can only protect Port 1, Port 2 can only protect Port 2, etc.</td>
</tr>
<tr>
<td>Splitter</td>
<td>TXPP_MR_2.5G, MXPP_MR_2.5G</td>
<td>A splitter protection group is automatically created when a TXPP_MR_2.5G or MXPP_MR_2.5G card is installed. You can edit the splitter protection group name.</td>
</tr>
</tbody>
</table>

Step 3
Verify that PPMs are provisioned for the same payload and payload rate on the TXP and MXP cards where you will create the Y-cable protection group.
• Display the TXP or MXP card in card view. Click the Provisioning > Pluggable Port Module tabs. Verify that a PPM is provisioned in the Pluggable Port Module area, and the payload type and rate is provisioned for it in the Selected PPM area.

The PPM payload and payload rate must be the same for both TXP or MXP cards. If they are not the same, for example, if the PPM payload and payload rate are not the same, you must either change the provisioned payload rate to match, or replace the PPM (SFP or XFP).

Step 4 In node view, click the Provisioning > Protection tabs.

Step 5 In the Protection Groups area, click Create.

Step 6 In the Create Protection Group dialog box, enter the following:
  • Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 0-9) characters. Special characters are permitted. For TL1 compatibility, do not use question mark (?), backslash (\), or double quote (") characters.
  • Type—Choose Y Cable from the drop-down list.
  • Protect Port—From the drop-down list, choose the port that will be the standby or protection port to the active port. The list displays the available transponder or muxponder ports. If transponder or muxponder cards are not installed, no ports appear in the drop-down list.

After you choose the protect port, a list of available working ports appear in the Available Ports list, as shown in Figure 5-5. If no cards are available, no ports appear. If this occurs, you can not complete this task until you install the physical cards or preprovision the ONS 15454 slots using the “NTP-G29 Preprovision a Slot” procedure on page 3-37.

Figure 5-5 Creating a Y-Cable Protection Group

Step 7 From the Available Ports list, choose the port that will be protected by the port you selected in Protect Ports. Click the top arrow button to move the port to the Working Ports list.

Step 8 Complete the remaining fields:
  • Revertive—Check this check box if you want traffic to revert to the working port after failure conditions remain corrected for the amount of time entered in the Reversion Time field.
Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse before the traffic reverts to the working card. The reversion timer starts after conditions causing the switch are cleared.

Step 9 Click OK.

Step 10 Repeat this procedure for every protection indicated in the Cisco MetroPlanner Traffic Matrix.

Stop. You have completed this procedure.

---

NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards

Purpose This procedure changes the line and threshold settings for TXP_MR_10G and TXP_MR_10E cards.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
DLP-G63 Install an SFP or XFP, page 3-45
DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)
DLP-G278 Provision the Optical Line Rate, page 5-6 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Note The TXP_MR_10G card does not support PPMs.

---

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the transponder card settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve the existing transmission settings.

Step 3 Perform any of the following tasks as needed:

- DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards, page 5-13
- DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards, page 5-14
- DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards, page 5-17
- DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads, page 5-19
- DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy, page 5-21
- DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds, page 5-24
DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards

Purpose
This task changes the card settings for TXP_MR_10G and TXP_MR_10E multirate (10 Gbps) transponder cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

**Step 1**
In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the card settings.

**Step 2**
Click the Provisioning > Card tabs.

**Step 3**
Modify any of the settings described in Table 5-3.

---

**Table 5-3**
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Termination Mode</td>
<td>Sets the mode of operation. See the “16.12 Termination Modes” section on page 16-117 for more details.</td>
<td>• Transparent&lt;br&gt;• Section (TXP_MR_10E only)&lt;br&gt;• Line</td>
<td>• Transparent&lt;br&gt;• Regeneration Section (TXP_MR_10E only)&lt;br&gt;• Multiplex Section</td>
</tr>
</tbody>
</table>

---

Stop. You have completed this procedure.
Table 5-3  TXP_MR-10G and TXP_MR_10E Card Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIS/Squelch Configuration</td>
<td>(TXP_MR_10E only) Sets the transparent termination mode configuration.</td>
<td>• Squelch</td>
<td>• Squelch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• AIS</td>
<td>• AIS</td>
</tr>
<tr>
<td>Wavelength</td>
<td>Sets the wavelength of the DWDM side optical transmitter.</td>
<td>• First Tunable Wavelength</td>
<td>• First Tunable Wavelength</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Further wavelengths in 100-GHz ITU spacing</td>
<td>• Further wavelengths in 100-GHz ITU spacing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported wavelengths are in white and marked by asterisks (**); unsupported wavelengths are gray.</td>
<td>• Supported wavelengths are in white and marked by asterisks (**); unsupported wavelengths are gray.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
<td>The four available wavelengths are listed in the Card Parameters section of the window and also on the Maintenance &gt; Info tab.</td>
<td>The four available wavelengths are listed in the Card Parameters section of the window and also on the Maintenance &gt; Info tab.</td>
</tr>
</tbody>
</table>

Step 4  Click Apply.

Step 5  Return to your originating procedure (NTP).

DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards

Purpose  This task changes the line settings for TXP_MR_10G and TXP_MR_10E transponder cards.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Step 1  In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the line settings.

Step 2  Click the Provisioning > Line > SONET (including 10G Ethernet WAN phy) tabs.

Step 3  Modify any of the settings described in Table 5-4.

Note  In Table 5-4, some parameter tabs do not always apply to both the TXP_MR_10G cards and the TXP_MR_10E cards. If a tab does not apply, it will not appear in CTC.
### Table 5-4  TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>1-1 (OC192)</td>
<td>1-1 (STM64)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Trunk)</td>
<td>2 (Trunk)</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
<tr>
<td>Admin State</td>
<td>Sets the port service state. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>IS, IS,AINS</td>
<td>Unlocked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS,DSBLD</td>
<td>Unlocked,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS,MT</td>
<td>Locked,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Locked,maintenance</td>
</tr>
<tr>
<td>Service State</td>
<td>(Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>IS-NR</td>
<td>Unlocked-enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-AU,AINS</td>
<td>Unlocked-disabled,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-MA,DSBLD</td>
<td>Locked-enabled,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-MA,MT</td>
<td>Locked-enabled,maintenance</td>
</tr>
<tr>
<td>SF BER</td>
<td>(SONET [ANSI] or SDH [ETSI] including 10G Ethernet WAN Phy only) Sets the signal fail bit error rate.</td>
<td>1E-3</td>
<td>1E-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-4</td>
<td>1E-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-5</td>
<td>1E-5</td>
</tr>
<tr>
<td>SD BER</td>
<td>(SONET [ANSI] or SDH [ETSI] including 10G Ethernet WAN Phy only) Sets the signal degrade bit error rate.</td>
<td>1E-5</td>
<td>1E-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-6</td>
<td>1E-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-7</td>
<td>1E-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-8</td>
<td>1E-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-9</td>
<td>1E-9</td>
</tr>
<tr>
<td>AINS Soak</td>
<td>(SONET [ANSI] or SDH [ETSI] including 10G Ethernet WAN Phy only) Sets the automatic in-service soak period. Double-click the time and use the up and down arrows to change settings.</td>
<td>Duration of valid input signal, in hh:mm format, after which the card becomes in service (IS) automatically 0 to 48 hours, 15-minute increments</td>
<td>Duration of valid input signal, in hh:mm format, after which the card becomes in service (IS) automatically 0 to 48 hours, 15-minute increments</td>
</tr>
<tr>
<td>Type</td>
<td>(SONET [ANSI] or SDH [ETSI] including 10G Ethernet WAN Phy only) The optical transport type.</td>
<td>SONET</td>
<td>SONET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDH</td>
<td>SDH</td>
</tr>
</tbody>
</table>
**Table 5-4**  
**TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
</table>
| ALS Mode             | Sets the automatic laser shutdown (ALS) function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled, or it can be set for one of three mode options. | • Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
• Manual Restart for Test: Manually restarts the laser for testing. | • Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
• Manual Restart for Test: Manually restarts the laser for testing. |
| ProvidesSync         | (TXP_MR_10E, OC192 only) Sets the ProvidesSync card parameter. If checked, the card is provisioned as a network element (NE) timing reference. | Checked or unchecked                                                               | Checked or unchecked                                                                |
| SyncMsgIn            | (TXP_MR_10E, OC192 only) Sets the EnableSync card parameter. Enables synchronization status messages (S1 byte), which allow the node to choose the best timing source. | Checked or unchecked                                                               | Checked or unchecked                                                                |
| Send DoNotUse        | (TXP_MR_10E, OC192 only) Sets the Send DoNotUse card state. When checked, sends a do not use (DUS) message on the S1 byte. | Checked or unchecked                                                               | Checked or unchecked                                                                |
| Max Size             | (TXP_MR_10E, 10_GE LAN Phy only) Sets the maximum Ethernet packet size.     | • 1548 bytes  
• Jumbo (64 to 9,216 bytes)                                                      | • 1548 bytes  
• Jumbo (64 to 9,216 bytes)                                                      |
| Incoming MAC Address | (TXP_MR_10E, 10_GE LAN Phy only) Sets the incoming MAC address.             | Value of MAC address. 6 bytes in hexadecimal format.                               | Value of MAC address. 6 bytes in hexadecimal format.                               |
Table 5-4  

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength</td>
<td>Displays the wavelength of the client port.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• First Tunable Wavelength</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Further wavelengths: 1310 nm to 1550 nm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 100-GHz ITU spacing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Coarse wavelength division multiplexing (CWDM) spacing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported wavelengths are marked by asterisks (**)</td>
<td></td>
</tr>
<tr>
<td>Reach</td>
<td>Displays the optical reach distance of the client port.</td>
<td>• The Reach options depend on the traffic type that has been selected</td>
<td>• The Reach options depend on the traffic type that has been selected</td>
</tr>
</tbody>
</table>

Step 4  Click **Apply**.

Step 5  Return to your originating procedure (NTP).

---

**DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards**

**Purpose**  This task changes the section trace settings for the TXP_MR_10G and TXP_MR_10E transponder cards.

**Tools/Equipment**  None

**Prerequisite Procedures**  DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Provisioning or higher

**Note**  The Section Trace tab is available for the TXP_MR_10G and TXP_MR_10E cards only if no PPM or an OC192 PPM has been provisioned. The tab is not available if a TEN_GE LAN Phy or FC10G PPM has been provisioned.

---

**Step 1**  In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the section trace settings.

**Step 2**  Click the **Provisioning > Line > Section Trace** tabs.

**Step 3**  Modify any of the settings described in **Table 5-5**.
DLP-G218 Change Section Trace Settings for the TXP_MR_10G and TXP_MR_10E Cards

Chapter 5  Provision Transponder and Muxponder Cards

Table 5-5  TXP_MR_10G and TXP_MR_10E Transponder Card Section Trace Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options — ONS 15454</th>
<th>Options — ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Sets the port number.</td>
<td>• 1-1 (OC192)</td>
<td>• 1-1 (STM64)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—Trunk</td>
<td>• 2—Trunk</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>• Off/None</td>
<td>• Off/None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual</td>
<td>• Manual</td>
</tr>
<tr>
<td>Section Trace</td>
<td>Sets the trace string size.</td>
<td>• 1 byte</td>
<td>• 1 byte</td>
</tr>
<tr>
<td>String Size</td>
<td></td>
<td>• 16 byte</td>
<td>• 16 byte</td>
</tr>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new</td>
<td>String of trace string size</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>transmit string. You can click the button on the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>right to change the display. Its title changes,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>based on the current display mode. Click <strong>Hex</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>to change the display to hexadecimal (button</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current transmit string; sets a new</td>
<td>String of trace string size</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>transmit string. You can click the button on the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>right to change the display. Its title changes,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>based on the current display mode. Click <strong>Hex</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>to change the display to hexadecimal (button</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received</td>
<td>String of trace string size</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>string. You can click Refresh to manually</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>refresh this display, or check the Auto-refresh</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>every 5 sec check box to keep this field</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>updated.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Step 4**  Click **Apply**.

**Step 5**  Return to your originating procedure (NTP).
DLP-G219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads

**Purpose**
This task changes the line threshold settings for TXP_MR_10G and TXP_MR_10E transponder cards carrying SONET or SDH payloads, including the physical 10G Ethernet WAN payload.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the line threshold settings.

**Step 2**
Click the **Provisioning > Line Thresholds > SONET Thresholds** tabs.

**Step 3**
Modify any of the settings described in Table 5-6.

**Note**
You must modify Near End and Far End independently; 15 Min and 1 Day independently; and Line and Section independently. To do so, choose the appropriate radio button and click **Refresh**.

### Table 5-6 TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number</td>
<td>• 1-1 (OC192)</td>
<td>• 1-1 (STM64)</td>
</tr>
<tr>
<td>CV</td>
<td>Coding violations</td>
<td>Numeric. Threshold display options include:</td>
<td>Numeric. Threshold display options include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction—Near End or Far End</td>
<td>• Direction—Near End or Far End</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Interval—15 Min (minutes) or 1 day</td>
<td>• Interval—15 Min (minutes) or 1 day</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Types—Line or Section (near end only)</td>
<td>• Types—Multiplex Section or Regeneration Section (near end only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose an option in each category and click <strong>Refresh</strong>.</td>
<td>Choose an option in each category and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds</td>
<td>Numeric. Threshold display options include:</td>
<td>Numeric. Threshold display options include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction—Near End or Far End</td>
<td>• Direction—Near End or Far End</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Interval—15 Min (minutes) or 1 day</td>
<td>• Interval—15 Min (minutes) or 1 day</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Types—Line or Section (near end only)</td>
<td>• Types—Multiplex Section or Regeneration Section (near end only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose an option in each category and click <strong>Refresh</strong>.</td>
<td>Choose an option in each category and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>
### DLP-6219 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for SONET or SDH Payloads

#### Chapter 5  Provision Transponder and Muxponder Cards

**Table 5-6  TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options – ONS 15454</th>
<th>Options – ONS 15454 SDH</th>
</tr>
</thead>
</table>
| SES       | Severely errored seconds | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Line or Section (near end only)  
  Choose an option in each category and click Refresh. | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Multiplex Section or Regeneration Section (near end only)  
  Choose an option in each category and click Refresh. |
| SEFS      | (Section only) Severely errored framing seconds | Numeric. Can be set for Far End for 15-minute or one-day intervals for Section only. Choose an interval option and click Refresh. | Numeric. Can be set for Far End for 15-minute or one-day intervals for Regeneration Section only. Choose an interval option and click Refresh. |
| FC        | Failure count | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Line or Section (near end only)  
  Choose an option in each category and click Refresh. | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Multiplex Section or Regeneration Section (near end only)  
  Choose an option in each category and click Refresh. |
| UAS       | Unavailable seconds | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Line or Section (near end only)  
  Choose an option in each category and click Refresh. | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Multiplex Section or Regeneration Section (near end only)  
  Choose an option in each category and click Refresh. |

**Step 4**  Click **Apply**.

**Step 5**  Return to your originating procedure (NTP).
DLP-G319 Change the TXP_MR_10G or TXP_MR_10E Card Line Thresholds for 10G Ethernet LAN Phy

Purpose
This task changes the line threshold settings for TXP_MR_10G and TXP_MR_10E transponder cards carrying the physical 10G Ethernet LAN payload.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Display the TXP_MR_10G or TXP_MR_10E card where you want to change the line threshold settings in card view.

Step 2
Click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Step 3
Click Create. The Create Threshold dialog box appears.

Step 4
From the Port drop-down list, choose the applicable port.

Step 5
From the Variable drop-down list, choose an Ethernet variable. See Table 5-7 for a list of available Ethernet thresholds.

Table 5-7 TXP_MR_10G and TXP_MR_10GE LAN Phy Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ifInOctets</td>
<td>Total number of octets received on the interface, including framing characters.</td>
</tr>
<tr>
<td>rxTotalPkts</td>
<td>Total number of received packets.</td>
</tr>
<tr>
<td>ifInMulticastPkts</td>
<td>Number of multicast frames received error free.</td>
</tr>
<tr>
<td>ifInBroadcastPkts</td>
<td>Number of packets, delivered by a sublayer to an higher sublayer, which were addressed to a broadcast address at this sublayer.</td>
</tr>
<tr>
<td>ifInErrors</td>
<td>Number of inbound packets that contained errors preventing them from being delivered to a higher-layer protocol.</td>
</tr>
<tr>
<td>ifInErrorBytePkts</td>
<td>Number of receive error bytes.</td>
</tr>
<tr>
<td>ifInFramingErrorPkts</td>
<td>Number of receive framing error counters.</td>
</tr>
<tr>
<td>ifInJunkInterPkts</td>
<td>Number of receive interpacket junk counters.</td>
</tr>
<tr>
<td>ifOutOctets</td>
<td>Total number of octets transmitted out of the interface, including framing characters.</td>
</tr>
<tr>
<td>txTotalPkts</td>
<td>Total number of transmit packets.</td>
</tr>
<tr>
<td>ifOutMulticastPkts</td>
<td>Number of multicast frames transmitted error free.</td>
</tr>
<tr>
<td>ifOutBroadcastPkts</td>
<td>Total number of packets that higher-level protocols requested be transmitted, and that were addressed to a broadcast address at this sublayer, including those that were discarded or not sent.</td>
</tr>
</tbody>
</table>
Table 5-7  TXP_MR_10G and TXP_MR_10GE LAN Phy Variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dot3StatsFCSErrors</td>
<td>Number of frames with frame check errors, that is, there is an integral number of octets, but an incorrect Frame Check Sequence (FCS).</td>
</tr>
<tr>
<td>dot3StatsFrameTooLong</td>
<td>Number of received frames that were larger than the maximum size permitted.</td>
</tr>
<tr>
<td>etherStatsUndersizePkts</td>
<td>Total number of packets received that were less than 64 octets long (excluding framing bits, but including FCS octets) and were otherwise well formed.</td>
</tr>
<tr>
<td>etherStatsFragments</td>
<td>Total number of packets received that were less than 64 octets in length (excluding framing bits but including FCS octets) and had either a bad FCS with an integral number of octets (FCS Error) or a bad FCS with a nonintegral number of octets (Alignment Error). Note that it is entirely normal for etherStatsFragments to increment. This is because it counts both runts (which are normal occurrences due to collisions) and noise hits.</td>
</tr>
<tr>
<td>etherStatsPkts64Octets</td>
<td>Total number of packets (including bad packets) received that were 64 octets in length (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsPkts65to127Octets</td>
<td>Total number of packets (including bad packets) received that were between 65 and 127 octets in length inclusive (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsPkts128to255Octets</td>
<td>The total number of packets (including bad packets) received that were between 128 and 255 octets in length inclusive (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsPkts256to511Octets</td>
<td>Total number of packets (including bad packets) received that were between 256 and 511 octets in length inclusive (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsPkts512to1023Octets</td>
<td>Total number of packets (including bad packets) received that were between 512 and 1023 octets in length inclusive (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsPkts1024to1518Octets</td>
<td>Total number of packets (including bad packets) received that were between 1024 and 1518 octets in length inclusive (excluding framing bits but including FCS octets).</td>
</tr>
<tr>
<td>etherStatsBroadcastPkts</td>
<td>Total number of good packets received that were directed to the broadcast address. Note that this does not include multicast packets.</td>
</tr>
<tr>
<td>etherStatsMulticastPkts</td>
<td>Total number of good packets received that were directed to a multicast address. Note that this number does not include packets directed to the broadcast address.</td>
</tr>
<tr>
<td>etherStatsOversizePkts</td>
<td>Total number of packets received that were longer than 1518 octets (excluding framing bits, but including FCS octets) and were otherwise well formed.</td>
</tr>
<tr>
<td>etherStatsJabbers</td>
<td>Total number of packets received that were longer than 1518 octets (excluding framing bits, but including FCS octets), and had either a bad FCS with an integral number of octets (FCS Error) or a bad FCS with a nonintegral number of octets (Alignment Error).</td>
</tr>
</tbody>
</table>
Step 6
From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, falling threshold, or both the rising and falling thresholds.

Step 7
From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total number of occurrences, regardless of time period.

Step 8
Type in an appropriate number of seconds for the Sample Period.

Step 9
Type in the appropriate number of occurrences for the Rising Threshold.
For a rising type of alarm, the measured value must move from below the falling threshold to above the rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10
Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold is set lower than the rising threshold.
A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11
Click OK.

Step 12
Return to your originating procedure (NTP).
DLP-G301 Provision the TXP_MR_10G and TXP_MR_10E Trunk Port Alarm and TCA Thresholds

Purpose
This task provisions the TXP_MR_10G and TXP_MR_10E trunk port alarm and threshold crossing alert (TCA) thresholds.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the trunk port alarm and TCA settings.

Step 2
Click the Provisioning > Optics Thresholds tabs.

Step 3
Referring to Table 5-8, provision the trunk port (Port 2) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low.

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Note
Do not modify the Laser Bias parameters.

Step 4
Click Apply.

Table 5-8  TXP_MR_10G and TXP_MR_10E Trunk Port TCA Thresholds

<table>
<thead>
<tr>
<th>Card</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP_MR_10G</td>
<td>–22 dBm</td>
<td>–8 dBm</td>
<td>–1 dBm</td>
<td>7 dBm</td>
</tr>
<tr>
<td>TXP_MR_10E</td>
<td>–18 dBm</td>
<td>–9 dBm</td>
<td>0 dBm</td>
<td>9 dBm</td>
</tr>
</tbody>
</table>

Step 5
Under Types, click the Alarm radio button and click Refresh.

Step 6
Referring to Table 5-9, provision the trunk port (Port 2) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low.

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Step 7
Click Apply.
**Table 5-9**  
**TXP_MR_10G and TXP_MR_10E Trunk Port Alarm Thresholds**

<table>
<thead>
<tr>
<th>Card</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP_MR_10G</td>
<td>-24 dBm</td>
<td>-8 dBm</td>
<td>2 dBm</td>
<td>4 dBm</td>
</tr>
<tr>
<td>TXP_MR_10E</td>
<td>-20 dBm</td>
<td>-8 dBm</td>
<td>3 dBm</td>
<td>7 dBm</td>
</tr>
</tbody>
</table>

**Step 8**  
Return to your originating procedure (NTP).

---

**DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA Thresholds**

**Purpose**  
This task provisions the client port alarm and TCA thresholds for the TXP_MR_10G and TXP_MR_10E cards.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
- DLP-G278 Provision the Optical Line Rate, page 5-6
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
Required

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

**Step 1**  
In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the client port alarm and TCA settings.

**Step 2**  
Click the **Provisioning > Optics Thresholds** tabs. The TCA thresholds are shown by default.

**Step 3**  
Referring to **Table 5-10**, provision the Port 1 (Client) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. For additional information about client SFP and XFP interfaces, also known as PPMs, refer to Appendix B, “Hardware Specifications.”

---

**Note**
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click **Refresh**.

---

**Note**
Do not modify the Laser Bias parameters.

**Step 4**  
Click **Apply**.
DLP-G302 Provision the TXP_MR_10G and TXP_MR_10E Client Port Alarm and TCA Thresholds

Table 5-10 TXP_MR_10E and TXP_MR_10G Card Client Interface TCA Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>SONET (or SDH)</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–11</td>
<td>–1</td>
<td>–12</td>
<td>5</td>
</tr>
<tr>
<td>10G Ethernet LAN Phy</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–14</td>
<td>1</td>
<td>–12</td>
<td>5</td>
</tr>
<tr>
<td>10G Ethernet WAN PHY</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–14</td>
<td>1</td>
<td>–12</td>
<td>5</td>
</tr>
</tbody>
</table>

Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 5-11, provision the Port 1 (Client) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-11 TXP_MR_10E and TXP_MR_10G Card Client Interface Alarm Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>SONET (or SDH)</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–14</td>
<td>2</td>
<td>–9</td>
<td>2</td>
</tr>
<tr>
<td>10G Ethernet LAN Phy</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–17</td>
<td>4</td>
<td>–9</td>
<td>2</td>
</tr>
<tr>
<td>10G Ethernet WAN PHY</td>
<td>TXP_MR_10E uses ONS-XC-10G-S1 TXP_MR_10G (XFP not present)</td>
<td>–17</td>
<td>4</td>
<td>–9</td>
<td>2</td>
</tr>
</tbody>
</table>

Step 7 Click Apply.
DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards

**Purpose**
This task changes the line optical transport network (OTN) settings for TXP_MR_10G and TXP_MR_10E transponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the OTN settings.

**Step 2**
Click one of the Provisioning > OTN tabs, then click one of the following subtabs: OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier.

**Step 3**
Modify any of the settings described in Tables 5-12 through 5-15.

**Note**
You must modify Near End, and Far End independently; 15 Min and 1 Day independently; and SM and PM independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-12 describes the values on the Provisioning > OTN > OTN Lines tab.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Port number.</td>
<td>2</td>
</tr>
<tr>
<td>G.709 OTN</td>
<td>Sets the OTN lines according to ITU-T G.709. Check box to enable.</td>
<td>• Enabled&lt;br&gt;• Disabled</td>
</tr>
<tr>
<td>FEC</td>
<td>Sets the OTN lines forward error correction (FEC) mode. FEC mode can be Disabled, Enabled or Enhanced FEC mode can be enabled (to provide greater range and lower bit error rate).</td>
<td>• Enabled—(TXP_MR_10G only)&lt;br&gt;FEC is on.&lt;br&gt;• Disabled—FEC is off.&lt;br&gt;• Standard—(TXP_MR_10E only)&lt;br&gt;Standard FEC is on.&lt;br&gt;• Enhanced—(TXP_MR_10E only)&lt;br&gt;Enhanced FEC is on.</td>
</tr>
</tbody>
</table>
Table 5-12  TXP_MR_10G and TXP_MR_10E Transponder Card OTN Lines Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD BER</td>
<td>Sets the signal degrade bit error rate.</td>
<td>• 1E-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-9</td>
</tr>
<tr>
<td>Asynch/Synch</td>
<td>(TXP_MR_10E only) The card can perform multiplexing per ITU-T G.709. The ODUk (client SONET/SDH payload) can be mapped to the Optical Channel (OTUk) either asynchronously or synchronously with this setting.</td>
<td>• Asynch mapping</td>
</tr>
<tr>
<td>Mapping</td>
<td></td>
<td>• Synch mapping</td>
</tr>
</tbody>
</table>

Table 5-13 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 5-13  TXP_MR_10G and TXP_MR_10E Transponder Card ITU-T G.709 Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>2</td>
</tr>
</tbody>
</table>
| ES        | Severely errored seconds. Two types of thresholds can be asserted. Selecting the SM (OTUk) radio button selects FEC, overhead management, and PM using OTUk. Selecting the PM radio button selects path PM using ODUk. | Numeric. Threshold display options include:  
  • Direction—Near End or Far End  
  • Interval—15 Min (minutes) or 1 day  
  • Types—SM (OTUk) or PM (ODUk)  
  Choose an option in each category and click **Refresh**.  
  **Note**  
  SM (OTUk) is the ITU-T G.709 optical channel transport unit order of k overhead frame used for management and performance monitoring. PM (ODUk) is the ITU-T G.709 optical channel data unit order of k overhead frame unit used for path performance monitoring. |
| SES       | Severely errored seconds  | Numeric. Threshold display options include:  
  • Direction—Near End or Far End  
  • Interval—15 Min (minutes) or 1 day  
  • Types—SM (OTUk) or PM (ODUk)  
  Choose an option in each category and click **Refresh**. |
### Table 5-13  TXP_MR_10G and TXP_MR_10E Transponder Card ITU-T G.709 Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| UAS       | Unavailable seconds | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—SM (OTUk) or PM (ODUk)  
  Choose an option in each category and click **Refresh**. |
| BBE       | Background block errors | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—SM (OTUk) or PM (ODUk)  
  Choose an option in each category and click **Refresh**. |
| FC        | Failure counter | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—SM (OTUk) or PM (ODUk)  
  Choose an option in each category and click **Refresh**. |

*Table 5-14 describes the values on the Provisioning > OTN > FEC Thresholds tab.*

### Table 5-14  TXP_MR_10G and TXP_MR_10E Transponder Card FEC Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number and optional name.</td>
<td>2</td>
</tr>
<tr>
<td>Bit Errors Corrected</td>
<td>Displays the number of bit errors corrected during the selected time period.</td>
<td>Numeric display. Can be set for 15-minute or one-day intervals.</td>
</tr>
<tr>
<td>Uncorrectable Words</td>
<td>Displays the number of uncorrectable words in the selected time period.</td>
<td>Numeric display. Can be set for 15-minute or one-day intervals.</td>
</tr>
</tbody>
</table>

*Table 5-15 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.*
DLP-G221 Change OTN Settings for TXP_MG_10G and TXP_MG_10E Cards

Step 4
Click **Apply**.

Step 5
Return to your originating procedure (NTP).

---

**Table 5-15 TXP_MG_10G and TXP_MG_10E Transponder Card Trail Trace Identifier Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Sets the port number.</td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td>Level</td>
<td>Sets the level.</td>
<td>• Section</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Path</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>• Off/None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual</td>
</tr>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string. You can</td>
<td>String of trace string size; trail trace identifier is 64 bytes in length.</td>
</tr>
<tr>
<td></td>
<td>click the button on the right to change the display. Its title changes,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>based on the current display mode. Click <strong>Hex</strong> to change the display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string. You can</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>click the button on the right to change the display. Its title changes,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>based on the current display mode. Click <strong>Hex</strong> to change the display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string. You can click Refresh</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>to manually refresh this display, or check the Auto-refresh every 5 sec</td>
<td></td>
</tr>
<tr>
<td></td>
<td>check box to keep this field updated.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E Cards

**Purpose**

This procedure changes the line and threshold settings for MXP_2.5G_10G and MXP_2.5G_10E muxponder cards.

**Tools/Equipment**

None

**Prerequisite Procedures**

NTP-G32 Install the Transponder and Muxponder Cards, page 3-43.
DLP-G63 Install an SFP or XFP, page 3-45
DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)
DLP-G278 Provision the Optical Line Rate, page 5-6 (if necessary)

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Provisioning or higher

---

**Step 1**

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the muxponder card settings. If you are already logged in, continue with **Step 2**.

**Step 2**

As needed, complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve the existing transmission settings.

**Step 3**

Perform any of the following tasks as needed:

- DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-32
- DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-34
- DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-36
- DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-38
- DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-39
- DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds, page 5-41
- DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA Thresholds, page 5-43
- DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-44

**Step 4**

As needed, complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.
DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Purpose
This task changes the card settings for MXP_2.5G_10G or MXP_2.5G_10E muxponder cards, including payload type, termination mode, and wavelength.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the MXP_2.5G_10G or and MXP_2.5G_10E card where you want to change the card settings.

Step 2
Click the Provisioning > Card tabs.

Step 3
Modify any of the settings described in Table 5-16.
Table 5-16   
**MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Termination Mode</td>
<td>Sets the mode of operation. Options that do not apply to a card do not display.</td>
<td>For ANSI platforms:</td>
</tr>
<tr>
<td></td>
<td>The MXP_2.5G_10G card is based on SONET/SDH multiplexing. The transparent mode terminates and</td>
<td>• Transparent</td>
</tr>
<tr>
<td></td>
<td>rebuilds the B1 byte (as well as other bytes) of the incoming OC-48/STM-16 signal. The B2 byte</td>
<td>• Section (MXP_2.5G_10E only)</td>
</tr>
<tr>
<td></td>
<td>is not touched.</td>
<td>• Line (MXP_2.5G_10E only)</td>
</tr>
<tr>
<td></td>
<td>The MXP_2.5G_10E card is fully transparent in transparent mode based on the OTN/ITU-T G.709</td>
<td>For ETSI platforms:</td>
</tr>
<tr>
<td></td>
<td>multiplexing scheme. It does not terminate the B1 byte or other bytes.</td>
<td>• Transparent</td>
</tr>
<tr>
<td></td>
<td>It encapsulates OC-48/STM-16 bytes into ODU1 first, then multiplexes them into an OTU2.</td>
<td>• Multiplex Section (MXP_2.5G_10E only)</td>
</tr>
<tr>
<td></td>
<td>See the “16.12 Termination Modes” section on page 16-117 for more information.</td>
<td>• Regeneration Section (MXP_2.5G_10E only)</td>
</tr>
<tr>
<td>Wavelength</td>
<td>Sets the wavelength of the DWDM side optical transmitter. You can set the wavelength to the</td>
<td>• First Tunable Wavelength</td>
</tr>
<tr>
<td></td>
<td>First Tunable Wavelength or to further wavelengths in 100 GHz ITU spacing.</td>
<td>• Further wavelengths in 100-GHz ITU grid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported wavelengths are in white and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>marked by asterisks (**); unsupported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>wavelengths are gray</td>
</tr>
<tr>
<td>AIS/Squelch</td>
<td>(MXP_2.5G_10E only) Sets the transparent termination mode configuration.</td>
<td>• Ais</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Squelch</td>
</tr>
<tr>
<td>Card Parameters</td>
<td>Displays the settings for the card.</td>
<td>Display only</td>
</tr>
</tbody>
</table>

**Step 4**  
Click **Apply**.

**Step 5**  
Return to your originating procedure (NTP).
DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

**Purpose**
This task changes the line settings for MXP_2.5G_10G or MXP_2.5G_10E muxponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
Double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the line settings.

**Step 2**
Click the **Provisioning > Line > SONET** (ANSI) or **SDH** (ETSI) tabs.

**Note**
The SONET tab appears only if you have created a PPM for a given port.

**Step 3**
Modify any of the settings described in *Table 5-17*.

**Note**
You must modify Near End, and Far End independently; 15 Min and 1 Day independently; and Line and Section independently. To do so, choose the appropriate radio button and click **Refresh**.

### Table 5-17 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Port #      | (Display only) Port number. Ports 1 to 4 are client ports (OC-48/STM-16). Port 5 (TXP_2.5G_10G) is the DWDM trunk (OC-192/STM-64) that provides wavelength services. | • 1  
• 2  
• 3  
• 4  
• 5 (MXP_2.5G_10G only) |
| Port Name   | Provides the ability to assign the specified port a logical name.            | User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default.         |
|             |                                                                              | See the “DLP-G104 Assign a Name to a Port” task on page 7-10.                                   |
| Admin State | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | • IS (ANSI) or Locked (ETSI)  
• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)  
• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)  
• OOS,MT (ANSI) or Locked,maintenance (ETSI) |
Table 5-17  
*Table 5-17  *MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings (continued)  

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Service State | Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | • IS-NR (ANSI) or Unlocked-enabled (ETSI)  
• OOS-AU,AINS (ANSI) or Unlocked-disabled, automaticInService (ETSI)  
• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)  
• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI) |
| ALS Mode    | Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options. | • Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
• Manual Restart for Test: Manually restarts the laser for testing. |
| SF BER      | Sets the signal fail bit error rate.                                                                 | • 1E-3  
• 1E-4  
• 1E-5 |
| SD BER      | Sets the signal degrade bit error rate.                                                               | • 1E-5  
• 1E-6  
• 1E-7  
• 1E-8  
• 1E-9 |
| AINS Soak   | Sets the automatic in-service soak period. Double-click the time and use the up and down arrows to change settings. | • Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically  
• 0 to 48 hours, 15-minute increments |
| Type        | Sets the optical transport type.                                                                         | • SONET  
• SDH |
<p>| ProvidesSync | Sets the ProvidesSync card parameter. If checked, the card is provisioned as an NE timing reference. (This parameter does not appear for the MXP_2.5G_10E trunk port.) | Checked or unchecked |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SyncMsgIn</td>
<td>Enables synchronization status messages (S1 byte), which allow the node to choose the best timing source. (This parameter does not appear for the MXP_2.5G_10E trunk port.)</td>
<td>Checked or unchecked</td>
</tr>
<tr>
<td>Send DoNotUse</td>
<td>When checked, sends a DUS message on the S1 byte. (This parameter does not appear for the MXP_2.5G_10E trunk port.)</td>
<td>Checked or unchecked</td>
</tr>
</tbody>
</table>
| Reach | Displays the optical reach distance of the client port. | • Autoprovision (default)  
• I1  
• S1  
• S2  
• L1  
• L2  
• L3 |
| Wavelength | Displays the wavelength of the client port. | • First Tunable Wavelength  
• Further wavelengths: 1310 nm to 1550 nm  
100-GHz ITU spacing, CWDM spacing  
• Supported wavelengths are marked by asterisks (**) |

**Step 4** Click Apply.

**Step 5** Return to your originating procedure (NTP).

### DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

**Purpose**
This task changes the section trace settings for MXP_2.5G_10G and MXP_2.5G_10E muxponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Note** The Section Trace tab appears only if you have created a PPM for the card.

**Step 6** In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the section trace settings.
Step 7  Click the Provisioning > Line > Section Trace tabs.

Step 8  Modify any of the settings described in Table 5-18.

Table 5-18  TXP_MR_10G and MXP_MR_10E Card Section Trace Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Sets the port number.</td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>• Off/None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual</td>
</tr>
<tr>
<td>Section Trace String Size</td>
<td>Sets the trace string size. Select either radio button.</td>
<td>• 1 byte</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 16 byte</td>
</tr>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string.</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>You can click the button on the right to change the display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Its title changes, based on the current display mode. Click Hex to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to hexadecimal (button changes to ASCII); click ASCII to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string.</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>You can click the button on the right to change the display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Its title changes, based on the current display mode. Click Hex to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to hexadecimal (button changes to ASCII); click ASCII to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string.</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>You can click Refresh to manually refresh this display, or check the Auto-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>refresh every 5 sec check box to keep this field updated.</td>
<td></td>
</tr>
</tbody>
</table>

Step 9  Click Apply.

Step 10  Return to your originating procedure (NTP).
DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

| Purpose | This task provisions the trunk settings for MXP_2.5G_10G and MXP_2.5G_10E muxponder cards. |
| Tools/Equipment | None |
| Prerequisite Procedures | DLP-G46 Log into CTC, page 2-25 |
| Required/As Needed | As needed |
| Onsite/Remote | Onsite or remote |
| Security Level | Provisioning or higher |

**Step 1**
In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the section trace settings.

**Step 2**
Click the Provisioning > Line > Trunk tab.

**Step 3**
Modify any of the settings described in Table 5-19.

### Table 5-19  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trunk Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number. Port 5 is the DWDM trunk (OC-192/STM-64) that provides wavelength services.</td>
<td>5</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a logical name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | - IS (ANSI) or Unlocked (ETSI)  
- IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)  
- OOS,DSBLD (ANSI) or Locked,disabled (ETSI)  
- OOS,MT (ANSI) or Locked,maintenance (ETSI) |
| Service State | Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | - IS-NR (ANSI) or Unlocked-enabled (ETSI)  
- OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService (ETSI)  
- OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)  
- OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI) |
DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Table 5-19  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trunk Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| ALS Mode      | Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options. | • Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
• Manual Restart for Test: Manually restarts the laser for testing. |
| AINS Soak     | (OC-N and STM-N payloads only) Sets the automatic in-service soak period. | • Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically  
• 0 to 48 hours, 15-minute increments |

**Step 4** Click **Apply**.

**Step 5** Return to your originating procedure (NTP).

DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

**Purpose**

This task changes the line threshold settings for MXP_2.5G_10G and MXP_2.5G_10E muxponder cards.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Provisioning or higher

**Step 1** In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the line threshold settings.

**Step 2** Click the Provisioning > Line Thresholds tabs.

**Step 3** Modify any of the settings described in Table 5-18.
You must modify Near End, and Far End independently; 15 Min and 1 Day independently; and Line or Multiplex Section and Section or Regeneration Section independently. To do so, choose the appropriate radio button and click **Refresh**.

**Note**

In Table 5-20, some parameter tabs or selections do not always apply to both the MXP_2.5G_10G and the MXP_2.5G_10E card. If the tabs or selections do not apply, they do not appear in CTC.

### Table 5-20  
**MXP_2.5G_10G and MXP_2.5G_10E Card Line Threshold Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>ONS 15454 Options</th>
<th>ONS 15454 SDH Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number</td>
<td>• 1-1 (OC192)</td>
<td>• 1-1 (STM64)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2 (Trunk)</td>
<td>• 2 (Trunk)</td>
</tr>
</tbody>
</table>
| CV              | Coding violations            | Numeric. Threshold display options include:  
|                 |                              | • Direction—Near End or Far End        |                                           |
|                 |                              | • Interval—15 Min (minutes) or 1 day   |                                           |
|                 |                              | • Types—Line or Section (near end only) |                                           |
|                 |                              | Choose an option in each category and click **Refresh**. |                                           |
| ES              | Errored seconds              | Numeric. Threshold display options include:  
|                 |                              | • Direction—Near End or Far End        |                                           |
|                 |                              | • Interval—15 Min (minutes) or 1 day   |                                           |
|                 |                              | • Types—Line or Section (near end only) |                                           |
|                 |                              | Choose an option in each category and click **Refresh**. |                                           |
| SES             | Severely errored seconds     | Numeric. Threshold display options include:  
|                 |                              | • Direction—Near End or Far End        |                                           |
|                 |                              | • Interval—15 Min (minutes) or 1 day   |                                           |
|                 |                              | • Types—Line or Section (near end only) |                                           |
|                 |                              | Choose an option in each category and click **Refresh**. |                                           |
| SEFS            | (Section only) Severely errored framing seconds | Numeric. Can be set for Far End for 15-minute or one-day intervals for Section only. Choose an interval option and click **Refresh**. | Numeric. Can be set for Far End for 15-minute or one-day intervals for Regeneration Section only. Choose an interval option and click **Refresh**. |
DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds

Table 5-20  MXP_2.5G_10G and MXP_2.5G_10E Card Line Threshold Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>ONS 15454 Options</th>
<th>ONS 15454 SDH Options</th>
</tr>
</thead>
</table>
| FC        | Failure count | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Line or Section (near end only)  
  Choose an option in each category and click Refresh. | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Multiplex Section or Regeneration Section (near end only)  
  Choose an option in each category and click Refresh. |
| UAS       | Unavailable seconds | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Line or Section (near end only)  
  Choose an option in each category and click Refresh. | Numeric. Threshold display options include:  
  - Direction—Near End or Far End  
  - Interval—15 Min (minutes) or 1 day  
  - Types—Multiplex Section or Regeneration Section (near end only)  
  Choose an option in each category and click Refresh. |

Step 4  Click Apply.
Step 5  Return to your originating procedure (NTP).

DLP-G303 Provision the MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm and TCA Thresholds

Purpose  This task changes the MXP_2.5G_10G and MXP_2.5G_10E trunk port alarm and TCA thresholds.
Tools/Equipment  None
Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Provisioning or higher

Step 1  In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the trunk port alarm and TCA settings.
Step 2  Click the Provisioning > Optics Thresholds tabs.
Step 3  Select a 15 Min or 1 Day PM interval radio button and then click Refresh.

Note  You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.
Step 4  Referring to Table 5-21, provision the trunk port (Port 5) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low.

Note  Do not modify the Laser Bias parameters.

Step 5  Click Apply.

Step 6  Under Types, click the Alarm radio button and click Refresh.

Step 7  Referring to Table 5-22, provision the trunk port (Port 5) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low.

Note  You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-21  MXP_2.5G_10G and MXP_2.5G_10E Trunk Port TCA Thresholds

<table>
<thead>
<tr>
<th>Card</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP_2.5G_10G</td>
<td>–22 dBm</td>
<td>–8 dBm</td>
<td>–1 dBm</td>
<td>7 dBm</td>
</tr>
<tr>
<td>MXP_2.5G_10E</td>
<td>–18 dBm</td>
<td>–9 dBm</td>
<td>0 dBm</td>
<td>9 dBm</td>
</tr>
</tbody>
</table>

Table 5-22  MXP_2.5G_10G and MXP_2.5G_10E Trunk Port Alarm Thresholds

<table>
<thead>
<tr>
<th>Card</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP_2.5G_10G</td>
<td>–24 dBm</td>
<td>–8 dBm</td>
<td>2 dBm</td>
<td>4 dBm</td>
</tr>
<tr>
<td>MXP_2.5G_10E</td>
<td>–20 dBm</td>
<td>–8 dBm</td>
<td>3 dBm</td>
<td>7 dBm</td>
</tr>
</tbody>
</table>

Step 8  Click Apply.

Step 9  Return to your originating procedure (NTP).
DLP-G304 Provision the MXP_2.5G_10G and MXP_2.5G_10E Client Port Alarm and TCA Thresholds

Purpose
This task provisions the client port alarm and TCA thresholds for the MXP_2.5G_10G and MXP_2.5G_10E cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G278 Provision the Optical Line Rate, page 5-6
DLP-G46 Log into CTC, page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the client port alarm and TCA settings.

Step 2
Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3
Referring to Table 5-23, provision the Port \(N\) (where \(N = 1\) through \(4\)) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. For additional information about client SFP and XFP interfaces, also known as PPMs, refer to Appendix B, “Hardware Specifications.”

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Step 4
Click Apply.

Table 5-23 MXP_2.5G_10G and MXP_2.5G_10E Card Client Interface TCA Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-48</td>
<td>ONS-SE-2G-S1</td>
<td>-18</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-OC48-IR</td>
<td>-18</td>
<td>0</td>
<td>-11</td>
<td>6</td>
</tr>
<tr>
<td>STM-16</td>
<td>ONS-SE-2G-S1</td>
<td>-18</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>-18</td>
<td>0</td>
<td>-11</td>
<td>6</td>
</tr>
</tbody>
</table>

Step 5
Repeat Steps 3 and 4 to provision each additional client port.

Step 6
Under Types, click the Alarm radio button and click Refresh.

Step 7
Referring to Table 5-24, provision the Port \(N\) (where \(N = 1\) through \(4\)) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.
DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Table 5-24  **MXP_2.5G_10G and MXP_2.5G_10E Card Client Interface Alarm Thresholds**

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-48</td>
<td>ONS-SE-2G-S1</td>
<td>-21</td>
<td>0</td>
<td>-13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-OC48-1R</td>
<td>-21</td>
<td>3</td>
<td>-8</td>
<td>3</td>
</tr>
<tr>
<td>STM-16</td>
<td>ONS-SE-2G-S1</td>
<td>-21</td>
<td>0</td>
<td>-13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>-21</td>
<td>3</td>
<td>-8</td>
<td>3</td>
</tr>
</tbody>
</table>

**Step 8**  Click **Apply**.

**Step 9**  Repeat Steps 7 and 8 to provision each additional client port. Otherwise, continue with **Step 10**.

**Step 10**  Return to your originating procedure (NTP).
### Table 5-25  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Line OTN Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>5</td>
</tr>
<tr>
<td>G.709 OTN</td>
<td>Sets the OTN lines according to ITU-T G.709.</td>
<td>• Enabled&lt;br&gt;• Disabled</td>
</tr>
<tr>
<td>FEC</td>
<td>Sets the OTN line FEC mode. FEC mode can be Disabled or Enabled. Enhanced FEC mode can be enabled (to provide greater range and lower bit error rate). E-FEC applies only to the MXP_2.5G_10E card.</td>
<td>• Enabled—(MXP_2.5G_10G only) FEC is on&lt;br&gt;• Disabled—FEC is off&lt;br&gt;• Standard—(MXP_2.5G_10E only) FEC is on&lt;br&gt;• Enhanced—(MXP_2.5G_10E only) Enhanced FEC is on</td>
</tr>
<tr>
<td>SF BER</td>
<td>Sets the signal fail bit error rate.</td>
<td>• 1E-5</td>
</tr>
<tr>
<td>SD BER</td>
<td>Sets the signal degrade bit error rate.</td>
<td>• 1E-5&lt;br&gt;• 1E-6&lt;br&gt;• 1E-7&lt;br&gt;• 1E-8&lt;br&gt;• 1E-9</td>
</tr>
<tr>
<td>Asynch/Synch Mapping</td>
<td>(MXP_2.5G_10E only) The MXP_2.5G_10E can perform standard ODU multiplexing according to ITU-T G.709. The card uses this to aggregate the four OC-48 client signals.</td>
<td>• ODU Multiplex</td>
</tr>
</tbody>
</table>

Table 5-26 describes the values on the Provisioning > OTN > OTN G.709 Thresholds tab.

### Table 5-26  MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card ITU-T G.709 Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number</td>
<td>5</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>SES</td>
<td>Severely errored seconds. Two types of thresholds can be asserted. Selecting the SM (OTUk) radio button selects FEC, overhead management, and PM using OTUk. Selecting the PM radio button selects path PM using ODUk.</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>UAS</td>
<td>Unavailable seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>
Table 5-26  **MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card ITU-T G.709 Threshold Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBE</td>
<td>Background block errors</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>FC</td>
<td>Failure counter</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>

Table 5-27 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 5-27  **MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card FEC Threshold Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>5</td>
</tr>
<tr>
<td>Bit Errors Corrected</td>
<td>Displays the number of bit errors corrected during the interval selected. The interval can be set for 15 minutes or one day.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Uncorrectable Words</td>
<td>Displays the number of uncorrectable words during the interval selected. The interval can be set for 15 minutes or one day.</td>
<td>Numeric</td>
</tr>
</tbody>
</table>

Table 5-28 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 5-28  **MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Sets the port number. The trail trace identifier is applicable only to the trunk interface, which handles ITU-T G.709 frames.</td>
<td>5</td>
</tr>
<tr>
<td>Level</td>
<td>Sets the level.</td>
<td>Section, Path</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>Off/None, Manual</td>
</tr>
</tbody>
</table>

---

**Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0**

September 2005
Table 5-28 MXP_2.5G_10G and MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click <strong>Hex</strong> to change the display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size; trail trace identifier is 64 bytes in length.</td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click <strong>Hex</strong> to change the display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size</td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string. You can click Refresh to manually refresh this display, or check the Auto-refresh every 5 sec box to keep this field updated.</td>
<td>String of trace string size</td>
</tr>
</tbody>
</table>

**Step 4** Click **Apply**.

**Step 5** Return to your originating procedure (NTP).
NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_MR_2.5G Cards

**Purpose**
This procedure changes the line and threshold settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
- DLP-G63 Install an SFP or XFP, page 3-45
- DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)
- DLP-G278 Provision the Optical Line Rate, page 5-6 (if necessary)

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the transponder card settings. If you are already logged in, continue with **Step 2**.

**Step 2**
As needed, complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve the existing transmission settings.

**Step 3**
Perform any of the following tasks as needed:
- DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-49
- DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-50
- DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-53
- DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH Payloads, page 5-54
- DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads, page 5-56
- DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds, page 5-57
- DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA Thresholds, page 5-58
- DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-62

Stop. You have completed this procedure.
DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Purpose
This task changes the card settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the card settings.

Step 2
Click the Provisioning > Card tabs.

Step 3
Modify any of the settings described in Table 5-29.

Table 5-29 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Termination Mode| Sets the mode of operation (option only supported for SONET/SDH payloads).  | • Transparent
                 | See the “16.12 Termination Modes” section on page 16-117 for more information.          | • Section (ANSI) or Regeneration Section (ETSI)
| Wavelength      | Sets the wavelength of the DWDM side optical transmitter.                     | • Line (ANSI) or Multiplex Section (ETSI)
|                 |                                                                              | • First Tunable Wavelength
|                 |                                                                              | • Further wavelengths in 100-GHz ITU spacing
|                 |                                                                              | • Supported wavelengths are in white and marked by asterisks (**); unsupported wavelengths are gray.
|                 | Note                                                                         | The four available wavelengths are listed in the Card Parameters section of the window and also in the Maintenance > Info tab. |
DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

### Purpose
This task changes the line settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

### Tools/Equipment
None

### Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

### Required/As Needed
As needed

### Onsite/Remote
Onsite or remote

### Security Level
Provisioning or higher

#### Step 1
In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line settings.

#### Step 2
Click the Provisioning > Line tabs and any additional PPM tabs depending on the client interface. Tabs and parameter selections vary according to PPM provisioning.

#### Step 3
Modify any of the settings described in Table 5-30.

---

**Table 5-29** TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Regeneration Peer Slot | Sets the slot containing another TXP_MR_2.5G or TXPP_MR_2.5G card to create a regeneration peer group. A regeneration peer group facilitates management of two TXP_MR_2.5G or TXPP_MR_2.5G cards that are needed to perform a complete signal regeneration. The regeneration peer group synchronizes provisioning of the two cards. Payload type and ITU-T G.709 OTN changes made on one TXP_MR_2.5G or TXPP_MR_2.5G card are reflected on the peer TXP_MR_2.5G or TXPP_MR_2.5G card. **Note** Y-cable protection groups cannot be created on TXP_MR_2.5G or TXPP_MR_2.5G cards that are in a regeneration peer group. | • None  
• 1  
• 2  
• 3  
• 4  
• 5  
• 6  
• 12  
• 13  
• 14  
• 15  
• 16  
• 17 |
| Regeneration Group Name | Sets the regeneration peer group name. User defined.                                                                                                                                                    | User defined. |
### Table 5-30  TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3 (TXPP_MR_2.5G card only)</td>
</tr>
<tr>
<td>Port Name</td>
<td>The user can assign a logical name for each of the</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default.</td>
</tr>
<tr>
<td></td>
<td>ports shown by filling in this field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
<tr>
<td>Admin State</td>
<td>Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• IS (ANSI) or Unlocked (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,MT (ANSI) or Locked,maintenance (ETSI)</td>
</tr>
<tr>
<td>Service State</td>
<td>Identifies the autonomously generated state that</td>
<td>• IS-NR (ANSI) or Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td>ALS Mode</td>
<td>Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options.</td>
<td>• Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual Restart for Test: Manually restarts the laser for testing.</td>
</tr>
<tr>
<td>SF BER</td>
<td>(OC-N and STM-N payloads only) Sets the signal fail bit error rate.</td>
<td>• 1E-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-5</td>
</tr>
</tbody>
</table>
Table 5-30  
**TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| SD BER    | (OC-N and STM-N payloads only) Sets the signal degrade bit error rate. | • 1E-5  
• 1E-6  
• 1E-7  
• 1E-8  
• 1E-9 |
| AINS Soak | (OC-N and STM-N payloads only) Sets the automatic in-service soak period. | • Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically  
• 0 to 48 hours, 15-minute increments |
| Type      | (OC-N and STM-N payloads only) The optical transport type. | • SONET  
• SDH |
| Reach     | Displays the optical reach distance of the client port. | • Autoprovision (default)  
• I1  
• S1  
• S2  
• L1  
• L2  
• L3 |
| Wavelength| Displays the wavelength of the client port. | • First Tunable Wavelength  
• Further wavelengths: 1310 nm to 1550 nm  
100-GHz ITU spacing, CWDM spacing  
• Supported wavelengths are marked by asterisks (*) |

**Step 4**  
Click **Apply**.

**Step 5**  
Return to your originating procedure (NTP).
DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

**Purpose**
This task changes the section trace settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Note**
This task only applies to SONET services.

---

**Step 1**
In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the section trace settings.

**Step 2**
Click the **Provisioning > Line > Section Trace** tabs.

**Step 3**
Modify any of the settings described in Table 5-31.

---

**Table 5-31**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3 (TXPP_MR_2.5G only)</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>• Off/None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual</td>
</tr>
<tr>
<td>Section Trace String Size</td>
<td>Sets the trace string size.</td>
<td>• 1 byte</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 16 byte</td>
</tr>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click <strong>Hex</strong> to change the display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size</td>
</tr>
</tbody>
</table>
### Step 4
Click **Apply**.

### Step 5
Return to your originating procedure (NTP).

---

**DLP-G232 Change TXP_MR_2.5G and TXPP_MR_2.5G Cards Line Threshold Settings for SONET or SDH Payloads**

**Purpose**
This task changes the line threshold settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards carrying OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 payloads.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line threshold settings.

**Step 2**
Click the **Provisioning > Line Thresholds** tabs.

**Note**
You must modify Near End, and Far End independently; 15 Min and 1 Day independently; and Line and Section independently. To do so, choose the appropriate radio button and click **Refresh**.

**Step 3**
Modify any of the settings in Table 5-32.

---

**Table 5-31 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click <strong>Hex</strong> to change the display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size</td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string. You can click Refresh to manually refresh this display, or check the Auto-refresh every 5 sec check box to keep this display updated automatically.</td>
<td>String of trace string size</td>
</tr>
</tbody>
</table>
### Table 5-32 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number</td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3 (TXPP_MR_2.5G card only)</td>
</tr>
<tr>
<td>CV</td>
<td>Coding violations</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for Line (Far End only), Section, or Path. Select the bullet and click Refresh.</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for Line (Far End only), Section, or Path. Select the bullet and click Refresh.</td>
</tr>
<tr>
<td>SES</td>
<td>Severely errored seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for Line (Far End only), Section, or Path. Select the bullet and click Refresh.</td>
</tr>
<tr>
<td>SEFS</td>
<td>(Section only) Severely errored framing seconds</td>
<td>Numeric. Can be set for Far End, for 15-minute or one-day intervals for Section only. Select the bullet and click Refresh.</td>
</tr>
<tr>
<td>FC</td>
<td>(Line only) Failure count</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals for Line only. Select the bullet and click Refresh.</td>
</tr>
<tr>
<td>UAS</td>
<td>(Line only) Unavailable seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, for Line only. Select the bullet and click Refresh.</td>
</tr>
</tbody>
</table>

**Step 4** Click **Apply**.

**Step 5** Return to your originating procedure (NTP).
DLP-G320 Change the TXP_MR_2.5G or TXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads

**Purpose**
This task changes the line threshold settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards carrying the 1G Ethernet or 1G FC/FICON payloads.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
Display the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line threshold settings in card view.

**Step 2**
Click the **Provisioning > Line Thresholds > RMON Thresholds** tabs.

**Step 3**
Click **Create**. The Create Threshold dialog box appears.

**Step 4**
From the Port drop-down list, choose the applicable port.

**Step 5**
From the Variable drop-down list, choose an Ethernet variable. See **Table 5-33** for a list of available Ethernet thresholds.

**Step 6**
From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, falling threshold, or both the rising and falling thresholds.

**Step 7**
From the Sample Type drop-down list, choose either **Relative** or **Absolute**. Relative restricts the threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total number of occurrences, regardless of time period.

**Step 8**
Type in an appropriate number of seconds for the Sample Period.

**Step 9**
Type in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

**Table 5-33**
**TXP_MR_2.5G and TXPP_MR_2.5G Card 1G Ethernet and 1G FC/FICON Thresholds**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ifInErrors</td>
<td>Number of inbound packets that contained errors preventing them from being deliverable to a higher-layer protocol.</td>
</tr>
<tr>
<td>rxTotalPkts</td>
<td>Total number of received packets.</td>
</tr>
<tr>
<td>8b10bStatsEncodingDispErrors</td>
<td>Number of 8b10b disparity violations on the Fibre Channel line side.</td>
</tr>
<tr>
<td>8b10bIdleOrderedSets</td>
<td>Number of received packets containing idle ordered sets.</td>
</tr>
<tr>
<td>8b10bNonIdleOrderedSets</td>
<td>Number of received packets containing non-idle ordered sets.</td>
</tr>
<tr>
<td>8b10bDataOrderedSets</td>
<td>Number of received packets containing data ordered sets.</td>
</tr>
</tbody>
</table>
DLP-G305 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds

**Step 10** Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

**Step 11** Click OK.

**Step 12** Return to your originating procedure (NTP).

---

**Purpose**
This task changes the TXP_MR_2.5G and TXPP_MR_2.5G trunk port alarm and TCA thresholds.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1** In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

**Step 2** Click the **Pluggable Port Modules** tab. Under Pluggable Ports, record the Rate that is provisioned.

**Step 3** Look up the rate in Table 16-54 on page 16-89 and determine whether it is 2R or 3R.

**Step 4** Click the **Provisioning > Optics Thresholds** tabs.

**Step 5** Click the **15 Min** PM interval radio button and click **Refresh**.

**Step 6** Referring to Table 5-34, provision the trunk port (Port 2) TCA thresholds for RX Power High and RX Power Low depending on whether the rate is 2R or 3R.

**Note**
Do not modify the Laser Bias parameters.

**Step 7** Click **Apply**.
DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA Thresholds

**Table 5-34** TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port TCA Thresholds

<table>
<thead>
<tr>
<th>Signal</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>3R</td>
<td>–23 dBm</td>
<td>–9 dBm</td>
</tr>
<tr>
<td>2R</td>
<td>–24 dBm</td>
<td>–9 dBm</td>
</tr>
</tbody>
</table>

**Step 8** Under Types, click the Alarm radio button and click Refresh.

**Step 9** Provision the trunk port (Port 2) Alarm thresholds for RX Power High to –7 dBm and the RX Power Low to –26 dBm.

**Step 10** Click Apply.

**Step 11** Click the 1 Day PM interval radio button, click Refresh, then repeat Steps 6 through 10 for the 1-day interval. If you have completed both intervals, continue with Step 12.

**Step 12** Return to your originating procedure (NTP).

**DLP-G306 Provision the TXP_MR_2.5G and TXPP_MR_2.5G Cards Client Port Alarm and TCA Thresholds**

**Purpose**
This task provisions the client port alarm and TCA thresholds for the TXP_MR_2.5G and TXPP_MR_2.5G cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G278 Provision the Optical Line Rate, page 5-6
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
Required

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1** In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.

**Step 2** Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

**Step 3** Referring to Table 5-35, provision the Port 1 (client) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. For additional information about client SFP and XFP interfaces, also known as PPMs, refer to Appendix B, “Hardware Specifications.”

**Note**
Do not modify the Laser Bias parameters.

**Note**
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.
### Table 5-35  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP or XFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-3</td>
<td>15454-SFP3-1-IR</td>
<td>-23</td>
<td>-8</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td>STM-1</td>
<td>15454E-SFP-L.1.1</td>
<td>-24</td>
<td>-10</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td>OC-12</td>
<td>15454-SFP12-4-IR</td>
<td>-28</td>
<td>-7</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td>STM-4</td>
<td>15454E-SFP-L.4.1</td>
<td>-28</td>
<td>-8</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td>OC-48</td>
<td>ONS-SE-2G-S1</td>
<td>-18</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-OC48-IR</td>
<td>-18</td>
<td>0</td>
<td>-11</td>
<td>6</td>
</tr>
<tr>
<td>STM-16</td>
<td>ONS-SE-2G-S1</td>
<td>-18</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>-18</td>
<td>0</td>
<td>-11</td>
<td>6</td>
</tr>
<tr>
<td>ONE_GE</td>
<td>15454-SFP-GEFC-SX</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td>ESCON</td>
<td>15454-SFP-200</td>
<td>-21</td>
<td>-14</td>
<td>-35</td>
<td>-8</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-200</td>
<td>-21</td>
<td>-14</td>
<td>-35</td>
<td>-8</td>
</tr>
<tr>
<td>DV6000</td>
<td>15454-SFP-OC48-IR</td>
<td>-28</td>
<td>-7</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>-18</td>
<td>0</td>
<td>-11</td>
<td>6</td>
</tr>
<tr>
<td>SDI_D1_VIDEO</td>
<td>15454-SFP12-4-IR</td>
<td>-28</td>
<td>-7</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.4.1</td>
<td>-28</td>
<td>-8</td>
<td>-21</td>
<td>-2</td>
</tr>
<tr>
<td>HDTV</td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td>PASS-THRU</td>
<td>2R MODE (not specified)</td>
<td>Service Dependent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td>FC2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>-15</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>-15</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td>FICON1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td>FICON2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>-17</td>
<td>0</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>-20</td>
<td>-3</td>
<td>-16</td>
<td>3</td>
</tr>
</tbody>
</table>
Chapter 5      Provision Transponder and Muxponder Cards

Table 5-35  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds (continued)

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP or XFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETR_CLO</td>
<td>15454-SFP-200</td>
<td>–17</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISC compat</td>
<td>15454-SFP-GE+LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISC peer</td>
<td>15454-SFP-GE+LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-36  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-3</td>
<td>15454-SFP3-1-IR</td>
<td>–26</td>
<td>–5</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td>STM-1</td>
<td>15454E-SFP-L.1.1</td>
<td>–27</td>
<td>–7</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td>OC-12</td>
<td>15454-SFP12-4-IR</td>
<td>–31</td>
<td>–4</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td>STM-4</td>
<td>15454E-SFP-L.4.1</td>
<td>–31</td>
<td>–5</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td>OC-48</td>
<td>ONS-SE-2G-S1</td>
<td>–21</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454-SFP-OC48-IR</td>
<td>–21</td>
<td>3</td>
<td>–8</td>
<td>3</td>
</tr>
<tr>
<td>STM-16</td>
<td>ONS-SE-2G-S1</td>
<td>–21</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>–21</td>
<td>3</td>
<td>–8</td>
<td>3</td>
</tr>
<tr>
<td>ONE_GE</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESCON</td>
<td>15454-SFP-200</td>
<td>–24</td>
<td>–11</td>
<td>–32</td>
<td>–11</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DV6000</td>
<td>15454-SFP-OC48-IR</td>
<td>–31</td>
<td>–4</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.16.1</td>
<td>–21</td>
<td>3</td>
<td>–8</td>
<td>3</td>
</tr>
<tr>
<td>SD1_D1_VIDEO</td>
<td>15454-SFP12-4-IR</td>
<td>–31</td>
<td>–4</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-L.4.1</td>
<td>–31</td>
<td>–5</td>
<td>–18</td>
<td>–5</td>
</tr>
<tr>
<td>HDTV</td>
<td>15454-SFP-GE+LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 5-36  TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (SFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>PASS-THRU</td>
<td>2R MODE (not specified)</td>
<td>Service Dependent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>FC2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–18</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>FICON1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>FICON2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>ETR_CLO</td>
<td>15454-SFP-200</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-200</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>ISC compat</td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td>ISC peer</td>
<td>15454-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
</tbody>
</table>

**Step 7**  Click **Apply**.

**Step 8**  Return to your originating procedure (NTP).
DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Purpose
This task changes the OTN settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the OTN settings.

Step 2
Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3
Modify any of the settings described in Tables 5-37 through 5-40.

Note
You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-37 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 5-37 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card OTN Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>2</td>
</tr>
<tr>
<td>G.709 OTN</td>
<td>Sets the OTN lines according to ITU-T G.709.</td>
<td>• Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disabled</td>
</tr>
<tr>
<td>FEC</td>
<td>Sets the OTN lines to FEC.</td>
<td>• Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disabled</td>
</tr>
<tr>
<td>SF BER</td>
<td>Sets the signal fail bit error rate.</td>
<td>• 1E-5</td>
</tr>
<tr>
<td>SD BER</td>
<td>Sets the signal degrade bit error rate.</td>
<td>• 1E-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1E-9</td>
</tr>
</tbody>
</table>

Table 5-38 describes the values on the Provisioning > OTN > G.709 Thresholds tab.
### Table 5-38 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card ITU-T G.709 Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>2</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>SES</td>
<td>Severely errored seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>UAS</td>
<td>Unavailable seconds</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>BBE</td>
<td>Background block errors</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>FC</td>
<td>Failure counter</td>
<td>Numeric. Can be set for Near End or Far End, for 15-minute or one-day intervals, or for SM (OTUk) or PM (ODUk). Select a bullet and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>

1. Latency for 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is 40 microseconds. Latency for 2G-FC payload without ITU-T G.709 is 2 microseconds, and with ITU-T G.709 is 20 microseconds. Consider these values when planning a FC network that is sensitive to latency.

### Table 5-39 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card FEC Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>2</td>
</tr>
<tr>
<td>Bit Errors Corrected</td>
<td>Sets the value for bit errors corrected.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals.</td>
</tr>
<tr>
<td>Uncorrectable Words</td>
<td>Sets the value for uncorrectable words.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals.</td>
</tr>
</tbody>
</table>

### Table 5-40 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>2</td>
</tr>
</tbody>
</table>
| Level     | Sets the level. | • Section  
• Path |
| Trace Mode | Sets the trace mode. | • Off/None  
• Manual |
### TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trace Identifier Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click Hex to change the display to hexadecimal (button changes to ASCII); click ASCII to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size</td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string. You can click the button on the right to change the display. Its title changes, based on the current display mode. Click Hex to change the display to hexadecimal (button changes to ASCII); click ASCII to change the display to ASCII (button changes to Hex).</td>
<td>String of trace string size</td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string. You can click Refresh to manually refresh this display, or check the Auto-refresh every 5 sec check box to keep this field updated.</td>
<td>String of trace string size</td>
</tr>
</tbody>
</table>

**Step 4** Click **Apply**.

**Step 5** Return to your originating procedure (NTP).
Chapter 5  Provision Transponder and Muxponder Cards

NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Purpose
This procedure changes the line and threshold settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

Tools/Equipment
None

Prerequisite Procedures
NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
DLP-G63 Install an SFP or XFP, page 3-45
DLP-G277 Provision a Multirate PPM, page 5-3 (if necessary)
DLP-G278 Provision the Optical Line Rate, page 5-6 (if necessary)

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the muxponder card settings. If you are already logged in, proceed to Step 2.

Step 2
As needed, complete the “NTP-G103 Back Up the Database” procedure on page 13-2 to preserve the existing transmission settings.

Step 3
Perform any of the following tasks as needed:

- DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-66
- DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-67
- DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-69
- DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-71
- DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-73
- DLP-G240 Change MXP_MR_2.5G and MXPP_MR_2.5G Card Line Threshold Settings for SONET or SDH Payloads, page 5-74
- DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads, page 5-77
- DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds, page 5-79
- DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds, page 5-80

Note
To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see Chapter 8, “Manage Alarms.”
Stop. You have completed this procedure.

DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

**Purpose**
This task changes the card settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Note**
Card settings can be changed only if the facilities are out of service (OOS).

**Step 1**
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the card settings.

**Step 2**
Click the Provisioning > Card tabs.

**Step 3**
Modify any of the settings described in Table 5-41.

**Table 5-41 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Mode</td>
<td>Sets the mode of operation (option only supported for SONET/SDH payloads).</td>
<td>• FC-GE</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This setting is not currently supported. The only option available currently is FC-GE.</td>
<td></td>
</tr>
<tr>
<td>Wavelength</td>
<td>Sets the wavelength of the DWDM side optical transmitter.</td>
<td>• First Tunable Wavelength</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Further wavelengths in 100-GHz ITU spacing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported wavelengths are in white and marked by asterisks (**); unsupported wavelengths are gray.</td>
</tr>
</tbody>
</table>

**Step 4**
Click Apply.

**Step 5**
Return to your originating procedure (NTP).
DLP-G236 Change Client Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

This task changes the line settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

Step 1
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the line settings.

Step 2
Click the Provisioning > Line > Client tabs. Tabs and parameter selections vary according to PPM provisioning.

Step 3
Modify any of the settings for the client service tab as described in Table 5-42.

### Table 5-42 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Client Service Tab Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Port number.</td>
<td>• 1&lt;br&gt;• 2</td>
</tr>
<tr>
<td>Port Name</td>
<td>The user can assign a logical name for each of the ports shown by filling in this field.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
<tr>
<td>Admin State</td>
<td>Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• IS (ANSI) or Unlocked (ETSI)&lt;br&gt;• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)&lt;br&gt;• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)&lt;br&gt;• OOS,MT (ANSI) or Locked,maintenance (ETSI)</td>
</tr>
<tr>
<td>Service State</td>
<td>Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• IS-NR (ANSI) or Unlocked-enabled (ETSI)&lt;br&gt;• OOS-AU,AINS (ANSI) or Unlocked-disabled, automaticInService (ETSI)&lt;br&gt;• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)&lt;br&gt;• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)</td>
</tr>
</tbody>
</table>
## ALS Mode
Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options.

- **Disable** (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.
- **Auto Restart**: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.
- **Manual Restart**: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.
- **Manual Restart for Test**: Manually restarts the laser for testing.

## Reach
Displays the optical reach distance of the client port.

The Reach options depend on the traffic type that has been selected.

## Wavelength
Displays the wavelength of the client port.

- **First Tunable Wavelength**
- **Further wavelengths**: 1310 nm to 1550 nm 100-GHz ITU spacing CWDM spacing
- **Supported wavelengths are marked by asterisks (**)**

### Table 5-42  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Client Service Tab Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| ALS Mode | Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options. | - Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
- Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
- Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
- Manual Restart for Test: Manually restarts the laser for testing. |
| Reach | Displays the optical reach distance of the client port. | The Reach options depend on the traffic type that has been selected. |
| Wavelength | Displays the wavelength of the client port. | - First Tunable Wavelength  
- Further wavelengths: 1310 nm to 1550 nm 100-GHz ITU spacing CWDM spacing  
- Supported wavelengths are marked by asterisks (**) |
### Purpose
This task changes the distance extension settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards. Distance extension should be enabled when the distance between the MXP_MR_2.5G/MXPP_MR_2.5G source and destination cards is greater than 5 km and/or when the Fibre Channel switch buffer is set to 128 bytes or less.

### Tools/Equipment
None

### Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

### Required/As Needed
As needed

### Onsite/Remote
Onsite or remote

### Security Level
Provisioning or higher

### Notes
- Distance extension settings can be changed only if the facilities are out of service (OOS).
- If distance extension is enabled for one MXP_MR_2.5G/MXPP_MR_2.5G card, it must be enabled on the MXP_MR_2.5G/MXPP_MR_2.5G card at the other end. A GFP-DE-MISMATCH alarm is raised if distance extension is enabled for a card at only one end.
- The MXP_MR_2.5G/MXPP_MR_2.5G cards can operate with different Fibre Channel switch buffers at each end. However, the traffic flow will be unequal.
- The distance extension parameters only apply to client ports (Ports 1 to 8) and not to the trunk ports (Port 9 for MXP_MR_2.5G card or Ports 9 and 10 for the MXPP_MR_2.5G card).

### Steps
1. In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the distance extension settings.
2. Click the Provisioning > Line > Distance Extension tabs. Tabs and parameter selections vary according to PPM provisioning.
3. Modify any of the settings for the Distance Extension tab as described in Table 5-43.
### Table 5-43 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Port number.</td>
<td>1 2</td>
</tr>
</tbody>
</table>
| Enable Distance Extension | If checked, allows end-to-end distances up to 1600 km for FC1G and up to 800 km for FC2G through a flow control scheme based on the transparent-mode Generic Framing Protocol (GFP-T). GFP-T flow control enables the node to be part of a storage area network (SAN) with long-distance remote nodes. Cisco recommends that you enable distance extension when one or both of the following conditions exist:  
  - The distance between the source and destination MXP_MR_2.5G/MXPP_MR_2.5G cards is greater than 5 km.  
  - The FC switch buffer at either end is less than 128 bytes.  
If distance extension is enabled, the Fibre Channel switch must be set to Interop or Open Fabric mode, depending on the switch. By default, the MXP_MR_2.5G/MXPP_MR_2.5G card interoperates with the Cisco Multilayer Director Switch (MDS) storage products. | Checked or unchecked |
| Auto Detect Credits  | (Available only when distance extension is enabled). If checked, enables the node to detect the transmit credits from a remote node. Credits are used for link flow control and for Extended Link Protocol (ELP) login frames between Fibre Channel/FICON switch E ports. If distance extension is enabled, Cisco recommends that you enable Auto Detect Credits. | Checked or unchecked |
| Credits Available    | If Auto Detect Credits is not enabled, sets the number of credits when an ELP login frame setting is missing or if the ELP login frame cannot be detected. | Numeric. Values are 2 through 256 in multiples of 2. |
Chapter 5  Provision Transponder and Muxponder Cards

DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Table 5-43  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoadjust GFP Buffer</td>
<td>If checked, the threshold of the GFP buffer between two MXP_MR_2.5G or two MXPP_MR_2.5G cards is automatically adjusted. This guarantees the best utilization of the SONET/SDH transport by balancing bandwidth and latency.</td>
<td>Checked or unchecked</td>
</tr>
<tr>
<td>Threshold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFP Buffers Available</td>
<td>If Autoadjust GFP Buffer Threshold is not checked, sets the GFP buffer depth. For shorter SONET transport distances, Cisco recommends lower values to decrease latency. For longer SONET transport distances, Cisco recommends higher values to provide higher bandwidth.</td>
<td>Numeric. Possible values are 16 through 1200 in multiples of 16.</td>
</tr>
</tbody>
</table>

Step 4  Click Apply.

Step 5  Return to your originating procedure (NTP).

DLP-G238 Change OC-48/STM-16 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Purpose  This task changes the OC-48/STM-16 settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Note  OC-48/STM-16 settings apply only to the trunk ports (Port 9 for the MXP_MR_2.5G card and Ports 9 and 10 for the MXPP_MR_2.5G card.)

Step 1  In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the OC-48/STM-64 settings.

Step 2  Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameter selections vary according to PPM provisioning.

Step 3  Modify any of the settings for the SONET or SDH tab as described in Table 5-44.
### Table 5-44  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line SONET or SDH Tab Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Port number.</td>
<td>9 (trunk for MXP_MR_2.5G) or 9 and 10 (trunks for MXPP_MR_2.5G)</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State    | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | • IS (ANSI) or Unlocked (ETSI)  
• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)  
• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)  
• OOS,MT (ANSI) or Locked,maintenance (ETSI) |
| Service State  | Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | • IS-NR (ANSI) or Unlocked-enabled (ETSI)  
• OOS-AU,AINS (ANSI) or Unlocked-disabled, automaticInService (ETSI)  
• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)  
• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI) |
| SF BER¹        | Sets the signal fail bit error rate.                                       | • 1E-3  
• 1E-4  
• 1E-5 |
| SD BER¹        | Sets the signal degrade bit error rate.                                    | • 1E-5  
• 1E-6  
• 1E-7  
• 1E-8  
• 1E-9 |
| AINS Soak      | Sets the automatic in-service soak period. Double-click the time and use the up and down arrows to change settings. | • Duration of valid input signal, in hh:mm format, after which the card becomes in service (IS) automatically  
• 0 to 48 hours, 15-minute increments |
| Type           | The optical transport type.                                                | • SONET (ANSI)  
• SDH (ETSI) |
DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Table 5-44  

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| ALS Mode          | Sets the ALS function mode. The DWDM transmitter supports ALS according to ITU-T G.644 (06/99). ALS can be disabled or can be set for one of three mode options. | • Disable (default): ALS is off; the laser is not automatically shut down when traffic outages (LOS) occur.  
• Auto Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.  
• Manual Restart: ALS is on; the laser automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.  
• Manual Restart for Test: Manually restarts the laser for testing. |
| ProvidesSync      | Sets the ProvidesSync card parameter. If checked, the card is provisioned as an NE timing reference. | Checked or unchecked                                                                       |
| SyncMsgIn         | Sets the EnableSync card parameter. Enables synchronization status messages (S1 byte), which allow the node to choose the best timing source. | Checked or unchecked                                                                       |
| Send DoNotUse     | Sets the Send DoNotUse card state. When checked, sends a DUS message on the S1 byte. | Checked or unchecked                                                                       |

1. SF BER and SD BER thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for MXPP_MR_2.5G).

**Step 4**  
Click **Apply**.

**Step 5**  
Return to your originating procedure (NTP).

DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

**Purpose**  
This task changes the section trace settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

**Step 1**  
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the section trace settings.
DLP-G240 Change MXP_MG_2.5G and MXPP_MG_2.5G Card Line Threshold Settings for SONET or SDH Payloads

Step 2  
Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to PPM provisioning.

Step 3  
Modify any of the settings in the Section Trace tab as described in Table 5-45.

Table 5-45  
MXP_MG_2.5G and MXPP_MG_2.5G Muxponder Card Line Section Trace Tab Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port number.</td>
<td>9 (trunk for MXP_MG_2.5G) or 9 and 10</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Sets the trace mode.</td>
<td>• Off/None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual</td>
</tr>
<tr>
<td>Section Trace</td>
<td>Sets the trace string size.</td>
<td>• 1 byte</td>
</tr>
<tr>
<td>String Size</td>
<td></td>
<td>• 16 byte</td>
</tr>
<tr>
<td>Transmit</td>
<td>Displays the current transmit string; sets a new transmit string.</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>You can click the button on the right to change the display. Its title</td>
<td></td>
</tr>
<tr>
<td></td>
<td>changes, based on the current display mode. Click <strong>Hex</strong> to change the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Expected</td>
<td>Displays the current expected string; sets a new expected string.</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>You can click the button on the right to change the display. Its title</td>
<td></td>
</tr>
<tr>
<td></td>
<td>changes, based on the current display mode. Click <strong>Hex</strong> to change the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>display to hexadecimal (button changes to ASCII); click <strong>ASCII</strong> to change</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the display to ASCII (button changes to Hex).</td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>(Display only) Displays the current received string. You can click Refresh</td>
<td>String of trace string size</td>
</tr>
<tr>
<td></td>
<td>to manually refresh this display, or check the Auto-refresh every 5 sec</td>
<td></td>
</tr>
<tr>
<td></td>
<td>check box to keep this field updated.</td>
<td></td>
</tr>
</tbody>
</table>

Step 4  
Click **Apply**.

Step 5  
Return to your originating procedure (NTP).
DLP-6240 Change MXP_MR_2.5G and MXPP_MR_2.5G Card Line Threshold Settings for SONET or SDH Payloads

**Step 1**  
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the line threshold settings.

**Step 2**  
Click the **Provisioning > Line Thresholds > SONET Thresholds** (ANSI) or **SDH Thresholds** (ETSI) tabs.

**Step 3**  
Modify any of the settings as shown in **Table 5-46**.

**Note**  
You must modify Near End, and Far End independently; 15 Min and 1 Day independently; and Line and Section independently. To do so, choose the appropriate radio button and click **Refresh**.

### Table 5-46  
**MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>ONS 15454 Options</th>
<th>ONS 15454 SDH Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Port (Display only) Port number.</td>
<td>• 9 (MXP_MR_2.5G)</td>
<td>• 9 (MXP_MD_2.5G)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 9 and 10 (MXPP_MR_2.5G)</td>
<td>• 9 and 10 (MXPP_MD_2.5G)</td>
</tr>
<tr>
<td>CV</td>
<td>Coding violations.</td>
<td>Numeric. Threshold display options</td>
<td>Numeric. Threshold display options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>include:</td>
<td>include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction—Near End or Far End</td>
<td>• Direction—Near End or Far End</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Interval—15 Min (minutes) or 1 day</td>
<td>• Interval—15 Min (minutes) or 1 day</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Types—Line or Section (near end</td>
<td>• Types—Multiplex Section or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only)</td>
<td>Regeneration Section (near end only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose an option in each category</td>
<td>Choose an option in each category</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and click <strong>Refresh</strong>.</td>
<td>and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds.</td>
<td>Numeric. Threshold display options</td>
<td>Numeric. Threshold display options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>include:</td>
<td>include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction—Near End or Far End</td>
<td>• Direction—Near End or Far End</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Interval—15 Min (minutes) or 1 day</td>
<td>• Interval—15 Min (minutes) or 1 day</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Types—Line or Section (near end</td>
<td>• Types—Multiplex Section or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only)</td>
<td>Regeneration Section (near end only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose an option in each category</td>
<td>Choose an option in each category</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and click <strong>Refresh</strong>.</td>
<td>and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>SES</td>
<td>Severely errored seconds.</td>
<td>Numeric. Threshold display options</td>
<td>Numeric. Threshold display options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>include:</td>
<td>include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Direction—Near End or Far End</td>
<td>• Direction—Near End or Far End</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Interval—15 Min (minutes) or 1 day</td>
<td>• Interval—15 Min (minutes) or 1 day</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Types—Line or Section (near end</td>
<td>• Types—Multiplex Section or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only)</td>
<td>Regeneration Section (near end only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose an option in each category</td>
<td>Choose an option in each category</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and click <strong>Refresh</strong>.</td>
<td>and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>

Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0

September 2005
Step 4  Click **Apply**.

Step 5  Return to your originating procedure (NTP).

### Table 5-46  MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>ONS 15454 Options</th>
<th>ONS 15454 SDH Options</th>
</tr>
</thead>
</table>
| SEFS | (Section only) Severe errored framing seconds. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—Line or Section (near end only)  
Choose an option in each category and click **Refresh**. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—Multiplex Section or Regeneration Section (near end only)  
Choose an option in each category and click **Refresh**. |
| FC | (Line only) Failure count. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—SM (OTUk) or PM (ODUk)  
Choose an option in each category and click **Refresh**. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—SM (OTUk) or PM (ODUk)  
Choose an option in each category and click **Refresh**. |
| UAS | (Line only) Unavailable seconds. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—Section only  
Choose an option in each category and click **Refresh**. | Numeric. Threshold display options include:  
- Direction—Near End or Far End  
- Interval—15 Min (minutes) or 1 day  
- Types—Regeneration Section (only)  
Choose an option in each category and click **Refresh**. |
DLP-G321 Change the MXP_MR_2.5G or MXPP_MR_2.5G Card Line Thresholds for 1G Ethernet or 1G FC/FICON Payloads

**Purpose**
This task changes the line threshold settings for MXP_MR_10G and MXPP_MR_10E transponder cards carrying the 1G Ethernet or 1G FC/FICON payloads.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
Display the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the line threshold settings in card view.

**Step 2**
Click the Provisioning > Line Thresholds > RMON Thresholds tabs.

**Step 3**
Click Create. The Create Threshold dialog box appears.

**Step 4**
From the Port drop-down list, choose the applicable port.

**Step 5**
From the Variable drop-down list, choose an Ethernet variable. See Table 5-47 for a list of available Ethernet thresholds.

**Table 5-47**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ifInOctets</td>
<td>Number of bytes received since the last counter reset.</td>
</tr>
<tr>
<td>rxTotalPkts</td>
<td>Total number of receive packets.</td>
</tr>
<tr>
<td>ifInDiscards</td>
<td>Number of inbound packets that were chosen to be discarded even though no errors had been detected to prevent their being deliverable to a higher-layer protocol.</td>
</tr>
<tr>
<td>ifInErrors</td>
<td>Total number of receive errors.</td>
</tr>
<tr>
<td>ifOutOctets</td>
<td>The total number of octets transmitted out of the interface, including framing characters.</td>
</tr>
<tr>
<td>txTotalPkts</td>
<td>Total number of transmitted packets.</td>
</tr>
<tr>
<td>ifOutDiscards</td>
<td>Number of outbound packets that were chosen to be discarded even though no errors had been detected to prevent their being transmitted.</td>
</tr>
<tr>
<td>mediaIndStatsRxFramesTruncated</td>
<td>Total number of frames received that are less than 5 bytes. This value is a part of high-level data link control (HDLC) and GFP port statistics.</td>
</tr>
<tr>
<td>mediaIndStatsRxFramesTooLong</td>
<td>Number of received frames that exceed the maximum transmission unit (MTU). This value is part of HDLC and GFP port statistics.</td>
</tr>
<tr>
<td>mediaIndStatsRxFramesBadCRC</td>
<td>Number of receive data frames with payload cyclic redundancy check (CRC) errors when HDLC framing is used.</td>
</tr>
</tbody>
</table>
Table 5-47  MXP_MR_2.5G and MXPP_MR 2.5G Card 1G Ethernet or 1G FC/FICON
Variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mediaIndStatsTxFramesBadCRC</td>
<td>Number of transmitted data frames with payload CRC errors when HDLC framing is used.</td>
</tr>
<tr>
<td>fcStatsLinkRecoveries</td>
<td>Number of link recoveries.</td>
</tr>
<tr>
<td>fcStatsZeroTxCredits</td>
<td>Number of transmit attempts that failed because of unavailable credits.</td>
</tr>
<tr>
<td>8b10bInvalidOrderedSets</td>
<td>Number of 8b10b disparity violations on the Fibre Channel line side.</td>
</tr>
<tr>
<td>8b10bStatsEncodingDispErrors</td>
<td>Number of 8b10b disparity violations on the Fibre Channel line side.</td>
</tr>
</tbody>
</table>

Step 6  From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, falling threshold, or both the rising and falling thresholds.

Step 7  From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total number of occurrences, regardless of time period.

Step 8  Type in an appropriate number of seconds for the Sample Period.

Step 9  Type in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11  Click OK.

Step 12 Return to your originating procedure (NTP).
DLP-G307 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Trunk Port Alarm and TCA Thresholds

**Purpose**
This task changes the MXP_MR_2.5G and MXPP_MR_2.5G trunk port alarm and TCA thresholds.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

**Step 2**
Click the ** Provisioning > Optics Thresholds** tabs.

*Note*
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click **Refresh**.

**Step 3**
Provision the trunk port (Port 9) TCA thresholds for RX Power High to –9 dBm and for RX Power Low to –23 dBm.

**Step 4**
Under Types, click the **Alarm** radio button and click **Refresh**.

*Note*
Do not modify the Laser Bias parameters.

**Step 5**
Provision the trunk port (Port 9) Alarm thresholds for RX Power High to –7 dBm and for RX Power Low to –26 dBm.

*Note*
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click **Refresh**.

**Step 6**
Click **Apply**.

**Step 7**
Return to your originating procedure (NTP).
DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds

Purpose
This task provisions the client port alarm and TCA thresholds for the MXP_MR_2.5G and MXPP_MR_2.5G cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G278 Provision the Optical Line Rate, page 5-6
DLP-G46 Log into CTC, page 2-25

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the MXP_MR_2.5G and MXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.

Step 2
Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3
Referring to Table 5-48, provision the client port (Ports 1 through 8) TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. For additional information about client SFP and XFP interfaces, also known as PPMs, refer to Appendix B, “Hardware Specifications.”

Note
Do not modify the Laser Bias parameters.

Note
You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Step 4
Click Apply.

Table 5-48  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface TCA Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–17</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–15</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FICON1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–17</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5  Provision Transponder and Muxponder Cards

DLP-G308 Provision the MXP_MR_2.5G and MXPP_MR_2.5G Client Port Alarm and TCA Thresholds

Table 5-48  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface TCA Thresholds (continued)

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>TCA RX Power Low</th>
<th>TCA RX Power High</th>
<th>TCA TX Power Low</th>
<th>TCA TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–17</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ONE_GE</td>
<td>15454-SFP-GEFC-SX</td>
<td>–17</td>
<td>0</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–20</td>
<td>–3</td>
<td>–16</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 5  Repeat Steps 3 and 4 to provision each additional client port.

Step 6  Under Types, click the Alarm radio button and click Refresh.

Step 7  Referring to Table 5-49, provision the client port (Ports 1 through 8) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Note  You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button and click Refresh.

Table 5-49  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface Alarm Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–18</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FICON1G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FICON2G</td>
<td>15454-SFP-GEFC-SX</td>
<td>–20</td>
<td>3</td>
<td>–13</td>
<td>–1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>–23</td>
<td>0</td>
<td>–13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 5-49  MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface Alarm Thresholds

<table>
<thead>
<tr>
<th>Port Type (by CTC)</th>
<th>Pluggable Port Module (XFP)</th>
<th>Alarm RX Power Low</th>
<th>Alarm RX Power High</th>
<th>Alarm TX Power Low</th>
<th>Alarm TX Power High</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONE_GE</td>
<td>15454-SFP-GEFC-SX</td>
<td>−20</td>
<td>3</td>
<td>−13</td>
<td>−1</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GEFC-S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15454-SFP-GE+-LX</td>
<td>−23</td>
<td>0</td>
<td>−13</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>15454E-SFP-GE+-LX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 8  Click Apply.

Step 9  Repeat Steps 7 and 8 to provision each additional client port. Otherwise, continue with Step 10.

Step 10 Return to your originating procedure (NTP).
Turn Up Network

This chapter explains how to turn up and test a Cisco ONS 15454 dense wavelength division multiplexing (DWDM) network. For DWDM topology reference information and span loss tables, see Chapter 18, “Network Reference.”

There are two main DWDM network types: metro core, where the channel power is equalized and dispersion compensation is applied, and metro access, where the channels are not equalized and dispersion compensation is not applied. The DWDM network topologies supported are hubbed rings, multihubbed rings, meshed rings, linear configurations, and single-span links. The DWDM node types supported are hub, terminal, optical add/drop multiplexing (OADM), reconfigurable optical add/drop multiplexing (ROADM) anti-amplified spontaneous emissions (ASE), and line amplifier. For DWDM and hybrid node turn-up procedures, see Chapter 3, “Turn Up a Node.”

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G51 Verify DWDM Node Turn-Up, page 6-2—Complete this procedure before beginning network turn-up.
2. NTP-G52 Verify Node-to-Node Connections, page 6-3—Complete this procedure next.
3. NTP-G53 Set Up Timing, page 6-4—Complete this procedure next.
4. NTP-G54 Provision and Verify a DWDM Network, page 6-8—Complete this procedure next.
5. NTP-G56 Verify the OSNR, page 6-12—Complete as needed.
6. NTP-G57 Create a Logical Network Map, page 6-15—Complete as needed.
NTP-G51 Verify DWDM Node Turn-Up

Purpose
This procedure verifies that each ONS 15454 is ready for DWDM network turn-up before adding nodes to a network. This procedure applies to all ROADM, OADM, and line amplifier nodes.

Tools/Equipment
None

Prerequisite Procedures
Chapter 3, “Turn Up a Node”

Required/As Needed
Required

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Log into an ONS 15454 on the network that you will test. See the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, proceed to Step 2.

Step 2
Click the Alarms tab.
   a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.
   b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 3
Verify that the software version shown in the node view status area matches your site plan. (The status area is located to the left of the shelf graphic.) If the software is not the correct version, install the correct version from the ONS 15454 software CD. Upgrade procedures are located in the release-specific software upgrade document. Follow the upgrade procedures appropriate to the software currently installed on the node. TCC2/TCC2P cards can also be ordered with the latest software release.

Step 4
Click the Provisioning > General tabs. Verify that all general node information settings are correct according to documentation provided by the network administrator. If not, see the “NTP-G80 Change Node Management Information” procedure on page 10-6.

Step 5
Click the Provisioning > Network tabs. Ensure that the IP settings and other Cisco Transport Controller (CTC) network access information is correct according to documentation provided by the network administrator. If not, see the “NTP-G81 Change CTC Network Access” procedure on page 10-18.

Step 6
Click the Provisioning > Protection tabs. Verify that all required protection groups have been created according to documentation provided by the network administrator. If not, see the “NTP-G33 Create a Y-Cable Protection Group” procedure on page 5-10 or the “NTP-G83 Modify or Delete Card Protection Settings” procedure on page 10-31.

Step 7
Click the Provisioning > Security tabs. Verify that all users have been created and that their security levels are correct according to documentation provided by the network administrator. If not, see the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

Step 8
If Simple Network Management Protocol (SNMP) is provisioned on the node, click the Provisioning > SNMP tabs. Verify that all SNMP settings are correct according to documentation provided by the network administrator. If not, see the “NTP-G89 Change SNMP Settings” procedure on page 10-61.

Step 9
Repeat this procedure at each node in the network.

Stop. You have completed this procedure.
NTP-G52 Verify Node-to-Node Connections

**Purpose**
This procedure verifies optical service channel (OSC) terminations between nodes and checks span attenuation. This procedure applies to all ROADM, OADM, and line amplifier locations.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G51 Verify DWDM Node Turn-Up, page 6-2

**Required/As Needed**
Required

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
Check to see if fiber is connected to the OPT-BST or OSC-CSM LINE RX and TX ports. If yes, continue with **Step 2**. If not, complete the following tasks:

a. Clean the fiber using the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.

b. Install the fiber using the “DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations Between Two Adjacent Nodes” task on page 3-51.

**Step 2**
Verify the network fiber connections:

- The east Line TX ports connect to the west Line RX ports of the adjacent node.
- The west Line RX ports connect to the east Line TX ports of the adjacent node.
- The west Line TX ports connect to the east Line RX ports of the adjacent node.
- The east Line RX ports connect to the west Line TX ports of the adjacent node.

**Step 3**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at a network node.

**Step 4**
Click the **Provisioning** > **Comm Channels** > **OSC** tabs. Verify that OSC terminations were created for the east and west OSC-CSM or OSCM cards and that the port state is In-Service and Normal (IS-NR [ANSI])/Unlocked-enabled (ETSI). If so, continue with **Step 5**. If OSC terminations are not created, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84.

**Step 5**
Complete the “NTP-G76 Verify Optical Span Loss Using CTC” procedure on page 10-2. If the measured span loss is within the minimum and maximum expected span loss values, continue with **Step 6**. If not, clean the fiber connected to the OPT-BST or OSC-CSM on both ends of the span, then repeat the “NTP-G76 Verify Optical Span Loss Using CTC” task on page 10-2. If the span loss is within the minimum and maximum expected span loss values, continue with **Step 6**. If not, contact your next level of support.

**Step 6**
Repeat Steps 2 through 5 at each network node.

**Stop. You have completed this procedure.**
NTP-G53 Set Up Timing

Purpose: This procedure provisions the ONS 15454 timing.
Tools/Equipment: None
Prerequisite Procedures: NTP-G51 Verify DWDM Node Turn-Up, page 6-2
Required/As Needed: Required
Onsite/Remote: Onsite or remote
Security Level: Provisioning or higher

Step 1: Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will set up timing. If you are already logged in, continue with Step 2.

Step 2: Complete the “DLP-G95 Set Up External or Line Timing” task on page 6-4 if an external building integrated timing supply (BITS) source is available. This is the common ONS 15454 timing setup procedure.

Step 3: If an external BITS source is not available, complete the “DLP-G96 Set Up Internal Timing” task on page 6-7. This task can only provide Stratum 3 timing.

Step 4: Repeat this procedure at each node in the network.

Stop. You have completed this procedure.

DLP-G95 Set Up External or Line Timing

Purpose: This task defines the ONS 15454 timing source (external or line).
Tools/Equipment: None
Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25
Required/As Needed: Required
Onsite/Remote: Onsite or remote
Security Level: Provisioning or higher

Step 1: In node view, click the Provisioning > Timing > General tabs.

Step 2: In the General Timing area, complete the following information:

- Timing Mode—Choose External if the ONS 15454 derives its timing from a BITS source wired to the backplane pins (ANSI) or a MIC-C/T/P FMEC (ETSI); choose Line if timing is derived from an OSC-CSM or OSCM card that is optically connected to the timing node. A third option, Mixed, allows you to set external and line timing references.

Note: Because Mixed timing might cause timing loops, Cisco does not recommend its use. Use this mode with care.
• SSM Message Set—For DWDM nodes, choose the Generation 2 synchronization status messaging (SSM) option. Generation 1 is used only by SONET or SDH ONS 15454s that are connected to equipment that does not support Generation 2.

• Quality of RES—If your timing source supports the reserved S1 byte, set the timing quality here. (Most timing sources do not use RES.) Qualities are displayed in descending quality order as ranges. For example, ST3<RES<ST2 means that the timing reference is higher than a Stratum 3 and lower than a Stratum 2. See Chapter 20, “Security Reference” for more information about SSM, including definitions of the SONET timing levels.

• Revertive—Select this check box if you want the ONS 15454 to revert to a primary reference source after the conditions that caused it to switch to a secondary timing reference are corrected.

• Revertive Time—If Revertive is checked, choose the amount of time that the ONS 15454 will wait before reverting to its primary timing source. Five minutes is the default.

**Step 3**

In the Reference Lists area, complete the following information:

---

**Note**

Reference Lists defines up to three timing references for the node and up to six BITS Out references. BITS Out references define the timing references used by equipment that can be attached to the node’s BITS Out pins on the backplane (ANSI) or FMEC (ETSI). If you attach equipment to BITS Out pins, you normally attach it to a node with Line mode, because equipment near the external timing reference can be directly wired to the reference.

• NE Reference—Allows you to define three timing references (Ref 1, Ref 2, Ref 3). The node uses Reference 1 unless a failure occurs to that reference, in which case the node uses Reference 2. If Reference 2 fails, the node uses Reference 3, which is typically set to Internal Clock. Reference 3 is the Stratum 3 clock provided on the TCC2/TCC2P card. The options displayed depend on the Timing Mode setting.
  - If the Timing Mode is set to External, your options are BITS-1, BITS-2, and Internal Clock.
  - If the Timing Mode is set to Line, your options are the node’s working OSCM cards, OSC-CSM cards, muxponder (MXP) cards, and Internal Clock. Choose the cards/ports that are directly or indirectly connected to the node wired to the BITS source. Set Reference 1 to the card that is closest to the BITS source. For example, if Slot 5 is connected to the node wired to the BITS source, choose Slot 5 as Reference 1.
  - If the Timing Mode is set to Mixed, both BITS references and OSC or MXP cards are available, allowing you to set a mixture of external BITS clocks and OSC or MXP cards as timing references.

• BITS-1 Out/BITS-2 Out—Sets the timing references for equipment wired to the BITS Out backplane (ANSI) or FMEC (ETSI) pins. BITS-1 Out and BITS-2 Out are enabled when BITS-1 Out and BITS-2 Out facilities are put in service. If Timing Mode is set to external, choose the OSC or MXP card used to set the timing. If Timing Mode is set to Line, you can choose an OSC or MXP card or choose NE Reference to have the BITS-1 Out and/or BITS-2 Out follow the same timing references as the network element (NE).

---

**Note**

All MXP card client ports are available for timing regardless of the card’s termination mode. MXP trunk ports can be a timing reference when ITU-T G.709 is set to OFF and the Termination Mode is set to LINE.
Step 4  Click **Apply**.

Step 5  Click the **BITS Facilities** tab.

Step 6  In the BITS Facilities area, complete the following information:

| Note | The BITS Facilities section sets the parameters for your BITS-1 and BITS-2 timing references. Many of these settings are determined by the timing source manufacturer. If equipment is timed through BITS Out, you can set timing parameters to meet the requirements of the equipment. |

- BITS In State—If Timing Mode is set to External or Mixed and one or both BITS input pin pairs on the backplane (ANSI) or FMEC (ETSI) are connected to the external timing source, set the BITS In State for BITS-1 and/or BITS-2 to **IS** (In Service). If Timing Mode is set to Line, set the BITS In State to **OOS** (Out of Service).
- BITS Out State—If equipment is connected to the node’s BITS output pins on the backplane (ANSI) or FMEC (ETSI) and you want to time the equipment from a node reference, set the BITS Out State for BITS-1 and/or BITS-2 to **IS**, depending on which BITS Out pins are used for the external equipment. If equipment is not attached to the BITS output pins, set the BITS Out State to **OOS**.

Step 7  If the BITS In State for BITS-1 and BITS-2 is set to OOS, continue with **Step 8**. If the BITS In State is set to IS for either BITS-1 or BITS-2, complete the following information:

- Coding—Set to the coding used by your BITS reference, either B8ZS (binary 8-zero substitution) or AMI (alternate mark inversion).
- Framing—Set to the framing used by your BITS reference, either ESF (Extended Super Frame) or SF (D4) (Super Frame).
- Sync Messaging—Check to enable SSM. SSM is not available if Framing is set to SF (D4).
- AIS Threshold—If SSM is disabled or SF (D4) is used, set the quality level at which a node sends an alarm indication signal (AIS) from the BITS-1 Out and BITS-2 Out backplane (ANSI) or FMEC (ETSI) pins. An AIS is raised when the optical source for the BITS reference falls to or below the SSM quality level defined in this field.
- LBO—If you are timing an external device connected to the BITS Out pins, set the distance between the device and the ONS 15454. Options are: 0-134 ft. (default), 124-266 ft., 267-399 ft., 400-533 ft., and 534-655 ft. Line build out (LBO) relates to the BITS cable length.

Step 8  Click **Apply**.

| Note | Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for timing-related alarms. |

Step 9  Return to your originating procedure (NTP).
DLP-G96 Set Up Internal Timing

Purpose
This task sets up internal timing (Stratum 3) for an ONS 15454.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed (use only if a BITS source is not available)

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Internal timing is Stratum 3 and is not intended for permanent use. All ONS 15454 SONET or SDH nodes should be timed to a Stratum 2 or better primary reference source. Internal timing is appropriate for DWDM nodes.

Step 1
In node view, click the Provisioning > Timing > General tabs.

Step 2
In the General Timing area, enter the following:
- Timing Mode—Set to External.
- SSM Message Set—Set to Generation 1.
- Quality of RES—Does not apply to internal timing.
- Revertive—Does not apply to internal timing.
- Revertive Time—Does not apply to internal timing.

Step 3
In the Reference Lists area, enter the following information:
- NE Reference
  - Ref 1—Set to Internal Clock.
  - Ref 2—Set to Internal Clock.
  - Ref 3—Set to Internal Clock.
- BITS-1 Out/BITS-2 Out—Set to None.

Step 4
Click Apply.

Step 5
Click the BITS Facilities tab.

Step 6
In the BITS Facilities area, change the BITS In State and BITS Out State to OOS for BITS 1 and BITS 2. Disregard the other BITS Facilities settings; they are not relevant to internal timing.

Step 7
Click Apply.

Step 8
Return to your originating procedure (NTP).
NTP-G54 Provision and Verify a DWDM Network

Purpose
This procedure verifies the performance of all cable connections and cards in a network topology. You can also use this procedure to troubleshoot any problems with DWDM network setup.

Tools/Equipment
Test set or protocol analyzer

Cisco MetroPlanner Traffic Matrix

Prerequisite Procedures
DLP-G277 Provision a Multirate PPM, page 5-3
DLP-G278 Provision the Optical Line Rate, page 5-6
NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and TXP_MR_10E Cards, page 5-12
NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 5-31
NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 5-48
NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 5-65

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into an ONS 15454 on the network.

Step 2
Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 3
Using the Cisco MetroPlanner Traffic Matrix (see Table 3-1 on page 3-3) for your site, identify the first channel (ITU wavelength) to be provisioned. Use the transponder (TXP), MXP, or line card that corresponds to the selected wavelength.

Step 4
As needed, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 6-11. This is an optional step requiring data communications channel (DCC) connectivity between the node and subtended client shelf or generic communications channel (GCC) connectivity between the TXPs.

Step 5
Create the optical channels at all sites according to the Cisco MetroPlanner Traffic Matrix. Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10.

Note
Every time a channel is created on the DWDM network, the amplifiers automatically calculate the optical output power to maintain a constant power level on each channel. Automatic power control (APC) also starts every 60 minutes. If the span length changes, APC modifies amplifier gains and express variable optical attenuation (VOA). For more information about APC, see the “18.4 Automatic Power Control” section on page 18-18.

Step 6
Select one of the nodes and go to node view.
Chapter 6      Turn Up Network

NTP-G54 Provision and Verify a DWDM Network

Step 7  If an OPT-PRE is installed, complete the following steps. If not, continue with Step 8.
   a.  Display the OPT-PRE card in card view.
   c.  Locate the Port 2 Signal Output Power. Verify that this value is equal to or higher than the Channel Power Ref value, which you can view by scrolling to the right. If so, continue with Step d. If the value is lower, contact your next level of support.

   Note  If the OPT-PRE is not carrying traffic, the values will not match.

   d.  Repeat Steps a through c for the second OPT-PRE, if one is installed. If not, continue with Step 8.

Step 8  If an OPT-BST is installed, complete the following steps. If not, continue with Step 9.
   a.  Display the OPT-BST card in card view.
   c.  Locate the Port 6 Signal Output Power. Verify that this value is equal to or higher than the Channel Power Ref value, which you can view by scrolling to the right. If so, continue with Step d. If the value is lower, contact your next level of support.

   Note  If the OPT-BST is not carrying traffic, the values will not match.

   d.  Repeat Steps a through c for the second OPT-BST, if one is installed. If not, continue with Step 9.

Step 9  If the node is a fixed OADM with AD-xC-xx.x or AD-xB-xx.x cards installed, and it has a circuit that is carrying traffic for the first time, complete one of the following procedures. If not, continue with Step 10.
   •  If the circuit is terminated inside the node, change to node view (single-node mode) or multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > Provisioning tabs. In the Selector area, click the West Pin > Pin AD Stage parameters. Verify that the value matches the value shown in the COM RX port of the first OADM card in your circuit heading west to east, ± 2 dB. If the values are outside of the error margins, contact your next level of support.
   •  If the circuit passes through the node, change to node view (single-node mode) or multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > Provisioning tabs. Click the West Pin > Pin AD Stage parameters. Verify that the value matches the value shown in the COM RX port for the first OADM card in your circuit heading west to east, ± 2 dB. Click East Pin and then Pout AD Stage. Verify that the value matches the value shown in the COM TX port for the first OADM card in your circuit heading west to east, ± 1 dB. If the values are outside of the ± 1 dB error margins, contact your next level of support.
   •  If the circuit starts from the node, change to node view (single-node mode) or multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > Provisioning tabs. Click the East Pin and then the Pin AD Stage parameters. Verify that the value matches the value shown in the COM TX port for the first OADM card in your circuit heading west to east, ± 1 dB. If the values are outside of the error margins, contact your next level of support.

Step 10  Check the received power range:
   a.  Navigate to the node where the first TXP, MXP, or line card is installed.
   b.  Display the TXP, MXP, or line card in card view.
   c.  Complete the “DLP-G136 Clear Selected PM Counts” task on page 9-7.
   d.  Click the Performance > Optics PM tabs.
e. Record the values shown in the RX Optical Pwr field.

f. Click the Provisioning > Optics Thresholds tabs.

g. Verify that the value in Step e falls between the values shown for the RX Power High and RX Power Low. If so, continue with Step 11. If not, complete one of the following.
   - Power lower than range—Clean the trunk fiber at the patch panel and on the TXP or MXP. Repeat Steps e through g. If the power is still too low, contact your next level of support.
   - Power higher than range—Add attenuation to the fiber and repeat Steps e through g.

Step 11 Perform a short-term bit error rate (BER) test:

a. Complete the “DLP-G136 Clear Selected PM Counts” task on page 9-7 for the TXP, MXP, or line card.

b. Display the TXP, MXP, or line card in card view.

c. Click the Performance > Payload PM tabs, or, if OTN is provisioned, the Performance > OTN PM tabs.

d. Perform a short-term BER test using a test signal from a test set or protocol analyzer.

e. Monitor the payload performance monitoring (PM) for at least 10 minutes for errors.

Note To see an accurate PM count, the BER test results must be consistent with the transmitted bit rate for at least 10 minutes.

Note For information about using a test set or protocol analyzer, refer to the test set or protocol analyzer user guide.

Step 12 Repeat Steps 6 through 11 for all sites that have add/drop traffic.

Step 13 If a node fails any test, verify correct setup and configuration and then repeat the test. If the test fails again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for service.

Stop. You have completed this procedure.
DLP-G99 Create a Provisionable Patchcord

**Purpose**
This task creates a provisionable patchcord, also called a virtual link. They appear as dashed lines in CTC network view.

For the specific situations in which a patchcord is necessary, see the “22.3 Provisionable Patchcords” section on page 22-21.

**Tools/Equipment**
OC-N, TXP, MXP, OADM, MUX, and DMX cards

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Note**
This task requires DCC connectivity between the node and the subtended client shelves, or GCC connectivity between the TXPs.

**Note**
An optical port requires two patchcords when the remote end is Y-cable protected or is an add/drop multiplexer or multiplexer/demultiplexer port.

---

**Step 1**
In node view, click the Provisioning > Comm Channels > Provisionable Patchcords tabs. If you are in network view, click the Provisioning > Provisionable Patchcords tabs.

**Step 2**
Click Create. The Provisionable Patchcord dialog box appears.

**Step 3**
In the Origination Node area, complete the following:

a. If you are in node view, the Origination Node defaults to the current node. If you are in network view, click the desired origination node from the drop-down list.

b. Type a patchcord identifier (0 through 32767) in the TX and RX ID fields.

c. Click the desired origination slot/port from the list of available slots/ports.

**Step 4**
In the Termination Node area, complete the following:

a. Click the desired termination node from the drop-down list. If the remote node has not previously been discovered by CTC but is accessible by CTC, type the name of the remote node.

b. Type a patchcord identifier (0 through 32767) in the TX and RX ID fields. The origination and termination IDs must be different if the patchcord is set up between two cards on the same node.

c. Click the desired termination slot/port from the list of available slots/ports. The origination port and the termination port must be different.

**Step 5**
If you need to provision transmit (Tx) and receive (Rx) separately for multiplexer/demultiplexer cards, check the Separate Tx/Rx check box. If not, continue with Step 6. The origination and termination TX ports are already provisioned. Complete the following to provision the RX ports:

a. In the Origination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The origination TX and RX IDs and the termination TX and RX IDs must be different.

b. Click the desired origination slot/port from the list of available slots/ports.

c. In the Termination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The origination TX and RX IDs and the termination TX and RX IDs must be different.
NTP-G56 Verify the OSNR

Purpose
This procedure verifies the optical signal-to-noise ratio (OSNR). The OSNR is the ratio between the signal power level and the noise power level.

Tools/Equipment
Optical spectrum analyzer

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network.

Step 2
Using an optical spectrum analyzer, check the received OSNR for each transmitted channel on both ends of the span. Identify the last OSC-CSM, OPT-PRE, or OPT-BST MON port that the channel passes through before the channel is dropped. If OPT-PRE cards are installed with an OPT-BST or OSC-CSM card, use the OPT-PRE MON port.

Note
For OSNR values for each card class, refer to Chapter 16, “Card Reference.”

Step 3
If the OSNR is too low, check the following, depending on your node configuration:

Note
The purpose of this step is not to improve the signal-to-noise ratio (SNR), but to match the per-channel power level within the RX port power range.

- Check the fiber connections between the OPT-BST or OSC-CSM and the OPT-PRE amplifier. If needed, clean the connectors. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25.
- On the near-end OPT-BST amplifier, check the equalization of the added channels at the monitor output.
- On the OPT-PRE amplifier, check the output power on both COM TX and DC TX ports.
- On the far-end OPT-PRE amplifier, check the amplifier gain tilt at the monitor output.

If the OSNR is still too low, contact your next level of support.

Step 4
Repeat Steps 2 and 3 for all traffic in the network.

Stop. You have completed this procedure.
**Purpose**
This procedure tests the optical path, client transponders, and Y-cable protection groups in your system for proper operation. The test signals can be generated by either the actual client device or a test set, whichever is available. Cisco recommends that you repeat this test at each node in the network where protection group traffic is dropped.

**Tools/Equipment**
A list of protection groups. This information is provided in the Cisco MetroPlanner Traffic Matrix.
A test set or actual client device that provides the required payload for the circuits that are provisioned.

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite; personnel are required to be on site at each end of the circuit under test.

**Security Level**
Provisioning or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network.

**Step 2**
Identify the Y-cable circuit to be tested by viewing the Traffic Matrix for your site. Locate the transponders in the ONS 15454 node that will be used for the protection group.

**Step 3**
Verify that the Y-cable protection group is provisioned:
- In node view, click the **Provisioning > Protection** tabs.
- In the Protect and Working areas, confirm the correct transponders are in the Y-cable protection group by viewing the slot number and card type.
- If the required protection group is not provisioned, stop and perform “NTP-G33 Create a Y-Cable Protection Group” procedure on page 5-10. Otherwise continue with Step 4.

**Step 4**
Repeat Step 3 for each Y-cable protection group at this node. When all protection groups are verified, proceed to Step 5.

**Step 5**
Physically connect the transmitter of the client or test set to either Port 10 or Port 12 of the Y-cable module protecting the circuit under test. (See Table 3-4 on page 3-79 and Table 3-5 on page 3-80.)

**Step 6**
If you connected the transmitter to Port 10, connect the client or test set receiver to Port 5 on the Y-cable module. If not, connect the client or test set receiver to Port 11 of the Y-cable module.

**Step 7**
At the far-end site for the circuit under test, physically loop the Y-cable module as follows:
- If this is the first client on the Y-cable module, loop Port 10 to Port 5 on the far-end Y-cable module.
- If this is the second client on the Y-cable module, loop Ports 11 and 12 on the far-end Y-cable module.

**Step 8**
At the near-end site for the circuit under test, place the client device or test set into service and begin transmitting the required payload.

**Step 9**
In CTC, display the near-end site in node view.

**Step 10**
Click the **Maintenance > Protection** tabs (Figure 6-1).
Step 11 In the Protection Groups area, highlight the protection group to be tested.

Step 12 In the Selected Group area, identify the slot that is Active and the slot that is Standby.

Step 13 Verify that the LED display on the physical cards in the shelf match the following:
   a. For the Active TXP card, record the slot number: ______. Verify the port LEDs are as follows:
      - DWDM port is green.
      - Client port is green.
   b. For the Standby TXP card, record the slot number: ______. Verify port LEDs are as follows:
      - DWDM Port is green.
      - Client Port is not illuminated.

Step 14 In the Selected Group area, highlight the Active transponder slot.

Step 15 From the Switch Commands area below the Selected Group area, click Manual, then click YES.

Step 16 From the Selected Group area, record the following information and verify the active and standby transponder slots are the opposite of Step 13.
   - Active TXP card slot number: ______
   - Standby TXP card slot number: ______

Step 17 Verify that the LED displays on the physical cards in the shelf match the following:
   a. For the Active transponder slot LEDs:
      - DWDM port is green.
      - Client port is green.
b. For the Standby transponder slot LEDs:
   – DWDM Port is green.
   – Client Port is not illuminated.

**Step 18** Confirm that the client or test set at the local site is operating normally with no alarms. If the test set is reporting active alarms, contact your next level of support.

**Note** It is normal to see a traffic hit on the test set during a protection switch.

**Step 19** From the Switch Commands area below the Selected Group area, click **Clear**, then click **YES** to return the protection group to the original state.

**Step 20** Repeat Steps 5 through 19 for each protection group at your site.

Stop. You have completed this procedure.

---

**NTP-G57 Create a Logical Network Map**

**Purpose**
This procedure allows a Superuser to create a consistent network view for all nodes on the network.

**Tools**
None

**Prerequisite Procedures**
This procedure assumes that network turn-up is complete.

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to create the network map. If you are already logged in, continue with Step 2.

**Step 2** From the View menu, choose **Go to Network View**.

**Step 3** Change the position of the nodes in the network view according to your site plan.

a. Click a node to select it, then press the **Ctrl** key while you drag and drop the node icon to a new location.

b. Repeat Step a for each node you need to position.

**Step 4** On the network view map, right-click and choose **Save Node Position** from the shortcut menu.

**Step 5** Click **Yes** in the Save Node Position dialog box.

CTC opens a progress bar and saves the new node positions.
**Note**  Retrieve, Provisioning, and Maintenance users can move nodes on the network map, but only Superusers can save new network map configurations. To restore the view to a previously saved version of the network map, right-click the network view map and choose **Reset Node Position**.

Stop. You have completed this procedure.
Create Channels and Circuits

This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM) optical channel network connections (OCHNCs) and overhead circuits.

Note
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide and the Cisco ONS 15454 SDH Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G58 Locate and View Optical Channel Network Connections, page 7-2—Complete as needed to find, view, and filter OCHNCs.
2. NTP-G59 Create and Delete Optical Channel Network Connections, page 7-9—Complete as needed.
3. NTP-G60 Create Overhead Circuits, page 7-13—Complete as needed to create IP-encapsulated, firewall, and proxy tunnels, to create generic communications channel (GCC) terminations, to provision orderwire, or to create user data channel (UDC) circuits.
4. NTP-G61 Modify and Delete Overhead Circuits, page 7-21—Complete as needed to repair IP circuits and delete overhead circuits.
5. NTP-G62 Create a J0 Section Trace, page 7-23—Complete as needed to monitor interruptions or changes to traffic between two nodes.
## NTP-G58 Locate and View Optical Channel Network Connections

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure allows you to locate and view DWDM OCHNCs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G105 Provision DWDM Optical Channel Network Connections, page 7-10</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Retrieve or higher</td>
</tr>
</tbody>
</table>

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to view the circuits. If you are already logged in, continue with Step 2.

**Note** Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this option is checked.

**Step 2** As needed, complete the “DLP-G100 Search for Optical Channel Network Connections” task on page 7-2.

**Step 3** As needed, complete the “DLP-G101 View Optical Channel Network Connection Information” task on page 7-3.

**Step 4** As needed, complete the “DLP-G102 Filter the Display of Optical Channel Network Connections” task on page 7-7.

**Step 5** As needed, complete the “DLP-G103 View Optical Channel Network Connections on a Span” task on page 7-8.

Stop. You have completed this procedure.

---

### DLP-G100 Search for Optical Channel Network Connections

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task searches for DWDM OCHNCs and ONS 15454 circuits at the network, node, or card level.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Retrieve or higher</td>
</tr>
</tbody>
</table>

**Step 1** Navigate to the appropriate Cisco Transport Controller (CTC) view:

- To search the entire network, choose **View > Go to Network View**.
To search for circuits that originate, terminate, or pass through a specific node, choose View > Go to Other Node, then choose the node you want to search and click OK.

To search for circuits that originate, terminate, or pass through a specific card, double-click the card on the shelf graphic in node view to open the card in card view.

**Step 2**
Click the Circuits tab.

**Step 3**
If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope drop-down list located at the bottom right side of the screen. Choose Node to see all of the circuits on that node, or Network (All) to see all circuits in the network.

**Step 4**
Click Search if you need to search through the list of circuits.

**Step 5**
In the Circuit Name Search dialog box, complete the following:
- Find What—Enter the text of the circuit name you want to find.
- Match whole word only—Check this check box to instruct CTC to select circuits only if the entire word matches the text in the Find What field.
- Match case—Check this check box to instruct CTC to select circuits only when the capitalization matches the capitalization entered in the Find What field.
- Direction—Choose the direction for the search. Searches are conducted up or down from the currently selected circuit.

**Step 6**
Click Find Next. If a match is found the circuit will be highlighted. To continue the search, click Find Next again to find the next circuit.

**Step 7**
Repeat Steps 5 and 6 until you are finished, then click Cancel.

**Step 8**
Return to your originating procedure (NTP).

---

**DLP-G101 View Optical Channel Network Connection Information**

**Purpose**
This task provides information about DWDM OCHNCs and ONS 15454 circuits.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

**Step 1**
Navigate to the appropriate CTC view:

---

**Note**
The following order is the default column sequence, the order might be different on your screen, depending on your individual CTC setup.

- To view circuits for an entire network, choose View > Go to Network View.
- To view circuits that originate, terminate, or pass through a specific node, choose View > Go to Other Node, then choose the node you want to search and click OK.
To view circuits that originate, terminate, or pass through a specific card, in node view, double-click the card containing the circuits you want to view.

**Note** In node or card view, you can change the scope of the circuits that appear by choosing Card (in card view), Node, or Network from the Scope drop-down list in the bottom right corner of the Circuits window.

**Step 2** Click the **Circuits** tab. The Circuits tab shows the following information:

- **Circuit Name**—Name of the circuit. The circuit name can be manually assigned or automatically generated.
- **Type**—Circuit types are OCHNC.

**Note** The following circuit types are not applicable to DWDM nodes: STS, VT, VTT (VT tunnel), VAP (VT aggregation point), STS-v (STS VCAT circuit), VT-v (VT VCAT circuit), HOP (high-order circuit), LOP (low-order circuit), VCT (VC low-order tunnel), and VCA (low-order VCAT circuit).

- **Size**—Circuit size. OCHNC sizes are Equipped not specific, Multi-rate, 2.5 Gbps No FEC (forward error correction), 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC.

**Note** The following circuit types under the circuit size column are not applicable to DWDM nodes: STS, VT, VCAT, VC12, VC11, VC3, and VC4.

- **OCHNC Wlen**—The wavelength provisioned for the OCHNC. See Table 7-3 on page 7-11 for a list of channels and wavelengths.
- **Direction**—The circuit direction, either two-way or one-way.
- **OCHNC Dir**—The line direction of the OCHNC, either East to West or West to East. If the direction is West to East, the channel exits from the node through the LINE-TX port of the OSC-CSM-E or OPT-BST-E, named the East Side Card by Cisco MetroPlanner (typically these cards are hosted by Slot 17). If the direction is East to West, the channel exits from the node through the LINE-TX port of OSC-CSM-W or OPT-BST-W, named the West Side Card by Cisco MetroPlanner (typically these cards are hosted by Slot 1).
- **Protection**—The type of circuit protection. See Table 7-1 on page 7-5 for a list of protection types.
- **Status**—The circuit status. Table 7-2 on page 7-6 lists the circuit statuses that can appear.
- **Source**—The circuit source in the format: `node/slot/port "port name"` (if a port name has been assigned by the user, the name will appear in quotes).

**Note** The user can assign a specific port name to every port of any DWDM card after completing the “DLP-G104 Assign a Name to a Port” task on page 7-10.

- **Destination**—The circuit destination in same format as the circuit source. STSs, VTs, VCs, and tributary units are not applicable to DWDM nodes.
- **# of VLANS**—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to DWDM nodes.
- **# of Spans**—The number of internode links that constitute the circuit.
State—The circuit service state, which is an aggregate of its cross-connects. For ANSI, the service state is IS, OOS, or OOS-PARTIAL. For ETSI, the service state is Unlocked, Locked, or Locked-partial. For more information about ANSI and ETSI service states, see the Appendix C, “DWDM Administrative and Service States.”

- IS/Unlocked—All cross-connects are in service and operational.
- OOS/Locked—For ANSI, all cross-connects are Out-of-Service and Management, Maintenance (OOS-MA,MT) and/or Out-of-Service and Management, Disabled (OOS-MA,DSBLD). For ETSI, all cross-connects are Locked-enabled,maintenance and/or Locked-enabled,disabled.
- OOS-PARTIAL/Locked-partial—At least one cross-connect is In-Service and Normal (IS-NR [ANSI]) or Unlocked-enabled (ETSI) and others are out-of-service.

Note

Right-clicking a column title (Circuit name, Type, etc.) opens a shortcut menu that allows you to show or hide the desired circuit details.

<table>
<thead>
<tr>
<th>Table 7-1 Circuit Protection Types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protection Type</strong></td>
</tr>
<tr>
<td>Y-Cable</td>
</tr>
<tr>
<td>Splitter</td>
</tr>
<tr>
<td>Unprot</td>
</tr>
<tr>
<td>N/A</td>
</tr>
<tr>
<td>Unknown</td>
</tr>
</tbody>
</table>
### Table 7-2  
**Cisco ONS 15454 Circuit Status**

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition/Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATING</td>
<td>CTC is creating a circuit.</td>
</tr>
<tr>
<td>DISCOVERED</td>
<td>CTC created a circuit. All components are in place and a complete path exists from the circuit source to the circuit destination.</td>
</tr>
<tr>
<td>DELETING</td>
<td>CTC is deleting a circuit.</td>
</tr>
<tr>
<td>PARTIAL</td>
<td>A CTC-created circuit is missing a cross-connect or network span, a complete path from source to destination(s) does not exist, or an alarm interface panel (AIP) change occurred on one of the circuit nodes and the circuit is in need of repair. (AIPs store the node MAC address.) In CTC, circuits are represented using cross-connects and network spans. If a network span is missing from a circuit, the circuit status is PARTIAL. However, a PARTIAL status does not necessarily mean that a circuit traffic failure has occurred, because traffic might flow on a protect path. Network spans are in one of two states: up or down. On CTC circuit and network maps, up spans are shown as green lines, and down spans are shown as gray lines. If a failure occurs on a network span during a CTC session, the span remains on the network map but its color changes to gray to indicate the span is down. If you restart your CTC session while the failure is active, the new CTC session cannot discover the span and its span line will not appear on the network map. Subsequently, circuits routed on a network span that goes down will appear as DISCOVERED during the current CTC session, but they will appear as PARTIAL to users who log in after the span failure. This status does not appear for OCHNC circuit types.</td>
</tr>
<tr>
<td>DISCOVERED_TL1</td>
<td>A TL1-created circuit or a TL1-like CTC-created circuit is complete. A complete path from source to destination(s) exists. This status does not appear for OCHNC circuit types.</td>
</tr>
<tr>
<td>PARTIAL_TL1</td>
<td>A TL1-created circuit or a TL1-like CTC-created circuit is missing a cross-connect, and a complete path from source to destination(s) does not exist. This status does not appear for OCHNC circuit types.</td>
</tr>
</tbody>
</table>

**Step 3**

Return to your originating procedure (NTP).
DLP-G102 Filter the Display of Optical Channel Network Connections

Purpose
This task filters the display of OCHNCs and circuits in the Circuits window. You can filter the circuits in network, node, or card view based on circuit or OCHNC name, size, type, direction, and other attributes.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
Navigate to the appropriate CTC view:
- To filter network circuits, choose View > Go to Network View.
- To filter circuits that originate, terminate, or pass through a specific node, choose View > Go to Other Node, then choose the node you want to search and click OK.
- To filter circuits that originate, terminate, or pass through a specific card, double-click the card on the shelf graphic in node view to open the card in card view.

Step 2
Click the Circuits tab.

Step 3
Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. In the Circuit Filter dialog box, set the filter attributes by choosing one or more of the following:
   - Name—Enter a complete or partial circuit name to filter circuits based on the circuit name; otherwise leave the field blank.
   - Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way circuits), or 2-way (display only two-way circuits).
   - OCHNC Dir—(DWDM OCHNCs only) Choose one: East to West (displays only east-to-west circuits) or West to East (displays only west-to-east circuits).
   - OCHNC Wlen—(DWDM OCHNCs only) Choose an OCHNC wavelength to filter the circuits. For example, choosing 1530.33 will display channels provisioned on the 1530.33-nm wavelength.
   - Status—Choose one: Any (status not used to filter circuits) or Discovered (display only discovered circuits). Other statuses do not apply to OCHNCs.
   - State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits; IS (ANSI) or Unlocked (ETSI) to display only in-service circuits (OCHNCs have IS/Unlocked states only); or OOS-PARTIAL (ANSI) or Locked-partial (ETSI) to display only circuits with cross-connects in mixed service states.
   - Slot—Enter a slot number to filter circuits based on the source or destination slot; otherwise leave the field blank.
   - Port—Enter a port number to filter circuits based on the source or destination port; otherwise leave the field blank.
   - Type—Choose one: Any (type not used to filter circuits) or OCHNC (displays only OCHNCs).
Note
The following circuit types are not applicable to DWDM nodes: STS (displays only STS circuits), VT (displays only VT circuits), VT Tunnel (displays only VT tunnels), STS-V (displays STS VCAT circuits), VT-V (displays VT VCAT circuits), and VT Aggregation Point (displays only VT aggregation points), VC_HO_PATH_CIRCUIT (displays VC4 and VC4-Nc circuits), VC_LO_PATH_CIRCUIT (displays only VC3 and VC12 circuits), VC_LO_PATH_TUNNEL (displays only low-order tunnels), VC_LO_PATH_AGGREGATION (displays only log-order aggregation points), VC_HO_PATH_VCAT_CIRCUIT (displays high-order VCAT circuits), VC_LO_PATH_VCAT_CIRCUIT (displays low-order VCAT circuits).

- Size—Click the appropriate check boxes to filter circuits based on size: Multi-rate, Equipment non specific, 2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, or 10 Gbps No FEC.

Note
VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.

The check boxes shown depend on the Type field selection. If you chose Any, all sizes are available. If you chose OCHNC as the circuit type, only Multi-rate, Equipment non specific, 2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear.

Step 4 Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits window.

Step 5 To turn filtering off, click the Filter icon in the lower right corner of the Circuits window. Click the icon again to turn filtering on, and click the Filter button to change the filter attributes.

Step 6 Return to your originating procedure (NTP).

**DLP-G103 View Optical Channel Network Connections on a Span**

**Purpose**
This task allows you to view OCHNCs and circuits on an ONS 15454 span.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G105 Provision DWDM Optical Channel Network Connections, page 7-10
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

**Step 1** In node view, choose View > Go to Network View. If you are already in network view, continue with Step 2.

**Step 2** Right-click the green line containing the circuits you want to view and choose Circuits to view DWDM OCHNCs or unprotected circuits on the span.
In the Circuits on Span dialog box, you can view information about the circuits that traverse the span. The information that appears depends on the circuit type. For DWDM OCHNCs, the following information appears:

- OCHNC Wavelength—The wavelength provisioned for the OCHNC.
- DIR—2-way or 1-way.
- OCHNC Dir—The direction provisioned for the OCHNC, either east-to-west or west-to-east.
- Circuit—The OCHNC circuit name.

**Step 3**  
Return to your originating procedure (NTP).

---

### NTP-G59 Create and Delete Optical Channel Network Connections

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure creates and deletes DWDM OCHNCs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>Chapter 3, “Turn Up a Node”</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Provisioning or higher</td>
</tr>
</tbody>
</table>

**Step 1**  
Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to create and delete OCHNCs. If you are already logged in, continue with Step 2.

**Step 2**  
If you want to assign a name to the OCHNC source and destination ports before you create the circuit, complete the “DLP-G104 Assign a Name to a Port” task on page 7-10. If not, continue with the next step.

**Step 3**  
Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10 as needed.

**Step 4**  
Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 as needed.  
Stop. You have completed this procedure.
DLP-G104 Assign a Name to a Port

**Purpose**
This task assigns a name to a port on any ONS 15454 card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
Double-click the card that has the port you want to provision. This can be any port on a traffic carrying card.

**Step 2**
Click the **Provisioning** tab.

**Step 3**
Click the **Port Name** column for the port number to which you are assigning a name.

**Step 4**
Type the port name. The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

**Step 5**
Click **Apply**.

**Step 6**
Return to your originating procedure (NTP).

DLP-G105 Provision DWDM Optical Channel Network Connections

**Purpose**
This task creates an OCHNC between ONS 15454s that are provisioned for DWDM.

**Tools/Equipment**
An OCHNC add port on the source node and an OCHNC drop port on destination node of the same wavelength are required.

DLP-G46 Log into CTC, page 2-25

**Prerequisite Procedures**
All procedures in Chapter 3, “Turn Up a Node” must be completed at all nodes within the OCHNC route.

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

**Step 1**
Choose View > Go to Network View.

**Step 2**
Click the **Circuits** tab, then click **Create**.

**Step 3**
In the Circuit Creation dialog box, choose **OCHNC** from the Circuit Type list.

**Step 4**
Click **Next**.

**Step 5**
Define the circuit attributes:
- Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters (including spaces). Circuit names should be 44 characters or less if you want the ability to create monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.
- Size—Equipped non specific is the default. You cannot change it.
- OCHNC Channel—Choose the wavelength you want to provision. Table 7-3 lists the thirty-two available wavelengths.

Table 7-3  **OCHNC Channels**

<table>
<thead>
<tr>
<th>Channel No.</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td>2</td>
<td>31.2</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td>3</td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td>4</td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td>5</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td>6</td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td>7</td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td>8</td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td>9</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td>10</td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td>11</td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td>12</td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td>13</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td>14</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td>15</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td>16</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td>17</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td>18</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td>19</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td>20</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td>21</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td>22</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td>23</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td>24</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td>25</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td>26</td>
<td>54.9</td>
<td>192.8</td>
<td>1544.94</td>
</tr>
<tr>
<td>27</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td>28</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
</tr>
<tr>
<td>29</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td>30</td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td>31</td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td>32</td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
</tbody>
</table>
Chapter 7  Create Channels and Circuits

DLP-G106 Delete Optical Channel Network Connections

- **OCHNC Direction**—Choose the OCHNC direction, either East to West or West to East. If you choose West to East, the channel will exit the node through the LINE-TX port of the OSC-CSM-E or OPT-BST-E, named the East Side Card by Cisco MetroPlanner (typically these cards are hosted by Slot 17). If you choose East to West, the channel will exit the node through the LINE-TX port of the OSC-CSM-W or OPT-BST-W, named the West Side Card by Cisco MetroPlanner (typically these cards are hosted by Slot 1).

- **Bidirectional**—Check this check box to create a bidirectional OCHNC; uncheck it to create a unidirectional OCHNC.

**Step 6**  Click *Next*.

**Step 7**  In the Circuit Source area, choose the source node from the Node drop-down list.

**Step 8**  Click *Next*.

**Step 9**  In the Circuit Destination area, choose the destination node from the Node drop-down list.

**Step 10**  Click *Finish*. The circuit might take a few minutes to come up, depending on the size of the network. If problems persist, refer to the *Cisco ONS 15454 DWDM Troubleshooting Guide* as necessary.

**Step 11**  Return to your originating procedure (NTP).

---

**DLP-G106 Delete Optical Channel Network Connections**

**Purpose**  This task deletes circuits and DWDM OCHNCs.

**Tools/Equipment**  None

**Prerequisite Procedures**  DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Provisioning or higher

**Step 1**  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2, or record the circuit information if it will be recreated.

**Step 2**  Consult your network operations center (NOC) or other appropriate personnel to verify that the OCHNC can be safely deleted.

**Step 3**  Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion.

**Step 4**  Choose View > Go to Network View.

**Step 5**  Click the Circuits tab.

**Step 6**  Choose the OCHNCs you want to delete, then click *Delete*.

**Step 7**  In the Delete Circuits confirmation dialog box, check Notify when completed, as needed.

If checked, the CTC Alerts confirmation dialog box indicates when the OCHNC is deleted. During this time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.
Chapter 7  Create Channels and Circuits

NTP-G60 Create Overhead Circuits

Note  The CTC Alerts dialog box will not automatically open to show a deletion error unless you checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-32. If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle inside the CTC Alerts toolbar icon indicates that a notification exists.

Step 8  Complete one of the following:
- If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the information, continue with Step 9. If you do not want to save the information, continue with Step 10.
- If you did not check Notify when completed, the Circuits window appears. Continue with Step 11.

Step 9  If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you do not want to save it, continue with Step 10.
   a. Click Save.
   b. Click Browse and navigate to the directory where you want to save the file.
   c. Type the file name using a .txt file extension, and click OK.

Step 10  Click Close to close the CTC Alerts dialog box.

Step 11  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2 if you require a backup of your changes.

Step 12  Return to your originating procedure (NTP).

NTP-G60 Create Overhead Circuits

Purpose  This procedure creates overhead circuits on an ONS 15454 network. Overhead circuits include generic communications channels (GCCs), IP-encapsulated tunnels, the AIC-I card orderwire, and the AIC-I card UDC.

Tools/Equipment  None
Prerequisite Procedures  None
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Provisioning or higher

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will create the overhead circuit. If you are already logged in, continue with Step 2.

Step 2  Choose View > Go to Network View.

Step 3  As needed, complete the “DLP-G76 Provision GCC Terminations” task on page 7-14.

Step 4  As needed, complete the “DLP-G97 Provision a Proxy Tunnel” task on page 7-15.

Step 5  As needed, complete the “DLP-G98 Provision a Firewall Tunnel” task on page 7-16.
Step 6  As needed, complete the “DLP-G107 Create an IP-Encapsulated Tunnel” task on page 7-17, then continue with the next step.

Step 7  After creating an IP-encapsulated tunnel, put the ports that are hosting the IP-encapsulated tunnel in service. See the “DLP-G108 Change the Service State for a Port” task on page 7-18.

Step 8  As needed, complete the “DLP-G109 Provision Orderwire” task on page 7-19.

Step 9  As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 7-20.

Stop. You have completed this procedure.

DLP-G76 Provision GCC Terminations

Purpose  This task creates the DWDM GCC terminations required for network setup when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10G cards. Perform this task before you create circuits for these cards. In this task, you can also set up the node so that it has direct IP access to a far-end non-ONS node over the GCC network.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Step 1  In node view, click the Provisioning > Comm Channels > GCC tabs.

Step 2  In the GCC Terminations area, click Create.

Step 3  In the Create OTN GCC Terminations dialog box, click the ports where you want to create the GCC termination. To select more than one port, press the Shift key or the Ctrl key.

Note  GCC refers to the general communications channel, which is used for ONS 15454 transponders and muxponders in DWDM applications.

Step 4  (Optional) From the GCC Rate drop-down list, choose from two options:

- 192k is the line rate of Section DCC (SDCC)—This is the default option.
- 576k is the line rate of Line DCC (LDCC)—This option will be supported in a future software release.

Step 5  Click Set to IS if you want to put ports in service.

Step 6  If the SDCC termination is to include a non-ONS node, check the Far End is Foreign check box. This automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified by the far end. To change the default to a specific the IP address, see the “DLP-G184 Change a GCC Termination” task on page 10-40.

Step 7  In the Layer 3 box, perform one of the following:

- Check the IP box only if the LDCC is between the ONS 15454 and another ONS node and only ONS nodes reside on the network. The LDCC will use Point-to-Point Protocol (PPP).
Check the IP and OSI boxes—if the LDCC is between the ONS 15454 and another ONS node, and third party NEs that use the OSI protocol stack are on the same network. The LDCC will use PPP.

**Step 8**
If you checked OSI, complete the following steps. If you checked IP only, continue with **Step 9**.

a. Click **Next**.

b. Provision the following fields:
   - **Router**—Choose the OSI router.
   - **ESH**—Sets the End System Hello (ESH) propagation frequency. End system network elements (NEs) transmit ESHs to inform other ESs and ISs about the Network Service Access Points (NSAPs) that it serves. The default is 10 seconds. The range is 10 to 1000 seconds.
   - **ISH**—Sets the Intermediate System Hello (ISH) PDU propagation frequency. Intermediate system NEs send ISHs to other ESs and ISs to inform them about the IS NEs that it serves. The default is 10 seconds. The range is 10 to 1000 seconds.
   - **IIH**—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default is 3 seconds. The range is 1 to 600 seconds.
   - **Metric**—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost to calculate the shortest routing path. The default metric cost for LAN subnets is 20. It normally should not be changed.

**Step 9**
Click **Finish**. Until all network GCC terminations are created and the ports are in service, GCC-EOC alarms appear.

**Step 10**
Return to your originating procedure (NTP).

---

## DLP-G97 Provision a Proxy Tunnel

**Purpose**
This task sets up a proxy tunnel to communicate with a non-ONS far-end node. Proxy tunnels are only necessary when the proxy server is enabled and a foreign GCC termination exists, or if static routes exist so that the GCC network is used to access remote networks or devices. You can provision a maximum of 12 proxy server tunnels.

**Tools/Equipment**
None

**Prerequisite Procedures**
- DLP-G46 Log into CTC, page 2-25
- DLP-G76 Provision GCC Terminations, page 7-14

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

**Note**
If the proxy server is disabled, you cannot set up a proxy tunnel.

---

**Step 1**
In node view, click the **Provisioning > Network > Proxy** tabs.

**Step 2**
Click **Create**.
DLP-G98 Provision a Firewall Tunnel

**Purpose**
This task provisions destinations that will not be blocked by the firewall. Firewall tunnels are only necessary when the proxy server is enabled and a foreign GCC termination exists, or if static routes exist so that the GCC network is used to access remote networks or devices. You can provision a maximum of 12 firewall tunnels.

**Tools/Equipment**
None

**Prerequisite Procedures**
- DLP-G46 Log into CTC, page 2-25
- DLP-G76 Provision GCC Terminations, page 7-14

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

**Note**
If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel.

**Step 1**
In node view, click the Provisioning > Network > Firewall tabs.

**Step 2**
Click Create.

**Step 3**
In the Create Tunnel dialog box, complete the following:
- **Source Address**—Type the IP address of the source node (32 bit length) or source subnet (any other length).
- **Length**—Choose the length of the source subnet mask.
- **Destination Address**—Type the IP address of the destination node (32 bit length) or destination subnet (any other length).
- **Length**—Choose the length of the destination subnet mask.

**Step 4**
Click OK.

**Step 5**
Continue with your originating procedure (NTP).
DLP-G107 Create an IP-Encapsulated Tunnel

**Purpose**  
This task creates an IP-encapsulated tunnel to transport traffic from third-party SONET/SDH equipment across ONS 15454 networks. IP-encapsulated tunnels are created on the Section DCC channel (D1-D3) (if not used by the ONS 15454 as a terminated data communications channel [DCC]).

**Tools/Equipment**  
An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed.

**Prerequisite Procedures**  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

---

**Note**  
Each ONS 15454 can have up to ten IP-encapsulated tunnel connections. Terminated Section DCCs (SDCCs) used by the ONS 15454 cannot be used as a tunnel endpoint, and an SDCC that is used as a tunnel endpoint cannot be terminated. All tunnel connections are bidirectional.

---

**Step 1**  
Verify that IP addresses are provisioned at both the source and destination nodes of the planned tunnel. For more information, see the “DLP-G56 Provision IP Settings” task on page 3-12.

**Step 2**  
In network view, click the **Provisioning > Overhead Circuits** tabs.

**Step 3**  
Click **Create**.

**Step 4**  
In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:
- Name—Type the tunnel name.
- Type—Choose **IP Tunnel-D1-D3**.
- Maximum Bandwidth—Type the percentage of total SDCC bandwidth used in the IP tunnel (the minimum percentage is 10 percent).

**Step 5**  
Click Next.

**Step 6**  
In the Circuit Source area, complete the following:
- Node—Choose the source node.
- Slot—Choose the source slot.
- Port—If applicable, choose the source port.
- Channel—Displays IPT (D1-D3).

**Step 7**  
Click Next.

**Step 8**  
In the Circuit Destination area, complete the following:
- Node—Choose the destination node.
- Slot—Choose the destination slot.
- Port—If applicable, choose the destination port.
- Channel—Displays IPT (D1-D3).
Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP).

DLP-G108 Change the Service State for a Port

Purpose This task puts a port in service or removes a port from service. After creating an IP-encapsulated tunnel, put the ports that are hosting the IP-encapsulated tunnel in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Step 1 In node view on the shelf graphic, double-click the card with the port(s) you want to put in or out of service. The card view appears.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Admin State column for the desired port, choose one of the following from the drop-down list:

- **IS (ANSI) or Unlocked (ETSI)**—Puts the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI) service state.

- **OOS,DSBLD (ANSI) or Locked,disabled (ETSI)**—Puts the port in the OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI) service state. For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR, OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled, Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

- **OOS,MT (ANSI) or Locked,maintenance (ETSI)**—Puts the port in the OOS-MAT/Locked-enabled,maintenance service state. This service state does not interrupt traffic flow, but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command. Use the OOS-MAT/Locked-enabled,maintenance service state for testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or OOS-AU,AINS/Unlocked-disabled,automaticInService service states when testing is complete.

- **IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)**—Puts the port in the OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this service state, alarm reporting is suppressed, but traffic is carried and loopbacks are allowed. After the soak period passes, the port changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms are reported or not, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command.

For more information about service states, see Appendix C, “DWDM Administrative and Service States.”
Chapter 7  Create Channels and Circuits

DLP-G109 Provision Orderwire

Step 4  If you set the Admin State to IS-AINS/Unlocked, automaticInService, set the soak period time in the AINS Soak field. This is the amount of time that the port will stay in the OOS-AU,AINS/Unlocked-enabled,automaticInService service state after a signal is continuously received. When the soak period elapses, the port changes to the IS-NR/Unlocked-enabled service state.

Step 5  Click Apply. The new port service state appears in the Service State column.

Step 6  As needed, repeat this task for each port.

Step 7  Return to your originating procedure (NTP).

DLP-G109 Provision Orderwire

Purpose  This task provisions orderwire on the AIC or the AIC-I card.

Tools/Equipment  An AIC-I card must be installed in Slot 9.
An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed.

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Step 1  In network view, click the Provisioning > Overhead Circuits tabs.

Step 2  Click Create.

Step 3  In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

- Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters (including spaces).
- Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use either local or express orderwire channels. If regenerators exist, use the express orderwire channel. You can provision up to four ONS 15454 OC-N ports for each orderwire path.
- PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law (North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both types of orderwire.

Caution  When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the ring nodes.

Step 4  Click Next.

Step 5  In the Circuit Source area, complete the following:

- Node—Choose the source node.
- Slot—Choose the source slot.
DLP-G110 Create a User Data Channel Circuit

Purpose
This task creates a UDC circuit on the ONS 15454. A UDC circuit allows you to create a dedicated data channel between nodes.

Tools/Equipment
OSCM, OSC-CSM, MXPP_MR_2.5G, or MXP_MR_2.5G must be installed.

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In network view, click the Provisioning > Overhead Circuits tabs.

Step 2
Click Create.

Step 3
In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

- Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters (including spaces).
- Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list. (User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 4
Click Next.

Step 5
In the Circuit Source area, complete the following:

- Node—Choose the source node.
- Slot—Choose the source slot.
- Port—If applicable, choose the source port.

Step 6
Click Next.

Step 7
In the Circuit Destination area, complete the following:

- Node—Choose the destination node.
- Slot—Choose the destination slot.
- Port—If applicable, choose the destination port.
Step 8  Click Finish.
Step 9  Return to your originating procedure (NTP).

NTP-G61 Modify and Delete Overhead Circuits

Purpose  This procedure repairs IP circuits and deletes overhead circuits.
Tools/Equipment  None
Prerequisite Procedures  NTP-G60 Create Overhead Circuits, page 7-13
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Provisioning or higher

Caution  Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25 for a node on the network where you want to repair or delete a circuit. If you are already logged in, continue with Step 2.
Step 2  As needed, complete the “DLP-G111 Repair an IP Tunnel” task on page 7-21.
Step 3  As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 7-22.
Stop. You have completed this procedure.

DLP-G111 Repair an IP Tunnel

Purpose  This task repairs circuits that have a PARTIAL status as a result of node IP address changes.
Tools/Equipment  None
Prerequisite Procedures  DLP-G107 Create an IP-Encapsulated Tunnel, page 7-17
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Provisioning or higher

Step 1  Obtain the original IP address of the node in question.
Step 2  From the View menu, choose Go to Network View.
Step 3  From the Tools menu, choose Overhead Circuits > Repair IP Circuits.
Step 4  Review the text in the IP Repair wizard and click Next.
Step 5  In the Node IP address area, complete the following:
  - Node—Choose the node that has a PARTIAL circuit.
DLP-G112 Delete Overhead Circuits

Purpose
This task deletes overhead circuits. Overhead circuits include IP-encapsulated tunnels, AIC and AIC-I card orderwire, and UDCs.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 7-18.

Step 1
From the View menu, choose Go to Network View.

Step 2
Click the Provisioning > Overhead Circuits tabs.

Step 3
Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated tunnel, or DCC tunnel.

Step 4
Click Delete.

Step 5
In the confirmation dialog box, click Yes to continue.

Step 6
Return to your originating procedure (NTP).
NTP-G62 Create a J0 Section Trace

Purpose
This procedure creates a repeated, fixed-length string of characters used to monitor interruptions or changes to traffic between nodes.

Tools/Equipment
At least one of the following cards must be installed: MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10E, TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G.

Prerequisite Procedures
None

Required/As Needed
As needed (optional if path trace is set)

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you will create the section trace. If you are already logged in, continue with Step 2.

Step 2
In node view, double-click the MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10E, TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G card.

Step 3
Click the Provisioning > Line > Section Trace tabs.

Step 4
From the Port drop-down list, choose the port for the section trace.

Step 5
From the Trace Mode drop-down list, enable the section trace expected string by choosing Auto or Manual:
- Auto—The first string received from the source port is automatically provisioned as the current expected string. An alarm is raised when a string that differs from the baseline is received.
- Manual—The string entered in the Current Expected String field is the baseline. An alarm is raised when a string that differs from the Current Expected String is received.

Step 6
In the Section Trace String Size area, click 1 byte, 16 byte, or 64 byte. The 1 byte option allows you to enter one character; the 16 byte option allows a 15 character string and the 64 byte option allows a 62 character string.

Step 7
In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the destination port easy to identify, such as the node IP address, node name, or another string. If the New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8
If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive from the source port in the New Expected String field. If you set Section Trace Mode to Auto, skip this step.

Step 9
Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm indication signal (AIS) and remote defect indication (RDI) when the STS Section Trace Identifier Mismatch Path (TIM-P) alarm appears. Refer to the Cisco ONS 15454 Troubleshooting Guide and the Cisco ONS 15454 SDH Troubleshooting Guide for descriptions of alarms and conditions.

Step 10
Click Apply.

Step 11
After you set up the section trace, the received string appears in the Received field. The following options are available:
- Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII Mode. Click it to return the section trace to ASCII format.
- Click the Reset button to reread values from the port.
NTP-G62 Create a J0 Section Trace

- Click **Default** to return to the section trace default settings (Section Trace Mode is set to Off and the New Transmit and New Expected Strings are null).

**Caution**

Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Section Trace Mode field is set to Auto or Manual.

**Stop. You have completed this procedure.**
Manage Alarms

This chapter contains the procedures for viewing and managing the alarms and conditions on a Cisco ONS 15454.

Cisco Transport Controller (CTC) detects and reports alarms generated by the Cisco ONS 15454 and the Optical Networking System (ONS) network. You can use CTC to monitor and manage alarms at card, node, or network level. You can also view alarm counts on the LCD front panel.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G63 Document Existing Provisioning, page 8-2—Complete this procedure as needed to print or export node data.
2. NTP-G64 View Alarms, History, Events, and Conditions, page 8-6—Complete this procedure as needed to see alarms and conditions occurring on the node and a complete history of alarm and condition messages.
3. NTP-G65 Delete Cleared Alarms from Display, page 8-13—Complete this procedure as needed to delete cleared alarm information.
4. NTP-G66 View Alarm-Affected Circuits, page 8-14—Complete this procedure as needed to find circuits that are affected by a particular alarm or condition.
5. NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port, page 8-15—Complete this procedure as needed to see a statistical count of alarms that have occurred for a slot or port.
6. NTP-G68 Create, Download, and Assign Alarm Severity Profiles, page 8-16—Complete this procedure as needed to change the default severity for certain alarms, to assign the new severities to a port, card, or node, and to delete alarm profiles.
7. NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering, page 8-25—Complete this procedure as needed to enable, disable, or modify alarm severity filtering in the Conditions, Alarms, or History screens at the node or network level.
8. NTP-G70 Suppress Alarms or Discontinue Alarm Suppression, page 8-29—Complete this procedure as needed to suppress reported alarms at the port, card, or node level and to disable the suppress command to resume normal alarm reporting.
NTP-G63 Document Existing Provisioning

Purpose
Use this procedure to document existing provisioning by printing card, node, or network CTC information or exporting card, node, or network information as delineated text files to other applications. This procedure is useful for network record keeping and troubleshooting.

Tools/Equipment
A printer connected to the CTC computer by a direct or network connection

Prerequisite Procedures
Chapter 3, “Turn Up a Node”

Required/As needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to print or export data. If you are already logged in, continue with Step 2.

Step 2
As needed, complete the “DLP-G113 Print CTC Data” task on page 8-2.

Step 3
As needed, complete the “DLP-G114 Export CTC Data” task on page 8-4.

Stop. You have completed this procedure.

DLP-G113 Print CTC Data

Purpose
This task prints CTC card, node, or network data in graphical or tabular format on a Windows-provisioned printer.

Tools/Equipment
Printer connected to the CTC computer by a direct or network connection

Prerequisite procedures
DLP-G46 Log into CTC, page 2-25

Required/As needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
Click the tab (and subtab, if present) containing the information you want to print. For example, click the Alarms tab to print Alarms window data.

The print operation is available for all network, node, and card view windows.

Step 2
From the File menu choose Print. The Print dialog box appears (Figure 8-1).
**Step 3**  In the Print dialog box, click a printing option:

- **Entire Frame**—Prints the entire CTC window including the graphical view of the card, node, or network. This option is available for all windows.
- **Tabbed View**—Prints the lower half of the CTC window containing tabs and data. The printout includes the selected tab (on top) and the data shown in the tab window. For example, if you print the History window Tabbed View, you print only history items appearing in the window. This option is available for all windows.
- **Table Contents**—Prints CTC data in table format without graphical representations of shelves, cards, or tabs. This option applies to all windows except:
  - Provisioning > General > General and Power Monitor windows
  - Provisioning > Network > General windows
  - Provisioning > Security > Policy, Access, and Legal Disclaimer windows
  - Provisioning > SNMP window
  - Provisioning > Timing window > General and BITS Facilities windows
  - Provisioning > OSI > Main Setup window
  - Maintenance > Cross-Connect > Cards window
  - Maintenance > Database window
  - Maintenance > Diagnostic window
  - Maintenance > Protection window
  - Maintenance > Timing > Source window

  The Table Contents option prints all the data contained in a table and the table column headings. For example, if you print the History window Table Contents view, you print all data included in the table whether or not items appear in the window.

**Tip**  When you print using the Tabbed View option, it can be difficult to distinguish whether the printout applies to the network, node, or card view. To determine the view, compare the tabs on the printout. The network, node, and card views are identical except that network view does not contain an Inventory tab or Performance tab.

**Step 4**  Click **OK**.

**Step 5**  In the Windows Print dialog box, click a printer and click **OK**.

**Step 6**  Repeat this task for each window that you want to print.
Step 7  Return to your originating procedure (NTP).

DLP-G114 Export CTC Data

Purpose  This task exports CTC table data as delineated text to view or edit the data in text editor, word processing, spreadsheet, database management, or web browser applications.

Tools/Equipment  None

Prerequisite procedures  DLP-G46 Log into CTC, page 2-25

Required/As needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Retrieve or higher

Step 1  Click the tab containing the information you want to export (for example, the Alarms tab or the Circuits tab).

Step 2  Choose Export from the File menu. The Export dialog box appears (Figure 8-2).

Figure 8-2  Selecting CTC Data For Export

Step 3  In the Export dialog box, click a data format:

- As HTML—Saves data as a simple HTML table file without graphics. The file must be viewed or edited with applications such as Netscape Navigator, Microsoft Internet Explorer, or other applications capable of opening HTML files.
- As CSV—Saves the CTC table as comma-separated values (CSV). This option does not apply to the Maintenance > Timing > Report window.
- As TSV—Saves the CTC table as tab-separated values (TSV).

Step 4  If you want to open a file in a text editor or word processor application, procedures will vary. Typically, you can use the File > Open command to view the CTC data, or you can double-click the file name and choose an application such as Notepad.

Text editor and word processor applications format the data exactly as it is exported, including comma or tab separators. All applications that open the data files allow you to format the data.

Step 5  If you want to open the file in spreadsheet and database management applications, procedures will vary. Typically, you need to open the application and choose File > Import, then choose a delimited file to format the data in cells.
Spreadsheet and database management programs also allow you to manage the exported data.

**Note** An exported file cannot be opened in CTC.

The export operation applies to all tabular data except:

- Provisioning > General > General and Power Monitor windows
- Provisioning > Network > General window
- Provisioning > Security > Policy, Access, and Legal Disclaimer windows
- Provisioning > SNMP window
- Provisioning > Timing window
- Provisioning > OSI > Main Setup window
- Provisioning > OSI > TARP > Config window
- Maintenance > Cross-Connect > Cards windows
- Maintenance > Database window
- Maintenance > Diagnostic window
- Maintenance > Protection window
- Maintenance > Timing > Source windows
- Maintenance > DWDM > ROADM Power Monitoring window [ETSI only]

**Step 6** Click **OK**.

**Step 7** In the Save dialog box, enter a name in the File name field using one of the following formats:

- `filename.html` for HTML files
- `filename.csv` for CSV files
- `filename.tsv` for TSV files

**Step 8** Navigate to a directory where you want to store the file.

**Step 9** Click **Save**.

**Step 10** Repeat the task for each window that you want to export.

**Step 11** Return to your originating procedure (NTP).
NTP-G64 View Alarms, History, Events, and Conditions

Use this procedure to view current or historical alarms and conditions for a card, node, or network. This information is useful for monitoring and troubleshooting hardware and software events.

- **Purpose**
- **Tools/Equipment** None
- **Prerequisite Procedures** None
- **Required/As Needed** As needed
- **Onsite/Remote** Onsite or remote
- **Security Level** Provisioning or higher

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25.
**Step 2** Complete the “DLP-G115 View Alarms” task on page 8-6 as needed.
**Step 3** Complete the “DLP-G116 View Alarm or Event History” task on page 8-8 as needed.
**Step 4** Complete the “DLP-G117 Change the Maximum Number of Session Entries for Alarm History” task on page 8-9 as needed.
**Step 5** Complete the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-11 as needed.
**Step 6** Complete the “DLP-G119 Synchronize Alarms” task on page 8-11 as needed.
**Step 7** Complete the “DLP-G120 View Conditions” task on page 8-12 as needed.

Stop. You have completed this procedure.

DLP-G115 View Alarms

Use this task to view current alarms on a card, node, or network.

- **Purpose**
- **Tools/Equipment** None
- **Prerequisite Procedures** DLP-G46 Log into CTC, page 2-25
- **Required/As Needed** As needed
- **Onsite/Remote** Onsite or remote
- **Security Level** Provisioning or higher

**Step 1** In card, node, or network view, click the Alarms tab to view the alarms for that card, node, or network. Table 8-1 describes the columns in the Alarms window.

**Table 8-1** Alarm Column Descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Information Recorded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num</td>
<td>Sequence number of the original alarm.</td>
</tr>
<tr>
<td>Ref</td>
<td>Reference number of the original alarm.</td>
</tr>
</tbody>
</table>
### Table 8-1 Alarm Column Descriptions (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Information Recorded</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Indicates a new alarm; to change this status, click either the Synchronize button or the Delete Cleared Alarms button.</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time of the alarm.</td>
</tr>
<tr>
<td>Node</td>
<td>The name of the node where the alarm occurred.</td>
</tr>
<tr>
<td>Object</td>
<td>TL1 access identifier (AID) for the alarmed object; for an STSmon or VTmon, this is the monitored synchronous transport signal (STS) or Virtual Tributary (VT).</td>
</tr>
<tr>
<td>Eqpt Type</td>
<td>If an alarm is raised on a card, the card type in this slot.</td>
</tr>
<tr>
<td>Slot</td>
<td>If an alarm is raised on a card, the slot where the alarm occurred (appears only in network and node view).</td>
</tr>
<tr>
<td>Port</td>
<td>If an alarm is raised on a card, the port where the alarm is raised; for STSTerm and VTTerm, the port refers to the upstream card it is partnered with.</td>
</tr>
<tr>
<td>Path Width</td>
<td>Indicates how many STSs are contained in the alarmed path. This information complements the alarm object notation, which is explained in the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide.</td>
</tr>
<tr>
<td>Sev</td>
<td>Severity level: CR (Critical), MJ (Major), MN (minor), NA (Not Alarmed), NR (Not Reported).</td>
</tr>
<tr>
<td>ST</td>
<td>Status: R (raised), C (clear), T (transient).</td>
</tr>
<tr>
<td>SA</td>
<td>When checked, indicates a service-affecting alarm.</td>
</tr>
<tr>
<td>Cond</td>
<td>The error message/alarm name; these names are alphabetically defined in the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the alarm.</td>
</tr>
</tbody>
</table>

### Table 8-2 Color Codes for Alarms and Condition Severities

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Raised Critical (CR) alarm</td>
</tr>
<tr>
<td>Orange</td>
<td>Raised Major (MJ) alarm</td>
</tr>
<tr>
<td>Yellow</td>
<td>Raised Minor (MN) alarm</td>
</tr>
<tr>
<td>Magenta (pink)</td>
<td>Raised Not Alarmed (NA) condition</td>
</tr>
<tr>
<td>Blue</td>
<td>Raised Not Reported (NR) condition</td>
</tr>
<tr>
<td>White</td>
<td>Cleared (C) alarm or condition</td>
</tr>
</tbody>
</table>

### Step 2

If alarms are present, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide for information and troubleshooting procedures.
Step 3  Return to your originating procedure (NTP).

DLP-G116 View Alarm or Event History

Purpose  This task is used to view past cleared and uncleared ONS 15454 alarm messages at the card, node, or network level. This task is useful for troubleshooting configuration, traffic, or connectivity issues that are indicated by alarms.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Retrieve or higher

Step 1  Decide whether you want to view the alarm message history at the node, network, or card level.

Step 2  To view node alarm history:

  a. In node view, click the History > Session tabs to view the alarms and conditions (events) raised during the current session.

  b. Click the History > Node tabs.

     If you check the Alarms check box, the node’s alarm history appears. If you check the Events check box, the node’s Not Alarmed and transient event history appears. If you check both check boxes, you will retrieve node history for alarms and events.

  c. Click Retrieve to view all available messages for the History > Node tab.

  ——

     Note  Alarms can be unreported when they are filtered out of the display using the Filter button in either tab. See the “DLP-G126 Enable Alarm Filtering” task on page 8-25 for information.

  ——

     Tip  Double-click an alarm in the alarm table or an event (condition) message in the history table to display the view that corresponds to the alarm message. For example, double-clicking a card alarm takes you to card view. In network view, double-clicking a node alarm takes you to node view.

Step 3  To view network alarm history:

  a. From the View menu, choose Go to Network View.

  b. Click the History tab.

     Alarms and conditions (events) raised during the current session appear.

Step 4  To view card alarm history:

  a. From the View menu, choose Go to Previous View.

  b. Double-click a card on the shelf graphic to open the card-level view. TCC2/TCC2P cards do not have a card view.
c. Click the **History > Session** tab to view the alarm messages raised during the current session.

d. Click the **History > Card** tab to retrieve all available alarm messages for the card and click **Retrieve**.

If you check the **Alarms** check box, the node’s alarm history appears. If you check the **Events** check box, the Not Alarmed and transient event history appears. If you check both boxes, node history for both alarms and events appears.

**Note**
The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 640 minor alarm messages, and 640 condition messages. When any of these limits is reached, the ONS 15454 discards the oldest events in that category.

Raised and cleared alarm messages (and events, if selected) appear.

**Step 5**
Return to your originating procedure (NTP).

---

**DLP-G117 Change the Maximum Number of Session Entries for Alarm History**

**Purpose**
This task changes the maximum number of session entries included in the alarm history. Use this task to expand the history list to save information for future reference or troubleshooting.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
From the Edit menu, choose **Preferences**.

The CTC Preferences dialog box appears (Figure 8-3).
DLP-G117 Change the Maximum Number of Session Entries for Alarm History

Figure 8-3  CTC Preferences Dialog Box

Step 2  Click the up or down arrow buttons next to the Maximum History Entries field to change the entry.

Step 3  Click Apply and OK.

Note  Setting the Maximum History Entries value to the high end of the range uses more CTC memory and could impair CTC performance.

Note  This task changes the maximum history entries recorded for CTC sessions. It does not affect the maximum number of history entries viewable for a network, node, or card.

Step 4  Return to your originating procedure (NTP).
DLP-G118 Display Alarms and Conditions Using Time Zone

Purpose
This task changes the time stamp for events to the time zone of the ONS node reporting the alarm. By default, the events time stamp is set to the time zone for the CTC workstation.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
From the Edit menu, choose Preferences.
The CTC Preferences dialog box appears (Figure 8-3 on page 8-10).

Step 2
Check the Display Events Using Each Node’s Timezone check box. The Apply button is enabled.

Step 3
Click Apply and OK.

Step 4
Return to your originating procedure (NTP).

DLP-G119 Synchronize Alarms

Purpose
This task is used to view ONS 15454 events at the card, node, or network level and to refresh the alarm listing so that you can check for new and cleared alarms and conditions.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
At card, node, or network view, click the Alarms tab.

Step 2
Click Synchronize.
This button causes CTC to retrieve a current alarm summary for the card, node, or network. This step is optional because CTC updates the Alarms window automatically as raise/clear messages arrive from the node.

Note
Alarms that have been raised during the session will have a check mark in the Alarms window New column. When you click Synchronize, the check mark disappears.

Step 3
Return to your originating procedure (NTP).
DLP-G120 View Conditions

Purpose
This task is used to view conditions (events with a Not Reported [NR] severity) at the card, node, or network level. Conditions give you a clear record of changes or events that do not result in alarms.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
From card, node, or network view, click the **Conditions** tab.

Step 2
Click **Retrieve**.

The Retrieve button requests the current set of fault conditions from the node, card, or network. The window is not updated when events change on the node. You must click Retrieve to see any changes. Conditions include all fault conditions raised on the node, whether or not they are reported.

Note
Alarms can be unreported if they are filtered out of the display. See the “DLP-G126 Enable Alarm Filtering” task on page 8-26 for information.

Events that are reported as Major (MJ), Minor (MN), or Critical (CR) severities are alarms. Events that are reported as Not Alarmed (NA) are conditions. Conditions that are not reported at all are marked Not Reported (NR) in the Conditions window severity column.

Conditions that have a default severity of Critical (CR), Major (MJ), Minor (MN), or Not Alarmed (NA) but are not reported due to exclusion or suppression are shown as NR in the Conditions window.

Note
For more information about alarm suppression, see the “DLP-G129 Suppress Alarm Reporting” task on page 8-29.

Current conditions are shown with the severity chosen in the alarm profile, if used. For more information about alarm profiles, see the “NTP-G68 Create, Download, and Assign Alarm Severity Profiles” procedure on page 8-16.

Note
When a port is placed in the Out-of-Service and Management, Maintenance (OOS-MA,MT) (ANSI) or Locked-enabled, maintenance (ETSI) service state, it raises an Alarms Suppressed for Maintenance (AS-MT) condition. For information about alarm and condition troubleshooting, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 3
If you want to apply exclusion rules, check the **Exclude Same Root Cause** check box at the node or network view, but do not check the Exclude Same Root Cause check box in card view.
An exclusion rule eliminates all lower-level alarms or conditions that originate from the same cause. For example, a fiber break might cause a loss of signal (LOS) alarm, an alarm indication signal (AIS) condition, and a signal fail (SF) condition. If you check the Exclude Same Root Cause check box, only the LOS alarm will appear. According to Telcordia, exclusion rules apply to a query of “all conditions from a node.”

**Step 4** Return to your originating procedure (NTP).

---

### NTP-G65 Delete Cleared Alarms from Display

**Purpose**
Use this procedure to delete Cleared (C) status alarms from the Alarms window or transient messages from the CTC History window.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2**
To delete cleared node-level alarms:

a. In node view, click the **Alarms** tab.

b. Click **Delete Cleared Alarms**.

- If the Autodelete Cleared Alarms check box is checked, an alarm disappears from the window when it is cleared.
- If the Autodelete Cleared Alarms check box is not checked, an alarm remains in the window when it is cleared. The alarm appears white in the window and has a Clear (CL) severity. The alarm can be removed by clicking the **Delete Cleared Alarms** button.

This action removes any cleared ONS 15454 alarms from the Alarms tab. The rows of cleared alarms turn white and have a C in their status (ST) column.

**Step 3**
To delete cleared card-level alarms:

a. In node view, double-click the card graphic for the card you want to open.

b. Click the **Alarms** tab and then click **Delete Cleared Alarms**, referring to the note in Step 2.

**Step 4**
To delete cleared network-level alarms:

a. In node view, click **View > Go to Network View**.

b. Click the **Alarms** tab and then click **Delete Cleared Alarms**, referring to the note in Step 2.
Step 5  To remove the transient messages from the History window, click **Delete Cleared Alarms**. Transient messages are single messages, not raise-and-clear pairs (that is, they do not have companion messages stating that they are cleared).

Stop. You have completed this procedure.

---

### NTP-G66 View Alarm-Affected Circuits

**Purpose**  Use this procedure to view all optical channel network connections (OCHNCs) and ONS 15454 circuits, if any, that are affected by an alarm or condition.

**Tools/Equipment**  None

**Prerequisite Procedures**  NTP-G64 View Alarms, History, Events, and Conditions, page 8-6

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Retrieve or higher

---

**Step 1**  Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2**  In network, node, or card view, click the **Alarms** tab or **Conditions** tab and then right-click anywhere in the row of an active alarm or condition.

**Note**  The node view is the default, but you can also navigate to the Alarms tab in the network view or card view to perform Step 2.

The Select Affected Circuit option appears on the shortcut menu.

**Step 3**  Left-click or right-click **Select Affected Circuits**.

The Circuits window appears with the affected OCHNC highlighted.

Stop. You have completed this procedure.
NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port

Purpose
Use this procedure to view an alarm summary for a node, slot, or port without using CTC.

Tools/Equipment
None

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Step 1
If you want to view the entire alarm summary for the node, press either the Slot button or Port button on the LCD panel until “Node” appears on the LCD. You will also see the direction, “Status=Alm Ct.” This means that if you press the Status button at this time, as directed in Step 2, you will see an alarm count for the node.

Step 2
Press the Status button to see a summary of alarms and severities for the node. You will see a message similar to “Alm Ct: 2: MJ:2 MN:2,” meaning that there are two critical alarms, two major alarms, and two minor alarms.

Step 3
If you want to see alarm counts for a particular slot, such as the alarms for an OC-3 card in Slot 3, press the Slot button until you see “Slot-3” on the LCD. You will see the direction, “Status=Alm Ct Sum.”

Step 4
Press the Status button to see a summary of alarms and severities against the slot. For example, you might see “Slot-3 Alm Sum:0 MJ:1 MN:2.” This means that there are no critical alarms, one major alarm, and two minor alarms against the slot.

Step 5
If you want to view the alarms against a port on the card, such as Port 3 of the OC-3 card you viewed previously, press the Port button until you see “Port-3 Status=Alm Ct.”

Step 6
Press Status to view alarm count against the port. You will see a message similar to “Slot-3 Port-0 Ct:0 MJ:1 MN:0.” This means that there is one major alarm against this port.

Figure 8-4 shows the shelf LCD panel.

Figure 8-4  Shelf LCD Panel

To return to the previous view from the Port screen, continue to press Port until the display cycles through all the ports on the slot.

To return to the node menu from the Slot screen, press Slot until you cycle through all the slots and see “Node.”

If you do not press any buttons, the LCD will return to its default display with the node name. However, if you did not cycle through the options to return to the node status, you will see the slot or port where you last checked status.
Note

A blank LCD results when the fuse on the alarm interface panel (AIP) board has blown. If this occurs, contact the Cisco Technical Assistance Center (TAC). See the “Obtaining Technical Assistance” section on page lxxvi.

Stop. You have completed this procedure.

NTP-G68 Create, Download, and Assign Alarm Severity Profiles

Purpose

Use this procedure to create a customized alarm profile at the network, node, or card level. This procedure also provides links to tasks that describe how to assign custom severities individually to each port, card, or node, and to delete alarm profiles.

Tools/Equipment

None

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to create an alarm profile. If you are already logged in, continue with Step 2 to create, clone, or modify an alarm profile, or go to Step 3 to download an alarm profile.

Step 2

Complete the “DLP-G121 Create a New or Cloned Alarm Severity Profile” task on page 8-17. This task clones a current alarm profile, renames the profile, and customizes the new profile.

Step 3

Complete the “DLP-G122 Download an Alarm Severity Profile” task on page 8-20. This task downloads an alarm severity profile from a CD or a node.

Note

After storing a created or downloaded alarm profile, you must go to the node (either by logging into it or clicking on it from the network view) and activate the profile by applying it to the shelf, one or more cards, or one or more ports.

Step 4

As necessary, complete the “DLP-G123 Apply Alarm Profiles to Ports” task on page 8-21 or the “DLP-G124 Apply Alarm Profiles to Cards and Nodes” task on page 8-23.

Step 5

As necessary, complete the “DLP-G125 Delete Alarm Severity Profiles” task on page 8-23.

Stop. You have completed this procedure.
DLP-G121 Create a New or Cloned Alarm Severity Profile

Purpose
This task creates a custom severity profile or clones and modifies the default severity profile.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
From the CTC window View menu, select Go To Network View.

Step 2
To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Note
To access the profile editor from node or card view, click the Provisioning > Alarm Profiles > Alarm Profile Editor tabs.

Step 3
If you want to create a new profile based on the default profile in use, click New. Continue with Step 9.

Step 4
If you want to create a profile using an existing profile located on the node, click Load and From Node in the Load Profiles dialog box.

a. Click the node name you are logged into in the Node Names list.

b. Click the name of an existing profile in the Profile Names list, such as Default. Continue with Step 6.

Step 5
If you want to create a profile using an existing profile located in a file that is stored locally or on a network drive, click From File in the Load Profiles dialog box.

a. Click Browse.

b. Navigate to the file location in the Open dialog box.

c. Click Open.

Note
All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474-CORE.

Step 6
Click OK.

The alarm severity profile appears in the Alarm Profiles window. The alarm profile list contains a master list of alarms that is used for a mixed node network. Some of these alarms might not be used in all ONS nodes.

Step 7
Right-click anywhere in the profile column to view the profile editing shortcut menu. (Refer to Step 10 for further information about the Default profile.)

Step 8
Click Clone in the shortcut menu.

Tip
To see the full list of profiles, including those available for loading or cloning, click Available. You must load a profile before you can clone it.
**Step 9**  In the New Profile dialog box, enter a name in the New Profile Name field. Profile names must be unique. If you try to import or name a profile that has the same name as another profile, CTC adds a suffix to create a new name. Long file names are supported.

**Step 10**  Click OK. A new alarm profile (named in Step 9) is created. (If this is the first alarm profile created during installation, the default alarm profile settings are displayed in the AlarmType::Condition column on the left.) This profile duplicates the default profile severities and appears at the right of the previous profile column in the Alarm Profiles window. You can select it and drag it to a different position.

**Note**  Up to ten profiles, including the two reserved profiles, Inherited and Default, can be stored in CTC.

The Default profile sets severities to standard Telcordia GR-253-CORE settings. If an alarm has an Inherited profile, it inherits (copies) its severity from the same alarm's severity at the higher level. For example, if you choose the Inherited profile from the network view, the severities at the lower levels (node, card, and port) will be copied from this selection. A card with an Inherited alarm profile copies the severities used by the node that contains the card. (If you are creating profiles, you can apply these separately at any level. To do this, refer to the “DLP-G124 Apply Alarm Profiles to Cards and Nodes” task on page 8-23.)

**Step 11**  Modify (customize) the new alarm profile:

a. In the new alarm profile column, click the alarm severity you want to change in the custom profile.

b. Choose a severity from the drop-down list.

c. Repeat Steps a and b for each severity you want to customize. Refer to the following guidelines when you view the alarms or conditions after making modifications:

- All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474-CORE.

- Default severities are used for all alarms and conditions until you create and apply a new profile.

- Changing a severity to inherited (I) or unset (U) does not change the severity of the alarm.

**Step 12**  After you have customized the new alarm profile, right-click the profile column to highlight it.

**Step 13**  Click Store.

**Step 14**  In the Store Profiles dialog box (Figure 8-5), click To Node(s) and go to Step a, or click To File and go to Step b.
a. Choose the node where you want to save the profile:

- If you want to save the profile to only one node, click the node in the Node Names list.
- If you want to save the profile to all nodes, click Select All.
- Press the Ctrl key, and simultaneously left-click the node where the profile is to be saved.
- If you do not want to save the profile to any nodes, click Select None.
- If you want to update alarm profile information, click (Synchronize).
- Click OK to save the profile.

b. Save the profile:

- Click Browse and navigate to the profile save location.
- Enter a name in the File name field.
- Click Select to choose this name and location. Long file names are supported. CTC supplies a suffix of *.pfl to stored files.
- Click OK to store the profile.

Step 15 As needed, perform any of the following actions. The following options are located at the bottom of the Provision > Alarm Profile window.

- Click the Hide Identical Rows check box to configure the Alarm Profiles window to view rows with dissimilar severities.
- Click the Hide Reference Values check box to configure the Alarm Profiles window to view severities that do not match the Default profile.
- Click the Only show service-affecting severities check box to configure the Alarm Profiles window not to display Minor and some Major alarms that will not affect service.

Step 16 Return to your originating procedure (NTP).
DLP-G122 Download an Alarm Severity Profile

Purpose
This task downloads a custom alarm severity profile from a network-drive-accessible CD-ROM, floppy disk, or hard disk location.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
You must always store the alarm profile after editing it. If you edit an alarm profile without saving it, changes to the profile will be lost if you change views in CTC.

Step 1
To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Note
To access the profile editor from node or card view, click the Provisioning > Alarm Profiles > Alarm Profile Editor tabs.

Step 2
Click Load.

Step 3
If you want to download a profile that exists on the node, click From Node in the Load Profiles dialog box.
   a. Click the node name you are logged into in the Node Names list.
   b. Click the name of the profile in the Profile Names list, such as Default.
   c. Click OK.

Step 4
If you want to download a profile that is stored locally or on a network drive, click From File in the Load Profile dialog box.
   a. Click Browse.
   b. Navigate to the file location in the Open dialog box.
   c. Click Open.

Note
All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474.

Step 5
Click OK.

The downloaded profile appears at the right side of the Alarm Profiles window.

Step 6
Right-click anywhere in the downloaded profile column to view the profile editing shortcut menu.

Step 7
Click Store.

Step 8
In the Store Profiles dialog box, click To Node(s).
   a. Choose the nodes where you want to save the profile:
      • If you want to save the profile to only one node, click the node in the Node Names list.
      • If you want to save the profile to all nodes, click Select All.
DLP-G123 Apply Alarm Profiles to Ports

**Purpose**  
This task applies a custom or default alarm severity profile to a port or ports.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G121 Create a New or Cloned Alarm Severity Profile, page 8-17  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

---

**Step 1**  
In node view, double-click the card that you want to change to open the card view.

---

**Note**  
The card view is not available for the TCC2/TCC2P card.

---

**Step 2**  
Click the **Provisioning > Alarm Profiles > Alarm Behavior** tabs.

**Figure 8-6** shows alarm profiles for the AD-1C card, for example. CTC shows Parent Card Profile: Inherited.
Go to Step 3 to apply profiles to a port. Go to Step 4 to apply profiles to all ports on a card.

**Step 3**  
To apply profiles on a port basis:
- a. In card view, click the port row in the Profile column.  
- b. Choose the new profile from the drop-down list.  
- c. Click **Apply**. Confirm that the profile updated to the port correctly.

**Step 4**  
To apply profiles to all ports on a card:
- a. In card view, click the **Force all ports to profile** drop-down arrow at the bottom of the window.  
- b. Choose the new profile from the drop-down list.  
- c. Click **Force (still need to “Apply”)**.  
- d. Click **Apply**. Confirm the profile updated to all ports correctly.

In node view, the Port Level Profiles column indicates port-level profiles with a notation such as “exist (1)”.

**Step 5**  
To reapply a previous alarm profile after you have applied a new one, select the previous profile and click **Apply** again.

**Step 6**  
Return to your originating procedure (NTP).
DLP-G124 Apply Alarm Profiles to Cards and Nodes

**Purpose**
This task applies a custom or default alarm profile to cards or nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G121 Create a New or Cloned Alarm Severity Profile, page 8-17
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, click the **Provisioning > Alarm Profiles > Alarm Behavior** tab.

**Step 2**
To apply profiles to a card:

a. Click a selection from the Profile column for the card.

b. Choose the new profile from the drop-down list.

c. Click **Apply**.

**Step 3**
To apply the profile to an entire node:

a. Click the **Force All Ports to Profile** drop-down arrow at the bottom of the window.

b. Choose the new alarm profile from the drop-down list.

c. Click **Force (still need to apply)**.

**Step 4**
Click **Apply** again.

**Step 5**
Return to your originating procedure (NTP).

---

DLP-G125 Delete Alarm Severity Profiles

**Purpose**
This task deletes a custom or default alarm severity profile.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
To access the alarm profile editor from network view, click the **Provisioning > Alarm Profiles** tabs.

---

**Note**
To access the profile editor from node or card view, click the **Provisioning > Alarm Profiles > Alarm Profile Editor** tabs.

**Step 2**
Click the profile that you want to delete. (Click the column that displays the profile name to select it.)

**Step 3**
Click **Delete**.
The Select Node/Profile Combination for Delete dialog box appears (Figure 8-7).

Figure 8-7 Select Node/Profile Combination For Delete Dialog Box

Note You cannot delete the Inherited or Default alarm profiles.

Note A previously created alarm profile cannot be deleted unless it has been stored on the node. If the profile is visible on the Alarm Profiles tab but is not listed in the Select Node/Profile Combinations to Delete dialog box, continue with Step 8.

Step 4 Click the node name in the Node Names list to highlight the profile location.

Tip If you hold the Shift key down, you can select consecutive node names. If you hold the Ctrl key down, you can select any combination of nodes.

Step 5 Click the profile names that you want to delete in the Profile Names list.

Step 6 Click OK.

Step 7 Click Yes in the Delete Alarm Profile dialog box.

If you delete a profile from a node, it still appears in the network view Provisioning > Alarm Profile Editor window unless you remove it using the following step.

Step 8 To remove the alarm profile from the window, right-click the column of the profile that you deleted and choose Remove from the shortcut menu.

If a node and profile combination is selected but does not exist, a warning appears: “One or more of the profiles selected do not exist on one or more of the node(s) selected.” For example, if Node A has only Profile 1 stored and the user tries to delete both Profile 1 and Profile 2 from Node A, this warning appears. However, the operation still removes Profile 1 from Node A.

The Default and Inherited special profiles cannot be deleted and do not appear in the Select Node/Profile Combination for Delete window.

Step 9 Return to your originating procedure (NTP).
NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering

**Purpose**
Use this procedure to start, change, or stop alarm filtering for one or more severities in the Alarms, Conditions, and History windows in all network nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to enable alarm severity filtering. If you are already logged in, continue with Step 2.

**Step 2**
As needed, complete the “DLP-G126 Enable Alarm Filtering” task on page 8-25. This task enables alarm filtering at the card, node, and network views for all nodes in the network. Alarm filtering can be enabled for alarms, conditions, or events.

**Step 3**
As needed, complete the “DLP-G127 Modify Alarm, Condition, and History Filtering Parameters” task on page 8-26 to modify the alarm filtering for network nodes to show or hide particular alarms or conditions.

**Step 4**
As needed, complete the “DLP-G128 Disable Alarm Filtering” task on page 8-28 to disable alarm profile filtering for all network nodes.

Stop. You have completed this procedure.

---

DLP-G126 Enable Alarm Filtering

**Purpose**
This task enables alarm filtering for alarms, conditions, or event history in all network nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
At node, network, or card view, click the Alarms tab.

**Step 2**
Click the Filter tool icon on the right side of the bottom toolbar.

**Note**
The Filter tool icon differs from the Filter button at the bottom left of the screen.

Alarm filtering is enabled if the tool is selected and disabled if the tool is raised (not selected).
Alarm filtering is enabled in the card, node, and network views of the same window for all nodes in the network. For example, if the Filter tool is enabled in the node view Alarms window, the network view Alarms window and card view Alarms window also show the tool enabled.

**Step 3** If you want alarm filtering enabled when you view conditions, repeat Steps 1 and 2 using the Conditions window.

**Step 4** If you want alarm filtering enabled when you view alarm history, repeat Steps 1 and 2 using the History window.

**Step 5** Return to your originating procedure (NTP).

### DLP-G127 Modify Alarm, Condition, and History Filtering Parameters

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task changes alarm and condition reporting in all network nodes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G126 Enable Alarm Filtering, page 8-25</td>
</tr>
<tr>
<td></td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Retrieve or higher</td>
</tr>
</tbody>
</table>

**Step 1** At node, network, or card view, click the Alarms tab, Conditions tab, or History tab.

**Step 2** Click the Filter button on the left side of the bottom toolbar.

The filter dialog box appears, displaying the General tab. Figure 8-8 shows the Alarm Filter dialog box; the Conditions and History tabs have similar dialog boxes.

![Figure 8-8 Alarm Filter Dialog Box General Tab](image-url)
In the General tab Show Severity area, you can choose which alarm severities will show through the alarm filter and provision a time period during which filtered alarms show through the filter. To change the alarm severities shown in the filter, go to Step 3. To change the time period filter for the alarms, go to Step 4.

**Step 3**
In the Show Severity area, click the check boxes for the severities [Critical (CR), Major (MJ), Minor (MN), or Not Alarmed (NA)] that you want to be reported at the network level. Leave severity check boxes deselected (unchecked) to prevent those severities from appearing.

When alarm filtering is disabled, all alarms show.

**Step 4**
In the Time area, click the **Show alarms between time limits** check box to enable it. Click the up and down arrows in the From Date, To Date, and Time fields to modify the period of alarms that is shown. To modify filter parameters for conditions, continue with Step 5. If you do not need to modify them, continue with Step 6.

**Step 5**
Click the filter dialog box **Conditions** tab (Figure 8-9).

![Figure 8-9 Alarm Filter Dialog Box Conditions Tab](image)

When filtering is enabled, conditions in the Show list are visible and conditions in the Hide list are invisible.

- To move conditions individually from the Show list to the Hide list, click the > button.
- To move conditions individually from the Hide list to the Show list, click the < button.
- To move conditions collectively from the Show list to the Hide list, click the >> button.
- To move conditions collectively from the Hide list to the Show list, click the << button.

**Note**
Conditions include alarms.

**Step 6**
Click **Apply** and **OK**.

Alarm and condition filtering parameters are enforced when alarm filtering is enabled (see the “DLP-G126 Enable Alarm Filtering” task on page 8-25), and the parameters are not enforced when alarm filtering is disabled (see the “DLP-G128 Disable Alarm Filtering” task on page 8-28).
DLP-G128 Disable Alarm Filtering

**Purpose**  
This task turns off specialized alarm filtering in all network nodes so that all severities are reported in CTC.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G126 Enable Alarm Filtering, page 8-25  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Retrieve or higher

---

**Step 1**  
At node, network, or card view, click the **Alarms** tab.

**Step 2**  
Click the **Filter** tool icon on the right side of the bottom toolbar.

**Note**  
The Filter tool icon differs from the Filter button at the bottom left of the screen.

Alarm filtering is enabled if the tool is indented and disabled if the tool is raised (not selected).

**Step 3**  
If you want alarm filtering disabled when you view conditions, click the **Conditions** tab and click the Filter tool.

**Step 4**  
If you want alarm filtering disabled when you view alarm history, click the **History** tab and click the Filter tool.

**Step 5**  
Return to your originating procedure (NTP).
NTP-G70 Suppress Alarms or Discontinue Alarm Suppression

**Purpose**
Use this procedure to prevent alarms from being reported for a port, card, or node in circumstances when an alarm or condition is known to exist but you do not want to include it in the display. This procedure also provides a link to a task that explains how to resume normal alarm reporting by discontinuing the suppression.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2**
Complete the “DLP-G129 Suppress Alarm Reporting” task on page 8-29 to enable the node to send autonomous messages that clear specific raised alarms and cause suppressed alarms to appear in the Conditions window.

Suppressing one or more alarms prevents them from appearing in Alarm or History windows or in any other clients. The suppress command causes CTC to display them in the Conditions window with their severity, their severity color code, and their service-affecting status.

**Step 3**
Complete the “DLP-G130 Discontinue Alarm Suppression” task on page 8-31 to discontinue alarm suppression and resume normal alarm reporting.

Stop. You have completed this procedure.

---

DLP-G129 Suppress Alarm Reporting

**Purpose**
This task suppresses the reporting of ONS 15454 alarms at the node, card, or port level.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

⚠️ **Caution**
If multiple CTC/TL1 sessions are open, suppressing alarms in one session suppresses the alarms in all other open sessions.
Note

Alarm suppression at the node level does not supersede alarm suppression at the card or port level. Suppression can exist independently for all three entities, and each entity will raise separate alarms suppressed by the user command (AS-CMD) alarm.

Step 1

If you are in node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step 2

To suppress alarms for the entire node:

   a. Check the Suppress Alarms check box.

   b. Click Apply.

All raised alarms for the node will change color to white in the Alarms window and their status will change to cleared. After suppressing alarms, clicking Synchronize in the Alarms window will remove cleared alarms from the window. However, an AS-CMD alarm will show in node or card view to indicate that node-level alarms were suppressed, and the word System will appear in the Object column.

Note

The only way to suppress building integrated timing supply (BITS), power source, or system alarms is to suppress alarms for the entire node. These cannot be suppressed separately.

Step 3

To suppress alarms for individual cards:

   a. In the alarm behavior window, locate the card row (using the Location column for the slot number or the Eqpt Type column for the equipment name).

   b. Check the Suppress Alarms column check box in that row.

Alarms that directly apply to this card will change appearance as described in Step 2. For example, if you suppressed raised alarms for an OC-48 card in Slot 16, raised alarms for this card will change in node or card view. The AS-CMD alarm will show the slot number in the Object number. For example, if you suppressed alarms for a Slot 16 OC-48 card, the AS-CMD object will be “SLOT-16.”

Click Apply.

Step 4

To suppress alarms for individual card ports, double-click the card in node view.

Step 5

Click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step 6

Check the Suppress Alarms column check box for the port row where you want to suppress alarms (Figure 8-6 on page 8-22).

Step 7

Click Apply.

Alarms that apply directly to this port will change appearance as described in Step 2. (However, alarms raised on the entire card will remain raised.) A raised AS-CMD alarm that shows the port as its object will appear in either alarm window. For example, if you suppressed alarms for Port 1 on the Slot 16 OC-48 card, the alarm object will show “FAC-16-1.”

Step 8

Return to your originating procedure (NTP).
DLP-G130 Discontinue Alarm Suppression

**Purpose**
This task discontinues alarm suppression and reenables alarm reporting on a port, card, or node.

**Tools/Equipment**
None

**Prerequisite Procedures**
- DLP-G129 Suppress Alarm Reporting, page 8-29
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

⚠️ **Caution**
If multiple CTC sessions are open, discontinuing suppression in one session will discontinue suppression in all other open sessions.

---

**Step 1**
To discontinue alarm suppression for the entire node:

a. In node view, click the **Provisioning > Alarm Profiles > Alarm Behavior** tab.

b. Uncheck the **Suppress Alarms** check box.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from the window using the Synchronize button.) The AS-CMD alarm with the System object will be cleared in all views.

**Step 2**
To discontinue alarm suppression for individual cards:

a. In node view, click the **Provisioning > Alarm Profiles > Alarm Behavior** tabs.

b. Locate the card that is suppressed in the slot list.

c. Uncheck the Suppress Alarms column check box for that slot.

d. Click **Apply**.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from the window using the Synchronize button.) The AS-CMD alarm with the slot object (for example, SLOT-16) will be cleared in all views.

**Step 3**
To discontinue alarm suppression for ports, click the **Provisioning > Alarm Profiles > Alarm Behavior** tabs.

**Step 4**
Uncheck the **Suppress Alarms** check box for the port(s) that you no longer want to suppress.

**Step 5**
Click **Apply**.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from the window using the Synchronize button.) The AS-CMD alarm with the port object (for example, FAC-16-1) will be cleared in all views.

**Step 6**
Return to your originating procedure (NTP).
NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card

Purpose
Use this procedure to create external (environmental) alarms and external controls for the AIC-I card.

Tools/Equipment
An AIC-I card must be installed in Slot 9.

Prerequisite Procedures
DLP-G34 Install the AIC-I Card, page 1-75

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
On the ONS 15454 ANSI shelf, the AIC-I card alarm provides direct alarm contacts (external alarm inputs and external control outputs) routed through the backplane to wire-wrap pins accessible from the back of the shelf. If you install an Alarm Expansion Panel (AEP), the AIC-I alarm contacts cannot be used. Only the AEP alarm contacts can be used. For further information about the AEP, see “NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44 and the “NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only)” procedure on page 1-58. The ONS 15454 ETSI shelf is not compatible with the AEP.

Note
For information about the AIC-I alarms, controls, and virtual wire, refer to the “23.7.3 Virtual Wires” section on page 23-13.

Step 1
If you are using an ONS 15454 ANSI shelf, verify the backplane wiring. If you are using the AEP, see the “NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44. Otherwise, see the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-47 for information about the ONS 15454 backplane pins.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN backplane pins.
b. For external controls, verify that the external device relays are wired to the ENVIR ALARMS OUT backplane pins.

Step 2
If you are using an ONS 15454 ETSI shelf, verify the alarm contact wiring. See the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-47 for information about the ONS 15454 SDH contacts.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN connector pins.
b. For external controls, verify the external device relays are wired to the ENVIR ALARMS OUT connector pins.

Step 3
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 4.

Step 4
In node view, double-click the AIC-I card on the shelf graphic. The card view appears.

Step 5
Click the Provisioning > Card tabs.
Step 6  In the Alarm Contacts area, click the Add Extension radio button if you are using the AEP. Clicking this option will choose the External Alarm input/output type and the AEP extension type; it will give you access to 16 external alarm contacts.

Step 7  If you did not click Add Extension, in the Input/Output area choose either External Alarm or External Control. (External Alarm will limit your input/output options as explained in Step 6.) Choosing External Control will enable both external alarms and external controls. This will convert four of the external alarm contacts to external controls, leaving 12 available external control contacts. The extension type for both options is AEP.

Step 8  Click Apply.

Step 9  If you are provisioning external alarms, click the External Alarms tab (Figure 8-10). If you are not provisioning external alarms, skip Steps 10 through 12 and go to Step 13.

Figure 8-10  Provisioning External Alarms on the AIC-I Card

Step 10  For external alarms, complete the following fields:

- **Enabled**—Check the check box to activate the fields for the alarm input number.
- **Alarm Type**—Choose an alarm type from the drop-down list.
- **Severity**—Choose a severity from the drop-down list.
  The severity determines the alarm’s severity in the Alarms and History tabs and determines whether the LEDs are activated. Critical (CR), Major (MJ), and Minor (MN) alarms activate the LEDs. Not Alarmed (NA) and Not Reported (NR) events do not activate LEDs, but do report the information in CTC.
- **Virtual Wire**—Choose the virtual wire number from the drop-down list if you want to assign the external device to a virtual wire. Otherwise, do not change the None default.
- **Raised When**—From the drop-down list, choose the contact condition (open or closed) that triggers the alarm.
NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card

Chapter 8      Manage Alarms

- Description—A default description is provided; enter a different description if needed.
  (Double-click the cell and highlight the text to change it.)

**Step 11** To provision additional devices, complete **Step 10** for each additional device.

**Step 12** Click **Apply**.

When you provision an external alarm, the alarm object is ENV-IN-\textit{nn}. The variable \textit{nn} refers to the external alarm’s number, regardless of the name you assign.

**Step 13** For external controls, click the **External Controls** tab and complete the following fields for each control wired to the ONS 15454 backplane (ANSI) or FMEC connector pins (ETSI):

- **Enabled**—Check this check box to activate the fields for the alarm input number.
- **Control Type**—Choose the control type from the drop-down list: air conditioner, engine, fan, generator, heat, light, sprinkler, or miscellaneous.
- **Trigger Type**—Choose a trigger type: a local minor, major, or critical alarm; a remote minor, major, or critical alarm; or a virtual wire activation.
- **Description**—Enter a description. (Double-click on the cell and highlight the text to change it.)

**Step 14** To provision additional external controls, complete **Step 13** for each device.

**Step 15** Click **Apply**.

**Note**  
External alarms and controls should be recorded locally for the network element (NE). Both the alarm name and resolution are node-specific.

---

Stop. You have completed this procedure.
Monitor Performance

This chapter explains how to enable and view performance monitoring (PM) statistics for the Cisco ONS 15454. PM parameters are used by service providers to gather, store, set thresholds, and report performance data for early detection of problems. For more PM information, details, and definitions, refer to the *Cisco ONS 15454 Troubleshooting Guide* (for ANSI shelves) or *Cisco ONS 15454 SDH Troubleshooting Guide* (for ETSI shelves).

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. **NTP-G73 Change the PM Display, page 9-2**—Complete as needed to change the displayed PM counts.

2. **NTP-G74 Monitor DWDM Card Performance, page 9-9**—Complete as needed to monitor dense wavelength division multiplexing (DWDM) performance.

3. **NTP-G75 Monitor Transponder and Muxponder Performance, page 9-19**—Complete as needed to monitor transponder (TXP) and muxponder (MXP) card performance.

Note

For additional information regarding PM parameters, refer to Telcordia GR-499-CORE, GR-253-CORE, GR-820-CORE (titled *Generic Digital Transmission Surveillance*), and GR-1230-CORE, and to the ANSI T1.231 document titled *Digital Hierarchy - Layer 1 In-Service Digital Transmission Performance Monitoring*. 
NTP-G73 Change the PM Display

Purpose: This procedure enables you to change the display of PM counts by selecting drop-down list or radio button options in the Performance window.

Tools/Equipment: None

Prerequisite Procedures: Before you monitor performance, be sure you have created the appropriate circuits and provisioned the card according to your specifications. For more information, see Chapter 7, “Create Channels and Circuits,” Chapter 5, “Provision Transponder and Muxponder Cards,” and Chapter 11, “Change DWDM Card Settings.”

Required/As Needed: As needed

Onsite/Remote: Onsite or remote

Security Level: Retrieve or higher

Step 1: Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node that you want to monitor. If you are already logged in, continue with Step 2.

Step 2: As needed, use the following tasks to change the display of PM counts:

- DLP-G131 Refresh PM Counts at 15-Minute Intervals, page 9-2
- DLP-G132 Refresh PM Counts at One-Day Intervals, page 9-3
- DLP-G133 View Near-End PM Counts, page 9-4
- DLP-G134 View Far-End PM Counts, page 9-5
- DLP-G135 Reset Current PM Counts, page 9-6
- DLP-G136 Clear Selected PM Counts, page 9-7
- DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts, page 9-8
- DLP-G138 Refresh PM Counts for a Different Port, page 9-9

Stop. You have completed this procedure.

DLP-G131 Refresh PM Counts at 15-Minute Intervals

Purpose: This task changes the window view to display PM counts in 15-minute intervals.

Tools/Equipment: None

Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25

Required/As Needed: As needed

Onsite/Remote: Onsite or remote

Security Level: Retrieve or higher

Step 1: In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to change the PM count display interval. The card view appears.
Step 2 Click the **Performance** tab.

Step 3 If you want to change the PM interval to 15 minutes for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

**Note** Performance subtabs vary, depending on the card viewed.

Step 4 If you want to change the PM interval to 15 minutes for a specific port, select the port from the Ports drop-down list (where available).

Step 5 Go to any of the tabs, subtabs, or ports (found in the Ports drop-down list where available) for that card where you want to set the PM count interval by clicking on the desired subtab and choosing the port from the drop-down list.

Step 6 Click the **15 min** radio button.

Step 7 Click **Refresh**. PM parameters appear in 15-minute intervals synchronized with the time of day.

Step 8 View the Curr column to find PM counts for the current 15-minute interval.

Each monitored performance parameter has corresponding threshold values for the current time period. If the value of the counter exceeds the threshold value for a particular 15-minute interval, a threshold crossing alert (TCA) is raised. The number represents the counter value for each specific PM parameter.

Step 9 View the Prev-n columns to find PM counts for the previous 15-minute intervals.

**Note** If a complete 15-minute interval count is not possible, the value appears with a yellow background. An incomplete or incorrect count can be caused by monitoring for less than 15 minutes after the counter started, changing the node timing settings, changing the time zone settings, replacing a card, resetting a card, or changing port service states. When the problem is corrected, the subsequent 15-minute interval appears with a white background.

Step 10 Return to your originating procedure (NTP).

---

### DLP-G132 Refresh PM Counts at One-Day Intervals

<table>
<thead>
<tr>
<th><strong>Purpose</strong></th>
<th>This task changes the window view to display PM parameters in 1-day intervals.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tools/Equipment</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Prerequisite Procedures</strong></td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td><strong>Required/As Needed</strong></td>
<td>As needed</td>
</tr>
<tr>
<td><strong>Onsite/Remote</strong></td>
<td>Onsite or remote</td>
</tr>
<tr>
<td><strong>Security Level</strong></td>
<td>Retrieve or higher</td>
</tr>
</tbody>
</table>

Step 1 In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to change the PM interval. The card view appears.

Step 2 Click the **Performance** tab.
Chapter 9  Monitor Performance

DLP-G133 View Near-End PM Counts

**Step 3** If you want to refresh the PM counts for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

*Note* Performance subtabs vary, depending on the card viewed.

**Step 4** If you want to refresh the PM counts for a specific port, select the port from the Ports drop-down list (where available).

**Step 5** Click the **1 day** radio button.

**Step 6** Click **Refresh**. Performance monitoring appears in 1-day intervals synchronized with the time of day.

**Step 7** View the Curr column to find PM counts for the current 1-day interval.

Each monitored performance parameter has corresponding threshold values for the current time period. If the value of the counter exceeds the threshold value for a particular 1-day interval, a TCA is raised. The number represents the counter value for each specific PM parameter.

**Step 8** View the Prev-n columns to find PM counts for the previous 1-day intervals.

*Note* If a complete count over a 1-day interval is not possible, the value appears with a yellow background. An incomplete or incorrect count can be caused by monitoring for less than 24 hours after the counter started, changing node timing settings, changing the time zone settings, replacing a card, resetting a card, or changing port service states. When the problem is corrected, the subsequent 1-day interval appears with a white background.

**Step 9** Return to your originating procedure (NTP).

---

DLP-G133 View Near-End PM Counts

**Purpose** This task enables you to view near-end PM counts for the selected card and port.

**Tools/Equipment** None

**Prerequisite Procedures** DLP-G46 Log into CTC, page 2-25

**Required/As Needed** As needed

**Onsite/Remote** Onsite or remote

**Security Level** Retrieve or higher

**Step 1** In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to view near end PM counts. The card view appears.

**Step 2** Click the **Performance** tab.

**Step 3** If you want to view the near-end PM counts for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

*Note* Performance subtabs vary, depending on the card viewed.
Step 4 If you want to view near-end PM counts for a specific port, select the port from the Ports drop-down list (where available).

Step 5 Click the Near End radio button, where available. (Viewing near-end PM counts is not available on some tabs.)

Step 6 Click Refresh. All PM parameters occurring for the selected card on the incoming signal appear. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 7 View the Curr column to find PM counts for the current time interval.

Step 8 View the Prev-n columns to find PM counts for the previous time intervals.

Step 9 Return to your originating procedure (NTP).

### DLP-G134 View Far-End PM Counts

**Purpose**
This task enables you to view far-end PM parameters for the selected card and port.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

**Note**
Far-end PM parameters are not available for all ports.

**Step 1**
In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to view far-end PM counts. The card view appears.

**Step 2**
Click the Performance tab.

**Step 3**
If you want to view far-end PM counts for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

**Note**
Performance subtabs vary, depending on the card viewed.

**Step 4**
If you want to view far-end PM counts for a specific port, select the port from the Ports drop-down list (where available).

**Step 5**
Click the Far End radio button, where available. (Viewing far-end PM counts is not available on some tabs.)

**Step 6**
Click Refresh. All PM parameters recorded by the far-end node for the selected card on the outgoing signal appear. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

**Step 7**
View the Curr column to find PM counts for the current time interval.

**Step 8**
View the Prev-n columns to find PM counts for the previous time intervals.
DLP-G135 Reset Current PM Counts

Purpose
This task clears the current PM count, but it does not clear the cumulative PM count. This task allows you to see how quickly PM counts rise.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to reset the current PM counts. The card view appears.

Step 2
Click the Performance tab.

Step 3
If you want to reset the PM counts for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

Note
Performance subtabs vary, depending on the card viewed.

Step 4
If you want to reset the PM counts for a specific port, select the port from the Ports drop-down list (where available).

Note
You cannot change the PM count interval on the TXP or MXP card Optics PM > Current Values tab.

Step 5
Click Baseline.

Note
The Baseline button clears the PM counts displayed in the current time interval but does not clear the PM counts on the card. When the current time interval expires or the window view changes, the total number of PM counts on the card and in the window appears in the appropriate column. The baseline values are discarded if you change views to a different window and then return to the Performance window.

Step 6
View the current statistics columns to observe changes to PM counts for the current time interval.

Step 7
Return to your originating procedure (NTP).
DLP-G136 Clear Selected PM Counts

Purpose: This task uses the Clear button to clear specified PM counts depending on the option selected.

Tools/Equipment: None

Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25

Required/As Needed: As needed

Onsite/Remote: Onsite or remote

Security Level: Superuser

Caution: Pressing the Clear button can mask problems if used incorrectly. This button is commonly used for testing purposes. After pressing this button, the current bin is marked invalid. Also note that the unavailable seconds (UAS) count is not cleared if you were counting UAS; therefore, this count could be unreliable when you press Clear.

Step 1: In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to clear the PM counts. The card view appears.

Step 2: Click the Performance tab.

Step 3: If you want to clear the selected PM counts for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

Note: Performance subtabs vary, depending on the card viewed.

Step 4: If you want to clear the selected PM counts for a specific port, select the port from the Ports drop-down list (where available).

Note: You cannot clear the PM count interval on the TXP or MXP card Optics PM > Current Values tab.

Step 5: Click Clear.

Step 6: From the Clear Statistics dialog box, click one of the following radio buttons:

- **Displayed statistics**: Clearing displayed statistics erases all PM counts associated with the current combination of statistics on the selected port from the card and the window. This means that the selected time interval, direction, and signal type counts are erased from the card and the window.

- **All statistics for port x**: Clearing all statistics for port x erases all PM counts associated with all combinations of the statistics on the selected port from the card and the window. This means that all time intervals, directions, and signal type counts are erased from the card and the window.

- **All statistics for card**: Clearing all statistics for card erases all PM counts for all ports from the card and the window.

Step 7: From the Clear Statistics dialog box, click OK to clear the selected statistics. Click Yes to confirm the change.

Step 8: Verify that the selected PM counts have been cleared.
Step 9

Return to your originating procedure (NTP).

---

DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts

**Purpose**
This task changes the window auto-refresh intervals for updating the PM counts.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to set the auto-refresh interval for displayed PM counts. The card view appears.

**Step 2**
Click the **Performance** tab.

**Step 3**
If you want to set the PM auto-refresh interval for a subtab, click the relevant subtab(s), located along the left side of the Performance tab.

---

**Note**
Performance subtabs vary, depending on the card viewed.

**Step 4**
If you want to set the PM auto-refresh interval for a specific port, select the port from the Ports drop-down list (where available).

**Step 5**
From the Auto-refresh drop-down list, choose one of the following options:

- **None**: This option disables the auto-refresh feature.
- **15 Seconds**: This option sets the window auto-refresh at 15-second time intervals.
- **30 Seconds**: This option sets the window auto-refresh at 30-second time intervals.
- **1 Minute**: This option sets the window auto-refresh at 1-minute time intervals.
- **3 Minutes**: This option sets the window auto-refresh at 3-minute time intervals.
- **5 Minutes**: This option sets the window auto-refresh at 5-minute time intervals.

**Step 6**
Click **Refresh**. The PM counts for the newly selected auto-refresh time interval appear.

Depending on the selected auto-refresh interval, the displayed PM counts automatically update when each refresh interval completes. If the auto-refresh interval is set to None, the PM counts that appear are not updated unless you click Refresh.

**Step 7**
Return to your originating procedure (NTP).
**DLP-G138 Refresh PM Counts for a Different Port**

**Purpose**
This task changes the window view to display PM counts for another port on a TXP or MXP card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view (single-shelf mode), or shelf view (multishelf mode), double-click the DWDM, TXP, or MXP card where you want to refresh PM counts for a different port. The card view appears.

**Step 2**
Click the Performance tab.

**Step 3**
In the Port drop-down list, choose a port.

**Step 4**
Click Refresh. The PM counts for the newly selected port appear.

**Step 5**
Return to your originating procedure (NTP).

---

**NTP-G74 Monitor DWDM Card Performance**

**Purpose**
This procedure enables you to view, transmit, and receive performance information for OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 4MD, AD-xC-xx.x, AD-xB-xx.x, 32WSS, OPT-BST, and OPT-PRE cards and ports during selected time intervals to detect possible performance problems.

**Tools/Equipment**
None

**Prerequisite Procedures**
Before you monitor performance, be sure you have created the appropriate circuits and provisioned the card according to your specifications. For more information, see Chapter 7, “Create Channels and Circuits” and Chapter 11, “Change DWDM Card Settings.”

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” procedure on page 2-25 at the node that you want to monitor. If you are already logged in, continue with Step 2.

**Step 2**
Complete the following tasks as needed:
- DLP-G139 View Optical Service Channel PM Parameters, page 9-10.
DLP-G139 View Optical Service Channel PM Parameters

**Purpose**

This task enables you to view optical service channel (OSC) PM counts at selected time intervals on an OSCM or OSC-CSM card and port to detect possible performance problems.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Retrieve or higher

**Step 1**

In node view, double-click the OSCM or OSC-CSM card where you want to view PM counts. The card view appears.

**Step 2**

Click the **Performance > OC3 Line** tabs (Figure 9-1).
Figure 9-1  OC3 Line Tab in the Optical Service Channel Card View Performance Window

Step 3  Click **Refresh**. PMs appear for the OC3 (Port 1).

Step 4  Click the **Optical Line** tab.

Step 5  In the Port drop-down list, choose the optical line port where you want to view the power statistics:

- 2—COM RX
- 3—COM TX
- 4—LINE RX (available only on the OSC-CSM card)
- 5—LINE TX (available only on the OSC-CSM card)
- 6—OSC RX (available only on the OSC-CSM card)
- 7—OSC TX (available only on the OSC-CSM card)

Step 6  Click **Refresh**. The minimum, maximum, and average optical power statistics for the selected line port appear.

Step 7  Return to your originating procedure (NTP).
DLP-G140 View Optical Amplifier Power Statistics

**Purpose**
This task enables you to view the power statistics on an OPT-PRE or OPT-BST amplifier card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view, double-click the optical amplifier card where you want to view PM counts. The card view appears.

**Step 2**
Click the **Performance > Optical Line** tabs (Figure 9-2).

**Figure 9-2 Optical Line Tab in the Optical Amplifier Card View Performance Window**

**Step 3**
In the Port drop-down list, choose an optical line port where you want to view the optical power statistics:
- For the OPT-PRE card, the following ports are available to view:
  - 1—COM RX
  - 3—DC RX
DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards

Purpose
This task enables you to view optical power statistics for a 32MUX-O, 32WSS, 32-DMX-O, or 32DMX card.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Retrieve or higher

Step 1
In node view, double-click the 32MUX-O, 32WSS, 32-DMX-O, or 32DMX card where you want to view PM counts. The card view appears.

Step 2
Click the Performance > Optical Chn tabs (Figure 9-3 on page 9-14).
Step 3  In the Port drop-down list, choose an optical channel to view by selecting the port where you want to view the optical power statistics.
- 32MUX-O—optical channel receive port (CHAN RX), Ports 01 through 32.
- 32WSS—optical channel receive port (ADD RX) Ports 01 through 32, or a pass-through port (PT), Ports 33 through 64.
- 32DMX-O and 32DMX—optical channel transmit port (CHAN TX), Ports 01 through 32.

Step 4  Click Refresh. Optical channel power statistics (minimum, maximum, average) for the selected port appear.

Step 5  Click the Optical Line tab.

Step 6  For a 32WSS card, select the port for which you wish to monitor power statistics (65, 66, 67, 68, or 69). For a 32DMX or 32DMX-O card, accept the default port (33).

Step 7  Click Refresh. Optical channel power statistics (minimum, maximum, average) for the selected port appear.

Step 8  Return to your originating procedure (NTP).
DLP-G276 View 4-Channel Multiplexer/Demultiplexer Optical Power Statistics

**Purpose**
This task enables you to view the minimum, maximum, and average optical power statistics for a 4MD-xx.x card channel and band ports.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view, double-click the 4MD-xxx card where you want to the optical power statistics. The card view appears.

**Step 2**
Click the **Performance > Optical Chn** tabs (Figure 9-4).

**Figure 9-4 Optical Channel Tab in the 4MD-xx.x Card View Performance Window**

**Step 3**
In the Port drop-down list, choose the channel port (1 through 8 for CHAN Ports 01 through 08) where you want to view the power statistics.

**Step 4**
Click **Refresh**. The minimum, maximum, and average optical power for the selected channel port appear.

**Step 5**
To change the auto-refresh interval, click **Auto Refresh** and choose one of the automatic refresh intervals: None, 15 seconds, 30 seconds, 1 minute, 3 minutes, or 5 minutes.
Step 6  Click the Optical Band tab.

Step 7  In the Port drop-down list, choose the band port (9 or 10 for COM Ports 09 and 10) where you want to view the power statistics.

Step 8  Click Refresh. The minimum, maximum, and average optical power for the selected band port appear.

Step 9  To change the auto-refresh interval, click Auto Refresh and choose one of the automatic refresh intervals: None, 15 seconds, 30 seconds, 1 minute, 3 minutes, or 5 minutes.

Step 10  Return to your originating procedure (NTP).

DLP-G142 View Channel Optical Add/Drop Multiplexer Power Statistics

Purpose  This task enables you to view channel optical add/drop multiplexer (OADM) minimum, maximum, and average power statistics on an AD-1C-xx.x, AD-2C-xx.x, or AD-4C-xx.x card.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Retrieve or higher

Step 1  In node view, double-click the optical AD-xC-xx.x card where you want to view the optical power statistics. The card view appears.

Step 2  Click the Performance > Optical Line tabs (Figure 9-5).
Step 3  In the Port drop-down list, choose an optical line port (Table 9-1) where you want to view the optical power statistics.

**Table 9-1  Channel OADM Optical Line Ports**

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-1C-xx.x</td>
<td>AD-2C-xx.x</td>
</tr>
<tr>
<td>EXP RX</td>
<td>3</td>
</tr>
<tr>
<td>EXP TX</td>
<td>4</td>
</tr>
<tr>
<td>COM RX</td>
<td>5</td>
</tr>
<tr>
<td>COM TX</td>
<td>6</td>
</tr>
</tbody>
</table>

Step 4  Click **Refresh**. Optical line power statistics for the selected port appear.

Step 5  Click the **Optical Chn** tab.

Step 6  In the Port drop-down list, choose an optical channel port (Table 9-1) where you want to view the optical power statistics.
DLP-G143 View Band Optical Add/Drop Multiplexer Power Statistics

**Table 9-2**  Channel OADM Optical Line Ports

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AD-1C-xx.x</td>
</tr>
<tr>
<td>CHAN RX</td>
<td>1</td>
</tr>
<tr>
<td>CHAN TX</td>
<td>2</td>
</tr>
<tr>
<td>CHAN RX</td>
<td>—</td>
</tr>
<tr>
<td>CHAN TX</td>
<td>—</td>
</tr>
<tr>
<td>CHAN RX</td>
<td>—</td>
</tr>
<tr>
<td>CHAN TX</td>
<td>—</td>
</tr>
<tr>
<td>CHAN RX</td>
<td>—</td>
</tr>
<tr>
<td>CHAN TX</td>
<td>—</td>
</tr>
</tbody>
</table>

**Step 7** Click **Refresh**. Optical channel PM statistics for the selected port appear.

**Step 8** Return to your originating procedure (NTP).

**DLP-G143 View Band Optical Add/Drop Multiplexer Power Statistics**

**Purpose**
This task enables you to view band OADM minimum, maximum, and average power statistics on an AD-1B-xx.x or AD-4B-xx.x card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

**Step 1** In node view, double-click the optical AD-xB-xx.x card where you want to view the optical power statistics. The card view appears.

**Step 2** Click the **Performance > Optical Line** tabs.

**Step 3** In the Port drop-down list, choose an optical line port (Table 9-3) where you want to view the optical power statistics.

**Table 9-3**  Band OADM Optical Line Ports

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AD-1B-xx.x</td>
</tr>
<tr>
<td>EXP RX</td>
<td>3</td>
</tr>
<tr>
<td>EXP TX</td>
<td>4</td>
</tr>
<tr>
<td>COM RX</td>
<td>5</td>
</tr>
<tr>
<td>COM TX</td>
<td>6</td>
</tr>
</tbody>
</table>
Step 4 Click **Refresh**. Optical line power statistics for the selected port appear.

Step 5 Click the **Optical Band** tab.

Step 6 In the Port drop-down list, choose an optical band port (Table 9-4) where you want to view the optical power statistics.

### Table 9-4 Band OADM Optical Line Ports

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAND RX</td>
<td>1</td>
</tr>
<tr>
<td>BAND TX</td>
<td>2</td>
</tr>
<tr>
<td>BAND RX</td>
<td>—</td>
</tr>
<tr>
<td>BAND TX</td>
<td>—</td>
</tr>
<tr>
<td>BAND RX</td>
<td>—</td>
</tr>
<tr>
<td>BAND TX</td>
<td>—</td>
</tr>
<tr>
<td>BAND RX</td>
<td>—</td>
</tr>
<tr>
<td>BAND TX</td>
<td>—</td>
</tr>
</tbody>
</table>

- **Purpose**: This procedure enables you to view node near-end or far-end performance during selected time intervals on a transponder (TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E) or muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10G) card and port to detect possible performance problems.
- **Tools/Equipment**: None
- **Prerequisite Procedures**: Before you monitor performance, be sure you have created the appropriate circuits and provisioned the card according to your specifications. For more information, see Chapter 7, “Create Channels and Circuits,” Chapter 5, “Provision Transponder and Muxponder Cards,” or Chapter 11, “Change DWDM Card Settings.”
- **Required/As Needed**: As needed
- **Onsite/Remote**: Onsite or remote
- **Security Level**: Retrieve or higher

Step 7 Click **Refresh**. Optical channel PM statistics for the selected port appear.

Step 8 Return to your originating procedure (NTP).

---

**NTP-G75 Monitor Transponder and Muxponder Performance**

- **Purpose**: This procedure enables you to view node near-end or far-end performance during selected time intervals on a transponder (TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E) or muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10G) card and port to detect possible performance problems.
- **Tools/Equipment**: None
- **Prerequisite Procedures**: Before you monitor performance, be sure you have created the appropriate circuits and provisioned the card according to your specifications. For more information, see Chapter 7, “Create Channels and Circuits,” Chapter 5, “Provision Transponder and Muxponder Cards,” or Chapter 11, “Change DWDM Card Settings.”
- **Required/As Needed**: As needed
- **Onsite/Remote**: Onsite or remote
- **Security Level**: Retrieve or higher

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node that you want to monitor. If you are already logged in, continue with Step 2.
Step 2  Complete the “DLP-G144 Enable or Disable OTN ITU-T G.709 Performance Monitoring” task on page 9-20 as needed for any TXP or MXP card (except the TXP_MR_10E and MXP_2.5G_10E cards) to enable or disable optical transport network (OTN) ITU-T G.709 monitoring.

Step 3  Complete the “DLP-G145 Enable or Disable OTN FEC Performance Monitoring” task on page 9-21 as needed for TXP_MR_10E and MXP_2.5G_10E cards to enable or disable OTN forward error correction (FEC) monitoring.

Step 4  Complete the following tasks as needed to view PM parameters:
- DLP-G146 View Optics PM Parameters, page 9-22
- DLP-G147 View Payload PM Parameters, page 9-23
- DLP-G148 View OTN PM Parameters, page 9-25
- DLP-G149 View Payload Statistics PM Parameters, page 9-27
- DLP-G150 View Payload Utilization PM Parameters, page 9-28
- DLP-G151 View Payload History PM Parameters, page 9-30
- DLP-G152 View Payload SONET PM Parameters, page 9-31

Note  To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on page 9-2.

Stop. You have completed this procedure.

DLP-G144 Enable or Disable OTN ITU-T G.709 Performance Monitoring

Purpose  This task enables or disables OTN ITU-T G.709 monitoring of near-end or far-end performance on a card and port during selected time intervals to detect possible problems. This task can be performed for any TXP or MXP card except the TXP_MR_10E and MXP_2.5G_10E cards. See the “DLP-G145 Enable or Disable OTN FEC Performance Monitoring” task on page 9-21 for TXP_MR_10E and MXP_2.5G_10E card information.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Step 1  In node view, double-click the card you want to monitor. The card view appears.

Step 2  Determine if the port where you want to enable or disable OTN ITU-T G.709 is in service (IS). (Click the Provisioning > Line tabs, and observe the Service State column for that port.) If it is IS, perform the following tasks for that port. If not, go to Step 3.

a. DLP-G108 Change the Service State for a Port, page 7-18 to set the port to Out of Service, Disabled (OOS,DSBLD).
DLP-G145 Enable or Disable OTN FEC Performance Monitoring

Purpose
This task enables or disables OTN FEC monitoring of node near-end or far-end performance on a selected TXP_MR_10E or MXP_2.5G_10E card and port during selected time intervals.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the card you want to monitor. The card view appears.

Step 2
Determine if the port where you want to enable or disable FEC is in service (IS). (Click the Provisioning > Line tabs, and observe the Service State column for that port.) If it is IS, perform the following tasks for that port. If not, go to Step 3.

a. DLP-G108 Change the Service State for a Port, page 7-18 to set the port to OOS,DSBLD.

b. DLP-G185 Delete a GCC Termination, page 10-40, if GCC is provisioned on that port.

Step 3
Click the Provisioning > OTN > OTN Lines tabs.

Step 4
Make an FEC selection based on the following rules:

- Choose Disable to disable the OTN FEC monitoring.
- Choose Enable to enable standard FEC monitoring for that port (default).

Step 5
Click Apply.

Step 6
Click the Performance tab to view PM parameters. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
DLP-G146 View Optics PM Parameters

**Purpose**
This task enables you to view the optics PM counts on a transponder (TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E), or muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10G) card and port to detect possible performance problems.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

**Step 1**
In node view, double-click the transponder or muxponder card where you want to view PM counts. The card view appears.

**Step 2**
Click the **Performance > Optics PM** tabs (Figure 9-6).
Step 3 View the PM parameter names that appear in the Param column of the Current Values and History PM tabs. The PM parameter values appear in the Curr (current) and Prev-n (previous) columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 4 Return to your originating procedure (NTP).

DLP-G147 View Payload PM Parameters

Purpose This task enables you to view the payload PM counts on a transponder (TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), or muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The card view appears.

Step 2 Click the Performance > Payload PM tabs (Figure 9-7).
Step 3 Go to any of the tabs, subtabs, or ports (found in the Ports drop-down list where available) for the card where you want to view the payload PM parameters by clicking on the desired subtab, and choosing the port from the Port drop-down list.

Step 4 View the PM parameter names that appear in the Param column of the Current Values and History PM tabs. The PM parameter values appear in the Curr (current), and Prev-n (previous) columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note The payload PMs for data parameters can be viewed only after creating a pluggable port module (PPM). See the “NTP-G128 Manage Pluggable Port Modules” procedure on page 5-2 for more information about PPMs.

Note The PM parameters that appear depend on the data payload and framing type provisioned on the port. Unframed data payloads such as Enterprise System Connection (ESCON), DV6000, DSI/D1 video, and high-definition television (HDTV) do not provide payload PM information. The PM parameters that appear also depend on the PPM payload configured. The TXP_MR_10E card supports three payloads, the MXP_2.5G_10G and MXP_2.5G_10E cards support the OC48/STM16 payload, and the MXP_MR_2.5G and MXPP_MR_2.5G cards support the 1G FC, 2G FC, 1G FICON, 2G FICON, and 1G payloads.
**Step 5**

Return to your originating procedure (NTP).

---

**DLP-G148 View OTN PM Parameters**

**Purpose**

This task enables you to view the OTN PM counts on a transponder (TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), or muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to detect possible performance problems.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Retrieve or higher

---

**Step 1**

In node view, double-click the TXP or MXP card where you want to view PM counts. The card view appears.

**Step 2**

Click the **Performance > OTN PM > G.709** tabs (Figure 9-8).

*Figure 9-8 Viewing OTN ITU-T G.709 Performance Monitoring Information*
Step 3 View the PM parameter names that appear in the Param column. The PM parameter values appear in the Curr (current) and Prev-\(n\) (previous) columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 4 Click the FEC PM tab (Figure 9-9).

Figure 9-9 Viewing OTN FEC Performance Monitoring Information

Step 5 View the PM parameter names that appear in the Param column. The PM parameter values appear in the Curr (current) and Prev-\(n\) (previous) columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).
DLP-G149 View Payload Statistics PM Parameters

**Purpose**  
This task enables you to view current statistical PM counts on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible performance problems.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Retrieve or higher

**Step 1**  
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM counts. The card view appears.

**Step 2**  
Click the Performance > Payload PM > Statistics tabs (Figure 9-10).

**Figure 9-10  Statistics Tab on the Card View Performance Window**

**Step 3**  
Click Refresh. PM statistics appear for each port on the card.

**Step 4**  
View the PM parameter names that appear in the Param column. The current PM parameter values appear in the Port # columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
DLP-G150 View Payload Utilization PM Parameters

**Purpose**
This task enables you to view line utilization PM counts on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible performance problems.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM counts. The card view appears.

**Step 2**
Click the **Performance > Payload PM > Utilization** tabs (Figure 9-11).
Step 3  Click **Refresh**. PM utilization values appear for each port on the card.

Step 4  View the appropriate row for the port you want to monitor.

Step 5  The transmit (Tx) and receive (Rx) bandwidth utilization values for the previous time intervals appear in the Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

**Note**  To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on page 9-2.

Step 6  Return to your originating procedure (NTP).
DLP-G151 View Payload History PM Parameters

**Purpose**
This task enables you to view historical PM counts at selected time intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible performance problems.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM counts. The card view appears.

**Step 2**
Click the **Performance > Payload PM > History** tabs (Figure 9-12).

**Figure 9-12** History Tab on the Card View Performance Window

---

**Step 3**
Select the desired port from the Port drop-down list.

**Step 4**
Click **Refresh**. PM statistics appear for the selected port.

**Step 5**
View the PM parameter names that appear in the Param column. The PM parameter values appear in the Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide*. 
Step 6

Return to your originating procedure (NTP).

DLP-G152 View Payload SONET PM Parameters

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task enables you to view SONET PM counts at selected time intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible performance problems.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Retrieve or higher</td>
</tr>
</tbody>
</table>

Step 1

In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM counts. The card view appears.

Step 2

Click the Performance > Payload PM > SONET PM tabs (Figure 9-13).
Step 3 Click Refresh. PM statistics appear for the selected port.

Step 4 View the PM parameter names that appear in the Param column. The PM parameter values appear in the Prev-n columns. For PM parameter definitions, refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note The MXP_MR_2.5G and MXPP_MR_2.5G cards support only the OC48/STM16 payload. Each payload has a set of PM parameters.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on page 9-2.

Step 5 Return to your originating procedure (NTP).
CHAPTER 10

Manage the Node

This chapter explains how to modify node provisioning for the Cisco ONS 15454 and perform common management tasks such as monitoring the dense wavelength division multiplexing (DWDM) automatic power control (APC) and span loss values. To provision a new node, see Chapter 3, “Turn Up a Node.” To change default network element (NE) settings and to view a list of those settings, refer to Appendix B, “Hardware Specifications.”

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

Before performing the following procedures, investigate all alarms and clear any trouble conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G76 Verify Optical Span Loss Using CTC, page 10-2—Complete this procedure as needed to view or modify the DWDM span loss values.

2. NTP-G77 Manage Automatic Power Control, page 10-3—Complete this procedure as needed to manage the DWDM APC.

3. NTP-G78 View ROADM Node Power Equalization, page 10-5—Complete this procedure as needed to view and update a reconfigurable optical add/drop multiplexing (ROADM) node’s power equalization.

4. NTP-G80 Change Node Management Information, page 10-6—Complete this procedure as needed to change node name, contact information, latitude, longitude, date, time, and login legal disclaimer.

5. NTP-G134 Modify OSI Provisioning, page 10-9—Complete this procedure as needed to modify Open System Interconnection (OSI) parameters including the OSI routing mode, Target Identifier Address Resolution Protocol (TARP), routers, subnets, and IP-over-CLNS tunnels.

6. NTP-G81 Change CTC Network Access, page 10-18—Complete this procedure as needed to change the IP address, default router, subnet mask, network configuration settings, and static routes.

7. NTP-G82 Customize the CTC Network View, page 10-26—Complete this procedure as needed to create domains and customize the appearance of the network map, including specifying a different default map, creating domains, selecting your own map or image, and changing the background color.
8. NTP-G83 Modify or Delete Card Protection Settings, page 10-31—Complete this procedure as needed.
9. NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands, page 10-34—Complete this procedure as needed.
10. NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords, page 10-39—Complete this procedure as needed to modify or delete generic communications channel (GCC) and optical service channel (OSC) terminations, and provisionable patchcords.
11. NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection, page 10-42—Complete this procedure as needed to convert a pass-through connection to an add/drop connection.
12. NTP-G87 Change Node Timing Parameters, page 10-44—Complete this procedure as needed.
13. NTP-G88 Modify Users and Change Security, page 10-45—Complete this procedure as needed to make changes to user settings, including security level and security policies, and to delete users.
14. NTP-G131 Convert DWDM Nodes to Hybrid Nodes, page 10-58—Complete this procedure as needed to convert a DWDM node to a hybrid node.
15. NTP-G89 Change SNMP Settings, page 10-61—Complete this procedure as needed.

NTP-G76 Verify Optical Span Loss Using CTC

Purpose
This procedure verifies the span loss between two DWDM nodes using Cisco Transport Controller (CTC). Perform this procedure after a node or network modification has occurred and you want to verify that the span loss between the nodes has not changed.

Tools/Equipment
None

Prerequisite Procedures
All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Note
Using CTC to verify span loss is faster than a span loss measurement using an optical time domain reflectometer (OTDR) and does not require fibers to be removed. However, the resolution is not as precise as an OTDR measurement.

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
In node view, click the Provisioning > Comm Channels > OSC tabs. Verify that two OSC terminations are provisioned and have an In-Service and Normal (IS-NR) (ANSI) or Unlocked-enabled (ETSI) service state.

Step 3
Click the Maintenance > DWDM > WDM Span Check tabs.

Step 4
Click Retrieve Span Loss Values to retrieve the latest span loss data.

Step 5
View the following information:
- Side—Shows the side to which the span loss values apply, either east or west.
NTP-G77 Manage Automatic Power Control

Purpose
This procedure manages the DWDM APC.

Tools/Equipment
None

Prerequisite Procedures
All procedures in the following chapters:
- Chapter 3, “Turn Up a Node”
- Chapter 6, “Turn Up Network”

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
Complete the following tasks as necessary:
- DLP-G157 Disable Automatic Power Control, page 10-4
- DLP-G158 Enable Automatic Power Control, page 10-4
- DLP-G159 Refresh Automatic Power Control Information, page 10-5

Stop. You have completed this procedure.
DLP-G157 Disable Automatic Power Control

Purpose: This task disables the DWDM APC.
Tools/Equipment: None
Prerequisite Procedures: All procedures in the following chapters:
- Chapter 3, “Turn Up a Node”
- Chapter 6, “Turn Up Network”
- DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Caution: Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1: In node view, click the Maintenance > DWDM > APC tabs.
Step 2: Click Disable APC.
Step 3: Verify that the Enable APC button changes to Disable APC.
Step 4: Return to your originating procedure (NTP).

DLP-G158 Enable Automatic Power Control

Purpose: This task enables the DWDM APC.
Tools/Equipment: None
Prerequisite Procedures: All procedures in the following chapters:
- Chapter 3, “Turn Up a Node”
- Chapter 6, “Turn Up Network”
- DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Caution: Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1: In node view, click the Maintenance > DWDM > APC tabs.
Step 2: Click Enable APC.
Step 3: In the confirmation dialog box, Click Yes.
Step 4  Return to your originating procedure (NTP).

DLP-G159 Refresh Automatic Power Control Information

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task refreshes the DWDM APC information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>A node provisioning plan prepared by Cisco MetroPlanner is required.</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>All procedures in the following chapters:</td>
</tr>
<tr>
<td></td>
<td>Chapter 3, “Turn Up a Node”</td>
</tr>
<tr>
<td></td>
<td>Chapter 6, “Turn Up Network”</td>
</tr>
<tr>
<td></td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

Step 1  In node view, click the Maintenance > DWDM > APC tabs.
Step 2  Click Refresh.
Step 3  Return to your originating procedure (NTP).

NTP-G78 View ROADM Node Power Equalization

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure allows you to view ROADM node power equalization levels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Superuser</td>
</tr>
</tbody>
</table>

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.
Step 2  In node view, click the Maintenance > DWDM > ROADM Power Monitoring tabs.
Step 3  On the Power Monitoring tab, view the following east-to-west (E > W) and west-to-east (W > E) power information:
  - Padd—Add power. This power level is represented by the red bar.
  - Ppt—Pass-through power. This power level is represented by the yellow bar.
  - Pout—Output power. This power level is represented by the blue bar. It shows the per-channel (wavelength) power at the 32WSS output (COM_TX) port.
Note The 32WSS is designed to handle minor differences in output power. The output power does not need to be exactly the same for all wavelengths.

Figure 10-1 shows an example of ROADM node with equalized output power.

**Figure 10-1 Equalized ROADM Power Example**

![Equalized ROADM Power Example](image)

**Step 4** If needed, click **Refresh** to update the display.

Stop. You have completed this procedure.

---

**NTP-G80 Change Node Management Information**

**Purpose**
This procedure changes the node name, date, time, contact information, and login legal disclaimer.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-8

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1** Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2** Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3** In node view, click the **Provisioning > General** tabs.

**Step 4** Complete the “DLP-G160 Change the Node Name, Date, Time, and Contact Information” task on page 10-7, as needed.

**Step 5** Complete the “DLP-G161 Change the Login Legal Disclaimer” task on page 10-8, as needed.

**Step 6** After confirming the changes, complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.
DLP-G160 Change the Node Name, Date, Time, and Contact Information

Purpose
This task changes basic information such as node name, date, time, and contact information.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Changing the date, time, or time zone might invalidate the node’s performance monitoring counters.

Step 1
In node view, click the Provisioning > General tabs.

Step 2
Change any of the following:
- General: Node Name
- General: Contact
- Location: Latitude
- Location: Longitude
- Location: Description

Note
To see changes to longitude or latitude on the network map, you must go to network view and right-click the specified node, then click Reset Node Position.

- Time: Use NTP/SNTP Server
- Time: Date (M/D/Y)
- Time: Time (H:M:S)
- Time: Time Zone
- Time: Use Daylight Saving Time
- AIS-V Insertion On STS-1 Signal Degrade - Path: Insert AIS-V on STS-1 SD-P
- AIS-V Insertion On STS-1 Signal Degrade - Path: SD-P BER

See the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 for detailed field descriptions.

Step 3
Click Apply.

Step 4
Return to your originating procedure (NTP).
DLP-G161 Change the Login Legal Disclaimer

**Purpose**
This task modifies the legal disclaimer statement shown in the CTC login dialog box so that it will display customer-specific information when users log into the network.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
In node view, click the **Provisioning > Security > Legal Disclaimer > HTML** tabs.

**Step 2**
The existing statement is a default, non-customer-specific disclaimer. If you want to edit this statement with specifics for your company, you can change the text. Use the HTML commands in Table 10-1 to format the text, as needed.

**Table 10-1 HTML Commands for the Legal Disclaimer**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;b&gt;</code></td>
<td>Begins boldface font</td>
</tr>
<tr>
<td><code>&lt;/b&gt;</code></td>
<td>Ends boldface font</td>
</tr>
<tr>
<td><code>&lt;center&gt;</code></td>
<td>Aligns type in the center of the window</td>
</tr>
<tr>
<td><code>&lt;/center&gt;</code></td>
<td>Ends the center alignment</td>
</tr>
<tr>
<td><code>&lt;font=n&gt;</code> (where n = font point size)</td>
<td>Changes the font to the new size</td>
</tr>
<tr>
<td><code>&lt;/font&gt;</code></td>
<td>Ends the font size command</td>
</tr>
<tr>
<td><code>&lt;p&gt;</code></td>
<td>Creates a line break</td>
</tr>
<tr>
<td><code>&lt;sub&gt;</code></td>
<td>Begins subscript</td>
</tr>
<tr>
<td><code>&lt;/sub&gt;</code></td>
<td>Ends subscript</td>
</tr>
<tr>
<td><code>&lt;sup&gt;</code></td>
<td>Begins superscript</td>
</tr>
<tr>
<td><code>&lt;/sup&gt;</code></td>
<td>Ends superscript</td>
</tr>
<tr>
<td><code>&lt;u&gt;</code></td>
<td>Begins underline</td>
</tr>
<tr>
<td><code>&lt;/u&gt;</code></td>
<td>Ends underline</td>
</tr>
</tbody>
</table>

**Step 3**
If you want to preview your changed statement and formatting, click the **Preview** subtab.

**Step 4**
Click **Apply**.

**Step 5**
Return to your originating procedure (NTP).
NTP-G134 Modify OSI Provisioning

**Purpose**
This procedure modifies the ONS 15454 OSI parameters including the OSI routing mode, TARP, routers, subnets, and IP-over-Connectionless network service (CLNS) tunnels.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G132 Provision OSI, page 3-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Note**
Additional information about the ONS 15454 implementation of OSI is provided in the “Management Network Connectivity” chapter of the *Cisco ONS 15454 Reference Manual*.

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3**
Perform any of the following tasks as needed:
- DLP-G284 Modify the TARP Operating Parameters, page 10-10
- DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache, page 10-12
- DLP-G286 Remove a Static TID to NSAP Entry from the TARP Data Cache, page 10-12
- DLP-G287 Add a TARP Manual Adjacency Table Entry, page 10-13
- DLP-G292 Remove a TARP Manual Adjacency Table Entry, page 10-13
- DLP-G293 Change the OSI Routing Mode, page 10-14
- DLP-G294 Edit the OSI Router Configuration, page 10-15
- DLP-G295 Edit the OSI Subnetwork Point of Attachment, page 10-16
- DLP-G296 Edit an IP-Over-CLNS Tunnel, page 10-17
- DLP-G297 Delete an IP-Over-CLNS Tunnel, page 10-18

**Step 4**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.
DLP-G284 Modify the TARP Operating Parameters

### Purpose
This task modifies the TARP operating parameters including TARP protocol data unit (PDU) propagation, timers, and loop detection buffer (LDB).

### Tools/Equipment
None

### Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

### Required/As Needed
As needed

### Onsite/Remote
Onsite or remote

### Security Level
Superuser

#### Step 1
In node view, click the **Provisioning > OSI > TARP > Config** tabs.

#### Step 2
Provision the following parameters, as needed:

- **TARP PDUs L1 Propagation**—If checked (default), TARP Type 1 PDUs that are received by the node and are not excluded by the LDB are propagated to other NEs within the Level 1 OSI area. (Type 1 PDUs request a protocol address that matches a target identifier [TID] within a Level 1 routing area.) The propagation does not occur if the NE is the target of the Type 1 PDU, and PDUs are not propagated to the NE from which the PDU was received.

  __Note__ The TARP PDUs L1 Propagation parameter is not used when the Node Routing Area (Provisioning > OSI > Main Setup tab) is set to End System.

- **TARP PDUs L2 Propagation**—If checked (default), TARP Type 2 PDUs received by the node that are not excluded by the LDB are propagated to other NEs within the Level 2 OSI areas. (Type 2 PDUs request a protocol address that matches a TID within a Level 2 routing area.) The propagation occurs if the NE is not the target of the Type 2 PDU, and PDUs are not propagated to the NE from which the PDU was received.

  __Note__ The TARP PDUs L2 Propagation parameter is only used when the Node Routing Area is provisioned to Intermediate System Level 1/Level 2.

- **TARP PDUs Origination**—If checked (default), the node performs all TARP origination functions including:
  - TID to Network Service Access Point (NSAP) resolution requests (originate TARP Type 1 and Type 2 PDUs)
  - NSAP to TID requests (originate Type 5 PDUs)
  - TARP address changes (originate Type 4 PDUs)

  __Note__ TARP Echo and NSAP to TID are not supported.

- **TARP Data Cache**—If checked (default), the node maintains a TARP data cache (TDC). The TDC is a database of TID to NSAP pairs created from TARP Type 3 PDUs received by the node and modified by TARP Type 4 PDUs (TID to NSAP updates or corrections). TARP 3 PDUs are responses to Type 1 and Type 2 PDUs. The TDC can also be populated with static entries entered on the TARP > Static TDC tab.
Chapter 10  Manage the Node

DLP-G284 Modify the TARP Operating Parameters

Note
This parameter is only used when the TARP PDUs Origination parameter is enabled.

- L2 TARP Data Cache—If checked (default), the TIDs and NSAPs of NEs originating Type 2 requests are added to the TDC before the node propagates the requests to other NEs.

Note
The L2 TARP Data Cache parameter is designed for Intermediate System Level 1/Level 2 nodes that are connected to other Intermediate System Level 1/Level 2 nodes. Enabling the parameter for Intermediate System Level 1 nodes is not recommended.

- LDB—If checked (default), enables the TARP loop detection buffer. The LDB prevents TARP PDUs from being sent more than once on the same subnet.

Note
The LDB parameter is not used if the Node Routing Mode is provisioned to End System or if the TARP PDUs L1 Propagation parameter is not enabled.

- LAN TARP Storm Suppression—If checked (default), enables TARP storm suppression. This function prevents redundant TARP PDUs from being unnecessarily propagated across the LAN network.

- Send Type 4 PDU on Startup—If checked, a TARP Type 4 PDU is originated during the initial ONS 15454 startup. Type 4 PDUs indicate that a TID or NSAP change has occurred at the NE. (The default setting is not enabled.)

- Type 4 PDU Delay—Sets the amount of time that will pass before the Type 4 PDU is generated when Send Type 4 PDU on Startup is enabled. 60 seconds is the default. The range is 0 to 255 seconds.

Note
The Send Type 4 PDU on Startup and Type 4 PDU Delay parameters are not used if the TARP PDUs Origination parameter is not enabled.

- LDB Entry—Sets the TARP loop detection buffer timer. The LDB buffer time is assigned to each LDB entry for which the TARP sequence number (tar-seq) is zero. The default is 5 minutes. The range is 1 to 10 minutes.

- LDB Flush—Sets the frequency period for flushing the LDB. The default is 5 minutes. The range is 0 to 1440 minutes.

- T1—Sets the amount of time to wait for a response to a Type 1 PDU. Type 1 PDUs seek a specific NE TID within an OSI Level 1 area. The default is 15 seconds. The range is 0 to 3600 seconds.

- T2—Sets the amount of time to wait for a response to a Type 2 PDU. TARP Type 2 PDUs seek a specific NE TID value within OSI Level 1 and Level 2 areas. The default is 25 seconds. The range is 0 to 3600 seconds.

- T3—Sets the amount of time to wait for an address resolution request. The default is 40 seconds. The range is 0 to 3600 seconds.

- T4—Sets the amount of time to wait for an error recovery. This timer begins after the T2 timer expires without finding the requested NE TID. The default is 20 seconds. The range is 0 to 3600 seconds.

Note
The T1, T2, and T4 timers are not used if TARP PDUs Origination is not enabled.
DLP-G285 Add a Static TID to NSAP Entry to the TARP Data Cache

**Purpose**
This task adds a static TID to NSAP entry to the TDC. The static entries are required for NEs that do not support TARP and are similar to static routes. For a specific TID, you must force a specific NSAP.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioner or higher

**Step 1**
In node view, click the Provisioning > OSI > TARP > Static TDC tabs.

**Step 2**
Click Add Static Entry.

**Step 3**
In the Add Static Entry dialog box, enter the following:
- **TID**—Enter the TID of the NE. (For ONS nodes, the TID is the Node Name parameter on the node view Provisioning > General tab.)
- **NSAP**—Enter the OSI NSAP address in the NSAP field or, if preferred, click Use Mask and enter the address in the Masked NSAP Entry dialog box.

**Step 4**
Click OK to close the Masked NSAP Entry dialog box, if used, and then click OK to close the Add Static Entry dialog box.

**Step 5**
Return to your originating procedure (NTP).

DLP-G286 Remove a Static TID to NSAP Entry from the TARP Data Cache

**Purpose**
This task removes a static TID to NSAP entry from the TDC.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioner or higher

**Step 1**
In node view, click the Provisioning > OSI > TARP > Static TDC tabs.

**Step 2**
Click the static entry that you want to delete.

**Step 3**
Click Delete Static Entry.

**Step 4**
In the Delete TDC Entry dialog box, click Yes.
DLP-G287 Add a TARP Manual Adjacency Table Entry

**Purpose**
This task adds an entry to the TARP manual adjacency table (MAT). Entries are added to the MAT when the ONS 15454 must communicate across routers or non-SONET NEs that lack TARP capability.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In the node view, click the **Provisioning > OSI > TARP > MAT** tabs.

**Step 2**
Click **Add**.

**Step 3**
In the Add TARP Manual Adjacency Table Entry dialog box, enter the following:

- **Level**—Sets the TARP Type Code that will be sent:
  - **Level 1**—Indicates that the adjacency is within the same area as the current node. The entry generates Type 1 PDUs.
  - **Level 2**—Indicates that the adjacency is in a different area from the current node. The entry generates Type 2 PDUs.

- **NSAP**—Enter the OSI NSAP address in the NSAP field or, if preferred, click **Use Mask** and enter the address in the Masked NSAP Entry dialog box.

**Step 4**
Click **OK** to close the Masked NSAP Entry dialog box, if used, and then click **OK** to close the Add Static Entry dialog box.

**Step 5**
Return to your originating procedure (NTP).

---

DLP-G292 Remove a TARP Manual Adjacency Table Entry

**Purpose**
This task removes an entry from the TARP MAT.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

⚠️ **Caution**
If TARP manual adjacency is the only means of communication to a group of nodes, loss of visibility will occur when the adjacency table entry is removed.
DLP-G293 Change the OSI Routing Mode

**Purpose**
This task changes the OSI routing mode.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Caution**
Do not complete this procedure until you confirm the role of the node within the network. It will be either an ES, IS Level 1, or IS Level 1/Level 2. This decision must be carefully considered. For additional information about OSI provisioning, refer to Chapter 22, “Management Connectivity Reference.”

**Caution**
Link state PDU (LSP) buffers must be the same at all NEs within the network, or loss of visibility could occur. Do not modify the LSP buffers unless you are sure that all NEs within the OSI have the same buffer size.

**Caution**
LSP buffer sizes cannot be greater than the LAP-D MTU size within the OSI area.

---

**Step 1**
Verify the following:
- All L1/L2 virtual routers on the NE must reside in the same area. This means that all neighboring virtual routers must have at least one common area address.
- For OSI L1/L2 to ES routing mode changes, only one L1/L2 virtual router and no more than one subnet can be configured.
- For OSI L1 to ES routing mode changes, only one L1 virtual router and no more than one subnet can be configured.

**Step 2**
In node view, click the **Provisioning > OSI** tabs.

**Step 3**
Choose one of the following routing modes:
- **End System**—The ONS 15454 performs OSI IS functions. It communicates with IS and ES nodes that reside within its OSI area. It depends upon an IS L1/L2 node to communicate with IS and ES nodes that reside outside its OSI area.
Intermediate System Level 1/Level 2—The ONS 15454 performs IS functions. It communicates with IS and ES nodes that reside within its OSI area. It also communicates with IS L1/L2 nodes that reside in other OSI areas. Before choosing this option, verify the following:

- The node is connected to another IS Level 1/Level 2 node that resides in a different OSI area.
- The node is connected to all nodes within its area that are provisioned as IS L1/L2.

Note: Changing a routing mode should be carefully considered. Additional information about OSI ESs and ISs and the ES-IS and IS-IS protocols are provided in Chapter 22, “Management Connectivity Reference.”

Step 4 Although Cisco does not recommend changing the LSP buffer sizes, you can adjust the buffers in the following fields:

- L1 LSP Buffer Size—Adjusts the Level 1 link state PDU buffer size.
- L2 LSP Buffer Size—Adjusts the Level 2 link state PDU buffer size.

Step 5 Return to your originating procedure (NTP).

DLP-G294 Edit the OSI Router Configuration

Purpose

This task allows you to edit the OSI router configuration, including enabling and disabling OSI routers, editing the primary area address, and creating or editing additional area addresses.

Tools/Equipment

None

Prerequisite Procedures

DLP-G46 Log into CTC, page 2-25

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1 Click the Provisioning > OSI > Routers > Setup tabs.

Step 2 Choose the router you want provision and click Edit.

Step 3 In the OSI Router Editor dialog box:

a. Check or uncheck the Enabled box to enable or disable the router.

Note: Router 1 must be enabled before you can enable Routers 2 and 3.

b. For enabled routers, edit the primary area address, if needed. The address can be between 8 and 24 alphanumeric characters in length.

c. If you want to add or edit an area address to the primary area, enter the address at the bottom of the Multiple Area Addresses area. The area address can be 2 to 26 numeric characters (0–9) in length. Click Add.

d. Click OK.
Step 4  Return to your originating procedure (NTP).

DLP-G295 Edit the OSI Subnetwork Point of Attachment

**Purpose**
This task allows you to view and edit the OSI subnetwork point of attachment parameters. The parameters are initially provisioned when you create a Section data communications channel (SDCC), Line data communications channel (LDCC), generic communications channel (GCC), or optical service channel (OSC), or when you enable the LAN subnet.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In the node view, click the **Provisioning > OSI > Routers > Subnet** tabs.

**Step 2**
Choose the subnet you want to edit, then click **Edit**.

**Step 3**
In the Edit **subnet type** Subnet **slot/port** dialog box, edit the following fields:

- **ESH**—The End System Hello (ESH) PDU propagation frequency. An end system NE transmits ESHs to inform other ESs and ISs about the NSAPs it serves. The default is 10 seconds. The range is 10 to 1000 seconds.

- **ISH**—The Intermediate System Hello (ISH) PDU propagation frequency. An intermediate system NE sends ISHs to other ESs and ISs to inform them about the NEs it serves. The default is 10 seconds. The range is 10 to 1000 seconds.

- **IIH**—The Intermediate System to Intermediate System Hello (IIH) PDU propagation frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default is 3 seconds. The range is 1 to 600 seconds.

**Note**
The IS-IS Cost and DIS Priority parameters are provisioned when you create or enable a subnet. You cannot change the parameters after the subnet is created. To change the DIS Priority and IS-IS Cost parameters, delete the subnet and create a new one.

Click **OK**.

**Step 4**
Return to your originating procedure (NTP).
DLP-G296 Edit an IP-Over-CLNS Tunnel

Purpose
This task allows you to edit the parameters of an IP-over-CLNS tunnel.

Tools/Equipment
None

Prerequisite Procedures
DLP-G291 Create an IP-Over-CLNS Tunnel, page 3-34
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Changing the IP or NSAP addresses or an IP-over-CLNS tunnel can cause loss of NE visibility or NE isolation. Do not change network addresses until you verify the changes with your network administrator.

Step 1
Click the Provisioning > OSI > Tunnels tabs.

Step 2
Click Edit.

Step 3
In the Edit IP Over OSI Tunnel dialog box, complete the following fields:

- **Tunnel Type**—Edit the tunnel type:
  - Cisco—Creates the proprietary Cisco IP tunnel. Cisco IP tunnels add the CLNS header to the IP packets.
  - GRE—Creates a generic routing encapsulation (GRE) tunnel. GRE tunnels add the CLNS header and a GRE header to the IP packets.

The Cisco proprietary tunnel is slightly more efficient than the GRE tunnel because it does not add the GRE header to each IP packet. The two tunnel types are not compatible. Most Cisco routers support the Cisco IP tunnel, while only a few support both GRE and Cisco IP tunnels. You generally should create Cisco IP tunnels if you are tunneling between two Cisco routers or between a Cisco router and an ONS node.

Caution
Always verify that the IP-over-CLNS tunnel type you choose is supported by the equipment at the other end of the tunnel.

- **IP Address**—Enter the IP address of the IP-over-CLNS tunnel destination.
- **IP Mask**—Enter the IP address subnet mask of the IP-over-CLNS destination.
- **OSPF Metric**—Enter the Open Shortest Path First (OSPF) metric for sending packets across the IP-over-CLNS tunnel. The OSPF metric, or cost, is used by OSPF routers to calculate the shortest path. The default is 110. Normally, it is not changed unless you are creating multiple tunnel routes and want to prioritize routing by assigning different metrics.
- **NSAP Address**—Enter the destination NE or OSI router NSAP address.

Step 4
Click OK.

Step 5
Return to your originating procedure (NTP).
DLP-G297 Delete an IP-Over-CLNS Tunnel

Purpose: This task allows you to delete an IP-over-CLNS tunnel.
Tools/Equipment: None
Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Provisioning or higher

Caution: Deleting an IP-over-CLNS tunnel might cause the nodes to lose visibility or cause node isolation. If node isolation occurs, onsite provisioning might be required to regain connectivity. Always confirm tunnel deletions with your network administrator.

Step 1: Click the Provisioning > OSI > Tunnels tabs.
Step 2: Choose the IP-over-CLNS tunnel that you want to delete.
Step 3: Click Delete.
Step 4: Click OK.
Step 5: Return to your originating procedure (NTP).

NTP-G81 Change CTC Network Access

Purpose: This procedure changes or deletes network information, including IP settings, static routes, OSPF options, proxy tunnels, and firewall tunnels.
Tools/Equipment: None
Prerequisite Procedures: NTP-G26 Set Up CTC Network Access, page 3-11
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Provisioning or higher

Note: Additional ONS 15454 networking information, including IP addressing examples, static route scenarios, OSPF protocol, and Routing Information Protocol (RIP) options are provided in Chapter 22, “Management Connectivity Reference.”

Step 1: Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.
Step 2: Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.
Step 3: Perform any of the following tasks as needed:
- DLP-G162 Change IP Settings, page 10-19
- DLP-G265 Lock Node Security, page 10-20
DLP-G162 Change IP Settings

Purpose
This task changes the IP address, subnet mask, default router, Dynamic Host Configuration Protocol (DHCP) access, firewall Internet Inter-Object Request Broker Protocol (IIOP) listener port, LCD IP display, and proxy server settings.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
DLP-G56 Provision IP Settings, page 3-12

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Caution
Changing the node IP address, subnet mask, or IIOP listener port causes the TCC2s/TCC2Ps to reboot. If Ethernet circuits using Spanning Tree Protocol (STP) originate or terminate on E-Series Ethernet cards installed in the node, circuit traffic will be lost for several minutes while the spanning trees reconverge. Other circuits are not affected by TCC2/TCC2P reboots.

Step 4
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

---

DLP-G162 Change IP Settings

Step 1
In node view, click the Provisioning > Network > General tabs.

Step 2
Change any of the following, as required:

- IP Address
- Suppress CTC IP Display
- LCD IP Setting
- Default Router
- Forward DHCP Request To
- Net/Subnet Mask Length
- TCC CORBA (IIOP) Listener Port
- Gateway Settings
DLP-G265 Lock Node Security

**Purpose**

This task locks the ONS 15454 security mode. When security mode is locked, two IP addresses must always be provisioned for the node, one for the TCC2P LAN (TCP/IP) port, and one for the backplane LAN port.

**Tools/Equipment**

TCC2P cards must be installed.

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

DLP-G264 Enable Node Security Mode, page 3-17

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Superuser

---

**Caution**

This task is irreversible. Do not proceed unless you want the node to permanently have two IP addresses.

**Note**

The options in this task are available only when using TCC2P cards.

---

**Step 1**

In node view, click the Provisioning > Security > Data Comm tabs.

**Step 2**

Click Lock.

**Step 3**

In the Confirm Lock Secure Mode dialog box, click Yes.

**Step 4**

Return to your originating procedure (NTP).
DLP-G266 Modify Backplane Port IP Settings

Purpose
This task modifies the ONS 15454 backplane IP address, subnet mask, and default router. It also modifies settings that control backplane IP address visibility in CTC and the ONS 15454 LCD. To perform this task, secure mode must be enabled.

Tools/Equipment
TCC2P cards must be installed.

Prerequisite Procedures
NTP-G103 Back Up the Database, page 13-2
DLP-G46 Log into CTC, page 2-25
DLP-G264 Enable Node Security Mode, page 3-17

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Caution
Provisioning an IP address that is incompatible with the ONS 15454 network might be service affecting.

Note
The options in this task are available only when using the TCC2P cards.

Step 1
Click the Provisioning > Security > Data Comm tabs.

Step 2
Modify the following fields, as necessary:

- IP Address
- Subnet Mask
- Default Router
- LCD IP Setting—choose one of the following:
  - Allow Configuration—Displays the backplane IP address on the LCD and allows it to be changed using the LCD buttons.
  - Display only—Displays the backplane IP address on the LCD but does not allow it to be changed using the LCD buttons.
  - Suppress Display—Suppresses the display of the IP address on the LCD.
- Suppress CTC IP Address—if checked, suppresses the IP address from display on the Data Comm subtab, CTC node view information area, and other locations.

Step 3
Click Apply.
If you changed the IP address, subnet mask, or default router, the node will reboot. This will take 5 to 10 minutes.

Step 4
Return to your originating procedure (NTP).
DLP-G267 Disable Node Security Mode

Purpose
This task disables the ONS 15454 security mode and allows only one IP address to be provisioned for the backplane LAN port and the TCC2P LAN port.

Tools/Equipment
TCC2P cards must be installed.

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
DLP-G264 Enable Node Security Mode, page 3-17

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Note
The node will reboot after you complete this task, causing a temporary disconnection between the CTC computer and the node.

Note
The options in this task are available only when using TCC2P cards.

Step 1
Click the **Provisioning > Security > Data Comm** tabs.

Step 2
Click **Change Mode**.

Step 3
Review the information on the Change Secure Mode wizard page, then click **Next**.

Step 4
On the Node IP Address page, choose the address you want to assign to the node:

- **Backplane Ethernet Port**—Assigns the backplane IP address as the node IP address.
- **TCC Ethernet Port**—Assigns the TCC2P port IP address as the node IP address.
- **New IP Address**—Allows you to define a new IP address. If you choose this option, enter the new IP address, subnet mask, and default router IP address.

Step 5
Click **Next**.

Step 6
On the SOCKS Proxy Server Settings page, choose one of the following:

- **External Network Element (ENE)**—If selected, the CTC computer is only visible to the ONS 15454 to which the CTC computer is connected. The computer is not visible to the data communications channel (DCC)-connected nodes. In addition, firewall is enabled, which means that the node prevents IP traffic from being routed between the DCC and the LAN port.
- **Gateway Network Element (GNE)**—If selected, the CTC computer is visible to other DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the LAN port.
- **Proxy-only**—If selected, the ONS 15454 responds to CTC requests with a list of DCC-connected nodes for which the node serves as a proxy. The CTC computer is visible to other DCC-connected nodes. The node does not prevent traffic from being routed between the DCC and LAN port.

Step 7
Click **Finish**.

Within the next 30 to 40 seconds, the TCC2Ps reboot. CTC switches to network view, and the CTC Alerts dialog box appears. In network view, the node changes to grey and a DISCONNECTED condition appears.
Step 8  In the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This might take several minutes.)

Step 9  Return to your originating procedure (NTP).

DLP-G163 Modify a Static Route

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task modifies a static route on an ONS 15454.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td></td>
<td>DLP-G58 Create a Static Route, page 3-18</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Provisioning or higher</td>
</tr>
</tbody>
</table>

Step 1  In node view, click the Provisioning > Network tabs.

Step 2  Click the Static Routing tab.

Step 3  Click the static route you want to edit.

Step 4  Click Edit.

Step 5  In the Edit Selected Static Route dialog box, enter the following:

- Mask
- Next Hop
- Cost

See the “DLP-G58 Create a Static Route” task on page 3-18 for detailed field descriptions.

Step 6  Click OK.

Step 7  Return to your originating procedure (NTP).
DLP-G164 Delete a Static Route

Purpose
This task deletes an existing static route on an ONS 15454.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
DLP-G58 Create a Static Route, page 3-18

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, click the Provisioning > Network > Static Routing tabs.

Step 2
Click the static route that you want to delete.

Step 3
Click Delete. A confirmation dialog box appears.

Step 4
Click Yes.

Step 5
Return to your originating procedure (NTP).

DLP-G165 Disable OSPF

Purpose
This task disables the OSPF routing protocol process for an ONS 15454 LAN.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
DLP-G59 Set Up or Change Open Shortest Path First Protocol, page 3-19

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, click the Provisioning > Network > OSPF tabs. The OSPF subtab has several options.

Step 2
In the OSPF on LAN area, uncheck the OSPF active on LAN check box.

Step 3
Click Apply. Confirm that the changes appear.

Step 4
Return to your originating procedure (NTP).
DLP-G166 Delete a Proxy Tunnel

Purpose  This task removes a proxy tunnel.
Tools/Equipment  None
Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Superuser

Step 1  Click the Provisioning > Network > Proxy subtabs.
Step 2  Click the proxy tunnel that you want to delete.
Step 3  Click Delete.
Step 4  Continue with your originating procedure (NTP).

DLP-G167 Delete a Firewall Tunnel

Purpose  This task removes a firewall tunnel.
Tools/Equipment  None
Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Superuser

Step 1  Click the Provisioning > Network > Firewall subtabs.
Step 2  Click the firewall tunnel that you want to delete.
Step 3  Click Delete.
Step 4  Return to your originating procedure (NTP).
NTP-G82 Customize the CTC Network View

Purpose
This procedure modifies the CTC network view, including grouping nodes into domains for a less-cluttered display, changing the network view background color, and using a custom image for the network view background.

Tools/Equipment None
Prerequisite Procedures None
Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher

---

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
Complete the following tasks, as needed:
- DLP-G168 Change the Network View Background Color, page 10-26
- DLP-G169 Change the Default Network View Background Map, page 10-27
- DLP-G170 Apply a Custom Network View Background Map, page 10-28
- DLP-G171 Create Domain Icons, page 10-28
- DLP-G172 Manage Domain Icons, page 10-29
- DLP-G173 Enable Dialog Box Do-Not-Display Option, page 10-30
- DLP-G174 Switch Between TDM and DWDM Network Views, page 10-31

Stop. You have completed this procedure.

---

DLP-G168 Change the Network View Background Color

Purpose
This task changes the network view background color or the domain view background color (the area displayed when you open a domain).

Tools/Equipment None
Prerequisite Procedures DLP-G46 Log into CTC, page 2-25
Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher

Note
If you modify background colors, the change is stored in your CTC user profile on the computer. The change does not affect other CTC users.

---

Step 1
From the View menu in CTC, choose Go to Network View.

Step 2
If you want to change a domain background, double-click the domain. If not, continue with Step 3.
Step 3 Right-click the network view or domain map area and choose Set Background Color from the shortcut menu.

Step 4 In the Choose Color dialog box, select a background color.

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

---

DLP-G169 Change the Default Network View Background Map

**Purpose**
This task changes the default map of the CTC network view.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

- **Note**
If you modify the background image, the change is stored in your CTC user profile on the computer. The change does not affect other CTC users.

---

Step 1 From the Edit menu, choose Preferences > Map and check the Use Default Map check box.

Step 2 Click Apply.

Step 3 Click OK. Verify that the United States map is displayed.

Step 4 In network view, double-click any node on the map.

Step 5 In node view, click the Provisioning > Defaults tabs.

Step 6 In the Defaults Selector area, choose CTC and then network. (You might have to scroll down on the list to find “network.”)

Step 7 Click the Default Value field and choose a default map from the drop-down list. Map choices are Germany, Japan, Netherlands, South Korea, United Kingdom, and the United States.

Step 8 Click Apply.

Step 9 Click OK.

Step 10 From the View menu, select Go to Network View. Confirm that the new map is displayed.

Step 11 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat until all the ONS 15454 icons are visible. (You can also choose Fit Graph to Window.)

Step 12 If you need to reposition the node icons, hold down the Ctrl key while you drag and drop them one at a time to a new location on the map.

Step 13 If you want to change the magnification of the icons, right-click the network view and choose Zoom In. Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 14 Return to your originating procedure (NTP).
DLP-G170 Apply a Custom Network View Background Map

**Purpose**
This task changes the background image or map of the CTC network view.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Note**
You can replace the network view background image with any JPEG or GIF image that is accessible on a local or network drive. If you apply a custom background image, the change is stored in your CTC user profile on the computer. The change does not affect other CTC users.

---

**Step 1**
From the Edit menu, choose **Preferences > Map** and uncheck the **Use Default Map** check box.

**Step 2**
From the View menu, choose **Go to Network View**.

**Step 3**
Right-click the network or domain map and choose **Set Background Image**.

**Step 4**
Click **Browse**. Navigate to the graphic file you want to use as a background.

**Step 5**
Select the file. Click **Open**.

**Step 6**
Click **Apply** and then click **OK**.

**Step 7**
If the ONS 15454 icons are not visible, right-click the network view and choose **Zoom Out**. Repeat this step until all the ONS 15454 icons are visible.

**Step 8**
If you need to reposition the node icons, hold down the Ctrl key while you drag and drop them one at a time to a new location on the map.

**Step 9**
If you want to change the magnification of the icons, right-click the network view and choose **Zoom In**. Repeat until the ONS 15454 icons are displayed at the magnification you want.

**Step 10**
Return to your originating procedure (NTP).

---

DLP-G171 Create Domain Icons

**Purpose**
This task creates a domain, which is an icon that groups ONS 15454 icons in CTC network view.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Note**
Domains created by one user are visible to all users who log into the network.
Step 1  From the View menu, choose **Go to Network View**.

Step 2  Right-click the network map and choose **Create New Domain** from the shortcut menu.

Step 3  When the domain icon appears on the map, click the map name and type the domain name.

Step 4  Press **Enter**.

Step 5  Return to your originating procedure (NTP).

---

**DLP-G172 Manage Domain Icons**

**Purpose**  This task manages CTC network view domain icons.

**Tools/Equipment**  None

**Prerequisite Procedures**  
- DLP-G46 Log into CTC, page 2-25
- DLP-G171 Create Domain Icons, page 10-28

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Provisioning or higher

**Note**  All domain changes, such as added or removed nodes, are visible to all users who log into the network.

---

**Step 1**  From the View menu, choose **Go to Network View**.

**Step 2**  Locate the domain action that you want to perform in **Table 10-2** and complete the appropriate steps.

**Table 10-2  Managing Domains**

<table>
<thead>
<tr>
<th>Domain Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a domain</td>
<td>Press Ctrl and drag and drop the domain icon to the new location.</td>
</tr>
<tr>
<td>Rename a domain</td>
<td>Right-click the domain icon and choose <strong>Rename Domain</strong> from the shortcut menu. Type the new name in the domain name field.</td>
</tr>
<tr>
<td>Add a node to a domain</td>
<td>Drag and drop the node icon to the domain icon.</td>
</tr>
<tr>
<td>Move a node from a domain to the network map</td>
<td>Open the domain and right-click a node. Choose <strong>Move Node Back to Parent View</strong>.</td>
</tr>
</tbody>
</table>
| Open a domain | Complete one of the following:  
  - Double-click the domain icon.  
  - Right-click the domain and choose **Open Domain**. |
| Return to network view | Right-click the domain view area and choose **Go to Parent View** from the shortcut menu. |
DLP-G173 Enable Dialog Box Do-Not-Display Option

### Purpose
This task ensures that a user-selected do-not-display dialog box preference is enabled for subsequent sessions or to disable the do-not-display option.

### Tools/Equipment
None

### Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

### Required/As Needed
As needed

### Onsite/Remote
Onsite or remote

### Security Level
Provisioning or higher

---

**Note**
If any user who has rights to perform an operation (for example, creating a circuit) selects the “Do not show this message again” check box in a dialog box, the dialog box is not displayed for any other users who perform that operation on the network from the same computer unless the command is overridden using the following task. (The preference is stored on the computer, not in the node database.)

---

**Step 1**
From the Edit menu, choose Preferences.

**Step 2**
In the Preferences dialog box, click the General tab.
The Preferences Management area field lists all dialog boxes where “Do not show this message again” is enabled.

**Step 3**
Choose one of the following options, or uncheck the individual dialog boxes that you want to appear:
- **Don’t Show Any**—Hides all do-not-display check boxes.
- **Show All**—Overrides do-not-display check box selections and displays all dialog boxes.

**Step 4**
Click OK.

**Step 5**
Return to your originating procedure (NTP).
DLP-G174 Switch Between TDM and DWDM Network Views

**Purpose**
Use this task to switch between time division multiplexing (TDM) and DWDM network views.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Retrieve or higher

---

**Step 1**
From the View menu, choose **Go to Network View**.

**Step 2**
From the Network Scope drop-down list on the toolbar, choose one of the following:
- **All**—Displays both TDM and DWDM nodes.
- **TDM**—Displays only ONS 15454s with SONET or SDH cards including the transponder and muxponder cards.
- **DWDM**—Displays only ONS 15454s with DWDM cards, including the transponder and muxponder cards.

**Step 3**
Return to your originating procedure (NTP).

---

NTP-G83 Modify or Delete Card Protection Settings

**Purpose**
This procedure modifies and deletes card protection settings.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G33 Create a Y-Cable Protection Group, page 5-10

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

⚠️ **Caution**
Modifying and deleting protection groups can be service affecting.

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

**Step 2**
Perform any of the following tasks as needed:
- DLP-G175 Modify a Y-Cable Protection Group, page 10-32
- DLP-G176 Modify a Splitter Protection Group, page 10-33
- DLP-G177 Delete a Y-Cable Protection Group, page 10-33

**Step 3**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.
Stop. You have completed this procedure.

DLP-G175 Modify a Y-Cable Protection Group

Purpose
This task modifies a Y-cable protection group for any client port on a MXP_2.5G_10G, TXP_MR_2.5G, or TXP_MR_10G card.

Tools/Equipment
None

Prerequisite Procedures
NTP-G33 Create a Y-Cable Protection Group, page 5-10
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, click the Provisioning > Protection tabs.

Step 2
In the Protection Groups area, click the Y-cable protection group that you want to modify.

Step 3
Click Edit.

Step 4
In the Selected Group area, you can modify the following, as needed:

• Name—Type the changes to the protection group name. The name can have up to 32 alphanumeric characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you do not want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert when conditions causing the switch are cleared.

Step 5
Click OK. Confirm that the changes appear.

Step 6
Return to your originating procedure (NTP).
DLP-G176 Modify a Splitter Protection Group

**Purpose**
This task modifies a splitter protection group for any client port on a TXPP_MR_2.5G or MXPP_MR_2.5G card. Splitter protection is automatically created when the TXPP or MXPP card is installed.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, click the **Provisioning > Protection** tabs.

**Step 2**
In the Protection Groups area, click the splitter protection group that you want to modify.

**Step 3**
Click **Edit**.

**Step 4**
In the Selected Group area, you can modify the following, as needed:

- **Name**—Type the changes to the protection group name. The name can have up to 32 alphanumeric characters.

- **Revertive**—Check this box if you want traffic to revert to the working card after failure conditions stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you do not want traffic to revert.

- **Reversion time**—If the Revertive check box is selected, choose the reversion time from the Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert when conditions causing the switch are cleared.

**Step 5**
Click **OK**. Confirm that the changes appear.

**Step 6**
Return to your originating procedure (NTP).

---

DLP-G177 Delete a Y-Cable Protection Group

**Purpose**
This task deletes a Y-cable protection group.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, click the **Provisioning > Protection** tabs.

**Step 2**
In the Protection Groups area, click the protection group you want to delete.

**Step 3**
Click **Delete**.
Step 4  Click Yes in the Delete Protection Group dialog box. Confirm that the changes appear.

Step 5  Return to your originating procedure (NTP).

---

NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands

**Purpose**
This procedure describes how to apply and remove Manual and Force protection switches on Y-cable and splitter protection groups. It also describes how to apply and remove a Lock On or Lock Out protection command to a Y-cable protection group.

**Tools/Equipment**
None

**Prerequisite Procedures**
- NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
- NTP-G33 Create a Y-Cable Protection Group, page 5-10

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Superuser

---

**Note**
Splitter protection groups are automatically created when you install a TXPP_MR_2.5G or MXPP_MR_2.5G card.

---

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2  To perform a Manual protection switch, complete the “DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch” task on page 10-35.

Step 3  To perform a Force protection switch, complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35.

Step 4  To clear a Force or Manual protection switch, complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36.

Step 5  To prevent traffic on a working or protect card from switching to the other card in the pair, complete the “DLP-G181 Apply a Lock-On” task on page 10-37.

Step 6  To prevent traffic from switching to the protect card, complete the “DLP-G182 Apply a Lockout” task on page 10-37.

Step 7  To remove a lock-on or lockout and return a protection group to its usual switching method, complete the “DLP-G183 Clear a Lock-On or Lockout” task on page 10-38.

Stop. You have completed this procedure.
DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch

**Purpose**
This task performs a Manual protection switch on a Y-cable or splitter protection group.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Caution**
A Manual switch will move traffic from the active to the standby card only if network conditions permit it. If conditions change during the switch, CTC will attempt to place traffic back on the original active card.

**Step 1**
In node view, click the Maintenance > Protection tabs.

**Step 2**
In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the Manual protection switch.

**Step 3**
In the Selected Group area, click the active card or port.

**Step 4**
In the Switch Commands drop-down list, click Manual.

**Step 5**
In the Confirm Manual Operation dialog box, click Yes.

If conditions permit, the Manual switch will be applied. To clear the Manual switch, see the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36.

**Step 6**
Return to your originating procedure (NTP).

---

DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch

**Purpose**
This task performs a Force protection switch on a Y-cable or splitter protection group.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Caution**
A Force switch will move traffic from the active to the standby card or port immediately, regardless of network conditions. The switch will remain in effect until it is cleared.

**Step 1**
In node view, click the Maintenance > Protection tabs.

**Step 2**
In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the Force protection switch.
Step 3 In the Selected Group area, click the active card or port.

Step 4 In the Switch Commands drop-down list, click **Force**.

Step 5 In the Confirm Manual Operation dialog box, click **Yes**.

The Force switch will be applied. To clear the Force switch, see the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36.

Step 6 Return to your originating procedure (NTP).

DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task clears a Manual or Force protection switch on a Y-Cable or splitter protection group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td></td>
</tr>
</tbody>
</table>
  DLP-G46 Log into CTC, page 2-25  
  DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch, page 10-35 or  
  DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch, page 10-35 |
| Required/As Needed | As needed                                                                                       |
| Onsite/Remote      | Both                                                                                           |
| Security Level     | Maintenance or higher                                                                          |

Step 1 In node view, click the **Maintenance > Protection** tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group area, click the card that you want to clear.

Step 4 In the Switch Commands drop-down list, click **Clear**.

Step 5 Click **Yes** in the confirmation dialog box.

The Manual or Force protection switch is cleared.

Step 6 Return to your originating procedure (NTP).
DLP-G181 Apply a Lock-On

**Purpose**
This task prevents traffic from being switched from the working/active card in a Y-cable protection group or port in a splitter protection group.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Note**
You can apply the Lock On command only to the working/active card or port. If the working card or port is standby (traffic is switched), the Lock Out button is not available.

---

**Step 1**
In node view, click the **Maintenance > Protection** tabs.

**Step 2**
In the Protection Groups area, click the protection group that contains the card (Y-cable) or port (splitter) that you want to lock on.

**Step 3**
In the Selected Group area, click the working/active card.

**Step 4**
In the Inhibit Switching drop-down list, click **Lock On**.

**Step 5**
Click **Yes** in the confirmation dialog box.

The lock-on has been applied. Traffic cannot switch to the protect card. To clear the lock-on, see the “DLP-G183 Clear a Lock-On or Lockout” task on page 10-38.

---

**Note**
Provisioning a lock-on raises a LOCKON-REQ or an FE-LOCKON condition in CTC. Clearing the lock on switch request clears these conditions.

---

**Step 6**
Return to your originating procedure (NTP).

---

DLP-G182 Apply a Lockout

**Purpose**
This task keeps traffic from switching to the protect/standby card or port. The Lock Out command overrides the Force and Manual switching commands.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Note**
You can apply the lockout to the protect/standby card or port. If the protect card or port is active (traffic is switched), the lockout task cannot be performed.
Step 1
In node view, click the **Maintenance > Protection** tabs.

Step 2
In the Protection Groups area, click the protection group that contains the card (Y-cable) or port (splitter) that you want to lock out.

Step 3
In the Selected Group area, click the protect/standby card.

Step 4
In the Inhibit Switching drop-down list, click **Lock Out**.

Step 5
Click **Yes** in the confirmation dialog box.

The lockout has been applied. Traffic cannot switch to the protect card. To clear the lockout, see the “DLP-G183 Clear a Lock-On or Lockout” task on page 10-38.

**Note**
Provisioning a lockout raises a LOCKOUT-REQ or an FE-LOCKOUT condition in CTC. Clearing the lockout switch request clears these conditions.

Step 6
Return to your originating procedure (NTP).

---

**DLP-G183 Clear a Lock-On or Lockout**

**Purpose**
This task clears a lock-on or lockout.

**Tools/Equipment**
None

**Prerequisite Procedures**
- DLP-G46 Log into CTC, page 2-25
- DLP-G181 Apply a Lock-On, page 10-37 or DLP-G182 Apply a Lockout, page 10-37

**Required/As Needed**
As needed

**Onsite/Remote**
Both

**Security Level**
Maintenance or higher

Step 1
In node view, click the **Maintenance > Protection** tabs.

Step 2
In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3
In the Selected Group area, click the card you want to clear.

Step 4
In the Inhibit Switching drop-down list, click **Unlock**.

Step 5
Click **Yes** in the confirmation dialog box.

The lock-on or lockout is cleared.

Step 6
Return to your originating procedure (NTP).
NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords

Purpose
This procedure modifies GCC terminations, and deletes provisionable patchcords, OSC terminations, and GCC terminations.

Tools/Equipment
None

Prerequisite Procedures
DLP-G76 Provision GCC Terminations, page 7-14 or
NTP-G38 Provision OSC Terminations, page 3-84
DLP-G99 Create a Provisionable Patchcord, page 6-11

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Deleting an OSC termination can cause you to lose visibility of nodes that do not have other OSCs or network connections to the CTC computer.

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
In node view, complete the following tasks as needed:

- To modify a GCC termination, complete the “DLP-G184 Change a GCC Termination” task on page 10-40.
- To delete a GCC termination, complete the “DLP-G185 Delete a GCC Termination” task on page 10-40.
- To delete an OSC termination, complete the “DLP-G186 Delete an OSC Termination” task on page 10-41.
- To delete a provisionable patchcord, complete the “DLP-G187 Delete a Provisionable Patchcord” task on page 10-42.

Stop. You have completed this procedure.
DLP-G184 Change a GCC Termination

Purpose
This task modifies a GCC termination. You can enable or disable OSPF and enable or disable the foreign node setting.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Remote

Security Level
Provisioning or higher

Step 1
Click the Provisioning > Comm Channels > GCC tabs.

Step 2
Click the GCC that you want to change.

Step 3
Click Edit.

Step 4
In the GCC Termination Editor dialog box, complete the following as necessary:

- GCC Rate—(Display only) Indicates the GCC rate.
- Disable OSPF on SDCC Link—If checked, Open Shortest Path First is disabled on the link. OSPF should be disabled only when the slot and port connect to third-party equipment that does not support OSPF.
- Far End is Foreign—Check this box to specify that the GCC termination is a non-ONS node.
- Far end IP—If you checked the Far End is Foreign check box, type the IP address of the far-end node or leave the 0.0.0.0 default. An IP address of 0.0.0.0 means that any address can be used by the far end.

Step 5
Click OK.

Step 6
Return to your origination procedure (NTP).

DLP-G185 Delete a GCC Termination

Purpose
This task deletes the DWDM GCC terminations required for network setup when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10G cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Note
Deleting the GCC termination on a port also deletes any provisionable patchcord links that might exist on the port.

Step 1
Click the Provisioning > Comm Channels > GCC tabs.
Step 2  Click the GCC that you want to delete.
Step 3  Click Delete.
Step 4  In the Delete GCC Terminations dialog box, check the Set port OOS check box if you want to place ports out of service.
Step 5  Click Yes. GCC-EOC alarms appear until all network GCC terminations are deleted and the ports are out of service.
Step 6  Return to your originating procedure (NTP).

**DLP-G186 Delete an OSC Termination**

**Purpose**
This task deletes an OSC termination on the ONS 15454.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Caution**
Deleting a OSC termination might cause node isolation and loss of visibility to nodes that do not have other OSCs or network connections to the CTC computer.

Step 1  Click the Provisioning > Comm Channel > OSC tab.
Step 2  If a Ring ID is created, complete the following steps. Otherwise, continue with Step 3.
   a. Select the DWDM Ring ID that you want to delete and click Delete.
   b. In the Delete DWDM Ring ID confirmation box, click Yes. Confirm that the changes appear.
Step 3  Click the OSC termination that you want to delete and click Delete.
Step 4  In the Delete OSC Termination confirmation box, click Yes. Confirm that the changes appear.
Until all network OSC terminations are deleted, loss of signal (LOS) or power failure alarms on the OPT-BST amplifier, OSCM card, and OSC-CSM card might appear.
Step 5  Return to your originating procedure (NTP).
DLP-G187 Delete a Provisionable Patchcord

Purpose  This task deletes a provisionable patchcord.
Tools/Equipment  None
Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25
DLP-G99 Create a Provisionable Patchcord, page 6-11
Required/As Needed  As needed
Onsite/Remote  Onsite or remote
Security Level  Provisioning and higher

Step 1  In node view, click the Provisioning > Comm Channels > PPC tabs. If you are in network view, click Provisioning > Provisionable Patchcords tabs.
Step 2  Click the provisionable patchcord that you want to delete.
Step 3  Click Delete.
Step 4  In the confirmation dialog box, click Yes.
Step 5  Return to your originating procedure (NTP).

NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection

Purpose  This procedure converts a pass-through connection into add/drop connections (one on the add side and the other on the drop side). Use this procedure during a network upgrade. Pass-through channel connections can be provided between channel input and output ports for the AD-xC-xx.x, 4MD-xx.x, 32MUX-O, 32DMX-O, and 32DMX cards. You can set up pass-through connections in nodes that might require more add or drop channel capability or configuration.
Tools/Equipment  None
Prerequisite Procedures  None
Required/As Needed  As needed
Onsite/Remote  Onsite
Security Level  Provisioning or higher

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network.
Step 2  In node view, click the Circuits tab. Delete the unidirectional or bidirectional pass-through optical channel network connection (OCHNC) that applies to the pass-through connection to be removed.
Step 3  Remove the physical pass-through cabling. Click the Provisioning > WDM-ANS > Connections tabs to identify the card ports to be removed. The pass-through connection that you are removing can be connected in both OADM and hub nodes.
  • For a hub node—Connect the 32DMX-O or 32DMX output port to the 32MUX-O input port.
For an OADM node—Connect the AD-xC-xx.x drop (TX) port to the AD-xC-xx.x add (RX) port.

**Step 4** Physically connect the proper client interface to the correct add and drop ports.

**Step 5** Delete the filter connections related to the pass-through connection that is being converted to an add/drop connection:

- a. In node view, click the **Provisioning > WDM-ANS > Port Status** tabs.
- b. Highlight the pass-through connections between ITU channel add and drop port filters.
- c. Click **Delete**.

**Step 6** Create two new unidirectional OCHNCs (one heading east, the other heading west) to support the new add/drop channels. See the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10.

**Step 7** As necessary, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 6-11.

**Step 8** As necessary, add an optical attenuator between the channel TX port of the OADM, 4MD-xx.x, 32DMX-O, or 32DMX card and the DWDM RX port on the TXP, MXP, or ITU-T line card.

---

**Note** If the channel is coming from a 32DMX-O, the optical power can be adjusted in CTC by modifying the value of the internal per-channel variable optical attenuator (VOA).

**Step 9** (Optional) The following verification steps might be needed for an intermediate node when a pass-through connection is converted:

- a. Verify that the received channels are at the specified power level. See the “NTP-G76 Verify Optical Span Loss Using CTC” procedure on page 10-2 for instructions.
- b. Verify that the added channels are equalized with the express channels within +/-1 dB.
- c. If the channels are not equalized with the express channels within +/-1 dB, check the attenuation of the VOAs.
- d. Check all the fiber adapters to minimize their insertion losses. See the “NTP-G115 Clean Fiber Connectors” procedure on page 13-25 for instructions.

**Stop. You have completed this procedure.**
NTP-G87 Change Node Timing Parameters

Purpose
This procedure changes the timing parameters for the ONS 15454. To switch the timing reference, see the “NTP-G112 Change the Node Timing Reference” procedure on page 13-17.

Tools/Equipment
None

Prerequisite Procedures
NTP-G53 Set Up Timing, page 6-4

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
The following procedure might be service affecting and should be performed during a scheduled maintenance window.

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Step 3
Click the Provisioning > Timing > General tabs.

Step 4
In the General Timing section, change any of the following information:
- Timing Mode
  
  **Note** Because mixed timing can cause timing loops, Cisco does not recommend using the Mixed Timing option. Use this mode with care.
  
  - SSM Message Set
  - Quality of RES
  - Revertive
  - Revertive Time

  See the “NTP-G53 Set Up Timing” task on page 6-4 for field descriptions.

Step 5
In the Reference Lists area, you can change the following information:

**Note** Reference lists define up to three timing references for the node and up to six BITS Out references. BITS Out references define the timing references used by equipment that can be attached to the node’s BITS Out pins on the backplane. If you attach equipment to BITS Out pins, you normally attach it to a node with Line mode because equipment near the external timing reference can be directly wired to the reference.

- NE Reference
- BITS 1 Out
- BITS 2 Out
Step 6  In the BITS In section, you can change the following information:

Note

The BITS Facilities section sets the parameters for your BITS1 and BITS2 timing references. Many of these settings are determined by the timing source manufacturer. If equipment is timed through BITS Out, you can set timing parameters to meet the requirements of the equipment.

- BITS In State
- Coding
- State
- Framing
- Sync Messaging
- Admin SSM

Step 7  In the BITS In section, you can change the following information:

- BITS Out State
- Coding
- Framing
- AIS Threshold
- LBO

Step 8  Click Apply. Confirm that the changes appear.

Caution

Internal timing is Stratum 3 and is not intended for permanent use. All ONS 15454s should be timed to a Stratum 2 or better primary reference source.

Step 9  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

NTP-G88 Modify Users and Change Security

Purpose  This procedure modifies user and security properties for the ONS 15454.

Tools/Equipment  None

Prerequisite Procedures  NTP-G23 Create Users and Assign Security, page 3-5

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Superuser

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.
Step 3 Perform any of the following tasks as needed:

- DLP-G188 Change Security Policy for a Single Node, page 10-46
- DLP-G189 Change Security Policy for Multiple Nodes, page 10-47
- DLP-G317 Change Node Access and PM Clearing Privilege, page 10-49
- DLP-G191 Change User Password and Security Level on a Single Node, page 10-50
- DLP-G192 Change User Password and Security Level for Multiple Nodes, page 10-51
- DLP-G193 Delete a User From a Single Node, page 10-52
- DLP-G194 Delete a User From Multiple Nodes, page 10-52
- DLP-G196 Log Out a User on Multiple Nodes, page 10-54
- DLP-G281 Configure the Node for RADIUS Authentication, page 10-55
- DLP-G282 View and Terminate Active Logins, page 10-57

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

---

DLP-G188 Change Security Policy for a Single Node

**Purpose**
This task changes the security policy for a single node, including idle user timeouts, user lockouts, password changes, and concurrent login policies.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Step 1**
In node view, click the **Provisioning > Security > Policy** tabs.

**Step 2**
If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle User Timeout area for the security level that you want to provision: RETRIEVE, MAINTENANCE, PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. The user is logged out after the idle user timeout period is reached.

**Step 3**
In the User Lockout area, you can modify the following:

- **Failed Logins Before Lockout**—The number of failed login attempts a user can make before the user is locked out from the node. You can choose a value between 0 and 10.
- **Manual Unlock by Superuser**—Allows a user with Superuser privileges to manually unlock a user who has been locked out from a node.
- **Lockout Duration**—Sets the amount of time the user will be locked out after a failed login. You can choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

**Note**
Manual Unlock by Superuser and Lockout Duration are mutually exclusive.
Step 4  In the Password Change area, you can modify the following:

- Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different passwords that the user must create before they can reuse a password.
- New Password must Differ from the Old Password—Choose the number of characters that must differ between the old and new password. The default number is 1. The range is 1 to 5.
- Cannot Change New Password for [ ] days—If checked, prevents users from changing their password for the specified period. The range is 20 to 95 days.
- Require Password Change on First Login to New Account—If checked, requires users to change their password the first time they log into their account.

Step 5  To require users to change their password at periodic intervals, check the Enforce Password Aging check box in the Password Aging area. If checked, provision the following parameters:

- Aging Period—Sets the amount of time that must pass before the user must change his or her password for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and SUPERUSER. The range is 20 to 95 days.
- Warning Period—Sets the number of days the user will be warned to change his or her password for each security level. The range is 2 to 20 days.

Step 6  In the Other area, you can provision the following:

- Single Session Per User—If checked, limits users to one login session at one time.
- Disable Inactive User—If checked, disables users who do not log into the node for the period of time specified in the Inactive Duration box. The Inactive Duration range is 1 to 99 days.

Step 7  Click Apply. Confirm that the changes appear.

Step 8  Return to your originating procedure (NTP).

DLP-G189 Change Security Policy for Multiple Nodes

**Purpose**  This task changes the security policy for multiple nodes including idle user timeouts, user lockouts, password change, and concurrent login policies.

**Tools/Equipment**  None

**Prerequisite Procedures**  DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Superuser

Step 1  From the View menu, choose Go to Network View.

Step 2  Click the Provisioning > Security > Policy tabs. A read-only table of nodes and their policies appears.

Step 3  Click a node on the table that you want to modify, then click Change.

Step 4  If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle User Timeout area for the security level that you want to provision: RETRIEVE, MAINTENANCE, PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. The user is logged out after the idle user timeout period is reached.
Step 5 In the User Lockout area, you can modify the following:

- Failed Logins Before Lockout—The number of failed login attempts a user can make before the user is locked out from the node. You can choose a value between 0 and 10.
- Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user who has been locked out from a node.
- Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Note Manual Unlock by Superuser and Lockout Duration are mutually exclusive.

Step 6 In the Password Change area, you can modify the following:

- Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different passwords that the user must create before they can reuse a password.
- New Password must Differ from the Old Password—Choose the number of characters that must differ between the old and new password. The default number is 1. The range is 1 to 5.
- Cannot Change New Password for [ ] days—If checked, prevents users from changing their password for the specified period. The range is 20 to 95 days.
- Require Password Change on First Login to New Account—If checked, requires users to change their password the first time they log into their account.

Step 7 To require users to change their password at periodic intervals, check the Enforce Password Aging check box in the Password Aging area. If checked, provision the following parameters:

- Aging Period—Sets the amount of time that must pass before the user must change his or her password for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and SUPERUSER. The range is 20 to 95 days.
- Warning Period—Sets the number of days the user will be warned to change his or her password for each security level. The range is 2 to 20 days.

Step 8 In the Other area, you can provision the following:

- Single Session Per User—If checked, limits users to one login session at one time.
- Disable Inactive User—If checked, disables users who do not log into the node for the period of time specified in the Inactive Duration box. The Inactive Duration range is 1 to 99 days.

Step 9 In the Select Applicable Nodes area, uncheck any nodes where you do not want to apply the changes.

Step 10 Click OK.

Step 11 In the Security Policy Change Results dialog box, confirm that the changes are correct, then click OK.

Step 12 Return to your originating procedure (NTP).
DLP-G317 Change Node Access and PM Clearing Privilege

Step 1  In node view, click the Provisioning > Security > Access tabs.

Step 2  In the Access area, provision the following:

- LAN access—Choose one of the following options to set the access paths to the node:
  - No LAN Access—Allows access to the node only through DCC connections. Access through the TCC2/TCC2P RJ-45 port and backplane is not permitted.
  - Front only—Allows access through the TCC2/TCC2P RJ-45 port. Access through the DCC and the backplane is not permitted.
  - Backplane only—Allows access through DCC connections and the backplane. Access through the TCC2/TCC2P RJ-45 port is not allowed.
  - Front and Backplane—Allows access through DCC, TCC2/TCC2P RJ-45 port, and backplane connections.

- Restore Timeout—Sets a time delay for enabling of front and backplane access when DCC connections are lost and “DCC only” is chosen in LAN Access. Front and backplane access is enabled after the restore timeout period has passed. Front and backplane access is disabled as soon as DCC connections are restored.

Step 3  In the Shell Access area, set the shell program used to access the node:

- Access State: Allows you to set the shell program access mode to Disable (disables shell access), Non-Secure, or Secure. Secure mode allows access to the node using the Secure Shell (SSH) program. SSH is a terminal-remote host Internet protocol that uses encrypted links.

- Telnet Port: Allows access to the node using the Telnet port. Telnet is the terminal-remote host Internet protocol developed for the Advanced Agency Research Project Network (ARPANET). Port 23 is the default.

- Enable Shell Password: If checked, enables the SSH password. To disable the password, you must uncheck the check box and click Apply. You must type the password in the confirmation dialog box and click OK to disable it.

Step 4  In the TL1 Access area, select the desired level of TL1 access. Disabled completely disables all TL1 access; Non-Secure and Secure allow access using SSH.

Step 5  In the PM Clearing Privilege field, choose the minimum security level that can clear node PM data: PROVISIONING or SUPERUSER.

Step 6  Select the Enable Craft Port check box to turn on the shelf controller serial ports.

Step 7  Select the EMS access state from the list. Available states are Non-Secure and Secure (allows access using SSH).
**Step 8** In the TCC CORBA (IIOP/SSLIOP) Listener Port area, choose a listener port option:

- **Default - TCC Fixed**—Uses Port 57790 to connect to ONS 15454s on the same side of the firewall or if no firewall is used (default). This option can be used for access through a firewall if Port 57790 is open.

- **Standard Constant**—Uses Port 683 (IIOP) or Port 684 (SSLIOP), the CORBA default port number.

- **Other Constant**—If the default port is not used, type the IIOP or SSLIOP (Secure Socket Layer Inter-ORB Protocol) port specified by your firewall administrator.

**Step 9** In the SNMP Access area, set the Simple Network Management Protocol (SNMP) access state to Non-Secure or Disabled (disables SNMP access).

**Step 10** Click **Apply**.

**Step 11** Return to your originating procedure (NTP).

---

**DLP-G191 Change User Password and Security Level on a Single Node**

**Purpose**
This task changes settings for an existing user at one node.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

**Step 1** In node view, click the **Provisioning > Security > Users** tabs.

**Step 2** Click the user whose settings you want to modify, then click **Edit**.

**Step 3** In the Change User dialog box, you can:

- Change a user password.
- Modify the user security level.
- Lock out the user.

See the “DLP-G54 Create a New User on a Single Node” procedure on page 3-6 for field descriptions.

**Step 4** Click **OK**.

**Step 5** Click **OK** in the confirmation dialog box.

**Note**
User settings that you changed during this task will not appear until that user logs off and logs back in.

**Step 6** Return to your originating procedure (NTP).
DLP-G192 Change User Password and Security Level for Multiple Nodes

**Purpose**
This task changes settings for an existing user at multiple nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

---

**Note**
You must add the same user name and password to each node that the user will access.

---

**Step 1**
From the View menu, choose **Go to Network View**. Verify that you can access all the nodes where you want to change the users.

**Step 2**
Click the **Provisioning > Security > Users** tabs. Highlight the user’s name whose settings you want to change.

**Step 3**
Click **Change**. The Change User dialog box appears.

**Step 4**
In the Change User dialog box, you can:
- Change a user’s password.
- Modify the user’s security level.
- Lock out the user.

See the “DLP-G55 Create a New User on Multiple Nodes” task on page 3-7 for field descriptions.

**Step 5**
In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s settings (all network nodes are selected by default).

**Step 6**
Click **OK**. A Change Results confirmation dialog box appears.

**Step 7**
Click **OK** to acknowledge the changes.

**Step 8**
Return to your originating procedure (NTP).
Chapter 10  Manage the Node

DLP-G193 Delete a User From a Single Node

**Purpose**
This task deletes an existing user from a single node.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G193 Delete a User From a Single Node

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

**Note**
You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G195 Log Out a User on a Single Node” task on page 10-53, or you can choose the “Logout before delete” option in the Delete User dialog box.

**Note**
CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete the CISCO15 user if you have created another Superuser. Use this option with caution.

**Step 1**
In node view, click the **Provisioning > Security > Users** tabs.

**Step 2**
Choose the user that you want to delete.

**Step 3**
Click **Delete**.

**Step 4**
In the Delete User dialog box, verify that the user name displayed is the one that you want to delete. Click **Logout before delete** if the user is currently logged in. (You cannot delete users if they are logged in.)

**Step 5**
Click **OK**.

**Step 6**
In the User Deletion Results box, click **OK**.

**Step 7**
Return to your originating procedure (NTP).

DLP-G194 Delete a User From Multiple Nodes

**Purpose**
This task deletes an existing user from multiple nodes.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G194 Delete a User From Multiple Nodes

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Superuser

**Note**
You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G196 Log Out a User on Multiple Nodes” task on page 10-54, or you can choose the “Logout before delete” option in the Delete User dialog box.
Note
CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > Security tabs. Highlight the name of the user you want to delete.
Step 3 Click Delete. The Delete User dialog box appears.
Step 4 In the Select Applicable Nodes area, uncheck any nodes where you do not want to delete this user.
Step 5 Click OK. A User Deletion Results confirmation dialog box appears.
Step 6 Click OK to acknowledge the changes. Confirm that the changes appear; if not, repeat the task.
Step 7 Return to your originating procedure (NTP).

DLP-G195 Log Out a User on a Single Node

Purpose This task logs out a user from a single node.
Tools/Equipment None
Prerequisite Procedures DLP-G46 Log into CTC, page 2-25
Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Superuser

Step 1 In node view, click the Provisioning > Security > Active Logins tabs.
Step 2 Choose the user that you want to log out and click Logout.
Step 3 In the Logout User dialog box, check Lockout before Logout if you want to lock the user out. This prevents the user from logging in after logout based on user lockout parameters provisioned in the Policy tab. A manual unlock by a Superuser is required, or else the user is locked out for the amount of time specified in the Lockout Duration field. See the “DLP-G188 Change Security Policy for a Single Node” task on page 10-46 for more information.
Step 4 Click OK.
Step 5 Click OK to confirm the logout.
Step 6 Return to your originating procedure (NTP).
DLP-G196 Log Out a User on Multiple Nodes

Purpose: This task logs out a user from multiple nodes.
Tools/Equipment: None
Prerequisite Procedures: DLP-G46 Log into CTC, page 2-25
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Step 1: From the View menu, chose Go to Network View.
Step 2: Click the Provisioning > Security > Active Logins tabs.
Step 3: Choose the user that you want to log out.
Step 4: Click Logout.
Step 5: In the Logout User dialog box, check the nodes where you want to log out the user.
Step 6: Check Lockout before Logout if you want to lock the user out prior to logout. This prevents the user from logging in after logout based on user lockout parameters provisioned in the Policy tab. A manual unlock by a Superuser is required, or else the user is locked out for the amount of time specified in the Lockout Duration field. See the “DLP-G189 Change Security Policy for Multiple Nodes” task on page 10-47 for more information.
Step 7: In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s settings (all network nodes are selected by default).
Step 8: Click OK.
Step 9: Click OK in the confirmation dialog box.
Step 10: Return to your originating procedure (NTP).
DLP-G281 Configure the Node for RADIUS Authentication

Purpose
This task allows you to configure a node for Remote Authentication Dial In User Service (RADIUS) authentication. RADIUS validates remote users who are attempting to connect to the network.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25
Before configuring the node for RADIUS authentication, you must first add the node as a network device on the RADIUS server. Refer to the User Guide for Cisco Secure ACS for Windows Server for more information about configuring a RADIUS server.

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Caution
Do not configure a node for RADIUS authentication until after you have added that node to the RADIUS server and added the RADIUS server to the list of authenticators. If you do not add the node to a RADIUS server prior to activating RADIUS authentication, no user will be able to access the node. Refer to the User Guide for Cisco Secure ACS for Windows Server for more information about adding a node to a RADIUS server.

Note
The following Cisco vendor-specific attribute (VSA) needs to be specified when adding users to the RADIUS server:
shell:priv-lvl=N
where N is equal to:
- 0 for Retrieve user
- 1 for Maintenance user
- 2 for Provisioning user
- 3 for Superuser

Step 1
In node view, click the Provisioning > Security > RADIUS Server tabs (Figure 10-2).
Step 2  Click Create to add a RADIUS server to the list of authenticators. The Create RADIUS Server Entry window appears (Figure 10-3).

Step 3  Enter the RADIUS server IP address in the IP Address field. If the node is an end network element (ENE), enter the IP address of the gateway network element (GNE) in this field. The GNE passes authentication requests from the ENEs in its network to the RADIUS server, which grants authentication if the GNE is listed as a client on the server.

Caution  Because the ENE nodes use the GNE to pass authentication requests to the RADIUS server, you must add the ENEs to the RADIUS server individually for authentication. If you do not add the ENE node to a RADIUS server prior to activating RADIUS authentication, no user will be able to access the node. Refer to the User Guide for Cisco Secure ACS for Windows Server for more information about adding a node to a RADIUS server.

Step 4  Enter the shared secret in the Shared Secret field. A shared secret is a text string that serves as a password between a RADIUS client and RADIUS server.

Step 5  Enter the RADIUS authentication port number in the Authentication Port field. The default port is 1812. If the node is an ENE, set the authentication port to a number within the range of 1860 to 1869.

Step 6  Enter the RADIUS accounting port in the Accounting Port field. The default port is 1813. If the node is an ENE, set the accounting port to a number within the range of 1870 to 1879.

Step 7  Click OK. The RADIUS server is added to the list of RADIUS authenticators.
Chapter 10  Manage the Node

Note  You can add up to 10 RADIUS servers to a node’s list of authenticators.

Step 8  Click Edit to make changes to an existing RADIUS server. You can change the IP address, the shared secret, the authentication port, and the accounting port.

Step 9  Click Delete to delete the selected RADIUS server.

Step 10 Select a server and click Move Up or Move Down to reorder that server in the list of RADIUS authenticators. The node requests authentication from the servers sequentially from top to bottom. If one server is unreachable, the node will request authentication from the next RADIUS server on the list.

Step 11 Click the Enable RADIUS Authentication check box to activate remote-server authentication for the node.

Step 12 Click the Enable RADIUS Accounting check box if you want to show RADIUS authentication information in the audit trail.

Step 13 Click the Enable the Node as the Final Authenticator check box if you want the node to be the final authenticator. This means that if every RADIUS authenticator is unavailable, the node will authenticate the login rather than locking the user out.

Step 14 Click Apply to save all changes or Reset to clear all changes.

Step 15 Return to your originating procedure (NTP).

---

DLP-G282 View and Terminate Active Logins

**Purpose**  This procedure allows you to view active CTC logins, retrieve the last activity time, and terminate all current logins.

**Tools/Equipment**  None

**Prerequisite Procedures**  DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Retrieve or higher for viewing; Superuser for session termination

---

**Step 1**  In node view, click the Provisioning > Security > Active Logins tabs. The Active Logins tab displays the following information:

- User ID
- User IP address
- Current node the user is logged into
- Session Type (EMS, TL1, FTP, telnet, or SSH)
- Login time
- Last activity time

**Step 2**  Click Logout to end the session of every logged-in user. This will log out all current users, excluding the initiating Superuser.
Step 3: Click **Retrieve Last Activity Time** to display the most recent activity date and time for users in the Last Activity Time field.

Step 4: Return to your originating procedure (NTP).

**NTP-G131 Convert DWDM Nodes to Hybrid Nodes**

**Purpose**
This procedure upgrades an OSCM card to an OSC-CSM card. OSCM cards use Slots 8 and 10, which are required for cross-connect cards in TDM and DWDM hybrid configurations. The OSC-CSM cards can be installed in Slots 1 to 6 or 12 to 17.

**Tools/Equipment**
Two OSC-CSM cards

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Maintenance or higher

**Note**
You cannot perform this upgrade on software released prior to Software Release 4.6.

**Note**
Downgrade procedures from OSC-CSM cards to OSCM cards are not supported. Contact the Cisco Technical Assistance Center (TAC) for more information. See the “Obtaining Technical Assistance” section on page lxxvi.

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will perform the upgrade. If you are already logged in, continue with Step 2.

**Step 2**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3**
If you have timing set up on the OSCM card, delete the timing source:
   a. In node view, click the **Provisioning > Timing** tabs.
   b. Scroll to the Reference Lists area.
   c. In the NE Reference column, select **Internal Clock** from the drop-down list for all entries where the selected Clock Source is the OSCM that you are removing.
   d. Click **Apply**.

**Step 4**
If you have overhead circuits on the node, complete the “DLP-G112 Delete Overhead Circuits” task on page 7-22.

**Step 5**
Delete the DWDM ring ID:
   a. In node view, click the **Provisioning > Comm Channels > OSC** tabs.
   b. Select the DWDM Ring ID that you want to delete and click **Delete**.
   c. In the Delete DWDM Ring ID confirmation box, click **Yes**. Confirm that the changes appear.

**Step 6**
If you have OSC terminations, refer to the “DLP-G186 Delete an OSC Termination” task on page 10-41 to delete the OSC termination.
Step 7  Delete the OSCM card wavelength division multiplexing-automatic node setup (WDM-ANS) connections:
   a. In node view, click the **Provisioning > WDM-ANS > Connections** tabs.
   b. Select the connection to be deleted.
   c. Click **Delete**.
   d. In the Delete Optical Link dialog box, click **Yes**.

Step 8  Delete the card from CTC:
   a. In node view, right-click the OSCM card.
   b. Select **Delete Card** from the shortcut menu.
      The card name disappears and the slot turns gray.

Step 9  Remove the cables from the OSCM OSC ports.

Step 10 Physically replace the deleted OSCM card on the ONS 15454 with an OSC-CSM card:
   a. Open the OSCM card ejectors.
   b. Slide the card out of Slot 8 or 10.
   c. Open the ejectors on the OSC-CSM card.
   d. Slide the OSC-CSM card into the slot along the guide rails according to your site plan.
   e. Close the ejectors.

   **Note**  The OSCM card and OSC-CSM card do not have the same slot requirements.

   a. Open the OSCM card ejectors.
   b. Slide the card out of Slot 8 or 10.
   c. Open the ejectors on the OSC-CSM card.
   d. Slide the OSC-CSM card into the slot along the guide rails according to your site plan.
   e. Close the ejectors.

   **Note**  On the OSC-CSM card, the fail LED above the ACT/STBY LED becomes red, blinks for several seconds, and turns off. The ACT/STBY LED turns green and remains on. In node view, the OSC-CSM appears green.

Step 11 If an OSCM card was removed from Slot 8 and an OSC-CSM card was installed in Slots 12 to 17, modify the OSC-CSM line direction from east-to-west to west-to-east.

   **Note**  The Cisco MetroPlanner configuration file labels the OSC-CSM card as west even if it is installed in the east side of the node.

   a. To modify the OSC-CSM card line direction, double-click the OSC-CSM card in node view. The card view appears.
   a. Click the **Provisioning > Optical Line > Parameter** tabs.
   b. In the Port 2 line, click the Line Direction drop-down list and choose **West to East**.
   c. Click **Apply**.

Step 12 If an OSCM card was removed from Slot 10 and an OSC-CSM card was installed in Slots 1 to 6, modify the OSC-CSM line direction from west-to-east to east-to-west.
Note The Cisco MetroPlanner configuration file will label the OSC-CSM card as east even if it is installed in the west side of the node.

a. To modify the OSC-CSM card line direction, double-click the OSC-CSM card in node view. The card view appears.

b. Click the Provisioning > Optical Line > Parameter tabs.

c. In the Port 2 line, click the Line Direction drop-down list and choose East to West.

d. Click Apply.

Step 13 Calculate default connections using WDM-ANS:

a. Click the CTC up arrow to get back to node view.

b. In node view, click the Provisioning > WDM-ANS > Connections tabs.

c. Click the Calculate Connections button.

Step 14 Connect the cables from the OSC-CSM LINE ports to the OPT-BST amplifier OSC ports. Follow the recommended connections that were automatically calculated in the Connections tab as described in Step 13.

Step 15 Launch ANS port regulation:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Click the Launch ANS button.

c. In the Link Status column, the ports change to Regulated.

Step 16 Create OSC terminations starting from the OSC-CSM card. See the “NTP-G38 Provision OSC Terminations” task on page 3-84.

Step 17 (Optional) If you want to set up timing on the OSC-CSM card, create the timing source:

a. In node view, click the Provisioning > Timing tabs.

b. Scroll down to the Reference Lists area.

c. In the NE Reference column, select Internal Clock from the drop-down list for all entries where the selected Clock Source is the OSC-CSM that you are adding.

d. Click Apply.

Step 18 (Optional) Complete the “NTP-G60 Create Overhead Circuits” procedure on page 7-13.

Step 19 Repeat Steps 3 through 18 for each OSCM card you are replacing in the node.

Step 20 If you are installing cross-connect cards, refer to the Cisco ONS 15454 Procedure Guide or the Cisco ONS 15454 SDH Procedure Guide for instructions.

Stop. You have completed this procedure.
NTP-G89 Change SNMP Settings

Purpose
This procedure modifies the SNMP settings for the ONS 15454.

Tools/Equipment
None

Prerequisite Procedures
NTP-G28 Set Up SNMP, page 3-35

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Step 3
Perform any of the following tasks as needed:
- DLP-G197 Modify SNMP Trap Destinations, page 10-61
- DLP-G198 Delete SNMP Trap Destinations, page 10-62

Step 4
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

DLP-G197 Modify SNMP Trap Destinations

Purpose
This task modifies the SNMP trap destinations on an ONS 15454 including community name, default User Datagram Protocol (UDP) port, SNMP trap version, and maximum traps per second.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, click the Provisioning > SNMP tabs.

Step 2
Select a trap from the Trap Destinations area.

For a description of SNMP traps, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 3
Highlight the Destination row field entry in the Community column and change the entry to another valid community name.

The community name is a form of authentication and access control. The community name assigned to the ONS 15454 is case-sensitive and must match the community name of the network management system (NMS).

Step 4
If needed, modify the UDP port in the UDP Port field. The default UDP port for SNMP is 162.
Step 5 Set the Trap Version field for either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine whether to use SNMPv1 or SNMPv2.

Step 6 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets check box. If this box is not checked, SET requests are rejected.

Step 7 If you want to set up the SNMP proxy feature to allow network management, message reporting, and performance statistics retrieval across ONS firewalls, click the Enable SNMP Proxy check box located on the SNMP tab.

Step 8 Click Apply.

Step 9 SNMP settings are now modified. To view SNMP information for each node, highlight the node IP address in the Trap Destinations area of the Trap Destinations area. Confirm that the changes appear; if not, repeat the task.

Step 10 Return to your originating procedure (NTP).

---

**DLP-G198 Delete SNMP Trap Destinations**

**Purpose**
This task deletes SNMP trap destinations on an ONS 15454.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, click the Provisioning > SNMP tabs.

**Step 2**
In the Trap Destinations area, click the trap that you want to delete.

**Step 3**
Click Delete. A confirmation dialog box appears.

**Step 4**
Click Yes. Confirm that the changes appear; if not, repeat the task.

**Step 5**
Return to your originating procedure (NTP).
Change DWDM Card Settings

This chapter explains how to change line, performance monitoring (PM), and threshold settings on Cisco ONS 15454 optical service, amplifier, multiplexer, demultiplexer, 32WSS, and AIC-I cards. To install DWDM cards, see the “NTP-G30 Install the DWDM Cards” procedure on page 3-39.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide as necessary.

Caution

Changing card settings can be service affecting. You should make all changes during a scheduled maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds, page 11-2—As needed, complete this procedure to change the OSCM and OSC-CSM card settings.
2. NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds, page 11-12—As needed, complete this procedure to change the amplifier card settings.
3. NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds, page 11-23—As needed, complete this procedure to change the multiplexer and demultiplexer card settings.
4. NTP-G93 Modify the 32WSS Thresholds and Settings, page 11-33—As needed, complete this procedure to change the 32WSS card settings.
5. NTP-G101 Modify Alarm Interface Controller–International Settings, page 11-42—As needed, complete this procedure to change settings for external alarms, controls, and orderwire for the AIC-I card.
6. NTP-G102 Change Card Service State, page 11-45—As needed, complete this procedure to change the card service state.
NTP-G90 Modify OSCM and OSC-CSM Line Settings and PM Parameters and Thresholds

Purpose
This procedure changes the optical service channel (OC-3/STM-1) and PM parameters and thresholds for the OSCM and OSC-CSM cards.

Tools/Equipment
None

Prerequisite Procedures
NTP-G30 Install the DWDM Cards, page 3-39

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the OSCM or OSC-CSM card settings. If you are already logged in, proceed to Step 2.

Step 2
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Step 3
Perform any of the following tasks as needed:

- DLP-G199 Change the OSCM and OSC-CSM Optical Service Channel Settings, page 11-2
- DLP-G200 Change the OSCM and OSC-CSM Optical Service Channel Thresholds, page 11-5
- DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards, page 11-6
- DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings, page 11-8
- DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings, page 11-10

Step 4
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

DLP-G199 Change the OSCM and OSC-CSM Optical Service Channel Settings

Purpose
This task changes the OC-3/STM-1 optical service channel settings for OSCM and OSC-CSM cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the OSCM or OSC-CSM card where you want to change the OC-3 optical line settings.

Step 2
Click the Provisioning > OC3 Line > OC3 Line tabs.

Step 3
Modify any of the settings described in Table 11-1. The provisionable parameters are listed in the Options column in the table.
### Table 11-1  
**OSCM and OSC-CSM Card OC-3 Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>Displays the port number.</td>
<td>Display only</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
<tr>
<td>SF BER</td>
<td>Sets the signal fail bit error rate.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-5</td>
</tr>
<tr>
<td>SD BER</td>
<td>Sets the signal degrade bit error rate.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1E-9</td>
</tr>
<tr>
<td>Provides Synch</td>
<td>(Display only) If checked, the card is provisioned as a network element (NE) timing reference.</td>
<td>Checked, Unchecked</td>
</tr>
<tr>
<td>SynMsgIn</td>
<td>Enables synchronization status messages (SSM) on the S1 byte, which allow the node to choose the best timing source.</td>
<td>Checked, Unchecked</td>
</tr>
<tr>
<td>Send Do Not Use</td>
<td>When checked, sends a Do Not Use for Synchronization (DUS) message on the S1 byte.</td>
<td>Checked, Unchecked</td>
</tr>
<tr>
<td>PJSTSMon #</td>
<td>(Display only) Sets the STS that will be used for pointer justification. If set to 0, no STS is monitored. Only one STS can be monitored on each OC-N port.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
</tr>
</tbody>
</table>
### Admin State

Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”

- IS (ANSI) or Unlocked (ETSI)—Puts the port in service. The port service state changes to IS-NR (ANSI) or Unlocked-enabled (ETSI).
- IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in automatic in-service. The port service state changes to OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService (ETSI).
- OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the port from service and disables it. The port service state changes to OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI).
- OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the port from service for maintenance. The port service state changes to OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI).

### Service State

Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”

- IS-NR (In-Service and Normal [ANSI]) or Unlocked-enabled (ETSI)—The port is fully operational and is performing as provisioned.
- OOS-AU,AINS (Out-Of-Service and Autonomous, Automatic In-Service [ANSI]) or Unlocked-disabled,automaticInService (ETSI)—The port is out of service, but traffic is carried. Alarm reporting is suppressed. The ONS node monitors the ports for an error-free signal. After an error-free signal is detected, the port stays in the OOS-AU,AINS/Unlocked-disabled,automaticInService state for the duration of the soak period. After the soak period ends, the port service state changes to IS-NR/Unlocked-enabled.
- OOS-MA,DSBLD (Out-of-Service and Management, Disabled [ANSI]) or Locked-enabled,disabled (ETSI)—The port is out of service and unable to carry traffic.
- OOS-MA,MT (Out-of-Service and Management, Maintenance [ANSI]) or Locked-enabled,maintenance (ETSI)—The port is out of service for maintenance. Alarm reporting is suppressed, but traffic is carried and loopbacks are allowed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Admin State     | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | • IS (ANSI) or Unlocked (ETSI)—Puts the port in service. The port service state changes to IS-NR (ANSI) or Unlocked-enabled (ETSI).  
• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in automatic in-service. The port service state changes to OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService (ETSI).  
• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the port from service and disables it. The port service state changes to OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI).  
• OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the port from service for maintenance. The port service state changes to OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI). |
| Service State   | Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | • IS-NR (In-Service and Normal [ANSI]) or Unlocked-enabled (ETSI)—The port is fully operational and is performing as provisioned.  
• OOS-AU,AINS (Out-Of-Service and Autonomous, Automatic In-Service [ANSI]) or Unlocked-disabled,automaticInService (ETSI)—The port is out of service, but traffic is carried. Alarm reporting is suppressed. The ONS node monitors the ports for an error-free signal. After an error-free signal is detected, the port stays in the OOS-AU,AINS/Unlocked-disabled,automaticInService state for the duration of the soak period. After the soak period ends, the port service state changes to IS-NR/Unlocked-enabled.  
• OOS-MA,DSBLD (Out-of-Service and Management, Disabled [ANSI]) or Locked-enabled,disabled (ETSI)—The port is out of service and unable to carry traffic.  
• OOS-MA,MT (Out-of-Service and Management, Maintenance [ANSI]) or Locked-enabled,maintenance (ETSI)—The port is out of service for maintenance. Alarm reporting is suppressed, but traffic is carried and loopbacks are allowed. |
Table 11-1  OSCM and OSC-CSM Card OC-3 Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| AINS Soak | Sets the automatic in-service soak period. | • Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically  
• 0 to 48 hours, 15-minute increments |
| Type      | Defines the port as SONET or SDH. The Enable Sync Msg field and the Send Do Not Use field must be disabled before the port can be set to SDH. | From the drop-down list, choose one of the following:  
• SONET  
• SDH |

Step 4  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 5  Return to your originating procedure (NTP).

DLP-G200 Change the OSCM and OSC-CSM Optical Service Channel Thresholds

**Purpose**

This task changes the OC-3 (STM-1) SONET (SDH) thresholds settings for the OSC signal transmitted by the OSCM and OSC-CSM cards.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Provisioning or higher

Step 1  In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line threshold settings.

Step 2  Click the **Provisioning > OC3 Line > SONET Thresholds** tabs.

Step 3  Modify any of the settings described in Table 11-2. The provisionable parameters are listed in the options column in the table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Displays the port number</td>
<td>Display only</td>
</tr>
<tr>
<td>CV</td>
<td>Coding violations</td>
<td>Numeric. Can be set for 15-minute or one-day intervals for Line or Section (Near and Far End). Select the bullet and click <strong>Refresh</strong>.</td>
</tr>
<tr>
<td>ES</td>
<td>Errored seconds</td>
<td>Numeric. Can be set for 15-minute or one-day intervals for Line or Section (Near and Far End). Select the bullet and click <strong>Refresh</strong>.</td>
</tr>
</tbody>
</table>
Chapter 11  Change DWDM Card Settings

DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards

Purpose
This task changes the optical line parameters for OSCM and OSC-CSM cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line parameters.

Step 2
Click the Provisioning > Optical Line > Parameters tabs.

Step 3
Modify any of the settings described in Table 11-3. The provisionable parameters are listed in the options column in the table.

Table 11-3  OSCM and OSC-CSM Card Optical Line Parameter Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>Displays the port number and TX or RX.</td>
<td>Display only</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
Table 11-3 OSCM and OSC-CSM Card Optical Line Parameter Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin State</td>
<td>Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IS/Unlocked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IS,AINS/Unlocked,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,DSBLD/Locked,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,MT/Locked,maintenance</td>
</tr>
<tr>
<td>Line Direction</td>
<td>Provides the ability to associate a card with the line direction. CTC automatically configures the line direction during node setup. To change this setting, you must change the Cisco MetroPlanner site plan and import it to the node.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• East to West</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• West to East</td>
</tr>
<tr>
<td>Service State</td>
<td>Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• IS-NR/Unlocked-enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-AU,AINS/Unlocked-disabled, automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,DSBLD/Locked-enabled,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,MT/Locked-enabled,maintenance</td>
</tr>
<tr>
<td>Type</td>
<td>(Display only) Identifies the type of port.</td>
<td>• Input Com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Output Com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Input Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Output Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Input OSC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Output OSC</td>
</tr>
<tr>
<td>Power</td>
<td>(Display only) Shows the current power level per port.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Mode</td>
<td>(Display only) Shows the functional mode of the variable optical attenuator (VOA), when present.</td>
<td>• Constant Attenuation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Constant Power</td>
</tr>
<tr>
<td>VOA Power Ref</td>
<td>(Display only) Shows the optical power setpoint that must be reached when a VOA is present and VOA Mode is set to Constant Power. This parameter can only be modified by Automatic Node Setup (ANS).</td>
<td>—</td>
</tr>
<tr>
<td>VOA Power Calib</td>
<td>Modifies the optical power value of the VOA when VOA Mode is set to Constant Power.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>VOA Attenuation Ref</td>
<td>Shows the VOA attenuation value when VOA Mode is set to Constant Attenuation. This parameter can only be modified by ANS.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Attenuation Calib</td>
<td>Modifies the attenuation value of the VOA when the VOA Mode is set to Constant Attenuation.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
</tbody>
</table>
Step 4  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 5  Return to your originating procedure (NTP).

---

**DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task changes the optical line threshold settings for OSCM and OSC-CSM cards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>DLP-G46 Log into CTC, page 2-25</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Provisioning or higher</td>
</tr>
</tbody>
</table>

**Step 1**  In node view, double-click the OSCM or OSC-CSM card where you want to change the optical channel threshold settings.

**Step 2**  Click the **Provisioning > Optical Line > Optics Thresholds** tabs.

**Step 3**  Under Types, choose the type of threshold you want to change, either **Warning** or **Alarm**.

**Caution**  Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

**Step 4**  Click **Refresh**.

**Step 5**  Modify any of the warning or alarm threshold settings. **Table 11-4** shows the thresholds for warnings. **Table 11-5** shows the thresholds for alarms.

---

**Table 11-4  OSCM and OSC-CSM Cards Optical Channel Warning Thresholds Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>Display only</td>
</tr>
<tr>
<td>opwrMin (dBm)</td>
<td>Sets the low power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is –50 dBm. Double-click the parameter, enter a value, and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>opwrMax (dBm)</td>
<td>Sets the high power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm. Double-click the parameter, enter a value, and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>
### Table 11-5  
**OSCM and OSC-CSM Cards Optical Channel Alarm Thresholds Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Failure</td>
<td>Shows the optical power failure low threshold for the port. The threshold is calculated automatically when you run ANS. If the VOA Mode is Constant Attenuation, you can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”) If VOA Mode is Constant Power, you cannot change the threshold manually because it is based on the Power setpoint (Optics Thresholds tab). To change the threshold, you must change the VOA Power Calib value. This adjusts the Power setpoint. The threshold is automatically set to a value that is 5 dB higher than the Power setpoint.</td>
<td>Numeric.</td>
</tr>
<tr>
<td>Low (dBm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Degrade</td>
<td>Shows the power degrade high threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port that is associated to a VOA (OSC-VOA). In Constant Power mode, the port is always active and the threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib). To change the threshold, change the Power Setpoint. The threshold will always be 2 dB higher than the Power Setpoint.</td>
<td>Numeric.</td>
</tr>
<tr>
<td>High (dBm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Degrade</td>
<td>Shows the power degrade low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. In this case, the threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint will result in changing the threshold (always 2 dB lower).</td>
<td>Numeric.</td>
</tr>
<tr>
<td>Low (dBm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Table 11-5  

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOA Degrade High (dBm)</td>
<td>Does not apply to OSCM and OSC-CSM cards.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Degrade Low (dBm)</td>
<td>Does not apply to OSCM and OSC-CSM cards.</td>
<td>—</td>
</tr>
</tbody>
</table>

Step 6  
Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 7  
Return to your originating procedure (NTP).

DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings

**Purpose**  
This task changes the automatic laser shutdown (ALS) maintenance settings for the OSCM and OSCM cards.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

Step 1  
In node view, double-click the OSCM or OSCM card where you want to change the ALS maintenance settings.

Step 2  
Click the **Maintenance > ALS** tabs.

Step 3  
Modify any of the settings described in Table 11-6. The provisionable parameters are listed in the options column in the table.
Chapter 11 Change DWDM Card Settings

Table 11-6 OSCM and OSC-CSM Maintenance Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSRI</td>
<td>Optical safety remote interlock. When set to On, the OSC TX output power is shut down.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td>ALS Mode</td>
<td>Automatic laser shutdown. For OSCM cards ALS provides the ability to shut down the OSC TX laser when the OSC RX detects a loss of signal (LOS). For OSC-CSM cards, ALS provides the same functions as the OSCM card and also enables an optical safety mechanism at the DWDM network layer. See the “16.8.5.13 Automatic Laser Shutdown” section on page 16-105 for more information.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disable—Deactivates ALS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Auto Restart—(Default) ALS is active. The power is automatically shut down when needed and automatically tries to restart using a probe pulse until the cause of the failure is repaired.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual Restart for Test</td>
</tr>
<tr>
<td>Recovery Pulse Duration</td>
<td>(Display only) Displays the duration of the optical power pulse that begins when an amplifier restarts.</td>
<td>—</td>
</tr>
<tr>
<td>Recovery Pulse Interval</td>
<td>(Display only) Displays the interval between optical power pulses.</td>
<td>—</td>
</tr>
<tr>
<td>Currently Shutdown</td>
<td>(Display only) Displays the current status of the laser.</td>
<td>—</td>
</tr>
<tr>
<td>Request Laser Restart</td>
<td>If checked, allows you to restart the laser for maintenance.</td>
<td>Checked or unchecked</td>
</tr>
</tbody>
</table>

**Step 4** Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 5** Return to your originating procedure (NTP).
NTP-G91 Modify OPT-PRE and OPT-BST Line Settings and PM Parameters and Thresholds

**Purpose**
This procedure changes the line and threshold settings for the OPT-PRE and OPT-BST amplifier cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G30 Install the DWDM Cards, page 3-39

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the OPT-PRE or OPT-BST amplifier card settings. If you are already logged in, proceed to **Step 2**.

**Step 2**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3**
Perform any of the following tasks as needed:
- DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers, page 11-12
- DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers, page 11-14
- DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers, page 11-16
- DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers, page 11-18
- DLP-G322 Change the OPT-BST ALS Maintenance Settings, page 11-22

**Step 4**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

---

**DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers**

**Purpose**
This task changes the optical line settings for OPT-PRE and OPT-BST amplifier cards.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical line settings.

**Step 2**
Click the Provisioning > Optical Line > Parameters tabs.
Step 3  Modify any of the settings described in Table 11-7. The provisionable parameters are listed in the options column in the table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>Displays port number and TX or RX.</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. Double-click, enter the name, and press Enter. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State  | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | From the drop-down list, choose one of the following:  
  - IS/Unlocked  
  - IS,AINS/Unlocked,automaticInService  
  - OOS,DSBLD/Locked,disabled  
  - OOS,MT/Locked,maintenance |
| Line Direction| Provides the ability to associate a card with the line direction. CTC automatically configures the line direction during node setup. To change this setting, you must change the Cisco MetroPlanner site plan and import it to the node. | From the drop-down list, choose one of the following:  
  - East to West  
  - West to East |
| Service State| (Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” |  
  - IS-NR/Unlocked-enabled  
  - OOS-AU,AINS/Unlocked-disabled,automaticInService  
  - OOS-MA,DSBLD/Locked-enabled,disabled  
  - OOS-MA,MT/Locked-enabled,maintenance |
| Type         | (Display only) Identifies the type of port.    | For OPT-BST cards:  
  - Input Com  
  - Output Com  
  - Input Line  
  - Output Line  
  - Input OSC  
  - Output OSC  
  For OPT-PRE cards:  
  - Input Com  
  - Input DCU  
  - Output DCU |
| Power        | (Display only) Shows the current power level per port. | — |
| AINS Soak    | (Display only) Shows the soak time.            | — |
Step 4 Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 5 Return to your originating procedure (NTP).

### DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers

**Purpose**

This task changes the optical line threshold settings for OPT-PRE and OPT-BST amplifier cards.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>opwrMin (dBm)</td>
<td>Sets the low power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is –50 dBm. Double-click, enter the name, and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>opwrMax (dBm)</td>
<td>Sets the high power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm. Double-click, enter the name, and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>

**Caution**

Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.
Step 6  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 7  Return to your originating procedure (NTP).

### Table 11-9  **OPT-PRE and OPT-BST Card Optical Channel Alarm Threshold Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the optical power failure low threshold for the port. The threshold is calculated automatically when you run ANS. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”) For OPT-BST cards, this parameter applies to Port 2 (Output COM) and Port 4 (Output OSC) are related to Optical Safety mechanism at DWDM Network layer (see Chapter 16: “16.4 Network Optical Safety - Automatic Laser Shutdown” for a detailed description).</td>
<td>Numeric.</td>
</tr>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Does not apply to OPT-BST and OPT-PRE line parameters.</td>
<td>Numeric.</td>
</tr>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Does not apply to OPT-BST and OPT-PRE line parameters.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Degrade High (dBm)</td>
<td>Does not apply to OPT-BST and OPT-PRE line parameters.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Degrade Low (dBm)</td>
<td>Does not apply to OPT-BST and OPT-PRE line parameters.</td>
<td>—</td>
</tr>
</tbody>
</table>
DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers

Purpose
This task changes the optical amplifier line settings for OPT-PRE and OPT-BST amplifier cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical amplifier line settings.

Step 2
Click the Provisioning > Opt. Ampli. Line > Parameters tabs.

Step 3
Modify any of the settings described in Table 11-10. The provisionable parameters are listed in the options column in the table.

Table 11-10 OPT-PRE and OPT-BST Optical Amplifier Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>Displays port number and TX or RX.</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters.</td>
</tr>
<tr>
<td>Admin State</td>
<td>Sets the port service state unless network conditions prevent the change.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>• IS/Unlocked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IS,AINS/Unlocked,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,DSBLD/Locked,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS,MT/Locked,maintenance</td>
</tr>
<tr>
<td>Line Direction</td>
<td>Provides the ability to associate a card with the line direction. CTC automatically configures the line direction during node setup. To change this setting, you must change the Cisco MetroPlanner site plan and import it to the node.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• East to West</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• West to East</td>
</tr>
<tr>
<td>Service State</td>
<td>(Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IS-NR/Unlocked-enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-AU,AINS/Unlocked-disabled, automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,DSBLD/Locked-enabled,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-MA,MT/Locked-enabled,maintenance</td>
</tr>
<tr>
<td>Type</td>
<td>(Display only) Identifies the type of port.</td>
<td>Output Line</td>
</tr>
</tbody>
</table>
Table 11-10  OPT-PRE and OPT-BST Optical Amplifier Line Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Output Power</td>
<td>(Display only) Shows the current power level per port.</td>
<td>—</td>
</tr>
<tr>
<td>Channel Power Ref.</td>
<td>(Display only) Shows the optical per-channel signal power setpoint that must be reached at the amplifier output when gain control is active.</td>
<td>—</td>
</tr>
<tr>
<td>Offset</td>
<td>Adjusts the Total Output Power unless network conditions prevent the adjustment, for example the port is in IS state.</td>
<td>—</td>
</tr>
<tr>
<td>Signal Output Power</td>
<td>Shows the current output power leaving the amplifier, including the amplified spontaneous emissions (ASE) contribution.</td>
<td>—</td>
</tr>
<tr>
<td>Channel Power Ref.</td>
<td>(Display only) Shows the optical power per channel leaving the amplifier.</td>
<td>—</td>
</tr>
<tr>
<td>Channel Power Ref.</td>
<td>(Display only) Shows the optical power per channel leaving the amplifier.</td>
<td>—</td>
</tr>
<tr>
<td>Power Calib</td>
<td>Allows you to manually change the total optical power going to the amplifiers.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Gain</td>
<td>(Display only) The current gain of the amplifiers.</td>
<td>—</td>
</tr>
<tr>
<td>Gain Set Point</td>
<td>The value of the gain that the amplifier must achieve. Automatic Power Control (APC) can modify this value based on the number of optical channel network connection (OCHNC) circuits that are managed by the amplifier or to compensate for fiber aging insertion loss. See the “18.4 Automatic Power Control” section on page 18-18 for more information.</td>
<td>Display only or numeric depending on mode setting. When the system is configured as metro core, this field is display only. When the system is configured as metro access, this field can be changed by the user.</td>
</tr>
<tr>
<td>Tilt Reference</td>
<td>(Display only) Shows the default value for the amplifier tilt. This field can only be modified by ANS.</td>
<td>—</td>
</tr>
<tr>
<td>Tilt Calibration</td>
<td>Allows you to manually change the amplifier tilt.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>Mode</td>
<td>(Display only) Shows the working mode of the amplifier.</td>
<td>• Control gain</td>
</tr>
<tr>
<td>DCU Insertion Loss</td>
<td>(OPT-PRE cards only; display only) Shows the working mode of the amplifier.</td>
<td>• Control gain</td>
</tr>
</tbody>
</table>

**Step 4**  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 5**  Return to your originating procedure (NTP).
DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers

Purpose
This task changes the optical channel threshold settings for OPT-PRE and OPT-BST amplifier cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

Step 1
In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical channel threshold settings.

Step 2
Click the Provisioning > Optical Line > Optics Thresholds tabs.

Step 3
Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4
Click Refresh.

Step 5
Modify any of the warning or alarm threshold settings. Table 11-11 shows the amplifier line thresholds for warnings. Table 11-12 shows the amplifier line thresholds for alarms. The provisionable parameters are listed in the options column in the table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>opwrMin (dBm)</td>
<td>Sets the low power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is –50 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>opwrMax (dBm)</td>
<td>Sets the high power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
</tbody>
</table>
### Table 11-12  OPT-PRE and OPT-BST Card Amplifier Line Alarm Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the optical power failure low threshold for the port. The threshold is calculated automatically when you run ANS. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”)</td>
<td>Numeric. Display only</td>
</tr>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Shows the current value of the optical power degrade high threshold. This threshold applies only when the amplifier is active and in constant power mode. Power Degrade High refers to the port’s Signal Output Power value and is automatically calculated by the TCC2/TCC2P when the amplifier is turned up. The Power Degrade High threshold is linked to the Output Power Setpoint on the Parameters tab. Changing the setpoint changes the Power Degrade High threshold. The threshold value is always 2 dB higher than the Output Power Setpoint value. APC can modify this value based on the number of OCHNC circuits the amplifier is managing. See the “18.4 Automatic Power Control” section on page 18-18 for more information.</td>
<td>—</td>
</tr>
</tbody>
</table>
### Table 11-12  OPT-PRE and OPT-BST Card Amplifier Line Alarm Threshold Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Shows the current value of the optical power degrade high threshold configured in the card. This threshold applies only when the amplifier is active and in constant power mode.</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Power Degrade Low refers to the port’s Signal Output Power value and is automatically calculated by the TCC2/TCC2P when the amplifier is turned up.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Power Degrade Low threshold is automatically linked to the Output Power Setpoint on the Parameters tab. Changing the setpoint changes the Power Degrade Low threshold. The threshold value is always 2 dB lower than the Output Power Setpoint.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>APC can modify this value based on the number of OCHNC circuits the amplifier is managing.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 11-12  OPT-PRE and OPT-BST Card Amplifier Line Alarm Threshold Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain Degrade High (dBm)</td>
<td>Shows the current value of the gain degrade high threshold configured in the card. This threshold applies only when the amplifier is active and in constant gain mode. Gain Degrade High refers to the port’s Gain value and is automatically calculated by the TCC2/TCC2P and when the amplifier is turned up. The Gain Degrade High threshold is linked to the Gain setpoint. Changing the setpoint changes the Gain Degrade High threshold. The threshold value is always 2 dB higher than the Gain Setpoint value. APC can modify this value based on the number of OCHNC circuits the amplifier is managing and to compensate for insertion loss due to fiber aging.</td>
<td>—</td>
</tr>
<tr>
<td>Gain Degrade Low (dBm)</td>
<td>Shows the current value of the gain degrade low threshold configured in the card. This threshold applies only when the amplifier is active and in constant gain mode. Gain Degrade Low refers to the port’s Gain value and is automatically calculated by the TCC2/TCC2P and when the amplifier is turned up. The Gain Degrade Low threshold is automatically linked to the Gain Setpoint that is provisioned. Changing the setpoint changes the Gain Degrade Low threshold. The threshold value is always 2 dB lower than the Gain Setpoint value. APC can also modify this value based on the number of OCHNC circuits the amplifier is managing.</td>
<td>—</td>
</tr>
</tbody>
</table>

**Step 6**  
Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 7**  
Return to your originating procedure (NTP).
DLP-G322 Change the OPT-BST ALS Maintenance Settings

Purpose
This task changes the ALS maintenance settings for the OPT-BST card.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the OPT-BST where you want to change the ALS maintenance settings.

Step 2
Click the Maintenance > ALS tabs.

Step 3
Modify any of the settings described in Table 11-13. The provisionable parameters are listed in the options column in the table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| OSRI                 | Optical safety remote interlock. When set to On, the OPT-BST TX output power is shut down. | From the drop-down list, choose one of the following:  
  • On  
  • Off |
| ALS Mode             | Automatic laser shutdown mode. For OPT-BST cards, ALS provides the ability to shut down the OPT-BST TX laser when the OPT-BST RX detects an LOS.  
  ALS also enables an optical safety mechanism at the DWDM network layer. See the “16.8.5.13 Automatic Laser Shutdown” section on page 16-105 for more information. | From the drop-down list, choose one of the following:  
  • Disable—Deactivates ALS.  
  • Auto Restart—(Default) ALS is active. The power is automatically shut down when needed and automatically tries to restart using a probe pulse until the cause of the failure is repaired.  
  • Manual Restart  
  • Manual Restart for Test |
| Recovery Pulse Duration | (Display only) Displays the duration of the optical power pulse that begins when an amplifier restarts. | — |
| Recovery Pulse Interval | (Display only) Displays the interval between optical power pulses. | — |
| Currently Shutdown | (Display only) Displays the current status of the laser. | — |
| Request Laser Restart | If checked, allows you to restart the laser for maintenance. | Checked or unchecked |
**NTP-G92 Modify 32MUX-O, 32DMX-O, 32DMX, and 4MD Line Settings and PM Thresholds**

**Step 4**  
Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 5**  
Return to your originating procedure (NTP).

---

**Purpose**  
This procedure changes the line and PM parameter threshold settings for the multiplexer and demultiplexer cards. The cards included in this category are the 32MUX-O, 32DMX-O, 32DMX, and 4MD-xx.x cards.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
NTP-G30 Install the DWDM Cards, page 3-39

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

**Note**  
Complete the “DLP-G141 View Optical Power Statistics for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards” task on page 9-13 to view multiplexer and demultiplexer optical power statistics.

**Step 1**  
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 32MUX-O, 32DMX-O, 32DMX, or 4MD-xx.x card settings. If you are already logged in, proceed to Step 2.

**Step 2**  
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3**  
Perform any of the following tasks as needed:

- DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards, page 11-24
- DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards, page 11-26
- DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards, page 11-27
- DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards, page 11-30

**Step 4**  
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.
DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards

Purpose
This task changes the optical line settings for 32MUX-O, 32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the multiplexer or demultiplexer card where you want to change the optical line settings.

Step 2
Click the Provisioning > Optical Line > Parameters tabs.

Step 3
Modify any of the settings described in Table 11-14. In the Options column, the SONET option is followed by the SDH option. The provisionable parameters are listed in the options column in the table.

Table 11-14 Multiplexer and Demultiplexer Card Optical Line Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>Displays port number and TX or RX.</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. Double-click, enter the name, and press Enter. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State      | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | From the drop-down list, choose one of the following:  
  • IS/Unlocked  
  • IS,AINS/Unlocked,automaticInService  
  • OOS,DSBLD/Locked,disabled  
  • OOS,MT/Locked,maintenance |
| Line Direction   | Provides the ability to associate a card with the line direction. CTC automatically configures the line direction during node setup. To change this setting, you must change the Cisco MetroPlanner site plan and import it to the node. | From the drop-down list, choose one of the following:  
  • East to West  
  • West to East |
| Service State    | Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | Display only  
  • IS-NR/Unlocked-enabled  
  • OOS-AU,AINS/Unlocked-disabled,automaticInService  
  • OOS-MA,DSBLD/Locked-enabled,disabled  
  • OOS-MA,MT/Locked-enabled,maintenance |
Table 11-14  
Multiplexer and Demultiplexer Card Optical Line Settings (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>(Display only) Identifies the type of port.</td>
<td>• Input Com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Output Com</td>
</tr>
<tr>
<td>Power</td>
<td>(Display only) Shows the current power level per port.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Mode</td>
<td>(32DMX only; display only) Shows the functional mode of the VOA, when present.</td>
<td>• Constant Attenuation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Constant Power</td>
</tr>
<tr>
<td>VOA Power Ref</td>
<td>(32DMX only; display only) Shows the optical power setpoint that must be reached when a VOA is present and VOA Mode is set to Constant Power. This parameter can only be modified by ANS.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Power Calib</td>
<td>(32DMX only) Modifies the optical power value of the VOA when VOA Mode is set to Constant Power.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>VOA ATTenuation Ref</td>
<td>(32DMX only; display only) Shows the VOA attenuation value when VOA Mode is set to Constant Attenuation. This parameter can only be modified by ANS.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Attenuation Calib</td>
<td>(32DMX only) Modifies the attenuation value of the VOA when the VOA Mode is set to Constant Attenuation.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>AINS Soak</td>
<td>(Display only) Sets the automatic in-service soak period.</td>
<td>• Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0 to 48 hours, 15-minute increments</td>
</tr>
</tbody>
</table>

**Step 4**  
Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 5**  
Return to your originating procedure (NTP).
DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards

Purpose
This task changes the optical line threshold settings for 32MUX-O, 32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Step 1
In node view, double-click the multiplexer or demultiplexer card where you want to change the optical line threshold settings.

Step 2
Click the Provisioning > Optical Line > Optics Thresholds tabs.

Step 3
Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4
Click Refresh.

Step 5
Modify any of the warning or alarm threshold settings. Table 11-15 shows the amplifier line thresholds for warnings. The provisionable parameters are listed in the options column in the table.

Table 11-15 Multiplexer and Demultiplexer Card Amplifier Line Warning Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>opwrMin (dBm)</td>
<td>Sets the low power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is –50 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>opwrMax (dBm)</td>
<td>Sets the high power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
</tbody>
</table>

Caution
Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

Table 11-16 shows the amplifier line thresholds for alarms.
Chapter 11  Change DWDM Card Settings

DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards

### Purpose

This task changes the optical channel settings for 32MUX-O, 32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards.

### Tools/Equipment

None

### Prerequisite Procedures

DLP-G46 Log into CTC, page 2-25

### Required/As Needed

As needed

### Onsite/Remote

Onsite or remote

### Security Level

Provisioning or higher

### Step 1

In node view, double-click the multiplexer or demultiplexer card where you want to change the optical channel settings.

### Step 2

Click the Provisioning > Optical Chn > Parameters tabs.

### Step 3

Modify any of the settings described in Table 11-17. The provisionable parameters are listed in the options column in the table.

---

### Table 11-16  Multiplexer and Demultiplexer Amplifier Line Alarm Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the optical power failure low threshold for the port. The threshold is calculated automatically when you run ANS. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”)</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Not applicable to 32MUX-O, 32DMX-O, 32DMX, and 4MD cards.</td>
<td>—</td>
</tr>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Not applicable to 32MUX-O, 32DMX-O, 32DMX, and 4MD cards.</td>
<td>—</td>
</tr>
<tr>
<td>Power Add Failure Low (dBm)</td>
<td>Not applicable to 32MUX-O, 32DMX-O, 32DMX, and 4MD cards.</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
</tbody>
</table>

### Step 6

Click Apply. If the change affects traffic, a warning message displays. Click Yes to complete the change.

### Step 7

Return to your originating procedure (NTP).
### Table 11-17 Multiplexer and Demultiplexer Card Optical Channel Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #</td>
<td>(Display only) Displays the port number.</td>
<td>Displays port number and TX or RX.</td>
</tr>
<tr>
<td>Port Name</td>
<td>Provides the ability to assign the specified port a name.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. Double-click, enter the name, and press Enter. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
<tr>
<td>Admin State</td>
<td>Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IS/Unlocked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IS,AINS/Unlocked,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OOS,DSBLD/Locked,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OOS,MT/Locked,maintenance</td>
</tr>
<tr>
<td>Line Direction</td>
<td>Provides the ability to associate a card with the line direction. CTC automatically configures the line direction during node setup. To change this setting, you must change the Cisco MetroPlanner site plan and import it to the node.</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- East to West</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- West to East</td>
</tr>
<tr>
<td>Service State</td>
<td>(Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.”</td>
<td>From the drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IS-NR/Unlocked-enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OOS-AU,AINS/Unlocked-disabled,automaticInService</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OOS-MA,DSBLD/Locked-enabled,disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OOS-MA,MT/Locked,maintenance</td>
</tr>
<tr>
<td>Type</td>
<td>(Display only) Identifies the type of port.</td>
<td>ADD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DROP</td>
</tr>
<tr>
<td>Power</td>
<td>(Display only) Shows the current power level per port.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Mode</td>
<td>(Display only; 32MUX-O, 32DMX-0, 4MD only) Shows the current functional mode of the VOA.</td>
<td>Constant Power</td>
</tr>
<tr>
<td>VOA Power Ref.</td>
<td>(Display only; 32MUX-O, 32DMX-0, 4MD only) Shows the Power setpoint that must be reached on the path where a VOA is present when the VOA Mode is Constant Power. Demultiplexers show the reference value of the desired optical power going to the client. Multiplexers show the reference value of the desired per-channel optical power. This parameter can only be modified by ANS.</td>
<td>Constant Attenuation</td>
</tr>
</tbody>
</table>
**Step 4**  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

**Step 5**  Return to your originating procedure (NTP).

---

**Table 11-17  Multiplexer and Demultiplexer Card Optical Channel Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOA Power Calib.</td>
<td>(32MUX-O, 32DMX-0, 4MD only) The user can modify the optical output power to the VOA if necessary. The VOA power calibration offsets the VOA power reference. For demultiplexers, you can modify the optical output power to the client if necessary. For multiplexers, you can modify the output power per channel. This feature is normally used when the Network Type is configured as Access in the Provisioning &gt; WDM-ANS tab.</td>
<td>Numeric. Double-click the parameter, enter a value and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>VOA Attenuation Ref.</td>
<td>(Display only; 32MUX-O, 32DMX-0, 4MD only) Shows the attenuation value of the VOA when the VOA is set in attenuation mode. This parameter can only be modified by ANS and APC.</td>
<td>—</td>
</tr>
<tr>
<td>VOA Attenuation Calib.</td>
<td>(32MUX-O, 32DMX-0, and 4MD only) Allows the user to modify the attenuation value of the VOA if necessary when the VOA mode is set for constant attenuation.</td>
<td>Numeric, double-click the parameter, enter a value and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>Actual Wavelength</td>
<td>(Display only) Shows the wavelength specified by the manufacturing data. This field cannot be set manually.</td>
<td>—</td>
</tr>
<tr>
<td>Expected Wavelength</td>
<td>Shows the preprovisioned wavelength. This field is used to preprovision cards.</td>
<td>Numeric. Double-click the parameter, enter a value and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>
DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards

Purpose
This task changes the optical channel threshold settings for 32MUX-O, 32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards.

Tools/Equipment
None

Prerequisite Procedures
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

Caution
Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

Step 1
In node view, double-click the multiplexer or demultiplexer card where you want to change the optical threshold settings.

Step 2
Click the Provisioning > Optical Chn > Optics Thresholds tabs.

Step 3
Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4
Click Refresh.

Step 5
Modify any of the warning or alarm threshold settings. Table 11-18 shows the amplifier line thresholds for warnings.

Table 11-18 Multiplexer and Demultiplexer Card Optical Channel Warning Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Low (dBm)</td>
<td>Set the low power settings.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is −50 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>Power High (dBm)</td>
<td>Set the high power settings.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
</tbody>
</table>

Table 11-19 shows the amplifier line thresholds for alarms.
### Table 11-19  Multiplexer and Demultiplexer Card Optical Channel Alarm Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the power failure low threshold. This power value applies to the</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td></td>
<td>corresponding port and is automatically calculated when ANS is run.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changing the setpoint results in changing the threshold (always 5 dB lower).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The 32DMX is an exception. 32DMX Power Failure Low thresholds apply to ports not associated to a VOA. The threshold is calculated automatically when you run ANS. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”)</td>
<td></td>
</tr>
</tbody>
</table>
Step 6  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 7  Return to your originating procedure (NTP).

---

**Table 11-19  Multiplexer and Demultiplexer Card Optical Channel Alarm Threshold Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Shows the power degrade high threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint will result in changing the threshold (always 3 dB higher). This threshold does not apply to the 32DMX card.</td>
<td>—</td>
</tr>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Shows the power degrade low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint will result in changing the threshold (always 2 dB lower). This threshold does not apply to the 32DMX card.</td>
<td>Numeric. Double-click the parameter, enter a value, and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>
**NTP-G93 Modify the 32WSS Thresholds and Settings**

**Purpose**
This procedure changes the 32WSS card thresholds and settings.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G30 Install the DWDM Cards, page 3-39.

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 32WSS card settings. If you are already logged in, continue with Step 2.

**Step 2**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

**Step 3**
Perform any of the following tasks as needed:

- DLP-G212 Change Optical Channel Parameters for the 32WSS Card, page 11-33
- DLP-G213 Change the 32WSS Optical Channel Thresholds, page 11-36

**Note**
To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see Chapter 8, “Manage Alarms.”

- DLP-G214 Change Optical Line Parameters for the 32WSS Card, page 11-39
- DLP-G215 Change the 32WSS Card Optical Line Thresholds, page 11-40

**Step 4**
Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

---

**DLP-G212 Change Optical Channel Parameters for the 32WSS Card**

**Purpose**
This task changes the optical channel parameter settings for the 32WSS card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, double-click the 32WSS card where you want to change the optical channel parameter settings.

**Step 2**
Click the Provisioning > Optical Chn: Optical Connector tab for one of the four available groups of eight optical channels.
Step 3  Modify any of the settings described in Table 11-20. The provisionable parameters are listed in the options column in the table.

Table 11-20  32WSS Optical Channel Parameter Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Shows the port number. Each optical channel (wavelength) has two logical ports. However, only one is active at a time depending on the operating mode provisioned for the port on the card view Maintenance tab: either Add Drop or Pass Through. Ports 1 through 32 (RX) are assigned to optical channels configured as Add Channels. Ports 33 through 64 (PT) are assigned to optical channels configured as Pass-Through channels.</td>
<td>—</td>
</tr>
<tr>
<td>Port Name</td>
<td>Allows a logical name to be assigned for each of the port.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. Double-click, enter the name, and press Enter. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State   | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | From the drop-down list, choose one of the following:  
• IS/Unlocked  
• IS,AINS/Unlocked,automaticInService  
• OOS,DSBLD/Locked,disabled  
• OOS,MT/Locked,maintenance |
| Service State | (Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” | • IS-NR/Unlocked-enabled  
• OOS-AU,AINS/Unlocked-disabled,automaticInService  
• OOS-MA,DSBLD/Locked-enabled,disabled  
• OOS-MA,MT/Locked-enabled,maintenance |
| Line Direction| (Display only) Displays the line direction associated with the port. The parameter is automatically configured during ANS. | From the drop-down list, choose one of the following:  
• East to West  
• West to East |
| Type          | (Display only) Port type                                                    | • Add  
• Passthrough |
| Power         | (Display only) Power value read by the photodiode located after the VOA associated to the port, and calibrated to the COM_TX port. For more information, see the “16.7.6 32WSS Card” section on page 16-76 and the “B.4.15 32WSS Card Specifications” section on page B-32. | Numeric value (dB) |
**Chapter 11  Change DWDM Card Settings**

---

**Table 11-20  32WSS Optical Channel Parameter Settings (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOA Mode</td>
<td>(Display only) Displays the active VOA working mode.</td>
<td>• Constant Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Constant Attenuation</td>
</tr>
<tr>
<td>VOA Power Reference</td>
<td>(Display only) Shows the value of the optical power setpoint that must be reached on the path where a VOA is present, when VOA Mode is set to Constant Power. This value is the desired per-channel optical power. This parameter can only be modified by ANS.</td>
<td>Numeric value (dB)</td>
</tr>
<tr>
<td>VOA Power Calibration</td>
<td>Allows you to modify the VOA power value when VOA Mode is Constant Power.</td>
<td>Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric value (dB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• –37 dB to –2 dB</td>
</tr>
<tr>
<td>VOA Attenuation Reference</td>
<td>(Display only) Shows the attenuation value of the VOA when the VOA Mode is Constant Attenuation. This parameter can only be modified by ANS.</td>
<td>Numeric value (dB)</td>
</tr>
<tr>
<td>VOA Attenuation Calibration</td>
<td>Allows you to modify the VOA attenuation value when VOA Mode is Constant Attenuation.</td>
<td>Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric value (dB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• –30 dB to +30 dB</td>
</tr>
<tr>
<td>Actual Wavelength</td>
<td>(Display only) Displays the actual wavelength utilized by the channel.</td>
<td>• Actual measured value (nm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UNKNOWN</td>
</tr>
<tr>
<td>Expected Wavelength</td>
<td>(Display only) Displays the expected wavelength assigned for the channel.</td>
<td>• Value (nm) from the ITU-T grid specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UNKNOWN</td>
</tr>
<tr>
<td>Power ADD</td>
<td>(Display only) Displays a measurement of the optical power coming in on the ADD RX port. This is the power transmitted by the TX laser of the TXP or MXP card that is connected to the 32WSS. The measurement is performed by a photodiode before the selector and the VOA. The photodiode validates the power level of the incoming wavelength power.</td>
<td>Numeric value (dB)</td>
</tr>
<tr>
<td>Path Value</td>
<td>(Display only) Displays Path value.</td>
<td>• Standby</td>
</tr>
<tr>
<td>AINS Soak</td>
<td>(Display only) Sets the automatic in-service soak period.</td>
<td>• Duration of valid input signal, in hh:mm format, after which the card becomes in service (IS) automatically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0 to 48 hours, 15-minute increments</td>
</tr>
</tbody>
</table>

**Step 4**  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.
Step 5  
Return to your originating procedure (NTP).

DLP-G213 Change the 32WSS Optical Channel Thresholds

Purpose  
This task changes the optical channel optics threshold settings for the 32WSS card.

Tools/Equipment  
None

Prerequisite Procedures  
DLP-G46 Log into CTC, page 2-25

Required/As Needed  
As needed

Onsite/Remote  
Onsite or remote

Security Level  
Provisioning or higher

Caution  
Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

Step 1  
In node view, double-click the 32WSS card where you want to change the optical channel optics threshold settings.

Step 2  
Click the Provisioning > Optical Chn: Optical Connector tab for one of the four groups of eight optical channels that are available.

Step 3  
Under Types, choose the type of threshold you want to change, either Warning or Alarm.

Step 4  
Click Refresh.

Step 5  
Modify any of the warning or alarm threshold settings. Table 11-21 shows the 32WSS optical line thresholds for warnings. The provisionable parameters are listed in the options column in the table.

Table 11-21  
32WSS Optical Channel Warning Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number.</td>
<td>—</td>
</tr>
<tr>
<td>Power Low</td>
<td>Set the low power settings.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>(dBm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power High</td>
<td>Set the high power settings.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>(dBm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 11-22 shows the 32WSS optical line thresholds for alarms.
Table 11-22  32WSS Optical Channel Alarm Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Displays the port number. For each optical channel (wavelength), two logical ports are associated. Only one port can be active at a time, depending on the port’s operating mode. The operating mode, provisioned on the card view Maintenance tab, is either Add Drop or Pass-Through. Ports 1 through 32 (RX) are associated to optical channels configured as Add Drop channels. Ports 33 through 64 (PT) are associated to optical channels configured as Pass-Through channels.</td>
<td>Display only</td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the power failure low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint results in changing the threshold (always 5 dB lower). The threshold is calculated automatically when you run ANS. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”)</td>
<td>Numeric. Double-click the parameter, enter a value, and press Enter.</td>
</tr>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Shows the power degrade high threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint results in changing the threshold (always 3 dB higher).</td>
<td>Display only</td>
</tr>
</tbody>
</table>
Step 6  Click **Apply**. If the change affects traffic, a warning message displays. Click **Yes** to complete the change.

Step 7  Return to your originating procedure (NTP).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Shows the power degrade low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to a port associated to a VOA (OSC-VOA) always active in Constant Power mode. The threshold is automatically linked to the Power Setpoint (VOA Power Ref + VOA Power Calib) provisioned. Changing the setpoint results in changing the threshold (always 2 dB lower).</td>
<td>Numeric, display only</td>
</tr>
<tr>
<td>Power ADD Failure Low (dBm)</td>
<td>Shows the power add failure low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. This threshold applies to the actual measurement of the optical power on the ADD RX port, that is, the power transmitted by the Trunk-Tx laser of the TXP/MXP card connected to the 32 WSS. The measurement is performed by a photodiode located before the selector and the VOA to validate the incoming wavelength power level. See the “16.7.6 32WSS Card” section on page 16-76 for more information.</td>
<td>Numeric. Double-click the parameter, enter a value, and press <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>
DLP-G214 Change Optical Line Parameters for the 32WSS Card

**Purpose**
This task changes the optical line parameter settings for the 32WSS card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1**
In node view, double-click the 32WSS card where you want to change the optical line parameter settings.

**Step 2**
Click the **Provisioning > Optical Line > Parameters** tab.

**Step 3**
Modify any of the settings described in Table 11-23. The provisionable parameters are listed in the options column in the table.

### Table 11-23 32WSS Optical Line Parameter Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>(Display only) Port designation information. See “16.7.6 32WSS Card” section on page 16-76 for more information.</td>
<td>—</td>
</tr>
<tr>
<td>Port Name</td>
<td>Allows you to assign a logical name for each of the ports shown.</td>
<td>User-defined. Name can be up to 32 alphanumeric/special characters. Blank by default. Double-click, enter the name, and press <strong>Enter</strong>. See the “DLP-G104 Assign a Name to a Port” task on page 7-10.</td>
</tr>
</tbody>
</table>
| Admin State     | Sets the port service state unless network conditions prevent the change. For more information about administrative states, see Appendix C, “DWDM Administrative and Service States.” | From the drop-down list, choose one of the following:  
- IS/Unlocked  
- IS,AINS/Unlocked,automaticInService  
- OOS,DSBLD/Locked,disabled  
- OOS,MT/Locked,maintenance |
| Service State   | (Display only) Identifies the autonomously generated state that gives the overall condition of the port. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about service states, see Appendix C, “DWDM Administrative and Service States.” |  
- IS-NR/Unlocked-enabled  
- OOS-AU,AINS/Unlocked-disabled, automaticInService  
- OOS-MA,DSBLD/Locked-enabled,disabled  
- OOS-MA,MT/Locked-enabled,maintenance |
| Line Direction  | (Display only) Shows the line direction associated with the optical signal that passes through the port. This parameter is automatically configured during ANS. | From the drop-down list, choose one of the following:  
- West to East  
- East to West |
Chapter 11 Change DWDM Card Settings

DLP-G215 Change the 32WSS Card Optical Line Thresholds

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Port type</td>
<td>From the drop-down list, choose one of the following: • Output Express • Input Express • Out Com • Input Com • Drop</td>
</tr>
<tr>
<td>Power</td>
<td>Power value read by the photodiode associated with the port.</td>
<td>Numeric value (dB)</td>
</tr>
<tr>
<td>AINS Soak</td>
<td>Sets the automatic in-service soak period.</td>
<td>• Duration of valid input signal, in hh.mm format, after which the card becomes in service (IS) automatically • 0 to 48 hours, 15-minute increments</td>
</tr>
</tbody>
</table>

Step 4 Return to your originating procedure (NTP).

DLP-G215 Change the 32WSS Card Optical Line Thresholds

Purpose This task changes the 32WSS card optical line threshold settings.
Tools/Equipment None
Prerequisite Procedures DLP-G46 Log into CTC, page 2-25
Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher

Caution Warning thresholds are not monitored by CTC. They must be user-provisioned and monitored through custom alarm profiles.

Step 1 In node view, double-click the 32WSS card where you want to change the optical line optics warning threshold settings.
Step 2 Click the Provisioning > Optical Line > Optical Thresholds tab for one of the four groups of eight optical channels that are available.
Step 3 Under Types, choose the type of threshold you want to change, either Warning or Alarm.
Step 4 Click Refresh.
Step 5 Modify any of the warning or alarm threshold settings. Table 11-24 shows the 32WSS optical line thresholds for warnings. The provisionable parameters are listed in the options column in the table.
Table 11-24  32WSS Optical Channel Warning Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port (Display only)</td>
<td>Displays the port number.</td>
<td></td>
</tr>
<tr>
<td>Power Low (dBm)</td>
<td>Set the low power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is –50 dBm.</td>
</tr>
<tr>
<td>Power High (dBm)</td>
<td>Set the high power warning level.</td>
<td>Numeric. Can be set for 15-minute or one-day intervals. The default is 30 dBm.</td>
</tr>
</tbody>
</table>

Table 11-25 shows the 32WSS optical line thresholds for alarms.

Table 11-25  32WSS Optical Channel Alarm Threshold Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port (Display only)</td>
<td>Displays the port number.</td>
<td></td>
</tr>
<tr>
<td>Power Failure Low (dBm)</td>
<td>Shows the power failure low threshold. This power value applies to the corresponding port and is automatically calculated when ANS is run. You can manually change the threshold. The value must be within the optical power range that is specified for the card. (See Appendix B, “Hardware Specifications.”)</td>
<td>Numeric.</td>
</tr>
<tr>
<td>Power Degrade High (dBm)</td>
<td>Does not apply to 32WSS cards at the optical line level.</td>
<td></td>
</tr>
<tr>
<td>Power Degrade Low (dBm)</td>
<td>Does not apply to 32WSS cards at the optical line level.</td>
<td>Numeric.</td>
</tr>
</tbody>
</table>

Step 6  Return to your originating procedure (NTP).
Chapter 11  Change DWDM Card Settings

NTP-G101 Modify Alarm Interface Controller—International Settings

Purpose  This procedure provisions the AIC-I card to receive input from or send output to external devices wired to the backplane (called external alarms and controls or environmental alarms), or changes orderwire settings.

Tools/Equipment  None

Prerequisite Procedures  NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller—International Card, page 8-32
DLP-G109 Provision Orderwire, page 7-19

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Step 1  Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the AIC-I card settings. If you are already logged in, proceed to Step 2.

Step 2  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Step 3  Perform any of the following tasks as needed:
- DLP-G245 Change External Alarms Using the AIC-I Card, page 11-42
- DLP-G246 Change External Controls Using the AIC-I Card, page 11-43
- DLP-G247 Change AIC-I Card Orderwire Settings, page 11-44

Step 4  Complete the “NTP-G103 Back Up the Database” procedure on page 13-2.

Stop. You have completed this procedure.

DLP-G245 Change External Alarms Using the AIC-I Card

Purpose  This task changes external alarm settings on the AIC-I card.

Tools/Equipment  None

Prerequisite Procedures  DLP-G46 Log into CTC, page 2-25

Required/As Needed  As needed

Onsite/Remote  Onsite or remote

Security Level  Provisioning or higher

Note  The procedure is the same if you are using the alarm expansion panel (AEP). In this case, the number of contacts that are shown on the screen is changed accordingly.

Step 1  Confirm that external-device relays are wired to the ENVIR ALARMS IN pins. See the “DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 (ETSI) or “DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 (ANSI) for more information.
**DLP-G246 Change External Controls Using the AIC-I Card**

**Purpose**
This task changes external control settings on the AIC-I card.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Note**
The task is the same if you are using the AEP. In this case, the number of contacts that are shown on the screen is changed accordingly.

---

**Step 1**
Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 (ETSI) or “DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 (ANSI) for more information.

**Step 2**
In node view, double-click the AIC-I card to display it in card view.

**Step 3**
On the External Controls subtab, modify any of the following fields for each external control wired to the ONS 15454 backplane. For definitions of these fields, see the “NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card” procedure on page 8-32.

- Enabled
- Trigger Type
- Control Type
- Description

**Step 4**
To provision additional controls, complete Step 3 for each additional device.
DLP-G247 Change AIC-I Card Orderwire Settings

**Purpose**  
This task changes orderwire settings on the AIC-I card.

**Tools/Equipment**  
None

**Prerequisite Procedures**  
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  
As needed

**Onsite/Remote**  
Onsite or remote

**Security Level**  
Provisioning or higher

---

**Caution**  
When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the ring nodes.

---

**Tip**  
Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

---

**Step 1**  
In node view, double-click the AIC-I card to display it in card view.

**Step 2**  
Click the **Provisioning > Local Orderwire** tabs or the **Provisioning > Express Orderwire** tabs, depending on the orderwire path that you want to change. Provisioning steps are the same for both types of orderwire.

**Step 3**  
If needed, adjust the transmit (Tx) and receive (Rx) dBm values by moving the slider to the right or left for the headset type (four-wire or two-wire) that you will use. In general, you should not need to adjust the dBm values.

**Step 4**  
If you want to turn on the audible alert (buzzer) for the orderwire, check the **Buzzer On** check box.

**Step 5**  
Click **Apply**.

**Step 6**  
Return to your originating procedure (NTP).
NTP-G102 Change Card Service State

Purpose: This procedure changes a card service state.
Tools/Equipment: None
Prerequisite Procedures: NTP-G30 Install the DWDM Cards, page 3-39 or NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Provisioning or higher

Step 1: Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the card service state.
Step 2: Click the Inventory tab.
Step 3: Click Admin State for the card you want to change, and choose an Admin state from the drop-down list:
   • IS (ANSI) or Unlocked (ETSI)
   • OOS,MT (ANSI) or Locked-enabled (ETSI)
Step 4: Click Apply.
Step 5: If an error message appears indicating that the card state cannot be changed from its current state, click OK.

For information about the enhanced state model and card state transitions, refer to the “DWDM Administrative and Service States” section on page C-1.

Stop. You have completed this procedure.
Add and Remove Cards and Nodes

This chapter provides procedures for adding and removing dense wavelength division multiplexing (DWDM) cards and nodes.

*Note*

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

**Before You Begin**

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the *Cisco ONS 15454 SONET and DWDM Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* as necessary for general troubleshooting information and alarm or error descriptions.

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. **NTP-G107 Remove and Replace DWDM Cards**, page 12-1—Complete as needed.
2. **NTP-G127 Add an AD-xC-xx.x Card to an OADM Node**, page 12-5—Complete as needed.
3. **NTP-G129 Add a DWDM Node**, page 12-7—Complete as needed.
4. **NTP-G130 Remove a DWDM Node**, page 12-9—Complete as needed.

**NTP-G107 Remove and Replace DWDM Cards**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure removes and replaces DWDM cards installed in the ONS 15454 shelf and rack.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>None</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>A card installation procedure</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite</td>
</tr>
<tr>
<td>Security Level</td>
<td>Provisioning or higher</td>
</tr>
</tbody>
</table>

*Caution*

Removing and replacing cards can be traffic affecting.
Caution
Do not use this procedure to replace a TCC2 or TCC2P card. To replace a TCC2/TCC2P card, refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25.

Note
If you cannot log into Cisco Transport Controller (CTC) and you need to remove a card, remove the card as described in Step 5. After you log into CTC, troubleshoot the mismatched equipment alarm (MEA) with the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 2
Click the Alarms tab.

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 3
Complete the following tasks, as needed:

• If the card carries unprotected circuits, you must delete them. Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12.

• If the card you want to replace is an active transponder (TXP) or muxponder (MXP) in a Y-cable protection group, complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35 to force traffic away from the TXP or MXP that you will remove. If the card you want to replace is the standby TXP or MXP in a Y-cable protection group, complete the “DLP-G182 Apply a Lockout” task on page 10-37 to prevent traffic from switching to the TXP or MXP that you will remove.

• If the card is an OSCM or OSC-CSM that is used as a node timing reference, complete the “NTP-G112 Change the Node Timing Reference” procedure on page 13-17.

• If the card is an OSCM or OSC-CSM with an optical service channel (OSC) or generic communications channel (GCC) termination, complete the “NTP-G85 Modify or Delete OSC Terminations, GCC Terminations, and Provisionable Patchcords” procedure on page 10-39.

Note
If you delete a card in CTC but do not remove it from the shelf, it will reboot and reappear in CTC.

Step 4
Complete the “DLP-G254 Place OPT-BST and OPT-PRE Ports Out of Service” task on page 12-3.

Step 5
Physically remove the card:

a. Disconnect any cables.

b. Open the card latches/ejectors.

c. Use the latches/ejectors to pull the card forward and away from the shelf.

Step 6
Insert the new card using one of the following procedures as applicable:

• NTP-G30 Install the DWDM Cards, page 3-39

• NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
**Step 7** Continue with the “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” procedure on page 3-48.

**Step 8** Complete the following tasks or procedures, as needed:

- If you switched a Y-cable protection group in Step 3, complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36.
- If you deleted circuits in Step 3, complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10.
- If you switched the timing reference in Step 3, complete the “NTP-G112 Change the Node Timing Reference” procedure on page 13-17.
- If you deleted an OSC or GCC termination in Step 3, complete the “NTP-G38 Provision OSC Terminations” procedure on page 3-84 or the “DLP-G76 Provision GCC Terminations” task on page 7-14.
- If you placed OPT-PRE or OPT-BST cards out of service, complete the “DLP-G318 Place OPT-BST and OPT-PRE Ports In Service” task on page 12-4.

**Step 9** Click the **Alarms** tab.

- Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.
- Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve them. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.

Stop. You have completed this procedure.

---

**DLP-G254 Place OPT-BST and OPT-PRE Ports Out of Service**

**Purpose**

This task places OPT-BST and OPT-PRE card ports out of service in preparation for card removal.

**Tools/Equipment**

None

**Prerequisite Procedures**

DLP-G46 Log into CTC, page 2-25

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Provisioning or higher

**Step 1** On the shelf graphic in CTC, double-click the OPT-BST or OPT-PRE card with the ports that you want to put out of service.

**Step 2** Click the **Provisioning** > **Optical Line** > **Parameters** tabs.

**Step 3** Under Admin State, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) for each port that does not have an OOS-MA,DSBLD or Locked-disabled service state.

**Step 4** Click **Apply**.

**Step 5** In the confirmation dialog box, click **Yes**.

**Step 6** Click the **Provisioning** > **Opt Apli Line** > **Parameters** tabs.
DLP-G318 Place OPT-BST and OPT-PRE Ports In Service

**Step 7** Under Admin State, choose **OOS,DSBLD** or **Locked,disabled** (ETSI) for each port that does not have an OOS-MA,DSBLD or Locked,disabled service state.

**Step 8** Click **Apply**.

**Step 9** In the confirmation dialog box, click **Yes**.

**Step 10** Return to your originating procedure (NTP).
NTP-G127 Add an AD-xC-xx.x Card to an OADM Node

Purpose
This procedure adds an AD-xC-xx.x card to an optical add/drop multiplexing (OADM) node.

Tools/Equipment
None

Prerequisite Procedures
Chapter 3, “Turn Up a Node”
A Cisco MetroPlanner OADM site plan recalculated for the new OADM card

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Provisioning or higher

**Note**
Do not begin this procedure until the Cisco MetroPlanner site plan has been recalculated with the new AD-xCxx.x card added to the OADM node.

**Note**
During this procedure, you will use TL1 commands to delete and recreate optical channel network connection (OCHNC) cross-connects. You might need to refer to the *Cisco ONS SONET TL1 Command Guide* or the *Cisco ONS 15454 SDH TL1 Command Guide*.

**Caution**
This procedure will affect the service of unprotected circuits that pass through the OADM node.

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the OADM network.

**Step 2**
In node view, display the OADM node where you will add the card.

**Step 3**
Click the Circuits tab.

**Step 4**
Make a list of all OCHNCs that are carried on the express path for both east-to-west (E > W) and west-to-east (W > E) directions.

**Step 5**
For OCHNCs identified in Step 4 that are routed on the active path of a splitter or Y-cable protection group, force the traffic to the protect path in the opposite side of the ring using the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35.

**Step 6**
Click the Circuits tab.

**Step 7**
Complete the following steps for all OCHNCs carried on the express path that were identified in Step 4:

a. Choose the OCHNC circuit(s) and click Edit. (To choose multiple circuits, press the Shift key while you click the circuits.)

b. In the Edit Circuit dialog box, click the State tab.

c. In the Target Circuit Admin State drop-down list, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI).

d. Click Apply.

e. Repeat Steps a through d for each OCHNC circuit.

**Step 8**
From the Tools menu, choose Open TL1 Session.
Step 9  In the Select Node dialog box, choose the OADM node where you will add the AD-xCxx.x card and click
OK.

Step 10 In the TL1 dialog box, use the DLT-WLEN command to delete the OCHNC cross-connects for the
express path OCHNCs listed in Step 4, as follows:
DLT-WLEN:[<TID>]:<AID>:<CTAG>[:::CMDMDE=<CMDMDE>];
where:
  • <AID> is the wavelength AID per ring direction from the wavelength (WLEN) section.
  • <CMDMDE> indicates the command execution mode.

For additional information, including valid command values, refer to the Cisco ONS SONET TL1
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 11 Close the TL1 session.

Step 12 In node view, click the Provisioning > WDM-ANS > Connections tabs.

Step 13 Highlight the two express connections that carry the circuits passing through the node. (The express
connections are the only ones connecting an EXP_TX port on the last west-side OADM card, W > E,
with an EXP_RX port on the first east-side OADM card, W > E.)

Step 14 Click Delete.

Step 15 Remove the physical express cables between the EXP_TX and EXP_RX ports specified in Step 13.

Step 16 Insert the new AD-xCxx.x card in the slot identified by your Cisco MetroPlanner site plan.

Step 17 Complete the “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” procedure on
page 3-48 for the OADM node, following the new internal connections table generated by Cisco
MetroPlanner.

Step 18 Complete the “NTP-G36 Calculate Cable Connections” procedure on page 3-80.

Step 19 Import the recalculated OADM site parameters. See the “NTP-G138 Import a Cisco MetroPlanner
Configuration File” task on page 3-82.

Step 20 In node view, click the Provisioning > WDM-ANS > Port Status tabs.

Step 21 Click Launch ANS.

Step 22 From the Tools menu, choose Open TL1 Session.

Step 23 In the Select Node dialog box, choose the OADM node and click OK.

Step 24 In the TL1 dialog box, use the ENT-WLEN command to create the OCHNC cross-connects that were
deleted in Step 10, as follows:
ENT-WLEN:[<TID>]:<AID>:<CTAG>:::[SIZE=<SIZE>]:[<PST>],[<SST>];
where:
  • <AID> is the wavelength AID.
  • <SIZE> is the circuit size allocated on this wavelength.
  • <PST> is the primary state.
  • <SST> is the secondary state.

For additional information and a list of valid command values, see the Cisco ONS SONET TL1 Command
Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 25 Close the TL1 dialog box.

Step 26 In node view, click the Circuits tab.
Step 27 Complete the following steps for all OCHNCs set to OOS, DSBLD or Locked, disabled in Step 7:

a. Choose the OCHNC circuit(s) and click Edit. To choose multiple circuits, press the Shift key while you click the circuits.

b. In the Edit Circuit dialog box, click the State tab.

c. In the Target Circuit Admin State window, choose IS,AINS (ANSI) or Unlocked, automaticInService (ETSI).

d. Click Apply.

Step 28 Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36 for OCHNCs that were switched to the opposite side of the ring as part of a splitter or Y-cable protection group.

Stop. You have completed this procedure.

NTP-G129 Add a DWDM Node

**Purpose**
This procedure adds a DWDM node to an existing Multi-Service Transport Platform (MSTP) network.

**Tools/Equipment**
None

**Prerequisite Procedures**
Chapter 3, “Turn Up a Node”
A Cisco MetroPlanner network plan recalculated for the new node

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

**Note**
Do not begin this procedure until the Cisco MetroPlanner network plan has been updated and recalculated with the new DWDM node.

**Note**
During this procedure, you will use TL1 commands to delete and recreate OCHNC cross-connects. You might need to refer to the Cisco ONS SONET TL1 Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

**Caution**
To complete this procedure, a span will be disconnected where the new node is added. This will affect the service of any unprotected circuits that pass through that span.

**Step 1**
If the Cisco MetroPlanner network design has not been updated and recalculated for the new node and client services, update and recalculate it now, following the procedures in the Cisco MetroPlanner documentation.

**Step 2**
Identify the fiber span that must be disconnected to insert the new node.

**Step 3**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at a DWDM node that is active on the network.
**NTP-G129 Add a DWDM Node**

**Step 4** In network view, click the **Circuits** tab.

**Step 5** Identify the OCHNCs that are carried on the fiber span that you identified in **Step 2** in both the east-to-west and west-to-east directions.

**Step 6** If the OCHNC circuit is on the active path and is protected by a splitter or Y-cable protection group, complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35 to force traffic away from the span where the node will be added. If not, continue with **Step 7**.

**Step 7** For each circuit identified in **Step 5** that was not switched in **Step 6** (unprotected circuits), complete the following steps:

a. Select the circuit and click **Edit**.

b. In the Edit Circuit dialog box, click the **State** tab.

c. In the Target Circuit Admin State field, choose **OOS,DSBLD** (ANSI) or **Locked,disabled** (ETSI).

**Step 8** Remove the fibers from the cards at the adjacent nodes that will connect to the new node.

**Step 9** At the node that will be added, complete the following procedures and tasks:

- **NTP-G22 Verify Common Card Installation**, page 3-4
- **NTP-G26 Set Up CTC Network Access**, page 3-11
- **NTP-G30 Install the DWDM Cards**, page 3-39
- **NTP-G36 Calculate Cable Connections**, page 3-80
- **NTP-G138 Import a Cisco MetroPlanner Configuration File**, page 3-82
- **NTP-G37 Run Automatic Node Setup**, page 3-83
- Node acceptance tests in Chapter 4, “Perform Node Acceptance Tests”

**Step 10** Create cross-connects on the new node for all circuits identified in **Step 5**:

a. From the Tools menu, choose **Open TL1 Session**.

b. In the Select Node dialog box, choose the new node and click **OK**.

c. In the TL1 dialog box, use the **ENT-WLEN** command to create the OCHNC cross-connects for each unprotected pass-through circuit as follows:

```
ENT-WLEN:[<TID>]:<AID>:<CTAG>:::[SIZE=<SIZE>];[<PST>,[<SST>];
```

where:

- `<AID>` is the wavelength AID.
- `<SIZE>` is the circuit size allocated on this wavelength.
- `<PST>` is the primary state.
- `<SST>` is the secondary state.

For additional information and a list of valid command values, see the *Cisco ONS SONET TL1 Command Guide* or the *Cisco ONS 15454 SDH TL1 Command Guide*.

d. Close the TL1 dialog box.

e. Repeat **Step 7** to change the circuits placed in OOS-DSLBD or Locked,disabled back in service by choosing **IS,AINS** (ANSI) or **Unlocked,automaticInService** (ETSI),in the Target Circuit Admin State field.

**Step 11** Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36 for the circuits that were switched in **Step 7**.
Step 12 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 for circuits identified in Step 5 that will not be part of the traffic matrix after the node is added.

Step 13 Divide the circuits that existed previously into two groups: those that will terminate in the new node and those that will pass through it.

Step 14 For circuits that will terminate in the new node, complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 and then the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10.

Step 15 Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10 to create new circuits.

Stop. You have completed this procedure.

---

## NTP-G130 Remove a DWDM Node

**Purpose**
This procedure removes a DWDM node from an MSTP network.

**Tools/Equipment**
None

**Prerequisite Procedures**
Chapter 3, “Turn Up a Node”
A Cisco MetroPlanner network plan recalculated for the new node

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

---

**Note**
Do not begin this procedure until the Cisco MetroPlanner network plan has been updated and recalculated with the DWDM node removed.

**Note**
During this procedure, you will use TL1 commands to delete and recreate OCHNC cross-connects. You might need to refer to the *Cisco ONS SONET TL1 Reference Guide* or the *Cisco ONS 15454 SDH TL1 Reference Guide*.

**Caution**
This procedure will affect the service of unprotected circuits that pass through the span where the node will be removed.

**Step 1**
If the Cisco MetroPlanner network design has not been updated and recalculated with the node removed, update and recalculate it now, following the procedures in the Cisco MetroPlanner documentation.

**Step 2**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the DWDM node that will be removed.

**Step 3**
Click the **Circuits** tab.

**Step 4**
Identify the OCHNCs that pass through or are added and dropped at the node that will be removed, in both east-to-west and west-to-east directions.
Step 5  If OCHNC circuits pass through the node to be removed on the active path and are protected by a splitter or Y-cable protection group, navigate to a node connected to the node that will be removed and complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35. Otherwise, continue with Step 6.

Step 6  Complete the following steps for each circuit identified in Step 4 that was not switched in Step 5:
   a. Select the circuit and click Edit.
   b. In the Edit Circuit dialog box, click the State tab.
   c. In the Target Circuit Admin State field, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI).

Step 7  Delete the cross-connects on the node that will be removed for each circuit placed in the OOS-DSLBD or Locked,disabled state in Step 6:
   a. From the Tools menu, choose Open TL1 Session.
   b. In the Select Node dialog box, select the new node and click OK.
   c. In the TL1 dialog box, use the DLT-WLEN command to delete the OCHNC cross-connects for each unprotected pass-through circuit as follows:

```
DLT-WLEN:[<TID>]:<AID>:<CTAG>:::[SIZE=<SIZE>]:[<PST>],[<SST>];
```

where:
   – <AID> is the wavelength AID.
   – <SIZE> is the circuit size allocated on this wavelength.
   – <PST> is the primary state.
   – <SST> is the secondary state.

For additional information and a list of valid command values, see the Cisco ONS SONET TL1 Reference Guide or the Cisco ONS 15454 SDH TL1 Reference Guide.
   d. Close the TL1 dialog box.
   e. Repeat Step 6 to change the circuits placed in OOS-DSLBD back in service by changing the Target circuit Admin State field to IS,AINS (ANSI) or Unlocked,automaticInService (ETSI).

Step 8  Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 10-36 for the circuits that were switched in Step 5.

Step 9  Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 to delete circuits identified in Step 4 that will terminate (add/drop) on the new DWDM node.

Step 10 Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10 to recreate circuits identified in Step 4 that will terminate on the new DWDM node. Choose the new DWDM node as the start/end (add/drop, respectively) for each circuit.

Step 11 Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 7-10 to create new circuits that originate or terminate in the new DWDM node.

Stop. You have completed this procedure.
CHAPTER 13

Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454, including database backup and restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance procedures.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin

Before performing any of the following procedures, investigate all alarms and clear any trouble conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454 SDH Troubleshooting Guide as necessary for general troubleshooting information and alarm or error descriptions.

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G103 Back Up the Database, page 13-2—Complete as needed.
2. NTP-G104 Restore the Database, page 13-3—Complete as needed.
3. NTP-G105 Restore the Node to Factory Configuration, page 13-4—Complete as needed to clear the database and upload a blank database and the latest software.
4. NTP-G133 View and Manage OSI Information, page 13-9—Complete as needed.
5. NTP-G106 Reset Cards Using CTC, page 13-12—Complete as needed to reset the TCC2/TCC2P cards and the dense wavelength division multiplexing (DWDM) cards.
7. NTP-G109 Off-Load the Audit Trail Record, page 13-16—Complete as needed.
8. NTP-G110 Off-Load the Diagnostics File, page 13-17—Complete as needed.
10. NTP-G113 View the ONS 15454 Timing Report, page 13-19—Complete as needed.
11. NTP-G114 Inspect, Clean, and Replace the Air Filter, page 13-22—Complete as needed.
13. NTP-G40 Replace the Front Door, page 13-28—Complete as needed.
14. NTP-G116 Replace the Fan-Tray Assembly, page 13-31—Complete as needed.
15. **NTP-G117 Replace the ANSI Shelf Alarm Interface Panel**, page 13-36—Complete as needed.

16. **NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover**, page 13-40—Complete as needed.

17. **NTP-G135 Edit Network Element Defaults**, page 13-42—Complete as needed to edit the factory-configured (default) network element (NE) settings for the Cisco ONS 15454.

18. **NTP-G136 Import Network Element Defaults**, page 13-43—Complete as needed to import the factory-configured (default) NE settings for the Cisco ONS 15454.

19. **NTP-G137 Export Network Element Defaults**, page 13-44—Complete as needed to export the factory-configured (default) NE settings for the Cisco ONS 15454.

---

### NTP-G103 Back Up the Database

**Purpose**

This procedure stores a backup version of the TCC2/TCC2P (software) database on the workstation running Cisco Transport Controller (CTC) or on a network server.

**Tools/Equipment**

None

**Prerequisite Procedures**

None

**Required/As Needed**

Required. Cisco recommends performing a database backup at approximately weekly intervals and prior to and after configuration changes.

**Onsite/Remote**

Onsite or remote

**Security Level**

Maintenance or higher

---

**Note**

You must back up and restore the database for each node on a circuit path in order to maintain a complete circuit.

---

**Note**

The following parameters are not backed up and restored: node name, IP address, subnet mask and gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up database with a different node name, the circuits map to the new node name. Cisco recommends keeping a record of the old and new node names.

---

**Step 1**

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node you want to back up. If you are already logged in, continue with **Step 2**.

**Step 2**

Click the **Maintenance > Database** tabs.

**Step 3**

Click **Backup**.

**Step 4**

Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name with the DB file extension; for example, database.db.

**Step 5**

Click **Save**.

**Step 6**

Click **OK** in the confirmation dialog box.

Stop. You have completed this procedure.
NTP-G104 Restore the Database

Purpose: This procedure restores the TCC2/TCC2P card software database.
Tools/Equipment: None
Prerequisite Procedures: NTP-G103 Back Up the Database, page 13-2
Required/As Needed: As needed
Onsite/Remote: Onsite or remote
Security Level: Superuser

Note: The following parameters are not backed up and restored: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node name and then restore a backed up database with a different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of the old and new node names.

Caution: If you are restoring the database on multiple nodes, wait approximately one minute after the TCC2/TCC2P card reboot has completed on each node before proceeding to the next node.

Step 1: Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you are restoring the database. If you are already logged in, continue with Step 2.
Step 2: Click the Circuits tab. Verify that no optical channel network connection (OCHNC) circuits have a PARTIAL_OOS state. If so, investigate and resolve the partial state before continuing.
Step 3: Complete the “DLP-G157 Disable Automatic Power Control” task on page 10-4.
Step 4: In node view, click the Maintenance > Database tabs.
Step 5: Click Restore.
Step 6: Locate the database file stored on the workstation hard drive or on network storage. To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 software CD.
Step 7: Click the database file to highlight it.
Step 8: Click OK. The DB Restore dialog box appears. Opening a restore file from another node or from an earlier backup might affect traffic on the login node.
Step 9: Click Yes.

The Restore Database dialog box monitors the file transfer (Figure 13-1).

Figure 13-1  Restoring the Database—In-Process Notification

Step 10: Wait for the file to complete the transfer to the TCC2/TCC2P card.
NTP-G105 Restore the Node to Factory Configuration

Purpose
This procedure reinitializes the ONS 15454 using the CTC reinitialization tool. Reinitialization uploads a new software package to the TCC2/TCC2P cards, clears the node database, and restores the factory default parameters.

Tools/Equipment
ONS 15454 System Software CD, Version 6.0
Java Runtime Environment (JRE) 1.4.2 must be installed on the computer to log into the node at the completion of the reinitialization. The reinitialization tool can run on JRE 1.3.1_02 or JRE 1.4.2.

Prerequisite Procedures
NTP-G103 Back Up the Database, page 13-2
NTP-G17 Set Up Computer for CTC, page 2-2
One of the following:
- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9, or
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
Superuser

Caution
Cisco strongly recommends that you keep different node databases in separate folders. This is because the reinitialization tool chooses the first product-specific software package in the specified directory if you use the Search Path field instead of the Package and Database fields. You might accidentally copy an incorrect database if multiple databases are kept in the specified directory.

Caution
Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution
Cisco recommends that you save the node database to safe location if you will not be restoring the node using the database provided on the software CD.
Note
The following parameters are not backed up and restored when you delete the database and restore the factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node name and then restore a backed up database with a different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1
If you need to install or replace one or more TCC2/TCC2P cards, see the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-72.

Step 2
If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload Software (Windows)” task on page 13-5.

Step 3
If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX)” task on page 13-7.

Stop. You have completed this procedure.

DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload Software (Windows)

Purpose
This task reinitializes the ONS 15454 using the CTC reinitialization tool on a Windows computer. Reinitialization uploads a new software package to the TCC2/TCC2P cards, clears the node database, and restores the factory default parameters.

Tools/Equipment
ONS 15454 System Software CD, Version 6.0
JRE 1.4.2 must be installed on the computer to log into the node at the completion of the reinitialization. The reinitialization tool can run on JRE 1.3.1_02 or JRE 1.4.2.

Prerequisite Procedures
NTP-G103 Back Up the Database, page 13-2
NTP-G17 Set Up Computer for CTC, page 2-2
One of the following:
- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9, or
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21

Required/As Needed
As needed to clear the existing database from a TCC2/TCC2P and restore the node default settings.

Onsite/Remote
Onsite

Security Level
Superuser

Caution
Restoring a node to the factory configuration deletes all cross-connects on the node.
Step 1 Insert the ONS 15454 System Software CD, Version 6.0, into the computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 From the Windows Start menu, choose Run. In the Run dialog box, click Browse and navigate to the CISCO15454 or CISCO15454SDH folder on the software CD.

Step 3 In the Browse dialog box Files of Type field, choose All Files.

Step 4 Choose the RE-INIT.jar file and click Open. The NE Re-Initialization window appears (Figure 13-2).

Figure 13-2 Reinitialization Tool

Step 5 Complete the following fields:

- **GNE IP**—If the node you are reinitializing is accessed through another node configured as a gateway network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave this field blank.
- **Node IP**—Enter the node name or IP address of the node that you are reinitializing.
- **User ID**—Enter the user ID needed to access the node.
- **Password**—Enter the password for the user ID.
- **Upload Package**—Check this box to send the software package file to the node. If unchecked, the software stored on the node is not modified.
- **Force Upload**—Check this box to send the software package file to the node even if the node is running the same software version. If unchecked, reinitialization will not send the software package if the node is already running the same version.
- **Activate/Revert**—Check this box to activate the uploaded software (if the software is later than the installed version) or revert to the uploaded software (if the software is earlier than the installed version) as soon as the software file is uploaded. If unchecked, the software is not activated or reverted after the upload, allowing you to initiate the functions later from the node view Maintenance > Software tab.
- **Re-init Database**—Check this box to send a new database to the node. (This is equivalent to the CTC database restore operation.) If unchecked, the node database is not modified.
- **Confirm**—Check this box if you want a warning message displayed before any operation is performed. If unchecked, reinitialization does not display a warning message.
DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX)

- Search Path—Enter the path to the CISCO15454 folder on the CD drive.

**Step 6** Click Go.

⚠️ **Caution** Before continuing with the next step, verify that the database to upload is correct. You cannot reverse the upload process after you click Yes.

**Step 7** Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the reinitialization.

The reinitialization begins. After the software is downloaded and activated, and the database is uploaded to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. Wait a few minutes for the reboot to complete.

**Step 8** After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-25.

**Step 9** Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 and the “NTP-G26 Set Up CTC Network Access” procedure on page 3-11.

**Step 10** Return to your originating procedure (NTP).

---

### Purpose
This task reinitializes the ONS 15454 using the CTC reinitialization tool on a UNIX computer. Reinitialization uploads a new software package to the TCC2/TCC2P cards, clears the node database, and restores the factory default parameters.

### Tools/Equipment
ONS 15454 SONET System Software CD, Version 5.0.x
JRE 1.4.2 must be installed on the computer to log into the node at the completion of the reinitialization. The reinitialization tool can run on JRE 1.3.1_02 or JRE 1.4.2.

### Prerequisite Procedures
NTP-G103 Back Up the Database, page 13-2
NTP-G17 Set Up Computer for CTC, page 2-2

One of the following:
- NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9, or
- NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-21

### Required/As Needed
As needed to clear the existing database from a TCC2/TCC2P and restore the node default settings.

### Onsite/Remote
Onsite

### Security Level
Superuser

⚠️ **Caution** Restoring a node to the factory configuration deletes all cross-connects on the node.
Step 1 Insert the system software CD containing the reinitialization tool, software, and defaults database into the computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually /cdrom/cdrom0/CISCO15454 or /cdrom/cdrom0/CISCO15454SDH).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file. If you are working with a command line, run java -jar RE-INIT.jar. The NE Re-Initialization window appears (Figure 13-2).

Step 4 Complete the following fields:
- GNE IP—If the node you are reinitializing is accessed through another node configured as a GNE, enter the GNE IP address. If you have a direct connection to the node, leave this field blank.
- Node IP—Enter the node name or IP address of the node that you are reinitializing.
- User ID—Enter the user ID needed to access the node.
- Password—Enter the password for the user ID.
- Upload Package—Check this box to send the software package file to the node. If unchecked, the software stored on the node is not modified.
- Force Upload—Check this box to send the software package file to the node even if the node is running the same software version. If unchecked, reinitialization will not send the software package if the node is already running the same version.
- Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the installed version) or revert to the uploaded software (if the software is earlier than the installed version) as soon as the software file is uploaded. If unchecked, the software is not activated or reverted after the upload, allowing you to initiate the functions later from the node view Maintenance > Software tab.
- Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC database restore operation.) If unchecked, the node database is not modified.
- Confirm—Check this box if you want a warning message displayed before any operation is performed. If unchecked, reinitialization does not display a warning message.
- Search Path—Enter the path to the CISCO15454 or CISCO15454SDH folder on the CD drive.

Step 5 Click Go.

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse the upload process after you click Yes.

Step 6 Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the reinitialization.

The reinitialization begins. After the software is downloaded and activated and the database is uploaded to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. Wait a few minutes for the reboot to complete.

Step 7 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-25.

Step 8 Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8 and the “NTP-G26 Set Up CTC Network Access” procedure on page 3-11.

Step 9 Return to your originating procedure (NTP).
NTP-G133 View and Manage OSI Information

Purpose

This procedure allows you to view and manage Open Systems Interconnection (OSI) including the End System to Intermediate System (ES-IS) and Intermediate System to Intermediate System (IS-IS) routing information tables, the Target Identifier Address Resolution Protocol (TARP) data cache, and the manual area table.

Tools/Equipment

None

Prerequisite Procedures

NTP-G103 Back Up the Database, page 13-2
NTP-G17 Set Up Computer for CTC, page 2-2
NTP-G132 Provision OSI, page 3-25

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

Additional information about the ONS 15454 implementation of OSI is provided in the Management Connectivity Reference chapter.

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with Step 2.

Step 2

Perform any of the following tasks as needed:

- DLP-G298 View IS-IS Routing Information Base, page 13-9
- DLP-G299 View ES-IS Routing Information Base, page 13-10
- DLP-G300 Manage the TARP Data Cache, page 13-11

Stop. You have completed this procedure.

DLP-G298 View IS-IS Routing Information Base

Purpose

This task allows you to view the IS-IS protocol routing information base (RIB). IS-IS is an OSI routing protocol that floods the network with information about NEs on the network. Each NE uses the information to build a complete and consistent picture of a network topology. The IS-IS RIB shows the network view from the perspective of the IS node.

Tools/Equipment

None

Prerequisite procedures

DLP-G46 Log into CTC, page 2-25

Required/As needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

In node view, click the Maintenance > OSI > IS-IS RIB tabs.
Step 2  View the following RIB information for Router 1:
- Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.
- Location—Indicates the OSI subnetwork point of attachment. For data communications channel (DCC) subnets, the slot and port are displayed. LAN subnets are shown as LAN.
- Destination Address—The destination Network Service Access Point (NSAP) of the IS.
- MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3  If additional routers are enabled, you can view their RIBs by choosing the router number in the Router field and clicking Refresh.

Step 4  Return to your originating procedure (NTP).

---

**DLP-G299 View ES-IS Routing Information Base**

**Purpose**
This task allows you to view the ES-IS protocol RIB. ES-IS is an OSI protocol that defines how end systems (hosts) and intermediate systems (routers) learn about each other. For ESs, the ES-IS RIB shows the network view from the perspective of the ES node. For ISs, the ES-IS RIB shows the network view from the perspective of the IS node.

**Tools/Equipment**
None

**Prerequisite procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

Step 1  In node view, click the Maintenance > OSI > ES-IS RIB tabs.

Step 2  View the following RIB information for Router 1:
- Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.
- Location—Indicates the subnet interface. For DCC subnets, the slot and port are displayed. LAN subnets are shown as LAN.
- Destination Address—The destination IS NSAP.
- MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3  If additional routers are enabled, you can view their RIBs by choosing the router number in the Router field and clicking Refresh.

Step 4  Return to your originating procedure (NTP).
DLP-G300 Manage the TARP Data Cache

**Purpose**
This task allows you to view and manage the TARP data cache (TDC). The TDC facilitates TARP processing by storing a list of TID to NSAP mappings.

**Tools/Equipment**
None

**Prerequisite procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

---

**Step 1**
In node view, click the **Maintenance > OSI > TDC** tabs.

**Step 2**
View the following TARP data cache information:
- **TID**—The target identifier of the originating NE. For ONS 15454s, the TID is the name entered in the Node Name/TID field on the Provisioning > General tab.
- **NSAP/NET**—The NSAP or Network Element Title (NET) of the originating NE.
- **Type**—Indicates how the TDC entry was created:
  - Dynamic—The entry was created through the TARP propagation process.
  - Static—The entry was manually created and is a static entry.

**Step 3**
If you want to query the network for an NSAP that matches a TID, complete the following steps. Otherwise, continue with **Step 4**.

**Note**
The TID to NSAP function is not available if the TDC is not enabled on the Provisioning > OSI > TARP subtab.

a. Click the **TID to NSAP** button.
b. In the TID to NSAP dialog box, enter the TID you want to map to an NSAP.
c. Click **OK**, then click **OK** in the information message box.
d. On the TDC tab, click **Refresh**.
   - If TARP finds the TID in its TDC, it returns the matching NSAP. If not, TARP sends protocol data units (PDUs) across the network. Replies will return to the TDC later, and a check TDC later message is displayed.

**Step 4**
If you want to delete all the dynamically generated TDC entries, click the **Flush Dynamic Entries** button. If not, continue with **Step 5**.

**Step 5**
Return to your originating procedure (NTP).
NTP-G106 Reset Cards Using CTC

Purpose
This procedure resets the TCC2/TCC2P and DWDM cards using CTC.

Tools/Equipment
None

Prerequisite Procedures
DLP-G33 Install the TCC2 or TCC2P Card, page 1-72

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you are performing the TCC2/TCC2P reset. If you are already logged in, continue with Step 2.

Step 2
As needed, complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 13-12.

Step 3
As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 13-13.

Stop. You have completed this procedure.

DLP-G250 Reset the TCC2/TCC2P Card

Purpose
This task resets the TCC2/TCC2P card and switches the node to the redundant TCC2/TCC2P.

Tools/Equipment
None

Prerequisite Procedures
DLP-G33 Install the TCC2 or TCC2P Card, page 1-72
DLP-G46 Log into CTC, page 2-25

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

⚠️ Warning
Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed circuitry could constitute an energy hazard. Statement 206

⚠️ Note
Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change you made to avoid losing any changes to the database.

⚠️ Note
When a software reset is performed on an active TCC2/TCC2P, the AIC-I card goes through an initialization process and also resets. The AIC-I card reset is normal and happens each time an active TCC2/TCC2P card goes through a software-initiated reset.
Step 1  Click the **Alarms** tab.

   a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-28 as necessary.

   b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve them before continuing. Refer to the *Cisco ONS 15454 Troubleshooting Guide* or the *Cisco ONS 15454 SDH Troubleshooting Guide* for procedures.

Step 2  In node view, right-click the TCC2/TCC2P card to reveal a shortcut menu.

Step 3  Click **Reset Card**.

Step 4  Click **Yes** when the confirmation dialog box appears.

Step 5  Click **OK** when the “Lost connection to node, changing to Network View” dialog box appears.

---

**Note**  For LED behavior during a TCC2/TCC2P reboot, see Table 3-2 on page 3-14.

Step 6  Confirm that the TCC2/TCC2P card LED is amber (standby).

Step 7  Return to your originating procedure (NTP).

---

### DLP-G251 Reset DWDM Cards Using CTC

**Purpose**  This task resets the OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 32DMX, 32WSS, OPT-BST, OPT-PRE, AD-xC.xx.x, AD-xB.xx.x, transponder (TXP), and muxponder (MXP) cards using CTC.

**Tools/Equipment**  None

**Prerequisite Procedures**  
- NTP-G30 Install the DWDM Cards, page 3-39
- NTP-G32 Install the Transponder and Muxponder Cards, page 3-43
- DLP-G46 Log into CTC, page 2-25

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite or remote

**Security Level**  Superuser

---

**Warning**  Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed circuitry could constitute an energy hazard. Statement 206

**Note**  ONS 15454 cards normally do not need to be reset. However, you might occasionally need to reset a card for testing or as an initial trouble-clearing step. For additional information, see the *Cisco ONS 15454 Troubleshooting Guide* or *Cisco ONS 15454 SDH Troubleshooting Guide*.

---

**Step 1**  If you will switch an active TXP or MXP card that is in a Y-cable protection group, complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35. If not, continue with Step 2.
**Step 2** Right-click the card that you want to reset to reveal a shortcut menu.

**Step 3** Click **Reset Card**.

**Step 4** Click **Yes** when the confirmation dialog box appears.

The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

**Step 5** If you performed a Y-cable protection group switch in **Step 1**, complete the “**DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch**” task on page 10-36. If not, continue with **Step 6**.

**Step 6** Return to your originating procedure (NTP).

---

### NTP-G108 Viewing the Audit Trail Records

**Purpose**
This procedure explains how to view audit trail records. Audit trail records are useful for maintaining security, recovering lost transactions, and enforcing accountability. Accountability refers to tracing user activities; that is, associating a process or action with a specific user.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Provisioning or higher

**Step 1** Complete the “**DLP-G46 Log into CTC**” task on page 2-25 at the node where you want to view the audit trail log. If you are already logged in, continue with **Step 2**.

**Step 2** In node view, click the **Maintenance > Audit** tabs.

**Step 3** Click **Retrieve**.

A window containing the most recent audit trail records appears as shown in **Figure 13-3**.
A definition of each column in the audit trail log is listed in Table 13-1.

### Table 13-1 Audit Trail Column Definitions

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date when the action occurred in the format MM/dd/yy HH:mm:ss</td>
</tr>
<tr>
<td>Num</td>
<td>Incrementing count of actions</td>
</tr>
<tr>
<td>User</td>
<td>User ID that initiated the action</td>
</tr>
<tr>
<td>P/F</td>
<td>Pass/Fail (that is, whether or not the action was executed)</td>
</tr>
<tr>
<td>Operation</td>
<td>Action that was taken</td>
</tr>
</tbody>
</table>

Right-click the column headings to display the list in ascending-to-descending or descending-to-ascending order.

Left-click the column heading to display the following options:
- Reset Sorting—Resets the column to the default setting.
- Hide Column—Hides the column from view.
- Reset Columns Order/Visibility—Displays all hidden columns.
- Row Count—Provides a numerical count of log entries.

Shift-click the column heading for an incremental sort of the list.

Stop. You have completed this procedure.
NTP-G109 Off-Load the Audit Trail Record

Purpose
This procedure describes how to off-load up to 640 audit trail log entries in a local or network drive file to maintain a record of actions performed for the node. If the audit trail log is not off-loaded, the oldest entries are overwritten after the log reaches capacity.

Tools/Equipment
None

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Provisioning or higher

---

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to off-load the audit trail log. If you are already logged in, continue with Step 2.

Step 2
In node view, click the Maintenance > Audit tabs.

Step 3
Click Retrieve.

Step 4
Click Archive.

Step 5
In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to save the file.

Step 6
Enter a name in the File Name field.

You do not have to give the archive file a particular extension. It is readable in any application that supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7
Click Save. Click OK.

The 640 entries are saved in this file. The next entries continue with the next number in the sequence, rather than starting over.

---

Note
Archiving does not delete entries from the CTC audit trail log. However, entries can be self-deleted by the system after the log maximum is reached. If you archived the entries, you cannot reimport the log file back into CTC and will have to view the log in a different application.

Stop. You have completed this procedure.
NTP-G110 Off-Load the Diagnostics File

Purpose
This procedure describes how to off-load a diagnostic file. The diagnostic file contains a set of debug commands that were run on a node and their results. This file is useful to the Cisco Technical Assistance Center (TAC) when troubleshooting problems with the node.

Tools/Equipment
None

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Maintenance or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to off-load the diagnostics file. If you are already logged in, continue with Step 2.

Step 2
In node view, click the Maintenance > Diagnostic tabs.

Step 3
Click Retrieve Tech Support Log.

Step 4
In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to save the file.

Step 5
Enter a name in the File Name field.
You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be unzipped and read by Cisco Technical Support.

Step 6
Click Save.
The Get Diagnostics status window shows a progress bar indicating the percentage of the file being saved, then shows “Get Diagnostics Complete.”

Step 7
Click OK.
Stop. You have completed this procedure.

NTP-G112 Change the Node Timing Reference

Purpose
This procedure enables automatic timing reference switching or returns the node timing to normal operation.

Tools/Equipment
None

Prerequisite Procedures
NTP-G53 Set Up Timing, page 6-4

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Maintenance or higher

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to enable timing switching. If you are already logged in, continue with Step 2.
Chapter 13      Maintain the Node

Step 2 Complete the “DLP-G259 Manual or Force Switch the Node Timing Reference” task on page 13-18 as needed.

Step 3 Complete the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on page 13-19 as needed.

Stop. You have completed this procedure.

DLP-G259 Manual or Force Switch the Node Timing Reference

Purpose This task commands the node to switch to the timing reference you have selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Step 1 In node view, click the Maintenance > Timing > Source tabs.

Step 2 From the Reference drop-down list for the desired Clock, choose the desired reference.

Step 3 From the Operation drop-down list for the desired Clock, choose one of the following options:

- **Manual**—This operation commands the node to switch to the reference you have selected if the synchronization status message (SSM) quality of the reference is not lower than the current timing reference.

- **Force**—This operation commands the node to switch to the reference you have selected, regardless of the SSM quality (if the reference is valid).

Note For information about the Clear option, see the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on page 13-19.

Step 4 Click Apply next to the timing source.

Step 5 Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid reference, the node switches to the selected timing reference. If the selected timing reference is invalid, a warning dialog box appears. Click OK; the node will not switch to the new timing reference.

Step 6 Return to your originating procedure (NTP).
DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference

**Purpose**
This task clears a Manual or Force switch on a node timing reference and reverts the timing reference to its provisioned reference.

**Tools/Equipment**
None

**Prerequisite Procedures**
DLP-G46 Log into CTC, page 2-25

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Step 1**
In node view, click the **Maintenance > Timing > Source** tabs.

**Step 2**
Find the Clock reference that is currently set to Manual or Force in the Operation drop-down list.

**Step 3**
From the Operation drop-down list, choose **Clear**.

**Step 4**
Click **Apply**.

**Step 5**
Click **Yes** in the confirmation dialog box. If the normal timing reference is an acceptable valid reference, the node switches back to the normal timing reference as defined by the system configuration. If the normal timing reference is invalid or has failed, a warning dialog box appears. Click **OK**; the timing reference will not revert.

**Step 6**
Return to your originating procedure (NTP).

---

NTP-G113 View the ONS 15454 Timing Report

**Purpose**
This procedure displays the current status of the ONS 15454 timing references.

**Tools/Equipment**
None

**Prerequisite Procedures**
NTP-G53 Set Up Timing, page 6-4

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite or remote

**Security Level**
Maintenance or higher

---

**Step 1**
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to view the node timing status. If you are already logged in, continue with **Step 2**.

**Step 2**
Click the **Maintenance > Timing > Report** tabs.

**Step 3**
In the Timing Report area, you can view node timing information. The date and time of the report appear at the top of the report. The time stamp is the same as the alarms time stamp and can be configured using the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-11. Table 13-2 describes the report fields and entries.

**Step 4**
To update the report, click **Refresh**.
### Table 13-2  ONS 15454 Timing Report

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Option</th>
<th>Option Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock</td>
<td>Indicates the timing clock. The report section that follows applies to the timing clock indicated.</td>
<td>NE</td>
<td>The node timing clock.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BITS-1 Out</td>
<td>The BITS-1 Out timing clock.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BITS-2 Out</td>
<td>The BITS-2 Out timing clock.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the status of the timing clock.</td>
<td>INIT_STATE</td>
<td>The timing reference has not been provisioned. For an NE reference, this status appears just before the first provisioning messages when the TCC2/TCC2P card is booting. Timing is provisioned to the internal clock of the node.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HOLDOVER_STATE</td>
<td>The clock was locked onto a valid timing reference for more than 140 seconds when a failure occurred. Holdover state timing is a computation based on timing during normal state combined with the node’s internal clock. The node holds onto this frequency until the valid reference is restored. This status appears for NE references only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREERUN_STATE</td>
<td>The node is running off its internal clock without any modification except the calibrated value to bring timing to 0 PPM. Freerun state can occur when a Force switch to the Internal clock is initiated, when all references fail without the 140 seconds of holdover data, or when only Internal timing references are defined. This status appears for NE references only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO_SYNC_STATE</td>
<td>A synchronization timing reference is not defined. BITS-1 Out or BITS-2 Out default to this status until an OC-N/STM-N card is defined as its reference on the Provisioning &gt; Timing tab. This status appears for external references only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NE_SYNCH_STATE</td>
<td>BITS-1 Out and BITS-2 Out use the same timing source as the NE. This is displayed when NE Reference is selected in the BITS-1 Out and BITS-2 Out Reference List on the Provisioning &gt; Timing tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NORMAL_STATE</td>
<td>The timing reference is locked onto one of its provisioned references. The reference cannot be Internal or NO SYNC STATE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FAST_START_STATE</td>
<td>The node has switched references, but the reference is too far away to reach NORMAL_STATE within an acceptable amount of time. FAST_START_STATE is a fast acquisition mode to allow the node to quickly acquire the reference. After it achieves this goal, the node progresses to the normal state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FAST_START_FAILED_STATE</td>
<td>A timing reference is too far away to reach in normal state. The FAST_START_STATE could not acquire sufficient timing information within the allowable amount of time.</td>
</tr>
</tbody>
</table>
### Table 13-2 ONS 15454 Timing Report (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Option</th>
<th>Option Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Changed At</td>
<td>Date and time of the last status change.</td>
<td>AUTOMATIC</td>
<td>The timing switch was system-generated.</td>
</tr>
<tr>
<td>Switch Type</td>
<td>Type of switch.</td>
<td>Manual</td>
<td>The timing switch was a user-initiated Manual switch.</td>
</tr>
<tr>
<td>Reference</td>
<td>Indicates the timing reference.</td>
<td>Force</td>
<td>The timing switch was user-initiated Force switch.</td>
</tr>
<tr>
<td>Selected</td>
<td>Indicates whether the reference is selected.</td>
<td>Selected</td>
<td>Selected references are indicated with an X.</td>
</tr>
<tr>
<td>Facility</td>
<td>Indicates the timing facility provisioned for the reference on the Provisioning &gt; Timing tab.</td>
<td>BITS-1</td>
<td>The timing facility is a building integrated timing supply (BITS) clock attached to the node’s BITS-1 pins.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BITS-2</td>
<td>The timing facility is a BITS clock attached to the node’s BITS-2 pins.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OC-N/STM-N card with port number</td>
<td>If the node is set to line timing, this is the OC-N/STM-N card and port provisioned as the timing reference.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Internal clock</td>
<td>The node is using its internal clock.</td>
</tr>
<tr>
<td>State</td>
<td>Indicates the timing reference state.</td>
<td>IS</td>
<td>The timing reference is in service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS</td>
<td>The timing reference is out of service.</td>
</tr>
<tr>
<td>Condition</td>
<td>Indicates the timing reference state.</td>
<td>OKAY</td>
<td>The reference is valid to use as a timing reference.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOB</td>
<td>Out of bounds; the reference is not valid and cannot be used as a timing reference, for example, a BITS clock is disconnected.</td>
</tr>
<tr>
<td>Condition Changed</td>
<td>Indicates the date and time of the last status change in MM/DD/YY HH:MM:SS format.</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>SSM</td>
<td>Indicates whether SSM is enabled for the timing reference.</td>
<td>Enabled</td>
<td>SSM is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled</td>
<td>SSM is not enabled.</td>
</tr>
</tbody>
</table>
NTP-G114 Inspect, Clean, and Replace the Air Filter

**Purpose**
This procedure ensures that the air filter is free from dirt and dust, which allows optimum air flow and prevents dirt and dust from entering the shelf.

**Tools/Equipment**
- Vacuum or detergent and water faucet
- Spare filter
- Pinned hex key tool

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
None

---

**Warning**
Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed circuitry could constitute an energy hazard. Statement 206

---

**Caution**
Cisco recommends that you inspect the air filter monthly, and clean the filter every three to six months. Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or solvents.

---

**Note**
Although the filter can work if it is installed with either side facing up, Cisco recommends that you install it with the metal bracing facing up to preserve the surface of the filter.

---

**Step 1**
Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell, polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later versions of the ONS 15454 use a reusable air filter.
Step 2  If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being careful not to dislodge any dust that might have collected on the filter and proceed to Step 9. Figure 13-4 shows the reusable fan-tray air filter in an external filter bracket on an ANSI shelf. Figure 13-5 shows the reusable fan-tray air filter in an external filter bracket on an ETSI shelf.

Step 3  If the filter is installed below the fan tray and not in the external filter brackets, open the front door of the shelf assembly. If the front door is already open, proceed to Step 4.

a.  Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key counterclockwise to unlock the door and clockwise to lock it.

b.  Press the door button to release the latch.

c.  Swing the door open.

Step 4  (Optional) Remove the front door. If you do not want to remove the door or it is already removed, proceed to Step 5.

a.  Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b.  Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c.  Secure the dangling end of the ground strap to the door or chassis with tape.
Figure 13-5  ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Step 5  Push the outer side of the handles on the fan-tray assembly to expose the handles.
Step 6  Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait until the fans stop.
Step 7  When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.
Step 8  Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that might have collected on the filter.
Step 9  Visually inspect the air filter material for dirt and dust.
Step 10 If the reusable air filter contains a concentration of dirt and dust, replace the dirty air filter with a clean air filter (spare filters should be kept in stock) and reinsert the fan-tray assembly. Then, vacuum the dirty air filter or wash it under a faucet with a light detergent.

Caution  Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can damage the ONS 15454 cards.

Note  Cleaning should take place outside of the operating environment to avoid releasing dirt and dust near the equipment.

Step 11 If you washed the filter, allow it to completely air dry for at least eight hours.

Caution  Do not put a damp filter back in the ONS 15454.
Step 12  Replace the clean filter:
   a. If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back
      of the brackets to complete the procedure, continue to step 16.
   b. If the filter is installed below the fan-tray assembly, remove the fan-tray assembly and slide the
      dry/clean air filter into the recessed compartment at the bottom of the shelf assembly. Put the front
      edge of the air filter flush against the front edge of the recessed compartment. Push the fan tray back
      into the shelf assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly
inserted.

Step 13  To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Step 14  Rotate the retractable handles back into their compartments.

Step 15  If you replace the door, also reattach the ground strap.

Step 16  Close and lock the door.

Stop. You have completed this procedure.

---

NTP-G115 Clean Fiber Connectors

Purpose This procedure cleans the fiber connectors.
Tools/Equipment Inspection microscope
          Compressed air/duster
          Type A Fiber Optic Connector Cleaner (CLETOP reel)
          Isopropyl alcohol 70 percent or higher
          Optical swab
          Optical receiver cleaning stick

Prerequisite Procedures None
Required/As Needed Required
Onsite/Remote Onsite
Security Level None

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056
Chapter 13      Maintain the Node

DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes

Step 1  Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2  Replace any damaged fiber connectors.

Note  Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3  Complete the “DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes” task on page 13-26 as necessary.

Step 4  Complete the “DLP-G262 Clean Fiber Connectors with CLETOP” task on page 13-27 as necessary.

Step 5  Complete the “DLP-G263 Clean the Fiber Adapters” task on page 13-27 as necessary.

Stop. You have completed this procedure.

DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes

Purpose  This task cleans the fiber connectors and adapters with alcohol and dry wipes.

Tools/Equipment
- Compressed air/duster
- Isopropyl alcohol 70 percent or higher
- Optical swab
- Optical receiver cleaning stick

Prerequisite Procedures  None

Required/As Needed  Required

Onsite/Remote  Onsite

Security Level  None

Warning  Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do not view directly with optical instruments. Viewing the laser output with certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye hazard. Statement 1056

Step 1  Remove the dust cap from the fiber connector.

Step 2  Wipe the connector tip with the premoistened alcohol wipe.

Step 3  Blow-dry using filtered air.

Step 4  Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the connector is not clean, repeat Steps 1 to 3.

Step 5  Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap using a CLETOP stick swab (14100400).
**Step 6**  
Return to your originating procedure (NTP).

---

**DLP-G262 Clean Fiber Connectors with CLETOP**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task cleans the fiber connectors with CLETOP.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>Type A Fiber Optic Connector Cleaner (CLETOP reel)</td>
</tr>
<tr>
<td></td>
<td>Optical receiver cleaning stick</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>None</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>Required</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite</td>
</tr>
<tr>
<td>Security Level</td>
<td>None</td>
</tr>
</tbody>
</table>

**Step 1**  
Remove the dust cap from the fiber connector.

**Step 2**  
Press the lever down to open the shutter door. Each time you press the lever, you expose a clean wiping surface.

**Step 3**  
Insert the connector into the CLETOP cleaning cassette slot, rotate one quarter turn, and gently swipe downwards.

**Step 4**  
Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the connector is not clean, repeat Steps 1 to 3.

**Step 5**  
Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

**Note**  
If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap using a CLETOP stick swab (14100400).

**Step 6**  
Return to your originating procedure (NTP).

---

**DLP-G263 Clean the Fiber Adapters**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This task cleans the fiber adapters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>CLETOP stick swab</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>None</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>Required</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite</td>
</tr>
<tr>
<td>Security Level</td>
<td>None</td>
</tr>
</tbody>
</table>

**Step 1**  
Remove the dust plug from the fiber adapter.

**Step 2**  
Insert a CLETOP stick swab (14100400) into the adapter opening and rotate the swab.
**NTP-G40 Replace the Front Door**

**Purpose**
This procedure replaces the front door and door ground strap after installing cards and fiber-optic cables.

**Tools/Equipment**
- #2 Phillips screwdriver
- Medium slot-head screwdriver
- Small slot-head screwdriver

**Prerequisite Procedures**
NTP-G3 Open and Remove the Front Door, page 1-20

**Required/As Needed**
- Required
- Onsite
- Security Level: None

**Note**
Be careful not to crimp any fiber cables that are connected to the MXP/TPX cards or DWDM cards. Some might not have the fiber boot attached.

**Step 1**
Insert the front door into the hinges on the shelf assembly.

**Step 2**
Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside of the door. Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench (Figure 13-6).
Step 3  Attach the other end of the ground strap to the longer screw on the fiber guide.
   a. Attach the lock washer.
   b. Attach the terminal lug.
   c. Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug.

Note  To avoid interference with the traffic (line) card, make sure the ground strap is in a flat position when the door is open. To move the ground strap into a flat position, rotate the terminal lug counterclockwise before tightening the Kepnut.

Step 4  Replace the left cable-routing channel.

Step 5  Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.

Figure 13-7 shows the shelf assembly with the front door and ground strap installed.
Step 6 Swing the door closed.

Note The ONS 15454 comes with a pinned hex key tool for locking and unlocking the front door. Turn the key counterclockwise to unlock the door and clockwise to lock it.

Stop. You have completed this procedure.
NTP-G116 Replace the Fan-Tray Assembly

Purpose
This procedure replaces a malfunctioning fan-tray assembly.

Tools/Equipment
None

Prerequisite Procedures
NTP-G8 Install the Fan-Tray Assembly

Required/As Needed
As needed

Onsite/Remote
Onsite

Security Level
None

Caution
The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly includes a pin that prevents it from being installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1 (15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution
Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or the connectors on the backplane.

Note
To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.

Step 1
Review Table 13-3 (ANSI) or Table 13-4 (ETSI) to ensure that you have compatible components when replacing the fan-tray assembly. Note the alarms that will be generated when an incompatibility occurs.

Note
If you need to determine the hardware that has been installed on a node, click the Inventory tab in node view.

---

### Table 13-3 Incompatibility Alarms for ONS 15454 ANSI

<table>
<thead>
<tr>
<th>Shelf Assembly</th>
<th>Fan Tray</th>
<th>AIP</th>
<th>10G Cards</th>
<th>Ethernet Cards</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>—</td>
<td>No fuse</td>
<td>—</td>
<td>—</td>
<td>Mismatch of equipment attributes (MEA) on the alarm interface panel (AIP)</td>
</tr>
<tr>
<td>NEBS3E or NEBS3</td>
<td>2A</td>
<td>2A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>NEBS3E or NEBS3</td>
<td>2A</td>
<td>2A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on 10G</td>
</tr>
<tr>
<td>NEBS3E or NEBS3</td>
<td>2A</td>
<td>5A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>NEBS3E or NEBS3</td>
<td>2A</td>
<td>5A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on 10G</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>2A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>2A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on fan tray, AIP, and Ethernet</td>
</tr>
</tbody>
</table>
NTP-G116 Replace the Fan-Tray Assembly

Table 13-3  Incompatibility Alarms for ONS 15454 ANSI (continued)

<table>
<thead>
<tr>
<th>Shelf Assembly1</th>
<th>Fan Tray2</th>
<th>AIP3</th>
<th>10G Cards4</th>
<th>Ethernet Cards5</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>2A</td>
<td>Yes</td>
<td>10G compatible</td>
<td>MEA on fan tray and AIP</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>5A</td>
<td>No</td>
<td>Either</td>
<td>None</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>5A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on fan tray and Ethernet</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>2A</td>
<td>5A</td>
<td>Yes</td>
<td>10G compatible</td>
<td>MEA on fan tray</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>5A</td>
<td>2A</td>
<td>No</td>
<td>Either</td>
<td>MEA on AIP</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>5A</td>
<td>2A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on AIP and Ethernet</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>5A</td>
<td>2A</td>
<td>Yes</td>
<td>10G compatible</td>
<td>MEA on AIP</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>5A</td>
<td>5A</td>
<td>No</td>
<td>Either</td>
<td>None</td>
</tr>
<tr>
<td>ANSI or HD</td>
<td>5A</td>
<td>5A</td>
<td>Yes</td>
<td>Either</td>
<td>None</td>
</tr>
</tbody>
</table>

1. 15454-SA-NEBS3E (P/N: 800-07149-xx) or 15454-SA-NEBS3 (P/N: 800-06741-xx) = shelf assemblies released before ONS 15454 Release 3.1
15454-SA-ANSI (P/N: 800-19857-01) = ONS 15454 Release 3.1 and later shelf assembly
15454-SA-HD (P/N: 800-24848) = ONS 15454 Release 3.1 and later shelf assembly

2. 5A Fan Tray = 15454-FTA3 (P/N: 800-19858-xx) or 15454-FTA3-T (P/N: 800-21448-xx)
2A Fan Tray = 15454-FTA2 (P/Ns: 800-07145-xx, 800-07385-xx, 800-19591-xx, 800-19590-xx)

3. 10G cards include the XC10G, OC192, and OC48AS.

4. 2.5G compatible indicates cards that are compatible with the XCVT cross-connect card. 10G compatible indicates cards that are compatible with the XC10G and XC-VXC-10G cross-connect cards.

Table 13-4  Incompatibility Alarms for ONS 15454 ETSI

<table>
<thead>
<tr>
<th>Shelf Assembly1</th>
<th>Fan Tray2</th>
<th>10G Cards3</th>
<th>Ethernet Cards</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454E-SA-ETSI</td>
<td>2A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on 10G</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>2A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on 10G</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>5A</td>
<td>No</td>
<td>—</td>
<td>MEA on fan tray</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>5A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on fan tray and 10G cards</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>5A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>15454E-SA-ETSI</td>
<td>5A</td>
<td>Yes</td>
<td>—</td>
<td>MEA on 10G</td>
</tr>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>No</td>
<td>—</td>
<td>None</td>
</tr>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on fan tray or Ethernet</td>
</tr>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>10G compatible</td>
<td>MEA on fan tray</td>
</tr>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>No</td>
<td>Either</td>
<td>None</td>
</tr>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on fan tray, Ethernet</td>
</tr>
</tbody>
</table>
Step 2
Open the front door of the shelf assembly. If the shelf assembly does not have a front door, continue with Step 4.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key counterclockwise to unlock the door and clockwise to lock it.

b. Press the door button to release the latch.

c. Swing the door open.

Step 3
(Optional) Remove the front door. If you do not want to remove the door, proceed to Step 4.

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step 4
Push the outer side of the handles on the fan-tray assembly to expose the handles.

Step 5
Fold out the retractable handles at the outside edges of the fan tray.

Step 6
Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait until the fans stop.

Step 7
When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly. Figure 13-8 shows the location of the fan tray on the ONS 15454 ANSI shelf.

---

**Table 13-4 Incompatibility Alarms for ONS 15454 ETSI (continued)**

<table>
<thead>
<tr>
<th>Shelf Assembly</th>
<th>Fan Tray</th>
<th>10G Cards</th>
<th>Ethernet Cards</th>
<th>Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETSI</td>
<td>2A</td>
<td>Yes</td>
<td>10G compatible</td>
<td>MEA on fan tray</td>
</tr>
<tr>
<td>ETSI</td>
<td>5A</td>
<td>Yes</td>
<td>2.5G compatible</td>
<td>MEA on Ethernet</td>
</tr>
<tr>
<td>ETSI</td>
<td>5A</td>
<td>No</td>
<td>Either</td>
<td>None</td>
</tr>
<tr>
<td>ETSI</td>
<td>5A</td>
<td>Yes</td>
<td>Either</td>
<td>None</td>
</tr>
</tbody>
</table>

1. 15454-SA-ETSI (P/N: 800-08708-XX) = ONS 15454 SDH Release 3.3 and later shelf assembly
2. 5A Fan Tray = 15454E-FTA-60V
   2A Fan Tray = 15454E-FTA-48V
3. 10G cards = XC10G, XC-VXL-10G, XC-VXC-10G
Figure 13-8  Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)
Step 8 If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket (ANSI shelf only), you can slide the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray air filter, see the “NTP-G114 Inspect, Clean, and Replace the Air Filter” procedure on page 13-22.

Step 9 Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into the corresponding receptacle on the backplane.

Step 10 To verify that the tray has plugged into the backplane, ensure that the LCD on the front of the fan tray is activated.

Step 11 If you replace the door on an ANSI shelf, be sure to reattach the ground strap.

Stop. You have completed this procedure.
NTP-G117 Replace the ANSI Shelf Alarm Interface Panel

<table>
<thead>
<tr>
<th>Purpose</th>
<th>This procedure replaces the AIP on the ONS 15454 ANSI shelf assembly.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools/Equipment</td>
<td>#2 Phillips screwdriver</td>
</tr>
<tr>
<td>Prerequisite Procedures</td>
<td>None</td>
</tr>
<tr>
<td>Required/As Needed</td>
<td>As needed</td>
</tr>
<tr>
<td>Onsite/Remote</td>
<td>Onsite or remote</td>
</tr>
<tr>
<td>Security Level</td>
<td>Provisioning or higher</td>
</tr>
</tbody>
</table>

**Caution**
Do not use a 2A AIP with a 5A fan-tray assembly; doing so will cause a blown fuse on the AIP.

**Caution**
Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

**Caution**
Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and result in a loss of data. For assistance with AIP replacement, contact the Cisco TAC. See the “Obtaining Technical Assistance” section on page lxxvi.

**Step 1**
Review Table 13-3 on page 13-31 to ensure that you have compatible components when replacing the fan-tray assembly and note the alarms that will occur when an incompatibility occurs.

**Step 2**
Ensure that all nodes in the affected network are running the same software version before replacing the AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade document. No hardware should be changed or circuit repair performed until after the software upgrade is complete. If you do not need to upgrade software or have completed the software upgrade, proceed to Step 3.

**Step 3**
Record the MAC address of the old AIP:

a. Log into the node where you will replace the AIP. See the “DLP-G46 Log into CTC” task on page 2-25.

b. In node view, click the Provisioning > Network tabs.

c. Record the MAC address shown in the General tab (Figure 13-10).
Step 4  Call Cisco TAC for assistance in replacing the AIP and maintaining the original MAC address. See the “Obtaining Technical Assistance” section on page lxxvi.

Step 5  Unscrew the five screws that hold the lower backplane cover in place (Figure 13-11).

Step 6  Grip the lower backplane cover and gently pull it away from the backplane.

Step 7  Unscrew the two screws that hold the AIP cover in place.

Step 8  Grip the cover and gently pull away from the backplane.

Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI shelf (P/N: 800-19857), the AIP cover is metal.
NTP-G117 Replace the ANSI Shelf Alarm Interface Panel

Step 9  
Grip the AIP and gently pull it away from the backplane.

Step 10  
Disconnect the fan-tray assembly power cable from the AIP.

Step 11  
Set the old AIP aside for return to Cisco.

Caution  
The type of shelf that the AIP resides in determines the version of AIP that should replace the failed AIP. The 15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP (P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149) shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution  
Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD (P/N: 800-24848) shelf; doing so will cause a blown fuse on the AIP.

Step 12  
Attach the fan-tray assembly power cable to the new AIP.

Step 13  
Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 14  
Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 15  
Replace the lower backplane cover and secure the cover with the five screws.

Step 16  
In node view, click the Provisioning > Network tabs.

Caution  
Cisco recommends that TCC2/TCC2P card resets be performed in a maintenance window to avoid any potential service disruptions.

Step 17  
Reset the standby TCC2/TCC2P card:
   a. Right-click the standby TCC2/TCC2P card and choose Reset Card.
   b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears on the card in CTC.

Note  
The reset takes approximately five minutes. Do not perform any other steps until the reset is complete.

Step 18  
Complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 13-12 to reset the active TCC2/TCC2P card.

Step 19  
From the File drop-down list, choose Exit to exit the CTC session.

Step 20  
Log back into the node. In the Login dialog box, choose (None) from the Additional Nodes drop-down list.

Step 21  
Record the new MAC address:
   a. In node view, click the Provisioning > Network tabs.
   b. Record the MAC address shown in the General tab.

Step 22  
In node view, click the Circuits tab. Note that all circuits listed have a status of PARTIAL.

Step 23  
In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box appears.
Step 24 Read the instructions in the Circuit Repair dialog box (Figure 13-12). If all the steps in the dialog box have been completed, click Next. Ensure that you have the old and new MAC addresses.

Figure 13-12 Repairing Circuits

Step 25 The Node MAC Addresses dialog box appears (Figure 13-13):

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 3.

c. Click Next.

Figure 13-13 Recording the Old MAC Address Before Replacing the AIP

Step 26 The Repair Circuits dialog box appears (Figure 13-14). Read the information in the dialog box and click Finish.
**Figure 13-14  Circuit Repair Information**

When the circuit repair is complete, the Circuits Repaired dialog box appears.

**Step 27**  Click **OK**.

**Step 28**  In node view of the new node, click the **Circuits** tab. Check to ensure that all circuits listed have a status of **DISCOVERED**. If all circuits listed are not **DISCOVERED**, call the Cisco TAC at (800) 553-2447 to open a Return Material Authorization (RMA).

**Stop. You have completed this procedure.**

---

**NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover**

**Purpose**  This procedure replaces the plastic cover located at the bottom rear of the ONS 15454 ANSI shelf.

**Tools/Equipment**  Phillips screwdriver

**Prerequisite Procedures**  None

**Required/As Needed**  As needed

**Onsite/Remote**  Onsite

**Security Level**  None

**Step 1**  Use the Phillips screwdriver to unscrew the five retaining screws that hold the metal cover in place.

**Step 2**  Grasp the metal cover on each side.

**Step 3**  Gently pull the metal cover away from the backplane.

**Step 4**  Place the plastic cover against the shelf assembly and align the screw holes on the cover and the shelf assembly (Figure 13-15).
Step 5  Tighten the five retaining screws that hold the plastic cover in place.

Stop. You have completed this procedure.
NTP-G135 Edit Network Element Defaults

Purpose

This procedure edits the factory-configured NE defaults using the NE Defaults editor. The new defaults can be applied to the node where they are edited, or exported to a file to be imported for use on other nodes.

Tools/Equipment

None

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Note

For a list of NE defaults, see Appendix D, “Network Element Defaults.”

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to edit NE defaults.

Step 2

Click the Provisioning > Defaults tabs.

Step 3

Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all available NE defaults (both node- and card-level) under Default Name.

Step 4

Locate a default that you want to change under Default Name.

Step 5

Click in the Default Value column for the default property that you are changing and either choose a value from the drop-down list (when available), or type in the desired new value.

Note

If you click Reset before you click Apply, all values will return to their original settings.

Step 6

Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You can modify multiple default values before applying the changes.

A pencil icon will appear next to any default value that will be changed as a result of editing the defaults file.

Step 7

If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully applied to the node. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will reboot and asks if you want to continue. Click Yes.

Note

Changes to most node defaults reprovision the node when you click Apply. Changes made to card settings using the Defaults Editor do not change the settings for cards that are already installed or slots that are preprovisioned for cards, but rather, change only cards that are installed or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder cards see Chapter 5, “Provision Transponder and Muxponder Cards.”
NTP-G136 Import Network Element Defaults

Purpose
This procedure imports the NE defaults using the NE Defaults editor. The defaults can either be imported from the CTC software CD (factory defaults) or from a customized file exported and saved from a node.

Tools/Equipment
None

Prerequisite Procedures
None

Required/As Needed
As needed

Onsite/Remote
Onsite or remote

Security Level
Superuser

Note
For a list of NE defaults, see Appendix D, “Network Element Defaults.”

Step 1
Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to import NE defaults.

Step 2
Click the Provisioning > Defaults tabs.

Step 3
Click Import.

Step 4
If the correct file name and location of the desired file do not appear in the Import Defaults from File dialog box, click Browse and browse to the file that you are importing.

Step 5
When the correct file name and location appear in the dialog box, click OK. If you are importing the factory defaults, the correct file name is 15454-defaults.txt for ANSI shelves and 15454SDH-defaults.txt for ETSI shelves. A pencil icon will appear next to any default value that will be changed as a result of importing the new defaults file.

Step 6
Click Apply.

Step 7
If the imported file fails to pass all edits, the problem field shows the first encountered problem default value that must be fixed. Change the problem default value and click Apply. Repeat until the imported file passes all edits successfully.

Step 8
If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully applied to the node. Click Yes.

Step 9
If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will reboot and asks if you want to continue. Click Yes.

Note
Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for the default to take effect. Before you change a default, view the Side Effects column of the Defaults editor (right-click a column header and select Show Column > Side Effects) and be prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.
**NTP-G137 Export Network Element Defaults**

**Purpose**

This procedure exports the NE defaults using the NE Defaults editor. The exported defaults can be imported to other nodes.

**Tools/Equipment**

None

**Prerequisite Procedures**

None

**Required/As Needed**

As needed

**Onsite/Remote**

Onsite or remote

**Security Level**

Superuser

**Note**

The defaults currently displayed are exported whether or not they have been applied to the current node.

**Note**

The NE defaults can also be exported from the File > Export menu. These exported defaults are for reference only and cannot be imported.

**Note**

For a list of NE defaults, see Appendix D, “Network Element Defaults.”

**Step 1**

Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to export NE defaults.

**Step 2**

Click the Provisioning > Defaults editor tabs.

**Step 3**

Click Export.

**Step 4**

If the location where you want to export the file does not appear in the Export Defaults to File dialog box, click Browse and browse to the location.

**Step 5**

Change the file name to something that is easy to remember (the file name has no extension).
Step 6  Click OK.

Stop. You have completed this procedure.
Power Down a Node

This chapter explains how to power down a node and stop all node activity on the Cisco ONS 15454 ANSI or ETSI.

NTP-G119 Power Down the Node

**Purpose**
This procedure stops all node activity.

**Tools/Equipment**
None

**Prerequisite Procedures**
None

**Required/As Needed**
As needed

**Onsite/Remote**
Onsite

**Security Level**
Provisioning or higher

---

**Warning**
Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed circuitry could constitute an energy hazard. Statement 206

---

**Caution**
The following procedure is designed to minimize traffic outages when powering down nodes, but traffic will be lost if you delete and recreate circuits that passed through a working node.

---

**Note**
Always use the supplied ESD wristband when working with the Cisco ONS 15454. Plug the wristband into the ESD jack located on the fan-tray assembly or on the lower right outside edge of the shelf on the NEBS 3 shelf assembly. To access the ESD plug on the NEBS 3 shelf assembly, open the front door of the Cisco ONS 15454. The front door is grounded to prevent electrical shock.

---

**Step 1**
Identify the node that you want to power down. If no cards are installed, go to Step 16. If cards are installed, log into the node. See the “DLP-G46 Log into CTC” task on page 2-25 for instructions.

**Step 2**
In node view, choose Go to Network View from the View menu.

**Step 3**
Verify that the node is not connected to a network.

a. If the node is part of a Software R4.7 or later dense wavelength division multiplexing (DWDM) configuration, see the “NTP-G130 Remove a DWDM Node” task on page 12-9 continue with Step 4.
b. If the node is not connected to a working network and the current configurations are no longer required, proceed to Step 4.

**Note** Before the power-down of a DWDM node, the fiber spans connected around it must be disconnected from the network. This is to prevent the accidental disconnection of wavelengths that pass through the shelf. A good indication that the shelf has been disconnected from the network is optical service channel (OSC) alarms, or no OSC channels provisioned.

**Note** Current configurations will be saved if Steps 4 to 16 are skipped.

**Step 4** In node view, click the **Circuits** tab and verify that no circuits appear, then proceed to Step 5. If circuits appear, delete all the circuits that originate or terminate in the node. Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 or the “DLP-G112 Delete Overhead Circuits” task on page 7-22 as needed.

**Note** When deleting circuits from a node, make sure that the node is not connected to any network.

**Step 5** In node view, click the **Provisioning > Protection** tabs and delete all protection groups:

a. Click the protection group that needs to be deleted and click **Delete**.

b. Click **Yes**.

Repeat until no protection groups appear.

**Step 6** In node view, click the **Provisioning > Comm Channels** tabs and delete all communications channel terminations:

a. Click the section data communications channel (SDCC), line data communications channel (LDCC), generic communications channel (GCC), or OSC termination that needs to be deleted and click **Delete**.

b. Click **Yes**.

Repeat until no SDCC, LDCC, GCC, or OSC terminations are present.

**Note** Before deleting the OSC termination, make sure the Ring ID is deleted. Click the **Provisioning > Comm Channels > OSC** tabs. Select the Ring ID and click **Delete**.

**Step 7** Before deleting any installed DWDM cards, the optical patch cords have to be deleted. In the node view, click **Provisioning > WDM-ANS > Connections** tabs.

a. Select all the connections and click **Delete**.

b. Click **Yes**.

**Step 8** For each installed MSTP channel-bearing card (AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x, where xx.x refers to the specific wavelengths), make sure all lines and bands are not in IS-NR (ANSI) or Unlocked-Enabled (ETSI) service state:

a. In the card view, click the **Provisioning > Optical Line > Parameters** tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) is selected.
c. Click the **Provisioning > Optical Chn > Parameters** tabs.

d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) is selected.

**Step 9**

For each installed DWDM band-bearing card (AD-1B-xx.x and AD-4B-xx.x, where xx.x refers to the specific wavelengths), make sure all lines and bands are not in the IS-NR (ANSI) or Unlocked-Enabled (ETSI) service state:

a. In the card view, click the **Provisioning > Optical Line > Parameters** tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) is selected.

c. Click the **Provisioning > Optical Band > Parameters** tabs.

d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) is selected.

**Step 10**

For each installed DWDM transponder (TXP), muxponder (MXP), multiplexer, demultiplexer or amplifier card (32MUX-O, 32DMX-0, 32DMX, 32WSS, 4MD-xx.x, OPT-BST, OPT-PRE, TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G, MXPP_MR_2.5G, MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G), make sure all lines are not in the IS-NR (ANSI) or Unlocked-enabled (ETSI) service state:

a. In card view, click the appropriate tab depending on the card:

   - For MXP_2.5G_10G, TXP_MR_10G, TXP_MR_10E cards, click the **Provisioning > Line > SONET** tabs if the card was provisioned for a SONET payload, or the **Provisioning > Line > SDH** tabs if the card was provisioned for an SDH payload.

   - For TXP_MR_2.5G, TXPP_MR_2.5G, and MXPP_MR_2.5G cards, click the **Provisioning > Line > OC48** tabs.

   - For MXP_2.5G_10E cards, click the **Provisioning > Line > Trunk** tabs.

   - For MXP_MR_2.5G cards, click the **Provisioning > Line > Client** tabs.

   - For 32MUX-O, 32DMX-0, 32DMX, 32WSS, OPT-BST, OPT-PRE cards, click the **Provisioning > Optical Line > Parameters** tabs.

   - For 32DMX and 32DMX-O cards, click the **Provisioning > Optical Chn > Parameters** tabs.

   - For 4MD-xx.x cards, click the **Provisioning > Optical Band > Parameters** tabs.

   - For OPT-BST and OPT-PRE cards, click the **Provisioning > Optical Ampli Line > Parameters** tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) is selected.

c. Repeat Steps a and b for each installed DWDM card.

**Note**

Ports are put in service when circuits are provisioned, and put out of service when circuits are deleted. When circuits are deleted the Admin State displays as IS, AINS (ANSI) or Unlocked,automaticInservice (ETSI) and the Service State displays OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService (ETSI).

**Step 11**

Remove all fiber connections to the cards.

**Step 12**

In node view, right-click an installed card and click **Delete**.

**Step 13**

Click **Yes**.
Step 14 After you have deleted the card, open the card ejectors and remove it from the node.

Step 15 Repeat Step 11 through Step 14 for each installed card.

Note You cannot delete a TCC2 or TCC2P card in Cisco Transport Controller (CTC). Physically remove it after all the other cards have been deleted and removed.

Step 16 Shut off the power from the power supply that feeds the node.

Step 17 Disconnect the node from its external fuse source.

Step 18 Store all of the cards that you removed and update inventory records according to local site practice.

Stop. You have completed this procedure.
Shelf Hardware Reference

This chapter provides a description of Cisco ONS 15454 hardware for the ANSI and ETSI shelf assemblies. For card descriptions, see Chapter 16, “Card Reference.” To install equipment, see Chapter 1, “Install the Shelf and Common Control Cards.”

Note
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

- 15.1 Overview, page 15-2
- 15.2 ONS 15454 ANSI Rack Installation, page 15-3
- 15.3 ONS 15454 ETSI Rack Installation, page 15-6
- 15.4 FlexLayer and Y-Cable Protection, page 15-9
- 15.5 Typical DWDM Rack Layouts, page 15-17
- 15.6 Front Door, page 15-19
- 15.7 ONS 15454 ANSI Backplane Covers, page 15-26
- 15.8 ONS 15454 ETSI Front Mount Electrical Connection, page 15-30
- 15.9 ONS 15454 ANSI Alarm Expansion Panel, page 15-30
- 15.10 Filler Card, page 15-35
- 15.11 Cable Routing and Management, page 15-36
- 15.12 Fan-Tray Assembly, page 15-41
- 15.13 Power and Ground Description, page 15-43
- 15.15 Cards and Slots, page 15-48
- 15.16 Ferrites (ANSI Only), page 15-50

Note
The Cisco ONS 15454 shelf assemblies are intended for use with telecommunications equipment only.
15.1 Overview

This section provides an introduction to the Cisco ONS 15454 ANSI and the Cisco ONS 15454 ETSI.

Install the ONS 15454 in compliance with your local and national electrical codes:

- Canada: Canadian Electrical Code, Part I, CSA C22.1.
- Other countries: If local and national electrical codes are not available, refer to IEC 364, Part 1 through Part 7.

15.1.1 Cisco ONS 15454 ANSI

When installed in an equipment rack, the ONS 15454 ANSI assembly is typically connected to a fuse and alarm panel to provide centralized alarm connection points and distributed power for the ONS 15454 ANSI. Fuse and alarm panels are third-party equipment and are not described in this documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, consult the user documentation for the related equipment. The front door of the ONS 15454 ANSI allows access to the shelf assembly, fan-tray assembly, and fiber-storage area. The backplanes provide access to alarm contacts, external interface contacts, power terminals, and BNC/SMB connectors.

You can mount the ONS 15454 ANSI in a 19- or 23-inch rack (482.6 or 584.2 mm). The shelf assembly weighs approximately 55 pounds (24.94 kg) with no cards installed.

The ONS 15454 ANSI is powered using –48 VDC power. Negative, return, and ground power terminals are accessible on the backplane.

15.1.2 Cisco ONS 15454 ETSI

When installed in an equipment rack, the ONS 15454 ETSI assembly is typically connected to a fuse and alarm panel to provide centralized alarm connection points and distributed power for the ONS 15454 ETSI. Fuse and alarm panels are third-party equipment and are not described in this documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, consult the user documentation for the related equipment. The front door of the ONS 15454 ETSI allows
access to the shelf assembly, fan-tray assembly, and fiber-storage area. The FMEC cover at the top of the shelf allows access to power connectors, external alarms and controls, timing input and output, and craft interface terminals.

You can mount the ONS 15454 ETSI in an ETSI rack. The shelf assembly weighs approximately 26 kg (57 pounds) with no cards installed. The shelf assembly includes a front door and a Front Mount Electrical Connection (FMEC) cover for added security, a fan tray module for cooling, and extensive fiber-storage space.

The ONS 15454 ETSI is powered using –48 VDC power. Negative, return, and ground power terminals are connected via the MIC-A/P and the MIC-C/T/P FMECs.

### 15.2 ONS 15454 ANSI Rack Installation

The ONS 15454 ANSI is mounted in a 19- or 23-in. (482.6- or 584.2-mm) equipment rack. The shelf assembly projects five inches (127 mm) from the front of the rack. It mounts in both Electronic Industries Alliance (EIA) standard and Telcordia-standard racks. The shelf assembly is a total of 17 inches (431.8 mm) wide with no mounting ears attached. Ring runs are not provided by Cisco and might hinder side-by-side installation of shelves where space is limited.

The ONS 15454 ANSI measures 18.5 inches (469.9 mm) high, 19 or 23 inches (482.6 or 584.2 mm) wide (depending on which way the mounting ears are attached), and 12 inches (304.8 mm) deep. You can install up to four ONS 15454 ANSIs in a seven-foot (2133.6 mm) equipment rack. The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ANSI is installed underneath the shelf assembly, the air ramp on top of the lower shelf assembly provides the air spacing needed and should not be modified in any way. Figure 15-1 shows the dimensions of the ONS 15454 ANSI.

**Note**

A 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and fan-tray assembly (15454-FTA3 or 15454-FTA3-T) are required if ONS 15454 ANSI 10-Gbps Cross-Connect (XC10G) cards are installed in the shelf.
15.2.1 Reversible Mounting Bracket

**Caution**
Use only the fastening hardware provided with the ONS 15454 ANSI shelf to prevent loosening, deterioration, and electromechanical corrosion of the hardware and joined material.

**Caution**
When mounting the ONS 15454 ANSI shelf in a frame with a nonconductive coating (such as paint, lacquer, or enamel) either use the thread-forming screws provided with the ONS 15454 ANSI shipping kit, or remove the coating from the threads to ensure electrical continuity.

The shelf assembly comes preset for installation in a 23-inch (584.2 mm) rack, but you can reverse the mounting bracket to fit the smaller 19-inch (482.6 mm) rack.
15.2.2 Mounting a Single Node

Mounting the ONS 15454 ANSI shelf in a rack requires a minimum of 18.5 inches (469.9 mm) of vertical rack space and one additional inch (25.4 mm) for air flow. To ensure the mounting is secure, use two to four #12-24 mounting screws for each side of the shelf assembly. Figure 15-2 shows the rack mounting position for the ONS 15454 ANSI shelf.

![Mounting an ONS 15454 ANSI Shelf in a Rack](image)

Figure 15-2  Mounting an ONS 15454 ANSI Shelf in a Rack

Two people should install the shelf assembly; however, one person can install it using the temporary set screws included. The shelf assembly should be empty for easier lifting. The front door can also be removed to lighten the shelf assembly.

15.2.3 Mounting Multiple Nodes

Most standard (Telcordia GR-63-CORE, 19-inch [482.6-mm] or 23-inch [584.2-mm]) seven-foot (2.133-m) racks can hold four ONS 15454 ANSI shelves and a fuse and alarm panel. However, unequal flange racks are limited to three ONS 15454 ANSI shelves and a fuse and alarm panel, or four ONS 15454 ANSI shelves using a fuse and alarm panel from an adjacent rack.

If you are using the external (bottom) brackets to install the fan-tray air filter, you can install three shelf assemblies in a standard seven-foot (2.133-m) rack. If you are not using the external (bottom) brackets, you can install four shelf assemblies in a rack. The advantage of using the bottom brackets is that you can replace the filter without removing the fan tray.
15.2.4 ONS 15454 ANSI Bay Assembly

The Cisco ONS 15454 ANSI bay assembly simplifies ordering and installing the ONS 15454 ANSI shelf because it allows you to order shelf assemblies preinstalled in a seven-foot (2,133 mm) rack. The bay assembly is available in a three- or four-shelf configuration. The three-shelf configuration includes three ONS 15454 ANSI shelf assemblies, a prewired fuse and alarm panel, and two fiber-storage trays. The four-shelf configuration includes four ONS 15454 ANSI shelf assemblies and a prewired fuse and alarm panel. You can order optional fiber channels with either configuration. Installation procedures are included in the Unpacking and Installing the Cisco ONS 15454 Four-Shelf and Zero-Shelf Bay Assembly document that ships with the bay assembly.

15.3 ONS 15454 ETSI Rack Installation

The ONS 15454 ETSI (15454-SA-ETSI) is mounted in a 600 x 600-mm (23-inch) or 600 x 300-mm (11.8-inch) equipment cabinet/rack. The shelf assembly projects 240 mm (9.45 inches) from the front of the rack. It mounts in ETSI-standard racks. The shelf assembly is a total of 435 mm (17.35 inches) wide with no mounting ears attached. Ring runs are not provided by Cisco and might hinder side-by-side installation of shelves where space is limited.

The ONS 15454 ETSI measures 616.5 mm (24.27 inches) high, 535 mm (21.06 inches) wide, and 280 mm (11.02 inches) deep. You can install up to three ONS 15454 ETSI shelves in a seven-foot (2133.6 mm) equipment rack. The ONS 15454 ETSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed below the first shelf assembly, an ETSI air ramp unit must be assembled between the two shelves to ensure adequate air flow.

Figure 15-3 provides the dimensions of the ONS 15454 ETSI.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The standard ETSI racks can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ONS 15454 ETSI must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to allow air flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) provides this spacing and should not be modified in any way.</td>
</tr>
</tbody>
</table>
15.3.1 Mounting a Single Node

The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm (1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space for air flow. To ensure the mounting is secure, use two to four M6 mounting screws for each side of the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in the rack.

Figure 15-4 shows the rack mounting position for the ONS 15454 ETSI shelf.
15.3.2 Mounting Multiple Nodes

Most standard (Telcordia GR-63-CORE, 23-inch [584.2 mm]) seven-foot (2,133 mm) racks can hold three ONS 15454 ETSI shelves, two air ramps, and a fuse and alarm panel. Figure 15-5 shows a three-shelf ONS 15454 ETSI bay assembly.
15.4 FlexLayer and Y-Cable Protection

The Cisco ONS 15454 FlexLayer DWDM system includes the following components:

- Two-channel add or drop flex module
- FlexLayer shelf assembly
- Y-cable FlexLayer module

The FlexLayer shelf assembly is 1 rack unit (RU) high and can be mounted in a 19-inch (482.6-mm) or 23-inch (584.2-mm) rack (two-way mounting brackets). The FlexLayer shelf assembly is used to house the FlexLayer and Y-Cable modules.
15.4.1 FlexLayer Modules

The two-channel add/drop FlexLayer module is a completely passive unidirectional component that allows the insertion or the extraction of two channels within the ONS 15454 channel plan. This module is used only in point-to-point, one-channel, amplified system configurations.

Sixteen specific modules are available to cover the whole 32-channel bandwidth. Table 15-1 shows how the FlexLayer add/drop modules are grouped in relation to the supported channels.

<table>
<thead>
<tr>
<th>ITU</th>
<th>Channel ID</th>
<th>Frequency (THz)</th>
<th>Wavelength (nm)</th>
<th>Two-Channel A/D Flex Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
<td>15216-FLB-2-31.1=</td>
</tr>
<tr>
<td>58</td>
<td>31.1</td>
<td>195.8</td>
<td>1531.12</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
<td>15216-FLB-2-32.6=</td>
</tr>
<tr>
<td>56</td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
<td>15216-FLB-2-35.0=</td>
</tr>
<tr>
<td>53</td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
<td>15216-FLB-2-36.6=</td>
</tr>
<tr>
<td>51</td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
<td>15216-FLB-2-38.9=</td>
</tr>
<tr>
<td>48</td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
<td>15216-FLB-2-40.5=</td>
</tr>
<tr>
<td>46</td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
<td>15216-FLB-2-42.9=</td>
</tr>
<tr>
<td>43</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
<td>15216-FLB-2-44.5=</td>
</tr>
<tr>
<td>41</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
<td>15216-FLB-2-46.9=</td>
</tr>
<tr>
<td>38</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
<td>15216-FLB-2-48.5=</td>
</tr>
<tr>
<td>36</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
<td>15216-FLB-2-50.9=</td>
</tr>
<tr>
<td>33</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
<td>15216-FLB-2-52.5=</td>
</tr>
<tr>
<td>31</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
<td>15216-FLB-2-54.9=</td>
</tr>
<tr>
<td>28</td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
<td>15216-FLB-2-56.5=</td>
</tr>
<tr>
<td>26</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
<td></td>
</tr>
</tbody>
</table>
Figure 15-6 shows the module functional block diagram. In Figure 15-6, the signal flows from left to right when the card is used as a drop component and from right to left when the module is used as an add component.

When the module is used as a drop component, the wave-division multiplexing (WDM) composite signal coming from the DROP-COM-RX port is filtered sequentially by two filters and the filtered channels are dropped at the two DROP-CH-TX ports. The rest of the WDM composite signal is sent to the DROP-COM-TX port. A two-percent tap coupler, DROP-MON, is used to monitor the input WDM composite signal.

When the module is used as an add component, the added channels coming from the two ADD-CH-RX ports are combined with the WDM composite signal coming from the ADD-COM-RX port. The multiplexed WDM composite signal is sent to the ADD-COM-TX port. A two-percent tap coupler, ADD-MON, is used to monitor the multiplexed WDM composite signal.
Figure 15-7 shows the physical appearance of the ONS 15454 two-channel add/drop FlexLayer module.

Figure 15-7  ONS 15454 Two-Channel Optical Add/Drop FlexLayer Module

Labels are provided to show how the module ports are mapped. It is the end user’s responsibility to label the module for its intended use (drop or add component).

Figure 15-8 shows how the connectors are mapped and labeled on the front panel when the component is used as a drop component. The COM-RX is mapped to Port 1, the COM-TX is mapped to Port 12, and the two dropped channel TX ports are mapped to Ports 9 and 10. The two-percent tap MON port is mapped to Port 6. Port 7 is not active.

Figure 15-8  Two-Channel Drop Component Connector Mapping and Labeling

Figure 15-9 shows how the connectors are mapped and labeled in the front panel when the component is used as an add component. The COM-TX is mapped to Port 1, the COM-RX is mapped to Port 12, and the added channels are mapped to the two RX Ports 9 and 10. The two-percent tap MON port is mapped to Port 7. Port 6 is not active.
15.4.2 Y-Cable Protection Module

The Y-cable protection module is a bidirectional module. It is equipped with two passive star couplers: one that is used as a splitter and one that is used as a coupler.

**Note**

None of the modules in this equipment release can be used for video on demand (VoD) applications.

The purpose of this module is to provide Y-cable protection on the CLIENT side of transponder (TXP) cards such as the TXP_MR_10G, XP_MR_10E, or TXP_MR_2.5G (Figure 15-10). There are two versions of this module, one for multimode applications (CS-MM-Y) and one for single-mode applications (CS-SM-Y).

Using one Y-cable protection module, you can protect one client signal with two TXP cards, and two client signals with four TXP cards.

**Figure 15-10  Typical Y-Cable Protection Module Configuration**
15.4.2 Y-Cable Protection Module

When the module is used in the coupler direction, the individual signals enter the module from the CPL-RX<sub>n</sub> ports and pass through a passive star coupler to the CPL-TX port.

The coupler is not meant to combine both the protect and working client card signals. The module allows a path for the working client transmit interface to connect to the network in the event the opposite interface in the protection pair should fail (the protect interface switches to the working interface).

When the module is used in the splitter direction, the signal enters the module from the SPL-RX port and is split through a passive star coupler to the SPL-TX<sub>n</sub> ports. This module, although designed to pass wavelengths associated with the ONS 15454 32-channel plan, is not selective to specific wavelengths (modules do not filter wavelengths).

Figure 15-11 shows the block diagram of the Y-cable protection module.

**Figure 15-11** 1:2 Splitter and 2:1 Coupler (Y-Cable Protection) Module Block Diagram

![Block Diagram](image)

**Figure 15-12** and Figure 15-13 show the physical appearance of the ONS 15454 Y-Cable Protection FlexLayer Module. This module has two versions, one for single-mode applications and the other for multimode applications.

**Figure 15-12** ONS 15454 Y-Cable Protection FlexLayer Module (Single-Mode)
Figure 15-13  **ONS 15454 Y-Cable Protection FlexLayer Module (Multimode)**

Figure 15-14 shows how the module front panel ports are mapped and labeled. The multimode module is mapped and labeled the same as the single-mode module.

**Figure 15-14  Y-Cable Protection Component Connector Mapping and Labeling**

Table 15-2 details the single-mode and multimode front panel Protection A mapping. It shows how two DWDM receive inputs (client working and protect) provide one output signal to the customer client equipment, using the module combiner function.

**Table 15-2  Protection A (TXP Cards 1 and 2) Port Mapping: Combiner from DWDM**

<table>
<thead>
<tr>
<th>Receive Port on the Y-Cable Module</th>
<th>Signal Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (RXa1)</td>
<td>Client TX port on the TXP 1 card</td>
</tr>
<tr>
<td>6 (RXa2)</td>
<td>Client TX port on the TXP 2 card</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmit Port on the Y-Cable Module</th>
<th>Signal Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 (TXa)</td>
<td>RX port on customer client equipment A</td>
</tr>
</tbody>
</table>
Table 15-3 details the single-mode and multimode front panel Protection A mapping. It shows how the module splits a single receive input from the equipment into two DWDM output signals (working and protect) to the TXP client port.

**Table 15-3 Protection A (TXP Cards 1 and 2) Port Mapping: Splitter to DWDM**

<table>
<thead>
<tr>
<th>Receive Port</th>
<th>Signal Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 (RXa)</td>
<td>TX port on customer client equipment A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmit Port</th>
<th>Signal Destinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 (TXa1)</td>
<td>Client RX port on the TXP 1 card</td>
</tr>
<tr>
<td>7 (TXa2)</td>
<td>Client RX port on the TXP 2 card</td>
</tr>
</tbody>
</table>

Table 15-4 details the single-mode and multimode front panel Protection B mapping. It shows how two DWDM receive inputs (client working and protect) provide one output signal to the equipment, using the module combiner function.

**Table 15-4 Protection B (TXP Cards 3 and 4) Port Mapping: Combiner from DWDM**

<table>
<thead>
<tr>
<th>Receive Port</th>
<th>Signal Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 (RXb1)</td>
<td>Client TX port on the TXP 3 card</td>
</tr>
<tr>
<td>8 (RXb2)</td>
<td>Client TX port on the TXP 4 card</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmit Port</th>
<th>Signal Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 (TXb)</td>
<td>RX port on customer client equipment B</td>
</tr>
</tbody>
</table>

Table 15-5 details the single-mode and multimode front panel Protection B mapping. It shows how the module splits a single receive input from the equipment into two DWDM output signals (working and protect) to the client.

**Table 15-5 Protection B (TXP Cards 3 and 4) Port Mapping: Splitter to DWDM**

<table>
<thead>
<tr>
<th>Receive Port Number</th>
<th>Signal Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 (RXb)</td>
<td>TX port on customer client equipment B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmit Port Number</th>
<th>Signal Destinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 (TXb1)</td>
<td>Client RX on the TXP 3 port</td>
</tr>
<tr>
<td>9 (TXb2)</td>
<td>Client RX on the TXP 4 port</td>
</tr>
</tbody>
</table>

The following muxponder (MXP) and transponder (TXP) cards can use Y-cable protection:

- MXP_2.5_10G
- MXP_2.5_10E
- MXP_MR_2.5G
- TXP_MR_10G
- TXP_MR_10E
- TXP_MR_2.5G
15.5 Typical DWDM Rack Layouts

Typical dense wavelength division multiplexing (DWDM) applications might include:

- 3 ONS 15454 shelves
- 1 Dispersion Compensating Unit (DCU)
- 7 patch panels (or fiber-storage trays)

Or, alternatively:

- 3 ONS 15454 shelves
- 2 DCUs
- 6 patch panels (or fiber-storage trays)

See Figure 15-15 for a typical rack layout.

Note

Use the rack layout generated by Cisco MetroPlanner to determine your exact shelf layout.
If you are installing a patch panel or fiber-storage tray below the ONS 15454 shelf, you must install the air ramp between the shelf and patch-panel tray/fiber-management tray, or leave one rack unit (RU) space open.
15.6 Front Door

The Critical, Major, and Minor alarm LEDs visible through the front door indicate whether a critical, major, or minor alarm is present anywhere on the ONS 15454 shelf. These LEDs must be visible so technicians can quickly determine if any alarms are present on the ONS 15454 shelf or the network. You can use the LCD to further isolate alarms. The front door (Figure 15-16) provides access to the shelf assembly, fiber-storage tray, fan-tray assembly, and LCD screen.

Figure 15-16  The ONS 15454 Front Door

The ONS 15454 ANSI ships with a standard door but can also accommodate a deep door and extended fiber clips (15454-DOOR-KIT) to provide additional room for cabling (Figure 15-17). The ONS 15454 ETSI does not support the deep door.
The ONS 15454 door locks with a pinned hex key that ships with the shelf assembly. A button on the right side of the shelf assembly releases the door. You can remove the front door to provide unrestricted access to the front of the shelf assembly.
Before you remove the ONS 15454 front door, you must remove the ground strap of the front door (Figure 15-18).

*Figure 15-18  ONS 15454 ANSI Front Door Ground Strap*
Figure 15-19 shows how to remove the ONS 15454 ANSI front door.

Figure 15-19  Removing the ONS 15454 ANSI Front Door
Figure 15-20 shows how to remove the ONS 15454 ETSI front door.

An erasable label is pasted on the inside of the front door. You can use the label to record slot assignments, port assignments, card types, node ID, rack ID, and serial number for the ONS 15454.
Figure 15-21 shows the erasable label on the ONS 15454 ANSI shelf.

Figure 15-21    ONS 15454 ANSI Front-Door Erasable Label

<table>
<thead>
<tr>
<th>SLOT ASSIGNMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>14</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>16</td>
</tr>
</tbody>
</table>

Figure 15-21 shows the erasable label on the ONS 15454 ANSI shelf.
Figure 15-22 shows the erasable label on the ONS 15454 ETSI shelf.

**Figure 15-22  ONS 15454 ETSI Front-Door Erasable Label**

| SLOT NUMBER | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |
|-------------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|
| CARD NAME   |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |
|             | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

The front door label also includes the Class I and Class 1M laser warning. **Figure 15-23** shows the ONS 15454 ANSI laser warning.

**Figure 15-23  Laser Warning on the ONS 15454 ANSI Front-Door Label**

Figure 15-24 shows the ONS 15454 ETSI laser warning.
15.7 ONS 15454 ANSI Backplane Covers

If a backplane does not have an electrical interface assembly (EIA) panel installed, it should have two sheet metal backplane covers (one on each side of the backplane). See Figure 15-25. Each cover is held in place with nine 6-32 x 3/8 inch Phillips screws.
15.7.1 Lower Backplane Cover

The lower section of the ONS 15454 ANSI backplane is covered by either a clear plastic protector (15454-SA-ANSI) or a sheet metal cover (15454-SA-HD), which is held in place by five 6-32 x 1/2 inch screws. Remove the lower backplane cover to access the alarm interface panel (AIP), alarm pin fields, frame ground, and power terminals (Figure 15-26).
15.7.2 Rear Cover

The ONS 15454 ANSI has an optional clear plastic rear cover. This clear plastic cover provides additional protection for the cables and connectors on the backplane. Figure 15-27 shows the rear cover screw locations.

Figure 15-27 Backplane Attachment for Cover

You can also install the optional spacers if more space is needed between the cables and rear cover (Figure 15-28).
15.7.3 Alarm Interface Panel

The AIP is located above the alarm contacts on the lower section of the backplane. The AIP provides surge protection for the ONS 15454 ANSI. It also provides an interface from the backplane to the fan-tray assembly and LCD. The AIP plugs into the backplane using a 96-pin DIN connector and is held in place with two retaining screws. The panel has a nonvolatile memory chip that stores the unique node address (MAC address). The MAC address identifies the nodes that support circuits. It allows Cisco Transport Controller (CTC) to determine circuit sources, destinations, and spans. The TCC2/TCC2P cards in the ONS 15454 ANSI also use the MAC address to store the node database.

**Note**
The 5-A AIP (73-7665-XX) is required when installing the new fan-tray assembly (15454-FTA3), which comes preinstalled on the shelf assembly (15454-SA-ANSI or 15454-SA-HD).

**Note**
A blown fuse on the AIP board can cause the LCD display to go blank.

15.7.4 Alarm Interface Panel Replacement

If the AIP fails, a MAC Fail alarm appears on the CTC Alarms menu and/or the LCD display on the fan-tray assembly goes blank. To perform an in-service replacement of the AIP, you must contact the Cisco Technical Assistance Center (Cisco TAC). For contact information, see the “Obtaining Technical Assistance” section on page lxxvi.
You can replace the AIP on an in-service system without affecting traffic (except Ethernet traffic on nodes running a software release earlier than Release 4.0). The circuit repair feature allows you to repair circuits affected by MAC address changes on one node at a time. Circuit repair works when all nodes are running the same software version. Each individual AIP upgrade requires an individual circuit repair; if AIPs are replaced on two nodes, the circuit repair must be performed twice. Always replace an AIP during a maintenance window.

**Caution**
Do not use a 2-A AIP with a 5-A fan-tray assembly; doing so causes a blown fuse on the AIP.

**Note**
Ensure that all nodes in the affected network are running the same software version before replacing the AIP and repairing circuits. If you need to upgrade nodes to the same software version, no hardware should be changed or circuit repair performed until after the software upgrade is complete.

### 15.8 ONS 15454 ETSI Front Mount Electrical Connection

The ONS 15454 ETSI positive and negative power terminals are located on FMEC cards in the Electrical Facility Connection Assembly (EFCA). The ground connection is the grounding receptacle on the side panel of the shelf.

The ONS 15454 ETSI EFCA at the top of the shelf has 12 FMEC slots numbered sequentially from left to right (18 to 29). Slots 18 to 22 and 25 to 29 provide electrical connections. Slots 23 and 24 host the MIC-A/P and MIC-C/T/P cards, respectively. The MIC-A/P and the MIC-C/T/P cards also connect alarm, timing, LAN, and craft connections to the ONS 15454 ETSI.

For more information about the MIC-A/P and MIC-C/T/P, see Chapter 16, “Card Reference.”

### 15.9 ONS 15454 ANSI Alarm Expansion Panel

The optional ONS 15454 ANSI alarm expansion panel (AEP) can be used with the Alarm Interface Controller–International card (AIC-I) card to provide an additional 48 dry alarm contacts for the ONS 15454 ANSI: 32 inputs and 16 outputs. The AEP is a printed circuit board assembly that is installed on the backplane. Figure 15-29 shows the AEP board; the left connector is the input connector and the right connector is the output connector.

The AIC-I without an AEP already contains direct alarm contacts. These direct AIC-I alarm contacts are routed through the backplane to wire-wrap pins accessible from the back of the shelf. If you install an AEP, you cannot use the alarm contacts on the wire-wrap pins. For more information about the AIC-I, see Chapter 16, “Card Reference.”
Each AEP alarm input port has provisionable label and severity. The alarm inputs have optocoupler isolation. They have one common 32-VDC output and a maximum of 2 mA per input. Each opto-metal oxide semiconductor (MOS) alarm output can operate by definable alarm condition, a maximum open circuit voltage of 60 VDC, and a maximum current of 100 mA. See the “23.7 External Alarms and Controls” section on page 23-12 for further information.

Figure 15-31 shows the wire-wrapping connections on the shelf backplane used to connect to the AEP.
Table 15-6 shows the backplane pin assignments and corresponding signals on the AIC-I and AEP.

**Table 15-6 Pin Assignments for the AEP**

<table>
<thead>
<tr>
<th>AEP Cable Wire</th>
<th>Backplane Pin</th>
<th>AIC-I Signal</th>
<th>AEP Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>A1</td>
<td>GND</td>
<td>AEP_GND</td>
</tr>
<tr>
<td>White</td>
<td>A2</td>
<td>AE_+5</td>
<td>AEP_+5</td>
</tr>
<tr>
<td>Slate</td>
<td>A3</td>
<td>VBAT–</td>
<td>VBAT–</td>
</tr>
<tr>
<td>Violet</td>
<td>A4</td>
<td>VB+</td>
<td>VB+</td>
</tr>
<tr>
<td>Blue</td>
<td>A5</td>
<td>AE_CLK_P</td>
<td>AE_CLK_P</td>
</tr>
<tr>
<td>Green</td>
<td>A6</td>
<td>AE_CLK_N</td>
<td>AE_CLK_N</td>
</tr>
<tr>
<td>Yellow</td>
<td>A7</td>
<td>AE_DIN_P</td>
<td>AE_DOUT_P</td>
</tr>
<tr>
<td>Orange</td>
<td>A8</td>
<td>AE_DIN_N</td>
<td>AE_DOUT_N</td>
</tr>
<tr>
<td>Red</td>
<td>A9</td>
<td>AE_DOUT_P</td>
<td>AE_DIN_P</td>
</tr>
<tr>
<td>Brown</td>
<td>A10</td>
<td>AE_DOUT_N</td>
<td>AE_DIN_N</td>
</tr>
</tbody>
</table>
Figure 15-32 is a circuit diagram of the alarm inputs. (Inputs 1 and 32 are shown in the example.)

**Figure 15-32  Alarm Input Circuit Diagram**

Table 15-7 lists the connections to the external alarm sources.

**Table 15-7  Alarm Input Pin Association**

<table>
<thead>
<tr>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALARM_IN_1–</td>
<td>27</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>28</td>
<td>ALARM_IN_2–</td>
</tr>
<tr>
<td>3</td>
<td>ALARM_IN_3–</td>
<td>29</td>
<td>ALARM_IN_4–</td>
</tr>
<tr>
<td>4</td>
<td>ALARM_IN_5–</td>
<td>30</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>31</td>
<td>ALARM_IN_6–</td>
</tr>
<tr>
<td>6</td>
<td>ALARM_IN_7–</td>
<td>32</td>
<td>ALARM_IN_8–</td>
</tr>
<tr>
<td>7</td>
<td>ALARM_IN_9–</td>
<td>33</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>34</td>
<td>ALARM_IN_10–</td>
</tr>
<tr>
<td>9</td>
<td>ALARM_IN_11–</td>
<td>35</td>
<td>ALARM_IN_12–</td>
</tr>
<tr>
<td>10</td>
<td>ALARM_IN_13–</td>
<td>36</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>GND</td>
<td>37</td>
<td>ALARM_IN_14–</td>
</tr>
<tr>
<td>12</td>
<td>ALARM_IN_15–</td>
<td>38</td>
<td>ALARM_IN_16–</td>
</tr>
<tr>
<td>13</td>
<td>ALARM_IN_17–</td>
<td>39</td>
<td>GND</td>
</tr>
<tr>
<td>14</td>
<td>GND</td>
<td>40</td>
<td>ALARM_IN_18–</td>
</tr>
<tr>
<td>15</td>
<td>ALARM_IN_19–</td>
<td>41</td>
<td>ALARM_IN_20–</td>
</tr>
<tr>
<td>16</td>
<td>ALARM_IN_21–</td>
<td>42</td>
<td>GND</td>
</tr>
<tr>
<td>17</td>
<td>GND</td>
<td>43</td>
<td>ALARM_IN_22–</td>
</tr>
</tbody>
</table>
15.9 ONS 15454 ANSI Alarm Expansion Panel

Table 15-7 Alarm Input Pin Association (continued)

<table>
<thead>
<tr>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>ALARM_IN_23–</td>
<td>44</td>
<td>ALARM_IN_24–</td>
</tr>
<tr>
<td>19</td>
<td>ALARM_IN_25–</td>
<td>45</td>
<td>GND</td>
</tr>
<tr>
<td>20</td>
<td>GND</td>
<td>46</td>
<td>ALARM_IN_26–</td>
</tr>
<tr>
<td>21</td>
<td>ALARM_IN_27–</td>
<td>47</td>
<td>ALARM_IN_28–</td>
</tr>
<tr>
<td>22</td>
<td>ALARM_IN_29–</td>
<td>48</td>
<td>GND</td>
</tr>
<tr>
<td>23</td>
<td>GND</td>
<td>49</td>
<td>ALARM_IN_30–</td>
</tr>
<tr>
<td>24</td>
<td>ALARM_IN_31–</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>25</td>
<td>ALARM_IN_+</td>
<td>51</td>
<td>GND1</td>
</tr>
<tr>
<td>26</td>
<td>ALARM_IN_0–</td>
<td>52</td>
<td>GND2</td>
</tr>
</tbody>
</table>

Figure 15-33 is a circuit diagram of the alarm outputs. (Outputs 1 and 16 are shown in the example.)

Table 15-8 Pin Association for Alarm Output Pins

<table>
<thead>
<tr>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
<td>27</td>
<td>COM_0</td>
</tr>
<tr>
<td>2</td>
<td>COM_1</td>
<td>28</td>
<td>—</td>
</tr>
<tr>
<td>3</td>
<td>NO_1</td>
<td>29</td>
<td>NO_2</td>
</tr>
<tr>
<td>4</td>
<td>—</td>
<td>30</td>
<td>COM_2</td>
</tr>
</tbody>
</table>
15.10 Filler Card

The filler card is designed to occupy empty multiservice and AIC-I slots in the Cisco ONS 15454 (Slots 1 – 6, 9, and 12 – 17). The filler card cannot operate in the XC slots (Slots 8 and 10) or TCC slots (Slots 7 and 11). The filler card is detected by CTC.

When installed, the filler card aids in maintaining proper air flow and EMI requirements.

Figure 15-34 shows the card faceplate. The filler card has no card-level LED indicators.

<table>
<thead>
<tr>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
<th>AMP Champ Pin Number</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>COM_3</td>
<td>31</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>NO_3</td>
<td>32</td>
<td>NO_4</td>
</tr>
<tr>
<td>7</td>
<td>—</td>
<td>33</td>
<td>COM_4</td>
</tr>
<tr>
<td>8</td>
<td>COM_5</td>
<td>34</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>NO_5</td>
<td>35</td>
<td>NO_6</td>
</tr>
<tr>
<td>10</td>
<td>—</td>
<td>36</td>
<td>COM_6</td>
</tr>
<tr>
<td>11</td>
<td>COM_7</td>
<td>37</td>
<td>—</td>
</tr>
<tr>
<td>12</td>
<td>NO_7</td>
<td>38</td>
<td>NO_8</td>
</tr>
<tr>
<td>13</td>
<td>—</td>
<td>39</td>
<td>COM_8</td>
</tr>
<tr>
<td>14</td>
<td>COM_9</td>
<td>40</td>
<td>—</td>
</tr>
<tr>
<td>15</td>
<td>NO_9</td>
<td>41</td>
<td>NO_10</td>
</tr>
<tr>
<td>16</td>
<td>—</td>
<td>42</td>
<td>COM_10</td>
</tr>
<tr>
<td>17</td>
<td>COM_11</td>
<td>43</td>
<td>—</td>
</tr>
<tr>
<td>18</td>
<td>NO_11</td>
<td>44</td>
<td>NO_12</td>
</tr>
<tr>
<td>19</td>
<td>—</td>
<td>45</td>
<td>COM_12</td>
</tr>
<tr>
<td>20</td>
<td>COM_13</td>
<td>46</td>
<td>—</td>
</tr>
<tr>
<td>21</td>
<td>NO_13</td>
<td>47</td>
<td>NO_14</td>
</tr>
<tr>
<td>22</td>
<td>—</td>
<td>48</td>
<td>COM_14</td>
</tr>
<tr>
<td>23</td>
<td>COM_15</td>
<td>49</td>
<td>—</td>
</tr>
<tr>
<td>24</td>
<td>NO_15</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>25</td>
<td>—</td>
<td>51</td>
<td>GND1</td>
</tr>
<tr>
<td>26</td>
<td>NO_0</td>
<td>52</td>
<td>GND2</td>
</tr>
</tbody>
</table>
15.11 Cable Routing and Management

The ONS 15454 cable management facilities include the following:

- Fiber patch panels
- A cable-routing channel (behind the fold-down door) that runs the width of the shelf assembly (Figure 15-35 on page 15-37)
- Plastic horseshoe-shaped fiber guides at each side opening of the cable-routing channel that ensure that the proper bend radius is maintained in the fibers (Figure 15-36 on page 15-38)
You can remove the fiber guide, if necessary, to create a larger opening (if you need to route CAT-5 Ethernet cables out the side, for example). To remove the fiber guide, take out the three screws that anchor it to the side of the shelf assembly.

- Cable tie-wrap facilities on EIAs that secure cables to the cover panel (ANSI only)
- Reversible jumper routing fins that enable you to route cables out either side by positioning the fins as desired
- Jumper slack storage reels (2) on each side panel that reduce the amount of slack in cables that are connected to other devices

To remove the jumper slack storage reels, take out the screw in the center of each reel.

- Optional fiber-storage tray (recommended for DWDM nodes)
- Optional tie-down bar (ANSI only)

Figure 15-35 shows the cable management facilities that you can access through the fold-down front door, including the cable-routing channel and the jumper routing fins.

### 15.11.1 Fiber Management

The jumper routing fins are designed to route fiber jumpers out of both sides of the shelf. Slots 1 to 6 exit to the left, and Slots 12 to 17 exit to the right. Figure 15-36 shows fibers routed from cards in the left slots, down through the fins, then exiting out the fiber channel to the left. The maximum capacity of the fiber routing channel depends on the size of the fiber jumpers.
**Table 15-9** provides the maximum capacity of the fiber channel for one side of an ANSI shelf, depending on fiber size and number of Ethernet cables running through that fiber channel.

### Table 15-9  ANSI Fiber Channel Capacity (One Side of the Shelf)

<table>
<thead>
<tr>
<th>Fiber Diameter</th>
<th>Maximum Number of Fibers Exiting Each Side</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No Ethernet Cables</td>
</tr>
<tr>
<td>1.6 mm (0.6 inch)</td>
<td>144</td>
</tr>
<tr>
<td>2 mm (0.7 inch)</td>
<td>90</td>
</tr>
<tr>
<td>3 mm (0.11 inch)</td>
<td>40</td>
</tr>
</tbody>
</table>

**Table 15-10** provides the maximum capacity of the fiber channel for one side of an ETSI shelf, depending on fiber size and number of Ethernet cables running through that fiber channel.

### Table 15-10  ETSI Fiber Channel Capacity (One Side of the Shelf)

<table>
<thead>
<tr>
<th>Fiber Diameter</th>
<th>Maximum Number of Fibers Exiting Each Side</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No Ethernet Cables</td>
</tr>
<tr>
<td>1.6 mm (0.6 inch)</td>
<td>126</td>
</tr>
<tr>
<td>2 mm (0.7 inch)</td>
<td>80</td>
</tr>
<tr>
<td>3 mm (0.11 inch)</td>
<td>36</td>
</tr>
</tbody>
</table>
Determine your fiber size according to the number of cards/ports installed in each side of the shelf. For example, if your port combination requires 36 fibers, 3-mm (0.11-inch) fiber is adequate. If your port combination requires 68 fibers, you must use 2-mm (0.7-inch) or smaller fibers.

15.11.2 Fiber Management Using the Patch-Panel Tray

The optional patch-panel tray manages the connections between multiplexer/demultiplexer and TXP cards by splitting patch cords into single connections. The patch-panel tray consists of a metal shelf, pull-out drawer, and drop-in patch-panel module. It can host up to eight ribbon cables (with eight fibers each) entering the drawer or 64 cables (with a maximum outer diameter of 2 mm [0.079 inches]). Because the patch-panel tray can host 64 connections, hub and ROADM nodes will typically require two patch-panel modules each, and other DWDM nodes typically require one. The module fits 19- and 23-inch (482.6-mm and 584.2-mm) ANSI racks and 600 mm (23.6 inch) x 300 mm (11.8 inch) ETSI racks, using reversible brackets. Figure 15-37 shows a partially fibered patch-panel tray.

Figure 15-37  Patch-Panel Tray

15.11.3 Fiber Management Using the Fiber-Storage Tray

Cisco recommends installing at least one fiber-storage tray in multinode racks to facilitate fiber-optic cable management for DWDM applications. This tray is usually used to store slack cable from cables installed between cards within a single node. Refer to Figure 15-15 on page 15-18 for typical mounting locations.
Table 15-11 provides the fiber capacity for each tray.

Table 15-11  Fiber-Storage Tray Capacity

<table>
<thead>
<tr>
<th>Fiber Diameter</th>
<th>Maximum Number of Fibers Exiting Each Side</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.6 mm (0.6 inch)</td>
<td>62</td>
</tr>
<tr>
<td>2 mm (0.7 inch)</td>
<td>48</td>
</tr>
<tr>
<td>3 mm (0.11 inch)</td>
<td>32</td>
</tr>
</tbody>
</table>

Figure 15-38 shows a fiber-management tray with fiber-optic cables routed through it. You can route cables around the cable rounders, entering and exiting from either side, as necessary.

Note

Figure 15-38 shows one example of how to route fibers through the fiber-storage tray. Route fibers as necessary for your site configuration.

Figure 15-38  Fiber-Storage Tray

15.11.4 Fiber Management Using the Optional ANSI Tie-Down Bar

You can install a 5-inch (127-mm) tie-down bar on the rear of the ANSI chassis. You can use tie-wraps or other site-specific material to bundle the cabling and attach it to the bar so that you can more easily route the cable away from the rack.

Figure 15-39 shows the tie-down bar, the ONS 15454 ANSI, and the rack.
15.12 Fan-Tray Assembly

The fan-tray assembly is located at the bottom of the ONS 15454 shelf assembly. The fan tray is a removable drawer that holds fans and fan-control circuitry for the ONS 15454. The front door can be left in place or removed before installing the fan-tray assembly. After you install the fan tray, you should only need to access it if a fan failure occurs or if you need to replace or clean the fan-tray air filter. Refer to Chapter 13, “Maintain the Node” to clean and replace the fan-tray assembly.

The front of the fan-tray assembly has an LCD screen that provides slot- and port-level information for all card slots, including the number of Critical, Major, and Minor alarms.

The fan-tray assembly features an air filter at the bottom of the tray that you can install and remove by hand. Remove and visually inspect this filter every 30 days and keep spare filters in stock. Refer to Chapter 13, “Maintain the Node,” for information about cleaning and maintaining the fan-tray air filter.

Caution

Do not operate an ONS 15454 without the mandatory fan-tray air filter.

Caution

The 15454-FTA3-T fan-tray assembly can only be installed in ONS 15454 Release 3.1 and later shelf assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly includes a pin that prevents it from being installed in ONS 15454 shelf assemblies released before ONS 15454 Release 3.1 (15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1). Equipment damage can result from attempting to install the 15454-FTA3 in a noncompatible shelf assembly.

See Figure 15-40 for the position of the ONS 15454 ETSI fan-tray assembly.
15.12.1 Fan Speed and Power Requirements

Fan speed is controlled by the TCC2/TCC2P card’s temperature sensors. The sensors measure the input air temperature at the fan-tray assembly. Fan speed options are low, medium, and high. If the TCC2/TCC2P card fails, the fans automatically shift to high speed. The temperature measured by the TCC2/TCC2P sensors appears on the LCD screen.

Table 15-12 lists power requirements for the fan-tray assembly.

<table>
<thead>
<tr>
<th>Fan Tray Assembly</th>
<th>Watts</th>
<th>Amps</th>
<th>BTU/Hr</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTA2</td>
<td>53</td>
<td>1.21</td>
<td>198</td>
</tr>
<tr>
<td>FTA3 -T</td>
<td>86.4</td>
<td>1.8</td>
<td>295</td>
</tr>
</tbody>
</table>
15.12.2 Fan Failure

If one or more fans fail on the fan-tray assembly, replace the entire assembly. You cannot replace individual fans. The red Fan Fail LED on the front of the fan tray illuminates when one or more fans fail. For fan-tray replacement instructions, see the “NTP-G116 Replace the Fan-Tray Assembly” procedure on page 13-31. The red Fan Fail LED clears after you install a working fan tray.

15.12.3 Air Filter

The ONS 15454 contains a reusable air filter (for ANSI: 15454-FTF2; for ETSI: 15454E-ETSI-FTF) that is installed either below the fan-tray assembly or, for the ONS 15454 ANSI, in the optional external filter brackets.

The reusable filter is made of a gray, open-cell, polyurethane foam that is specially coated to provide fire and fungi resistance. All versions of the ONS 15454 can use the reusable air filter. Spare filters should be kept in stock. Inspect the air filter every 30 days, and clean the filter every three to six months. Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or solvents.

Earlier versions of the ONS 15454 ANSI shelf used a disposable air filter that is installed beneath the fan-tray assembly only. However, the reusable air filter is backward compatible.

15.13 Power and Ground Description

Ground the equipment according to Telcordia standards or local practices. The following sections describe power and ground for the ONS 15454 shelves.

15.13.1 ONS 15454 ANSI Power and Ground

Cisco recommends the following wiring conventions, but customer conventions prevail:

- Red wire for battery connections (–48 VDC).
- Black wire for battery return connections (0 VDC).
- The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE, Issue 3.

The ONS 15454 ANSI has redundant –48 VDC #8 power terminals on the shelf-assembly backplane. The terminals are labeled BAT1, RET1, BAT2, and RET2 and are located on the lower section of the backplane behind a clear plastic cover.

To install redundant power feeds, use four power cables and one ground cable. For a single power feed, only two power cables (#10 AWG, 2.588 mm² [0.1018 inch], copper conductor, 194°F [90°C]) and one ground cable (#6 AWG, 4.115 mm² [0.162 inch]) are required. Use a conductor with low impedance to ensure circuit overcurrent protection. However, the conductor must have the capability to safely conduct any faulty current that might be imposed.

Note

If you are installing power on a Release 3.0 ONS 15454 ANSI shelf assembly (15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1), the #12 to #14 AWG (2.053 to 1.628 mm²) power cable and #14 AWG (1.628 mm²) ground cable are required.
The existing ground post is a #10-32 bolt. The nut provided for a field connection is also a #10 AWG (2.588 mm² [0.1018 inch]), with an integral lock washer. The lug must be a dual-hole type and rated to accept the #6 AWG (4.115 mm² [0.162 inch]) cable. Two posts are provided on the ONS 15454 ANSI to accommodate the dual-hole lug. Figure 15-41 shows the location of the ground posts.

**Figure 15-41  Ground Posts on the ONS 15454 ANSI Backplane**

---

### 15.13.2 ONS 15454 ETSI Power and Ground

The ONS 15454 ETSI has redundant –48 VDC power connectors on the MIC-A/P and MIC-C/T/P faceplates.

To install redundant power feeds, use the two power cables shipped with the ONS 15454 ETSI and one ground cable. For details, see the “16.3.1 MIC-A/P FMEC” section on page 16-21 and the “16.3.2 MIC-C/T/P FMEC” section on page 16-24.

---

**Caution**

Only use the power cables shipped with the ONS 15454 ETSI.

### 15.14 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections

Pin connections are provided on the ONS 15454 ANSI backplane. For information about ONS 15454 ETSI connections, see the “15.8 ONS 15454 ETSI Front Mount Electrical Connection” section on page 15-30.

---

**Caution**

Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

The ONS 15454 ANSI has a backplane pin field located at the bottom of the backplane. The backplane pin field provides 0.045 inch² (29 mm²) wire-wrap pins for enabling external alarms, timing input and output, and craft interface terminals. This section describes the backplane pin field and the pin assignments for the field. Figure 15-42 shows the wire-wrap pins on the backplane pin field. Beneath each wire-wrap pin is a frame ground pin. Frame ground pins are labeled FG1, FG2, FG3, etc. Install the ground shield of the cables connected to the backplane to the ground pin that corresponds to the pin field used.
**Note**

The AIC-I requires a shelf assembly running Software Release 3.4.0 or later. The backplane of the ANSI shelf contains a wire-wrap field with pin assignment according to the layout in Figure 1-21 on page 1-54. The shelf assembly might be an existing shelf that has been upgraded to R3.4 or later. In this case the backplane pin labeling appears as indicated in Figure 15-42 on page 15-45, but you must use the pin assignments provided by the AIC-I as shown in Figure 1-21 on page 1-54.

### Figure 15-42 ONS 15454 ANSI Backplane Pinouts

<table>
<thead>
<tr>
<th>Field</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITS</td>
<td>A1</td>
<td>BITS Output 2 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>BITS Output 2 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>BITS Input 2 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>BITS Input 2 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>BITS Output 1 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>BITS Output 1 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>BITS Input 1 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B4</td>
<td>BITS Input 1 positive (+)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITS</td>
<td>A1</td>
<td>BITS Output 2 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>BITS Output 2 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>BITS Input 2 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>BITS Input 2 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>BITS Output 1 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>BITS Output 1 positive (+)</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>BITS Input 1 negative (-)</td>
</tr>
<tr>
<td></td>
<td>B4</td>
<td>BITS Input 1 positive (+)</td>
</tr>
</tbody>
</table>

### 15.14.1 Alarm Contact Connections

The alarm pin field supports up to 17 alarm contacts, including four audible alarms, four visual alarms, one alarm cutoff (ACO), and four user-definable alarm input and output contacts.
Audible alarm contacts are in the LOCAL ALARM AUD pin field and visual contacts are in the LOCAL ALARM VIS pin field. Both of these alarms are in the LOCAL ALARMS category. User-definable contacts are in the ENVIR ALARM IN (external alarm) and ENVIR ALARM OUT (external control) pin fields. These alarms are in the ENVIR ALARMS category; you must have the AIC-I card installed to use the ENVIR ALARMS. Alarm contacts are Normally Open (N/O), meaning that the system closes the alarm contacts when the corresponding alarm conditions are present. Each alarm contact consists of two wire-wrap pins on the shelf assembly backplane. Visual and audible alarm contacts are classified as Critical, Major, Minor, and Remote. \textit{Figure 15-42 on page 15-45} shows alarm pin assignments.

Visual and audible alarms are typically wired to trigger an alarm light or bell at a central alarm collection point when the corresponding contacts are closed. You can use the ACO pins to activate a remote ACO for audible alarms. You can also activate the ACO function by pressing the ACO button on the TCC2/TCC2P card faceplate. The ACO function clears all audible alarm indications. After clearing the audible alarm indication, the alarm is still present and viewable in the Alarms tab in CTC.

### 15.14.2 Timing Connections

The ONS 15454 ANSI backplane supports two building integrated timing supply (BITS) clock pin fields. The first four BITS pins, rows 3 and 4, support output and input from the first external timing device. The last four BITS pins, rows 1 and 2, perform the identical functions for the second external timing device. \textit{Table 15-13} lists the pin assignments for the BITS timing pin fields.

\begin{table}[h]
\centering
\begin{tabular}{|l|l|l|}
\hline
\textbf{External Device} & \textbf{Contact} & \textbf{Tip and Ring} & \textbf{Function} \\
\hline
First external device & A3 (BITS 1 Out) & Primary ring (–) & Output to external device \\
& B3 (BITS 1 Out) & Primary tip (+) & Output to external device \\
& A4 (BITS 1 In) & Secondary ring (–) & Input from external device \\
& B4 (BITS 1 In) & Secondary tip (+) & Input from external device \\
\hline
Second external device & A1 (BITS 2 Out) & Primary ring (–) & Output to external device \\
& B1 (BITS 2 Out) & Primary tip (+) & Output to external device \\
& A2 (BITS 2 In) & Secondary ring (–) & Input from external device \\
& B2 (BITS 2 In) & Secondary tip (+) & Input from external device \\
\hline
\end{tabular}
\caption{BITS External Timing Pin Assignments}
\end{table}

\textbf{Note}

For timing connection, use 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm$^2$ [0.020 inch] or 0.64 mm$^2$ [0.0252 inch]), twisted-pair T1-type.

Refer to Telcordia SR-NWT-002224 for rules about provisioning timing references.
15.14.3 LAN Connections

Use the LAN pins on the ONS 15454 ANSI backplane to connect the ONS 15454 ANSI to a workstation or Ethernet LAN, or to a LAN modem for remote access to the node. You can also use the LAN port on the TCC/TCC2P faceplate to connect a workstation or to connect the ONS 15454 ANSI to the network. Table 15-14 shows the LAN pin assignments.

Before you can connect an ONS 15454 ANSI to other ONS 15454 ANSI shelves or to a LAN, you must change the default IP address that is shipped with each ONS 15454 ANSI (192.1.0.2).

Table 15-14   LAN Pin Assignments

<table>
<thead>
<tr>
<th>Pin Field</th>
<th>Backplane Pins</th>
<th>RJ-45 Pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN 1 Connecting to data circuit-terminating equipment (DCE(^1), a hub or switch)</td>
<td>B2</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>A1</td>
<td>6</td>
</tr>
<tr>
<td>LAN 1 Connecting to data terminal equipment (DTE) (a PC/workstation or router)</td>
<td>B1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A1</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>6</td>
</tr>
</tbody>
</table>

\(^1\) The Cisco ONS 15454 ANSI is DCE.

15.14.4 TL1 Craft Interface Installation

You can use the craft pins on the ONS 15454 ANSI backplane or the EIA/TIA-232 port on the TCC2/TCC2P faceplate to create a VT100 emulation window to serve as a TL1 craft interface to the ONS 15454 ANSI. Use a straight-through cable to connect to the EIA/TIA-232 port. Table 15-15 shows the pin assignments for the CRAFT pin field.

Note

You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2/TCC2P card simultaneously.

Table 15-15   Craft Interface Pin Assignments

<table>
<thead>
<tr>
<th>Pin Field</th>
<th>Contact</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Craft</td>
<td>A1</td>
<td>Receive</td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>Transmit</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>DTR</td>
</tr>
</tbody>
</table>
15.15 Cards and Slots

ONS 15454 cards have electrical plugs at the back that plug into electrical connectors on the shelf assembly backplane. When the ejectors are fully closed, the card plugs into the assembly backplane. Figure 15-43 shows card installation for an ONS 15454 ANSI shelf.

Figure 15-43  Installing Cards in the ONS 15454 ANSI
15.15.1 Card Slot Requirements

The ONS 15454 shelf assemblies have 17 card slots numbered sequentially from left to right. Slots 7 and 11 are dedicated to TCC2/TCC2P cards. Slot 9 is reserved for the optional AIC-I card.

Caution
Do not operate the ONS 15454 with a single TCC2/TCC2P card. Always operate the shelf assembly with one working and one protect card of the same type.

Shelf assembly slots have symbols indicating the type of cards that you can install in them. Each ONS 15454 card has a corresponding symbol. The symbol on the card must match the symbol on the slot.


Table 15-16 shows the slot and card symbol definitions.

### Table 15-16  Slot and Card Symbols

<table>
<thead>
<tr>
<th>Symbol Color/Shape</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange/Circle</td>
<td>Slots 1 to 6 and 12 to 17. Only install cards with a circle symbol on the faceplate.</td>
</tr>
<tr>
<td>Blue/Triangle</td>
<td>Slots 5, 6, 12, and 13. Only install cards with circle or a triangle symbol on the faceplate.</td>
</tr>
<tr>
<td>Purple/Square</td>
<td>TCC2/TCC2P slot, Slots 7 and 11. Only install cards with a square symbol on the faceplate.</td>
</tr>
<tr>
<td>Green/Cross</td>
<td>Cross-connect (XC/XCVT/XC10G) slot, Slots 8 and 10. Only install ONS 15454 cards with a cross symbol on the faceplate.</td>
</tr>
<tr>
<td>Red/P</td>
<td>Protection slot in 1:N protection schemes.</td>
</tr>
<tr>
<td>Gold/Star</td>
<td>Slots 1 to 4 and 14 to 17. Only install cards with a star symbol on the faceplate.</td>
</tr>
<tr>
<td>Blue/Hexagon</td>
<td>(Only used with the 15454-SA-HD shelf assembly.) Slots 3 and 15. Only install ONS 15454 ANSI cards with a blue hexagon symbol on the faceplate.</td>
</tr>
</tbody>
</table>

### 15.15.2 Card Replacement

To replace an ONS 15454 card with another card of the same type, you do not need to make any changes to the database; remove the old card and replace it with a new card. To replace a card with a card of a different type, physically remove the card and replace it with the new card, then delete the original card from CTC. For specifics, see Chapter 13, “Maintain the Node.”

**Caution**

Removing any active card from the ONS 15454 can result in traffic interruption. Use caution when replacing cards and verify that only inactive or standby cards are being replaced. If the active card needs to be replaced, switch it to standby prior to removing the card from the node. For traffic switching procedures, refer to the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-35.

**Note**

An improper removal (IMPROPRMVL) alarm is raised whenever a card pull (reseat) is performed, unless the card is deleted in CTC first. The alarm clears after the card replacement is complete.

### 15.16 Ferrites (ANSI Only)

Place third-party ferrites on certain cables to dampen electromagnetic interference (EMI) from the ONS 15454 ANSI. Ferrites must be added to meet the requirements of Telcordia GR-1089-CORE. Refer to the ferrite manufacturer documentation for proper use and installation of the ferrites. Ferrite placements on the ONS 15454 ANSI can include power cables, AMP Champ connectors, baluns, BNC/SMB connectors, and the wire-wrap pin field.
Card Reference

Note

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path protection feature, which may be used in any topological network configuration. Cisco does not recommend using its path protection feature in any particular topological network configuration.

This chapter describes Cisco ONS 15454 dense wavelength division multiplexing (DWDM) card and client card features and functions. It also describes the common control cards needed to support them as well as the optical plug-in modules (Small Form-factor Pluggables [SFPs]). For installation and card turn-up procedures, refer to Chapter 3, “Turn Up a Node.” For card safety and compliance information, refer to the Cisco Optical Transport Products Safety and Compliance Information document.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

- 16.1 Card Overview, page 16-2
- 16.2 Common Control Cards, page 16-9
- 16.3 Front Mount Electrical Connections, page 16-21
- 16.4 Optical Service Channel Cards, page 16-25
- 16.5 Optical Amplifier Cards, page 16-34
- 16.6 Multiplexer and Demultiplexer Cards, page 16-45
- 16.7 Optical Add/Drop Multiplexer Cards, page 16-59
- 16.8 Transponder and Muxponder Cards, page 16-82
- 16.9 Transponder and Muxponder Protection, page 16-114
- 16.10 Far-End Laser Control (FELC), page 16-116
- 16.11 Jitter Considerations, page 16-116
- 16.12 Termination Modes, page 16-117
- 16.13 SFP and XFP Modules, page 16-118
16.1 Card Overview

The card overview section lists the cards described in this chapter and summarizes card functions, power consumption, and temperature ranges of the optical cards covered in this reference section.

**Note**

Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. The cards are then installed into slots displaying the same symbols. See the “15.15.1 Card Slot Requirements” section on page 15-49 for a list of slots and symbols.

16.1.1 Common Control Cards

The following common control cards are needed to support the functions of the DWDM, transponder, and muxponder cards:

- TCC2 or TCC2P
- AIC-I (optional)

16.1.2 Front Mount Electrical Connections (ETSI only)

The following Front Mount Electrical Connections (FMECs) are needed to support the functions of the DWDM, transponder, and muxponder cards:

- MIC-A/P
- MIC-C/T/P

16.1.3 DWDM Cards

ONS 15454 DWDM cards are grouped into the following categories:

- Optical service channel cards—These cards provide channels that connect ONS 15454 DWDM nodes and transport general-purpose information (including Cisco Transport Controller [CTC] management) without affecting the client traffic. ONS 15454 optical service channel cards include the Optical Service Channel Module (OSCM) and the Optical Service Channel and Combiner/Separator Module (OSC-CSM).

- Optical amplifier cards—These cards are used in amplified DWDM nodes, including hub nodes, amplified OADM nodes, and line amplified nodes. Optical amplifier cards include the Optical Preamplifier (OPT-PRE), Optical Booster (OPT-BST), and Optical Booster Enhanced (OPT-BST-E) amplifier.

- Dispersion compensation units—These cards are installed in the ONS 15454 dispersion compensation shelf when optical preamplifier cards are installed in the DWDM node. Each dispersion compensation unit (DCU) module is designed to compensate a specific fiber length, up to a maximum (per-module) of 65 km of standard single-mode fiber (SMF-28). DCUs can be cascaded to extend the compensation to 130 km.

- Multiplexer and demultiplexer cards—These cards multiplex and demultiplex DWDM optical channels. ONS 15454 multiplexer and demultiplexer cards include the 32-Channel Multiplexer (32MUX-O), the 32-Channel Demultiplexer (32DMX-O), the single-slot 32-Channel Demultiplexer (32DMX), and the 4-Channel Multiplexer/Demultiplexer (4MD-xx.x).
• Optical Add/Drop Multiplexer (OADM) cards—These cards are mainly divided into two groups: band OADM and channel OADM cards. Band OADM cards add and drop one or four bands of adjacent channels; they include the 4-Band OADM (AD-4B-xx.x) and the 1-Band OADM (AD-1B-xx.x). Channel OADM cards add and drop one, two, or four adjacent channels; they include the 4-Channel OADM (AD-4C-xx.x), the 2-Channel OADM (AD-2C-xx.x), and the 1-Channel OADM (AD-1C-xx.x). This section also covers the 32-Channel Wavelength Selective Switch (32WSS) used to implement Reconfigurable OADM (ROADM) functionality.

16.1.4 Transponder and Muxponder Cards

The purpose of a transponder (TXP) or muxponder (MXP) card is to convert the “gray” optical client interface signals into trunk signals that operate in the “colored” DWDM wavelength range. Transponding or muxponding is the process of converting the signals between the client and trunk wavelengths.

A muxponder generally handles several client signals. It aggregates, or multiplexes, lower rate client signals together and sends them out over a higher rate trunk port. Likewise, it demultiplexes optical signals coming in on a trunk and sends them out to individual client ports. A transponder converts a single client signal to a single trunk signal and converts a single incoming trunk signal to a single client signal.

All of the TXP and MXP cards perform optical to electrical to optical (OEO) conversion. As a result, they are not optically transparent cards. The reason for this is that the cards must operate on the signals passing through them, so it is necessary to do an OEO conversion.

On the other hand, the termination mode for all of the TXPs and MXPs, which is done at the electrical level, can be configured to be transparent. In this case, neither the Line nor the Section overhead is terminated. The cards can also be configured so that either Line or Section overhead can be terminated, or both can be terminated.

Note

The MXP_2.5G_10G card, by design, when configured in the transparent termination mode, actually does terminate some of the bytes. See Table 16-68 on page 16-117 for details.

16.1.5 Card Summary

Table 16-1 lists and summarizes the functions of each Cisco ONS 15454 DWDM and client card.

<table>
<thead>
<tr>
<th>Card</th>
<th>Port Description</th>
<th>For Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optical Service Channel Cards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSCM</td>
<td>The OSCM has one set of optical ports and one Ethernet port located on the faceplate. It operates in Slots 8 and 10.</td>
<td>See the “16.4.1 OSCM Card” section on page 16-26.</td>
</tr>
</tbody>
</table>

1. Client-facing gray optical signals generally operate at shorter wavelengths, whereas DWDM colored optical signals are in the longer wavelength range (for example, 1490 nm = violet; 1510 nm = blue; 1530 nm = green; 1550 nm = yellow; 1570 nm = orange; 1590 nm = red; 1610 nm = brown). Some of the newer client-facing SFPs, however, operate in the colored region.
### Table 16-1 DWDM and Client Cards for the ONS 15454 (continued)

<table>
<thead>
<tr>
<th>Card</th>
<th>Port Description</th>
<th>For Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSC-CSM</td>
<td>The OSC-CSM has three sets of optical ports and one Ethernet port located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.4.2 OSC-CSM Card” section on page 16-29.</td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>The OPT-PRE amplifier has five optical ports (three sets) located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.5.1 OPT-PRE Amplifier” section on page 16-35.</td>
</tr>
<tr>
<td>OPT-BST</td>
<td>The OPT-BST amplifier has four sets of optical ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.5.2 OPT-BST Amplifier Card” section on page 16-38.</td>
</tr>
<tr>
<td>OPT-BST-E</td>
<td>The OPT-BST-E amplifier has four sets of optical ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.5.3 OPT-BST-E Amplifier Card” section on page 16-41.</td>
</tr>
<tr>
<td>32MUX-O</td>
<td>The 32MUX-O has five sets of ports located on the faceplate. It operates in Slots 1 to 5 and 12 to 16.</td>
<td>See the “16.6.1 32MUX-O Card” section on page 16-45.</td>
</tr>
<tr>
<td>32DMX-O</td>
<td>The 32DMX-O has five sets of ports located on the faceplate. It operates in Slots 1 to 5 and 12 to 16.</td>
<td>See the “16.6.2 32DMX-O Card” section on page 16-49.</td>
</tr>
<tr>
<td>32DMX</td>
<td>The 32DMX has five sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.6.3 32DMX Card” section on page 16-52</td>
</tr>
<tr>
<td>4MD-xx.x</td>
<td>The 4MD-xx.x card has five sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.6.4 4MD-xx.x Card” section on page 16-55.</td>
</tr>
<tr>
<td>AD-1C-xx.x</td>
<td>The AD-1C-xx.x card has three sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.7.1 AD-1C-xx.x Card” section on page 16-59.</td>
</tr>
<tr>
<td>AD-2C-xx.x</td>
<td>The AD-2C-xx.x card has four sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.7.2 AD-2C-xx.x Card” section on page 16-62.</td>
</tr>
<tr>
<td>AD-4C-xx.x</td>
<td>The AD-4C-xx.x card has six sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.7.3 AD-4C-xx.x Card” section on page 16-66.</td>
</tr>
<tr>
<td>AD-1B-xx.x</td>
<td>The AD-1B-xx.x card has three sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.7.4 AD-1B-xx.x Card” section on page 16-70.</td>
</tr>
<tr>
<td>AD-4B-xx.x</td>
<td>The AD-4B-xx.x card has six sets of ports located on the faceplate. It operates in Slots 1 to 6 and 12 to 17.</td>
<td>See the “16.7.5 AD-4B-xx.x Card” section on page 16-73.</td>
</tr>
<tr>
<td>32WSS</td>
<td>The 32WSS card has seven sets of ports located on the faceplate. It operates in Slots 1 to 5 and 12 to 16.</td>
<td>See the “16.7.6 32WSS Card” section on page 16-76.</td>
</tr>
</tbody>
</table>
16.1.6 Card Compatibility

Table 16-2 lists the CTC software compatibility for each DWDM and client card.

Table 16-2  DWDM and Client Card CTC Software Release Compatibility

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optical Service Channel Cards</strong></td>
<td></td>
</tr>
<tr>
<td>OSCM</td>
<td>Yes</td>
</tr>
<tr>
<td>OSC-CSM</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Optical Amplifier Cards</strong></td>
<td></td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>Yes</td>
</tr>
<tr>
<td>OPT-BST</td>
<td>Yes</td>
</tr>
<tr>
<td>OPT-BST-E</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Multiplexer and Demultiplexer Cards</strong></td>
<td></td>
</tr>
<tr>
<td>32MUX-O</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 16-2  DWDM and Client Cards for the ONS 15454 (continued)

<table>
<thead>
<tr>
<th>Card</th>
<th>Port Description</th>
<th>For Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP_MR_10G</td>
<td>The TXP_MR_10G card has two sets of ports located on the faceplate.</td>
<td>See the “16.8.1 TXP_MR_10G Card” section on page 16-82</td>
</tr>
<tr>
<td>TXP_MR_10E</td>
<td>The TXP_MR_10E card has two sets of ports located on the faceplate.</td>
<td>See the “16.8.2 TXP_MR_10E Card” section on page 16-84</td>
</tr>
<tr>
<td>TXP_MR_2.5G</td>
<td>The TXP_MR_2.5G card has two sets of ports located on the faceplate.</td>
<td>See the “16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards” section on page 16-88</td>
</tr>
<tr>
<td>TXPP_MR_2.5G</td>
<td>The TXPP_MR_2.5G card has three sets of ports located on the faceplate.</td>
<td>See the “16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards” section on page 16-88</td>
</tr>
<tr>
<td>MXP_2.5G_10G</td>
<td>The MXP_2.5G_10G card has 9 sets of ports located on the faceplate.</td>
<td>See the “16.8.4 MXP_2.5G_10G Card” section on page 16-95</td>
</tr>
<tr>
<td>MXP_2.5G_10E</td>
<td>The MXP_2.5G_10E card has 9 sets of ports located on the faceplate.</td>
<td>See the “16.8.5 MXP_2.5G_10E Card” section on page 16-99</td>
</tr>
<tr>
<td>MXP_MR_2.5G</td>
<td>The MXP_MR_2.5G card has 9 sets of ports located on the faceplate.</td>
<td>See the “16.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards” section on page 16-106</td>
</tr>
<tr>
<td>MXPP_MR_2.5G</td>
<td>The MXPP_MR_2.5G card has ten sets of ports located on the faceplate.</td>
<td>See the “16.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards” section on page 16-106</td>
</tr>
</tbody>
</table>
The 32MUX-O, 32DMX, 32DMX-O, 32DMX-N, 32WSS, 32DMX, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x cards have different input and output optical channel signals depending upon the interface card where the input signal originates. The input interface cards have been grouped in classes listed in Table 16-3. The subsequent tables list the optical performances and output power of each interface class.

### Table 16-2 DWDM and Client Card CTC Software Release Compatibility (continued)

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>R4.5</td>
</tr>
<tr>
<td>32DMX-O</td>
<td>Yes</td>
</tr>
<tr>
<td>32DMX</td>
<td>No</td>
</tr>
<tr>
<td>4MD-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>Optical Add/Drop Multiplexer Cards</td>
<td></td>
</tr>
<tr>
<td>AD-1C-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>AD-2C-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>AD-4C-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>AD-1B-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>AD-4B-xx.x</td>
<td>Yes</td>
</tr>
<tr>
<td>32WSS</td>
<td>No</td>
</tr>
<tr>
<td>Transponder and Muxponder Cards</td>
<td></td>
</tr>
<tr>
<td>TXP_MR_10G</td>
<td>Yes</td>
</tr>
<tr>
<td>TXP_MR_10E</td>
<td>No</td>
</tr>
<tr>
<td>TXP_MR_2.5G</td>
<td>Yes</td>
</tr>
<tr>
<td>TXP_PP_2.5G</td>
<td>Yes</td>
</tr>
<tr>
<td>MXP_2.5G_10G</td>
<td>Yes</td>
</tr>
<tr>
<td>MXP_2.5G_10E</td>
<td>No</td>
</tr>
<tr>
<td>MXP_PP_2.5G</td>
<td>No</td>
</tr>
<tr>
<td>MXP_PP_2.5G</td>
<td>No</td>
</tr>
</tbody>
</table>

### 16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes

The 32MUX-O, 32WSS, 32DMX, 32DMX-O, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x cards have different input and output optical channel signals depending upon the interface card where the input signal originates. The input interface cards have been grouped in classes listed in Table 16-3. The subsequent tables list the optical performances and output power of each interface class.

### Table 16-3 ONS 15454 Card Interfaces Assigned to Input Power Classes

<table>
<thead>
<tr>
<th>Input Power Class</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10-Gbps multirate transponder (TXP_MR_10G or TXP_MR_10E) with forward error correction (FEC) enabled or 10-Gbps muxponder (MXP_2.5G_10G or MXP_2.5G_10E) with FEC enabled</td>
</tr>
<tr>
<td>B</td>
<td>10-Gbps multirate transponder (TXP_MR_10G) without FEC or 10-Gbps muxponder (MXP_2.5G_10G) with FEC disabled</td>
</tr>
<tr>
<td>C</td>
<td>OC-192 LR ITU, TXP_MR_10E without FEC</td>
</tr>
<tr>
<td>D</td>
<td>2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and unprotected, with FEC enabled</td>
</tr>
</tbody>
</table>
10-Gbps cards that provide signal input to OADM cards have the optical performance parameters listed in Table 16-4. 2.5-Gbps card interface performance parameters are listed in Table 16-5 on page 16-8.

### Table 16-4 10-Gbps Interface Optical Performance

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Class A</th>
<th>Class B</th>
<th>Class C</th>
<th>Class I</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum bit rate</td>
<td>10 Gbps</td>
<td>10 Gbps</td>
<td>10 Gbps</td>
<td>10 Gbps</td>
</tr>
<tr>
<td>Regeneration</td>
<td>3R</td>
<td>3R</td>
<td>3R</td>
<td>3R</td>
</tr>
<tr>
<td>FEC</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes (E-FEC)</td>
</tr>
<tr>
<td>Threshold</td>
<td>Optimum</td>
<td>Average</td>
<td>Average</td>
<td>Optimum</td>
</tr>
<tr>
<td>Maximum BER&lt;sup&gt;2&lt;/sup&gt;</td>
<td>$10^{-15}$</td>
<td>$10^{-12}$</td>
<td>$10^{-12}$</td>
<td>$10^{-15}$</td>
</tr>
<tr>
<td>Power sensitivity</td>
<td>23 dB</td>
<td>9 dB</td>
<td>23 dB</td>
<td>19 dB</td>
</tr>
<tr>
<td>Power overload</td>
<td>$-24$ dBm</td>
<td>$-18$ dBm</td>
<td>$-21$ dBm</td>
<td>$-20$ dBm</td>
</tr>
<tr>
<td>Transmitted Power Range&lt;sup&gt;3&lt;/sup&gt;</td>
<td>$-8$ dBm</td>
<td>$-8$ dBm</td>
<td>$-9$ dBm</td>
<td>$-8$ dBm</td>
</tr>
<tr>
<td>10-Gbps multirate transponder/10-Gbps FEC transponder (TXP_MR_10G)</td>
<td>+2.5 to 3.5 dBm</td>
<td>+2.5 to 3.5 dBm</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>OC-192 LR ITU</td>
<td>---</td>
<td>---</td>
<td>+3.0 to 6.0 dBm</td>
<td>---</td>
</tr>
<tr>
<td>10-Gbps multirate transponder/10-Gbps FEC transponder (TXP_MR_10E)</td>
<td>+3.0 to 6.0 dBm</td>
<td>+3.0 to 6.0 dBm</td>
<td>---</td>
<td>+3.0 to 6.0 dBm</td>
</tr>
<tr>
<td>Dispersion compensation tolerance</td>
<td>+/-800 ps/nm</td>
<td>+/-1,000 ps/nm</td>
<td>+/-1,000 ps/nm</td>
<td>+/-800 ps/nm</td>
</tr>
</tbody>
</table>

1. OSNR = optical signal-to-noise ratio
2. BER = bit error rate
Table 16-6 | DWDM Card Channel Allocation Plan

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Class D</th>
<th>Class E</th>
<th>Class F</th>
<th>Class G</th>
<th>Class H</th>
<th>Class J</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power Limited</td>
<td>OSNR Limited</td>
<td>Power Limited</td>
<td>OSNR Limited</td>
<td>Power Limited</td>
<td>OSNR Limited</td>
</tr>
<tr>
<td>Maximum bit rate</td>
<td>2.5 Gbps</td>
<td>2.5 Gbps</td>
<td>2.5 Gbps</td>
<td>2.5 Gbps</td>
<td>1.25 Gbps</td>
<td>2.5 Gbps</td>
</tr>
<tr>
<td>Regeneration</td>
<td>3R</td>
<td>3R</td>
<td>2R</td>
<td>3R</td>
<td>3R</td>
<td>3R</td>
</tr>
<tr>
<td>FEC</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Threshold</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
</tr>
<tr>
<td>Maximum BER</td>
<td>$10^{-15}$</td>
<td>$10^{-12}$</td>
<td>$10^{-12}$</td>
<td>$10^{-12}$</td>
<td>$10^{-12}$</td>
<td>$10^{-12}$</td>
</tr>
<tr>
<td>OSNR sensitivity</td>
<td>14 dB</td>
<td>{6 dB}</td>
<td>14 dB</td>
<td>10 dB</td>
<td>14 dB</td>
<td>11 dB</td>
</tr>
<tr>
<td>Power sensitivity</td>
<td>–31 dBm</td>
<td>–25 dBm</td>
<td>–30 dBm</td>
<td>–23 dBm</td>
<td>–24 dBm</td>
<td>–27 dBm</td>
</tr>
<tr>
<td>Power overload</td>
<td>–9 dBm</td>
<td>–9 dBm</td>
<td>–9 dBm</td>
<td>–9 dBm</td>
<td>–7 dBm</td>
<td>–17 dBm</td>
</tr>
<tr>
<td>Transmitted Power Range&lt;sup&gt;1&lt;/sup&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TXP_MR_2.5G</td>
<td>–1.0 to 1.0 dBm</td>
<td>–1.0 to 1.0 dBm</td>
<td>–1.0 to 1.0 dBm</td>
<td>–2.0 to 0 dBm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TXPP_MR_2.5G</td>
<td>–4.5 to –2.5 dBm</td>
<td>–4.5 to –2.5 dBm</td>
<td>–4.5 to –2.5 dBm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP_MR_2.5G</td>
<td></td>
<td>+2.0 to +4.0 dBm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXPP_MR_2.5G</td>
<td></td>
<td>–1.5 to +0.5 dBm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/4 port GbE Transponder (GBIC WDM 100GHz)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dispersion compensation tolerance</td>
<td>–1200 to +5400 ps/nm</td>
<td>–1200 to +5400 ps/nm</td>
<td>–1200 to +3300 ps/nm</td>
<td>–1200 to +3300 ps/nm</td>
<td>–1000 to +3600 ps/nm</td>
<td>–1000 to +3200 ps/nm</td>
</tr>
</tbody>
</table>

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

16.1.8 DWDM Card Channel Allocation Plan

ONS 15454 DWDM multiplexers, demultiplexers, channel OADM, and band OADM cards are designed for use with specific channels. In most cases, the channels for these cards are either numbered (1 to 32) or delimited (odd or even). Client interfaces must comply with these channel assignments to be compatible with the ONS 15454 system.

Table 16-6 lists the channel IDs and wavelengths assigned to the DWDM channels.
Table 16-6  DWDM Channel Allocation Plan

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Channel ID</th>
<th>Frequency (THz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td>2</td>
<td>31.2</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td>3</td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td>4</td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td>5</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td>6</td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td>7</td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td>8</td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td>9</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td>10</td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td>11</td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td>12</td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td>13</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td>14</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td>15</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td>16</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td>17</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td>18</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td>19</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td>20</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td>21</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td>22</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td>23</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td>24</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td>25</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td>26</td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td>27</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td>28</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
</tr>
<tr>
<td>29</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td>30</td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td>31</td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td>32</td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
</tbody>
</table>

16.2 Common Control Cards

This section describes the common control cards (TCC2, TCC2P, and AIC-I).
16.2.1 TCC2 Card

The Advanced Timing, Communications, and Control (TCC2) card performs system initialization, provisioning, alarm reporting, maintenance, diagnostics, IP address detection/resolution, SONET section overhead (SOH) data communications channel/generic communications channel (DCC/GCC) termination, optical service channel (OSC) DWDM data communications network (DCN) termination, and system fault detection for the ONS 15454. The TCC2 also ensures that the system maintains Stratum 3 (Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system.

**Note**

The LAN interface of the TCC2 card meets the standard Ethernet specifications by supporting a cable length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius).

*Figure 16-1* shows the faceplate and block diagram for the TCC2.
16.2.1 TCC2 Functionality

The TCC2 card terminates up to 32 DCCs. The TCC2 hardware is prepared for up to 84 DCCs, which will be available in a future software release.

The node database, IP address, and system software are stored in TCC2 nonvolatile memory, which allows quick recovery in the event of a power or card failure.
The TCC2 performs all system-timing functions for each ONS 15454. The TCC2 monitors the recovered clocks from each traffic card and two building integrated timing supply (BITS) ports for frequency accuracy. The TCC2 selects a recovered clock, a BITS, or an internal Stratum 3 reference as the system-timing reference. You can provision any of the clock inputs as primary or secondary timing sources. A slow-reference tracking loop allows the TCC2 to synchronize with the recovered clock, which provides holdover if the reference is lost.

The TCC2 monitors both supply voltage inputs on the shelf. An alarm is generated if one of the supply voltage inputs has a voltage out of the specified range.

Install TCC2 cards in Slots 7 and 11 for redundancy. If the active TCC2 fails, traffic switches to the protect TCC2.

The TCC2 card has two built-in interface ports for accessing the system: an RJ-45 10BaseT LAN interface and an EIA/TIA-232 ASCII interface for local craft access. It also has a 10BaseT LAN port for user interfaces via the backplane.

16.2.1.2 Redundant TCC2 Card Installation

Cisco does not support operation of the ONS 15454 with only one TCC2 card. For full functionality and to safeguard your system, always operate with two TCC2 cards.

When a second TCC2 card is inserted into a node, it synchronizes its software, its backup software, and its database with the active TCC2. If the software version of the new TCC2 does not match the version on the active TCC2, the newly inserted TCC2 copies from the active TCC2, taking about 15 to 20 minutes to complete. If the backup software version on the new TCC2 does not match the version on the active TCC2, the newly inserted TCC2 copies the backup software from the active TCC2 again, taking about 15 to 20 minutes. Copying the database from the active TCC2 takes about 3 minutes. Depending on the software version and backup version the new TCC2 started with, the entire process can take between 3 and 40 minutes.

16.2.1.3 TCC2 Card-Level Indicators

The TCC2 faceplate has eight LEDs. Table 16-7 describes the two card-level LEDs on the TCC2 faceplate.

<table>
<thead>
<tr>
<th>Card-Level LEDs</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>This LED is on during reset. The FAIL LED flashes during the boot and write process. Replace the card if the FAIL LED persists.</td>
</tr>
<tr>
<td>ACT/STBY LED</td>
<td>Indicates the TCC2 is active (green) or in standby (yellow) mode. The ACT/STBY LED also provides the timing reference and shelf control. When the active TCC2 is writing to its database or to the standby TCC2 database, the card LEDs blink. To avoid memory corruption, do not remove the TCC2 when the active or standby LED is blinking.</td>
</tr>
</tbody>
</table>

16.2.1.4 Network-Level Indicators

Table 16-8 describes the six network-level LEDs on the TCC2 faceplate.
16.2.2 TCC2P Card

The Advanced Timing, Communications, and Control Plus (TCC2P) card is an enhanced version of the TCC2 card. The primary enhancements are Ethernet security features and 64K composite clock BITS timing.

The TCC2P card performs system initialization, provisioning, alarm reporting, maintenance, diagnostics, IP address detection/resolution, SONET SOH DCC/GCC termination, and system fault detection for the ONS 15454. The TCC2P also ensures that the system maintains Stratum 3 (Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system.

**Note**

The LAN interface of the TCC2P card meets the standard Ethernet specifications by supporting a cable length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius). The interfaces can operate with a cable length of 32.8 ft (10 m) maximum at temperatures from –40 to 32 degrees Fahrenheit (–40 to 0 degrees Celsius).

Figure 16-2 shows the faceplate and block diagram for the TCC2P card.
Figure 16-2 TCC2P Faceplate and Block Diagram

-48V PWR Monitors
Real Time Clock
400MHz Processor
SDRAM Memory & Compact Flash
Faceplate Ethernet Port
RS-232 Port

System Timing
FPGA
DCC Processor
TCCA ASIC SCL Processor

MCC1 MCC2
SMC1 SCC2
SCC3
FCC1
SCC4 FCC2
Communications Processor

Ethernet Switch

RS-232 Craft Interface

Faceplate RS-232 Port

Note: Only 1 RS-232 Port Can Be Active - Backplane Port Will Supercede Faceplate Port
16.2.3 TCC2P Functionality

The TCC2P card supports multichannel, high-level data link control (HDLC) processing for the DCC. Up to 84 DCCs can be routed over the TCC2P card and up to 84 section DCCs can be terminated at the TCC2P card (subject to the available optical digital communication channels). The TCC2P selects and processes 84 DCCs to facilitate remote system management interfaces.

The TCC2P card also originates and terminates a cell bus carried over the module. The cell bus supports links between any two cards in the node, which is essential for peer-to-peer communication. Peer-to-peer communication accelerates protection switching for redundant cards.

The node database, IP address, and system software are stored in TCC2P card nonvolatile memory, which allows quick recovery in the event of a power or card failure.

The TCC2P card performs all system-timing functions for each ONS 15454. The TCC2P card monitors the recovered clocks from each traffic card and two BITS ports for frequency accuracy. The TCC2P card selects a recovered clock, a BITS, or an internal Stratum 3 reference as the system-timing reference. You can provision any of the clock inputs as primary or secondary timing sources. A slow-reference tracking loop allows the TCC2P card to synchronize with the recovered clock, which provides holdover if the reference is lost.

The TCC2P card supports 64/8K composite clock and 6.312 MHz timing output.

The TCC2P card monitors both supply voltage inputs on the shelf. An alarm is generated if one of the supply voltage inputs has a voltage out of the specified range.

Install TCC2P cards in Slots 7 and 11 for redundancy. If the active TCC2P card fails, traffic switches to the protect TCC2P card. All TCC2P card protection switches conform to protection switching standards when the bit error rate (BER) counts are not in excess of 1 * 10 exp – 3 and completion time is less than 50 ms.

The TCC2P card has two built-in Ethernet interface ports for accessing the system: one built-in RJ-45 port on the front faceplate for on-site craft access and a second port on the backplane. The rear Ethernet interface is for permanent LAN access and all remote access via TCP/IP as well as for Operations Support System (OSS) access. The front and rear Ethernet interfaces can be provisioned with different IP addresses using CTC.

Two EIA/TIA-232 serial ports, one on the faceplate and a second on the backplane, allow for craft interface in TL1 mode.

16.2.3.1 Redundant TCC2P Card Installation

Cisco does not support operation of the ONS 15454 with only one TCC2P card. For full functionality and to safeguard your system, always operate with two TCC2P cards.

When a second TCC2P card is inserted into a node, it synchronizes its software, its backup software, and its database with the active TCC2P card. If the software version of the new TCC2P card does not match the version on the active TCC2P card, the newly inserted TCC2P card copies from the active TCC2P card, taking about 15 to 20 minutes to complete. If the backup software version on the new TCC2P card does not match the version on the active TCC2P card, the newly inserted TCC2P card copies the backup software from the active TCC2P card again, taking about 15 to 20 minutes. Copying the database from the active TCC2P card takes about 3 minutes. Depending on the software version and backup version the new TCC2P card started with, the entire process can take between 3 and 40 minutes.
16.2.3.2 TCC2P Card-Level Indicators

The TCC2P faceplate has eight LEDs. Table 16-9 describes the two card-level LEDs on the TCC2P faceplate.

<table>
<thead>
<tr>
<th>Card-Level LEDs</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>This LED is on during reset. The FAIL LED flashes during the boot and write process. Replace the card if the FAIL LED persists.</td>
</tr>
<tr>
<td>ACT/STBY LED</td>
<td>Indicates the TCC2P is active (green) or in standby (amber) mode. The ACT/STBY LED also provides the timing reference and shelf control. When the active TCC2P is writing to its database or to the standby TCC2P database, the card LEDs blink. To avoid memory corruption, do not remove the TCC2P when the active or standby LED is blinking.</td>
</tr>
</tbody>
</table>

16.2.3.3 Network-Level Indicators

Table 16-10 describes the six network-level LEDs on the TCC2P faceplate.

<table>
<thead>
<tr>
<th>System-Level LEDs</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red CRIT LED</td>
<td>Indicates critical alarms in the network at the local terminal.</td>
</tr>
<tr>
<td>Red MAJ LED</td>
<td>Indicates major alarms in the network at the local terminal.</td>
</tr>
<tr>
<td>Amber MIN LED</td>
<td>Indicates minor alarms in the network at the local terminal.</td>
</tr>
<tr>
<td>Red REM LED</td>
<td>Provides first-level alarm isolation. The remote (REM) LED turns red when an alarm is present in one or more of the remote terminals.</td>
</tr>
<tr>
<td>Green SYNC LED</td>
<td>Indicates that node timing is synchronized to an external reference.</td>
</tr>
<tr>
<td>Green ACO LED</td>
<td>After pressing the ACO button, the ACO LED turns green. The ACO button opens the audible alarm closure on the backplane. ACO is stopped if a new alarm occurs. After the originating alarm is cleared, the ACO LED and audible alarm control are reset.</td>
</tr>
</tbody>
</table>

16.2.4 AIC-I Card

The optional Alarm Interface Controller–International (AIC-I) card provides customer-defined (environmental) alarms and controls and supports local and express orderwire. It provides 12 customer-defined input and 4 customer-defined input/output contacts. The physical connections are via the backplane wire-wrap pin terminals. If you use the additional alarm expansion panel (AEP), the AIC-I card can support up to 32 inputs and 16 outputs, which are connected on the AEP connectors. The AEP is compatible with ANSI shelves only. A power monitoring function monitors the supply voltage (–48 VDC). Figure 16-3 shows the AIC-I faceplate and a block diagram of the card.
### 16.2.4.1 AIC-I Card-Level Indicators

Table 16-11 describes the eight card-level LEDs on the AIC-I card faceplate.

<table>
<thead>
<tr>
<th>Card-Level LEDs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>Indicates that the card’s processor is not ready. The FAIL LED is on during reset and flashes during the boot process. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>Indicates the AIC-I card is provisioned for operation.</td>
</tr>
</tbody>
</table>
16.2.4 AIC-I Card

16.2.4.2 External Alarms and Controls

The AIC-I card provides input/output alarm contact closures. You can define up to 12 external alarm inputs and 4 external alarm inputs/outputs (user configurable). The physical connections are made using the backplane wire-wrap pins or FMEC connections. See the “15.9 ONS 15454 ANSI Alarm Expansion Panel” section on page 15-30 for information about increasing the number of input/output contacts.

LEDs on the front panel of the AIC-I indicate the status of the alarm lines, one LED representing all of the inputs and one LED representing all of the outputs. External alarms (input contacts) are typically used for external sensors such as open doors, temperature sensors, flood sensors, and other environmental conditions. External controls (output contacts) are typically used to drive visual or audible devices such as bells and lights, but they can control other devices such as generators, heaters, and fans.

You can program each of the twelve input alarm contacts separately. You can program each of the sixteen input alarm contacts separately. Choices include:

- Alarm on Closure or Alarm on Open
- Alarm severity of any level (Critical, Major, Minor, Not Alarmed, Not Reported)
- Service Affecting or Non-Service Affecting alarm-service level
- 63-character alarm description for CTC display in the alarm log.

You cannot assign the fan-tray abbreviation for the alarm; the abbreviation reflects the generic name of the input contacts. The alarm condition remains raised until the external input stops driving the contact or you provision the alarm input.

The output contacts can be provisioned to close on a trigger or to close manually. The trigger can be a local alarm severity threshold, a remote alarm severity, or a virtual wire:

- Local NE alarm severity: A hierarchy of Not Reported, Not Alarmed, Minor, Major, or Critical alarm severities that you set to cause output closure. For example, if the trigger is set to Minor, a Minor alarm or above is the trigger.
- Remote NE alarm severity: Same as the local NE alarm severity but applies to remote alarms only.

<table>
<thead>
<tr>
<th>Card-Level LEDs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green/red PWR A LED</td>
<td>The PWR A LED is green when a supply voltage within a specified range has been sensed on supply input A. It is red when the input voltage on supply input A is out of range.</td>
</tr>
<tr>
<td>Green/red PWR B LED</td>
<td>The PWR B LED is green when a supply voltage within a specified range has been sensed on supply input B. It is red when the input voltage on supply input B is out of range.</td>
</tr>
<tr>
<td>Yellow INPUT LED</td>
<td>The INPUT LED is yellow when there is an alarm condition on at least one of the alarm inputs.</td>
</tr>
<tr>
<td>Yellow OUTPUT LED</td>
<td>The OUTPUT LED is yellow when there is an alarm condition on at least one of the alarm outputs.</td>
</tr>
<tr>
<td>Green RING LED</td>
<td>The RING LED on the local orderwire (LOW) side is flashing green when a call is received on the LOW.</td>
</tr>
<tr>
<td>Green RING LED</td>
<td>The RING LED on the express orderwire (EOW) side is flashing green when a call is received on the EOW.</td>
</tr>
</tbody>
</table>
Virtual wire entities: You can provision any environmental alarm input to raise a signal on any virtual wire on external outputs 1 through 4 when the alarm input is an event. You can provision a signal on any virtual wire as a trigger for an external control output.

You can also program the output alarm contacts (external controls) separately. In addition to provisionable triggers, you can manually force each external output contact to open or close. Manual operation takes precedence over any provisioned triggers that might be present.

Note
For ANSI shelves, the number of inputs and outputs can be increased using the AEP. The AEP is connected to the shelf backplane and requires an external wire-wrap panel.

16.2.4.3 Orderwire
Orderwire allows a craftsperson to plug a phoneset into an ONS 15454 and communicate with craftspeople working at other ONS 15454s or other facility equipment. The orderwire is a pulse code modulation (PCM) encoded voice channel that uses E1 or E2 bytes in section/line overhead.

The AIC-I allows simultaneous use of both local (section overhead signal) and express (line overhead channel) orderwire channels on a SONET/SDH ring or particular optics facility. Express orderwire also allows communication via regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with CTC similar to the current provisioning model for DCC/GCC channels. In CTC, you provision the orderwire communications network during ring turn-up so that all NEs on the ring can reach one another. Orderwire terminations (that is, the optics facilities that receive and process the orderwire channels) are provisionable. Both express and local orderwire can be configured as on or off on a particular SONET/SDH facility. The ONS 15454 supports up to four orderwire channel terminations per shelf. This allows linear, single ring, dual ring, and small hub-and-spoke configurations. Orderwire is not protected in ring topologies such as BLSR/MS-SPRing and path protection/SNCP.

Caution
Do not configure orderwire loops. Orderwire loops cause feedback that disables the orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line acts as a party line. Anyone who picks up the orderwire channel can communicate with all other participants on the connected orderwire subnetwork. The local orderwire party line is separate from the express orderwire party line. Up to four OC-N/STM-N facilities for each local and express orderwire are provisionable as orderwire paths.

The AIC-I supports selective dual tone multifrequency (DTMF) dialing for telephony connectivity, which causes one AIC-I card or all ONS 15454 AIC-I cards on the orderwire subnetwork to “ring.” The ringer/buzzer resides on the AIC-I. There is also a “ring” LED that mimics the AIC-I ringer. It flashes when a call is received on the orderwire subnetwork. A party line call is initiated by pressing *0000 on the DTMF pad. Individual dialing is initiated by pressing * and the individual four-digit number on the DTMF pad.

Table 16-12 shows the pins on the orderwire connector that correspond to the tip and ring orderwire assignments.
16.2.4 AIC-I Card

When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist. Loops cause oscillation and an unusable orderwire channel.

Figure 16-4 shows the standard RJ-11 connectors used for orderwire ports.

16.2.4.4 Power Monitoring

The AIC-I card provides a power monitoring circuit that monitors the supply voltage of –48 VDC for presence, undervoltage, and overvoltage.

16.2.4.5 User Data Channel

The user data channel (UDC) features a dedicated data channel of 64 kbps (F1 byte) between two nodes in an ONS 15454 network. Each AIC-I card provides two user data channels, UDC-A and UDC-B, through separate RJ-11 connectors on the front of the AIC-I card. Each UDC can be routed to an individual optical interface in the ONS 15454. For instructions, see the “DLP-G110 Create a User Data Channel Circuit” task on page 7-20.

The UDC ports are standard RJ-11 receptacles. Table 16-13 lists the UDC pin assignments.

<table>
<thead>
<tr>
<th>RJ-11 Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>For future use</td>
</tr>
<tr>
<td>2</td>
<td>TXN</td>
</tr>
<tr>
<td>3</td>
<td>RXN</td>
</tr>
<tr>
<td>4</td>
<td>RXP</td>
</tr>
</tbody>
</table>

Table 16-12  Orderwire Pin Assignments

<table>
<thead>
<tr>
<th>RJ-11 Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Four-wire receive ring</td>
</tr>
<tr>
<td>2</td>
<td>Four-wire transmit tip</td>
</tr>
<tr>
<td>3</td>
<td>Two-wire ring</td>
</tr>
<tr>
<td>4</td>
<td>Two-wire tip</td>
</tr>
<tr>
<td>5</td>
<td>Four-wire transmit ring</td>
</tr>
<tr>
<td>6</td>
<td>Four-wire receive tip</td>
</tr>
</tbody>
</table>

Table 16-13  UDC Pin Assignments
16.2.4.6 Data Communications Channel

The DCC features a dedicated data channel of 576 kbps (D4 to D12 bytes) between two nodes in an ONS 15454 network. Each AIC-I card provides two data communications channels, DCC-A and DCC-B, through separate RJ-45 connectors on the front of the AIC-I card. Each DCC can be routed to an individual optical interface in the ONS 15454. For instructions, see the “DLP-G110 Create a User Data Channel Circuit” task on page 7-20.

The DCC ports are standard RJ-45 receptacles. Table 16-14 lists the DCC pin assignments.

Table 16-14  DCC Pin Assignments

<table>
<thead>
<tr>
<th>RJ-45 Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TCLKP</td>
</tr>
<tr>
<td>2</td>
<td>TCLKN</td>
</tr>
<tr>
<td>3</td>
<td>TXP</td>
</tr>
<tr>
<td>4</td>
<td>TXN</td>
</tr>
<tr>
<td>5</td>
<td>RCLKP</td>
</tr>
<tr>
<td>6</td>
<td>RCLKN</td>
</tr>
<tr>
<td>7</td>
<td>RXP</td>
</tr>
<tr>
<td>8</td>
<td>RXN</td>
</tr>
</tbody>
</table>

16.3 Front Mount Electrical Connections

This section describes the MIC-A/P and MIC-C/T/P FMECs, which provide power, external alarm, and timing connections for the ONS 15454 ETSI shelf.

16.3.1 MIC-A/P FMEC

The MIC-A/P FMEC provides connection for the BATTERY B input, one of the two possible redundant power supply inputs. It also provides connection for eight alarm outputs (coming from the TCC2/TCC2P card), sixteen alarm inputs, and four configurable alarm inputs/outputs. Its position is in Slot 23 in the center of the subrack Electrical Facility Connection Assembly (EFCA) area.

The MIC-A/P FMEC has the following features:

- Connection for one of the two possible redundant power supply inputs
- Connection for eight alarm outputs (coming from the TCC2/TCC2P card)
- Connection for four configurable alarm inputs/outputs
- Connection for sixteen alarm inputs
• Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the ONS 15454 ETSI shelf. Figure 16-5 shows the MIC-A/P faceplate.

![Figure 16-5 MIC-A/P Faceplate](image)

Figure 16-6 shows a block diagram of the MIC-A/P.

![Figure 16-6 MIC-A/P Block Diagram](image)

Table 16-15 shows the alarm interface pinouts on the MIC-A/P DB-62 connector.

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALMCUTOFF N</td>
<td>Alarm cutoff, normally open ACO pair</td>
</tr>
<tr>
<td>2</td>
<td>ALMCUTOFF P</td>
<td>Alarm cutoff, normally open ACO pair</td>
</tr>
<tr>
<td>3</td>
<td>ALMINP0 N</td>
<td>Alarm input pair 1, reports closure on connected wires</td>
</tr>
<tr>
<td>4</td>
<td>ALMINP0 P</td>
<td>Alarm input pair 1, reports closure on connected wires</td>
</tr>
<tr>
<td>5</td>
<td>ALMINP1 N</td>
<td>Alarm input pair 2, reports closure on connected wires</td>
</tr>
<tr>
<td>6</td>
<td>ALMINP1 P</td>
<td>Alarm input pair 2, reports closure on connected wires</td>
</tr>
<tr>
<td>7</td>
<td>ALMINP2 N</td>
<td>Alarm input pair 3, reports closure on connected wires</td>
</tr>
</tbody>
</table>
### Table 16-15  Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>ALMINP2 P</td>
<td>Alarm input pair 3, reports closure on connected wires</td>
</tr>
<tr>
<td>9</td>
<td>ALMINP3 N</td>
<td>Alarm input pair 4, reports closure on connected wires</td>
</tr>
<tr>
<td>10</td>
<td>ALMINP3 P</td>
<td>Alarm input pair 4, reports closure on connected wires</td>
</tr>
<tr>
<td>11</td>
<td>EXALM0 N</td>
<td>External customer alarm 1</td>
</tr>
<tr>
<td>12</td>
<td>EXALM0 P</td>
<td>External customer alarm 1</td>
</tr>
<tr>
<td>13</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>14</td>
<td>EXALM1 N</td>
<td>External customer alarm 2</td>
</tr>
<tr>
<td>15</td>
<td>EXALM1 P</td>
<td>External customer alarm 2</td>
</tr>
<tr>
<td>16</td>
<td>EXALM2 N</td>
<td>External customer alarm 3</td>
</tr>
<tr>
<td>17</td>
<td>EXALM2 P</td>
<td>External customer alarm 3</td>
</tr>
<tr>
<td>18</td>
<td>EXALM3 N</td>
<td>External customer alarm 4</td>
</tr>
<tr>
<td>19</td>
<td>EXALM3 P</td>
<td>External customer alarm 4</td>
</tr>
<tr>
<td>20</td>
<td>EXALM4 N</td>
<td>External customer alarm 5</td>
</tr>
<tr>
<td>21</td>
<td>EXALM4 P</td>
<td>External customer alarm 5</td>
</tr>
<tr>
<td>22</td>
<td>EXALM5 N</td>
<td>External customer alarm 6</td>
</tr>
<tr>
<td>23</td>
<td>EXALM5 P</td>
<td>External customer alarm 6</td>
</tr>
<tr>
<td>24</td>
<td>EXALM6 N</td>
<td>External customer alarm 7</td>
</tr>
<tr>
<td>25</td>
<td>EXALM6 P</td>
<td>External customer alarm 7</td>
</tr>
<tr>
<td>26</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>27</td>
<td>EXALM7 N</td>
<td>External customer alarm 8</td>
</tr>
<tr>
<td>28</td>
<td>EXALM7 P</td>
<td>External customer alarm 8</td>
</tr>
<tr>
<td>29</td>
<td>EXALM8 N</td>
<td>External customer alarm 9</td>
</tr>
<tr>
<td>30</td>
<td>EXALM8 P</td>
<td>External customer alarm 9</td>
</tr>
<tr>
<td>31</td>
<td>EXALM9 N</td>
<td>External customer alarm 10</td>
</tr>
<tr>
<td>32</td>
<td>EXALM9 P</td>
<td>External customer alarm 10</td>
</tr>
<tr>
<td>33</td>
<td>EXALM10 N</td>
<td>External customer alarm 11</td>
</tr>
<tr>
<td>34</td>
<td>EXALM10 P</td>
<td>External customer alarm 11</td>
</tr>
<tr>
<td>35</td>
<td>EXALM11 N</td>
<td>External customer alarm 12</td>
</tr>
<tr>
<td>36</td>
<td>EXALM11 P</td>
<td>External customer alarm 12</td>
</tr>
<tr>
<td>37</td>
<td>ALMOUP0 N</td>
<td>Normally open output pair 1</td>
</tr>
<tr>
<td>38</td>
<td>ALMOUP0 P</td>
<td>Normally open output pair 1</td>
</tr>
<tr>
<td>39</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>40</td>
<td>ALMOUP1 N</td>
<td>Normally open output pair 2</td>
</tr>
<tr>
<td>41</td>
<td>ALMOUP1 P</td>
<td>Normally open output pair 2</td>
</tr>
<tr>
<td>42</td>
<td>ALMOUP2 N</td>
<td>Normally open output pair 3</td>
</tr>
<tr>
<td>43</td>
<td>ALMOUP2 P</td>
<td>Normally open output pair 3</td>
</tr>
</tbody>
</table>
16.3.2 MIC-C/T/P FMEC

The MIC-C/T/P FMEC provides connection for the BATTERY A input, one of the two possible redundant power supply inputs. It also provides connection for system management serial port, system management LAN port, modem port (for future use), and system timing inputs and outputs. Install the MIC-C/T/P in Slot 24.

The MIC-C/T/P FMEC has the following features:

- Connection for one of the two possible redundant power supply inputs
- Connection for two serial ports for local craft/modem (for future use)
- Connection for one LAN port
- Connection for two system timing inputs
- Connection for two system timing outputs
- Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the shelf. Figure 16-7 shows the MIC-C/T/P FMEC faceplate.

Table 16-15  Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>44</td>
<td>ALMOUP3 N</td>
<td>Normally open output pair 4</td>
</tr>
<tr>
<td>45</td>
<td>ALMOUP3 P</td>
<td>Normally open output pair 4</td>
</tr>
<tr>
<td>46</td>
<td>AUDALM0 N</td>
<td>Normally open Minor audible alarm</td>
</tr>
<tr>
<td>47</td>
<td>AUDALM0 P</td>
<td>Normally open Minor audible alarm</td>
</tr>
<tr>
<td>48</td>
<td>AUDALM1 N</td>
<td>Normally open Major audible alarm</td>
</tr>
<tr>
<td>49</td>
<td>AUDALM1 P</td>
<td>Normally open Major audible alarm</td>
</tr>
<tr>
<td>50</td>
<td>AUDALM2 N</td>
<td>Normally open Critical audible alarm</td>
</tr>
<tr>
<td>51</td>
<td>AUDALM2 P</td>
<td>Normally open Critical audible alarm</td>
</tr>
<tr>
<td>52</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>53</td>
<td>AUDALM3 N</td>
<td>Normally open Remote audible alarm</td>
</tr>
<tr>
<td>54</td>
<td>AUDALM3 P</td>
<td>Normally open Remote audible alarm</td>
</tr>
<tr>
<td>55</td>
<td>VISALM0 N</td>
<td>Normally open Minor visual alarm</td>
</tr>
<tr>
<td>56</td>
<td>VISALM0 P</td>
<td>Normally open Minor visual alarm</td>
</tr>
<tr>
<td>57</td>
<td>VISALM1 N</td>
<td>Normally open Major visual alarm</td>
</tr>
<tr>
<td>58</td>
<td>VISALM1 P</td>
<td>Normally open Major visual alarm</td>
</tr>
<tr>
<td>59</td>
<td>VISALM2 N</td>
<td>Normally open Critical visual alarm</td>
</tr>
<tr>
<td>60</td>
<td>VISALM2 P</td>
<td>Normally open Critical visual alarm</td>
</tr>
<tr>
<td>61</td>
<td>VISALM3 N</td>
<td>Normally open Remote visual alarm</td>
</tr>
<tr>
<td>62</td>
<td>VISALM3 P</td>
<td>Normally open Remote visual alarm</td>
</tr>
</tbody>
</table>
16.4 Optical Service Channel Cards

This section describes the optical service channel cards. An optical service channel (OSC) is a bidirectional channel connecting two adjacent nodes in a DWDM ring. For every DWDM node (except terminal nodes), two different OSC terminations are present, one for the West side and another for the East side. The channel transports OSC overhead that is used to manage ONS 15454 DWDM networks. An OSC signal uses the 1510-nm wavelength and does not affect client traffic. The primary purpose of this channel is to carry clock synchronization and orderwire channel communications for the DWDM network. It also provides transparent links between each node in the network. The OSC is an OC-3/STM-1 formatted signal.

There are two versions of the OSC modules: the OSCM, and the OSC-CSM, which contains the OSC wavelength combiner and separator component in addition to the OSC module.
16.4.1 OSCM Card

The OSCM card is used in amplified nodes that include the OPT-BST or OPT-BST-E booster amplifier. The OPT-BST and OPT-BST-E include the required OSC wavelength combiner and separator component. The OSCM cannot be used in nodes where you use OC-N/STM-N cards, electrical cards, or cross-connect cards. The OSCM uses Slots 8 and 10, which are also cross-connect card slots.

The OSCM supports the following features:

- OC-3/STM-1 formatted OSC
- Supervisory data channel (SDC) forwarded to the TCC2/TCC2P cards for processing
- Distribution of the synchronous clock to all nodes in the ring
- 100BaseT far-end (FE) UDC
- Monitoring functions such as orderwire support and optical safety

The OC-3/STM-1 section data communications channel (SDCC) overhead bytes are used for network communications. An optical transceiver terminates the OC-3/STM-1, then it is regenerated and converted into an electrical signal. The SDCC bytes are forwarded to the active and standby TCC2/TCC2P cards for processing via the system communication link (SCL) bus on the backplane. Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the TCC2/TCC2P for forwarding to the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UDC. The frame is sent to a packet-over-SONET/SDH (POS) processing block that extracts the Ethernet packets and makes them available at the RJ-45 connector.

The OSCM distributes the reference clock information by removing it from the incoming OC-3/STM-1 signal and then sending it to the DWDM cards. The DWDM cards then forward the clock information to the active and standby TCC2/TCC2P cards.
Figure 16-9 shows the OSCM faceplate.

Figure 16-9  OSCM Card Faceplate

Figure 16-10 shows a block diagram of the OSCM card.
16.4.1 OSCM Card

Figure 16-10 OSCM Block Diagram

Figure 16-11 shows the block diagram of the variable optical attenuator (VOA) within the OSCM.

Figure 16-11 OSCM VOA Optical Module Functional Block Diagram

16.4.1.1 Power Monitoring

Physical photodiode P1 monitors the power for the OSCM card. The returned power level value is calibrated to the OSC TX port (Table 16-16).

Table 16-16 OSCM VOA Port Calibration

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Output OSC</td>
<td>OSC TX</td>
</tr>
</tbody>
</table>
16.4.2 OSCM Card-Level Indicators

The OSCM card has three card-level LED indicators, described in Table 16-17.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that</td>
</tr>
<tr>
<td></td>
<td>there is an internal hardware failure. Replace the card if the red FAIL LED</td>
</tr>
<tr>
<td></td>
<td>persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the OSCM is carrying traffic or is</td>
</tr>
<tr>
<td></td>
<td>traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure or condition such as loss of</td>
</tr>
<tr>
<td></td>
<td>signal (LOS), loss of frame alignment (LOF), line alarm indication signal</td>
</tr>
<tr>
<td></td>
<td>(AIS-L), or high BER on one or more of the card’s ports. The amber signal</td>
</tr>
<tr>
<td></td>
<td>fail (SF) LED also illuminates when the transmit and receive fibers are</td>
</tr>
<tr>
<td></td>
<td>incorrectly connected. When the fibers are properly connected, the light</td>
</tr>
<tr>
<td></td>
<td>turns off.</td>
</tr>
</tbody>
</table>

16.4.3 OSCM Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The OSCM has one OC-3/STM-1 optical port located on the faceplate. One long-reach OSC transmits and receives the OSC to and from another DWDM node. Both data communications network (DCN) data and FE payload are carried on this link.

16.4.2 OSC-CSM Card

The OSC-CSM card is used in unamplified nodes. This means that the booster amplifier with the OSC wavelength combiner and separator is not required for OSC-CSM operation. The OSC-CSM can be installed in Slots 1 to 6 and 12 to 17. To operate in hybrid mode, the OSC-CSM cards must be accompanied by cross-connect cards. The cross-connect cards enable functionality on the OC-N/STM-N cards and electrical cards.

The OSC-CSM supports the following features:
- Optical combiner and separator module for multiplexing and demultiplexing the optical service channel to or from the wavelength division multiplexing (WDM) signal
- OC-3/STM-1 formatted OSC
- SDC forwarded to the TCC2/TCC2P cards for processing
- Distribution of the synchronous clock to all nodes in the ring
- 100BaseT FE UDC
- Monitoring functions such as orderwire support
- Optical safety: Signal loss detection and alarming, fast transmitted power shut down by means of an optical 1x1 switch
- Optical safety remote interlock (OSRI), a feature capable of shutting down the optical output power
- Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut
The WDM signal coming from the line is passed through the OSC combiner and separator, where the OSC signal is extracted from the WDM signal. The WDM signal is sent along with the remaining channels to the COM port (label on the front panel) for routing to the OADM or amplifier units, while the OSC signal is sent to an optical transceiver.

The OSC is an OC-3/STM-1 formatted signal. The OC-3/STM-1 SDCC overhead bytes are used for network communications. An optical transceiver terminates the OC-3/STM-1, and then it is regenerated and converted into an electrical signal. The SDCC bytes are forwarded to the active and standby TCC2/TCC2P cards for processing via the SCL bus on the backplane. Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the TCC2/TCC2P for forwarding to the AIC-1 card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UDC. The frame is sent to a POS processing block that extracts the Ethernet packets and makes them available at the RJ-45 front panel connector.

The OSC-CSM distributes the reference clock information by removing it from the incoming OC-3/STM-1 signal and then sending it to the active and standby TCC2/TCC2P cards. The clock distribution is different from the OSCM card because the OSC-CSM does not use Slot 8 or 10 (cross-connect card slots).

**Note**

S1 and S2 (Figure 16-14 on page 16-33) are optical splitters with a splitter ratio of 2:98. The result is that the power at the MON TX port is about 17 dB lower than the relevant power at the COM RX port, and the power at the MON RX port is about 20 dB lower than the power at the COM TX port. The difference is due to the presence of a tap coupler for the P1 photodiode.
Figure 16-12 shows the OSC-CSM faceplate.

Figure 16-12  OSC-CSM Faceplate

Figure 16-13 shows a block diagram of the OSC-CSM card.
Figure 16-13 OSC-CSM Block Diagram
Figure 16-14 shows the OSC-CSM optical module functional block diagram.

**Figure 16-14   OSC-CSM Optical Module Functional Block Diagram**

16.4.2.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P5 monitor the power for the OSC-CSM card. Their function is as follows:

- **P1 and P2**: The returned power value is calibrated to the LINE RX port, including the insertion loss of the previous filter (the reading of this power dynamic range has been brought backward towards the LINE RX output).
- **P3**: The returned value is calibrated to the COM RX port.
- **P5**: The returned value is calibrated to the LINE TX port, including the insertion loss of the subsequent filter.

The returned power level values are calibrated to the ports as shown in Table 16-18.
The OSC-CSM card has three card-level LED indicators, described in Table 16-19.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Out Com</td>
<td>LINE RX</td>
</tr>
<tr>
<td>P2</td>
<td>Input OSC</td>
<td>LINE RX</td>
</tr>
<tr>
<td>P3</td>
<td>In Com</td>
<td>COM RX</td>
</tr>
<tr>
<td>P5</td>
<td>Output Osc</td>
<td>LINE TX</td>
</tr>
</tbody>
</table>

### 16.5 Optical Amplifier Cards

This section describes the optical amplifier cards. Optical amplifiers are used in amplified nodes, such as hub nodes, amplified OADM nodes, and line amplifier nodes. There are three forms of amplifiers, the Optical Preamp (OPT-PRE), the Optical Booster (OPT-BST) amplifier, and the Optical Booster Enhanced (OPT-BST-E) amplifier. The optical amplifier card architecture includes an optical plug-in module with a controller that manages optical power, laser current, and temperature control loops. The amplifier also manages communication with the TCC2/TCC2P card, and operations, administration, maintenance, and provisioning (OAM&P) functions such as provisioning, controls, and alarms.

Optical amplifiers have a linear power feature that enables them to be kept in the constant gain mode if the gain is less than 28 dB. However, for longer span solutions it is necessary to place the amplifier in constant power mode. In constant power mode, automatic power control (APC) requirements change. This is because span loss degradation does not affect the system and amplifiers are not able to automatically modify the output power for variations in the number of channels when provisioning changes and a failure occurs.
16.5.1 OPT-PRE Amplifier

This section describes the OPT-PRE amplifier card. The OPT-PRE is designed to support 64 channels at 50-GHz channel spacing, but is currently limited to 32 channels at 100 GHz. The OPT-PRE is a C-band DWDM, two-stage erbium-doped fiber amplifier (EDFA) with mid-amplifier loss (MAL) for allocation to a DCU. To control the gain tilt, the OPT-PRE is equipped with a built-in VOA. The VOA can also be used to pad the DCU to a reference value. You can install the OPT-PRE in Slots 1 to 6 and 12 to 17.

The OPT-PRE features:

- Fixed gain mode with programmable tilt
- True variable gain
- Fast transient suppression
- Nondistorting low-frequency transfer function
- Settable maximum output power
- Fixed output power mode (mode used during provisioning)
- MAL for fiber-based DCU
- Amplified spontaneous emissions (ASE) compensation in fixed gain mode
- Full monitoring and alarm handling with settable thresholds
- Four signal photodiodes to monitor the input and output optical power of the two amplifier stages through CTC
- An optical output port for external monitoring

Note

The optical splitter has a ratio of 1:99. The result is that the power at the MON port is about 20 dB lower than the power at the COM TX port.
Figure 16-15 shows the OPT-PRE amplifier faceplate.

Figure 16-15  OPT-PRE Faceplate

Figure 16-16 shows a block diagram of the OPT-PRE card.
Figure 16-17 shows the OPT-PRE optical module functional block diagram.

**16.5.1.1 Power Monitoring**

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-PRE card. The returned power level values are calibrated to the ports as shown in Table 16-20.

**Table 16-20  OPT-PRE Port Calibration**

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Input Com</td>
<td>COM RX</td>
</tr>
<tr>
<td>P2</td>
<td>Output DC</td>
<td>DC TX</td>
</tr>
<tr>
<td>P3</td>
<td>Input DC</td>
<td>DC RX</td>
</tr>
<tr>
<td>P4</td>
<td>Output COM (Total Output)</td>
<td>COM TX</td>
</tr>
<tr>
<td></td>
<td>Output COM (Signal Output)</td>
<td></td>
</tr>
</tbody>
</table>
16.5.2 OPT-BST Amplifier Card

This section describes the OPT-BST amplifier card. The OPT-BST gain range is 5 to 20 dB in constant gain mode and output power mode. The OPT-BST is designed to support 64 channels at 50-GHz channel spacing, but currently is limited to 32 channels at 100 GHz. The OPT-BST is a C-band DWDM EDFA with OSC add-and-drop capability. When an ONS 15454 has an OPT-BST installed, it is only necessary to have the OSCM to process the OSC. You can install the OPT-BST in Slots 1 to 6 and 12 to 17. To control the gain tilt, the OPT-BST is equipped with a built-in VOA.

The OPT-BST features include:
- Fixed gain mode (with programmable tilt)
- True variable gain
- Fast transient suppression
- Nondistorting low-frequency transfer function
- Settable maximum output power
- Fixed output power mode (mode used during provisioning)
- ASE compensation in fixed gain mode
- Full monitoring and alarm handling with settable thresholds
- OSRI, which is a software feature capable (through CTC) of shutting down the optical output power or reducing the power to a safe level (automatic power reduction)
- ALS, which is a safety mechanism used in the event of a fiber cut

---

Table 16-21 OPT-PRE Amplifier Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the OPT-PRE is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure or condition such as LOS on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.5.1.2 OPT-PRE Amplifier Card-Level Indicators

The OPT-PRE amplifier has three card-level LED indicators, described in Table 16-21.

16.5.1.3 OPT-PRE Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The OPT-PRE amplifier has five optical ports located on the faceplate. MON is the output monitor port. COM RX (receive) is the input signal port. COM TX (transmit) is the output signal port. DC Rx is the MAL input signal port. DC Tx is the MAL output signal port.
The optical splitters each have a ratio of 1:99. The result is that the power at the MON TX and MON RX ports is about 20 dB lower than the power at the COM TX and COM RX ports.

Figure 16-18 shows the OPT-BST amplifier faceplate.

Figure 16-19 shows a block diagram of the OPT-BST card.
16.5.2 OPT-BST Amplifier Card

Figure 16-19  OPT-BST Block Diagram

Figure 16-20  OPT-BST Optical Module Functional Block Diagram

16.5.2.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST card. The returned power level values are calibrated to the ports as shown in Table 16-22.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Input Com</td>
<td>COM RX</td>
</tr>
<tr>
<td>P2</td>
<td>Output Line (Total Output)</td>
<td>LINE TX</td>
</tr>
<tr>
<td></td>
<td>Output Line (Signal Output)</td>
<td></td>
</tr>
</tbody>
</table>
16.5.2.2 OPT-BST Amplifier Card-Level Indicators

The OPT-BST amplifier has three card-level LED indicators, described in Table 16-23.

Table 16-23 OPT-BST Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the OPT-BST is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure or condition such as LOS on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.5.2.3 OPT-BST Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The OPT-BST amplifier has eight optical ports located on the faceplate. MON RX is the output monitor port (receive section). MON TX is the output monitor port. COM RX is the input signal port. LINE TX is the output signal port (receive section). COM TX is the output signal port (receive section). OSC RX is the OSC add input port. OSC TX is the OSC drop output port.

16.5.3 OPT-BST-E Amplifier Card

This section describes the OPT-BST-E amplifier card. The OPT-BST-E gain range is 8 to 23 dBm with the tilt managed at 0 dBm in constant gain mode and output power mode. However, an extended gain range of 23 to 26 dBm is available with the tilt unmanaged. See Appendix B, “Hardware Specifications” for detailed specification information. The OPT-BST-E is designed to support 64 channels at 50-GHz channel spacing, but currently is limited to 32 channels at 100 GHz. The OPT-BST-E is a C-band DWDM EDFA with OSC add-and-drop capability. When an ONS 15454 has an OPT-BST-E installed, it is only necessary to have the OSCM to process the OSC. You can install the OPT-BST-E in Slots 1 to 6 and 12 to 17. To control the gain tilt, the OPT-BST-E is equipped with a built-in VOA.

The OPT-BST-E features include:
- Fixed gain mode (with programmable tilt)
- True variable gain
- Extended gain (with unmanaged tilt)
16.5.3 OPT-BST-E Amplifier Card

- Fast transient suppression
- Nondistorting low-frequency transfer function
- Settable maximum output power
- Fixed output power mode (mode used during provisioning)
- ASE compensation in fixed gain mode
- Full monitoring and alarm handling with settable thresholds
- OSRI, which is a software feature capable (through CTC) of shutting down the optical output power or reducing the power to a safe level (automatic power reduction)
- ALS, which is a safety mechanism used in the event of a fiber cut

**Note**
The optical splitters each have a ratio of 1:99. The result is that the power at the MON TX and MON RX ports is about 20 dB lower than the power at the COM TX and COM RX ports.
Figure 16-21 shows the OPT-BST-E amplifier faceplate.

**Figure 16-21  OPT-BST-E Faceplate**

Figure 16-22 shows a block diagram of the OPT-BST-E card.
16.5.3.1 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST-E card. The returned power level values are calibrated to the ports as shown in Table 16-24.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Input Com</td>
<td>COM RX</td>
</tr>
<tr>
<td>P2</td>
<td>Output Line (Total Output)</td>
<td>LINE TX</td>
</tr>
<tr>
<td></td>
<td>Output Line (Signal Output)</td>
<td></td>
</tr>
</tbody>
</table>
16.5.3.2 OPT-BST-E Amplifier Card-Level Indicators

The OPT-BST-E amplifier has three card-level LED indicators, described in Table 16-25.

Table 16-24 OPT-BST-E Port Calibration (continued)

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P3</td>
<td>Output COM</td>
<td>LINE RX</td>
</tr>
<tr>
<td>P4</td>
<td>Output OSC</td>
<td></td>
</tr>
</tbody>
</table>

16.5.3.3 OPT-BST-E Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The OPT-BST-E amplifier has eight optical ports located on the faceplate. MON RX is the output monitor port (receive section). MON TX is the output monitor port. COM RX is the input signal port. LINE TX is the output signal port. LINE RX is the input signal port (receive section). COM TX is the output signal port (receive section). OSC RX is the OSC add input port. OSC TX is the OSC drop output port.

16.6 Multiplexer and Demultiplexer Cards

This section describes the multiplexer and demultiplexer cards.

16.6.1 32MUX-O Card

The 32-Channel Multiplexer (32MUX-O) card multiplexes 32 100-GHz-spaced channels identified in the channel plan. The 32MUX-O card takes up two slots in an ONS 15454 and can be installed in Slots 1 to 5 and 12 to 16.

The 32MUX-O features include:

- Arrayed waveguide grating (AWG) device that enables full multiplexing functions for the channels.
Each single-channel port is equipped with VOAs for automatic optical power regulation prior to multiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for safety purposes. A manual VOA setting is also available.

Each single-channel port is monitored using a photodiode to enable automatic power regulation. An additional optical monitoring port with 1:99 splitting ratio is available.

Figure 16-24 shows the 32MUX-O faceplate.

Figure 16-24  32MUX-O Faceplate

Figure 16-25 shows a block diagram of the 32MUX-O card.
The 32MUX-O has four receive connectors that accept multifiber push-on (MPO) cables, which break out into eight separate cables, on its front panel for the client input interfaces. The 32MUX-O also has two LC-PC-II optical connectors, one for the main output and the other for the monitor port.

Figure 16-26 shows the 32MUX-O optical module functional block diagram.

**16.6.1 Channel Plan**

The 32MUX-O is typically used in hub nodes and provides the multiplexing of 32 channels, spaced at 100 GHz, into one fiber before their amplification and transmission along the line. The channel plan is shown in Table 16-26.
### Table 16-26  32MUX-O Channel Plan

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30.3</td>
<td>195.3</td>
<td>1530.33</td>
</tr>
<tr>
<td>2</td>
<td>31.2</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td>3</td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td>4</td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td>5</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td>6</td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td>7</td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td>8</td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td>9</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td>10</td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td>11</td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td>12</td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td>13</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td>14</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td>15</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td>16</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td>17</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td>18</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td>19</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td>20</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td>21</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td>22</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td>23</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td>24</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td>25</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td>26</td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td>27</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td>28</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
</tr>
<tr>
<td>29</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td>30</td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td>31</td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td>32</td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
</tbody>
</table>

1. The Channel Number column is only for reference purposes. The channel ID is consistent with ONS 15454 and will be used in unit identification.
16.6.2 32DMX-O Card

The 32-Channel Demultiplexer (32DMX-O) card demultiplexes 32 100-GHz-spaced channels identified in the channel plan. The 32DMX-O takes up two slots in an ONS 15454 and can be installed in Slots 1 to 5 and 12 to 16.

The 32DMX-O features include:

- AWG that enables channel demultiplexing functions.
- Each single-channel port is equipped with VOAs for automatic optical power regulation after demultiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for safety purposes. A manual VOA setting is also available.

16.6.1.2 Power Monitoring

Physical photodiodes P1 through P32 monitor the power for the 32MUX-O card. The returned power level values are calibrated to the ports as shown in Table 16-27.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P32</td>
<td>ADD</td>
<td>COM TX</td>
</tr>
</tbody>
</table>

16.6.1.3 32MUX-O Card-Level Indicators

The 32MUX-O card has three card-level LED indicators, described in Table 16-28.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the 32MUX-O is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.6.1.4 32MUX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The 32MUX-O card has five sets of ports located on the faceplate.

COM Tx is the line output. MON is the optical monitoring port. The xx.x-yy.y RX ports represent the four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.
16-6.2 32DMX-O Card

- The 32DXM-O has four physical receive connectors that accept multifiber push-on (MPO) cables, which break out into eight separate cables, on its front panel for the client input interfaces.

**Note** In contrast, the single-slot 32DMX card does not have VOAs on each drop port for optical power regulation. The 32DMX optical demultiplexer module is used in conjunction with the 32-Channel Wavelength Selective Switch (32WSS) card in ONS 15454 Multiservice Transport Platform (MSTP) nodes.

- Each single-channel port is monitored using a photodiode to enable automatic power regulation. Figure 16-27 shows the 32DMX-O card faceplate.

Figure 16-27  32DMX-O Faceplate

![32DMX-O Faceplate Diagram]

Figure 16-28 shows a block diagram of the 32DMX-O card.
16.6.2 32DMX-O Card

Figure 16-28 32DMX-O Block Diagram

Figure 16-29 shows the 32DMX-O optical module functional block diagram.

Figure 16-29 32DMX-O Optical Module Functional Block Diagram

16.6.2.1 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX-O card. The returned power level values are calibrated to the ports as shown in Table 16-29.

Table 16-29 32DMX-O Port Calibration

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P32</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
<tr>
<td>P33</td>
<td>INPUT COM</td>
<td>COM RX</td>
</tr>
</tbody>
</table>
16.6.2.2 32DMX-O Card-Level Indicators

The 32DMX-O card has three card-level LED indicators, described in Table 16-30.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the 32DMX-O is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.6.2.3 32DMX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The 32DMX-O card has five sets of ports located on the faceplate. MON is the output monitor port. COM RX is the line input. The xx.x-yy.y Tx ports represent the four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

16.6.3 32DMX Card

The 32-Channel Demultiplexer card (32DMX) is a single-slot optical demultiplexer. The card receives an aggregate optical signal on its COM RX port and demultiplexes it into 32 100-GHz-spaced channels. The 32DMX card can be installed in Slots 1 to 6 and in Slots 12 to 17.

The 32DMX includes these high-level features:

- **COM RX port**: COM RX is the input port for the aggregate optical signal being demultiplexed. This port is supported by both a VOA for optical power regulation and a photodiode for optical power monitoring.

- **DROP ports (1 to 32)**: On its output, the 32DMX provides 32 drop ports that are typically used for dropping channels within the ROADM node. Each drop port has a photodiode for optical power monitoring. Unlike the two-slot 32DMX-O demultiplexer, the drop ports on the 32DMX do not have a VOA per channel for optical power regulation.

- A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or west side of the shelf.

Figure 16-30 shows the 32DMX card front panel and the basic traffic flow through the ports.
The 32DMX front panel has connectors for 32 DROP TX ports. These ports are connected using four 8-fiber multifiber push-on (MPO) ribbon connectors. The incoming optical signal to the demultiplexer comes into the COM RX. This input port is connected using a single LC duplex optical connector.

A block diagram of the 32DMX card is shown in Figure 16-31.
16.6.3 32DMX Card

Figure 16-31  32DMX Block Diagram

30.3 to 36.6
8 CHS TX
38.1 to 44.5
8 CHS TX
46.1 to 52.5
8 CHS TX
54.1 to 60.6
8 CHS TX

Optical module

FPGA
For SCL Bus management
Processor
DC/DC
Power supply
Input filters

SCL Bus
TCCi M
SCL Bus
TCCi P

MON
COM RX

BAT A&B

Figure 16-32 shows the 32DMX optical module functional block diagram.

Figure 16-32  32DMX Optical Module Functional Block Diagram

16.6.3.1 ROADM

The 32DMX card works in conjunction with the 32WSS card to create a software-controlled network element with ROADM functionality. ROADM functionality requires two 32DMX single-slot cards and two 32WSS double-slot cards (six slots in the ONS 15454 chassis).

Equipped with ROADM functionality, ONS 15454 MSTP nodes can be configured at the optical channel level using CTC, Cisco MetroPlanner, and Cisco Transport Manager (CTM). Both the 32DMX card and 32WSS card utilize planar lightwave circuit (PLC) technology to perform wavelength-level processing.
16.6.3.2 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX card. The returned power level values are calibrated to the ports as shown in Table 16-31.

| Table 16-31 32DMX Port Calibration |
|------------------------|------------------------|
| Photodiode | CTC Type Name | Calibrated to Port |
| P1–P32 | DROP | DROP TX |
| P33 | INPUT COM | COM RX |

16.6.3.3 32DMX Card-Level Indicators

Table 16-32 describes the three card-level LED indicators on the 32DMX card.

| Table 16-32 32DMX Card-Level Indicators |
|-------------------------|-------------------------|
| Card-Level Indicators | Description |
| RedFAIL LED | The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists. |
| Green ACT LED | The green ACT LED indicates that the 32DMX card is carrying traffic or is traffic-ready. |
| AmberSF LED | The amber SF LED indicates a signal failure on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off. |

16.6.3.4 32DMX Port-Level Indicators

You can find the status of the 32DMX ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot.

The 32DMX card has five ports located on the faceplate. The port labeled COM RX is the line input (it typically receives DROP TX from the 32WSS module). The TX ports are 32 drop ports. The connectors provide four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

16.6.4 4MD-xx.x Card

The 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) card multiplexes and demultiplexes four 100-GHz-spaced channels identified in the channel plan. The 4MD-xx.x card is designed to be used with band OADMs (both AD-1B-xx.x and AD-4B-xx.x).

The card is bidirectional. The demultiplexer and multiplexer functions are implemented in two different sections of the same card. In this way, the same card can manage signals flowing in opposite directions.

There are eight versions of this card that correspond with the eight sub-bands specified in Table 16-33. The 4MD-xx.x can be installed in Slots 1 to 6 and 12 to 17.
The 4MD-xx.x has the following features implemented inside a plug-in optical module:

- Passive cascade of interferential filters perform the channel multiplex/demultiplex function.
- Software-controlled VOAs at every port of the multiplex section regulate the optical power of each multiplexed channel.
- Software-monitored photodiodes at the input and output multiplexer and demultiplexer ports for power control and safety purposes.
- Software-monitored “virtual photodiodes” at the common DWDM output and input ports. A “virtual photodiode” is a firmware calculation of the optical power at that port. This calculation is based on the single channel photodiode reading and insertion losses of the appropriated paths.

Figure 16-33 shows the 4MD-xx.x faceplate.

**Figure 16-33   4MD-xx.x Faceplate**
Figure 16-34 shows a block diagram of the 4MD-xx.x card.

**Figure 16-34  4MD-xx.x Block Diagram**

![Block Diagram](image)

Figure 16-35 shows the 4MD-xx.x optical module functional block diagram.

**Figure 16-35  4MD-xx.x Optical Module Functional Block Diagram**

![Block Diagram](image)

The optical module shown in Figure 16-35 is optically passive and consists of a cascade of interferential filters that perform the channel multiplexing and demultiplexing functions.
VOAs are present in every input path of the multiplex section in order to regulate the optical power of each multiplexed channel. Some optical input and output ports are monitored by means of photodiodes implemented both for power control and for safety purposes. An internal control manages VOA settings and functionality as well as photodiode detection and alarm thresholds. The power at the main output and input ports is monitored through the use of virtual photodiodes. A virtual photodiode is implemented in the firmware of the plug-in module. This firmware calculates the power on a port, summing the measured values from all single channel ports (and applying the proper path insertion loss) and then providing the TCC2/TCC2P card with the obtained value.

16.6.4.1 Wavelength Pairs

Table 16-33 shows the band IDs and the add/drop channel IDs for the 4MD-xx.x card.

### Table 16-33 4MD-xx.x Channel Sets

<table>
<thead>
<tr>
<th>Band ID</th>
<th>Add/Drop Channel IDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 30.3 (A)</td>
<td>30.3, 31.2, 31.9, 32.6</td>
</tr>
<tr>
<td>Band 34.2 (B)</td>
<td>34.2, 35.0, 35.8, 36.6</td>
</tr>
<tr>
<td>Band 38.1 (C)</td>
<td>38.1, 38.9, 39.7, 40.5</td>
</tr>
<tr>
<td>Band 42.1 (D)</td>
<td>42.1, 42.9, 43.7, 44.5</td>
</tr>
<tr>
<td>Band 46.1 (E)</td>
<td>46.1, 46.9, 47.7, 48.5</td>
</tr>
<tr>
<td>Band 50.1 (F)</td>
<td>50.1, 50.9, 51.7, 52.5</td>
</tr>
<tr>
<td>Band 54.1 (G)</td>
<td>54.1, 54.9, 55.7, 56.5</td>
</tr>
<tr>
<td>Band 58.1 (H)</td>
<td>58.1, 58.9, 59.7, 60.6</td>
</tr>
</tbody>
</table>

16.6.4.2 Power Monitoring

Physical photodiodes P1 through P8 and virtual photodiodes V1 and V2 monitor the power for the 4MD-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-34.

### Table 16-34 4MD-xx.x Port Calibration

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P4</td>
<td>ADD</td>
<td>COM TX</td>
</tr>
<tr>
<td>P5–P8</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
<tr>
<td>V1</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
<tr>
<td>V2</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
</tbody>
</table>

16.6.4.3 4MD-xx.x Card-Level Indicators

The 4MD-xx.x card has three card-level LED indicators, described in Table 16-35.
Chapter 16      Card Reference

16.7 Optical Add/Drop Multiplexer Cards

16.7.1 AD-1C-xx.x Card

The 1-Channel OADM (AD-1C-xx.x) card passively adds or drops one of the 32 channels utilized within the 100-GHz-spacing of the DWDM card system. Thirty-two versions of this card—each designed only for use with one wavelength—are used in the ONS 15454 DWDM system. Each wavelength version of the card has a different part number. The AD-1C-xx.x can be installed in Slots 1 to 6 and 12 to 17.

The AD-1C-xx.x has the following internal features:

- Two cascaded passive optical interferential filters perform the channel add and drop functions.
- One software-controlled VOA regulates the optical power of the inserted channel.
- Software-controlled VOA regulates the insertion loss of the express optical path.
- Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.
- Software-monitored virtual photodiodes (firmware calculations of port optical power) at the common DWDM output and input ports.

Figure 16-36 shows the AD-1C-xx.x faceplate.
Figure 16-36   AD-1C-xx.x Faceplate

Figure 16-37 shows a block diagram of the AD-1C-xx.x card.
16.7.1 AD-1C-xx.x Card

Figure 16-37  AD-1C-xx.x Block Diagram

Figure 16-38  shows the AD-1C-xx.x optical module functional block diagram.

16.7.1.1 Power Monitoring

Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2 monitor the power for the AD-1C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-36.

Table 16-36  AD-1C-xx.x Port Calibration

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>ADD</td>
<td>COM TX</td>
</tr>
<tr>
<td>P2</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
<tr>
<td>P3</td>
<td>IN EXP</td>
<td>EXP RX</td>
</tr>
</tbody>
</table>
16.7.2 AD-2C-xx.x Card

The 2-Channel OADM (AD-2C-xx.x) card passively adds or drops two adjacent 100-GHz channels within the same band. Sixteen versions of this card—each designed for use with one pair of wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the same card to manage signal flow in both directions. Each version of the card has a different part number.

The AD-2C-xx.x has the following features:

- Passive cascade of interferential filters perform the channel add and drop functions.
- Two software-controlled VOAs in the add section, one for each add port, regulate the optical power of inserted channels.
- Software-controlled VOAs regulate insertion loss on express channels.
- Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.
- Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common DWDM output and input ports.

Figure 16-39 shows the AD-2C-xx.x faceplate.

### Table 16-36 AD-1C-xx.x Port Calibration (continued)

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P4</td>
<td>OUT EXP</td>
<td>EXP TX</td>
</tr>
<tr>
<td>V1</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
<tr>
<td>V2</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
</tbody>
</table>

### 16.7.1.2 AD-1C-xx.x Card-Level Indicators

The AD-1C-xx.x card has three card-level LED indicators, described in Table 16-37.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-1C-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure. The SF LED also illuminates when the transmitting and receiving fibers are incorrectly connected. When the fibers are properly connected, the LED turns off.</td>
</tr>
</tbody>
</table>

### 16.7.1.3 AD-1C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The AD-1C-xx.x has six LC-PC-II optical ports: two for add/drop channel client input and output, two for express channel input and output, and two for communication.
Figure 16-39  AD-2C-xx.x Faceplate

Figure 16-40 shows a block diagram of the AD-2C-xx.x card.
16.7.2 AD-2C-xx.x Card

**Figure 16-40 AD-2C-xx.x Block Diagram**

![AD-2C-xx.x Block Diagram](image)

**Figure 16-41 shows the AD-2C-xx.x optical module functional block diagram.**

**Figure 16-41 AD-2C-xx.x Optical Module Functional Block Diagram**

![AD-2C-xx.x Optical Module Functional Block Diagram](image)

16.7.2.1 Wavelength Pairs

The AD-2C-xx.x cards are provisioned for the wavelength pairs in Table 16-38. In this table, channel IDs are given rather than wavelengths. To compare channel IDs with the actual wavelengths they represent, see Table 16-6 on page 16-9.
16.7.2.2 Power Monitoring

Physical photodiodes P1 through P10, and virtual photodiodes V1 and V2 monitor the power for the AD-2C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-39.

<table>
<thead>
<tr>
<th>Band ID</th>
<th>Add/Drop Channel ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 30.3 (A)</td>
<td>30.3, 31.2</td>
</tr>
<tr>
<td></td>
<td>31.9, 32.6</td>
</tr>
<tr>
<td>Band 34.2 (B)</td>
<td>34.2, 35.0</td>
</tr>
<tr>
<td></td>
<td>35.8, 36.6</td>
</tr>
<tr>
<td>Band 38.1 (C)</td>
<td>38.1, 38.9</td>
</tr>
<tr>
<td></td>
<td>39.7, 40.5</td>
</tr>
<tr>
<td>Band 42.1 (D)</td>
<td>42.1, 42.9</td>
</tr>
<tr>
<td></td>
<td>43.7, 44.5</td>
</tr>
<tr>
<td>Band 46.1 (E)</td>
<td>46.1, 46.9</td>
</tr>
<tr>
<td></td>
<td>47.7, 48.5</td>
</tr>
<tr>
<td>Band 50.1 (F)</td>
<td>50.1, 50.9</td>
</tr>
<tr>
<td></td>
<td>51.7, 52.5</td>
</tr>
<tr>
<td>Band 54.1 (G)</td>
<td>54.1, 54.9</td>
</tr>
<tr>
<td></td>
<td>55.7, 56.5</td>
</tr>
<tr>
<td>Band 58.1 (H)</td>
<td>58.1, 58.9</td>
</tr>
<tr>
<td></td>
<td>59.7, 60.6</td>
</tr>
</tbody>
</table>

16.7.2.3 AD-2C-xx.x Card-Level Indicators

The AD-2C-xx.x card has three card-level LED indicators, described in Table 16-40.

Table 16-38 AD-2C-xx.x Channel Pairs

<table>
<thead>
<tr>
<th>Band ID</th>
<th>Add/Drop Channel ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 30.3 (A)</td>
<td>30.3, 31.2</td>
</tr>
<tr>
<td></td>
<td>31.9, 32.6</td>
</tr>
<tr>
<td>Band 34.2 (B)</td>
<td>34.2, 35.0</td>
</tr>
<tr>
<td></td>
<td>35.8, 36.6</td>
</tr>
<tr>
<td>Band 38.1 (C)</td>
<td>38.1, 38.9</td>
</tr>
<tr>
<td></td>
<td>39.7, 40.5</td>
</tr>
<tr>
<td>Band 42.1 (D)</td>
<td>42.1, 42.9</td>
</tr>
<tr>
<td></td>
<td>43.7, 44.5</td>
</tr>
<tr>
<td>Band 46.1 (E)</td>
<td>46.1, 46.9</td>
</tr>
<tr>
<td></td>
<td>47.7, 48.5</td>
</tr>
<tr>
<td>Band 50.1 (F)</td>
<td>50.1, 50.9</td>
</tr>
<tr>
<td></td>
<td>51.7, 52.5</td>
</tr>
<tr>
<td>Band 54.1 (G)</td>
<td>54.1, 54.9</td>
</tr>
<tr>
<td></td>
<td>55.7, 56.5</td>
</tr>
<tr>
<td>Band 58.1 (H)</td>
<td>58.1, 58.9</td>
</tr>
<tr>
<td></td>
<td>59.7, 60.6</td>
</tr>
</tbody>
</table>

Table 16-39 AD-2C-xx.x Port Calibration

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P4</td>
<td>ADD</td>
<td>COM TX</td>
</tr>
<tr>
<td>P5–P8</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
<tr>
<td>P9</td>
<td>IN EXP</td>
<td>EXP RX</td>
</tr>
<tr>
<td>P10</td>
<td>OUT EXP</td>
<td>EXP TX</td>
</tr>
<tr>
<td>V1</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
<tr>
<td>V2</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
</tbody>
</table>

Table 16-39 AD-2C-xx.x Port Calibration
16.7.3 AD-4C-xx.x Card

The 4-Channel OADM (AD-4C-xx.x) card passively adds or drops all four 100-GHz-spaced channels within the same band. Eight versions of this card—each designed for use with one band of wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the same card to manage signal flow in both directions. There are eight versions of this card with eight part numbers.

The AD-4C-xx.x has the following features:

- Passive cascade of interferential filters perform the channel add and drop functions.
- Four software-controlled VOAs in the add section, one for each add port, regulate the optical power of inserted channels.
- Two software-controlled VOAs regulate insertion loss on express and drop path, respectively.
- Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.
- Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common DWDM output and input ports.

Figure 16-42 shows the AD-4C-xx.x faceplate.

### Table 16-40 AD-2C-xx.x Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-2C-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.7.4 AD-2C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The AD-2C-xx.x card has eight LC-PC-II optical ports: four for add/drop channel client input and output, two for express channel input and output, and two for communication.
Figure 16-42  AD-4C-xx.x Faceplate

Figure 16-43 shows a block diagram of the AD-4C-xx.x card.
16.7.3 AD-4C-xx.x Card

Figure 16-43  AD-4C-xx.x Block Diagram

Figure 16-44 shows the AD-4C-xx.x optical module functional block diagram.

Figure 16-44  AD-4C-xx.x Optical Module Functional Block Diagram

16.7.3.1 Wavelength Pairs

The AD-4C-xx.x cards are provisioned for the wavelength pairs in Table 16-41 on page 16-69. In this table, channel IDs are given rather than wavelengths. To compare channel IDs with the actual wavelengths they represent, see Table 16-6 on page 16-9.
### 16.7.3 AD-4C-xx.x Card

#### 16.7.3.2 Power Monitoring

Physical photodiodes P1 through P10, and virtual photodiodes V1 and V2 monitor the power for the AD-4C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-42.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P4</td>
<td>ADD</td>
<td>COM TX</td>
</tr>
<tr>
<td>P5–P8</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
<tr>
<td>P9</td>
<td>IN EXP</td>
<td>EXP RX</td>
</tr>
<tr>
<td>P10</td>
<td>OUT EXP</td>
<td>EXP TX</td>
</tr>
<tr>
<td>V1</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
<tr>
<td>V2</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
</tbody>
</table>

#### 16.7.3.3 AD-4C-xx.x Card-Level Indicators

The AD-4C-xx.x card has three card-level LED indicators, described in Table 16-43.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-4C-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure or condition. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>
16.7.4 AD-1B-xx.x Card

The 1-Band OADM (AD-1B-xx.x) card passively adds or drops a single band of four adjacent 100-GHz-spaced channels. Eight versions of this card with eight different part numbers—each version designed for use with one band of wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the same card to manage signal flow in both directions. This card can be used when there is asymmetric adding and dropping on each side (east or west) of the node; a band can be added or dropped on one side but not on the other.

The AD-1B xx.x can be installed in Slots 1 to 6 and 12 to 17 and has the following features:

- Passive cascaded interferential filters perform the channel add and drop functions.
- Two software-controlled VOAs regulate the optical power flowing in the express and drop OADM paths (drop section).
- Output power of the dropped band is set by changing the attenuation of the VOA drop.
- The VOA express is used to regulate the insertion loss of the express path.
- Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.
- Software-monitored virtual photodiode (firmware calculation of port optical power) at the common DWDM output.

Figure 16-45 shows the AD-1B-xx.x faceplate.
Figure 16-45 AD-1B-xx.x Faceplate

Figure 16-46 shows a block diagram of the AD-1B-xx.x card.
Figure 16-47 shows the AD-1B-xx.x optical module functional block diagram.

**16.7.4.1 Power Monitoring**

Physical photodiodes P1 through P4, and virtual photodiodes V1 and V2 monitor the power for the AD-1B-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-44.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>ADD</td>
<td>BAND RX</td>
</tr>
<tr>
<td>P2</td>
<td>DROP</td>
<td>BAND TX</td>
</tr>
<tr>
<td>P3</td>
<td>IN EXP</td>
<td>EXP RX</td>
</tr>
</tbody>
</table>
Chapter 16  Card Reference

16.7.4 AD-1B-xx.x Card-Level Indicators

The AD-1B-xx.x card has three card-level LED indicators, described in Table 16-45.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-1B-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.7.4.3 AD-1B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The AD-1B-xx.x has six LC-PC-II optical ports: two for add/drop channel client input and output, two for express channel input and output, and two for communication.

16.7.5 AD-4B-xx.x Card

The 4-Band OADM (AD-4B-xx.x) card passively adds or drops four bands of four adjacent 100-GHz-spaced channels. Two versions of this card with different part numbers—each version designed for use with one set of bands—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the same card to manage signal flow in both directions. This card can be used when there is asymmetric adding and dropping on each side (east or west) of the node; a band can be added or dropped on one side but not on the other.

The AD1B-xx.x can be installed in Slots 1 to 6 and 12 to 17 and has the following features:

- Five software-controlled VOAs regulate the optical power flowing in the OADM paths.
- Output power of each dropped band is set by changing the attenuation of each VOA drop.
- The VOA express is used to regulate the insertion loss of the express path.
- Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.
- Software-monitored virtual photodiode (firmware calculation of port optical power) at the common DWDM output port.

Figure 16-48 shows the AD-4B-xx.x faceplate.

---

Table 16-44  AD-1B-xx.x Port Calibration (continued)

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P4</td>
<td>OUT EXP</td>
<td>EXP TX</td>
</tr>
<tr>
<td>V1</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
<tr>
<td>V2</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
</tbody>
</table>

Table 16-45  AD-1B-xx.x Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-1B-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

Figure 16-48  shows the AD-4B-xx.x faceplate.
Figure 16-49 shows a block diagram of the 4D-4B-xx.x card.
Figure 16-49  AD-4B-xx.x Block Diagram

Figure 16-50 shows the AD-4B-xx.x optical module functional block diagram.

Figure 16-50  AD-4B-xx.x Optical Module Functional Block Diagram

Virtual photodiode

Physical photodiode

Variable optical attenuator

16.7.5.1 Power Monitoring

Physical photodiodes P1 through P11, and virtual photodiode V1 monitor the power for the AD-4B-xx.x card. The returned power level values are calibrated to the ports as shown in Table 16-46.
16.7.5.2 AD-4B-xx.x Card-Level Indicators

The AD-4B-xx.x card has three card-level LED indicators, described in Table 16-47.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the AD-4B-xx.x card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

16.7.5.3 AD-4B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The AD-4B-xx.x has 12 LC-PC-II optical ports: eight for add/drop band client input and output, two for express channel input and output, and two for communication.

16.7.6 32WSS Card

The 32-Channel Wavelength Selective Switch (32WSS) card performs channel add/drop processing within the ONS 15454 DWDM node. The 32WSS works in conjunction with the 32DMX to implement ROADM functionality. Equipped with ROADM functionality, the ONS 15454 DWDM can be configured to add or drop individual optical channels using CTC, Cisco MetroPlanner, and CTM.

An ROADM network element utilizes two 32WSS cards (two slots each) and two 32DMX cards (one slot each), for a total of six slots in the chassis. For a diagram of a typical ROADM configuration, see the “17.1.4 ROADM Node” section on page 17-8. The 32WSS card can be installed in Slots 1 and 2, 3 and 4, 5 and 6, 12 and 13, 14 and 15, or 16 and 17.
The 32WSS has six types of ports:

- **ADD RX ports (1 to 32):** These ports are used for adding channels. Each add channel is associated with an individual switch element that selects whether an individual channel is added. Each add port has optical power regulation provided by a VOA. The 32WSS has four physical receive connectors that accept multifiber push-on (MPO) cables, which break out into eight separate cables, on its front panel for the client input interfaces.

- **EXP RX port:** The EXP RX port receives an optical signal from another 32WSS module in the same network element.

- **EXP TX port:** The EXP TX port sends an optical signal to the other 32WSS module within the network element.

- **COM TX port:** The COM TX port sends an aggregate optical signal to a booster amplifier card (for example, OPT-BST) for transmission outside of the network element.

- **COM RX port:** The COM RX port receives the optical signal from a preamplifier and sends it to the optical splitter.

- **DROP TX port:** The DROP TX port sends the split off optical signal that contains drop channels to the 32DMX card where the channels are further processed and dropped.

A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or west side of the shelf. **Figure 16-51** shows the 32WSS module front panel and identifies the traffic flow through the ports.
Figure 16-51  32WSS Faceplate and Ports

Figure 16-52 provides a high-level functional block diagram of the 32WSS card.
Aggregate optical signals that enter the EXP RX and COM RX port are processed in two ways. The optical processing stages are shown in Figure 16-53, which provides a detailed optical functional diagram of the 32WSS card.
The EX PORT and COM PORT operate as follows:

- **EXP RX Port Add Channel/Pass-through Processing**

  The incoming optical signal is received at the EXP RX port from the other 32WSS module within the network element. The incoming aggregate optical signal is demultiplexed into 32 individual wavelength components, or channels. Then each channel is individually processed by the optical switch, which does add/pass-through processing. Under software control, the switch either selects the optical channel coming in from the demultiplexer (the pass-through channel) or it selects the external ADD channel. If the ADD port channel is selected, the optical signal coming from the demultiplexer is blocked, and the ADD channel is transmitted in its place.

  After the optical switch stage, each of the channels passes through a VOA. Then all of the channels are multiplexed together into an aggregate optical signal, which is sent out on the COM TX port. The output is typically connected to an OPT-BST or OPT-BST-E (in the event a booster amplifier is needed) or to an OSC-CSM (if no amplification is needed).

- **COM RX Port Optical Splitter Processing**

  The incoming optical signal received at the COM RX port and is applied to the optical splitter within the 32WSS. Channels that are designated to be dropped are diverted optically to the DROP TX port by the splitter. The DROP TX port on the 32WSS is typically connected to the COM RX port of the 32DMX where the drop channels are dropped. Channels that are not dropped pass through the optical splitter and flow out of the EXP TX port of the 32WSS. This optical signal is typically connected to the other 32WSS module within the network element.
### 16.7.6.1 Power Monitoring

Physical photodiodes P1 through P69 monitor the power for the 32WSS card. The returned power level values are calibrated to the ports as shown in Table 16-48.

<table>
<thead>
<tr>
<th>Photodiode</th>
<th>CTC Type Name</th>
<th>Calibrated to Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1–P32</td>
<td>ADD (Power ADD)</td>
<td>ADD RX</td>
</tr>
<tr>
<td>P33–P64</td>
<td>PASS THROUGH</td>
<td>COM TX</td>
</tr>
<tr>
<td></td>
<td>ADD (Power)</td>
<td>COM TX</td>
</tr>
<tr>
<td>P65</td>
<td>OUT EXP</td>
<td>EXP TX</td>
</tr>
<tr>
<td>P66</td>
<td>IN EXP</td>
<td>EXP RX</td>
</tr>
<tr>
<td>P67</td>
<td>OUT COM</td>
<td>COM TX</td>
</tr>
<tr>
<td>P68</td>
<td>IN COM</td>
<td>COM RX</td>
</tr>
<tr>
<td>P69</td>
<td>DROP</td>
<td>DROP TX</td>
</tr>
</tbody>
</table>

1. P33–P64 monitor either ADD or PASSTHROUGH power, depending on the state of the optical switch.

### 16.7.6.2 32WSS Card-Level Indicators

Table 16-49 describes the three card-level LED indicators on the 32WSS card.

<table>
<thead>
<tr>
<th>Card-Level Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready or that there is an internal hardware failure. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>Green ACT LED</td>
<td>The green ACT LED indicates that the 32WSS card is carrying traffic or is traffic-ready.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure on one or more of the card’s ports. The amber SF LED also illuminates when the transmit and receive fibers are incorrectly connected. When the fibers are properly connected, the light turns off.</td>
</tr>
</tbody>
</table>

### 16.7.6.3 32WSS Port-Level Indicators

You can find the status of the 32WSS card’s ports using the LCD screen on the ONS 15454 fan-tray assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms for a given port or slot. The 32WSS card has five sets of ports located on the faceplate. COM RX is the line input, COM TX is the line output, EXP RX is the port where a channel can be added or passed through, EXP TX is the port that passes through the channels that are not dropped, and DROP TX is the port for the dropped channels. The xx.x-yy.y TX ports represent the four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.
16.8 Transponder and Muxponder Cards

This section describes the transponder (TXP) and muxponder (MXP) cards. See the “NTP-G32 Install the Transponder and Muxponder Cards” procedure on page 3-43 as needed. Detailed specifications for the cards are found in Appendix B, “Hardware Specifications.”

TXP and MXP cards detect SF, LOS, or LOF conditions on the optical facility. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide for a description of these conditions. The cards also count section and line BIP errors from B1 and B2 byte registers in the section and line overhead.

16.8.1 TXP_MR_10G Card

The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx card (TXP_MR_10G) processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side). It provides one 10-Gbps port per card that can be provisioned for an STM-64/OC-192 short reach (1310-nm) signal, compliant with ITU-T G.707, G.709, ITU-T G.691, and Telcordia GR-253-CORE, or a 10GBASE-LR signal compliant with IEEE 802.3.

The TXP_MR_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage of 32 different wavelengths in the 1550-nm range.

Note

ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. FEC enables longer fiber links because errors caused by the optical signal degrading with distance are corrected.

The trunk port operates at 9.95328 Gbps (or 10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC) and at 10.3125 Gbps (or 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified distances up to 80 km (50 miles) with different types of fiber such as C-SMF or dispersion compensated fiber limited by loss and/or dispersion.

Caution

Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_10G card does not display circuits under card view.

Caution

You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

You can install TXP_MR_10G cards in Slots 1 to 6 and 12 to 17 and provision this card in a linear configuration. TXP_MR_10G cards cannot be provisioned as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can only be used in the middle of BLSR/MS-SPRing and 1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10G port features a 1550-nm laser for the trunk port and a 1310-nm laser for the client port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

Figure 16-54 shows the TXP_MR_10G faceplate and block diagram.
16.8.1.1 Y-Cable Protection

Two TXP_MR_10G cards can be joined in a Y-cable protection group. In Y-cable protection, the client ports of the two cards are joined by Y-cables. A single incoming receive (Rx) client signal is injected into the Rx Y-cable port and is split between the two TXP_MR_10G cards (connected to the Rx client ports) in the protection group. The transmit (Tx) client signals from the two protection group TXP_MR_10G cards are connected to the correspondent ports of the Tx Y-cable. Only the Tx client port of the active TXP_MR_10G card is turned on and transmits the signal toward the receiving client equipment. See the “16.9 Transponder and Muxponder Protection” section on page 16-114 for more information.

If you create a GCC on either card of the protection group, the trunk (span) port stays permanently active, regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead bytes. The GCC is not protected by the protect group.

16.8.1.2 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS provisioning information, see the “DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards” section on page 5-14.
16.8.1.3 TXP_MR_10G Card-Level Indicators

Table 16-50 lists the three card-level LEDs on the TXP_MR_10G card.

<table>
<thead>
<tr>
<th>Card-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAIL LED (Red)</td>
<td>Red indicates that the card’s processor is not ready. This LED is on during reset. The FAIL LED flashes during the boot process. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>ACT/STBY LED</td>
<td>Green indicates that the card is operational (one or both ports active) and ready to carry traffic. Amber indicates that the card is operational and in standby (protect) mode.</td>
</tr>
<tr>
<td>SF LED (Amber)</td>
<td>Amber indicates a signal failure or condition such as LOS, LOF, or high BERs on one or more of the card’s ports. The amber SF LED is also illuminated if the transmit and receive fibers are incorrectly connected. If the fibers are properly connected and the link is working, the LED turns off.</td>
</tr>
</tbody>
</table>

16.8.1.4 TXP_MR_10G Port-Level Indicators

Table 16-51 lists the four port-level LEDs in the TXP_MR_10G card.

<table>
<thead>
<tr>
<th>Port-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Client LED</td>
<td>The green Client LED indicates that the client port is in service and that it is receiving a recognized signal.</td>
</tr>
<tr>
<td>Green DWDM LED</td>
<td>The green DWDM LED indicates that the DWDM port is in service and that it is receiving a recognized signal.</td>
</tr>
<tr>
<td>Green Wavelength 1 LED</td>
<td>Each port supports two wavelengths on the DWDM side. Each wavelength LED matches one of the wavelengths. This LED indicates that the card is configured for Wavelength 1.</td>
</tr>
<tr>
<td>Green Wavelength 2 LED</td>
<td>Each port supports two wavelengths on the DWDM side. Each wavelength LED matches one of the wavelengths. This LED indicates that the card is configured for Wavelength 2.</td>
</tr>
</tbody>
</table>

16.8.2 TXP_MR_10E Card

The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_10E) card is a multirate transponder for the ONS 15454 platform. The card is fully backward compatible with the TXP_MR_10G card. It processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side) that is tunable over four wavelength channels (spaced at 100 GHz on the ITU grid) in the C-band and tunable over eight wavelength channels (spaced at 50 GHz on the ITU grid) in the L-band. There are eight versions of the C-band card, with each version covering four wavelengths, for a total coverage of 32 wavelengths. There are five versions of the L-band card, with each version covering eight wavelengths, for a total coverage of 40 wavelengths.
You can install TXP_MR_10E cards in Slots 1 to 6 and 12 to 17 and provision the cards in a linear configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The card can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10E card features a 1550-nm tunable laser (C-band) or a 1580-nm tunable laser (L-band) for the trunk port and a separately orderable ONS-XC-10G-S1 1310-nm laser XFP module for the client port. On its faceplate, the TXP_MR_10E card contains two transmit and receive connector pairs, one for the trunk port and one for the client port. Each connector pair is labeled.

16.8.2.1 Key Features

The key features of the TXP_MR_10E card are:

- A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately)
  - OC-192 (SR1)
  - 10GE (10GBASE-LR)
  - 10G-FC (1200-SM-LL-L)
- OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping

16.8.2.2 Faceplate and Block Diagram

Figure 16-55 shows the TXP_MR_10E faceplate and block diagram.

Figure 16-55  TXP_MR_10E Faceplate and Block Diagram
16.8.2 TXP_MR_10E Card

16.8.2.3 Client Interface

The client interface is implemented with a separately orderable XFP module. The module is a tri-rate transceiver, providing a single port that can be configured in the field to support an OC-192 SR-1 (Telcordia GR-253-CORE) or STM-64 I-64.1 (ITU-T G.691) optical interface, as well as 10GE LAN PHY (10GBASE-LR), 10GE WAN PHY (10GBASE-LW), or 10G FC signals.

The client side XFP pluggable module supports LC connectors and is equipped with a 1310-nm laser.

16.8.2.4 DWDM Trunk Interface

On the trunk side, the TXP_MR_10E card provides a 10-Gbps STM-64/OC-192 interface. There are four tunable channels available in the 1550-nm band or eight tunable channels available in the 1580-nm band on the 50-GHz ITU grid for the DWDM interface. The TXP_MR_10E card provides 3R transponder functionality for this 10-Gbps trunk interface. Therefore, the card is suited for use in long-range amplified systems. The DWDM interface is compliant with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE standards.

The DWDM trunk port operates at a rate that is dependent on the input signal and the presence or absence of the ITU-T G.709 Digital Wrapper/FEC. The possible trunk rates are:

- OC192 (9.95328 Gbps)
- OTU2 (10.70923 Gbps)
- 10GE (10.3125 Gbps) or 10GE into OTU2 (nonstandard 11.0957 Gbps)
- 10G FC (10.51875 Gbps) or 10G FC into OTU2 (nonstandard 11.31764 Gbps).

The maximum system reach in filterless applications without the use of optical amplification or regenerators is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but is given for informational purposes. It is subject to change.

16.8.2.5 Y-Cable Protection

The TXP_MR_10E card supports Y-cable protection, which provides transponder equipment protection without client terminal equipment interface protection. A single client interface can be split between two transponder cards using a Y-protection device.

With Y-cable protection, two TXP_MR_10E transponder cards can be joined in a Y-cable protection group. In Y-cable protection, the client ports of the two cards are joined by Y cables. An incoming client signal is injected into the Rx Y-cable port and is split between the two TXP_MR_10E cards (connected to Rx client ports) in the protection group. The Tx client signals from the two protection group TXP_MR_10E cards are connected to the correspondent ports of the Tx Y cable. Only the Tx client port of the active TXP_MR_10E card is turned on and transmits the signal towards the receiving client equipment. See the “16.9.1 Y-Cable Protection” section on page 16-114 for more details.
If you create a GCC using a digital wrapper and apply it to either card of the Y-cable protect group, the DWDM trunk (span) port stays permanently active, regardless of the switch’s state. When you provision a GCC, you are provisioning unprotected overhead (OH) bytes. The GCC is not protected by the protection group.

16.8.2.6 Enhanced FEC (E-FEC) Feature

A key feature of the TXP_MR_10E is the availability to configure the forward error correction in three modes: NO FEC, FEC, and E-FEC. The output bit rate is always 10.7092 Gbps as defined in ITU-T G.709, but the error coding performance can be provisioned as follows:

- NO FEC—No forward error correction
- FEC—Standard ITU-T G.975 Reed-Solomon algorithm
- E-FEC—Standard ITU-T G.975.1 algorithm, which is a super FEC code.

16.8.2.7 FEC and E-FEC Modes

As client side traffic passes through the TXP_MR_10E card, it can be digitally wrapped using FEC mode, E-FEC mode, or no error correction at all. The FEC mode setting provides a lower level of error detection and correction than the E-FEC mode setting of the card. As a result, using E-FEC mode allows higher sensitivity (lower OSNR) with a lower bit error rate than FEC mode. E-FEC enables longer distance trunk-side transmission than with FEC.

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be turned on, or E-FEC can be turned on to provide greater range and lower BER. The default mode is FEC on and E-FEC off. E-FEC is provisioned using CTC.

Because the transponder has no visibility into the data payload and detect circuits, the TXP_MR_10E card does not display circuits under the card view.

16.8.2.8 Client-to-Trunk Mapping

The TXP_MR_10E card can perform ODU2-to-OCh mapping, which allows operators to provision data payloads in a standard way across 10-Gbps optical links.

Digital wrappers that define client side interfaces are called Optical Data Channel Unit 2 (ODU2) entities in ITU-T G.709. Digital wrappers that define trunk side interfaces are called Optical Channels (OCh) in ITU-T G.709. ODU2 digital wrappers can include Generalized Multiprotocol Label Switching (G-MPLS) signaling extensions to ITU-T G.709 (such as Least Significant Part [LSP] and Generalized Payload Identifier [G-PID] values) to define client interfaces and payload protocols.

16.8.2.9 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS provisioning information, see the “DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards” section on page 5-14.
16.8.2.10 TXP_MR_10E Card-Level Indicators

Table 16-52 lists the three card-level LEDs on the TXP_MR_10E card.

Table 16-52  TXP_MR_10E Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red FAIL LED</td>
<td>The red FAIL LED indicates that the card’s processor is not ready. This LED is on during reset. The FAIL LED flashes during the boot process. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>ACT/STBY LED</td>
<td>If the ACT/STBY LED is green, the card is operational (one or both ports active) and ready to carry traffic. If the ACT/STBY LED is amber, the card is operational and in standby (protect) mode.</td>
</tr>
<tr>
<td>Amber SF LED</td>
<td>The amber SF LED indicates a signal failure or condition such as LOS, LOF, or high BERs on one or more of the card’s ports. The amber SF LED is also on if the transmit and receive fibers are incorrectly connected. If the fibers are properly connected and the link is working, the light turns off.</td>
</tr>
</tbody>
</table>

16.8.2.11 TXP_MR_10E Port-Level Indicators

Table 16-53 lists the two port-level LEDs in the TXP_MR_10E card.

Table 16-53  TXP_MR_10E Port-Level Indicators

<table>
<thead>
<tr>
<th>Port-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Client LED</td>
<td>The green Client LED indicates that the client port is in service and that it is receiving a recognized signal.</td>
</tr>
<tr>
<td>Green DWDM LED</td>
<td>The green DWDM LED indicates that the DWDM port is in service and that it is receiving a recognized signal.</td>
</tr>
</tbody>
</table>

16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards

The 2.5-Gbps Multirate Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_2.5G) card processes one 8-Mbps to 2.488-Gbps signal (client side) into one 8-Mbps to 2.5-Gbps, 100-GHz DWDM signal (trunk side). It provides one long-reach STM-16/OC-48 port per card, compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE.

The 2.5-Gbps Multirate Transponder–Protected–100-GHz–Tunable xx.xx-xx.xx (TXPP_MR_2.5G) card processes one 8-Mbps to 2.488-Gbps signal (client side) into two 8-Mbps to 2.5-Gbps, 100-GHz DWDM signals (trunk side). It provides two long-reach STM-16/OC-48 ports per card, compliant with ITU-T G.707, ITU-T G.957, and Telcordia GR-253-CORE.

The TXP_MR_2.5G and TXPP_MR_2.5G cards are tunable over four wavelengths in the 1550-nm, ITU 100-GHz range. They are available in eight versions, each of which covers four wavelengths, for a total coverage of 32 different wavelengths in the 1550-nm range.
ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you transparently take in a signal on the client side, wrap a frame around it, and restore it to its original form. FEC enables longer fiber links because errors caused by the optical signal degrading with distance are corrected.

The trunk/line port operates at up to 2.488 Gbps (or up to 2.66 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified distances up to 360 km (223.7 miles) with different types of fiber such as C-SMF or higher if dispersion compensation is used.

Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_2.5G or TXPP_MR_2.5G card does not display circuits under card view.

The TXP_MR_2.5G and TXPP_MR_2.5G cards support 2R and 3R modes of operation where the client signal is mapped into a ITU-T G.709 frame. The mapping function is simply done by placing a digital wrapper around the client signal. Only OC-48/STM-16 client signals are fully ITU-T G.709 compliant, and the output bit rate depends on the input client signal. Table 16-54 shows the possible combinations of client interfaces, input bit rates, 2R and 3R modes, and ITU-T G.709 monitoring.

Table 16-54  2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

<table>
<thead>
<tr>
<th>Client Interface</th>
<th>Input Bit Rate</th>
<th>3R vs. 2R</th>
<th>ITU-T G.709</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-48/STM-16</td>
<td>2.488 Gbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>DV-6000</td>
<td>2.38 Gbps</td>
<td>2R —</td>
<td></td>
</tr>
<tr>
<td>2 Gigabit Fibre Channel (2G-FC)/fiber connection (FICON)</td>
<td>2.125 Gbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>High-Definition Television (HDTV)</td>
<td>1.48 Gbps</td>
<td>2R —</td>
<td></td>
</tr>
<tr>
<td>Gigabit Ethernet (GE)</td>
<td>1.25 Gbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>1 Gigabit Fibre Channel (1G-FC)/FICON</td>
<td>1.06 Gbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>OC-12/STM-4</td>
<td>622 Mbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>OC-3/STM-1</td>
<td>155 Mbps</td>
<td>3R On or Off</td>
<td></td>
</tr>
<tr>
<td>Enterprise System Connection (ESCON)</td>
<td>200 Mbps</td>
<td>2R —</td>
<td></td>
</tr>
<tr>
<td>SDI/D1 video</td>
<td>270 Mbps</td>
<td>2R —</td>
<td></td>
</tr>
<tr>
<td>ISC-1 Compact</td>
<td>1.06 Gbps</td>
<td>3R Off</td>
<td></td>
</tr>
<tr>
<td>ISC-3</td>
<td>1.06 or 2.125 Gbps</td>
<td>2R —</td>
<td></td>
</tr>
<tr>
<td>ETR_CLO</td>
<td>16 Mbps</td>
<td>2R —</td>
<td></td>
</tr>
</tbody>
</table>

1. No monitoring

The output bit rate is calculated for the trunk bit rate by using the 255/238 ratio as specified in ITU-T G.709 for OTU1. Table 16-55 lists the calculated trunk bit rates for the client interfaces with ITU-T G.709 enabled.
For 2R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to pass data through transparently from client side interfaces to a trunk side interface, which resides on an ITU grid. The data might vary at any bit rate from 200-Mbps up to 2.38-Gbps, including ESCON and video signals. In this pass-through mode, no performance monitoring (PM) or digital wrapping of the incoming signal is provided, except for the usual PM outputs from the SFPs. Similarly, this card has the ability to pass data through transparently from the trunk side interfaces to the client side interfaces with bit rates varying from 200-Mbps up to 2.38-Gbps. Again, no performance monitoring or digital wrapping of received signals is available in this pass-through mode.

For 3R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards apply a digital wrapper to the incoming client interface signals (OC-N/STM-N, 1G-FC, 2G-FC, GE). Performance monitoring is available on all of these signals except for 2G-FC, and varies depending upon the type of signal. For client inputs other than OC-48/STM-16, a digital wrapper might be applied but the resulting signal is not ITU-T G.709 compliant. The card applies a digital wrapper that is scaled to the frequency of the input signal.

The TXP_MR_2.5G and TXPP_MR_2.5G card has the ability to take digitally wrapped signals in from the trunk interface, remove the digital wrapper, and send the unwrapped data through to the client interface. Performance monitoring of the ITU-T G.709 OH and SONET/SDH OH is implemented.

### 16.8.3.1 Faceplate

Figure 16-56 shows the TXP_MR_2.5G and TXPP_MR_2.5G faceplates.

<table>
<thead>
<tr>
<th>Client Interface</th>
<th>ITU-T G.709 Disabled</th>
<th>ITU-T G.709 Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC-48/STM-16</td>
<td>2.488 Gbps</td>
<td>2.66 Gbps</td>
</tr>
<tr>
<td>2G-FC</td>
<td>2.125 Gbps</td>
<td>2.27 Gbps</td>
</tr>
<tr>
<td>GE</td>
<td>1.25 Gbps</td>
<td>1.34 Gbps</td>
</tr>
<tr>
<td>1G-FC</td>
<td>1.06 Gbps</td>
<td>1.14 Gbps</td>
</tr>
<tr>
<td>OC-12/STM-3</td>
<td>622 Mbps</td>
<td>666.43 Mbps</td>
</tr>
<tr>
<td>OC-3/STM-1</td>
<td>155 Mbps</td>
<td>166.07 Mbps</td>
</tr>
</tbody>
</table>
16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards

16.8.3.2 Block Diagram

Figure 16-57 shows a block diagram of the TXP_MR_2.5G and TXPP_MR_2.5G cards.
**Caution**

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G and TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_2.5G and TXPP_MR_2.5G cards.

You can install TXP_MR_2.5G and TXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear configuration. TXP_MR_10G and TXPP_MR_2.5G cards cannot be provisioned as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The TXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm laser for the client port. It contains two transmit and receive connector pairs (labeled) on the card faceplate. The card uses dual LC connectors for optical cable termination.

The TXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser (depending on the SFP) for the client port and contains three transmit and receive connector pairs (labeled) on the card faceplate. The card uses dual LC connectors for optical cable termination.

### 16.8.3.3 Y-Cable Protection

For the TXP_MR_2.5G card, protection is done using Y-cable protection. In Y-cable protection, the client ports of two TXP_MR_2.5G cards can be joined by Y cables in a Y-cable protection group. A single incoming Rx client signal is injected into the Rx Y-cable port and is split between the two TXP_MR_2.5G cards (connected to the Rx client ports) in the protection group. The Tx client signals from the two protection group TXP_MR_2.5G cards are connected to the correspondent ports of the Tx Y-cable. Only the Tx client port of the active TXP_MR_2.5G card is turned on and transmits the signal towards the receiving client equipment. See the “16.9 Transponder and Muxponder Protection” section on page 16-114 for more information.
16.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards

16.8.3.4 Splitter Protection

For the TXPP_MR_2.5G card, protection is done using splitter protection. In splitter protection, the single client signal is injected into the client Rx port. It is then split into two separate signals on the two trunk Tx ports. The two signals are transmitted over diverse paths. The far-end TXPP_MR_2.5G card chooses one of the two trunk Rx port signals and injects it into the Tx client port. The TXPP_MR_2.5G card switches the selected trunk Rx port signal in case of failure. See the “16.9 Transponder and Muxponder Protection” section on page 16-114 for more details.

16.8.3.5 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS provisioning information, see the “DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards” section on page 5-50.

16.8.3.6 TXP_MR_2.5G and TXPP_MR_2.5G Safety Labels

The TXP_MR_2.5G and TXPP_MR_2.5G cards have several safety labels that provide laser radiation and electrical shock warnings.

Figure 16-58 shows the laser radiation warning hazard level label. The faceplate of these cards are clearly labeled with warnings about the equipment radiation level. Personnel must understand all warning labels before working with these cards. The hazard level label warns the personnel against exposure to laser radiation of Class 1M limits calculated in accordance with IEC60825-1 Ed.1.2.

Figure 16-58 Laser Radiation Warning—Hazard Level Label

Figure 16-59 shows the laser source connector label. This label indicates a laser source at the optical connectors where it has been placed.
16.8.3 TXP_MG_2.5G and TXPP_MG_2.5G Cards

16.8.3.7 TXP_MG_2.5G and TXPP_MG_2.5G Card-Level Indicators

Table 16-56 lists the three card-level LEDs on the TXP_MG_2.5G and TXPP_MG_2.5G cards.
16.8.3.8 TXP_MR_2.5G and TXPP_MR_2.5G Port-Level Indicators

Table 16-57 lists the four port-level LEDs on the TXP_MR_2.5G and TXPP_MR_2.5G cards.

<table>
<thead>
<tr>
<th>Port-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Client LED</td>
<td>The green Client LED indicates that the client port is in service and that it is receiving a recognized signal.</td>
</tr>
<tr>
<td>Green DWDM LED</td>
<td>The green DWDM LED indicates that the DWDM port is in service and that it is receiving a recognized signal.</td>
</tr>
<tr>
<td>Green TX LED</td>
<td>The green TX LED indicates that the indicated DWDM port is in service and that it is currently transmitting a recognized signal.</td>
</tr>
<tr>
<td>Green RX LED</td>
<td>The green RX LED indicates that the indicated DWDM port is in service and that it is currently receiving a recognized signal.</td>
</tr>
</tbody>
</table>

16.8.4 MXP_2.5G_10G Card

The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10G) card multiplexes/demultiplexes four 2.5-Gbps signals (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side). It provides one extended long-range STM-64/OC-192 port per card on the trunk side (compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE) and four intermediate- or short-range OC-48/STM-16 ports per card on the client side. The port operates at 9.95328 Gbps over unamplified distances up to 80 km (50 miles) with different types of fiber such as C-SMF or dispersion compensated fiber limited by loss and/or dispersion.

Client ports on the MXP_2.5G_10G card are also interoperable with OC-1 (STS-1) fiber optic signals defined in Telcordia GR-253-CORE. An OC-1 signal is the equivalent of one DS-3 channel transmitted across optical fiber. OC-1 is primarily used for trunk interfaces to phone switches in the United States. There is no SDH equivalent for OC-1.

The MXP_2.5G_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage of 32 different wavelengths in the 1550-nm range.
Note
ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. FEC enables longer fiber links because errors caused by the optical signal degrading with distance are corrected.

The port can also operate at 10.70923 Gbps in ITU-T G.709 Digital Wrapper/FEC mode.

Caution
Because the transponder has no capability to look into the payload and detect circuits, an MXP_2.5G_10G card does not display circuits under card view.

Caution
You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

You can install MXP_2.5G_10G cards in Slots 1 to 6 and 12 to 17.

Caution
Do not install an MXP_2.5G_10G card in Slot 3 if you have installed a DS3/EC1-48 card in Slots 1 or 2. Likewise, do not install an MXP_2.5G_10G card in Slot 17 if you have installed a DS3/EC1-48 card in Slots 15 or 16. If you do, the cards will interact and cause DS-3 bit errors.

You can provision this card in a linear configuration. MXP_2.5G_10G cards cannot be provisioned as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The MXP_2.5G_10G port features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses a dual LC connector on the trunk side and SFP connectors on the client side for optical cable termination.

Figure 16-62 shows the MXP_2.5G_10G faceplate.
Figure 16-62 MXP_2.5G_10G Faceplate

Figure 16-63 shows a block diagram of the MXP_2.5G_10G card.
### 16.8.4 MXP_2.5G_10G Card

#### 16.8.4.1 Y-Cable Protection

For the MXP_2.5G_10G card, protection is done using Y-cable protection. In Y-cable protection, the client ports of two MXP_2.5G_10G cards can be joined by Y cables in a Y-cable protection group. A single Rx client signal is injected into the Rx Y-cable and is split between the two MXP_2.5G_10G cards in the protection group. The Tx client signals from the two protection group MXP_2.5G_10G cards are connected via the TX Y cable with only the active card signal passing through as the single TX client signal. See the “16.9.1 Y-Cable Protection” section on page 16-114 for more details.

**Note**

If you create a GCC on either card of the protect group, the trunk port stays permanently active, regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead bytes. The GCC is not protected by the protect group.

#### 16.8.4.2 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS provisioning information, see the “DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards” section on page 5-34.

#### 16.8.4.3 Timing Synchronization

The MXP_2.5G_10G card is synchronized to the TCC2/TCC2P clock during normal conditions and transmits the ITU-T G.709 frame using this clock. The TCC2/TCC2P card can operate from an external BITS clock, an internal Stratum 3 clock, or from clock recovered from one of the four valid client clocks. If clocks from both TCC2/TCC2P cards are not available, the MXP_2.5G_10G card switches automatically (with errors, not hitless) to an internal 19.44 MHz clock that does not meet SONET clock requirements. This will result in a clock alarm.
16.8.5 MXP_2.5G_10E Card

The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10E) card is a DWDM muxponder for the ONS 15454 platform that supports full optical transparency on the client side. The card multiplexes four 2.5 Gbps client signals (4 x OC48/STM-16 SFP) into a single 10-Gbps DWDM optical signal on the trunk side. The MXP_2.5G_10E provides wavelength transmission service for the four incoming 2.5 Gbps client interfaces. The MXP_2.5G_10E muxponder passes all SONET/SDH overhead bytes transparently.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring.
The MXP_2.5G_10E works with OTN devices defined in ITU-T G.709. The card supports ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH payload into a digitally wrapped envelope. See the “16.8.5.5 Multiplexing Function” section on page 16-102.

The MXP_2.5G_10E card is not compatible with the MXP_2.5G_10G card, which does not support full optical transparency. The faceplate designation of the card is “4x2.5G 10E MXP.”

You can install MXP_2.5G_10E cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The card can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode.

The MXP_2.5G_10E features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses a dual LC connector on the trunk side and uses SFP modules on the client side for optical cable termination. The SFP pluggable modules are short reach (SR) or intermediate reach (IR) and support an LC fiber connector.

16.8.5.1 Key Features

The MXP_2.5G_10E card has the following high level features:

- Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals are mapped into an ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

- Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the transmission range on these interfaces. The E-FEC functionality increases the correction capability of the transponder to improve performance, allowing operation at a lower OSNR compared to the standard RS (237,255) correction algorithm. A new BCH algorithm implemented in E-FEC allows recovery of an input BER up to 1E-3.

- Pluggable client interface optic modules: The MXP_MP_10E card has modular interfaces. Two types of optics modules can be plugged into the card. These include an OC-48/STM 16 SR-1 interface with a 7 km nominal range (for short range and intra-office applications) and an IR-1 interface with a range up to 40 km. SR-1 is defined in Telcordia GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 (ITU-T G.957).

- High level provisioning support: The MXP_MP_10E card is initially provisioned using Cisco MetroPlanner software. Subsequently, the card can be monitored and provisioned using CTC software.

- Link monitoring and management: The MXP_MP_10E card uses standard OC-48 OH (overhead) bytes to monitor and manage incoming interfaces. The card passes the incoming SDH/SONET data stream and its overhead bytes transparently.

- Control of layered SONET/SDH transport overhead: The card is provisionable to terminate regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce the number of alarms and help isolate faults in the network.

- Automatic timing source synchronization: The MXP_MP_10E normally synchronizes from the TCC2/TCC2P card. If for some reason, such as maintenance or upgrade activity, the TCC2/TCC2P is not available, the MXP_MP_10E automatically synchronizes to one of the input client interface clocks.

- Configurable squelching policy: The card can be configured to squelch the client interface output if there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the card manages multiplex section alarm indication signal (MS-AIS) insertion.
16.8.5.2 Faceplate

Figure 16-64 shows the MXP_2.5G_10E faceplate.

Figure 16-64  MXP_2.5G_10E Faceplate

Figure 16-65 shows a block diagram of the MXP_2.5G_10E card.
16.8.5.3 Client Interfaces

The MXP_2.5G_10E provides four intermediate- or short-range OC-48/STM-16 ports per card on the client side. Both SR-1 or IR-1 optics can be supported and the ports use SFP connectors. The client interfaces use four wavelengths in the 1310-nm, ITU 100-MHz-spaced, channel grid.

16.8.5.4 DWDM Interface

The MXP_MP_10E serves as an OTN multiplexer, transparently mapping four OC-48 channels asynchronously to ODU1 into one 10-Gbps trunk. The DWDM trunk is tunable for transmission over four wavelengths in the 1550-nm, ITU 100-GHz spaced channel grid.

**Caution**

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MP_10E card in a loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_MP_10E card. Using direct fiber loopbacks causes irreparable damage to the MXP_MP_10E card.

16.8.5.5 Multiplexing Function

The muxponder is an integral part of the optically transparent ROADM network in which data payload channels and wavelengths are processed exclusively at the optical level without electrical to optical (E-O) conversion. The key function of MXP_MP_10E is to multiplex 4 OC-48/STM16 signals onto one ITU-T G.709 OTU2 optical signal (DWDM transmission). The multiplexing mechanism allows the signal to be terminated at a far-end node by another MXP_2.5G_10E card.

Optical transparency on the muxponder is configured using OTUx and ODUx OH bytes. The ITU-T G.709 specification defines OH byte formats that are used to configure, set, and monitor frame alignment, FEC mode, section monitoring, tandem connection monitoring, and optical transparency.
The MXP_2.5G_10E card performs ODU to OTU multiplexing as defined in ITU-T G.709. The ODU is the framing structure and byte definition (ITU-T G.709 digital wrapper) used to define the data payload coming into one of the SONET/SDH client interfaces on MXP_2.5G_10E. The term ODU1 refers to an ODU that operates at 2.5-Gbps line rate. On the MXP_2.5G_10E, there are four client interfaces that can be defined using ODU1 framing structure and format by asserting a ITU-T G.709 digital wrapper.

The output of the muxponder is a single 10-Gbps DWDM trunk interface defined using OTU2. It is within the OTU2 framing structure that FEC or E-FEC information is appended to enable error checking and correction.

### 16.8.5.6 Timing Synchronization

The MXP_2.5G_10E card is synchronized to the TCC2/TCC2P clock during normal conditions and transmits the ITU-T G.709 frame using this clock. No holdover function is implemented. If neither TCC2/TCC2P clock is available, the MXP_2.5G_10E switches automatically (hitless) to the first of the four valid client clocks with no time restriction as to how long it can run on this clock. The MXP_2.5G_10E continues to monitor the TCC2/TCC2P card. If a TCC2/TCC2P card is restored to working order, the MXP_2.5G_10E reverts to the normal working mode of running from the TCC2/TCC2P clock. If there is no valid TCC2/TCC2P clock and all of the client channels become invalid, the card waits (no valid frames processed) until one of the TCC2/TCC2P cards supplies a valid clock. In addition, the card is allowed to select the recovered clock from one active and valid client channel and supply that clock to the TCC2/TCC2P card.

### 16.8.5.7 Y-Cable Protection

The MXP_2.5G_10E card supports Y-cable protection. Two MXP_2.5G_10E cards can be joined in a Y-cable protection group with one card assigned as the working card and the other defined as the protection card. This protection mechanism provides redundant bidirectional paths. See the “16.9.1 Y-Cable Protection” section on page 16-114 for more detailed information.

The Y-protection mechanism is provisionable and can be set ON or OFF (OFF is the default mode). When a signal fault is detected (LOS, LOF, signal degrade [SD], or SF on the DWDM receiver port in the case of ITU-T G.709 mode) the protection mechanism software automatically switches between paths.

Note

If you create a GCC on either card of the protect group, the trunk port stays permanently active, regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead bytes. The GCC is not protected by the protect group.

### 16.8.5.8 Enhanced FEC (E-FEC) Capability

The MXP_2.5G_10E can configure the FEC in three modes: NO FEC, FEC, and E-FEC. The output bit rate is always 10.7092 Gbps as defined in ITU-T G.709, but the error coding performance can be provisioned as follows:

- **NO FEC**—No FEC
- **FEC**—Standard ITU-T G.975 Reed-Solomon algorithm
- **E-FEC**—Standard ITU-T G.975.1, two orthogonally concatenated BCH super FEC code. This FEC scheme contains three parameterizations of the same scheme of two orthogonally interleaved block codes (BCH). The constructed code is decoded iteratively to achieve the expected performance.
16.8.5.9 FEC and E-FEC Modes

As client side traffic passes through the MXP_2.5G_10E card, it can be digitally wrapped using FEC mode error correction or E-FEC mode error correction (or no error correction at all). The FEC mode setting provides a lower level of error detection and correction than the E-FEC mode setting of the card. As a result, using E-FEC mode allows higher sensitivity (lower OSNR) with a lower BER than FEC mode. E-FEC enables longer distance trunk-side transmission than with FEC.

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be turned on, or E-FEC can be turned on to provide greater range and lower BER. The default mode is FEC on and E-FEC off. E-FEC is provisioned using CTC.

16.8.5.10 SONET/SDH Overhead Byte Processing

The card passes the incoming SONET/SDH data stream and its overhead bytes for the client signal transparently. The card can be provisioned to terminate regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce the number of alarms and help isolate faults in the network.

16.8.5.11 Client Interface Monitoring

The following parameters are monitored on the MXP_2.5G_10E card:

- Laser bias current is measured as a PM parameter
- LOS is detected and signaled
- Rx and Tx power are monitored

The following parameters are monitored in real time mode (one second):

- Optical power transmitted (client)
- Optical power received (client)

In case of loss of communication (LOC) at the DWDM receiver or far-end LOS, the client interface behavior is configurable. AIS can be invoked or the client signal can be squelched.

16.8.5.12 Wavelength Identification

The card uses trunk lasers that are wave-locked, which allows the trunk transmitter to operate on the ITU grid effectively. Table 16-60 describes the required trunk transmit laser wavelengths. The laser is tunable over eight wavelengths at 50-GHz spacing or four at 100-GHz spacing.

<table>
<thead>
<tr>
<th>Band</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30.3</td>
<td>1530.33</td>
</tr>
<tr>
<td>30.3</td>
<td>1531.12</td>
</tr>
<tr>
<td>30.3</td>
<td>1531.90</td>
</tr>
<tr>
<td>30.3</td>
<td>1532.68</td>
</tr>
<tr>
<td>34.2</td>
<td>1534.25</td>
</tr>
<tr>
<td>34.2</td>
<td>1535.04</td>
</tr>
</tbody>
</table>
16.8.5.13 Automatic Laser Shutdown

The ALS procedure is supported on both client and trunk interfaces. On the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration is user-configurable. For ALS provisioning information, see the “DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards” section on page 5-34.

16.8.5.14 Jitter

For SONET and SDH signals, the MXP_2.5G_10E card complies to GR-253-CORE, ITU-T G.825, and ITU-T G.873 for jitter generation, jitter tolerance, and jitter transfer.
16.8.5.15 Lamp Test

The MXP_2.5G_10E card supports a lamp test function that is activated from the ONS 15454 front panel or through CTC to ensure that all LEDs are functional.

16.8.5.16 Onboard Traffic Generation

The MXP_2.5G_10E card provides internal traffic generation for testing purposes according to pseudo-random bit sequence (PRBS), SONET/SDH, or ITU-T G.709.

16.8.5.17 MXP_2.5G_10E Card-Level Indicators

Table 16-61 describes the three card-level LEDs on the MXP_2.5G_10E card.

<table>
<thead>
<tr>
<th>Card-Level LED</th>
<th>Description</th>
</tr>
</thead>
</table>
| Red FAIL LED          | The red FAIL LED indicates that the card’s processor is not ready. This LED is on during reset. The FAIL LED flashes during the boot process. Replace the card if the red FAIL LED persists.
| ACT/STBY LED          | If the ACT/STBY LED is green, the card is operational (one or more ports active) and ready to carry traffic. If the ACT/STBY LED is amber, the card is operational and in standby (protect) mode. |
| Green (Active) Amber (Standby) | If the fibers are properly connected and the link is working, the light turns off. |
| Amber SF LED          | The amber SF LED indicates a signal failure or condition such as LOS, LOF, or high BERs on one or more of the card’s ports. The amber SF LED is also on if the transmit and receive fibers are incorrectly connected. |

16.8.5.18 MXP_2.5G_10E Port-Level Indicators

Table 16-62 describes the port-level LEDs on the MXP_2.5G_10E card.

<table>
<thead>
<tr>
<th>Port-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Client LED (four LEDs)</td>
<td>The green Client LED indicates that the client port is in service and that it is receiving a recognized signal. The card has four client ports, and so has four Client LEDs.</td>
</tr>
<tr>
<td>Green DWDM LED</td>
<td>The green DWDM LED indicates that the DWDM port is in service and that it is receiving a recognized signal.</td>
</tr>
</tbody>
</table>

16.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards

The 2.5-Gbps Multirate Muxponder-100 GHz-Tunable 15xx.xx-15yy.yy (MXP_MR_2.5G) card aggregates a mix and match of client Storage Area Network (SAN) service client inputs (GE, FICON, and Fibre Channel) into one 2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides one long-reach STM-16/OC-48 port per card and is compliant with Telcordia GR-253-CORE.
The 2.5-Gbps Multirate Muxponder—Protected—100 GHz–Tunable 15xx.xx-15yy.yy (MXPP_MR_2.5G) card aggregates various client SAN service client inputs (GE, FICON, and Fibre Channel) into one 2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides two long-reach STM-16/OC-48 ports per card and is compliant with ITU-T G.957 and Telcordia GR-253-CORE.

Because the cards are tunable to one of four adjacent grid channels on a 100-GHz spacing, each card is available in eight versions, with 15xx.xx representing the first wavelength and 15yy.yy representing the last wavelength of the four available on the board. In total, 32 DWDM wavelengths are covered in accordance with the ITU-T 100-GHz grid standard, G.692, and Telcordia GR-2918-CORE, Issue 2. The card versions along with their corresponding wavelengths are shown in Table 16-63.

### Table 16-63 Card Versions

<table>
<thead>
<tr>
<th>Card Version</th>
<th>Frequency Channels at 100 GHz (0.8 nm) Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1530.33–1532.68</td>
<td>1530.33 nm 1531.12 nm 1531.90 nm 1532.68 nm</td>
</tr>
<tr>
<td>1534.25–1536.61</td>
<td>1534.25 nm 1535.04 nm 1535.82 nm 1536.61 nm</td>
</tr>
<tr>
<td>1538.19–1540.56</td>
<td>1538.19 nm 1538.98 nm 1539.77 nm 1540.56 nm</td>
</tr>
<tr>
<td>1542.14–1544.53</td>
<td>1542.14 nm 1542.94 nm 1543.73 nm 1544.53 nm</td>
</tr>
<tr>
<td>1546.12–1548.51</td>
<td>1546.12 nm 1546.92 nm 1547.72 nm 1548.51 nm</td>
</tr>
<tr>
<td>1550.12–1552.52</td>
<td>1550.12 nm 1550.92 nm 1551.72 nm 1552.52 nm</td>
</tr>
<tr>
<td>1554.13–1556.55</td>
<td>1554.13 nm 1554.94 nm 1555.75 nm 1556.55 nm</td>
</tr>
<tr>
<td>1558.17–1560.61</td>
<td>1558.17 nm 1558.98 nm 1559.79 nm 1560.61 nm</td>
</tr>
</tbody>
</table>

The muxponders are intended to be used in applications with long DWDM metro or regional unregenerated spans. Long transmission distances are achieved through the use of flat gain optical amplifiers.

The client interface supports the following payload types:
- GE
- 1G FC
- 2G FC
- 1G FICON
- 2G FICON

Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to a maximum limit of 2.5 Gbps.

Table 16-64 shows the input data rate for each client interface, and the encapsulation method. The current version of the Transparent Generic Framing Procedure (GFP-T) G.7041 supports transparent mapping of 8B/10B block-coded protocols, including Gigabit Ethernet, Fibre Channel, and FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed SERDES is mapped to an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the high-speed serializer/deserializer (SERDES), the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the second STS-24c channel. The two channels are then mapped into an OC-48 trunk channel.
16.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards

Table 16-65 shows some of the mix and match possibilities on the various client ports. The table is intended to show the full client payload configurations for the card.

Table 16-64  MXP_MR_2.5G and MXPP_MR_2.5G Client Interface Data Rates and Encapsulation

<table>
<thead>
<tr>
<th>Client Interface</th>
<th>Input Data Rate</th>
<th>GFP-T G.7041 Encapsulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>GE</td>
<td>1.25 Gbps</td>
<td>Yes</td>
</tr>
<tr>
<td>1G FC</td>
<td>1.06 Gbps</td>
<td>Yes</td>
</tr>
<tr>
<td>2G FC</td>
<td>2.125 Gbps</td>
<td>Yes</td>
</tr>
<tr>
<td>1G FICON</td>
<td>1.06 Gbps</td>
<td>Yes</td>
</tr>
<tr>
<td>2G FICON</td>
<td>2.125 Gbps</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 16-65  Client Data Rates and Ports

<table>
<thead>
<tr>
<th>Mode</th>
<th>Port(s)</th>
<th>Aggregate Data Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>GE</td>
<td>1, 2</td>
<td>2.5 Gbps</td>
</tr>
<tr>
<td>1G FC</td>
<td>1, 2</td>
<td>2.125 Gbps</td>
</tr>
<tr>
<td>2G FC</td>
<td>1</td>
<td>2.125 Gbps</td>
</tr>
<tr>
<td>1G FICON</td>
<td>1, 2</td>
<td>2.125 Gbps</td>
</tr>
<tr>
<td>2G FICON</td>
<td>1</td>
<td>2.125 Gbps</td>
</tr>
</tbody>
</table>

For the MXP_MR_2.5G card, protection is done using Y-cable protection. Two MXP_MR_2.5G cards can be joined in a Y-cable protection group, which provides protection against failures both on the fiber and in the muxponders.

For the MXPP_MR_2.5G card, protection is done using splitter protection, which provides protection against failures due to fiber cuts or unacceptable signal degradation on the trunk side. See the “16.9 Transponder and Muxponder Protection” section on page 16-114 for more detailed information.

Note

Switching is performed only if the protect line is error free.

GFP-T performance monitoring (GFP-T PM) is available via remote monitoring (RMON), and trunk PM is managed according to Telcordia GR-253-CORE and ITU G.783/826. Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to stop transmitting and wait for the receipt of a “ready” indication. The MXP_MR_2.5G and MXPP_MR_2.5 cards support FC credit-based flow control with a buffer-to-buffer credit extension of up to 1600 km for 1G FC and up to 800 km for 2G FC. The feature can be enabled or disabled.

You can install MXP_MR_2.5G and MXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. The TCC2/TCC2P card is the only other card required to be used with these muxponder cards. Cross-connect cards do not affect the operation of the muxponder cards.
The MXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser (depending on the SFP) for the client ports. The card contains eight 12.5 degree downward tilt SFP modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are labeled TX and RX on the faceplate. The trunk port is a dual-LC connector with a 45 degree downward angle.

The MXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser (depending on the SFP) for the client port. The card contains eight 12.5 degree downward tilt SFP modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are labeled TX and RX on the faceplate. There are two trunk port connectors (one for working and one for protect). Each is a dual-LC connector with a 45-degree downward angle.

16.8.6.1 Faceplates

Figure 16-66 shows the MXP_MR_2.5G and MXPP_MR_2.5G faceplates.
16.8.6.2 Block Diagram

Figure 16-67 shows a block diagram of the MXP_My_2.5G card. The card has eight SFP client interfaces. Ports 1 and 2 can be used for GE, FC, or FICON. Ports 3 through 8 are for future use. There are two SERDES blocks dedicated to the high-speed interfaces (GE, FC, and FICON) and two SERDES blocks for future interfaces. A field programmable gate array (FPGA) is provided to support different configurations for different modes of operation. This FPGA has a Universal Test and Operations Physical Interface for ATM (UTOPIA) interface. A transceiver add-drop multiplexer (TADM) chip
supports framing. Finally, the output signal is serialized and connected to the trunk front end with a direct modulation laser. The trunk receive signal is converted into an electrical signal with an avalanche photodiode (APD), is deserialized, and is then sent to the TADM framer and FPGA.

The MXPP_MR_2.5G is the same, except a 50/50 splitter divides the power at the trunk interface. In the receive direction, there are two APDs, two SERDES blocks, and two TADM framers. This is necessary to monitor both the working and protect paths. A switch selects one of the two paths to connect to the client interface.

![Figure 16-67 MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram](image)

**Caution**

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and MXPP_MR_2.5G cards in a loopback configuration on the trunk port. Do not use direct fiber loopbacks with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

### 16.8.6.3 MXP_MR_2.5G and MXPP_MR_2.5G Safety Labels

The MXP_MR_2.5G and MXPP_MR_2.5G cards have several safety labels that provide laser radiation and electrical shock warnings. **Figure 16-68** shows the laser radiation warning hazard level label. The faceplate of these cards are clearly labeled with warnings about the equipment radiation level. Personnel must understand all warning labels before working with these cards. The hazard level label warns the personnel against exposure to laser radiation of Class 1M limits calculated in accordance with IEC60825-1 Ed.1.2.
Figure 16-68  Laser Radiation Warning—Hazard Level Label

Figure 16-69 shows the laser source connector label. This label indicates a laser source at the optical connectors where it has been placed.

Figure 16-69  Laser Radiation Warning—Laser Source Connector Label

Figure 16-70 shows the FDA compliance label. This label shows the statement of compliance to FDA standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure 16-70  FDA Compliance Statement Label

Figure 16-71 shows the electrical energy hazard label. This label alerts personnel to electrical hazards within the card. The potential of shock hazard exists when adjacent cards are removed during maintenance and touching exposed electrical circuitry on the card itself.
16.8.6.4 MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators

Table 16-66 lists the four card-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

Table 16-66  MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators

<table>
<thead>
<tr>
<th>Card-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAIL LED (Red)</td>
<td>Red indicates that the card’s processor is not ready. This LED is on during reset. The FAIL LED flashes during the boot process. Replace the card if the red FAIL LED persists.</td>
</tr>
<tr>
<td>ACT/STBY LED</td>
<td>Green indicates that the card is operational (one or both ports active) and ready to carry traffic. Amber indicates that the card is operational and in standby (protect) mode.</td>
</tr>
<tr>
<td>SF LED (Amber)</td>
<td>Amber indicates a signal failure or condition such as LOS, LOF, or high BERs on one or more of the card’s ports. The amber SF LED is also illuminated if the transmit and receive fibers are incorrectly connected. If the fibers are properly connected and the link is working, the LED turns off.</td>
</tr>
<tr>
<td>DWDM LED</td>
<td>Green indicates that the board is carrying traffic (active) on the interface. When the LED is amber, it indicates that the interface is carrying protect traffic in a splitter protection card (MXPP_MR_2.5G). A red LED indicates that the interface has detected an LOS or LOC.</td>
</tr>
</tbody>
</table>

16.8.6.5 MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators

Table 16-67 lists the eight port-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

Table 16-67  MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators

<table>
<thead>
<tr>
<th>Port-Level LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client LEDs (eight LEDs)</td>
<td>Green indicates that the port is carrying traffic (active) on the interface. Amber indicates that the port is carrying protect traffic (MXPP_MR_2.5G). Red indicates that the port has detected a loss of signal.</td>
</tr>
</tbody>
</table>
16.9 Transponder and Muxponder Protection

Two types of protection are available:

- Y-cable protection
- Splitter protection

16.9.1 Y-Cable Protection

Y-cable protection is available for the following ONS 15454 transponder and muxponder cards:

- TXP_MR_10G
- TXP_MR_2.5G
- MXP_MR_2.5G
- MXP_2.5G_10G

To create Y-cable protection, you create a Y-cable protection group for two TXP or MXP cards using the CTC software, then connect the client ports of the two cards physically with a Y-cable. The single client signal is sent into the Rx Y-cable and is split between the two TXP or MXP cards. The two Tx signals from the client side of the TXP or MXP cards are combined in the TX Y-cable into a single client signal. Only the active card signal passes through as the single TX client signal. The other card must have its laser turned off to avoid signal degradation where the Y-cable joins. See the “NTP-G33 Create a Y-Cable Protection Group” procedure on page 5-10 as needed.

Figure 16-72 shows the Y-cable signal flow.

---

**Note**

Loss of Signal–Payload (LOS-P) alarms, also called Incoming Payload Signal Absent alarms, can occur on a split signal if the ports are not in a Y-cable protection group.
16.9.2 Splitter Protection

Splitter protection, shown in Figure 16-73, is provided with TXPP and MXPP cards. To implement splitter protection, a client injects a single signal into the client Rx port. An optical splitter internal to the card then splits the signal into two separate signals and routes them to the two trunk Tx ports. The two signals are transmitted over diverse optical paths. The far-end MXPP or TXPP card uses an optical switch to choose one of the two trunk Rx port signals and injects it into the Tx client port. When using splitter protection with two MXPP or TXPP cards, there are two different optical signals that flow over diverse paths in each direction. In case of failure, the far-end switch must choose the appropriate signal using its built-in optical switch. The triggers for a protection switch are LOS, LOF, SF, or SD.
16.10 Far-End Laser Control (FELC)

The 15454 DWDM cards provide a transparent mode that accurately conveys the client input signal to the far-end client output signal. The client signal is normally carried as payload over the DWDM signals. Certain client signals, however, cannot be conveyed as payload. In particular, client LOS or LOF cannot be carried. Far-end laser control is the ability to convey an LOS or LOF from the near-end client input to the far-end client output.

If an LOS is detected on the near-end client input, the near-end trunk sets the appropriate bytes in the OTN overhead of the DWDM line. These bytes are received by the far-end trunk, and cause the far-end client laser to be turned off. When the laser is turned off, it is said to be squelched. If the near-end LOS clears, the near-end trunk clears the appropriate bytes in the OTN overhead, the far-end detects the changed bytes, and the far-end client squelch is removed.

FELC also covers the situation in which the trunk port detects that it has an invalid signal; the client is squelched so as not to propagate the invalid signal.

Payload types with the 2R mode preclude the use of OTN overhead bytes. In 2R mode, an LOS on the client port causes the trunk laser to turn off. The far end detects the LOS on its trunk receiver and squelches the client.

FELC is not provisionable. It is always enabled when the DWDM card is in Transparent mode. However, FELC signaling to the far-end is only possible when ITU-T G.709 is enabled on both ends of the trunk span.

16.11 Jitter Considerations

Jitter introduced by the SFPs used in the transponders and muxponders must be considered when cascading several cards. With TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, and TXP_MR_10G cards, several transponders can be cascaded before the cumulative jitter violates the jitter specification. The recommended limit is 20 cards. With TXP_MR_10G cards, you can also cascade several cards, although the recommended limit is 12 cards. With MXP_2.5G_10G and MXP_2.5G_10E
cards, any number of cards can be cascaded as long as the maximum reach between any two is not exceeded. This is because any time the signal is demultiplexed, the jitter is eliminated as a limiting factor.

The maximum reach between one transponder and the other must be halved if a Y cable is used. For more information on Y-cable operation, see the “16.9.1 Y-Cable Protection” section on page 16-114.

## 16.12 Termination Modes

Transponder and muxponder cards have various SONET and SDH termination modes that can be configured using CTC (see Chapter 11, “Change DWDM Card Settings”). The termination modes are summarized in Table 16-68.

<table>
<thead>
<tr>
<th>Card</th>
<th>Termination Modes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All TXP and MXP cards, with the exception of the MXP_2.5G_10G card (see next section of this table)</td>
<td>Transparent Termination</td>
<td>All the bytes of the payload pass transparently through the cards.</td>
</tr>
<tr>
<td></td>
<td>Section Termination</td>
<td>The SONET Transport Overhead (TOH) section bytes and the SDH regenerator section overhead bytes are terminated. None of these section overhead bytes are passed through. They are all regenerated, including the SONET TOH section data communication channel (SDCC) bytes and the SDH data communications channel regenerator (DCCr) bytes. In the section termination mode, the SONET TOH line and SDH multiplex section overhead bytes are passed transparently.</td>
</tr>
<tr>
<td></td>
<td>Line Termination</td>
<td>In line termination mode, the section and line overhead bytes for SONET and the overhead bytes for the SDH multiplex and regenerator sections are terminated. None of the overhead bytes are passed through. They are all regenerated, including the SONET SDCC and line data communication channel (LDCC) bytes and the SDH DCCr and data communications channel multiplexer (DCCm) bytes.</td>
</tr>
<tr>
<td>MXP_2.5G_10G</td>
<td>Transparent Termination</td>
<td>All of the client bytes of the clients passes transparently through except the following: B1 is rebuilt, S1 is rewritten, A1 to A2 are regenerated, and H1 to H3 are regenerated.</td>
</tr>
<tr>
<td></td>
<td>Section Termination</td>
<td>The SONET TOH section bytes and the SDH regenerator section overhead bytes are terminated. None of these section overhead bytes are passed through. They are all regenerated, including the SONET TOH section DCC bytes and the SDH DCCr bytes. In the section termination mode, the SONET TOH line and SDH multiplex section overhead bytes are passed transparently.</td>
</tr>
<tr>
<td></td>
<td>Line Termination</td>
<td>In the line termination mode, the section and line overhead bytes for SONET and the overhead bytes for the SDH multiplex and regenerators sections are terminated. None of the overhead bytes are passed through. They are all regenerated, including the SONET SDCC and LDCC bytes and the SDH DCCr and DCCm bytes.</td>
</tr>
</tbody>
</table>

1. The clients operating at rates of OC48/STM16 are multiplexed into an OC192/STM64 frame before going to OTN or DWDM.
16.13 SFP and XFP Modules

This section describes the SFPs and 10-Gbps SFPs (XFPs) that can be used with some transponder and muxponder cards. To install SFPs or XFPs, see the “DLP-G63 Install an SFP or XFP” task on page 3-45. In CTC, SFPs/XFPs are called pluggable port modules (PPMs). To provision SFPs/XFPs and change the line rate for multirate PPMs, see the “NTP-G128 Manage Pluggable Port Modules” procedure on page 5-2.

16.13.1 Compatibility by Card

Table 16-69 lists the transponder and muxponder cards and their compatible SFPs/XFPs.

Caution

Only use SFPs/XFPs certified for use in Cisco Optical Networking Systems (ONSs). The qualified Cisco SFP/XFP pluggable module’s top assembly numbers (TANs) are provided in Table 16-69.

<table>
<thead>
<tr>
<th>Card</th>
<th>Compatible SFP (Cisco Product ID)</th>
<th>Cisco Top Assembly Number (TAN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP_2.5G_10G (ONS 15454 SONET/SDH)</td>
<td>15454-SFP-OC48-IR= ONS-SE-2G-S1=</td>
<td>10-1975-01 10-2017-01</td>
</tr>
<tr>
<td>MXP_MR_2.5G</td>
<td>15454-SFP-GE+-LX= 15454E-SFP-GE+-LX= 15454-SFP-GEFC-SX= 15454E-SFP-GEFC-S=</td>
<td>10-1832-03 10-1832-03 10-1833-01 10-1833-02</td>
</tr>
<tr>
<td>TXP_MR_10E (ONS 15454 SONET/SDH)</td>
<td>ONS-XC-10G-S1</td>
<td>10-2012-01</td>
</tr>
</tbody>
</table>
16.13.2 SFP and XFP Description

SFPs and XFPs are integrated fiber optic transceivers that provide high-speed serial links from a port or slot to the network. Various latching mechanisms can be utilized on the SFP modules. There is no correlation between the type of latch to the model type (such as SX or LX/LH) or technology type (such as Gigabit Ethernet). See the label on the SFP or XFP for technology type and model.

The SFPs use the latches show in the following figures. One type of latch is a mylar tab (Figure 16-74).

Figure 16-74 Mylar Tab SFP

A second type of latch is an actuator/button (Figure 16-75).

Figure 16-75 Actuator/Button SFP

A third type of latch is a bail clasp (Figure 16-76).

Figure 16-76 Bail Clasp SFP

SFP dimensions are:
- Height 0.03 in. (8.5 mm)
- Width 0.53 in. (13.4 mm)
- Depth 2.22 in. (56.5 mm)

SFP temperature ranges are:
- COM—Commercial operating temperature range –5 to 70 degrees Celsius (23 to 158 degrees Fahrenheit)
16.13.2 SFP and XFP Description

- **EXT**—Extended operating temperature range –5 to 85 degrees Celsius (23 to 185 degrees Fahrenheit)
- **IND**—Industrial operating temperature range –40 to 85 degrees Celsius (–40 to 185 degrees Fahrenheit)

The XFPs uses the bail clasp latching mechanism as shown unlatched in Figure 16-77 and latched in Figure 16-78. See the label on the XFP for technology type and model.

![Figure 16-77 Bail Clasp XFP (Unlatched)](image)

![Figure 16-78 Bail Clasp XFP (Latched)](image)

XFP dimensions are:
- Height 0.33 in. (8.5 mm)
- Width 0.72 in. (18.3 mm)
- Depth 3.1 in. (78 mm)

XFP temperature ranges are:
- **COM**—Commercial operating temperature range –5 to 70 degrees Celsius (23 to 158 degrees Fahrenheit)
- **EXT**—Extended operating temperature range –5 to 85 degrees Celsius (23 to 185 degrees Fahrenheit)
- **IND**—Industrial operating temperature range –40 to 85 degrees Celsius (–40 to 185 degrees Fahrenheit)
Node Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) node types that are available for the ONS 15454. The DWDM node type is determined by the type of amplifier and filter cards that are installed in an ONS 15454. The chapter also explains the DWDM automatic power control, ROADM power equalization, span loss verification, and automatic node setup functions.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

- 17.1 DWDM Node Configurations, page 17-1
- 17.2 DWDM and TDM Hybrid Node Types, page 17-14
- 17.3 Automatic Node Setup, page 17-29

17.1 DWDM Node Configurations

The ONS 15454 supports the following DWDM node configurations: hub, terminal, OADM, reconfigurable OADM, anti-ASE, line amplifier, and OSC regeneration line.

Note

The Cisco MetroPlanner tool creates a plan for amplifier placement and proper node equipment.

17.1.1 Hub Node

A hub node is a single ONS 15454 node equipped with two TCC2/TCC2P (Timing Control Card) cards and one of the following combinations:

- Two 32MUX-O (32-Channel Multiplexer) and two 32DMX-O (32-Channel Demultiplexer) or 32DMX cards
- Two 32WSS (32-Channel Wavelength Selective Switch) and two 32DMX or 32DMX-O cards

Note

The 32WSS and 32DMX are normally installed in reconfigurable OADM (ROADM) nodes, but they can be installed in hub and terminal nodes. If the cards are installed in a hub node, the 32WSS express (EXP RX and EXP TX) ports are not cabled.
A Dispersion Compensation Unit (DCU) can also be added, if necessary. The hub node does not support both DWDM and time-division multiplexing (TDM) applications since the DWDM slot requirements do not leave room for TDM cards. Figure 17-1 shows a hub node configuration with 32MUX-O and 32DMX-O cards installed.

Note

The optical add/drop multiplexing (OADM) AD-xC-xx.x or AD-xB-xx.x cards are not part of a hub node because the 32MUX-O and 32DMX-O cards drop and add all 32 channels; therefore, no other cards are necessary.

**Figure 17-1   Hub Node Configuration Example**

Figure 17-2 shows the channel flow for a hub node. Up to 32-channels from the client ports are multiplexed and equalized onto one fiber using the 32MUX-O card. Then, multiplexed channels are transmitted on the line in the eastward direction and fed to the Optical Booster (OPT-BST) amplifier. The output of this amplifier is combined with an output signal from the Optical Service Channel Modem (OSCM) card and transmitted toward the east line.

Received signals from the east line port are split between the OSCM card and an Optical Preamplifier (OPT-PRE). Dispersion compensation is applied to the signal received by the OPT-PRE amplifier, and it is then sent to the 32DMX-O card, which demultiplexes and attenuates the input signal. The west receive fiber path is identical through the west OPT-BST amplifier, the west OPT-PRE amplifier, and the west 32DMX-O card.
17.1.2 Terminal Node

A terminal node is a single ONS 15454 node equipped with two TCC2/TCC2P cards and one of the following combinations:

- One 32MUX-O card and one 32DMX-O card
- One 32WSS and either a 32DMX or a 32DMX-O cards

Terminal nodes can be either east or west. In west terminal nodes, the cards are installed in the east slots (Slots 1 through 6). In east terminal nodes, cards are installed in the west slots (Slots 12 through 17). Figure 17-3 shows an example of an east terminal configuration with a 32MUX-O and 32DMX-O cards installed. The channel flow for a terminal node is the same as the hub node (Figure 17-2).
17.1.3 OADM Node

An OADM node is a single ONS 15454 node equipped with cards installed on both sides and at least one AD-xC-xx.x card or one AD-xB-xx.x card and two TCC2/TCC2P cards. 32MUX-O or 32DMX-O cards cannot be installed in an OADM node. In an OADM node, channels can be added or dropped independently from each direction, and then passed through the reflected bands of all OADMs in the DWDM node (called express path). They can also be passed through one OADM card to another OADM card without using a TDM ITU line card (called optical passthrough) if an external patch cord is installed.

Unlike express path, an optical passthrough channel can be converted later to an add/drop channel in an altered ring without affecting another channel. OADM amplifier placement and required card placement is determined by the Cisco MetroPlanner tool or your site plan.

OADM nodes can be amplified or passive. In amplified OADMs, the OPT-PRE and the OPT-BST amplifiers are installed on the east and west sides of the node. Figure 17-4 shows an example of an amplified OADM node configuration.
Figure 17-4  Amplified OADM Node Configuration Example

Figure 17-5 shows an example of the channel flow on the amplified OADM node. Since the 32-wavelength plan is based on eight bands (each band contains four channels), optical adding and dropping can be performed at the band level and/or at the channel level (meaning individual channels can be dropped).
Figure 17-6 shows an example of a passive OADM node configuration. The passive OADM node is equipped with a band filter, one four-channel multiplexer/demultiplexer, and a channel filter on each side of the node.
Figure 17-6 Passive OADM Node Configuration Example

![Passive OADM Node Configuration Example Diagram]

Figure 17-7 shows an example of traffic flow on the passive OADM node. The signal flow of the channels is the same as the amplified OADM, except that the Optical Service Channel and Combiner/Separator Module (OSC-CSM) card is used instead of the OPT-BST amplifier and the OSCM card.

Figure 17-7 Passive OADM Node Channel Flow Example

![Passive OADM Node Channel Flow Example Diagram]
17.1.4 ROADM Node

A reconfigurable OADM (ROADM) node allows you to add and drop wavelengths without changing the physical fiber connections. ROADM nodes are equipped with two 32WSS cards. 32DMX or 32DMX-O demultiplexers are typically installed, but are not required. Transponders (TXPs) and muxponders (MXPs) can be installed in Slots 6 and 12 and, if amplification is not used, in any open slot. Figure 17-8 shows an example of an amplified ROADM node configuration.

Both 32DMX-O and 32-DMX cards can be used in ROADM nodes. Cisco MetroPlanner automatically determines at ROADM Node level which Demultiplexer to use based on the overall Network design.

---

**Note**

Both 32DMX-O and 32DMX cards can be used in an ROADM node. Cisco Metroplanner automatically chooses the demultiplexer to use for the ROADM node based on the overall network requirements.

**Figure 17-8**  
ROADM Node with BST-PRE, OPT-BST, and 32DMX Cards Installed
Figure 17-9 shows an example of an ROADM with 32DMX-O cards installed.

Figure 17-9  **ROADM Node with BST-PRE, OPT-BST, and 32DMX-O Cards Installed**

Figure 17-10 shows an example of a reconfigurable OADM east-to-west optical signal flow. The west-to-east optical signal flow follows an identical path through the west OSC-CSM and west 32WSS modules. In this example, OSC-CSM modules are installed so OPT-BST modules are not needed.
17.1.5 Anti-ASE Node

In a meshed ring network, the ONS 15454 requires a node configuration that prevents amplified spontaneous emission (ASE) accumulation and lasing. An anti-ASE node can be created by configuring a hub node or an OADM node with some modifications. No channels can travel through the express path, but they can be demultiplexed and dropped at the channel level on one side and added and multiplexed on the other side.

The hub node is the preferred node configuration when some channels are connected in passthrough mode. For rings that require a limited number of channels, combine AD-xB-xx.x and 4MD-xx.x cards, or cascade AD-xC-xx.x cards. See Figure 17-5 on page 17-6.

Figure 17-11 shows an anti-ASE node that uses all wavelengths in the passthrough mode. Use Cisco MetroPlanner to determine the best configuration for anti-ASE nodes.

---

**Figure 17-10  ROADM Optical Signal Flow Example**

1. The OSC-CSM receives the optical signal. It separates the optical service channel from the optical payload and sends the payload to the OPT-PRE module.
2. The OPT-PRE compensates for chromatic dispersion, amplifies the optical payload, and sends it to the 32WSS.
3. The 32WSS splits the signal into two components. The 80% component is sent to the DROP-TX port and the 20% component is sent to the EXP-TX port.
4. The drop component goes to the 32DMX where it is de-multiplexed and dropped.
5. The express wavelength aggregate signal goes to the 32WSS on the other side where it is de-multiplexed. Channels are stopped or forwarded based upon their switch states. Forwarded wavelengths are merged with those coming from the ADD path and sent to the OSC-CSM module.
6. The OSC-CSM combines the multiplexed payload with the OSC and sends the signal out the transmission line.
A line amplifier node is a single ONS 15454 node equipped with OPT-PRE amplifiers or OPT-BST amplifiers and TCC2/TCC2P cards. Attenuators might also be required between each preamplifier and booster amplifier to match the optical input power value and to maintain the amplifier gain tilt value. Two OSCM cards are connected to the east or west ports of the booster amplifiers to multiplex the optical service channel (OSC) signal with the pass-through channels. If the node does not contain OPT-BST amplifiers, you must use OSC-CSM cards rather than OSCM cards in your configuration. Figure 17-12 shows an example of a line node configuration.
17.1.7 OSC Regeneration Node

The OSC regeneration node is added to the DWDM networks for two purposes:

- To electrically regenerate the OSC channel whenever the span links are 37 dB or longer and payload amplification and add/drop capabilities are not present. Cisco MetroPlanner places an OSC regeneration node in spans longer than 37 dB. 31 dB is the longest span between the OSC regeneration node and the next DWDM network site.

- To add data communications network (DCN) capability wherever needed within the network. OSC regeneration nodes require two OSC-CSM cards, as shown in Figure 17-13.
Figure 17-13  OSC Regeneration Line Node Configuration Example

Figure 17-14 shows the OSC regeneration line node OSC signal flow.

Figure 17-14  OSC Regeneration Line Node Flow
17.2 DWDM and TDM Hybrid Node Types

The node type in a network configuration is determined by the type of card that is installed in an ONS 15454 hybrid node. The ONS 15454 supports the following hybrid DWDM and TDM node types: 1+1 protected flexible terminal, scalable terminal, hybrid terminal, hybrid OADM, hybrid line amplifier, and amplified TDM.

*Note* The MetroPlanner tool creates a plan for amplifier placement and proper equipment for DWDM node configurations. Although TDM cards can be used with DWDM node configuration, the MetroPlanner tool does not create a plan for TDM card placement. MetroPlanner will support TDM configurations in a future release.

17.2.1 1+1 Protected Flexible Terminal Node

The 1+1 protected flexible terminal node is a single ONS 15454 node equipped with a series of OADM cards acting as a hub node configuration. This configuration uses a single hub or OADM node connected directly to the far-end hub or OADM node through four fiber links. This node type is used in a ring configured with two point-to-point links. The advantage of the 1+1 protected flexible terminal node configuration is that it provides path redundancy for 1+1 protected TDM networks (two transmit paths and two receive paths) using half of the DWDM equipment that is usually required. In the following example (Figure 17-15), one node transmits traffic to the other node on both east and west sides of the ring for protection purposes. If the fiber is damaged on one side of the ring, traffic still arrives safely through fiber on the other side of the ring.
Figure 17-15  **Double Terminal Protection Configuration**

Figure 17-15 shows a 1+1 protected single-span link with hub nodes. This node type cannot be used in a hybrid configuration.
Figure 17-16  1+1 Protected Single-Span Link with Hub Nodes

Figure 17-17 shows a 1+1 protected single-span link with active OADM nodes. This node type can be used in a hybrid configuration.
Figure 17-17 illustrates a 1+1 protected single-span link with active OADM nodes. This node type can be used in a hybrid configuration.

Figure 17-18 shows a 1+1 protected single-span link with passive OADM nodes. This node type can be used in a hybrid configuration.
17.2.2 Scalable Terminal Node

The scalable terminal node is a single ONS 15454 node equipped with a series of OADM cards and amplifier cards. This node type is more cost effective if a maximum of 16 channels are used (Table 17-1). This node type does not support a terminal configuration exceeding 16 channels because the 32-channel terminal site is more cost effective for 17 channels and beyond.

Note The dash (—) in the following table below means not applicable.

---

### Table 17-1: Scalable Terminal Node Configuration

<table>
<thead>
<tr>
<th>OADM Node</th>
<th>Client Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCC</td>
<td>4 ch demux</td>
</tr>
<tr>
<td>TCC2</td>
<td>4 ch demux</td>
</tr>
<tr>
<td>AIC-I</td>
<td>4 ch demux</td>
</tr>
<tr>
<td>OSC</td>
<td>4 ch demux</td>
</tr>
<tr>
<td>OSC-CSM</td>
<td>4 ch demux</td>
</tr>
</tbody>
</table>

---
The OADM cards that can be used in this type of node are: AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, and AD-1B-xx.x. You can also use AD-4B-xx.x and up to four 4MD-xx.x cards. The OPT-PRE and/or OPT-BST amplifiers can be used. The OPT-PRE or OPT-BST configuration depends on the node loss and the span loss. When the OPT-BST is not installed, the OSC-CSM must be used instead of the OSCM card. Figure 17-19 on page 17-20 shows a channel flow example of a scalable terminal node configuration.

<table>
<thead>
<tr>
<th>Number of Channels</th>
<th>Terminal Configuration</th>
<th>Option 1</th>
<th>Option 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AD-1C-xx.x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>AD-2C-xx.x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AD-4C-xx.x</td>
<td>AD-1B-xx.x + 4MD-xx.x</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AD-4C-xx.x</td>
<td>AD-1B-xx.x + 4MD-xx.x</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>AD-1C-xx.x + AD-4C-xx.x</td>
<td>AD-1C-xx.x + AD-1B-xx.x + 4MD-xx.x</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>AD-2C-xx.x + AD-4C-xx.x</td>
<td>AD-2C-xx.x + AD-1B-xx.x + 4MD-xx.x</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2 x AD-4C-xx.x</td>
<td>2 x (AD-1B-xx.x + 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2 x AD-4C-xx.x</td>
<td>2 x (AD-1B-xx.x + 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>AD-1C-xx.x + (2 x AD-4C-xx.x)</td>
<td>AD-1C-xx.x + 2 x (AD-1B-xx.x + 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>AD-2C-xx.x + (2 x AD-4C-xx.x)</td>
<td>AD-2C-xx.x + 2 x (AD-1B-xx.x + 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>3 x AD-4C-xx.x</td>
<td>AD-4B-xx.x + (3 x 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>3 x AD-4C-xx.x</td>
<td>AD-4B-xx.x + (3 x 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>AD-4B-xx.x + (3 x 4MD-xx.x) + AD-1C-xx.x</td>
<td>AD-4B-xx.x + (4 x 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>AD-4B-xx.x + (3 x 4MD-xx.x) + AD-1C-xx.x</td>
<td>AD-4B-xx.x + (4 x 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>—</td>
<td>AD-4B-xx.x + (4 x 4MD-xx.x)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>—</td>
<td>AD-4B-xx.x + (4 x 4MD-xx.x)</td>
<td></td>
</tr>
</tbody>
</table>
A scalable terminal node can be created by using band and/or channel OADM filter cards. This node type is the most flexible of all node types because the OADM filter cards can be configured to accommodate node traffic. If the node does not contain amplifiers, it is considered a passive hybrid terminal node. Figure 17-20 shows an example of a scalable terminal node configuration. This node type can be used without add or drop cards.
A hybrid terminal node is a single ONS 15454 node equipped with at least one 32 MUX-O card, one 32 DMX-O card, two TCC2/TCC2P cards, and TDM cards. If the node is equipped with OPT-PRE or OPT-BST amplifiers, it is considered an amplified terminal node. The node becomes passive if the amplifiers are removed. The hybrid terminal node type is based on the DWDM terminal node type described in the “17.1.2 Terminal Node” section on page 17-3. Figure 17-21 shows an example of an amplified hybrid terminal node configuration.
### Figure 17-21 Amplified Hybrid Terminal Example

<table>
<thead>
<tr>
<th>DCU</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air ramp</td>
<td></td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>OPT-PRE or OSC-CSM</td>
</tr>
<tr>
<td>32MUX-O</td>
<td>32MUX-O</td>
</tr>
<tr>
<td>TCC2/TCC2P</td>
<td>TCC2/TCC2P</td>
</tr>
<tr>
<td>XC10G</td>
<td>XC10G</td>
</tr>
<tr>
<td>TXP-MXP or ITU-T line card</td>
<td>TXP-MXP or ITU-T line card</td>
</tr>
<tr>
<td>OSC-CSM, TXP-MXP or ITU-T line card</td>
<td>OSC-CSM, TXP-MXP or ITU-T line card</td>
</tr>
</tbody>
</table>

Figure 17-22 shows an example of a passive hybrid terminal node configuration.
17.2.4 Hybrid OADM Node

A hybrid OADM node is a single ONS 15454 node equipped with at least one AD-xC-xx.x card or one AD-xB-xx.x card, and two TCC2/TCC2P cards. The hybrid OADM node type is based on the DWDM OADM node type described in the “17.1.3 OADM Node” section on page 17-4. TDM cards can be installed in any available slot. Review the plan produced by MetroPlanner to determine slot availability. Figure 17-23 shows an example of an amplified hybrid OADM node configuration. The hybrid OADM node can also become passive by removing the amplifier cards.
17.2.5 Hybrid Line Amplifier Node

A hybrid line amplifier node is a single ONS 15454 node with open slots for both TDM and DWDM cards. Figure 17-24 shows an example of a hybrid line amplifier node configuration. Figure 17-25 on page 17-26 shows a channel flow example of a hybrid line node configuration. Since this node contains both TDM and DWDM rings, both TDM and DWDM rings should be terminated even if no interactions are present between them.

**Note**

For DWDM applications, if the OPT-BST is not installed within the node, the OSC-CSM card must be used instead of the OSCM card.
Figure 17-24  Hybrid Line Amplifier Example
17.2.6 Amplified TDM Node

An amplified TDM node is a single ONS 15454 node that increases the span length between two ONS 15454 nodes that contain TDM cards and optical amplifiers. There are three possible installation configurations for an amplified TDM node. Scenario 1 uses client cards and OPT-BST amplifiers. Scenario 2 uses client cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters. Scenario 3 uses client cards, OPT-BST amplifiers, OPT-PRE amplifiers, AD-1C-xx.x cards, and OSC-CSM cards.

The client cards that can be used in an amplified TDM node are: TXP_MR_10G, MXP_2.5G_10G, TXP_MR_2.5G, TXPP_MR_2.5G, OC-192 LR/STM 64 ITU 15xx.xx, and OC-48 ELR/STM 16 EH 100 GHz.

Figure 17-26 shows the first amplified TDM node scenario with an OPT-BST amplifier.
Figure 17-26 Amplified TDM Example with an OPT-BST Amplifier

Figure 17-27 shows the first amplified TDM node channel flow scenario configured with OPT-BST amplifiers.

Figure 17-27 Amplified TDM Channel Flow Example With OPT-BST Amplifiers

Figure 17-28 shows the second amplified TDM node configuration scenario with client cards, AD-1C-xx.x cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters.
Figure 17-28  Amplified TDM Example with FlexLayer Filters

Figure 17-29 shows the second amplified TDM node channel flow configuration scenario with client cards, OPT-BST amplifiers, OPT-PRE amplifiers, and FlexLayer filters.

Figure 17-29  Amplified TDM Channel Flow Example With FlexLayer Filters

Figure 17-30 shows the third amplified TDM channel flow configuration scenario with client cards, OPT-BST amplifiers, OPT-PRE amplifiers, AD-1C-xx.x cards, and OSC-CSM cards.
17.3 Automatic Node Setup

Automatic node setup (ANS) is a TCC2/TCC2P function that adjusts values of the VOAs on the DWDM channel paths to equalize the per-channel power at the amplifier input. This power equalization means that at launch, all the channels have the same amplifier power level, independent from the input signal on the client interface and independent from the path crossed by the signal inside the node. This equalization is needed for two reasons:

- Every path introduces a different penalty on the signal that crosses it.
- Client interfaces add their signal to the ONS 15454 DWDM ring with different power levels.

To support ANS, the integrated VOAs and photodiodes are provided in the following ONS 15454 DWDM cards:

- OADM band cards (AD-xB-xx.x) express and drop path
- OADM channel cards (AD-xC-xx.x) express and add path
- 4-Channel Terminal Multiplexer/Demultiplexer (4MD-xx.x) input port
- 32-Channel Terminal Multiplexer (32MUX-O) input port
- 32-Channel Wavelength Selective Switch (32WSS) input port
- 32-Channel Terminal Demultiplexer (32DMX-O and 32DMX) output port

Optical power is equalized by regulating the VOAs. Based on the expected per-channel power, ANS automatically calculates the VOA values by:

- Reconstructing the different channels paths
- Retrieving the path insertion loss (stored in each DWDM transmission element)

VOAs operate in one of three working modes:

- Automatic VOA Shutdown—In this mode, the VOA is set at maximum attenuation value. Automatic VOA shutdown mode is set when the channel is not provisioned to ensure system reliability in the event that power is accidentally inserted.
17.3 Automatic Node Setup

- Constant Attenuation Value—In this mode, the VOA is regulated to a constant attenuation independent from the value of the input signal. Constant attenuation value mode is set on the following VOAs:
  - OADM band card VOAs on express and drop paths (as operating mode)
  - OADM channel card VOAs during power insertion startup
  - The multiplexer/demultiplexer card VOAs during power insertion startup

- Constant Power Value—in this mode, the VOA values are automatically regulated to keep a constant output power when changes occur to the input power signal. This working condition is set on OADM channel card VOAs as “operating” and on 32MUX-O, 32WSS, 32DMX-O, and 32DMX card VOAs as “operating mode.”

In the normal operating mode, OADM band card VOAs are set to a constant attenuation, while OADM channel card VOAs are set to a constant power. ANS requires the following VOA provisioning parameters to be specified:

- Target attenuation (OADM band card VOA and OADM channel card startup)
- Target power (channel VOA)

To allow you to modify ANS values based on your DWDM deployment, provisioning parameters are divided into two contributions:

- Reference Contribution (read only)—Set by ANS.
- Calibration Contribution (read and write)—Set by user.

The ANS equalization algorithm requires the following knowledge of the DWDM transmission element layout:

- The order in which the DWDM elements are connected together on the express paths
- Channels that are dropped and added
- Channels or bands that have been configured as passthrough

ANS assumes that every DWDM port has a line direction parameter that is either west to east (W-E) or east to west (E-W). ANS automatically configures the mandatory optical connections according to following main rules:

- Cards equipped in Slots 1 to 6 have a drop section facing west.
- Cards equipped in Slots 12 to 17 have a drop section facing east.
- Contiguous cards are cascaded on the express path.
- 4MD-xx.x and AD-xB-xx.x are always optically coupled.
- A 4MD-xx.x absence forces an optical passthrough connection.
- Transmit (Tx) ports are always connected to receive (Rx) ports.

Optical patch cords are passive devices that are not autodiscovered by ANS. However, optical patch cords are used to build the alarm correlation graph. From CTC or TL1 you can:

- Calculate the default connections on the NE.
- Retrieve the list of existing connections.
- Retrieve the list of free ports.
- Create new connections or modify existing ones.
- Launch ANS.

After you launch ANS, the following status are provided for each ANS parameter:
17.3.1 Automatic Node Setup Parameters

Optical connections are identified by the two termination points, each with an assigned slot and port. ANS checks that a new connection is feasible (according to embedded connection rules) and returns a denied message in the case of a violation.

ANS requires provisioning of the expected wavelength. When provisioning the expected wavelength, the following rules apply:

- The card name is generically characterized by the card family, and not the particular wavelengths supported (for example, AD-2C for all 2-channel OADMs).
- At the provisioning layer, you can provision a generic card for a specific slot using CTC or TL1.
- Wavelength assignment is done at the port level.
- An equipment mismatch alarm is raised when a mismatch between the identified and provisioned value occurs. The default value for the provisioned attribute is AUTO.

All ONS 15454 ANS parameters are calculated by Cisco MetroPlanner for nodes configured for metro core networks. (Parameters must be configured manually for metro access nodes.) Cisco MetroPlanner exports the calculated parameters to an ASCII file called “NE Update.” In CTC, you can import the NE Update file to automatically provision the node. Table 17-2 shows ANS parameters arranged in east and west, transmit and receive groups.
### Table 17-2 ANS Parameters

<table>
<thead>
<tr>
<th>Direction</th>
<th>ANS Parameters</th>
</tr>
</thead>
</table>
| West Side - Receive | • West Side Rx Max Expected Span Loss  
                      | • West Side Rx Min Expected Span Loss  
                      | • West Side Rx Amplifier Working Mode  
                      | • West Side Rx Amplifier Ch Power  
                      | • West Side Rx Amplifier Gain  
                      | • West Side Rx Amplifier Tilt  
                      | • West Side OSC LOS Threshold  
                      | • West Side Channel LOS Threshold  
                      | • West Side Rx Amplifier Input Power Fail Th  
                      | • West Side Add and Drop Stage Input Power  
                      | • West Side Add and Drop Stage Drop Power  
                      | • West Side Add and Drop Stage Band (i) Drop Power (i = 1 through 8)  
                      | • West Side Add and Drop Stage Channel (i) Drop Power (i = 1 through 32) |
| East Side - Receive | • East Side Rx Max Expected Span Loss  
                      | • East Side Rx Min Expected Span Loss  
                      | • East Side Rx Amplifier Working Mode  
                      | • East Side Rx Amplifier Ch Power  
                      | • East Side Rx Amplifier Gain  
                      | • East Side Rx Amplifier Tilt  
                      | • East Side OSC LOS Threshold  
                      | • East Side Channel LOS Threshold  
                      | • East Side Rx Amplifier Input Power Fail Th  
                      | • East Side Add and Drop Stage Input Power  
                      | • East Side Add and Drop Stage Drop Power  
                      | • East Side Add and Drop Stage Band (i) Drop Power (i = 1 through 8)  
                      | • East Side Add and Drop Stage Channel (i) Drop Power (i = 1 through 32) |
17.3.2 View and Provision ANS Parameters

All ANS parameters can be viewed and provisioned from the node view Provisioning > WDM-ANS > Provisioning subtab, shown in Figure 17-31. The WDM-ANS > Provisioning > Provisioning subtab presents the parameters in the following tree view:

root
+/- East
  • +/- Receiving
    – +/- Amplifier
    – +/- Power
    – +/- Threshold
  • +/- Transmitting
    – +/- Amplifier
    – +/- Power
    – +/- Threshold
+/- West
  • +/- Receiving
    – +/- Amplifier
    – +/- Power
    – +/- Threshold
  • +/- Transmitting

Table 17-2 ANS Parameters (continued)

<table>
<thead>
<tr>
<th>Direction</th>
<th>ANS Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>West Side - Transmit</td>
<td>• West Side Tx Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>• West Side Tx Amplifier Ch Power</td>
</tr>
<tr>
<td></td>
<td>• West Side Tx Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>• West Side Tx Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>• West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td></td>
<td>• West Side Add and Drop Stage Output Power</td>
</tr>
<tr>
<td></td>
<td>• West Side Add and Drop Stage By-Pass Power</td>
</tr>
<tr>
<td>East Side - Transmit</td>
<td>• East Side Tx Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>• East Side Tx Amplifier Ch Power</td>
</tr>
<tr>
<td></td>
<td>• East Side Tx Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>• East Side Tx Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>• East Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td></td>
<td>• East Side Add and Drop Stage Output Power</td>
</tr>
<tr>
<td></td>
<td>• East Side Add and Drop Stage By-Pass Power</td>
</tr>
</tbody>
</table>
17.3.2 View and Provision ANS Parameters

- +/- Amplifier
- +/- Power
- +/- Threshold

Figure 17-31  WDM-ANS Provisioning

Table 17-3 shows the parameter IDs based on platform, line-direction, and functional group.

Table 17-3  ANS-WDM > Provisioning Subtab Parameters

<table>
<thead>
<tr>
<th>Tree Element</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>root</td>
<td>Network Type (dwdm)</td>
</tr>
<tr>
<td>root +/- East +/- Receiving</td>
<td>East Side Rx Max Expected Span Loss</td>
</tr>
<tr>
<td></td>
<td>East Side Rx Min Expected Span Loss</td>
</tr>
<tr>
<td>root +/- East +/- Receiving +/- Amplifier</td>
<td>East Side Rx Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>East Side Rx Amplifier Ch Power</td>
</tr>
<tr>
<td></td>
<td>East Side Rx Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>East Side Rx Amplifier Tilt</td>
</tr>
</tbody>
</table>
**Table 17-3**  
**ANS-WDM > Provisioning Subtab Parameters (continued)**

<table>
<thead>
<tr>
<th>Tree Element</th>
<th>Parameters</th>
</tr>
</thead>
</table>
| root +/- East +/- Receiving +/- Power | East Side Add and Drop Input Power  
East Side Add and Drop Drop Power  
East Side Band n Drop Power (n = 1-8)  
East Side Channel n Drop Power East (n = 1-32)  |
| root +/- East +/- Receiving +/- Thresholds | East Side OSC LOS Threshold  
East Side Channel LOS Threshold  
East Side Rx Amplifier In Power Fail Th  |
| root +/- East +/- Transmitting +/- Amplifier | East Side Tx Amplifier Working Mode  
East Side Tx Amplifier Ch Power  
East Side Tx Amplifier Gain  
East Side Tx Amplifier Tilt  |
| root +/- East +/- Transmitting +/- Power | East Side Add and Drop Output Power  
East Side Add and Drop By-Pass Power  |
| root +/- East +/- Transmitting +/- Thresholds | East Side Fiber Stage Input Threshold  |
| root +/- West +/- Receiving | West Side Rx Max Expected Span Loss  
West Side Rx Min Expected Span Loss  |
| root +/- West +/- Receiving +/- Amplifier | West Side Rx Amplifier Working Mode  
West Side Rx Amplifier Ch Power  
West Side Rx Amplifier Gain  
West Side Rx Amplifier Tilt  |
| root +/- West +/- Receiving +/- Power | West Side Add and Drop Input Power  
West Side Add and Drop Drop Power  
West Side Band n Drop Power (n = 1-8)  
West Side Channel n Drop Power (n = 1-32)  |
| root +/- West +/- Receiving +/- Thresholds | West Side OSC LOS Threshold  
West Side Channel LOS Threshold  
West Side Rx Amplifier In Power Fail Th  |
| root +/- West +/- Transmitting +/- Amplifier | West Side Tx Amplifier Working Mode  
West Side Tx Amplifier Ch Power  
West Side Tx Amplifier Gain  
West Side Tx Amplifier Tilt  |
| root +/- West +/- Transmitting +/- Power | West Side Add and Drop Output Power  
West Side Add and Drop By-Pass Power  |
| root +/- West +/- Transmitting +/- Thresholds | West Side Fiber Stage Input Threshold  |
The ANS parameters that appear in the WDM-ANS > Provisioning subtab depend on the node type. Table 17-4 shows the DWDM node types and their ANS parameters.

**Table 17-4  ANS Parameters By Node Type**

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Parameter Group</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hub</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td></td>
<td>Span Loss</td>
<td>East and West Expected Span Loss</td>
</tr>
<tr>
<td>Amplifier Tx</td>
<td></td>
<td>East and West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transit Amplifier Tilt</td>
</tr>
<tr>
<td>Amplifier Rx</td>
<td></td>
<td>East and West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td>Thresholds Tx</td>
<td></td>
<td>East and West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td>Thresholds Rx</td>
<td></td>
<td>East and West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Input Power Fail</td>
</tr>
<tr>
<td>Power</td>
<td></td>
<td>East and West Side Add and Drop Input Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Add and Drop Output Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Add and Drop By-Pass Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel (n) Drop Power</td>
</tr>
</tbody>
</table>
### Table 17-4  ANS Parameters By Node Type (continued)

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Parameter Group</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td></td>
<td>Span Loss</td>
<td>East or West Expected Span Loss</td>
</tr>
<tr>
<td>Amplifier Tx</td>
<td>E-W Transmit</td>
<td>East or West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East or West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East or West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East or West Side Transmit Amplifier Tilt</td>
</tr>
<tr>
<td>Amplifier Rx</td>
<td>E-W Receive</td>
<td>East or West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East or West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East or West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East or West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td>Thresholds Tx</td>
<td>E-W Fiber Stage</td>
<td>East or West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td>Thresholds Rx</td>
<td>E-W Osc Loss</td>
<td>East or West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td>E-W Channel</td>
<td>East or West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td>E-W Rx</td>
<td>East or West Side Receive Amplifier Input Power Fail</td>
</tr>
<tr>
<td>Power</td>
<td>E-W Add</td>
<td>East or West Side Add and Drop Input Power</td>
</tr>
<tr>
<td></td>
<td>E-W Drop</td>
<td>East or West Side Add and Drop Output Power</td>
</tr>
<tr>
<td></td>
<td>E-W Band</td>
<td>East or West Side Band (n) Drop Power (n = 1-32)</td>
</tr>
<tr>
<td>Flexible Channel</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td>Count Terminal</td>
<td>Span Loss</td>
<td>East and West Expected Span Loss</td>
</tr>
<tr>
<td>Amplifier Tx</td>
<td>E-W Transmit</td>
<td>East and West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East and West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East and West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>E-W Transmit</td>
<td>East and West Side Transmit Amplifier Tilt</td>
</tr>
<tr>
<td>Amplifier Rx</td>
<td>E-W Receive</td>
<td>East and West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East and West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East and West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td>E-W Receive</td>
<td>East and West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td>Thresholds Tx</td>
<td>E-W Fiber Stage</td>
<td>East and West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td>Thresholds Rx</td>
<td>E-W Osc Loss</td>
<td>East and West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td>E-W Channel</td>
<td>East or West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td>E-W Rx</td>
<td>East or West Side Receive Amplifier Input Power Fail</td>
</tr>
<tr>
<td>Power</td>
<td>E-W Add</td>
<td>East and West Side Add and Drop Input Power</td>
</tr>
<tr>
<td></td>
<td>E-W Drop</td>
<td>East and West Side Add and Drop Output Power</td>
</tr>
<tr>
<td></td>
<td>E-W Band</td>
<td>East and West Side Band (n) Drop Power (n = 1-8)</td>
</tr>
</tbody>
</table>
Table 17-4 ANS Parameters By Node Type (continued)

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Parameter Group</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>OADM</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td></td>
<td>Span Loss</td>
<td>East and West Expected Span Loss</td>
</tr>
<tr>
<td></td>
<td>Amplifier Tx</td>
<td>East and West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Amplifier Rx</td>
<td>East and West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Thresholds Tx</td>
<td>East and West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td></td>
<td>Thresholds Rx</td>
<td>East and West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Input Power Fail</td>
</tr>
<tr>
<td></td>
<td>Power</td>
<td>East and West Side Add and Drop Input Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Add and Drop Output Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Band (n) Drop Power (n = 1-8)</td>
</tr>
<tr>
<td>Line Amplifier</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td></td>
<td>Span Loss</td>
<td>East and West Expected Span Loss</td>
</tr>
<tr>
<td></td>
<td>Amplifier Tx</td>
<td>East and West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Amplifier Rx</td>
<td>East and West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Thresholds Tx</td>
<td>East and West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td></td>
<td>Thresholds Rx</td>
<td>East and West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Input Power Fail</td>
</tr>
</tbody>
</table>
Table 17-4  ANS Parameters By Node Type (continued)

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Parameter Group</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROADM</td>
<td>Network</td>
<td>Network Type</td>
</tr>
<tr>
<td></td>
<td>Span Loss</td>
<td>East and West Expected Span Loss</td>
</tr>
<tr>
<td></td>
<td>Amplifier Tx</td>
<td>East and West Side Transmit Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Transmit Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Amplifier Rx</td>
<td>East and West Side Receive Amplifier Working Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Channel Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Tilt</td>
</tr>
<tr>
<td></td>
<td>Thresholds Tx</td>
<td>East and West Side Fiber Stage Input Threshold</td>
</tr>
<tr>
<td></td>
<td>Thresholds Rx</td>
<td>East and West Side Osc Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel Los Threshold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Receive Amplifier Input Power Fail</td>
</tr>
<tr>
<td></td>
<td>Power</td>
<td>East and West Side Add and Drop Input Power (if 32DMX East/West is installed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Add and Drop Output Power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Add and Drop Drop Power (if 32DMX East/West is installed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>East and West Side Channel (n) Drop Power (if 32DMX-O East/West is installed)</td>
</tr>
</tbody>
</table>

Table 17-5 shows the following information for all ONS 15454 ANS parameters:

- **Min**—Minimum value in decibels.
- **Max**—Maximum value in decibels.
- **Def**—Default value in decibels. Other defaults include MC (metro core), CG (control gain), U (unknown).
- **Group**—Group(s) to which the parameter belongs: ES (east side), WS (west side), Rx (receive), Tx (transmit), Amp (amplifier), P (power), DB (drop band), DC (drop channel), A (attenuation), Th (threshold).
- **Network Type**—Parameter network type: MC (metro core), MA (metro access), ND (not DWDM)
- **Optical Type**—Parameter optical type: TS (32 channel terminal), FC (flexible channel count terminal), O (OADM), H (hub), LS (line amplifier), R (ROADM), U (unknown)

Table 17-5  ANS Parameters Summary

<table>
<thead>
<tr>
<th>General Name</th>
<th>Min</th>
<th>Max</th>
<th>Def</th>
<th>Group</th>
<th>Network Type</th>
<th>Optical Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Type</td>
<td>–</td>
<td>–</td>
<td>MC</td>
<td>Root</td>
<td>MC, MA, ND</td>
<td>U, TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Max Expected Span Loss</td>
<td>0</td>
<td>60</td>
<td>60</td>
<td>WS, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>General Name</td>
<td>Min</td>
<td>Max</td>
<td>Def</td>
<td>Group</td>
<td>Network Type</td>
<td>Optical Type</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>East Side Rx Max Expected Span Loss</td>
<td>0</td>
<td>60</td>
<td>60</td>
<td>ES, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Min Expected Span Loss</td>
<td>0</td>
<td>60</td>
<td>60</td>
<td>WS, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Rx Min Expected Span Loss</td>
<td>0</td>
<td>60</td>
<td>60</td>
<td>ES, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Tx Amplifier Working Mode</td>
<td>–</td>
<td>–</td>
<td>CG</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Tx Amplifier Working Mode</td>
<td>–</td>
<td>–</td>
<td>CG</td>
<td>ES, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Working Mode</td>
<td>–</td>
<td>–</td>
<td>CG</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Working Mode</td>
<td>–</td>
<td>–</td>
<td>CG</td>
<td>ES, Rx</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Tx Amplifier Ch Power</td>
<td>–10</td>
<td>17</td>
<td>2</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Tx Amplifier Ch Power</td>
<td>–10</td>
<td>17</td>
<td>2</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Ch Power</td>
<td>–10</td>
<td>17</td>
<td>2</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Ch Power</td>
<td>–10</td>
<td>17</td>
<td>2</td>
<td>WS, Tx, Amp</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Tx Amplifier Gain</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Tx Amplifier Gain</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Gain</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Rx Amplifier Gain</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Tx Amplifier Tilt</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Tx Amplifier Tilt</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Tx, Amp</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Rx Amplifier Tilt</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Rx, Amp</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Rx Amplifier Tilt</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>WS, Rx, Amp</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side OSC LOS Threshold</td>
<td>–50</td>
<td>30</td>
<td>U</td>
<td>WS, Rx, Th</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side OSC LOS Threshold</td>
<td>–50</td>
<td>30</td>
<td>U</td>
<td>WS, Rx, Th</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Channel LOS Threshold</td>
<td>–50</td>
<td>30</td>
<td>U</td>
<td>WS, Rx, Th</td>
<td>MC, MA</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>East Side Channel LOS Threshold</td>
<td>–50</td>
<td>30</td>
<td>U</td>
<td>ES, Rx, Th</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Fiber State Input Threshold</td>
<td>–50</td>
<td>30</td>
<td>U</td>
<td>WS, Tx, Th</td>
<td>MC, MA, ND</td>
<td>TS, FC, O, H, LS, R</td>
</tr>
<tr>
<td>West Side Add and Drop Output Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>WS, Tx, P</td>
<td>MC</td>
<td>TS, FC, O, H, R</td>
</tr>
<tr>
<td>East Side Add and Drop Output Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>ES, Tx, P</td>
<td>MC</td>
<td>TS, FC, O, H, R</td>
</tr>
<tr>
<td>West Side Add and Drop Input Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>WS, Rx, P</td>
<td>MC</td>
<td>TS, FC, O, H, R</td>
</tr>
<tr>
<td>East Side Add and Drop Input Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>ES, Rx, P</td>
<td>MC</td>
<td>TS, FC, O, H, R</td>
</tr>
<tr>
<td>West Side Add and Drop By-Pass Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>WS, Tx, P</td>
<td>MC</td>
<td>H</td>
</tr>
<tr>
<td>East Side Add and Drop By-Pass Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>ES, Tx, P</td>
<td>MC</td>
<td>H</td>
</tr>
<tr>
<td>West Side Add and Drop Drop Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>WS, Tx, P</td>
<td>MC</td>
<td>R</td>
</tr>
<tr>
<td>East Side Add and Drop Drop Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>ES, Tx, P</td>
<td>MC</td>
<td>R</td>
</tr>
<tr>
<td>West Side Band 1...8 Drop Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>WS, Rx, P, DB</td>
<td>MC</td>
<td>FC, O</td>
</tr>
<tr>
<td>East Side Band 1...8 Drop Power</td>
<td>–50</td>
<td>30</td>
<td>–14</td>
<td>ES, Rx, P, DB</td>
<td>MC</td>
<td>FC, O</td>
</tr>
</tbody>
</table>
Table 17-5  ANS Parameters Summary (continued)

<table>
<thead>
<tr>
<th>General Name</th>
<th>Min</th>
<th>Max</th>
<th>Def</th>
<th>Group</th>
<th>Network Type</th>
<th>Optical Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>West Side Channel 1...32 Drop Power</td>
<td>−50</td>
<td>30</td>
<td>−14</td>
<td>WS, Rx, P, DC, B1</td>
<td>MC, MA</td>
<td>TS, H, R</td>
</tr>
<tr>
<td>East Side Channel 1...32 Drop Power</td>
<td>−50</td>
<td>30</td>
<td>−14</td>
<td>ES, Rx, P, DC, B1</td>
<td>MC, MA</td>
<td>TS, H, R</td>
</tr>
</tbody>
</table>
Network Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) network applications and topologies. The chapter also provides network-level optical performance references.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

- 18.1 Network Applications, page 18-1
- 18.2 Network Topologies, page 18-2
- 18.3 Optical Performance, page 18-6
- 18.4 Automatic Power Control, page 18-18
- 18.5 ROADM Power Equalization Monitoring, page 18-22
- 18.6 Span Loss Verification, page 18-23
- 18.8 Network-Level Gain—Tilt Management of Optical Amplifiers, page 18-28

18.1 Network Applications

Cisco ONS 15454s can be provisioned for metro access and metro core DWDM network applications. Metro access networks are 60 km or less in size. Channels are not equalized and dispersion compensation is not applied. Metro access networks have few spans and very low span loss, so the signal link budget is the limiting factor for performance. Metro core networks can be up to 400 km in size. The channel power is equalized and dispersion compensation is applied. Metro core networks often include multiple spans and amplifiers, so the optical signal-to-noise ratio (OSNR) is the limiting factor for channel performance in metro core networks.

Within DWDM networks, the ONS 15454 uses a communications protocol, called node services protocol (NSP), to communicate with other nodes. NSP automatically updates nodes whenever a change in the network occurs. Each ONS 15454 DWDM node can:

- Identify other ONS 15454 DWDM nodes in the network.
- Identify the different types of DWDM networks.
- Identify when the DWDM network is complete and when it is incomplete.
18.2 Network Topologies

The ONS 15454 DWDM network topologies include hubbed, multihubbed, and meshed rings, and linear and single-span networks.

18.2.1 Hubbed Rings

In the hubbed ring topology (Figure 18-1), a hub node terminates all the DWDM channels. A channel can be provisioned to support protected traffic between the hub node and any node in the ring. Both working and protected traffic use the same wavelength on both sides of the ring. Protected traffic can also be provisioned between any pair of optical add/drop multiplexing (OADM) nodes, except that either the working or the protected path must be regenerated in the hub node.

Protected traffic saturates a channel in a hubbed ring, that is, no channel reuse is possible. However, the same channel can be reused in different sections of the ring by provisioning unprotected multihop traffic. From a transmission point of view, this network topology is similar to two bidirectional point-to-point links with OADM nodes.

For more information about hub nodes, see the “17.1.1 Hub Node” section on page 17-1.

18.2.2 Multihubbed Rings

A multihubbed ring (Figure 18-2) is based on the hubbed ring topology, except that two or more hub nodes are added. Protected traffic can only be established between the two hub nodes. Protected traffic can be provisioned between a hub node and any OADM node only if the allocated wavelength channel
is regenerated through the other hub node. Multihop traffic can be provisioned on this ring. From a transmission point of view, this network topology is similar to two or more point-to-point links with OADM nodes.

**Figure 18-2  Multihubbed Ring**

### 18.2.3 Any-to-Any Rings

The any-to-any ring topology (Figure 18-3) contains only reconfigurable OADM (ROADM) nodes, or ROADM nodes with Optical Service Channel (OSC) regeneration or amplifier nodes. This topology potentially allows you to route every wavelength from any source to any destination node inside the network.

See the “17.1.4 ROADM Node” section on page 17-8 for more information.
18.2.4 Meshed Rings

The meshed ring topology (Figure 18-4) does not use hubbed nodes; only amplified and passive OADM nodes are present. Protected traffic can be provisioned between any two nodes; however, the selected channel cannot be reused in the ring. Unprotected multihop traffic can be provisioned in the ring. A meshed ring must be designed to prevent amplified spontaneous emission (ASE) lasing. This is done by configuring a particular node as an anti-ASE node. An anti-ASE node can be created in two ways:

- Equip an OADM node with 32MUX-O cards and 32DMX-O cards. This solution is adopted when the total number of wavelengths deployed in the ring is higher than ten. OADM nodes equipped with 32MUX-O cards and 32DMX-O cards are called full OADM nodes.

- When the total number of wavelengths deployed in the ring is lower than ten, the anti-ASE node is configured by using an OADM node where all the channels that are not terminated in the node are configured as “optical pass-through.” In other words, no channels in the anti-ASE node can travel through the express path of the OADM node.

For more information about OADM nodes, see the “17.1.3 OADM Node” section on page 17-4. For more information about anti-ASE nodes, see the “17.1.5 Anti-ASE Node” section on page 17-10.
18.2.5 Linear Configurations

Linear configurations are characterized by the use of two terminal nodes (west and east). The terminal nodes can be equipped with a 32MUX-O card and a 32DMX-O card, or a 32WSS card with a 32DMX or 32DMX-O card. OADM or line amplifier nodes can be installed between the two terminal nodes. Only unprotected traffic can be provisioned in a linear configuration. Figure 18-5 shows five ONS 15454 nodes in a linear configuration with an amplified and a passive OADM node.

Figure 18-5 shows five ONS 15454 nodes in a linear configuration without an OADM node. See the “17.1.2 Terminal Node” section on page 17-3 for more information.
18.2.6 Single-Span Link

Single-span link is a type of linear configuration characterized by a single-span link with pre-amplification and post-amplification. A single-span link is also characterized by the use of two terminal nodes (west and east). The terminal nodes are usually equipped with a 32MUX-O card and a 32DMX-O card. However, a 32WSS card and a 32DMX or a 32DMX-O card can be installed. Software R4.7 and later also supports single-span links with AD-4C-xx.x cards. Only unprotected traffic can be provisioned on a single-span link.

Figure 18-7 shows ONS 15454s in a single-span link. Eight channels are carried on one span. Single-span link losses apply to OC-192 LR ITU cards. The optical performance values are valid assuming that the sum of the OADM passive node insertion losses and the span losses does not exceed 35 dB.

18.3 Optical Performance

This section provides optical performance information for ONS 15454 DWDM networks. The performance data is a general guideline based upon the network topology, node type, client cards, fiber type, number of spans, and number of channels. The maximum number of nodes that can be in an ONS 15454 DWDM network is 16. The DWDM topologies and node types that are supported are shown in Table 18-1.
### Table 18-1  Supported Topologies and Node Types

<table>
<thead>
<tr>
<th>Number of Channels</th>
<th>Fiber</th>
<th>Topologies</th>
<th>Node Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 channels</td>
<td>SMF-28(^1) E-LEAF(^2) TW-RS(^3)</td>
<td>Ring</td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linear</td>
<td>Active OADM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linear without OADM</td>
<td>Passive OADM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OSC regeneration</td>
</tr>
<tr>
<td>16 channels</td>
<td>SMF-28</td>
<td>Ring</td>
<td>Hub</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linear</td>
<td>Active OADM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linear without OADM</td>
<td>Passive OADM</td>
</tr>
<tr>
<td>8 channels</td>
<td>SMF-28</td>
<td>Linear without OADM</td>
<td>Terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Line</td>
</tr>
</tbody>
</table>

1. SMF-28 = single-mode fiber 28
2. E-LEAF = enhanced large effective area fiber
3. TW-RS = TrueWave reduced slope fiber

DWDM client cards are grouped into nine classes, shown in Table 18-2. Span loss estimates are based on the number of spans in the network and the client card class. Some cards belong to more than one class depending on whether forward error correction (FEC) is enabled and on the payload data type provisioned for the card.

### Table 18-2  ONS 15454 Client Card Classes

<table>
<thead>
<tr>
<th>Class</th>
<th>Rate</th>
<th>Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10 Gbps</td>
<td>TXP_2.5G_10G—FEC enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP_2.5G_10E—FEC enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP_MR_10G—FEC enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP_MR_10E—FEC enabled</td>
</tr>
<tr>
<td>B</td>
<td>10 Gbps</td>
<td>TXP_2.5G_10G—FEC not enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP_MR_10G—FEC not enabled</td>
</tr>
<tr>
<td>C</td>
<td>10 Gbps</td>
<td>OC-192 LR ITU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP_2.5G_10E—FEC not enabled</td>
</tr>
<tr>
<td>D</td>
<td>2.5 Gbps</td>
<td>TXP_MR_2.5G—FEC enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXPP_MR_2.5G—FEC enabled</td>
</tr>
</tbody>
</table>
18.3.1 Optical Performance for Rings and Linear Networks with OADM Nodes

The following tables provide optical performance estimates for open and closed ONS 15454 rings and linear networks with OADM nodes.

**Table 18-3** shows the optical performance for 32-channel networks using SMF fiber. Span losses shown in the table assume:

- OADM nodes have a loss of 16 dB and equal span losses.
- The DCU loss is 9 dB.
- Optical Preamp (OPT-PRE) and Optical Booster (OPT-BST/OPT-BST-E) amplifiers are installed in all nodes.
- The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 18-2 for a list of cards in each class. A dash (—) indicates spans that are not supported.

### Table 18-3  Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
</tr>
<tr>
<td>2</td>
<td>29 dB</td>
<td>21 dB</td>
</tr>
<tr>
<td>3</td>
<td>26 dB</td>
<td>17 dB</td>
</tr>
<tr>
<td>4</td>
<td>24 dB</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>20 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER > 10^-6
Table 18-4 shows the optical performance for 16-channel networks using SMF fiber. Span loss values assume the following:

- OADM nodes have a loss of 16 dB and equal span losses.
- The DCU loss is 9 dB.
- All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.
- The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-4: Span Loss for 16-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>37 dB</td>
<td>37 dB</td>
</tr>
<tr>
<td>2</td>
<td>32 dB</td>
<td>34 dB</td>
</tr>
<tr>
<td>3</td>
<td>29 dB</td>
<td>31 dB</td>
</tr>
<tr>
<td>4</td>
<td>27 dB</td>
<td>29 dB</td>
</tr>
<tr>
<td>5</td>
<td>26 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>25 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>24 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

Table 18-5 shows the optical performance for 32-channel networks using TW-RS fiber. Span loss values assume the following:

- OADM nodes have a loss of 16 dB and equal span losses.
- The DCU is 550 ps with 4 dB loss.
- All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.
- The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-5: Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using TW-RS Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
</tr>
<tr>
<td>2</td>
<td>29 dB</td>
<td>21 dB</td>
</tr>
<tr>
<td>3</td>
<td>27 dB</td>
<td>17 dB</td>
</tr>
<tr>
<td>4</td>
<td>25 dB</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>20 dB</td>
<td>—</td>
</tr>
</tbody>
</table>
18.3.2 Optical Performance for Linear Networks Without OADM Nodes

Table 18-6 shows the optical performance for 32-channel networks using E-LEAF fiber. Span loss values assume the following:

- OADM nodes have a loss of 16 dB and equal span losses.
- The DCU is 550 ps with 4 dB loss.
- All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.
- The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 18-6  Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using E-LEAF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th></th>
<th></th>
<th>2.5 Gbps</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
<td>Class C</td>
<td>Class I</td>
<td>Class D</td>
<td>Class E</td>
<td>Class F</td>
<td>Class G</td>
<td>Class H</td>
<td>Class J</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
<td>25 dB</td>
<td>37 dB</td>
<td>37 dB</td>
<td>33 dB</td>
<td>30 dB</td>
<td>32 dB</td>
<td>34 dB</td>
<td>30 dB</td>
</tr>
<tr>
<td>2</td>
<td>29 dB</td>
<td>21 dB</td>
<td>20 dB</td>
<td>31 dB</td>
<td>32 dB</td>
<td>28 dB</td>
<td>26 dB</td>
<td>27 dB</td>
<td>29 dB</td>
<td>26 dB</td>
</tr>
<tr>
<td>3</td>
<td>27 dB</td>
<td>17 dB</td>
<td>15 dB</td>
<td>29 dB</td>
<td>30 dB</td>
<td>26 dB</td>
<td>23 dB</td>
<td>25 dB</td>
<td>27 dB</td>
<td>23 dB</td>
</tr>
<tr>
<td>4</td>
<td>24 dB</td>
<td>—</td>
<td>—</td>
<td>26 dB</td>
<td>28 dB</td>
<td>23 dB</td>
<td>20 dB</td>
<td>22 dB</td>
<td>24 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td>5</td>
<td>22 dB</td>
<td>—</td>
<td>—</td>
<td>24 dB</td>
<td>27 dB</td>
<td>22 dB</td>
<td>16 dB</td>
<td>20 dB</td>
<td>23 dB</td>
<td>16 dB</td>
</tr>
<tr>
<td>6</td>
<td>20 dB</td>
<td>—</td>
<td>—</td>
<td>22 dB</td>
<td>25 dB</td>
<td>19 dB</td>
<td>—</td>
<td>17 dB</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>17 dB</td>
<td>—</td>
<td>—</td>
<td>20 dB</td>
<td>24 dB</td>
<td>16 dB</td>
<td>—</td>
<td>—</td>
<td>19 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

18.3.2 Optical Performance for Linear Networks Without OADM Nodes

The following tables list the reference optical performances for linear networks without OADM nodes. Table 18-7 shows the optical performance for 32-channel linear networks using SMF fiber. Span loss values assume the following:

- No OADM nodes are installed and span losses are equal.
- The DCU loss is 9 dB.
- Only OPT-PRE amplifiers are installed.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

Table 18-7  Span Loss for 32-Channel Linear Networks without OADM Nodes Using SMF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th></th>
<th></th>
<th>2.5 Gbps</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
<td>Class C</td>
<td>Class I</td>
<td>Class D</td>
<td>Class E</td>
<td>Class F</td>
<td>Class G</td>
<td>Class H</td>
<td>Class J</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
<td>25 dB</td>
<td>37 dB</td>
<td>37 dB</td>
<td>33 dB</td>
<td>30 dB</td>
<td>32 dB</td>
<td>34 dB</td>
<td>30 dB</td>
</tr>
<tr>
<td>2</td>
<td>27 dB</td>
<td>20 dB</td>
<td>19 dB</td>
<td>29 dB</td>
<td>30 dB</td>
<td>26 dB</td>
<td>23 dB</td>
<td>25 dB</td>
<td>26 dB</td>
<td>23 dB</td>
</tr>
<tr>
<td>3</td>
<td>24 dB</td>
<td>17 dB</td>
<td>17 dB</td>
<td>25 dB</td>
<td>26 dB</td>
<td>23 dB</td>
<td>20 dB</td>
<td>22 dB</td>
<td>23 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td>4</td>
<td>22 dB</td>
<td>15 dB</td>
<td>14 dB</td>
<td>23 dB</td>
<td>24 dB</td>
<td>21 dB</td>
<td>19 dB</td>
<td>20 dB</td>
<td>22 dB</td>
<td>19 dB</td>
</tr>
<tr>
<td>5</td>
<td>21 dB</td>
<td>—</td>
<td>—</td>
<td>22 dB</td>
<td>22 dB</td>
<td>20 dB</td>
<td>18 dB</td>
<td>19 dB</td>
<td>20 dB</td>
<td>18 dB</td>
</tr>
<tr>
<td>6</td>
<td>20 dB</td>
<td>—</td>
<td>—</td>
<td>21 dB</td>
<td>21 dB</td>
<td>19 dB</td>
<td>17 dB</td>
<td>18 dB</td>
<td>19 dB</td>
<td>17 dB</td>
</tr>
<tr>
<td>7</td>
<td>19 dB</td>
<td>—</td>
<td>—</td>
<td>20 dB</td>
<td>20 dB</td>
<td>18 dB</td>
<td>16 dB</td>
<td>18 dB</td>
<td>19 dB</td>
<td>16 dB</td>
</tr>
</tbody>
</table>
Table 18-8 shows the optical performance for 32-channel linear networks using TW-RS fiber. Span loss values assume the following:

- No OADM nodes are installed and span losses are equal.
- The DCU is 550 ps with 4 dB loss.
- Only OPT-PRE amplifiers are installed.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-8 Span Loss for 32-Channel Linear Networks without OADM Nodes Using TW-RS Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
</tr>
<tr>
<td>2</td>
<td>28 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td>3</td>
<td>26 dB</td>
<td>18 dB</td>
</tr>
<tr>
<td>4</td>
<td>24 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>5</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>22 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>21 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

Table 18-9 shows the optical performance for 32-channel linear networks using E-LEAF fiber. Span loss values assume the following:

- No OADM nodes are installed and span losses are equal.
- The DCU is 550 ps with 4 dB loss.
- Only OPT-PRE amplifiers are installed.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-9 Span Loss for 32-Channel Linear Networks without OADM Nodes Using E-LEAF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
</tr>
<tr>
<td>2</td>
<td>28 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td>3</td>
<td>25 dB</td>
<td>18 dB</td>
</tr>
<tr>
<td>4</td>
<td>24 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>5</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>20 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

Table 18-10 shows the optical performance for 16-channel linear networks using SMF fiber. Span loss values assume the following:

- No OADM nodes are installed and span losses are equal.
- The DCU loss is 9 dB.
18.3.3 Optical Performance for ROADM Rings and Linear Networks

- Only OPT-PRE amplifiers are installed.
- The minimum channel power is 4 dBm.
- Wavelengths are picked up without any restriction from Bands 4 and 5 (1542.14 to 1545.51 nm).

See Table 18-2 for a list of cards in each class.

**Table 18-10 Span Loss for 16-Channel Linear Networks without OADM Nodes Using SMF Fiber**

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>37 dB</td>
<td>29 dB</td>
</tr>
<tr>
<td>2</td>
<td>32 dB</td>
<td>23 dB</td>
</tr>
<tr>
<td>3</td>
<td>28 dB</td>
<td>21 dB</td>
</tr>
<tr>
<td>4</td>
<td>26 dB</td>
<td>19 dB</td>
</tr>
<tr>
<td>5</td>
<td>24 dB</td>
<td>18 dB</td>
</tr>
<tr>
<td>6</td>
<td>23 dB</td>
<td>17 dB</td>
</tr>
<tr>
<td>7</td>
<td>22 dB</td>
<td>16 dB</td>
</tr>
</tbody>
</table>

**Table 18-11 Span Loss for Eight-Channel Linear Networks without OADM Nodes Using SMF Fiber**

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>37 dB</td>
<td>31 dB</td>
</tr>
<tr>
<td>2</td>
<td>34 dB</td>
<td>26 dB</td>
</tr>
<tr>
<td>3</td>
<td>31 dB</td>
<td>23 dB</td>
</tr>
<tr>
<td>4</td>
<td>29 dB</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>27 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Table 18-11 shows the optical performance for 8-channel linear networks with 8 dBm per channel using SMF fiber. Span loss values assume the following:

- No OADM nodes are installed and span losses are equal.
- The DCU loss is 9 dB.
- Only OPT-PRE amplifiers are installed.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

**Table 18-12 Span Loss for 32-Channel Linear or Ring Networks using SMF Fiber**

The following tables list the reference optical performances for ROADM rings and linear networks. Table 18-12 shows the optical performance for 32-channel linear or ring networks using SMF fiber with only ROADM nodes installed. Span loss values assume the following:

- All nodes in the ring or linear network are ROADM with equal span losses.
- The DCU loss is 9 dB.
- OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-12 Span Loss for 32-Channel Linear or Ring Networks with all ROADM Nodes Using SMF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>35 dB</td>
<td>25 dB</td>
</tr>
<tr>
<td>2</td>
<td>30 dB</td>
<td>21 dB</td>
</tr>
<tr>
<td>3</td>
<td>28 dB</td>
<td>18 dB</td>
</tr>
<tr>
<td>4</td>
<td>26 dB</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>25 dB</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>24 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>22 dB</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>10</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>11</td>
<td>18 dB</td>
<td>—</td>
</tr>
<tr>
<td>12</td>
<td>17 dB</td>
<td>—</td>
</tr>
<tr>
<td>13</td>
<td>15 dB</td>
<td>—</td>
</tr>
<tr>
<td>14</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>15</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

1. If the number of boosters is greater than 10 and power per channel is equal to +1 dBm.

Table 18-13 shows the optical performance for 32-channel linear or ring network with ROADM and OADM nodes using SMF fiber. Span loss values assume the following:

- All nodes in the ring or linear network are ROADM or OADM.
- OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.
- Span losses are equal.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-13 Span Loss for 32-Channel Ring and Linear Networks with ROADM and OADM Nodes Using SMF Fiber

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>30 dB</td>
<td>23 dB</td>
</tr>
<tr>
<td>2</td>
<td>26 dB</td>
<td>19 dB</td>
</tr>
<tr>
<td>3</td>
<td>23 dB</td>
<td>—</td>
</tr>
<tr>
<td>4</td>
<td>21 dB</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>20 dB</td>
<td>—</td>
</tr>
</tbody>
</table>
Section 18.3.3 Optical Performance for ROADM Rings and Linear Networks

The following tables show the pass/fail criteria for eight and sixteen ROADM nodes. Table 18-14 shows the pass/fail criteria for eight ROADM nodes (seven spans) required for any-to-any node circuit reconfigurations:

- All nodes in the ring are ROADM.
- Span losses are equal.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

**Table 18-13 Span Loss for 32-Channel Ring and Linear Networks with ROADM and OADM Nodes Using SMF Fiber**

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>6</td>
<td>17 dB</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>15 dB</td>
<td>—</td>
</tr>
</tbody>
</table>

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER>10^-6

**Table 18-14 Pass/Fail Criteria for 32-Channel, Eight-Node ROADM Rings Using SMF Fiber**

<table>
<thead>
<tr>
<th>Span Loss (dB)</th>
<th>Amplifiers Installed</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Class A</td>
<td>Class B</td>
<td>Class C</td>
</tr>
<tr>
<td>1</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>2</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>3</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>4</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>5</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>6</td>
<td>OPT-PRE only</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>7</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>8</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>9</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>10</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>11</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>12</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
</tbody>
</table>
### Table 18-14: Pass/Fail Criteria for 32-Channel, Eight-Node ROADM Rings Using SMF Fiber (continued)

<table>
<thead>
<tr>
<th>Span Loss (dB)</th>
<th>Amplifiers Installed</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>13</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>14</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
<tr>
<td>15</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>Yes</td>
<td>&lt;7</td>
</tr>
</tbody>
</table>

Table 18-15 shows the pass/fail criteria for 16 ROADM nodes (15 spans) required for any-to-any node circuit reconfigurations:

- All nodes in the ring are ROADM.
- Span losses are equal.

See Table 18-2 for a list of cards in each class. A dash (—) indicates the spans that are not supported.

### Table 18-15: Pass/Fail Criteria for 32-Channel, 16-Node ROADM Rings Using SMF Fiber

<table>
<thead>
<tr>
<th>Span Loss (dB)</th>
<th>Amplifiers Installed</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>1</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>2</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>3</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>4</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>5</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>6</td>
<td>OPT-PRE only</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>7</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>8</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>9</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>10</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
<tr>
<td>11</td>
<td>OPT-PRE and OPT-BST/ OPT-BST-E</td>
<td>&lt;15^1</td>
<td>&lt;15^1</td>
</tr>
</tbody>
</table>
Table 18-16 lists the span loss for a single-span link configuration with eight channels. The optical performance for this special configuration is given only for Classes A and C. This configuration assumes a maximum channel capacity of eight channels (8-dBm nominal channel power) used without any restrictions on the 32 available channels.

Table 18-17 lists the span loss for a single-span link configuration with 16 channels. The optical performance for this special configuration is given only for Classes A and C. This configuration assumes a maximum channel capacity of 16 channels (5-dBm nominal channel power) used without any restrictions on the 32 available channels.

1. Cisco MetroPlanner calculates the maximum ring circumference and number of nodes that can be supported.

18.3.4 Optical Performance for Single-Span Networks

Table 18-16 lists the span loss for a single-span link configuration with eight channels. The optical performance for this special configuration is given only for Classes A and C. This configuration assumes a maximum channel capacity of eight channels (8-dBm nominal channel power) used without any restrictions on the 32 available channels.

Table 18-17 lists the span loss for a single-span link configuration with 16 channels. The optical performance for this special configuration is given only for Class A and Class C. This configuration assumes a maximum channel capacity of 16 channels (5-dBm nominal channel power) used without any restrictions on the 32 available channels.

Table 18-18 lists the span loss for a single-span link configuration with 16 channels. The optical performance for this special configuration is given only for Class A and Class C. This configuration assumes a maximum channel capacity of 16 channels (5-dBm nominal channel power) used without any restrictions on the 32 available channels.
Table 18-18 lists the span loss for a single-span link configuration with AD-1C-xx.x cards, OPT-PRE amplifiers, and OPT-BST/OPT-BST-E amplifiers. The single-span link with a flexible channel count is used both for transmitting and receiving. If dispersion compensation is required, a DCU can be used with an OPT-PRE amplifier. The optical performance for this special configuration is given for Classes A through G (8-dBm nominal channel power) used without any restrictions on the 32 available channels.

Table 18-18  Span Loss for Single-Span Link with AD-1C-xx.x Cards, OPT-PRE Amplifiers, and OPT-BST/OPT-BST-E Amplifiers

<table>
<thead>
<tr>
<th>Node Configuration</th>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>2.5 Gbps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Class A</td>
<td>Class B</td>
</tr>
<tr>
<td>With OSCM cards&lt;sup&gt;1&lt;/sup&gt;</td>
<td>1</td>
<td>37 dB</td>
<td>31 dB</td>
</tr>
<tr>
<td>Hybrid with OSC-CSM cards&lt;sup&gt;2&lt;/sup&gt;</td>
<td>1</td>
<td>35 dB</td>
<td>31 dB</td>
</tr>
</tbody>
</table>

1. OSCM sensitivity limits the performance to 37 dB.
2. OSC-CSM sensitivity limits the performance to 35 dB when it replaces the OSCM.

Table 18-19 lists the span loss for a single-span link configuration with one channel and OPT-BST/OPT-BST-E amplifiers. The optical performance for this special configuration is given for Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. Classes D, E, F, and G use 12-dBm nominal channel power. There are no restriction on the 32 available channels. That is, a line card, transponder, or muxponder wavelength can be extracted from the 32 available wavelengths. Also, the optical service channel is not required.

Table 18-19  Span Loss for Single-Span Link with One Channel and OPT-BST Amplifiers

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>Class A</th>
<th>Class B</th>
<th>Class C</th>
<th>2.5 Gbps</th>
<th>Class E</th>
<th>Class F</th>
<th>Class G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20 to 30 dB</td>
<td>17 to 26 dB</td>
<td>17 to 28 dB</td>
<td>Unprotected from 29 to 41 dB</td>
<td>Unprotected from 28 to 37 dB</td>
<td>Unprotected from 21 to 34 dB</td>
<td>From 23 to 36 dB</td>
<td></td>
</tr>
</tbody>
</table>

Table 18-20 lists the span loss for a single-span link configuration with one channel, OPT-BST/OPT-BST-E amplifiers, OPT-PRE amplifiers, and ONS 15216 FlexLayer filters. ONS 15216 FlexLayer filters are used instead of the AD-1C-xx.x cards to reduce equipment costs and increase the span length, since the optical service channel is not necessary. The optical performance for this special configuration is given for Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. Classes D, E, F, and G use 12-dBm nominal channel power. There are no restriction on the first 16 available wavelengths (from 1530.33 to 1544.53 nm).

Table 18-20  Span Loss for Single-Span Link with One Channel, OPT-BST/OPT-BST-E Amplifiers, OPT-PRE Amplifiers, and ONS 15216 FlexLayer Filters

<table>
<thead>
<tr>
<th>Number of Spans</th>
<th>10 Gbps</th>
<th>Class A</th>
<th>Class B</th>
<th>Class C</th>
<th>2.5 Gbps</th>
<th>Class E</th>
<th>Class F</th>
<th>Class G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1x</td>
<td>38 dB</td>
<td>30 dB</td>
<td>30 dB</td>
<td>44 dB</td>
<td>40 dB</td>
<td>38 dB</td>
<td>40 dB</td>
<td></td>
</tr>
</tbody>
</table>
18.4 Automatic Power Control

The ONS 15454 automatic power control (APC) feature performs the following functions:

- Maintains constant per-channel power when changes to the number of channels occur.
- Compensates for optical network degradation (aging effects).
- Simplifies the installation and upgrade of DWDM optical networks by automatically calculating the amplifier setpoints.

Note

APC functions are performed by software algorithms on the OPT-BST, OPT-PRE, and TCC2/TCC2P cards.

Amplifier software uses a control gain loop with fast transient suppression to keep the channel power constant regardless of any changes in the number of channels. Amplifiers monitor the changes to the input power and change the output power according to the calculated gain setpoint. The shelf controller software emulates the control output power loop to adjust for fiber degradation. To perform this function, the TCC2/TCC2P needs to know the channel distribution, which is provided by a signaling protocol, and the expected per-channel power, which you can provision. The TCC2/TCC2P compares the actual amplifier output power with the expected amplifier output power and modifies the setpoints if any discrepancies occur.

18.4.1 APC at the Amplifier Card Level

In constant gain mode, the amplifier power out control loop performs the following input and output power calculations, where G represents the gain and t represents time.

\[ P_{out}(t) = G \times P_{in}(t) \text{ (mW)} \]

\[ P_{out}(t) = G + P_{in}(t) \text{ (dB)} \]

In a power-equalized optical system, the total input power is proportional to the number of channels. The amplifier software compensates for any variation of the input power due to changes in the number of channels carried by the incoming signal.

Amplifier software identifies changes in the read input power in two different instances, \( t_1 \) and \( t_2 \) as a change in the carried traffic. The letters \( m \) and \( n \) in the following formula represent two different channel numbers. \( P_{in/ch} \) represents the per-channel input power:

\[ P_{in}(t_1) = nP_{in/ch} \]

\[ P_{in}(t_2) = mP_{in/ch} \]

Amplifier software applies the variation in the input power to the output power with a reaction time that is a fraction of a millisecond. This keeps the power constant on each channel at the output amplifier, even during a channel upgrade or a fiber cut.

Amplifier parameters are configured using east and west conventions for ease of use. Selecting west provisions parameters for the preamplifier receiving from the west and the booster amplifier transmitting to the west. Selecting east provisions parameters for the preamplifiers receiving from the east and the booster amplifier transmitting to the east.

Starting from the expected per-channel power, the amplifiers automatically calculate the gain setpoint after the first channel is provisioned. An amplifier gain setpoint is calculated in order to make it equal to the loss of the span preceding the amplifier itself. After the gain is calculated, the setpoint is no longer...
changed by the amplifier. Amplifier gain is recalculated every time the number of provisioned channels returns to zero. If you need to force a recalculation of the gain, move the number of channels back to zero.

18.4.2 APC at the Node and Network Levels

The amplifier adjusts the gain to compensate for span loss. Span loss changes due to aging fiber and components, or changes in operating conditions. To correct the gain or express variable optical attenuator (VOA) setpoints, APC calculates the difference between the power value read by the photodiodes and the expected power value. The expected power values is calculated using:

- Provisioned per-channel power value
- Channel distribution (the number of express, add, and drop channels in the node)
- ASE estimation

Channel distribution is determined by the sum of the provisioned and failed channels. Information about provisioned wavelengths is sent to APC on the applicable nodes during circuit creation. Information about failed channels is collected through a signaling protocol that monitors alarms on ports in the applicable nodes and distributes that information to all the other nodes in the network.

ASE calculations purify the noise from the power level reported from the photodiode. Each amplifier can compensate for its own noise, but cascaded amplifiers cannot compensate for ASE generated by preceding nodes. The ASE effect increases when the number of channels decreases; therefore, a correction factor must be calculated in each amplifier of the ring to compensate for ASE build-up.

APC is a network-level feature. The APC algorithm designates a master node that is responsible for starting APC hourly or every time a new circuit is provisioned or removed. Every time the master node signals for APC to start, gain and VOA setpoints are evaluated on all nodes in the network. If corrections are needed in different nodes, they are always performed sequentially following the optical paths starting from the master node.

APC corrects the power level only if the variation exceeds the hysteresis thresholds of +/- 0.5 dB. Any power level fluctuation within the threshold range is skipped since it is considered negligible. Because APC is designed to follow slow time events, it skips corrections greater than 3 dB. This is the typical total aging margin that is provisioned during the network design phase. After you provision the first channel or the amplifiers are turned up for the first time, APC does not apply the 3 dB rule. In this case, APC corrects all the power differences to turn up the node.

Note

Software R6.0 does not report corrections that are not performed and exceed the 3 dB correction factor to Cisco Transport Controller (CTC), Cisco Transport Manager (CTM), and Transaction Language One (TL1) management interfaces.

To avoid large power fluctuations, APC adjusts power levels incrementally. The maximum power correction is +/- 0.5 dB. This is applied to each iteration until the optimal power level is reached. For example, a gain deviation of 2 dB is corrected in four steps. Each of the four steps requires a complete APC check on every node in the network. APC can correct up to a maximum of 3 dB on an hourly basis. If degradation occurs over a longer time period, APC will compensate for it by using all margins that you provision during installation.

When no margin is available, adjustments cannot be made because setpoints exceed ranges. APC communicates the event to CTC, CTM, and TL1 through an APC Fail condition. APC will clear the APC fail condition when the setpoints return to the allowed ranges.

APC automatically disables itself when:
18.4.3 Managing APC

- A HW FAIL alarm is raised by any card in any of the network nodes.
- A Mismatch Equipment Alarm (MEA) is raised by any card in any of the network nodes.
- An Improper Removal alarm is raised by any card in any of the network nodes.
- Gain Degrade, Power Degrade, and Power Fail Alarms are raised by the output port of any amplifier card in any of the network nodes.
- A VOA degrade or fail alarm is raised by any of the cards in any of the network nodes.

The APC state (Enable/Disable) is located on every node and can be retrieved by the CTC or TL1 interfaces. If an event that disables APC occurs in one of the network nodes, APC is disabled on all the others and the APC state changes to DISABLE - INTERNAL. The disabled state is raised only by the node where the problem occurred to simplify troubleshooting.

APC raises the following standing conditions at the port level in CTC, TL1, and SNMP:
- APC Out of Range—APC cannot assign a new setpoint for a parameter this is allocated to a port because the new setpoint exceeds the parameter range.
- APC Correction Skipped—APC skipped a correction to one parameter allocated to a port because the difference between the expected and current values exceeds the +/- 3 dB security range.

After the error condition is cleared, signaling protocol enables APC on the network and the APC DISABLE - INTERNAL condition is cleared. Because APC is required after channel provisioning to compensate for ASE effects, all optical channel network connection (OCHNC) circuits that you provision during the disabled APC state are kept in the Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS [ANSI]) or Unlock-disabled,automaticInService (ETSI) service state until APC is enabled. OCHNCs automatically go into the In-Service and Normal (IS-NR [ANSI]) or Unlocked-enabled (ETSI) service state only after APC is enabled.

**Caution**

When APC is disabled, aging compensation is not applied and circuits cannot be activated. Do not disable APC unless it is required for specific maintenance or troubleshooting tasks. Always enable APC as soon as the tasks are completed.
The APC subtab provides the following information:

- **Slot ID**—The ONS 15454 slot number for which APC information is shown.
- **Port**—The port number for which APC information is shown.
- **Card**—The card for which power control information is shown.
- **Last Modification**—Date and time APC last modified a setpoint for the parameters shown in Table 18-21.
- **Last Check**—Date and time APC last verified the setpoints for the parameters shown in Table 18-21.

### Table 18-21  APC-Managed Parameters

<table>
<thead>
<tr>
<th>Card</th>
<th>Port</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPT-BST</td>
<td>LINE-3-TX</td>
<td>• Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Total Signal Output Power</td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>LINE-1-TX</td>
<td>• Gain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Total Signal Output Power</td>
</tr>
<tr>
<td>AD-xB-xx.x</td>
<td>LINE-1-TX</td>
<td>VOA Target Attenuation</td>
</tr>
<tr>
<td></td>
<td>BAND-i-TX</td>
<td></td>
</tr>
</tbody>
</table>
18.5 ROADM Power Equalization Monitoring

Reconfigurable OADM (ROADM) nodes allow you to monitor the 32WSS card equalization functions on the Maintenance > DWDM > Power Monitoring subtab (Figure 18-9). The tab shows the input channel power (Padd), the express or pass-through (Ppt) power and the power level at output (Pout).

Figure 18-9  Power Monitoring Subtab

### Table 18-21  APC-Managed Parameters (continued)

<table>
<thead>
<tr>
<th>Card</th>
<th>Port</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-1C-xx.x</td>
<td>LINE-1-TX</td>
<td>VOA Target Attenuation</td>
</tr>
<tr>
<td>AD-2C-xx.x</td>
<td>LINE-1-TX</td>
<td>VOA Target Attenuation</td>
</tr>
<tr>
<td>AD-4C-xx.x</td>
<td>LINE-1-TX</td>
<td>VOA Target Attenuation</td>
</tr>
<tr>
<td>32-DMX</td>
<td>LINE-1-TX</td>
<td>VOA Target Attenuation</td>
</tr>
</tbody>
</table>
18.6 Span Loss Verification

Span loss measurements can be performed from the Maintenance > DWDM > WDM Span Check subtab (Figure 18-10). The CTC span check compares the far-end OSC power with the near-end OSC power. A “Span Loss Out of Range” condition is raised when the measured span loss is higher than the maximum expected span loss. It is also raised when the measured span loss is lower than the minimum expected span loss and the difference between the minimum and maximum span loss values is greater than 1 dB. The minimum and maximum expected span loss values are calculated by Cisco MetroPlanner for the network and imported into CTC. However, you can manually change the minimum and expected span loss values.

CTC span loss measurements provide a quick span loss check and are useful whenever changes to the network occur, for example after you install equipment or repair a broken fiber. CTC span loss measurement resolutions are:

- +/- 1.5 dB for measured span losses between 0 and 25 dB
- +/- 2.5 dB for measured span losses between 25 and 38 dB

For ONS 15454 span loss measurements with higher resolutions, an optical time domain reflectometer (OTDR) must be used.

Figure 18-10  Span Loss Verification
18.7 Network Optical Safety—Automatic Laser Shutdown

Automatic laser shutdown (ALS) is a technique used to automatically shut down the output power of OSC laser transmitters (contained in the OSCM and OSC-CSM cards) and optical amplifiers (contained in OPT-BST cards) in the event of a fiber break. Cards with OSC laser transmitters and optical amplifiers (OPT-BST only) can be provisioned as follows with respect to ALS:

- **Disable**: ALS is off; the laser and optical amplifiers (OPT-BST only) is not automatically shut down when a traffic outage loss of signal (LOS) occurs.
- **Auto Restart**: ALS is on. The laser and optical amplifiers (OPT-BST only) automatically shuts down when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the outage are resolved.

**Note**

Auto Restart is the default ALS provisioning.

- **Manual Restart**: ALS is on. The laser and optical amplifiers (OPT-BST only) automatically shuts down when traffic outages (LOS) occur. However, the laser must be manually restarted when conditions that caused the outage are resolved.
- **Manual Restart for Test**: Manually restarts the laser and optical amplifiers (OPT-BST only) for testing.

In the following paragraphs, two ALS scenarios are given:

- Nodes using OPT-BST cards (amplified nodes)
- Nodes using OSC-CSM cards (passive nodes)

### 18.7.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST/OPT-BST-E Cards

Figure 18-11 shows nodes using OPT-BST/OPT-BST-E cards with a fiber cut between them.
Two photodiodes at Node B monitor the received signal strength for the optical payload and optical service channel (OSC) signals. When the fiber is cut, a loss of signal (LOS) is detected at both of the photodiodes. The AND function then indicates an overall LOS condition, which causes the OPT-BST/OPT-BST-E transmitter, OPT-PRE transmitter, and OSCM lasers to shut down. This in turn leads to a LOS for both the optical payload and OSC at Node A, which causes Node A to turn off the OSCM, OPT-PRE transmitter, and OPT-BST/OPT-BST-E transmitter lasers. The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 18-11):

1. Fiber is cut.
2. Node B power monitoring photodiode detects a Loss of Incoming Overhead (LOS-O) on the OPT-BST/OPT-BST-E card and the OSCM card detects a LOS (OC3) at the SONET layer. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
3. Node B power monitoring photodiode detects a Loss of Incoming Payload (LOS-P) on the OPT-BST/OPT-BST-E card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
4. On the OPT-BST/OPT-BST-E card, the simultaneous LOS-O and LOS-P detection triggers a command to shut down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
5. The OPT-BST/OPT-BST-E card amplifier is shut down within three seconds.
6. The OSCM laser is shut down.
7. The OPT-PRE card automatically shuts down due to a loss of incoming optical power.
8. Node A power monitoring photodiode detects a LOS-O on the OPT-BST/OPT-BST-E card and the OSCM card detects a LOS (OC3) at the SONET layer. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

9. Node A power monitoring photodiode detects a LOS-P on the OPT-BST/OPT-BST-E card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

10. On the OPT-BST, the simultaneous LOS-O and LOS-P detection triggers a command to shut down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

11. The OPT-BST/OPT-BST-E card amplifier is shut down within three seconds.

12. The OSCM laser is shut down.

---

**Note**  
The shutdown of the OPT-BST/OPT-BST-E and OSCM cards, which launch power into the cut fiber, achieves the aim of the Network Optical Safety feature.

13. The node A OPT-PRE card automatically shuts down due to a loss of incoming optical power. When the fiber is repaired, either an automatic or manual restart at the Node A OPT-BST/OPT-BST-E transmitter or at the Node B OPT-BST/OPT-BST-E transmitter is required. A system that has been shut down is reactivated through the use of a restart pulse. The pulse is used to signal that the optical path has been restored and transmission can begin. For example, when the far end, Node B, receives a pulse, it signals to the Node B OPT-BST/OPT-BST-E transmitter to begin transmitting an optical signal. The OPT-BST/OPT-BST-E receiver at Node A receives that signal and signals the Node A OPT-BST/OPT-BST-E transmitter to resume transmitting.

---

**Note**  
During a laser restart pulse, automatic power reduction (APR) is disabled and the laser power does not exceed Class 1 limits.

### 18.7.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards

Figure 18-12 shows nodes using OSC-CSM cards with a fiber cut between them.
Two photodiodes at the Node B OSC-CSM card monitor the received signal strength for the received optical payload and OSC signals. When the fiber is cut, LOS is detected at both of the photodiodes. The AND function then indicates an overall LOS condition, which causes the Node B OSC laser to shut down and the optical switch to block traffic. This in turn leads to LOS for both the optical payload and OSC signals at Node A, which causes Node A to turn off the OSC laser and the optical switch to block outgoing traffic. The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 18-12):

1. Fiber is cut.
2. Node B power monitoring photodiode detects a LOS-O on the OSC-CSM card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
3. Node B power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
4. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
5. The optical switch blocks outgoing traffic.
6. The OSC laser is shut down.
7. Node A power monitoring photodiode detects a LOS-O on the OSC-CSM card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.
8. Node A power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

9. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are demoted. Refer to the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454 SDH Troubleshooting Guide.

10. The OSC laser is shut down.

11. The optical switch blocks outgoing traffic.

When the fiber is repaired, either an automatic or manual restart at the Node A OSC-CSM OSC or at the Node B OSC-CSM OSC is required. A system that has been shut down is reactivated through the use of a restart pulse. The pulse is used to signal that the optical path has been restored and transmission can begin. For example, when the far-end Node B receives a pulse, it signals to the Node B OSC to begin transmitting its optical signal and for the optical switch to pass incoming traffic. The OSC-CSM at Node A then receives the signal and tells the Node A OSC to resume transmitting and for the optical switch to pass incoming traffic.

18.8 Network-Level Gain—Tilt Management of Optical Amplifiers

The ability to control and adjust per channel optical power equalization is a principal feature of ONS 15454 DWDM Metro-Core network applications. A critical parameter to assure optical spectrum equalization throughout the DWDM system is the gain flatness of EDFA amplifiers.

Two items, gain tilt and gain ripple, are factors in the power equalization of optical amplifier cards such as the OPT-BST/OPT-BST-E or OPT-PRE. Figure 18-13 is a graph of the amplifier output power spectrum and how it is affected by gain tilt and gain ripple.
18.8.1 Gain Tilt Control at the Card Level

Gain ripple and gain tilt are defined as follows:

- Gain Ripple is random and depends on the spectral shape of the amplifier optical components.
- Gain Tilt is systematic and depends on the gain setpoint (Gstp) of the optical amplifier, which is a mathematical function F(Gstp) that relates to the internal amplifier design.

Gain tilt is the only contribution to the power spectrum disequalization that can be compensated at the card level. A Variable Optical Attenuator (VOA) internal to the amplifier can be used to compensate for gain tilt.

An Optical Spectrum Analyzer (OSA) device is used to acquire the output power spectrum of an amplifier. The OSA shows the peak-to-peak difference between the maximum and minimum power levels, and takes into account the contributions of both gain tilt and gain ripple.

**Note**

Peak-to-peak power acquisition using an OSA cannot be used to “measure” the Gain Tilt, because gain ripple itself is a component of the actual measurement.

The OPT-BST/OPT-BST-E and OPT-PRE amplifier cards have a “flat” output (gain tilt = 0 dB) for only a specific gain value (Gdesign), based on the internal optical design (see Figure 18-14).
If the “working” gain setpoint of the amplifier is different from Gdesign, the output spectrum begins to suffer a gain tilt variation.

In order to compensate for the absolute value of the increase of the spectrum tilt, the OPT-BST/OPT-BST-E and OPT-PRE cards automatically adjust the attenuation of the VOA to maintain a flat power profile at the output, as shown in Figure 18-15.

The VOA attenuator automatic regulation guarantees (within limits) a “zero tilt” condition in the EDFA amplifier for a wide range of possible gain setpoint values.
Table 18-22 shows the “flat output” gain range limits for the OPT-BST/OPT-BST-E and OPT-PRE cards, as well as the maximum (worst case) values of gain tilt and gain ripple expected in the specific gain range.

<table>
<thead>
<tr>
<th>Amplifier Card Type</th>
<th>Flat Output Gain Range</th>
<th>Gain Tilt (Maximum)</th>
<th>Gain Ripple (Maximum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPT-BST/ OPT-BST-E</td>
<td>G &lt; 20 dB</td>
<td>0.5 dB</td>
<td>1.5 dB</td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>G &lt; 21 dB</td>
<td>0.5 dB</td>
<td>1.5 dB</td>
</tr>
</tbody>
</table>

If the “operating” gain value is outside of the range shown in Table 18-22, the EDFA amplifier introduces a tilt contribution for which the card itself cannot directly compensate. This condition is managed in different ways, depending the amplifier card type:

- OPT-BST/OPT-BST-E. The OPT-BST/OPT-BST-E amplifier is, by card design, not allowed to work outside the “zero tilt” range. The MetroPlanner tool validates network designs using the OPT-BST/OPT-BST-E amplifier card only when the gain is less than or equal to 20 dB.
- OPT-PRE. The MetroPlanner tool allows network designs even if the operating gain value is equal to or greater than 21 dB. In this case, a system-level tilt compensation strategy is adopted by the DWDM system. A more detailed explanation is given in the following section.

18.8.2 System Level Gain Tilt Control

System level gain tilt control for OPT-PRE cards is achievable with two main scenarios:
- Without a reconfigurable optical add-drop multiplexer (ROADM) node
- With a ROADM node

18.8.2.1 System Gain Tilt Compensation Without ROADM Nodes

When an OPT-PRE card along a specific line direction (West to East or East to West) is working outside the “flat output” gain range (G > 21 dB), the unregulated tilt is compensated for in spans not facing ROADM nodes by configuring an equal but opposite tilt on one or more of the amplifiers in the downstream direction. The number of downstream amplifiers involved depends on the amount of tilt compensation needed and the gain setpoint of the amplifiers that are involved. See Figure 18-16.
The proper Tilt Reference value is calculated by MetroPlanner and inserted in the Installation Parameter List imported during the Node Turn-Up procedure (see “NTP-G138 Import a Cisco MetroPlanner Configuration File” task on page 3-82). For both OPT-PRE and OPT-BST/OPT-BST-E cards, the provisionable Gain Tilt Reference range is between –3 dB and +3 dB.

During the Automatic Node Setup (ANS) procedure, the Tilt value for the OPT-BST/OPT-BST-E or OPT-PRE card is provisioned by the TCC card (see Figure 18-17). The provisioned Tilt Reference Value is reported in the CTC OPT-PRE or OPT-BST/OPT-BST-E card view (Provisioning > Opt.Ampli.Line > Parameters > Tilt Reference).
18.8.2 System Level Gain Tilt Control

When an ROADM Node is present in the network, as shown in Figure 18-18, a per-channel dynamic gain equalization can be performed. Both gain tilt and gain ripple are completely compensated using the following techniques:

- Implementing the per-channel VOAs present inside the 32-WSS, and
- Operating in Power Control Mode with the specific power setpoint designed by MetroPlanner.
Figure 18-18 System Tilt Compensation With a ROADM

SPAN 1 = 25 dB

G_{OPT-PRE} > 21 dB
Unregulated Tilt

Per-channel Power Equalization

Tilt Reference = 0
CTC Operation Reference

This chapter describes Cisco Transport Controller (CTC), the software interface for the Cisco ONS 15454. For CTC setup and login information, see Chapter 2, “Connect the PC and Log into the GUI.”

Chapter topics include:

- 19.1 CTC Software Delivery Methods, page 19-1
- 19.2 CTC Installation Overview, page 19-3
- 19.3 PC and UNIX Workstation Requirements, page 19-4
- 19.4 ONS 15454 Connections, page 19-6
- 19.5 CTC Window, page 19-7
- 19.6 TCC2/TCC2P Card Reset, page 19-14
- 19.7 TCC2/TCC2P Card Database, page 19-15
- 19.8 Software Revert, page 19-15

19.1 CTC Software Delivery Methods

ONS 15454 provisioning and administration is performed using the CTC software. CTC is a Java application that is installed in two locations: it is stored on the TCC2 or TCC2P card and it is downloaded to your workstation the first time you log into the ONS 15454 with a new software release.

19.1.1 CTC Software Installed on the TCC2/TCC2P Card

CTC software is preloaded on the ONS 15454 TCC2/TCC2P cards; therefore, you do not need to install software on the TCC2/TCC2P cards. When a new CTC software version is released, use the release-specific software upgrade document to upgrade the ONS 15454 software on the TCC2/TCC2P card.
When you upgrade CTC software, the TCC2/TCC2P cards store the new CTC version as the protect CTC version. When you activate the new CTC software, the TCC2/TCC2P cards store the older CTC version as the protect CTC version, and the newer CTC release becomes the working version. You can view the software versions that are installed on an ONS 15454 by selecting the Maintenance > Software tabs in node view (Figure 19-1).

**Figure 19-1  CTC Software Versions, Node View**

Select the Maintenance > Software tabs in network view to display the software versions installed on all the network nodes (Figure 19-2).
19.1.2 CTC Software Installed on the PC or UNIX Workstation

CTC software is downloaded from the TCC2/TCC2P cards and installed on your computer automatically after you connect to the ONS 15454 with a new software release for the first time. Downloading the CTC software files automatically ensures that your computer is running the same CTC software version as the TCC2/TCC2P cards you are accessing. The CTC files are stored in the temporary directory designated by your computer operating system. You can use the Delete CTC Cache button to remove files stored in the temporary directory. If the files are deleted, they download the next time you connect to an ONS 15454. Downloading the Java archive (JAR) files for CTC takes several minutes depending on the bandwidth of the connection between your workstation and the ONS 15454. For example, JAR files downloaded from a modem or a data communications channel (DCC) network link require more time than JAR files downloaded over a LAN connection.

19.2 CTC Installation Overview

To connect to an ONS 15454 using CTC, you enter the ONS 15454 IP address in the URL field of Netscape Navigator or Microsoft Internet Explorer. After connecting to an ONS 15454, the following occurs automatically:

1. A CTC launcher applet is downloaded from the TCC2/TCC2P card to your computer.
2. The launcher determines whether your computer has a CTC release matching the release on the ONS 15454 TCC2/TCC2P card.
3. If the computer does not have CTC installed, or if the installed release is older than the TCC2/TCC2P card’s version, the launcher downloads the CTC program files from the TCC2/TCC2P card.

4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web browser is no longer needed. Always log into nodes having the latest software release. If you log into an ONS 15454 that is connected to ONS 15454s with older versions of CTC, or to Cisco ONS 15327s or Cisco ONS 15600s, CTC files are downloaded automatically to enable you to interact with those nodes. The CTC file download occurs only when necessary, such as during your first login. You cannot interact with nodes on the network that have a software version later than the node that you used to launch CTC.

Each ONS 15454 can handle up to five concurrent CTC sessions. CTC performance can vary, depending upon the volume of activity in each session, network bandwidth, and TCC2/TCC2P card load.

Note: You can also use TL1 commands to communicate with the Cisco ONS 15454 through VT100 terminals and VT100 emulation software, or you can telnet to an ONS 15454 using TL1 port 3083. Refer to the Cisco ONS SONET TL1 Command Guide or Cisco ONS 15454 SDH TL1 Command Guide for a comprehensive list of TL1 commands.

### 19.3 PC and UNIX Workstation Requirements

To use CTC for the ONS 15454, your computer must have a web browser with the correct Java Runtime Environment (JRE) installed. The correct JRE for each CTC software release is included on the Cisco ONS 15454 software CD and the ONS 15454 documentation CD. If you are running multiple CTC software releases on a network, the JRE installed on the computer must be compatible with the different software releases.

When you change the JRE version on the JRE tab, you must exit and restart CTC for the new JRE version to take effect. Table 19-1 shows JRE compatibility with ONS 15454 software releases.

<table>
<thead>
<tr>
<th>ONS Software Release</th>
<th>JRE 1.2.2 Compatible</th>
<th>JRE 1.3 Compatible</th>
<th>JRE 1.4 Compatible</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONS 15454 Release 4.5</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>ONS 15454 Release 4.6</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ONS 15454 Release 4.7</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>ONS 15454 Release 5.0</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>ONS 15454 Release 6.0</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 19-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java plug-in is also included on the ONS 15454 software CD.
### Table 19-2  Computer Requirements for CTC

<table>
<thead>
<tr>
<th>Area</th>
<th>Requirements</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium III 700 MHz, UltraSPARC, or equivalent</td>
<td>700 MHz is the recommended processor speed. You can use computers with a lower processor speed; however, you might experience longer response times and slower performance.</td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM recommended, 512 MB RAM optimum</td>
<td>—</td>
</tr>
<tr>
<td>Hard drive</td>
<td>20 GB hard drive with 50 MB of space available</td>
<td>—</td>
</tr>
</tbody>
</table>
| Operating System         | • PC: Windows 98 (1st and 2nd editions), Windows ME, Windows NT 4.0 (with Service Pack 6a), Windows 2000 (with Service Pack 3), or Windows XP Home  
                           | • Workstation: Solaris versions 8 or 9                                       | —                                                                                                                                        |
| Java Runtime Environment | JRE 1.4.2                                                                    | JRE 1.4.2 is installed by the CTC Installation Wizard included on the Cisco ONS 15454 software and documentation CDs. JRE 1.4.2 provides enhancements to CTC performance, especially for large networks with numerous circuits.  
                           |                                                                              | If CTC must be launched directly from nodes running software earlier than R4.6, uninstall JRE 1.4.2 and reinstall JRE 1.3.1_02, then, to run R6.0, uninstall JRE 1.3.1_02 and reinstall JRE 1.4.2. |
| Web browser              | Netscape 7.x or Internet Explorer 6.x                                        | Netscape 7.x is available at the following site:  
                           |                                                                              | http://channels.netscape.com/ns/browsers/default.jsp  
                           |                                                                              | Internet Explorer 6.x is available at the following site:  
                           |                                                                              | http://www.microsoft.com                                                  |
| Cable                    | User-supplied CAT-5 straight-through cable with RJ-45 connectors on each end to connect the computer to the ONS 15454 directly or through a LAN | —                                                                                                                                        |
19.4 ONS 15454 Connections

You can connect to the ONS 15454 in multiple ways. You can connect your PC directly to the ONS 15454 (local craft connection) using the RJ-45 port on the TCC2/TCC2P card or, for the ANSI shelf, the LAN pins on the backplane (the ETSI shelf provides a LAN connection via the RJ-45 jack on the MIC-T/C/P FMEC). Alternatively, you can connect your PC to a hub or switch that is connected to the ONS 15454, connect to the ONS 15454 through a LAN or modem, or establish TL1 connections from a PC or TL1 terminal. Table 19-3 lists the ONS 15454 connection methods and requirements.

Table 19-3 ONS 15454 Connection Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Craft</td>
<td>Refers to onsite network connections between the CTC computer and the ONS 15454 using one of the following: The RJ-45 (LAN) port on the TCC2/TCC2P card. The LAN pins on the ONS 15454 backplane (ANSI). The RJ-45 jack on the MIC-T/C/P FMEC (ETSI). A hub or switch to which the ONS 15454 is connected.</td>
<td>If you do not use Dynamic Host Configuration Protocol (DHCP), you must change the computer IP address, subnet mask, and default router, or use automatic host detection.</td>
</tr>
<tr>
<td>Corporate LAN</td>
<td>Refers to a connection to the ONS 15454 through a corporate or network operations center (NOC) LAN.</td>
<td>• The ONS 15454 must be provisioned for LAN connectivity, including IP address, subnet mask, and default gateway. • The ONS 15454 must be physically connected to the corporate LAN. • The CTC computer must be connected to the corporate LAN that has connectivity to the ONS 15454.</td>
</tr>
<tr>
<td>TL1</td>
<td>Refers to a connection to the ONS 15454 using TL1 rather than CTC. TL1 sessions can be started from CTC, or you can use a TL1 terminal. The physical connection can be a craft connection, corporate LAN, or a TL1 terminal.</td>
<td>Refer to the Cisco ONS SONET TL1 Reference Guide or the Cisco ONS 15454 SDH TL1 Reference Guide.</td>
</tr>
<tr>
<td>Remote</td>
<td>Refers to a connection made to the ONS 15454 using a modem.</td>
<td>• A modem must be connected to the ONS 15454. • The modem must be provisioned for the ONS 15454. To run CTC, the modem must be provisioned for Ethernet access.</td>
</tr>
</tbody>
</table>
19.5 CTC Window

The CTC window appears after you log into an ONS 15454 (Figure 19-3). The window includes a menu bar, a toolbar, and a top and bottom pane. The top pane provides status information about the selected objects and a graphic of the current view. The bottom pane provides tabs and subtab to view ONS 15454 information and perform ONS 15454 provisioning and maintenance. From this window, you can display three ONS 15454 views: network, node, and card.

Figure 19-3  Node View (Default Login View)

19.5.1 Node View

Node view, shown in Figure 19-3, is the first view that appears after you log into an ONS 15454. The login node is the first node shown, and it is the “home view” for the session. Node view allows you to manage one ONS 15454 node. The status area shows the node name; IP address; session boot date and time; number of Critical (CR), Major (MJ), and Minor (MN) alarms; name and security level of the current logged-in user; software version; and network element default setup.

19.5.1.1 CTC Card Colors

The graphic area of the CTC window depicts the ONS 15454 shelf assembly. The colors of the cards in the graphic reflect the real-time status of the physical card and slot (Table 19-4).

Table 19-4  Node View Card Colors

<table>
<thead>
<tr>
<th>Card Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>Slot is not provisioned; no card is installed.</td>
</tr>
<tr>
<td>Violet</td>
<td>Slot is provisioned; no card is installed.</td>
</tr>
</tbody>
</table>
On the ONS 15454 ETSI, the colors of the Front Mount Electrical Connection (FMEC) cards reflect the real-time status of the physical FMEC cards. Table 19-5 lists the FMEC card colors. The FMEC ports shown in CTC do not change color.

Note
You cannot preprovision FMECs.

<table>
<thead>
<tr>
<th>Upper Shelf FMEC Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td>Functioning card is installed.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Minor alarm condition exists.</td>
</tr>
<tr>
<td>Orange (Amber)</td>
<td>Major alarm condition exists.</td>
</tr>
<tr>
<td>Red</td>
<td>Critical alarm exists.</td>
</tr>
</tbody>
</table>

The wording on a card in node view shows the status of a card (Active, Standby, Loading, or Not Provisioned). Table 19-6 lists the card statuses.

<table>
<thead>
<tr>
<th>Card Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sty</td>
<td>Card is in standby mode.</td>
</tr>
<tr>
<td>Act</td>
<td>Card is active.</td>
</tr>
<tr>
<td>NP</td>
<td>Card is not present.</td>
</tr>
<tr>
<td>Ldg</td>
<td>Card is resetting.</td>
</tr>
</tbody>
</table>

Port color in both card and node view indicates the port service state. Table 19-7 lists the port colors and their service states. For more information about port service states, refer to Appendix C, “DWDM Administrative and Service States.”
### Table 19-7  Node View Card Port Colors and Service States

<table>
<thead>
<tr>
<th>Port Color</th>
<th>Service State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan (blue)</td>
<td>Out-of-Service and Management, Loopback (OOS-MA,LPBK [ANSI])</td>
<td>Port is in a loopback state. On the card in node view, a line between ports indicates that the port is in terminal or facility loopback (see Figure 19-4 and Figure 19-5). Traffic is carried and alarm reporting is suppressed. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command.</td>
</tr>
<tr>
<td>Cyan (blue)</td>
<td>Out-of-Service and Management, Maintenance (OOS-MA,MT [ANSI])</td>
<td>Port is out-of-service for maintenance. Traffic is carried and loopbacks are allowed. Alarm reporting is suppressed. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command. Use this service state for testing or to suppress alarms temporarily. Change the state to IS-NR/Unlocked-enabled; OOS-MA,DSBLD/Locked-enabled,disabled; or OOS-AU,AINS/Unlocked-disabled,automaticInService when testing is complete.</td>
</tr>
<tr>
<td>Gray</td>
<td>Out-of-Service and Management, Disabled (OOS-MA,DSBLD [ANSI])</td>
<td>The port is out-of-service and unable to carry traffic. Loopbacks are not allowed in this service state.</td>
</tr>
<tr>
<td>Green</td>
<td>In-Service and Normal (IS-NR [ANSI])</td>
<td>The port is fully operational and performing as provisioned. The port transmits a signal and displays alarms; loopbacks are not allowed.</td>
</tr>
<tr>
<td>Violet</td>
<td>Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS [ANSI])</td>
<td>The port is out-of-service, but traffic is carried. Alarm reporting is suppressed. The node monitors the ports for an error-free signal. After an error-free signal is detected, the port stays in this service state for the duration of the soak period. After the soak period ends, the port service state changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command. The AINS port will automatically transition to IS-NR/Unlocked-enabled when a signal is received for the length of time provisioned in the soak field.</td>
</tr>
</tbody>
</table>

### Figure 19-4  Terminal Loopback Indicator

![Terminal Loopback Indicator](image)

---

Cisco ONS 15454 DWDM Installation and Operations Guide, R6.0

August 2005
19.5.1 Node View

19.5.1.2 Node View Card Shortcuts

If you move your mouse over cards in the graphic, popups display additional information about the card including the card type; the card status (active or standby); the type of alarm, such as Critical, Major, or Minor (if any); the alarm profile used by the card; and for transponder (TXP) or muxponder (MXP) cards, the wavelength of the dense wavelength division multiplexing (DWDM) port. Right-click a card to reveal a shortcut menu, which you can use to open, reset, delete, or change a card. Right-click a slot to preprovision a card (that is, provision a slot before installing the card).

19.5.1.3 Node View Tabs

Table 19-8 lists the tabs and subtabs available in the node view.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
<th>Subtabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>Lists current alarms (CR, MJ, MN) for the node and updates them in real time.</td>
<td>—</td>
</tr>
<tr>
<td>Conditions</td>
<td>Displays a list of standing conditions on the node.</td>
<td>—</td>
</tr>
<tr>
<td>History</td>
<td>Provides a history of node alarms including date, type, and severity of each alarm. The Session subtab displays alarms and events for the current session. The Node subtab displays alarms and events retrieved from a fixed-size log on the node.</td>
<td>Session, Node</td>
</tr>
<tr>
<td>Circuits</td>
<td>Creates, deletes, edits, and maps circuits.</td>
<td>—</td>
</tr>
<tr>
<td>Provisioning</td>
<td>Provisions the ONS 15454 node.</td>
<td>General, Ether Bridge, Network, Protection, BLSR, Security, SNMP, Comm Channels, Timing, Alarm Profiles, Defaults, UCP, WDM-ANS</td>
</tr>
<tr>
<td>Inventory</td>
<td>Provides inventory information (part number, serial number, Common Language Equipment Identification [CLEI] codes) for cards installed in the node. Allows you to delete and reset cards and change the card service state.</td>
<td>—</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Performs maintenance tasks for the node.</td>
<td>Database, Ether Bridge, Protection, BLSR (ANSI), MS-SPRing (ETSI), Software, Cross-Connect, Overhead XConnect, Diagnostic, Timing, Audit, Routing Table, RIP Routing Table, Test Access, DWDM</td>
</tr>
</tbody>
</table>
19.5.2 Network View

Network view allows you to view and manage ONS 15454s that have DCC connections to the node that you logged into and any login node groups you have selected (Figure 19-6).

Figure 19-6  Network in CTC Network View

![Network View Diagram]

Note

Nodes with DCC connections to the login node do not appear if you checked the Disable Network Discovery check box in the Login dialog box.

The graphic area displays a background image with colored ONS 15454 icons. A Superuser can set up the logical network view feature, which enables each user to see the same network view.

The lines show DCC connections between the nodes (Table 19-9). DCC connections can be green (active) or gray (fail). The lines can also be solid (circuits can be routed through this link) or dashed (circuits cannot be routed through this link). Circuit provisioning uses active/routable links. Selecting a node or span in the graphic area displays information about the node and span in the status area.

<table>
<thead>
<tr>
<th>Color and Line Style</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green and solid</td>
<td>Active/Routable</td>
</tr>
<tr>
<td>Green and dashed</td>
<td>Active/Nonroutable</td>
</tr>
<tr>
<td>Gray and solid</td>
<td>Failed/Routable</td>
</tr>
<tr>
<td>Gray and dashed</td>
<td>Failed/Nonroutable</td>
</tr>
</tbody>
</table>
The color of a node in network view, shown in Table 19-10, indicates the node alarm status.

<table>
<thead>
<tr>
<th>Color</th>
<th>Alarm Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No alarms</td>
</tr>
<tr>
<td>Yellow</td>
<td>Minor alarms</td>
</tr>
<tr>
<td>Orange</td>
<td>Major alarms</td>
</tr>
<tr>
<td>Red</td>
<td>Critical alarms</td>
</tr>
<tr>
<td>Gray with Unknown#</td>
<td>Node initializing for the first time (CTC displays Unknown# because CTC has not discovered the name of the node yet)</td>
</tr>
</tbody>
</table>

Table 19-11 lists the tabs and subtabs available in network view.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
<th>Subtabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>Lists current alarms (CR, MJ, MN) for the network and updates them in real time.</td>
<td>—</td>
</tr>
<tr>
<td>Conditions</td>
<td>Displays a list of standing conditions on the network.</td>
<td>—</td>
</tr>
<tr>
<td>History</td>
<td>Provides a history of network alarms including date, type, and severity of each alarm.</td>
<td>—</td>
</tr>
<tr>
<td>Circuits</td>
<td>Creates, deletes, edits, filters, and searches for network circuits.</td>
<td>—</td>
</tr>
<tr>
<td>Provisioning</td>
<td>Provisions security, alarm profiles, bidirectional line switched rings (BLSRs) (ANSI), multiplex section-shared protection rings (MS-SPRing) (ETSI), and overhead circuits.</td>
<td>Security, Alarm Profiles, BLSR (ANSI), MS-SPRing (ETSI), Overhead Circuits, Provisionable Patchcords</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Displays the type of equipment and the status of each node in the network; displays working and protect software versions; and allows software to be downloaded.</td>
<td>Software</td>
</tr>
</tbody>
</table>

19.5.3 Card View

The card view provides information about individual ONS 15454 cards. Use this window to perform card-specific maintenance and provisioning (Figure 19-7). A graphic showing the ports on the card is shown in the graphic area. The status area displays the node name, slot, number of alarms, card type, equipment type, card status (active or standby), card service state if the card is present, and port service state (described in Table 19-7 on page 19-9). The information that appears and the actions you can perform depend on the card. For more information about card service states, refer to Appendix C, “DWDM Administrative and Service States.”
CTC provides a card view for all ONS 15454 cards except the TCC2/TCC2P card.

Use the card view tabs and subtabs shown in Table 19-12 to provision and manage the ONS 15454. The subtabs, fields, and information shown under each tab depend on the card type selected. The Performance tab is not available for the Alarm Interface Controller–International (AIC-I) cards.

Table 19-12  Card View Tabs and Subtabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
<th>Subtabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>Lists current alarms (CR, MJ, MN) for the card and updates them in real time.</td>
<td>—</td>
</tr>
<tr>
<td>Conditions</td>
<td>Displays a list of standing conditions on the card.</td>
<td>—</td>
</tr>
<tr>
<td>History</td>
<td>Provides a history of card alarms including date, object, port, and severity of each alarm.</td>
<td>Session (displays alarms and events for the current session), Card (displays alarms and events retrieved from a fixed-size log on the card)</td>
</tr>
<tr>
<td>Circuits</td>
<td>Creates, deletes, edits, and search circuits.</td>
<td>—</td>
</tr>
</tbody>
</table>
19.6 TCC2/TCC2P Card Reset

You can reset the ONS 15454 TCC2/TCC2P card by using CTC (a soft reset) or by physically reseating a TCC2/TCC2P card (a hard reset). A soft reset reboots the TCC2/TCC2P card and reloads the operating system and the application software. Additionally, a hard reset temporarily removes power from the TCC2/TCC2P card and clears all buffer memory.

You can apply a soft reset from CTC to either an active or standby TCC2/TCC2P card without affecting traffic. If you need to perform a hard reset on an active TCC2/TCC2P card, put the TCC2/TCC2P card into standby mode first by performing a soft reset.

Note

When a CTC reset is performed on an active TCC2/TCC2P card, the AIC-I card goes through an initialization process and also resets because it is controlled by the active TCC2/TCC2P card.

---

Table 19-12 Card View Tabs and Subtabs (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
<th>Subtabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning</td>
<td>Provisions an ONS 15454 card.</td>
<td>DS-N and OC-N cards: Line, Line Thresholds (different threshold options are available for DS-N and OC-N cards), Elect Path Thresholds, SONET Thresholds, SONET STS, and Alarm Profiles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP and MXP cards: Card, Line, Line Thresholds, Optics Thresholds, OTN, and Alarm Profiles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DWDM cards (subtabs depend on card type): Optical Line, Optical Chn, Optical Amplifier, Parameters, Optics Thresholds, and Alarm Profiles</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Performs maintenance tasks for the card.</td>
<td>Loopback, Info, Protection, J1 Path Trace, AINS Soak (options depend on the card type), Automatic Laser Shutdown</td>
</tr>
<tr>
<td>Performance</td>
<td>Performs performance monitoring for the card.</td>
<td>DS-N and OC-N cards: no subtabs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXP and MXP cards: Optics PM, Payload PM, OTN PM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DWDM cards (subtabs depend on card type): Optical Line, Optical Chn, Optical Amplifier Line, OC3 Line, Parameters, Optics Thresholds</td>
</tr>
<tr>
<td>Inventory</td>
<td>Displays an Inventory screen of the ports (TXP and MXP cards only).</td>
<td>—</td>
</tr>
</tbody>
</table>
19.7 TCC2/TCC2P Card Database

When dual TCC2/TCC2P cards are installed in the ONS 15454, each TCC2/TCC2P card hosts a separate database; therefore, the protect card database is available if the database on the working TCC2/TCC2P fails. You can also store a backup version of the database on the workstation running CTC. This operation should be part of a regular ONS 15454 maintenance program at approximately weekly intervals, and should also be completed when preparing an ONS 15454 for a pending natural disaster, such as a flood or fire.

Note
The following parameters are not backed up and restored: node name, IP address, mask and gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up database with a different node name, the circuits map to the new node name. Cisco recommends keeping a record of the old and new node names.

19.8 Software Revert

When you click the Activate button after a software upgrade, the TCC2/TCC2P card copies the current working database and saves it in a reserved location in the TCC2/TCC2P card flash memory. If later during the upgrade you need to revert to the original working software load from the protect software load, the saved database installs automatically. You do not need to restore the database manually or recreate circuits.

The revert feature is useful if the maintenance window in which you were performing an upgrade closes while you are still upgrading CTC software. You can revert to the protect software load without losing traffic. During the next maintenance window, you can complete the upgrade and activate the new software load.

Circuits created or provisioning done after you activate a new software load (upgrade to a higher release) will be lost with a revert. The database configuration at the time of activation is reinstated after a revert. (This does not apply to maintenance reverts, such as R5.0.1 to 5.0.2, because maintenance releases retain the database during activation.)

Caution
Cisco does not recommend reverting after changing provisioning on the node. Depending upon the particular provisioning, reverting in this case can be traffic affecting.

To perform a supported (non-service-affecting) revert from a software release you have just activated, the release you revert to must have been working at the time you first activated the new software on that node. Because a supported revert automatically restores the node configuration at the time of the previous activation, any configuration changes made after activation will be lost when you revert the software. Downloading the software release you are upgrading to a second time after you have activated the new load ensures that no actual revert to a previous load can take place (the TCC2/TCC2P will reset, but will not be traffic affecting and will not change your database).

Note
To perform a supported software upgrade or revert you must consult the specific upgrade document and release notes for the release you are upgrading to (or reverting from).
CHAPTER 20

Security Reference

This chapter provides information about Cisco ONS 15454 users and security. To create users for a single node or multiple nodes, see the “NTP-G23 Create Users and Assign Security” procedure on page 3-5. To change security policies, node access, and passwords or to delete or log out users, see the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

Note
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:
- 20.1 User IDs and Security Levels, page 20-1
- 20.2 User Privileges and Policies, page 20-2
- 20.3 Audit Trail, page 20-7
- 20.4 RADIUS Security, page 20-8

20.1 User IDs and Security Levels

The Cisco Transport Controller (CTC) ID is provided with the ONS 15454 system, but the system does not display the user ID when you sign into CTC. This ID can be used to set up other ONS 15454 users.

You can have up to 500 user IDs on one ONS 15454. Each CTC or TL1 user can be assigned one of the following security levels:
- Retrieve—Users can retrieve and view CTC information but cannot set or modify parameters.
- Maintenance—Users can access only the ONS 15454 maintenance options.
- Provisioning—Users can access provisioning and maintenance options.
- Superusers—Users can perform all of the functions of the other security levels as well as set names, passwords, and security levels for other users.

See Table 20-3 on page 20-6 for idle user timeout information for each security level.

By default, multiple concurrent user ID sessions are permitted on the node, that is, multiple users can log into a node using the same user ID. However, you can provision the node to allow only a single login per user and prevent concurrent logins for all users.

Note
You must add the same user name and password to each node the user accesses.
20.2 User Privileges and Policies

This section lists user privileges for each CTC task and describes the security policies available to Superusers for provisioning.

20.2.1 User Privileges by CTC Task

Table 20-1 shows the actions that each user privilege level can perform in node view.

<table>
<thead>
<tr>
<th>CTC Tab</th>
<th>Subtab</th>
<th>[Subtab]:Actions</th>
<th>Retrieve</th>
<th>Maintenance</th>
<th>Provisioning</th>
<th>Superuser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>—</td>
<td>Synchronize/Filter/Delete</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cleared Alarms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conditions</td>
<td>—</td>
<td>Retrieve/Filter</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>History</td>
<td>Session</td>
<td>Filter</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Node</td>
<td>Retrieve/Filter</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Circuits</td>
<td>Circuits</td>
<td>Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Filter/Search</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Rolls</td>
<td>Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Filter/Search</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CTC Tab</td>
<td>Subtab</td>
<td>[Subtab]:Actions</td>
<td>Retrieve</td>
<td>Maintenance</td>
<td>Provisioning</td>
<td>Superuser</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------</td>
<td>-------------------------------------------</td>
<td>----------</td>
<td>-------------</td>
<td>--------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Provisioning</td>
<td>General</td>
<td>General: Edit</td>
<td>—</td>
<td>—</td>
<td>Partial¹ X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power Monitor: Edit</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>EtherBridge</td>
<td>Spanning trees: Edit</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>General: All</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static Routing: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OSPF: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RIP: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Proxy: Create/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Firewall: Create/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>OSIMain Setup</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>TARP</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Routers</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>GRE Tunnel Routes</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Protection</td>
<td>Create/Delete/Edit</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BLSR (ANSI)</td>
<td>Create/Edit/Delete</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MS-SPRing (ETSI)</td>
<td>Ring Map/Squelch Table/RIP Table</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Security</td>
<td>Users: Create/Delete</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Users: Change</td>
<td>Same user</td>
<td>Same user</td>
<td>Same user</td>
<td>Same user</td>
<td>All users</td>
</tr>
<tr>
<td></td>
<td>Users: Clear Security Intrusion</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Active Logins: Logout</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Policy: Edit</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Access: Edit</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>RADIUS Server</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Legal Disclaimer: Edit</td>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td>SNMP</td>
<td>Create/Delete/Edit</td>
<td></td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Browse trap destinations</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## Table 20-1  ONS 15454 Security Levels—Node View (continued)

<table>
<thead>
<tr>
<th>CTC Tab</th>
<th>Subtab</th>
<th>[Subtab]:Actions</th>
<th>Retrieve</th>
<th>Maintenance</th>
<th>Provisioning</th>
<th>Superuser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning</td>
<td>Comm Channels</td>
<td>SDCC: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LDCC: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GCC: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OSC: OSC Terminations: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OSC: DWDM Ring ID: Create/Edit/Delete</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provisionable Patchcords: Create/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Timing</td>
<td>General: Edit</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>BITS Facilities: Edit</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Alarm Profiles</td>
<td>Alarm Behavior: Edit</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Alarm Profiles Editor: Load/Store/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alarm Profile Editor: New/Compare/Available/Usage</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Defaults</td>
<td>Edit/Import</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>UCP</td>
<td>Node: Edit/Provision</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Neighbor: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IPCC: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Interface: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Circuit: Create/Edit/Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WDM-ANS</td>
<td>Provisioning: Import</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Provisioning: Export</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Connections: Create/Edit/Delete/Commit/Calculate</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port Status: Launch</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Inventory</td>
<td>—</td>
<td>Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reset</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Database</td>
<td>Backup</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Restore</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td>EtherBridge</td>
<td></td>
<td>Spanning Trees: View</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MAC Table: Retrieve</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MAC Table: Clear/Clear All</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Trunk Utilization: Refresh</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Circuits: Refresh</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 20-1 ONS 15454 Security Levels—Node View (continued)

<table>
<thead>
<tr>
<th>CTC Tab</th>
<th>Subtab</th>
<th>[Subtab]: Actions</th>
<th>Retrieve</th>
<th>Maintenance</th>
<th>Provisioning</th>
<th>Superuser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>OSI</td>
<td>IS-IS RIB</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>ES-IS RIB</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>TDC</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>X</td>
</tr>
<tr>
<td>Protection</td>
<td>Switch/Lock out/Unlock/ Clear/Unlock</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>BLSR (ANSI)</td>
<td>West/East Switches</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>MS-SPRing (ETSI)</td>
<td>Reset</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Software</td>
<td>Download</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Activate/Revert</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Cross-Connect</td>
<td>Cards: Switch/Lock/Unlock</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Resource Usage: Delete</td>
<td>—</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Overhead</td>
<td>View</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XConnect</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagnostic</td>
<td>Retrieve/Lamp Test</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Timing</td>
<td>Source: Edit</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Timing Report: View/Refresh</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Audit</td>
<td>Retrieve/Archive</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Routing Table</td>
<td>Retrieve</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>RIP Routing Table</td>
<td>Retrieve</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Test Access</td>
<td>Read-only</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>DWDM</td>
<td>APC: Run/Disable/Refresh</td>
<td>—</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>WDM Span Check: Retrieve Span Loss values, Reset</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Power Monitoring: Refresh</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
</tbody>
</table>

1. A Provisioning user cannot change node name, contact, or AIS-V insertion on STS-1 signal degrade (SD) parameters.
2. The action buttons in the subtab are active for all users, but the actions can be completely performed only by the users assigned with the required security levels.

Table 20-2 shows the actions that each user privilege level can perform in network view.

### Table 20-2 ONS 15454 Security Levels—Network View

<table>
<thead>
<tr>
<th>CTC Tab</th>
<th>Subtab</th>
<th>[Subtab]: Actions</th>
<th>Retrieve</th>
<th>Maintenance</th>
<th>Provisioning</th>
<th>Superuser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>—</td>
<td>Synchronize/Filter/Delete cleared alarms</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Conditions</td>
<td>—</td>
<td>Retrieve/Filter</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>History</td>
<td>—</td>
<td>Filter</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Superusers can provision security policies on the ONS 15454. These security policies include idle user timeouts, password changes, password aging, and user lockout parameters. In addition, Superusers can access the ONS 15454 through the TCC2/TCC2P RJ-45 port, the backplane LAN connection, or both.

### 20.2.2.1 Idle User Timeout

Each ONS 15454 CTC or TL1 user can be idle during his or her login session for a specified amount of time before the CTC window is locked. The lockouts prevent unauthorized users from making changes. Higher-level users have shorter default idle periods and lower-level users have longer or unlimited default idle periods, as shown in Table 20-3. The user idle period can be modified by a Superuser; refer to the “NTP-G88 Modify Users and Change Security” procedure on page 10-45.

<table>
<thead>
<tr>
<th>Security Level</th>
<th>ONS 15454 Default User Idle Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>Superuser</td>
<td>15 minutes</td>
</tr>
<tr>
<td>Provisioning</td>
<td>30 minutes</td>
</tr>
</tbody>
</table>
20.2.2 User Password, Login, and Access Policies

Superusers can view real-time lists of users who are logged into CTC or TL1 user logins by node. Superusers can also provision the following password, login, and node access policies:

- Password expirations and reuse—Superusers can specify when users must change their passwords and when they can reuse them.
- Login attempts—Superusers can specify the maximum number of times a user is allowed to attempt to login to CTC.
- Locking out and disabling users—Superusers can provision the number of invalid logins that are allowed before locking out users and the length of time before inactive users are disabled. The number of allowed lockout attempts is set to the number of allowed login attempts.
- Node access and user sessions—Superusers can limit the number of CTC sessions one user can have, and they can prohibit access to the ONS 15454 using the LAN or TCC2/TCC2P RJ-45 connections.

In addition, a Superuser can select secure shell (SSH) instead of Telnet at the CTC Provisioning > Security > Access tabs. SSH is a terminal-remote host Internet protocol that uses encrypted links. It provides authentication and secure communication over unsecure channels. Port 22 is the default port and cannot be changed.

20.3 Audit Trail

The Cisco ONS 15454 maintains a Telcordia GR-839-CORE-compliant audit trail log that resides on the TCC2/TCC2P card. Audit trails are useful for maintaining security, recovering lost transactions and enforcing accountability. Accountability refers to tracing user activities; that is, associating a process or action with a specific user. This record shows who has accessed the system and what operations were performed during a given period of time. The log includes authorized Cisco logins and logouts using the operating system command line interface, CTC, and TL1; the log also includes FTP actions, circuit creation/deletion, and user/system generated actions.

Event monitoring is also recorded in the audit log. An event is defined as the change in status of an element within the network. External events, internal events, attribute changes, and software upload/download activities are recorded in the audit trail.

The audit trail is stored in persistent memory and is not corrupted by processor switches, resets or upgrades. However, if a user pulls both TCC2/TCC2P cards, the audit trail log is lost.

See the “NTP-G108 Viewing the Audit Trail Records” procedure on page 13-14 as necessary.

20.3.1 Audit Trail Log Entries

Table 20-4 contains the columns listed in Audit Trail window.
20.3.2 Audit Trail Capacities

The system is able to store 640 log entries. When this limit is reached, the oldest entries are overwritten with new events. When the log server is 80 percent full, an AUD-LOG-LOW condition is raised and logged (by way of Common Object Request Broker Architecture [CORBA]/CTC).

When the log server reaches a maximum capacity of 640 entries and begins overwriting records that were not archived, an AUD-LOG-LOSS condition is raised and logged. This event indicates that audit trail records have been lost. Until the user off-loads the file, this event occurs only once regardless of the amount of entries that are overwritten by the system. See the “NTP-G109 Off-Load the Audit Trail Record” procedure on page 13-16 for more information.

20.4 RADIUS Security

Superusers can configure nodes to use Remote Authentication Dial In User Service (RADIUS) authentication. RADIUS uses a strategy known as authentication, authorization, and accounting (AAA) for verifying the identity of, granting access to, and tracking the actions of remote users. See the “DLP-G281 Configure the Node for RADIUS Authentication” task on page 10-55 as needed.
20.4.1 RADIUS Authentication

RADIUS is a system of distributed security that secures remote access to networks and network services against unauthorized access. RADIUS comprises three components:

- A protocol with a frame format that utilizes User Datagram Protocol (UDP)/IP
- A server
- A client

The server runs on a central computer typically at the customer's site, while the clients reside in the dial-up access servers and can be distributed throughout the network.

An ONS 15454 node operates as a client of RADIUS. The client is responsible for passing user information to designated RADIUS servers, and then acting on the response that is returned. RADIUS servers are responsible for receiving user connection requests, authenticating the user, and returning all configuration information necessary for the client to deliver service to the user. The RADIUS servers can act as proxy clients to other kinds of authentication servers. Transactions between the client and RADIUS server are authenticated through the use of a shared secret, which is never sent over the network. In addition, any user passwords are sent encrypted between the client and RADIUS server. This eliminates the possibility that someone snooping on an unsecured network could determine a user's password.

20.4.2 Shared Secrets

A shared secret is a text string that serves as a password between:

- A RADIUS client and RADIUS server
- A RADIUS client and a RADIUS proxy
- A RADIUS proxy and a RADIUS server

For a configuration that uses a RADIUS client, a RADIUS proxy, and a RADIUS server, the shared secret that is used between the RADIUS client and the RADIUS proxy can be different than the shared secret used between the RADIUS proxy and the RADIUS server.

Shared secrets are used to verify that RADIUS messages, with the exception of the Access-Request message, are sent by a RADIUS-enabled device that is configured with the same shared secret. Shared secrets also verify that the RADIUS message has not been modified in transit (message integrity). The shared secret is also used to encrypt some RADIUS attributes, such as User-Password and Tunnel-Password.

When creating and using a shared secret:

- Use the same case-sensitive shared secret on both RADIUS devices.
- Use a different shared secret for each RADIUS server-RADIUS client pair.
- To ensure a random shared secret, generate a random sequence at least 16 characters long.
- You can use any standard alphanumeric and special characters.
- You can use a shared secret of up to 16 characters in length. To protect your server and your RADIUS clients from brute force attacks, use long shared secrets.
- Make the shared secret a random sequence of letters, numbers, and punctuation and change it often to protect your server and your RADIUS clients from dictionary attacks. Shared secrets should contain characters from each of the three groups listed in Table 20-5.
Table 20-5  Shared Secret Character Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letters (uppercase and lowercase)</td>
<td>A, B, C, D and a, b, c, d</td>
</tr>
<tr>
<td>Numerals</td>
<td>0, 1, 2, 3</td>
</tr>
<tr>
<td>Symbols (all characters not defined as letters or numerals)</td>
<td>Exclamation point (!), asterisk (*), colon (:)</td>
</tr>
</tbody>
</table>

The stronger your shared secret, the more secure are the attributes (for example, those used for passwords and encryption keys) that are encrypted with it. An example of a strong shared secret is 8d#>9fq4bV)H7%a3.
Timing Reference

This chapter provides information about Cisco ONS 15454 users and node timing. To provision security and timing, see the “NTP-G23 Create Users and Assign Security” procedure on page 3-5.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:
- 21.1 Node Timing Parameters, page 21-1
- 21.3 Synchronization Status Messaging, page 21-3

21.1 Node Timing Parameters

SONET timing parameters must be set for each ONS 15454. Each ONS 15454 independently accepts its timing reference from one of three sources:

- The building integrated timing supply (BITS) pins on the ONS 15454 backplane (ANSI) or MIC-C/T/P coaxial connectors (ETSI).
- An OC-N/STM-N card installed in the ONS 15454. The card is connected to a node that receives timing through a BITS source.
- The internal ST3 clock on the TCC2/TCC2P card.

You can set ONS 15454 timing to one of three modes: external, line, or mixed. If timing is coming from the BITS pins, set ONS 15454 timing to external. If the timing comes from an OC-N/STM-N card, set the timing to line. In typical ONS 15454 networks:

- One node is set to external. The external node derives its timing from a BITS source wired to the BITS backplane pins. The BITS source, in turn, derives its timing from a primary reference source (PRS) such as a Stratum 1 clock or global positioning satellite (GPS) signal.
- The other nodes are set to line. The line nodes derive timing from the externally timed node through the OC-N trunk (span) cards. The DWDM node normally derives timing from the line using the OSCM or OSC-CSM card that are inside an OC-3/STM-1 channel.

You can set three timing references for each ONS 15454. The first two references are typically two BITS-level sources, or two line-level sources optically connected to a node with a BITS source. The third reference is usually assigned to the internal clock provided on every ONS 15454 TCC2/TCC2P card.
However, if you assign all three references to other timing sources, the internal clock is always available as a backup timing reference. The internal clock is a Stratum 3 (ST3), so if an ONS 15454 node becomes isolated, timing is maintained at the ST3 level.

The CTC Maintenance > Timing > Report tabs show current timing information for an ONS 15454, including the timing mode, clock state and status, switch type, and reference data.

Caution

Mixed timing allows you to select both external and line timing sources. However, Cisco does not recommend its use because it can create timing loops. Use this mode with caution.

21.2 Network Timing

Figure 21-1 shows an ONS 15454 network timing setup example. Node 1 is set to external timing. Two timing references are set to BITS. These are Stratum 1 timing sources wired to the BITS input pins on the Node 1 backplane. The third reference is set to internal clock. The BITS output pins on the backplane of Node 3 are used to provide timing to outside equipment, such as a digital access line access multiplexer.

In the example, Slots 5 and 6 contain the trunk (span) cards. Timing at Nodes 2, 3, and 4 is set to line, and the timing references are set to the trunk cards based on distance from the BITS source. Reference 1 is set to the trunk card closest to the BITS source. At Node 2, Reference 1 is Slot 5 because it is connected to Node 1. At Node 4, Reference 1 is set to Slot 6 because it is connected to Node 1. At Node 3, Reference 1 could be either trunk card because they are equal distance from Node 1.
21.3 Synchronization Status Messaging

Synchronization status messaging (SSM) is a SONET protocol that communicates information about the quality of the timing source. SSM messages are carried on the S1 byte of the SONET Line layer. They enable SONET devices to automatically select the highest quality timing reference and to avoid timing loops.

SSM messages are either Generation 1 or Generation 2. Generation 1 is the first and most widely deployed SSM message set. Generation 2 is a newer version. If you enable SSM for the ONS 15454, consult your timing reference documentation to determine which message set to use. Table 21-1 and Table 21-2 on page 21-4 show the Generation 1 and Generation 2 message sets.

<table>
<thead>
<tr>
<th>Message</th>
<th>Quality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRS</td>
<td>1</td>
<td>Primary reference source—Stratum 1</td>
</tr>
<tr>
<td>STU</td>
<td>2</td>
<td>Synchronization traceability unknown</td>
</tr>
</tbody>
</table>
### Table 21-1  SSM Generation 1 Message Set (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Quality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST2</td>
<td>3</td>
<td>Stratum 2</td>
</tr>
<tr>
<td>ST3</td>
<td>4</td>
<td>Stratum 3</td>
</tr>
<tr>
<td>SMC</td>
<td>5</td>
<td>SONET minimum clock</td>
</tr>
<tr>
<td>ST4</td>
<td>6</td>
<td>Stratum 4</td>
</tr>
<tr>
<td>DUS</td>
<td>7</td>
<td>Do not use for timing synchronization</td>
</tr>
<tr>
<td>RES</td>
<td>—</td>
<td>Reserved; quality level set by user</td>
</tr>
</tbody>
</table>

### Table 21-2  SSM Generation 2 Message Set

<table>
<thead>
<tr>
<th>Message</th>
<th>Quality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRS</td>
<td>1</td>
<td>Primary reference source—Stratum 1</td>
</tr>
<tr>
<td>STU</td>
<td>2</td>
<td>Synchronization traceability unknown</td>
</tr>
<tr>
<td>ST2</td>
<td>3</td>
<td>Stratum 2</td>
</tr>
<tr>
<td>TNC</td>
<td>4</td>
<td>Transit node clock</td>
</tr>
<tr>
<td>ST3E</td>
<td>5</td>
<td>Stratum 3E</td>
</tr>
<tr>
<td>ST3</td>
<td>6</td>
<td>Stratum 3</td>
</tr>
<tr>
<td>SMC</td>
<td>7</td>
<td>SONET minimum clock</td>
</tr>
<tr>
<td>ST4</td>
<td>8</td>
<td>Stratum 4</td>
</tr>
<tr>
<td>DUS</td>
<td>9</td>
<td>Do not use for timing synchronization</td>
</tr>
<tr>
<td>RES</td>
<td>—</td>
<td>Reserved; quality level set by user</td>
</tr>
</tbody>
</table>
Management Connectivity Reference

This chapter provides nine scenarios showing Cisco ONS 15454s in common IP network configurations as well as information about provisionable patchcords, the routing table, external firewalls, and open gateway network element (GNE) networks. The chapter does not provide a comprehensive explanation of IP networking concepts and procedures. For IP setup instructions, see the “DLP-G56 Provision IP Settings” task on page 3-12.

Note
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:
- 22.1 IP Networking Overview, page 22-1
- 22.2 IP Addressing Scenarios, page 22-2
- 22.3 Provisionable Patchcords, page 22-21
- 22.4 Routing Table, page 22-23
- 22.5 External Firewalls, page 22-25
- 22.6 Open GNE, page 22-26

Note
To connect ONS 15454s to an IP network, you must work with a LAN administrator or other individual at your site who has IP networking training and experience.

22.1 IP Networking Overview

ONS 15454s can be connected in many different ways within an IP environment:
- They can be connected to LANs through direct connections or a router.
- IP subnetting can create ONS 15454 node groups that allow you to provision non-data communication channel (DCC) connected nodes in a network.
- Different IP functions and protocols can be used to achieve specific network goals. For example, Proxy Address Resolution Protocol (ARP) enables one LAN-connected ONS 15454 to serve as a gateway for ONS 15454s that are not connected to the LAN.
- Static routes can be created to enable connections among multiple Cisco Transport Controller (CTC) sessions with ONS 15454s that reside on the same subnet with multiple CTC sessions.


- ONS 15454s can be connected to Open Shortest Path First (OSPF) networks so ONS 15454 network information is automatically communicated across multiple LANs and WANs.

- The ONS 15454 proxy server can control the visibility and accessibility between CTC computers and ONS 15454 element nodes.

### 22.2 IP Addressing Scenarios

ONS 15454 IP addressing generally has eight common scenarios or configurations. Use the scenarios as building blocks for more complex network configurations. Table 22-1 provides a general list of items to check when setting up ONS 15454s in IP networks.

<table>
<thead>
<tr>
<th>Item</th>
<th>What to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link integrity</td>
<td>Verify that link integrity exists between:</td>
</tr>
<tr>
<td></td>
<td>- CTC computer and network hub/switch</td>
</tr>
<tr>
<td></td>
<td>- ONS 15454s (backplane [ANSI] or MIC-C/T/P [ETSI] wire-wrap pins or RJ-45 port) and network hub/switch</td>
</tr>
<tr>
<td></td>
<td>- Router ports and hub/switch ports</td>
</tr>
<tr>
<td>ONS 15454 hub/switch ports</td>
<td>If connectivity problems occur, set the hub or switch port that is connected to the ONS 15454 to 10 Mbps half-duplex.</td>
</tr>
<tr>
<td>Ping</td>
<td>Ping the node to test connections between computers and ONS 15454s.</td>
</tr>
<tr>
<td>IP addresses/subnet masks</td>
<td>Verify that ONS 15454 IP addresses and subnet masks are set up correctly.</td>
</tr>
<tr>
<td>Optical connectivity</td>
<td>Verify that ONS 15454 optical trunk ports are in service and that a DCC is enabled on each trunk port.</td>
</tr>
</tbody>
</table>

### 22.2.1 Scenario 1: CTC and ONS 15454s on Same Subnet

Scenario 1 shows a basic ONS 15454 LAN configuration (Figure 22-1). The ONS 15454s and CTC computer reside on the same subnet. All ONS 15454s connect to LAN A, and all ONS 15454s have DCC connections.
22.2.2 Scenario 2: CTC and ONS 15454s Connected to a Router

In Scenario 2, the CTC computer resides on a subnet (192.168.1.0) and attaches to LAN A (Figure 22-2). The ONS 15454s reside on a different subnet (192.168.2.0) and attach to LAN B. A router connects LAN A to LAN B. The IP address of router interface A is set to LAN A (192.168.1.1), and the IP address of router interface B is set to LAN B (192.168.2.1). The routers each have a subnet mask of 255.255.255.0.

On the CTC computer, the default gateway is set to router interface A. If the LAN uses DHCP (Dynamic Host Configuration Protocol), the default gateway and IP address are assigned automatically. In the Figure 22-2 example, a DHCP server is not available.
22.2.3 Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway

ARP matches higher-level IP addresses to the physical addresses of the destination host. It uses a lookup table (called ARP cache) to perform the translation. When the address is not found in the ARP cache, a broadcast is sent out on the network with a special format called the ARP request. If one of the machines on the network recognizes its own IP address in the request, it sends an ARP reply back to the requesting host. The reply contains the physical hardware address of the receiving host. The requesting host stores this address in its ARP cache so that all subsequent datagrams (packets) to this destination IP address can be translated to a physical address.

Proxy ARP enables one LAN-connected ONS 15454 to respond to the ARP request for ONS 15454s not connected to the LAN. (ONS 15454 proxy ARP requires no user configuration.) For this to occur, the DCC-connected ONS 15454s must reside on the same subnet as the LAN-connected (gateway) ONS 15454. When a LAN device sends an ARP request to an ONS 15454 that is not connected to the LAN, the gateway ONS 15454 (the one connected to the LAN) returns its MAC address to the LAN.
device. The LAN device then sends the datagram for the remote ONS 15454 to the MAC address of the proxy ONS 15454. The proxy ONS 15454 uses its routing table to forward the datagram to the non-LAN ONS 15454.

Scenario 3 is similar to Scenario 1, but only one ONS 15454 (Node 1) connects to the LAN (Figure 22-3). Two ONS 15454s (Node 2 and Node 3) connect to ONS 15454 Node 1 through the section DCC. Because all three ONS 15454s are on the same subnet, proxy ARP enables ONS 15454 Node 1 to serve as a gateway for ONS 15345 Node 2 and Node 3.

**Note**

This scenario assumes all CTC connections are to Node 1. If you connect a laptop to either ONS 15454 Node 2 or Node 3, network partitioning occurs; neither the laptop or the CTC computer can see all nodes. If you want laptops to connect directly to end network elements, you must create static routes (see Scenario 5) or enable the ONS 15454 proxy server (see Scenario 7).

Be aware that:

- GNE and ENE 15454 proxy ARP is disabled.
- There is exactly one proxy ARP server on any given Ethernet segment; however, there may be more than one server in an ANSI or ETSI topology.
- The proxy ARP server does not perform the proxy ARP function for any node or host that is on the same Ethernet segment.
- It is important in Figure 22-3 that the CTC workstation be located within the same subnet and on the same Ethernet segment as the proxy ARP server.
You can also use proxy ARP to communicate with hosts attached to the craft Ethernet ports of DCC-connected nodes (Figure 22-4). The node with an attached host must have a static route to the host. Static routes are propagated to all DCC peers using OSPF. The existing proxy ARP node is the gateway for additional hosts. Each node examines its routing table for routes to hosts that are not connected to the DCC network but are within the subnet. The existing proxy server replies to ARP requests for these additional hosts with the node MAC address. The existence of the host route in the routing table ensures that the IP packets addressed to the additional hosts are routed properly. Other than establishing a static route between a node and an additional host, no provisioning is necessary. The following restrictions apply:

- Only one node acts as the proxy ARP server for any given additional host.
- A node cannot be the proxy ARP server for a host connected to its Ethernet port.

In Figure 22-4, Node 1 announces to Node 2 and 3 that it can reach the CTC host. Similarly, Node 3 announces that it can reach the ONS 152xx. The ONS 152xx is shown as an example; any network element can be set up as an additional host.
22.2.4 Scenario 4: Default Gateway on CTC Computer

Scenario 4 is similar to Scenario 3, but Nodes 2 and 3 reside on different subnets, 192.168.2.0 and 192.168.3.0, respectively (Figure 22-5). Node 1 and the CTC computer are on subnet 192.168.1.0. Proxy ARP is not used because the network includes different subnets. For the CTC computer to communicate with Nodes 2 and 3, Node 1 is entered as the default gateway on the CTC computer.
22.2.5 Scenario 5: Using Static Routes to Connect to LANs

Static routes are used for two purposes:

- To connect ONS 15454s to CTC sessions on one subnet connected by a router to ONS 15454s residing on another subnet. (These static routes are not needed if OSPF is enabled. Scenario 6 shows an OSPF example.)
- To enable multiple CTC sessions among ONS 15454s residing on the same subnet.

In Figure 22-6, one CTC residing on subnet 192.168.1.0 connects to a router through interface A (the router is not set up with OSPF). ONS 15454s residing on different subnets are connected through Node 1 to the router through interface B. Because Nodes 2 and 3 are on different subnets, proxy ARP does not enable Node 1 as a gateway. To connect to CTC computers on LAN A, a static route is created on Node 1.
22.2.5 Scenario 5: Using Static Routes to Connect to LANs

The destination and subnet mask entries control access to the ONS 15454s:

- If a single CTC computer is connected to a router, enter the complete CTC “host route” IP address as the destination with a subnet mask of 255.255.255.255.
- If CTC computers on a subnet are connected to a router, enter the destination subnet (in this example, 192.168.1.0) and a subnet mask of 255.255.255.0.
- If all CTC computers are connected to a router, enter a destination of 0.0.0.0 and a subnet mask of 0.0.0.0. Figure 22-7 shows an example.

The IP address of router interface B is entered as the next hop, and the cost (number of hops from source to destination) is 2.
22.2.6 Scenario 6: Using OSPF

Open Shortest Path First (OSPF) is a link state Internet routing protocol. Link state protocols use a “hello protocol” to monitor their links with adjacent routers and to test the status of their links to their neighbors. Link state protocols advertise their directly connected networks and their active links. Each link state router captures the link state “advertisements” and puts them together to create a topology of the entire network or area. From this database, the router calculates a routing table by constructing a shortest path tree. Routes are recalculated when topology changes occur.

ONS 15454s use the OSPF protocol in internal ONS 15454 networks for node discovery, circuit routing, and node management. You can enable OSPF on the ONS 15454s so that the ONS 15454 topology is sent to OSPF routers on a LAN. Advertising the ONS 15454 network topology to LAN routers
eliminates the need to manually enter static routes for ONS 15454 subnetworks. Figure 22-8 shows a network enabled for OSPF. Figure 22-9 shows the same network without OSPF. Static routes must be manually added to the router for CTC computers on LAN A to communicate with Nodes 2 and 3 because these nodes reside on different subnets.

OSPF divides networks into smaller regions, called areas. An area is a collection of networked end systems, routers, and transmission facilities organized by traffic patterns. Each OSPF area has a unique ID number, known as the area ID. Every OSPF network has one backbone area called “area 0.” All other OSPF areas must connect to area 0.

When you enable an ONS 15454 OSPF topology for advertising to an OSPF network, you must assign an OSPF area ID in decimal format to the ONS 15454 network. An area ID is a “dotted quad” value that appears similar to an IP address. Coordinate the area ID number assignment with your LAN administrator. All DCC-connected ONS 15454s should be assigned the same OSPF area ID.

*Note*

It is recommended that the number of 15454s in an OSPF area be limited, because this allows faster loading into a CTC and is less likely to incur any problems.

**Figure 22-8  Scenario 6: OSPF Enabled (ANSI and ETSI)**

CTC Workstation
IP Address 192.168.1.100
Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1
Host Routes = N/A

Router
IP Address of interface “A” to LAN A 192.168.1.1
IP Address of interface “B” to LAN B 192.168.2.1
Subnet Mask 255.255.255.0

LAN A
Int “A”

LAN B
Int “B”

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

ONS 15454 #2
IP Address 192.168.3.20
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.4.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

Ring
22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server

The ONS 15454 proxy server is a set of functions that allows you to network ONS 15454s in environments where visibility and accessibility between ONS 15454s and CTC computers must be restricted. For example, you can set up a network so that field technicians and network operating center (NOC) personnel can both access the same ONS 15454s while preventing the field technicians from accessing the NOC LAN. To do this, one ONS 15454 is provisioned as a GNE and the other ONS 15454s are provisioned as end network elements (ENEs). The GNE ONS 15454 tunnels connections between CTC computers and ENE ONS 15454s, providing management capability while preventing access for non-ONS 15454 management purposes.
The ONS 15454 gateway setting performs the following tasks:

- Isolates DCC IP traffic from Ethernet (craft port) traffic and accepts packets based on filtering rules. The filtering rules (see Table 22-3 on page 22-16 and Table 22-4 on page 22-17) depend on whether the packet arrives at the ONS 15454 DCC or TCC2/TCC2P Ethernet interface.

- Processes Simple Network Time Protocol (SNTP) and Network Time Protocol (NTP) requests. ONS 15454 ENEs can derive time-of-day from an SNTP/NTP LAN server through the GNE ONS 15454.

- Processes Simple Network Management Protocol version 1 (SNMPv1) traps. The GNE ONS 15454 receives SNMPv1 traps from the ENE ONS 15454s and forwards or relays the traps to SNMPv1 trap destinations or ONS 15454 SNMP relay nodes.

The ONS 15454 proxy server is provisioned using the Enable proxy server on port check box on the Provisioning > Network > General tab. If checked, the ONS 15454 serves as a proxy for connections between CTC clients and ONS 15454s that are DCC-connected to the proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes through the proxy node. The CTC client can connect to nodes that it cannot directly reach from the host on which it runs. If not selected, the node does not proxy for any CTC clients, although any established proxy connections continue until the CTC client exits. In addition, you can set the proxy server as an ENE or a GNE:

- End Network Element (ENE)—If set as an ENE, the ONS 15454 neither installs nor advertises default or static routes that go through its Ethernet port. However, an ENE does install and advertise routes that go through the DCC. CTC computers can communicate with the ONS 15454 using the TCC2/TCC2P craft port, but they cannot communicate directly with any other DCC-connected ONS 15454.

  In addition, firewall is enabled, which means that the node prevents IP traffic from being routed between the DCC and the LAN port. The ONS 15454 can communicate with machines connected to the LAN port or connected through the DCC. However, the DCC-connected machines cannot communicate with the LAN-connected machines, and the LAN-connected machines cannot communicate with the DCC-connected machines. A CTC client using the LAN to connect to the firewall-enabled node can use the proxy capability to manage the DCC-connected nodes that would otherwise be unreachable. A CTC client connected to a DCC-connected node can only manage other DCC-connected nodes and the firewall itself.

- Gateway Network Element (GNE)—If set as a GNE, the CTC computer is visible to other DCC-connected nodes and firewall is enabled.

- Proxy-only—If Proxy-only is selected, firewall is not enabled. CTC can communicate with any other DCC-connected ONS 15454s.

If you launch CTC against a node through a Network Address Translation (NAT) or Port Address Translation (PAT) router and that node does not have proxy enabled, your CTC session starts and initially appears to be fine. However CTC never receives alarm updates and disconnects and reconnects every two minutes. If the proxy is accidentally disabled, it is still possible to enable the proxy during a reconnect cycle and recover your ability to manage the node, even through a NAT/PAT firewall.

Figure 22-10 shows an ONS 15454 proxy server implementation. A GNE ONS 15454 is connected to a central office LAN and to ENE ONS 15454s. The central office LAN is connected to a NOC LAN, which has CTC computers. The NOC CTC computer and craft technicians must both be able to access the ONS 15454 ENEs. However, the craft technicians must be prevented from accessing or seeing the NOC or central office LANs.
In the example, the ONS 15454 GNE is assigned an IP address within the central office LAN and is physically connected to the LAN through its LAN port. ONS 15454 ENEs are assigned IP addresses that are outside the central office LAN and given private network IP addresses. If the ONS 15454 ENEs are collocated, the craft LAN ports could be connected to a hub. However, the hub should have no other network connections.

**Figure 22-10  Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI and ETSI)**

![Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI and ETSI)](image)

Table 22-2 shows recommended settings for ONS 15454 GNEs and ENEs in the configuration shown in Figure 22-10.

**Table 22-2  ONS 15454 Gateway and End NE Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>ONS 15454 Gateway NE</th>
<th>ONS 15454 End NE</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSPF</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>SNTP server (if used)</td>
<td>SNTP server IP address</td>
<td>Set to ONS 15454 GNE IP address</td>
</tr>
<tr>
<td>SNMP (if used)</td>
<td>SNMPv1 trap destinations</td>
<td>Set SNMPv1 trap destinations to ONS 15454 GNE, port 391</td>
</tr>
</tbody>
</table>
Figure 22-11 shows the same proxy server implementation with ONS 15454 ENEs on different subnets. The ONS 15454 GNEs and ENEs are provisioned with the settings shown in Table 22-2.

**Figure 22-11  Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on Different Subnets (ANSI and ETSI)**
Figure 22-12 shows the same proxy server implementation with ONS 15454 ENEs in multiple rings.

Table 22-3 shows the rules the ONS 15454 follows to filter packets for the firewall when nodes are configured as ENEs and GNEs. If the packet is addressed to the ONS 15454, additional rules (shown in Table 22-4) are applied. Rejected packets are silently discarded.

Table 22-3  Proxy Server Firewall Filtering Rules

<table>
<thead>
<tr>
<th>Packets Arriving At:</th>
<th>Are Accepted if the Destination IP Address is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCC2/TCC2P Ethernet interface</td>
<td>• The ONS 15454 itself</td>
</tr>
<tr>
<td></td>
<td>• The ONS 15454’s subnet broadcast address</td>
</tr>
<tr>
<td></td>
<td>• Within the 224.0.0.0/8 network (reserved network used for standard multicast messages)</td>
</tr>
<tr>
<td></td>
<td>• Subnet mask = 255.255.255.255</td>
</tr>
<tr>
<td>DCC interface</td>
<td>• The ONS 15454 itself</td>
</tr>
<tr>
<td></td>
<td>• Any destination connected through another DCC interface</td>
</tr>
<tr>
<td></td>
<td>• Within the 224.0.0.0/8 network</td>
</tr>
</tbody>
</table>
22.2.8 Scenario 8: Dual GNEs on a Subnet

The ONS 15454 provides GNE load balancing, which allows CTC to reach ENEs over multiple GNEs without the ENEs being advertised over OSPF. This feature allows a network to quickly recover from the loss of GNE, even if the GNE is on a different subnet. If a GNE fails, all connections through that GNE fail. CTC disconnects from the failed GNE and from all ENEs for which the GNE was a proxy, and then reconnects through the remaining GNEs. GNE load balancing reduces the dependency on the launch GNE and DCC bandwidth, both of which enhance CTC performance.

Table 22-4 Proxy Server Firewall Filtering Rules When Packet Addressed to ONS 15454

<table>
<thead>
<tr>
<th>Packets Arriving At</th>
<th>Rejects</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCC2/TCC2P Ethernet interface</td>
<td>• UDP (User Datagram Protocol) packets addressed to the SNMP trap relay port (391)</td>
</tr>
<tr>
<td>DCC interface</td>
<td>• TCP (Transmission Control Protocol) packets addressed to the proxy server port (1080)</td>
</tr>
</tbody>
</table>

If you implement the proxy server, note that all DCC-connected ONS 15454s on the same Ethernet segment must have the same gateway setting. Mixed values produce unpredictable results, and might leave some nodes unreachable through the shared Ethernet segment.

If nodes become unreachable, correct the setting by performing one of the following:

- Disconnect the craft computer from the unreachable ONS 15454. Connect to the ONS 15454 through another network ONS 15454 that has a DCC connection to the unreachable ONS 15454.
- Disconnect all DCCs to the node by disabling them on neighboring nodes. Connect a CTC computer directly to the ONS 15454 and change its provisioning.

Note

Dual GNEs do not need special provisioning

Figure 22-13 shows a network with dual GNEs on the same subnet.
Figure 22-13  Scenario 8: Dual GNEs on the Same Subnet (ANSI and ETSI)

Remote CTC 10.10.20.10

10.10.20.0/24

Interface 0/0
10.10.20.1

Router A

Interface 0/1
10.10.10.1

10.10.10.0/24

ONS 15454 Gateway NE 10.10.10.100/24

ONS 15454 Gateway NE 10.10.10.150/24

ONS 15454 End NE 10.10.10.250/24

ONS 15454 End NE 10.10.10.200/24

Local/Craft CTC 192.168.20.20

Ethernet

Optical Fiber
22.2.9 Scenario 9: IP Addressing with Secure Mode Enabled

TCC2P cards provide a secure mode option allowing you to provision two IP addresses for the ONS 15454. One IP address is provisioned for the ONS 15454 backplane LAN port. The other IP address is provisioned for the TCC2P TCP/IP craft port. The two IP addresses provide an additional layer of separation between the craft access port and the ONS 15454 LAN. If secure mode is enabled, the IP addresses provisioned for the TCC2P TCP/IP ports must follow general IP addressing guidelines. In addition, TCC2P IP addresses must reside on a different subnet from the ONS 15454 backplane port and ONS 15454 default router IP addresses.

The IP address assigned to the backplane LAN port becomes a private address, which is used to connect the ONS 15454 GNE to an OSS (Operations Support System) through a central office LAN or private enterprise network. In secure mode, the backplane’s LAN IP address is not displayed on the CTC node view or to a technician directly connected to the node by default. This default can be changed to allow the backplane IP address to be viewed on CTC only by a Superuser.
22.2.9 Scenario 9: IP Addressing with Secure Mode Enabled

Figure 22-15 shows an example of ONS 15454s on the same subnet with secure mode enabled.

**Note**
Secure mode is not available if TCC2 cards are installed, or if only one TCC2P card is installed.

![Figure 22-15 Scenario 9: ONS 15454 GNE and ENEs on the Same Subnet with Secure Mode Enabled](image)

Figure 22-16 shows an example of ONS 15454s connected to a router with secure mode enabled. In each example, TCC2P port addresses are on a different subnet from the node backplane addresses.
22.3 Provisionable Patchcords

A provisionable patchcord is a user-provisioned link that is advertised by OSPF throughout the network. Provisionable patchcords, also called virtual links, are needed in the following situations:

- An optical port is connected to a transponder or muxponder client port provisioned in transparent mode.
- An optical ITU port is connected to a DWDM optical channel card.
- Two transponder or muxponder trunk ports are connected to a DWDM optical channel card and the generic control channel (GCC) is carried transparently through the ring.
- Transponder or muxponder client and trunk ports are in a regenerator group, the cards are in transparent mode, and DCC/GCC termination is not available.

Provisionable patchcords are required on both ends of a physical link. The provisioning at each end includes a local patchcord ID, slot/port information, remote IP address, and remote patchcord ID. Patchcords appear as dashed lines in CTC network view.

Table 22-5 lists the supported card combinations for client and trunk ports in a provisionable patchcord.
22.3 Provisionable Patchcords

If the OCSM card is installed in Slot 8, provisionable patchcords from OC-N ports to the following cards are not supported on the same node: MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10E, TXP_MR_10E, 32MUX-O, 32DMX-O, 32WSS, or 32DMX.

Table 22-6 lists the supported card combinations for client-to-client ports in a patchcord.

Table 22-6 Cisco ONS 15454 Client/Client Card Combinations for Provisionable Patchcords

<table>
<thead>
<tr>
<th>Trunk Cards</th>
<th>MXP_2.5G_10G/ TXP_MR_10G</th>
<th>TXP_MR_2.5G/ TXPP_MR_2.5G</th>
<th>MXP_2.5G_10E/ TXP_MR_10E</th>
<th>32MUX-O</th>
<th>32DMX-O</th>
<th>AD-xC-xx.x</th>
<th>4MD-xx.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP_2.5G_10G/ TXP_MR_10G</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>TXP_MR_2.5G/ TXPP_MR_2.5G</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MXP_2.5G_10E/ TXP_MR_10E</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MXP_MR_2.5G/ MXPP_MR_2.5G</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>OC-192</td>
<td>Yes</td>
<td>—</td>
<td>Yes</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>OC-48</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>OC-192 ITU</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>OC-48 ITU</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Table 22-7 lists the supported card combinations for trunk-to-trunk ports in a patchcord.

Table 22-7 Cisco ONS 15454 Trunk/Trunk Card Combinations for Provisionable Patchcords

<table>
<thead>
<tr>
<th>Trunk Cards</th>
<th>MXP_2.5G_10G/ TXP_MR_10G</th>
<th>TXP_MR_2.5G/ TXPP_MR_2.5G</th>
<th>MXP_2.5G_10E/ TXP_MR_10E</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP_2.5G_10G/ TXP_MR_10G</td>
<td>Yes</td>
<td>—</td>
<td>Yes</td>
</tr>
<tr>
<td>TXP_MR_2.5G/ TXPP_MR_2.5G</td>
<td>—</td>
<td>Yes</td>
<td>—</td>
</tr>
<tr>
<td>MXP_2.5G_10E/ TXP_MR_10E</td>
<td>Yes</td>
<td>—</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Optical ports have the following requirements when used in a provisionable patchcord:

- An optical port connected to transponder/muxponder port or add/drop multiplexer or multiplexer/demultiplexer port requires section DCC/line DCC (SDCC/LDCC or RS-DCC/MS-DCC) termination.
- If the optical port is the protection port in a 1+1 group, the working port must have SDCC/LDCC or RS-DCC/MS-DCC termination provisioned.
- If the remote end of a patchcord is Y-cable protected or is an add/drop multiplexer or multiplexer/demultiplexer port, an optical port requires two patchcords.

Transponder and muxponder ports have the following requirements when used in a provisionable patchcord:

- Two patchcords are required when a transponder/muxponder port is connected to an add/drop multiplexer or multiplexer/demultiplexer port. CTC automatically prompts the user to set up the second patchcord.
- If a patchcord is on a client port in a regenerator group, the other end of the patchcord must be on the same node and on a port within the same regenerator group.
- A patchcord is allowed on a client port only if the card is in transparent mode.

DWDM cards support provisionable patchcords only on optical channel ports. Each DWDM optical channel port can have only one provisionable patchcord.

### 22.4 Routing Table

ONS 15454 routing information is displayed on the Maintenance > Routing Table tabs. The routing table provides the following information:

- Destination—Displays the IP address of the destination network or host.
- Mask—Displays the subnet mask used to reach the destination host or network.
- Gateway—Displays the IP address of the gateway used to reach the destination network or host.
- Usage—Shows the number of times the listed route has been used.
- Interface—Shows the ONS 15454 interface used to access the destination. Values are:
  - motfcc0—The ONS 15454 Ethernet interface, that is, the RJ-45 jack on the TCC2/TCC2P and, for ANSI shelves, the LAN 1 pins on the backplane or, for ETSI shelves, the LAN connection on the MIC-C/T/P.
  - pdcc0—An SDCC or RS-DCC interface, that is, an OC-N trunk card identified as the SDCC or RS-DCC termination.
  - lo0—A loopback interface.

Table 22-8 shows sample routing entries for an ONS 15454.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Destination</th>
<th>Mask</th>
<th>Gateway</th>
<th>Usage</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
<td>172.20.214.1</td>
<td>265103</td>
<td>motfcc0</td>
</tr>
<tr>
<td>2</td>
<td>172.20.214.0</td>
<td>255.255.255.0</td>
<td>172.20.214.92</td>
<td>0</td>
<td>motfcc0</td>
</tr>
<tr>
<td>3</td>
<td>172.20.214.92</td>
<td>255.255.255.255</td>
<td>127.0.0.1</td>
<td>54</td>
<td>lo0</td>
</tr>
</tbody>
</table>
Entry 1 shows the following:

- **Destination (0.0.0.0)** is the default route entry. All undefined destination network or host entries on this routing table are mapped to the default route entry.
- **Mask (0.0.0.0)** is always 0 for the default route.
- **Gateway (172.20.214.1)** is the default gateway address. All outbound traffic that cannot be found in this routing table or is not on the node’s local subnet is sent to this gateway.
- **Interface (motfcc0)** indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 2 shows the following:

- **Destination (172.20.214.0)** is the destination network IP address.
- **Mask (255.255.255.0)** is a 24-bit mask, meaning all addresses within the 172.20.214.0 subnet can be a destination.
- **Gateway (172.20.214.92)** is the gateway address. All outbound traffic belonging to this network is sent to this gateway.
- **Interface (motfcc0)** indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 3 shows the following:

- **Destination (172.20.214.92)** is the destination host IP address.
- **Mask (255.255.255.255)** is a 32-bit mask, meaning only the 172.20.214.92 address is a destination.
- **Gateway (127.0.0.1)** is a loopback address. The host directs network traffic to itself using this address.
- **Interface (lo0)** indicates that the local loopback interface is used to reach the gateway.

Entry 4 shows the following:

- **Destination (172.20.214.93)** is the destination host IP address.
- **Mask (255.255.255.255)** is a 32-bit mask, meaning only the 172.20.214.93 address is a destination.
- **Gateway (0.0.0.0)** means the destination host is directly attached to the node.
- **Interface (pdcc0)** indicates that a DCC interface is used to reach the destination host.

Entry 5 shows a DCC-connected node that is accessible through a node that is not directly connected:

- **Destination (172.20.214.94)** is the destination host IP address.
- **Mask (255.255.255.255)** is a 32-bit mask, meaning only the 172.20.214.94 address is a destination.
- **Gateway (172.20.214.93)** indicates that the destination host is accessed through a node with IP address 172.20.214.93.
- **Interface (pdcc0)** indicates that a DCC interface is used to reach the gateway.
### 22.5 External Firewalls

This section provides sample access control lists for external firewalls. Table 22-9 lists the ports that are used by the TCC2/TCC2P.

<table>
<thead>
<tr>
<th>Port</th>
<th>Function</th>
<th>Action¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Never used</td>
<td>D</td>
</tr>
<tr>
<td>20</td>
<td>FTP</td>
<td>D</td>
</tr>
<tr>
<td>21</td>
<td>FTP control</td>
<td>D</td>
</tr>
<tr>
<td>22</td>
<td>SSH</td>
<td>D</td>
</tr>
<tr>
<td>23</td>
<td>Telnet</td>
<td>D</td>
</tr>
<tr>
<td>80</td>
<td>HTTP</td>
<td>D</td>
</tr>
<tr>
<td>111</td>
<td>SUNRPC</td>
<td>NA</td>
</tr>
<tr>
<td>161</td>
<td>SNMP traps destinations</td>
<td>D</td>
</tr>
<tr>
<td>162</td>
<td>SNMP traps destinations</td>
<td>D</td>
</tr>
<tr>
<td>513</td>
<td>rlogin</td>
<td>D</td>
</tr>
<tr>
<td>683</td>
<td>CORBA IIOP</td>
<td>OK</td>
</tr>
<tr>
<td>1080</td>
<td>Proxy server (socks)</td>
<td>D</td>
</tr>
<tr>
<td>2001-2017</td>
<td>I/O card Telnet</td>
<td>D</td>
</tr>
<tr>
<td>2018</td>
<td>DCC processor on active TCC2/TCC2P</td>
<td>D</td>
</tr>
<tr>
<td>2361</td>
<td>TL1</td>
<td>D</td>
</tr>
<tr>
<td>3082</td>
<td>Raw TL1</td>
<td>D</td>
</tr>
<tr>
<td>3083</td>
<td>TL1</td>
<td>D</td>
</tr>
<tr>
<td>5001</td>
<td>BLSR server port</td>
<td>D</td>
</tr>
<tr>
<td>5002</td>
<td>BLSR client port</td>
<td>D</td>
</tr>
<tr>
<td>7200</td>
<td>SNMP alarm input port</td>
<td>D</td>
</tr>
<tr>
<td>9100</td>
<td>EQM port</td>
<td>D</td>
</tr>
<tr>
<td>9401</td>
<td>TCC boot port</td>
<td>D</td>
</tr>
<tr>
<td>9999</td>
<td>Flash manager</td>
<td>D</td>
</tr>
<tr>
<td>10240-12287</td>
<td>Proxy client</td>
<td>D</td>
</tr>
<tr>
<td>57790</td>
<td>Default TCC listener port</td>
<td>OK</td>
</tr>
</tbody>
</table>

1. D = deny, NA = not applicable, OK = do not deny

The following access control list (ACL) example shows a firewall configuration when the proxy server gateway setting is not enabled. In the example, the CTC workstation's address is 192.168.10.10, and the ONS 15454 address is 10.10.10.100. The firewall is attached to the GNE, so inbound is CTC to the GNE and outbound is from the GNE to CTC. The CTC Common Object Request Broker Architecture (CORBA) Standard constant is 683 and the TCC CORBA Default is TCC Fixed (57790).

```
access-list 100 remark *** Inbound ACL, CTC -> NE ***
access-list 100 remark
```
22.6 Open GNE

The ONS 15454 can communicate with non-ONS nodes that do not support Point-to-Point Protocol (PPP) vendor extensions or OSPF type 10 opaque link-state advertisements (LSA), both of which are necessary for automatic node and link discovery. An open GNE configuration allows a GCC-based network to function as an IP network for non-ONS nodes.

To configure an open GNE network, you can provision GCC terminations to include a far-end, non-ONS node using either the default IP address of 0.0.0.0 or a specified IP address. You provision a far-end, non-ONS node by checking the “Far End is Foreign” check box during GCC creation. The default 0.0.0.0 IP address allows the far-end, non-ONS node to identify itself with any IP address; if you set an IP address other than 0.0.0.0, a link is established only if the far-end node identifies itself with that IP address, providing an extra level of security.

By default, the proxy server only allows connections to discovered ONS peers and the firewall blocks all IP traffic between the GCC network and LAN. You can, however, provision proxy tunnels to allow up to 12 additional destinations for SOCKS version 5 connections to non-ONS nodes. You can also provision firewall tunnels to allow up to 12 additional destinations for direct IP connectivity between the GCC network and LAN. Proxy and firewall tunnels include both a source and destination subnet. The connection must originate within the source subnet and terminate within the destination subnet before
either the SOCKS connection or IP packet flow is allowed. A proxy connection is allowed if the CTC client is in a source subnet and the requested destination is in the destination subnet. Firewall tunnels allow IP traffic to route between the node Ethernet and pdcc interfaces. An inbound Ethernet packet is allowed through the firewall if its source address matches a tunnel source and its destination matches a tunnel destination. An inbound pdcc packet is allowed through the firewall if its source address matches a tunnel destination and its destination address matches a tunnel source. Tunnels only affect TCP and UDP packets.

The availability of proxy and/or firewall tunnels depends on the network access settings of the node:

- If the node is configured with the proxy server enabled in GNE or ENE mode, you must set up a proxy tunnel and/or a firewall tunnel.
- If the node is configured with the proxy server enabled in proxy-only mode, you can set up proxy tunnels. Firewall tunnels are not allowed.
- If the node is configured with the proxy server disabled, neither proxy tunnels or firewall tunnels are allowed.

Figure 22-17 shows an example of a foreign node connected to the GCC network. Proxy and firewall tunnels are useful in this example because the GNE would otherwise block IP access between the PC and the foreign node.
Figure 22-17  Proxy and Firewall Tunnels for Foreign Terminations

Remote CTC
10.10.20.10

Interface 0/0
10.10.20.1
Router A

Interface 0/1
10.10.10.1

ONS 15454
GNE
10.10.10.100/24

ONS 15454
ENE
10.10.10.150/24

ONS 15454
ENE
10.10.10.250/24

ONS 15454
ENE
10.10.10.200/24

Non-ONS node
Foreign NE
130.94.122.199/28

Local/Craft CTC
192.168.20.20

Figure 22-18 shows a remote node connected to an ENE Ethernet port. Proxy and firewall tunnels are useful in this example because the GNE would otherwise block IP access between the PC and foreign node. This configuration also requires a firewall tunnel on the ENE.
22.7 TCP/IP and OSI Networking

ONS 15454 DCN communication is based on the TCP/IP protocol suite. However, ONS 15454s can also be networked with equipment that uses the OSI protocol suite. While TCP/IP and OSI protocols are not directly compatible, they do have the same objectives and occupy similar layers of the OSI reference model. For detailed information about OSI protocols, processes, and scenarios, refer to the “Management Network Connectivity” chapter in the ONS 15454 Reference Manual. OSI/MSTP scenarios are provided in the following sections.

In OSI/MSTP Scenario 1 (Figure 22-19), an SDCC or RS-DCC carries an OC-N signal from an OSI-based third party NE to an TXP/MXP card on an ONS NE. It is carried by GCC to a TXP/MXP card on another MSTP NE and then by SDCC or RS-DCC to a second third party NE. This scenario requires TXPs/MXPs whose client interfaces can be provisioned in section or line termination mode. These include:

- TXP_MR_2.5 / TXPP_MR_2.5 (when equipped with OCn-N SFPs)
- TXP_MR_10G / TXP_MR_10E (when the client is configured as OC192)
- MXP_2.5_10G and MXP_2.5_10E
OSI has to be carried or tunnelled to the other TXP/MXP through an OSC termination, GCC termination, or both. The third party NMS has OSI connectivity to its NEs with the MSTP ONS NE serving as the GNE for third party vendor OSI-based SONET equipment.

**Figure 22-19  OSI/MSTP Scenario 1**

OSI/MSTP Scenario 2 (Figure 22-20) is similar to Scenario 1, except the MSTP NEs do not have connectivity to an OSI NMS.
OSI/MSTP Scenario 3 (Figure 22-21) shows the following:

- OSI is carried over an SDCC or RS-DCC termination.
- OSI has to be carried or tunnelled to the other peer TXP/MXP through an OSC termination, GCC termination, or both.
- An OSS has IP connectivity to all the NEs.
- The MSTP NE is a GNE for the third party OSI-based SONET NEs. the MSTP NEs perform all mediation functions.
OSI/MSTP Scenario 4 (Figure 22-22) shows the following:

- OSI is carried over an SDCC or RS-DCC termination.
- OSI has to be carried or tunnelled to the other peer TXP/MXP through an OSC termination, GCC termination, or both
- An OSS has IP connectivity to all the NEs through third party NE network
- The MSTP NE is a GNE for the third party OSI-based SONET NEs, the MSTP NEs perform all mediation functions.
- The third party vendor NE is a GNE for the Cisco MSTP network.
Figure 22-22  OSI/IP Scenario 4
Alarm Management Reference

This chapter describes Cisco Transport Controller (CTC) alarm management. To troubleshoot specific alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide (for DWDM alarms), the Cisco ONS 15454 Troubleshooting Guide (for ANSI shelves) or the Cisco ONS 15454 SDH Troubleshooting Guide (for ETSI shelves).

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

- 23.1 Overview, page 23-1
- 23.2 Alarm Counts on the LCD for a Node, Slot, or Port, page 23-2
- 23.3 Alarm Display, page 23-2
- 23.4 Alarm Severities, page 23-7
- 23.5 Alarm Profiles, page 23-7
- 23.6 Alarm Suppression, page 23-11
- 23.7 External Alarms and Controls, page 23-12

23.1 Overview

CTC detects and reports alarms generated by the Cisco ONS 15454 and the larger network. You can use CTC to monitor and manage alarms at the card, node, or network level. Default alarm severities conform to the Telcordia GR-253-CORE standard, but you can set alarm severities in customized alarm profiles or suppress CTC alarm reporting. For a detailed description of the standard Telcordia categories employed by Optical Networking System (ONS) nodes, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide.

Note

ONS 15454 alarms can also be monitored and managed through Transaction Language One (TL1) or a network management system (NMS).
23.2 Alarm Counts on the LCD for a Node, Slot, or Port

You can view node, slot, or port-level alarm counts and summaries using the buttons on the ONS 15454 LCD panel. The Slot and Port buttons toggle between display types; the Slot button toggles between node display and slot display, and the Port button toggles between slot and port views. Pressing the Status button after you choose the display mode changes the display from alarm count to alarm summary.

The ONS 15454 has a one-button update for some commonly viewed alarm counts. If you press the Slot button once and then wait eight seconds, the display automatically changes from a slot alarm count to a slot alarm summary. If you press the Port button to toggle to port-level display, you can use the Port button to toggle to a specific slot and to view each port’s port-level alarm count. Figure 23-1 shows the LCD panel layout.

Figure 23-1  Shelf LCD Panel

23.3 Alarm Display

In the card, node, or network CTC view, click the Alarms tab to display the alarms for that card, node, or network. The Alarms window shows alarms in compliance with Telcordia GR-253-CORE. This means that if a network problem causes two alarms, such as loss of frame (LOF) and loss of signal (LOS), CTC only shows the LOS alarm in this window because it supersedes the LOF and replaces it.

The Path Width column in the Alarms and Conditions tabs expands on the alarmed object information contained in the access identifier (AID) string (such as “STS-4-1-3”) by giving the number of STSs contained in the alarmed path. For example, the Path Width tells you whether a critical alarm applies to an STS1 or an STS48c. The column reports the width as a 1, 3, 6, 12, 48, etc. as appropriate, understood to be “STS-N.”

Table 8-1 on page 8-6 lists the column headings and the information recorded in each column and Table 8-2 on page 8-7 provides the color codes for alarm and condition severities.

For a list of circuits with raised alarms, see the “NTP-G66 View Alarm-Affected Circuits” procedure on page 8-14.

23.3.1 Viewing Alarms by Time Zone

By default, alarms and conditions are displayed with the time stamp of the CTC workstation where you are viewing them. However, you can set the node to report alarms (and conditions) using the time zone where the node is located. See the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-11 for instructions.
23.3.2 Controlling Alarm Display

You can control the display of the alarms shown on the Alarms window. Table 23-1 shows the actions you can perform in the Alarms window.

<table>
<thead>
<tr>
<th>Table 23-1</th>
<th>Alarm Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Button/Check Box/Tool</strong></td>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>Filter button</td>
<td>Allows you to change the display on the Alarms window to show only alarms that meet a certain severity level, occur in a specified time frame, or reflect specific conditions. For example, you can set the filter so that only critical alarms display in the window. If you enable the Filter feature by clicking the Filter button in one CTC view, such as node view, it is enabled in the others as well (card view and network view).</td>
</tr>
<tr>
<td>Synchronize button</td>
<td>Updates the alarm display. Although CTC displays alarms in real time, the Synchronize button allows you to verify the alarm display. This is particularly useful during provisioning or troubleshooting.</td>
</tr>
<tr>
<td>Delete Cleared Alarms button</td>
<td>Deletes alarms that have been cleared.</td>
</tr>
<tr>
<td>AutoDelete Cleared Alarms check box</td>
<td>If checked, CTC automatically deletes cleared alarms.</td>
</tr>
<tr>
<td>Filter tool</td>
<td>Enables or disables alarm filtering in the card, node, or network view. When enabled or disabled, this state applies to other views for that node and for all other nodes in the network. For example, if the Filter tool is enabled in the node (default login) view Alarms window, the network view Alarms window and card view Alarms window also show the tool enabled.</td>
</tr>
</tbody>
</table>

23.3.3 Filtering Alarms

The alarm display can be filtered to prevent the display of alarms with certain severities or alarms that occurred between certain dates. You can set the filtering parameters by clicking the Filter button at the bottom-left of the Alarms window. You can turn the filter on or off by clicking the Filter tool at the bottom-right of the window. CTC retains your filter activation setting. For example, if you turn the filter on and then log out, CTC keeps the filter active the next time you log in.

See the “NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering” procedure on page 8-25.

23.3.4 Conditions Tab

The Conditions window displays retrieved fault conditions. A condition is a fault or status detected by ONS 15454 hardware or software. When a condition occurs and continues for a minimum period, CTC raises a condition, which is a flag showing that this particular condition currently exists on the ONS 15454. See the “DLP-G120 View Conditions” task on page 8-12.

The Conditions window shows all conditions that occur, including those that are superseded. For instance, if a network problem causes two alarms, such as LOF and LOS, CTC shows both the LOF and LOS conditions in this window (even though LOS supersedes LOF). Having all conditions visible can
be helpful when troubleshooting the ONS 15454. If you want to retrieve conditions that obey a root-cause hierarchy (that is, LOS supersedes and replaces LOF), you can exclude the same root causes by checking a check box in the window.

Fault conditions include reported alarms and Not Reported or Not Alarmed conditions. Refer to the trouble notifications information in the *Cisco ONS 15454 DWDM Troubleshooting Guide*, the *Cisco ONS 15454 Troubleshooting Guide*, or the *Cisco ONS 15454 SDH Troubleshooting Guide* for more information about alarm and condition classifications.

### 23.3.5 Controlling the Conditions Display

You can control the display of the conditions on the Conditions window. Table 23-2 shows the actions you can perform in the window.

<table>
<thead>
<tr>
<th>Table 23-2</th>
<th>Conditions Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Button</strong></td>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>Retrieve</td>
<td>Retrieves the current set of all existing fault conditions, as maintained by the alarm manager, from the ONS 15454.</td>
</tr>
<tr>
<td>Filter</td>
<td>Allows you to change the Conditions window display to only show the conditions that meet a certain severity level or occur in a specified time frame. For example, you can set the filter so that only critical conditions display on the window. There is a Filter button on the lower-right of the window that allows you to enable or disable the filter feature.</td>
</tr>
<tr>
<td>Exclude Same Root Cause</td>
<td>Retrieves conditions that obey a root-cause hierarchy (LOS supersedes and replaces LOF).</td>
</tr>
</tbody>
</table>

### 23.3.5.1 Retrieving and Displaying Conditions

The current set of all existing conditions maintained by the alarm manager can be seen when you click the Retrieve button. The set of conditions retrieved is relative to the CTC view. For example, if you click the button while displaying the node view, node-specific conditions appear. If you click the button while displaying the network view, all conditions for the network (including ONS 15454 nodes and other connected nodes) appear, and the card view shows only card-specific conditions.

You can also set a node to display conditions using the time zone where the node is located, rather than the time zone of the PC where they are being viewed. See the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-11 for instructions.

### 23.3.5.2 Conditions Column Descriptions

Table 23-3 lists the Conditions window column headings and the information recorded in each column.

<table>
<thead>
<tr>
<th>Table 23-3</th>
<th>Conditions Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
<td><strong>Information Recorded</strong></td>
</tr>
<tr>
<td>Date</td>
<td>Date and time of the condition.</td>
</tr>
<tr>
<td>Object</td>
<td>TL1 AID for the condition object. For an STSmon or VTmon, the object.</td>
</tr>
</tbody>
</table>
23.3.6 Viewing History

The History window displays historic alarm or condition data for the node or for your login session. You can choose to display only alarm history, only events, or both by checking check boxes in the History > Node window. You can view network-level alarm and condition history, such as for circuits, at that level. At the node level, you can see all port (facility), card, STS, and system-level history entries. For example, protection-switching events or performance-monitoring threshold crossings appear here. If you double-click a card, you can view all port, card, and STS alarm or condition history that directly affects the card. See the “DLP-G116 View Alarm or Event History” task on page 8-8.

The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 640 minor alarm messages, and 640 condition messages. When any of these limits is reached, the ONS 15454 discards the oldest events in that category.

1. All alarms, their severities, and service-affecting statuses are also displayed in the Condition tab unless you choose to filter the alarm from the display using the Filter button.

### Table 23-3  Conditions Column Description (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Information Recorded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eqpt Type</td>
<td>Card type in this slot.</td>
</tr>
<tr>
<td>Slot</td>
<td>Slot where the condition occurred (appears only in network and node view).</td>
</tr>
<tr>
<td>Port</td>
<td>Port where the condition occurred. For STSTerm and VTTerm, the port refers to the upstream card it is partnered with.</td>
</tr>
<tr>
<td>Path Width</td>
<td>Width of the data path.</td>
</tr>
<tr>
<td>Sev1</td>
<td>Severity level: CR (Critical), MJ (Major), MN (Minor), NA (Not Alarmed), NR (Not Reported).</td>
</tr>
<tr>
<td>SA1</td>
<td>Indicates a service-affecting alarm (when checked).</td>
</tr>
<tr>
<td>Cond</td>
<td>The error message/alarm name; these names are alphabetically defined in the Cisco ONS 15454 DWDM Troubleshooting Guide, the Cisco ONS 15454 Troubleshooting Guide, or the Cisco ONS 15454 SDH Troubleshooting Guide.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the condition.</td>
</tr>
</tbody>
</table>

Note

In the Preference dialog General tab, the Maximum History Entries value only applies to the Session window.

Different views of CTC display different kinds of history:
23.3.6 Viewing History

- The History > Session window is shown in network view, node view, and card view. It shows alarms and conditions that occurred during the current user CTC session.
- The History > Node window is only shown in node view. It shows the alarms and conditions that occurred on the node since CTC software was operated on the node.
- The History > Card window is only shown in card view. It shows the alarms and conditions that occurred on the card since CTC software was installed on the node.

**Tip**

Double-click an alarm in the History window to display the corresponding view. For example, double-clicking a card alarm takes you to card view. In network view, double-clicking a node alarm takes you to node view.

If you check the History window Alarms check box, you display the node history of alarms. If you check the Events check box, you display the node history of Not Alarmed and transient events (conditions). If you check both check boxes, you retrieve node history for both.

### 23.3.6.1 History Column Descriptions

Table 23-4 lists the History window column headings and the information recorded in each column.

**Table 23-4 History Column Description**

<table>
<thead>
<tr>
<th>Column</th>
<th>Information Recorded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num</td>
<td>Num (number) is the quantity of alarm messages received, and is incremented automatically as alarms occur to display the current total of received error messages. (The column is hidden by default; to view it, right-click a column and choose Show Column.)</td>
</tr>
<tr>
<td>Ref</td>
<td>Ref (reference) is a unique identification number assigned to each alarm to reference a specific alarm message that is displayed. (The column is hidden by default; to view it, right-click a column and choose Show Column.)</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time of the condition.</td>
</tr>
<tr>
<td>Object</td>
<td>TL1 AID for the condition object. For an STSmon or VTmon, the object.</td>
</tr>
<tr>
<td>Slot</td>
<td>Slot where the condition occurred (only displays in network view and node view).</td>
</tr>
<tr>
<td>Port</td>
<td>Port where the condition occurred. For STSTerm and VTTerm, the port refers to the upstream card it is partnered with.</td>
</tr>
<tr>
<td>Path Width</td>
<td>Width of the data path.</td>
</tr>
<tr>
<td>Sev</td>
<td>Severity level: Critical (CR), Major (MJ), Minor (MN), Not Alarmed (NA), Not Reported (NR).</td>
</tr>
<tr>
<td>ST</td>
<td>Status: raised (R), cleared (C), or transient (T).</td>
</tr>
<tr>
<td>SA</td>
<td>Indicates a service-affecting alarm (when checked).</td>
</tr>
<tr>
<td>Cond</td>
<td>Condition name.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the condition.</td>
</tr>
<tr>
<td>Eqpt Type</td>
<td>Card type in this slot.</td>
</tr>
</tbody>
</table>
Chapter 23      Alarm Management Reference

23.3.6.2 Retrieving and Displaying Alarm and Condition History

You can retrieve and view the history of alarms and conditions, including transient conditions (passing notifications of processes as they occur) in the CTC History window. The information in this window is specific to the view where it is shown (that is, network history in the network view, node history in the node view, and card history in the card view).

The node and card history views are each divided into two tabs. In node view, when you click the Retrieve button, you can see the history of alarms, conditions, and transients that have occurred on the node in the History > Node window, and the history of alarms, conditions, and transients that have occurred on the node during your login session in the History > Session window. In the card-view history window, after you retrieve the card history, you can see the history of alarms, conditions, and transients that have occurred during your login session in the History > Session window. You can also filter the severities and occurrence period in these history windows.

23.4 Alarm Severities

ONS 15454 alarm severities follow the Telcordia GR-253-CORE standard, so a condition might be Alarmed (at a severity of Critical [CR], Major [MJ], or Minor [MN]), Not Alarmed (NA), or Not Reported (NR). These severities are reported in the CTC software Alarms, Conditions, and History windows at all levels: network, shelf, and card.

ONS equipment provides a standard profile named Default listing all alarms and conditions with severity settings based on Telcordia GR-253-CORE and other standards, but users can create their own profiles with different settings for some or all conditions and apply these wherever desired. (See the “23.5 Alarm Profiles” section on page 23-7.) For example, in a custom alarm profile, the default severity of a carrier loss (CARLOSS) alarm on an Ethernet port could be changed from major to critical. The profile allows setting to Not Reported or Not Alarmed, as well as the three alarmed severities. Critical and Major severities are only used for service-affecting alarms. If a condition is set as Critical or Major by profile, it will raise as Minor alarm in the following situations:

- In a protection group, if the alarm is on a standby entity (the side not carrying traffic)
- If the alarmed entity has no traffic provisioned on it, no service is lost

Because of this possibility of being raised at two different levels, the alarm profile pane shows Critical as CR / MN and Major as MJ / MN.

23.5 Alarm Profiles

The alarm profiles feature allows you to change default alarm severities by creating unique alarm profiles for individual ONS 15454 ports, cards, or nodes. A created alarm profile can be applied to any node on the network. Alarm profiles can be saved to a file and imported elsewhere in the network, but the profile must be stored locally on a node before it can be applied to the node, its cards, or its cards’ ports.

CTC can store up to ten active alarm profiles at any time to apply to the node. Custom profiles can take eight of these active profile positions. Two other profiles, Default profile and Inherited profile, are reserved by the NE, and cannot be edited. The reserved Default profile contains Telcordia GR-253-CORE severities. The reserved Inherited profile allows port alarm severities to be governed by the card-level severities, or card alarm severities to be determined by the node-level severities.
23.5.1 Creating and Modifying Alarm Profiles

Alarm profiles are created in the network view using the Provisioning > Alarm Profiles tabs. **Figure 23-2** shows the default list of alarm severities. A default alarm severity following Telcordia GR-253-CORE standards is preprovisioned for every alarm. After loading the default profile or another profile on the node, you can clone a profile to create custom profiles. After the new profile is created, the Alarm Profiles window shows the original profile (frequently Default) and the new profile.

**Figure 23-2  Network View Alarm Profiles Window**

---

**Note**  
The alarm profile list contains a master list of alarms that is used for a mixed node network. Some of these alarms might not be used in all ONS nodes.

**Note**  
The Default alarm profile list contains alarm and condition severities that correspond when applicable to default values established in Telcordia GR-253-CORE.

**Note**  
All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to Minor (MN) in non-service-affecting situations as defined in Telcordia GR-474.
23.5.2 Alarm Profile Buttons

To see the full list of profiles, including those available for loading or cloning, click the Available button. You must load a profile before you can clone it.

Tip

Up to 10 profiles, including the two reserved profiles (Inherited and Default) can be stored in CTC.

Note

Wherever it is applied, the Default alarm profile sets severities to standard Telcordia GR-253-CORE settings. In the Inherited profile, alarms inherit, or copy, severity from the next-highest level. For example, a card with an Inherited alarm profile copies the severities used by the node housing the card. If you choose the Inherited profile from the network view, the severities at the lower levels (node and card) are copied from this selection.

You do not have to apply a single severity profile to the node-, card-, and port-level alarms. Different profiles can be applied at different levels. You could use the inherited or default profile on a node and on all cards and ports, but apply a custom profile that downgrades an alarm on one particular card. For example, you might choose to downgrade an OC-N unequipped path alarm (UNEQ-P) from Critical (CR) to Not Alarmed (NA) on an optical card because this alarm raises and then clears every time you create a circuit. UNEQ-P alarms for the card with the custom profile would not display on the Alarms tab (but they would still be recorded on the Conditions and History tabs.)

When you modify severities in an alarm profile:

- All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474.
- Default severities are used for all alarms and conditions until you create a new profile and apply it.

The Load and Store buttons are not available for Retrieve and Maintenance users.

The Delete and Store options will only display nodes to delete profiles from or store profiles to if the user has provisioning permission for those nodes. If the user does not have the proper permissions, CTC greys out the buttons and they are not available to the user.

23.5.2 Alarm Profile Buttons

The Alarm Profiles window displays six buttons at the bottom of the screen. Table 23-5 lists and describes each of the alarm profile buttons and their functions.

Table 23-5 Alarm Profile Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new profile.</td>
</tr>
<tr>
<td>Load</td>
<td>Loads a profile to a node or a file.</td>
</tr>
<tr>
<td>Store</td>
<td>Saves profiles on a node (or nodes) or in a file.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes profiles from a node.</td>
</tr>
<tr>
<td>Compare</td>
<td>Displays differences between alarm profiles (for example, individual alarms that are not configured equivalently between profiles).</td>
</tr>
<tr>
<td>Available</td>
<td>Displays all profiles available on each node.</td>
</tr>
<tr>
<td>Usage</td>
<td>Displays all entities (nodes and alarm subjects) present in the network and which profiles contain the alarm. Can be printed.</td>
</tr>
</tbody>
</table>
23.5.3 Alarm Profile Editing

Table 23-6 lists and describes the five profile-editing options available when you right-click an alarm item in the profile column (such as Default).

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store</td>
<td>Saves a profile in a node or in a file.</td>
</tr>
<tr>
<td>Rename</td>
<td>Changes a profile name.</td>
</tr>
<tr>
<td>Clone</td>
<td>Creates a profile that contains the same alarm severity settings as the profile being cloned.</td>
</tr>
<tr>
<td>Reset</td>
<td>Restores a profile to its previous state or to the original state (if it has not yet been applied).</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a profile from the table editor.</td>
</tr>
</tbody>
</table>

23.5.4 Alarm Severity Options

To change or assign alarm severity, left-click the alarm severity you want to change in the alarm profile column. Seven severity levels appear for the alarm:

- Not Reported (NR)
- Not Alarmed (NA)
- Minor (MN)
- Major (MJ)
- Critical (CR)
- Use Default
- Inherited

Inherited and Use Default severity levels only appear in alarm profiles. They do not appear when you view alarms, history, or conditions.

23.5.5 Row Display Options

In the network or node view, the Alarm Profiles window (Alarm Profile Editor for Node view) displays three check boxes at the bottom of the window:

- Only show service-affecting severities—If unchecked, the editor shows severities in the format sev1/sev2 where sev1 is a service-affecting severity and sev2 is not service-affecting. If checked, the editor only shows sev1 alarms.
- Hide reference values—Highlights alarms with nondefault severities by clearing alarm cells with default severities.
- Hide identical rows—Hides rows of alarms that contain the same severity for each profile.
23.5.6 Applying Alarm Profiles

In CTC node view, the Alarm Behavior window displays alarm profiles for the node. In card view, the Alarm Behavior window displays the alarm profiles for the selected card. Alarm profiles form a hierarchy. A node-level alarm profile applies to all cards in the node except cards that have their own profiles. A card-level alarm profile applies to all ports on the card except ports that have their own profiles.

At the node level, you can apply profile changes on a card-by-card basis or set a profile for the entire node. At the card-level view, you can apply profile changes on a port-by-port basis or set alarm profiles for all ports on that card. Figure 23-3 shows alarm profiles for an OPT-BST card.

Figure 23-3  OPT-BST Card Alarm Profiles

23.6 Alarm Suppression

ONS 15454 nodes have an alarm suppression option that clears raised alarm messages for the node, chassis, one or more slots (cards), or one or more ports. After they are cleared, these alarms change appearance from their normal severity color to white and they can be cleared from the display by clicking Synchronize. Alarm suppression itself raises an alarm called AS-CMD that is shown in applicable Alarms windows. Node-level suppression is shown in the node view Alarms window, and card or port-level suppression is shown in all views. The AS-CMD alarm itself is not cleared by the suppress command. Each instance of this alarm indicates its object separately in the Object column.

A suppression command applied at a higher level does not supersede a command applied at a lower level. For example, applying a node-level alarm suppression command makes all raised alarms for the node appear to be cleared, but it does not cancel out card-level or port-level suppression. Each of these conditions can exist independently and must be cleared independently.
23.7 External Alarms and Controls

Suppression causes the entity alarm to behave like a Not Reported event. This means that the alarms, having been suppressed from view in the Alarms window, are now only shown in the Conditions window. The suppressed alarms are displayed with their usual visual characteristics (service-affecting status and color-coding) in the window. The alarms still appear in the History window.

See the “NTP-G70 Suppress Alarms or Discontinue Alarm Suppression” procedure on page 8-29.

**Note**
Use alarm suppression with caution. If multiple CTC or TL1 sessions are open, suppressing the alarms in one session suppresses the alarms in all other open sessions.

### 23.7 External Alarms and Controls

External alarm inputs can be provisioned on the Alarm Interface Controller–International (AIC-I) card for external sensors such as an open door and flood sensors, temperature sensors, and other environmental conditions. External control outputs on these two cards allow you to drive external visual or audible devices such as bells and lights. They can control other devices such as generators, heaters, and fans.

Up to 12 external alarm inputs and four external controls are available with the AIC-I card. If you also provision the alarm extension panel (AEP), there are 32 inputs and 16 outputs. The AEP is compatible with the ONS 15454 ANSI shelf only. It is not compatible with the ONS 15454 ETSI shelf.

See the “NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International Card” procedure on page 8-32.

#### 23.7.1 External Alarms

You can provision each alarm input separately. Provisionable characteristics of external alarm inputs include:

- **Alarm Type**—List of alarm types.
- **Severity**—CR, MJ, MN, NA, and NR.
- **Virtual Wire**—The virtual wire associated with the alarm.
- **Raised When**—Open means that the normal condition is no current flowing through the contact, and the alarm is generated when current does flow; closed means that normal condition is to have current flowing through the contact, and the alarm is generated when current stops flowing.
- **Description**—CTC alarm log description (up to 63 characters).

**Note**
If you provision an external alarm to raise when a contact is open, and you have not attached the alarm cable, the alarm will remain raised until the alarm cable is connected.

**Note**
When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to the external alarm’s number, regardless of the name you assign.
23.7.2 External Controls

You can provision each alarm output separately. Provisionable characteristics of alarm outputs include:

- Control type.
- Trigger type (alarm or virtual wire).
- Description for CTC display.
- Closure setting (manually or by trigger). If you provision the output closure to be triggered, the following characteristics can be used as triggers:
  - Local NE alarm severity—A chosen alarm severity (for example, major) and any higher-severity alarm (in this case, critical) causes output closure.
  - Remote NE alarm severity—Similar to local NE alarm severity trigger setting, but applies to remote alarms.
  - Virtual wire entities—You can provision an alarm that is input to a virtual wire to trigger an external control output.

23.7.3 Virtual Wires

Provisioning the AIC and AIC-I card provides a “virtual wires” option used to route external alarms and controls from different nodes to one or more alarm collection centers. In Figure 23-4, smoke detectors at Nodes 1, 2, 3, and 4 are assigned to Virtual Wire #1, and Virtual Wire #1 is provisioned as the trigger for an external bell at Node 1.
23.7.3 Virtual Wires

Figure 23-4  *External Alarms and Controls Using a Virtual Wire*

When using AIC virtual wires, you can:

- Assign different external devices to the same virtual wire.
- Assign virtual wires as the trigger type for different external controls.
CTC Information and Shortcuts

Note
The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path protection feature, which may be used in any topological network configuration. Cisco does not recommend using its path protection feature in any particular topological network configuration.

This appendix describes the Cisco Transport Controller (CTC) views, menus options, tool options, shortcuts, and table display options. This appendix also describes the shelf inventory data presented in CTC. For more information about CTC, see Chapter 19, “CTC Operation Reference.”

Note
Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

A.1 Display Node, Card, and Network Views

CTC provides three views of the ONS 15454 and the ONS network:

- Node view appears when you first log into an ONS 15454. This view shows a graphic of the ONS 15454 shelf and provides access to tabs and subtabs that you use to manage the node.
- Card view provides access to individual ONS 15454 cards. This view provides a graphic of the card and provides access to tabs and subtabs that you use to manage the card.
- Network view shows all the nodes in a ring. A Superuser can set up this feature so each user will see the same network view, or the user can create a custom view with maps. This view provides access to tabs and subtabs that you use to manage the network.

Table A-1 lists different actions for changing CTC views.
Table A-1  Change CTC Views

<table>
<thead>
<tr>
<th>To Display</th>
<th>Perform One of the Following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node view</td>
<td>• Log into a node; node view is the default view.</td>
</tr>
<tr>
<td></td>
<td>• In network view, double-click a node icon, or right-click the node and choose Open Node from the shortcut menu.</td>
</tr>
<tr>
<td></td>
<td>• In network view, single-click a node icon, then choose Go To Selected Object View from the View menu.</td>
</tr>
<tr>
<td></td>
<td>• From the View menu, choose Go To Other Node, then choose the node you want from the shortcut menu.</td>
</tr>
<tr>
<td></td>
<td>• Use the arrows on the CTC toolbar to navigate up or down views. For example, in network view, click a node, then click the down arrow.</td>
</tr>
<tr>
<td>Network view</td>
<td>• In node view, click the up arrow or the Network View tool on the CTC toolbar.</td>
</tr>
<tr>
<td></td>
<td>• From the View menu, choose Go To Network View.</td>
</tr>
<tr>
<td>Card view</td>
<td>• In node view, double-click a card or right-click the card and choose Open Card.</td>
</tr>
<tr>
<td></td>
<td>• In node view, single-click a card icon, then choose Go To Selected Object View from the View menu.</td>
</tr>
<tr>
<td></td>
<td>• Use the arrows on the CTC toolbar to navigate up or down views. For example, in node view, click a card, then click the down arrow.</td>
</tr>
</tbody>
</table>

A.1.1 Node Icons on the Network View Map

Table A-2 lists the node icons on the network view map.
### Description of Node Icons on Network View Map

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SONET</td>
<td><img src="image" alt="icon" /></td>
<td>A SONET, SDH, hybrid, or amplified time-division multiplexing (TDM) node icon is represented as a cylinder with crossed arrows.</td>
</tr>
<tr>
<td>SDH</td>
<td></td>
<td>- A SONET or SDH node can include OC-N cards, electrical cards, cross-connects, Storage Access Management (SAM) cards, and Ethernet cards.</td>
</tr>
<tr>
<td>Hybrid OADM</td>
<td></td>
<td>- A hybrid optical add/drop multiplexing (OADM) node contains at least one Channel OADM (AD-xC-xx.x) or one Band OADM (AD-xB-xx.x) card and two Advanced Timing, Communications, and Controller (TCC2/TCC2P) cards. TDM cards can be installed in any available slot.</td>
</tr>
<tr>
<td>Hybrid line amplifier</td>
<td></td>
<td>- A hybrid line amplifier node contains amplifiers and both TDM and dense wavelength division multiplexing (DWDM) cards.</td>
</tr>
<tr>
<td>Hybrid terminal</td>
<td></td>
<td>- A hybrid terminal node contains at least one 32-Channel Multiplexer (32MUX-O) card, one Double-Slot 32-Channel Demultiplexer (32DMX-O) card, amplifiers, two TCC2/TCC2P cards, and TDM cards.</td>
</tr>
<tr>
<td>Passive hybrid terminal</td>
<td></td>
<td>- A passive hybrid terminal node has the same equipment as the hybrid terminal node, but does not contain amplifiers.</td>
</tr>
<tr>
<td>Amplified TDM</td>
<td><img src="image" alt="icon" /></td>
<td>- An amplified TDM node is a node that increases the span length between two ONS 15454 nodes that contain TDM cards and optical amplifiers. Amplified TDM nodes contain either Optical Booster (OPT-BST) amplifiers or AD-1C cards.</td>
</tr>
<tr>
<td>Hub</td>
<td><img src="image" alt="icon" /></td>
<td>A DWDM hub node icon is represented as a three-dimensional cylinder with amplifiers. A hub node contains at least two 32DMX or 32DMX-O cards and two 32MUX-O. No OADM cards are provisioned.</td>
</tr>
<tr>
<td>OADM</td>
<td><img src="image" alt="icon" /></td>
<td>A DWDM OADM node icon is represented as a three-dimensional cylinder with arrows. An OADM node contains at least one AD-xC-xx.x or one AD-xB-xx.x. No 32MUX-O, 32DMX-O, or 32DMX cards are provisioned.</td>
</tr>
<tr>
<td>ROADM</td>
<td><img src="image" alt="icon" /></td>
<td>A reconfigurable OADM (ROADM) node icon is represented as a three-dimensional cylinder with two amplifier symbols that have arrows between them. An ROADM node contains at least one 32-channel Wavelength Selective Switch (32WSS). A single-slot 32DMX or double-slot 32DMX-O can be installed, but is not required. Transponders (TXPs) and muxponders (MXPs) can be installed in Slots 6 and 12. If amplification is not used, TXPs or MXPs can be installed in Slots 1 and 17. If OPT-BSTs are not installed, Optical Service Channel and Combiner/Separator Module (OSC-CSM) cards are installed in Slots 2 and 16 and Slots 8 and 10 are empty.</td>
</tr>
</tbody>
</table>
A.2 Manage the CTC Window

Different navigational methods are available within the CTC window to access views and perform management actions. You can double-click and right-click objects in the graphic area and move the mouse over nodes, cards, and ports to view popup status information.

A.2.1 CTC Menu and Toolbar Options

The CTC window menu bar and toolbar provide primary CTC functions. Table A-3 shows the actions that are available from the CTC menu and toolbar.

### Table A-2 Description of Node Icons on Network View Map (continued)

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Terminal (west)            | ![Icon](image) | A terminal (west) node is represented as a three-dimensional cylinder with one amplifier on the west side of the icon.  
  - A terminal node contains one 32DMX or 32DMX-O and one 32-MUX-O. No OADM cards are provisioned.  
  - A flexible terminal node contains a series of OADM and amplifier cards. |
| Terminal (east)            | ![Icon](image) | A terminal (east) node is represented as a three-dimensional square with one amplifier on the east side of the icon.  
  - A terminal node contains one 32DMX or 32DMX-O and one 32MUX-O. No OADM cards are provisioned.  
  - A flexible terminal node contains a series of OADM and amplifier cards. |
| Line OSC regeneration line | ![Icon](image) | Line and OSC regeneration line nodes are represented as a three-dimensional cylinder with one arrow pointing west and another arrow pointing east.  
  - A line node has only Optical Preamplifier (OPT-PRE) or OPT-BST amplifiers provisioned.  
  - An optical service channel (OSC) regeneration line node contains two OSC-CSM cards. |
| Unknown                    | ![Icon](image) | An unknown DWDM node icon is represented as a three-dimensional cylinder with one arrow pointing north. An unknown node means that the provisioned cards do not allow the node to fit any of the defined DWDM node categories. |
### Table A-3  CTC Menu and Toolbar Options

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Add Node</td>
<td>![Add Node]</td>
<td>Adds a node to the current session. See the “DLP-G49 Add a Node to the Current Session or Login Group” task on page 2-30.</td>
</tr>
<tr>
<td></td>
<td>Delete Selected Node</td>
<td>![Delete Selected Node]</td>
<td>Deletes a node from the current session.</td>
</tr>
<tr>
<td></td>
<td>Lock CTC</td>
<td>![Lock CTC]</td>
<td>Locks CTC without closing the CTC session. A user name and password are required to open CTC.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>![Print]</td>
<td>Prints CTC data. See the “DLP-G113 Print CTC Data” task on page 8-2.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>![Export]</td>
<td>Exports CTC data. See the “DLP-G114 Export CTC Data” task on page 8-4.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>![Exit]</td>
<td>Closes the CTC session.</td>
</tr>
<tr>
<td>Edit</td>
<td>Preferences</td>
<td>![Preferences]</td>
<td>Displays the Preferences dialog box, which shows the following tabs:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• General—Allows you to change event defaults and manage preferences.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Login Node Groups—Allows you to create login node groups. See the “DLP-G48 Create Login Node Groups” task on page 2-28.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Map—Allows you to customize the network view. See the “DLP-G168 Change the Network View Background Color” task on page 10-26 and the “DLP-G170 Apply a Custom Network View Background Map” task on page 10-28.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Circuit—Allows you to change the color of circuit spans. This task is not applicable on DWDM-only nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Firewall—Sets the Internet Inter-ORB Protocol (IIOP) listener ports for access to the ONS 15454 through a firewall. See the “NTP-G27 Set Up the ONS 15454 for Firewall Access” procedure on page 3-23.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• JRE—Allows you to select another Java Runtime Environment (JRE) version. See the “DLP-G52 Change the JRE Version” task on page 2-31.</td>
</tr>
</tbody>
</table>
### A.2.1 CTC Menu and Toolbar Options

#### CTC Menu and Toolbar Options (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Go To Previous View</td>
<td><img src="image" alt="Go to Previous View" /></td>
<td>Displays the previous CTC view.</td>
</tr>
<tr>
<td></td>
<td>Go To Next View</td>
<td><img src="image" alt="Go to Next View" /></td>
<td>Displays the next CTC view. Available only after you navigate to a previous view. Go to Previous View and Go to Next View are similar to forward and backward navigation in a web browser.</td>
</tr>
<tr>
<td></td>
<td>Go To Parent View</td>
<td><img src="image" alt="Go to Parent View" /></td>
<td>References the CTC view hierarchy: network view, node view, and card view. In card view, this command displays the node view; in node view, the command displays network view. Not available in network view.</td>
</tr>
<tr>
<td></td>
<td>Go To Selected Object View</td>
<td><img src="image" alt="Go to Selected Object View" /></td>
<td>Displays the object selected in the CTC window.</td>
</tr>
<tr>
<td></td>
<td>Go To Home View</td>
<td><img src="image" alt="Go to Home View" /></td>
<td>Displays the login node in node view.</td>
</tr>
<tr>
<td></td>
<td>Go To Network View</td>
<td><img src="image" alt="Go to Network View" /></td>
<td>Displays the network view.</td>
</tr>
<tr>
<td></td>
<td>Go To Other Node</td>
<td><img src="image" alt="Go to Other Node" /></td>
<td>Displays a dialog box allowing you to type in the node name or IP address of a network node that you want to view.</td>
</tr>
<tr>
<td></td>
<td>Show Status Bar</td>
<td>—</td>
<td>Click this item to display or hide the status bar at the bottom of the CTC window.</td>
</tr>
<tr>
<td></td>
<td>Show Tool Bar</td>
<td>—</td>
<td>Click this item to display or hide the CTC toolbar.</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td><img src="image" alt="Zoom out" /></td>
<td>Zooms out the network view area (toolbar only).</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td><img src="image" alt="Zoom in" /></td>
<td>Zooms in the network view area (toolbar only).</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td><img src="image" alt="Zoom in selected area" /></td>
<td>Zooms in a selected network view area (toolbar only).</td>
</tr>
</tbody>
</table>
### Table A-3  CTC Menu and Toolbar Options (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools Circuits</td>
<td>—</td>
<td>—</td>
<td>Displays the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Repair Circuits—Repairs incomplete circuits following replacement of the ONS 15454 alarm interface panel (AIP). Refer to the <em>Cisco ONS 15454 SONET and DWDM Troubleshooting Guide</em> or the <em>Cisco ONS 15454 SDH Troubleshooting Guide</em> for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Reconfigure Circuits—Allows you to reconfigure circuits. Not applicable to DWDM nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Set Path Selector Attributes—Allows you to edit path protection or subnetwork connection protection (SNCP) circuit path selector attributes. Not applicable on DWDM nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Set Circuit State—Allows you to change a circuit state. Not applicable on DWDM nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Roll Circuit—Allows you to reroute live traffic without interrupting service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Delete Rolls —Removes rolls that are not deleted by CTC after a roll has been completed.</td>
</tr>
<tr>
<td>Overhead Circuits</td>
<td>—</td>
<td>—</td>
<td>Displays the Repair IP Tunnels option, which fixes circuits that are in the PARTIAL status as a result of node IP address changes. See the “DLP-G111 Repair an IP Tunnel” task on page 7-21.</td>
</tr>
<tr>
<td>Topology Upgrade</td>
<td>—</td>
<td>—</td>
<td>Displays the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Convert path protection (or SNCP) to BLSR (or MS-SPRing)—Converts a path protection to a bidirectional line switch ring (BLSR). Not applicable to DWDM nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Convert Unprotected to path protection (or SNCP)—Converts a point-to-point or linear add/drop multiplexer (ADM) to path protection. Not applicable to DWDM nodes.</td>
</tr>
<tr>
<td>Manage VLANs</td>
<td>—</td>
<td>—</td>
<td>Displays a list of VLANs that have been created and allows you to delete VLANs. Not applicable to DWDM nodes.</td>
</tr>
<tr>
<td>Open TL1 Connection</td>
<td>—</td>
<td>—</td>
<td>Displays the TL1 session dialog box so you can create a TL1 session to a specific node. Refer to the <em>Cisco ONS SONET TL1 Reference Guide</em> and the <em>Cisco ONS 15454 SDH TL1 Reference Guide</em>.</td>
</tr>
<tr>
<td>Open IOS Connection</td>
<td>—</td>
<td>—</td>
<td>Displays the Cisco IOS command line interface dialog box if a Cisco IOS capable card (ML1000-2, ML100T-12, or ML-100X-8) is installed in the node. Not applicable to DWDM nodes.</td>
</tr>
<tr>
<td>Help</td>
<td>Contents and Index</td>
<td>—</td>
<td>Displays the online help window.</td>
</tr>
<tr>
<td></td>
<td>User Manuals</td>
<td>—</td>
<td>Displays the Cisco ONS 15454 documentation.</td>
</tr>
<tr>
<td></td>
<td>About CTC</td>
<td>—</td>
<td>Displays the software version and the nodes in the CTC session.</td>
</tr>
</tbody>
</table>
A.2.2 CTC Mouse Options

In addition to the CTC menu bar and toolbar, you can invoke actions by double-clicking CTC window items with your mouse, or by right-clicking an item and selecting actions from shortcut menus. 

Table A-4 lists the CTC window mouse shortcuts.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Scope</td>
<td>Displays the selected network scope. The network scope drop-down list has three options: DWDM, TDM, or All. If you choose DWDM, DWDM and hybrid nodes appear on the network view map. If you choose TDM, TDM and hybrid nodes appear on the network view map. If you choose All, every node on the network appears on the network view map.</td>
</tr>
<tr>
<td>—</td>
<td>Opens the CTC Alerts dialog box, which shows the status of certain CTC background tasks. When the CTC Alerts toolbar icon contains a red triangle, unread notifications exist. When there are no unread notifications, the CTC Alerts toolbar icon contains a gray triangle (see the icons in the Toolbar column for comparison). Notifications include:</td>
</tr>
<tr>
<td></td>
<td>• Network disconnection.</td>
</tr>
<tr>
<td></td>
<td>• Send-PDIP inconsistency—CTC discovers a new node that does not have a SEND-PDIP setting consistent with the login node.</td>
</tr>
<tr>
<td></td>
<td>• Circuit deletion status—Reports when the circuit deletion process completes if you chose “Notify when complete” as described in the “NTP-G61 Modify and Delete Overhead Circuits” procedure on page 7-21. The CTC Alerts window always reports circuit deletion errors.</td>
</tr>
<tr>
<td></td>
<td>• Conditions retrieval error.</td>
</tr>
<tr>
<td></td>
<td>• Software download failure.</td>
</tr>
</tbody>
</table>

You can save a notification by clicking the Save button in the CTC Alerts dialog box and navigating to the directory where you want to save the text file. 

By default, the CTC Alerts dialog box appears automatically. To disable automatic popup, see the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-32.
### Table A-4  CTC Window Mouse Shortcuts

<table>
<thead>
<tr>
<th>Technique</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Double-click** | • Node in network view—Displays the node view.  
• Card in node view—Displays the card view.  
• Alarm/Event—Displays the object that raised the alarm or event.  
• Circuits—Displays the Edit Circuit window. |
| **Right-click**  | • Network view graphic area—Displays a menu that you can use to create a new domain; change the position and zoom level of the graphic image; save the map layout (if you have a Superuser security level); reset the default layout of the network view; set, change, or remove the background image and color; and save or reset the node position.  
• Node in network view—Displays a menu that you can use to open the node, reset the node icon position to the longitude and latitude set on the Provisioning > General tab, delete the node, fix the node position for automatic layout, provision circuits, provision channels, and update circuits or channels with a new node.  
• Span in network view—Displays a menu that you can use to view information about the span’s source and destination ports, the protection scheme, and the optical or electrical level.  
• Card in node view—Displays a menu that you can use to open, delete, reset, and change cards. The card that you choose determines the commands that appear.  
• Card in card view—Displays a menu that you can use to reset the card, or go to the parent view (node view).  
• Empty slot in node view—Displays a menu with cards that you can choose to preprovision the slot. |
| **Move mouse cursor** | • Over node in network view—Displays a summary of node alarms and provides a warning if the node icon has been moved out of the map range.  
• Over span in network view—Displays circuit (node, slot, port) bandwidth and protection information. For DWDM spans, the optical direction and optical ring ID appear. If the span terminates on the trunk port of a transponder card (TXP or MXP), the associated DWDM wavelength also appears.  
• Over card in node view—Displays card type, card status, alarm profile status and, depending on the DWDM card type, number of bands or channels.  
• Over card port in node view—Displays card name, port state, and alarm profile status.  
• Over card port in card view—Displays port state and alarm profile status. For DWDM cards, the port number is labeled as channel, band, or line depending on the card type along with the port state and alarm profile status. |
A.2.3 Node View Shortcuts

Table A-5 shows actions on ONS 15454 cards that you can perform by moving your mouse over the CTC window.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display card information</td>
<td>In node view, move your mouse over cards in the graphic to display tool tips with the card type, card status (active or standby), the highest level of alarm (if any), and the alarm profile used by the card.</td>
</tr>
<tr>
<td>Open, reset, or delete a card</td>
<td>In node view, right-click a card. Choose Open Card to display the card in card view, Delete Card to delete it, or Reset Card to reset the card.</td>
</tr>
<tr>
<td>Preprovision a slot</td>
<td>In node view, right-click an empty slot. Choose the card type for which you want to provision the slot from the shortcut menu.</td>
</tr>
<tr>
<td>Change a card</td>
<td>In node view, right-click an OC-N card or a DS3 card, and choose Change Card. In the Change Card dialog box, choose the card type. Change Card retains all card provisioning, including data communications channel (DCC) terminations, protection, circuits, and ring.</td>
</tr>
</tbody>
</table>

A.2.4 Network View Tasks

Right-click the network view graphic area or a node, span, or domain to display shortcut menus. Table A-6 lists the actions that are available from the network view.

<table>
<thead>
<tr>
<th>Action</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a node</td>
<td>Any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Double-click a node icon.</td>
</tr>
<tr>
<td></td>
<td>• Right-click a node icon and choose Open Node from the shortcut menu.</td>
</tr>
<tr>
<td></td>
<td>• Click a node and choose Go To Selected Object View from the View menu.</td>
</tr>
<tr>
<td></td>
<td>• From the View menu, choose Go To Other Node. Choose a node from the Select Node dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Double-click a node alarm or event in the Alarms or History tab.</td>
</tr>
<tr>
<td>Move a node icon</td>
<td>Press the Ctrl key and the left mouse button simultaneously and drag the node icon to a new location.</td>
</tr>
<tr>
<td>Reset node icon position</td>
<td>Right-click a node and choose Reset Node Position from the shortcut menu. The node icon moves to the position defined by the longitude and latitude fields on the Provisioning &gt; General tab in node view.</td>
</tr>
<tr>
<td>Provision a circuit</td>
<td>Right-click a node. From the shortcut menu, choose Provision Circuit To and choose the node where you want to provision the circuit. For circuit creation procedures, see Chapter 7, “Create Channels and Circuits.”</td>
</tr>
</tbody>
</table>
A.2.5 Table Display Options

Right-clicking a table column displays a menu. Table A-7 shows table display options, which include rearranging or hiding CTC table columns and sorting table columns by primary or secondary keys.

Table A-7  Table Display Options

<table>
<thead>
<tr>
<th>Task</th>
<th>Click</th>
<th>Right-Click Shortcut Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize column</td>
<td>Click while dragging the column separator to the right or left.</td>
<td>—</td>
</tr>
<tr>
<td>Rearrange column order</td>
<td>Click while dragging the column header to the right or left.</td>
<td>—</td>
</tr>
<tr>
<td>Reset column order</td>
<td>—</td>
<td>Choose Reset Columns Order/Visibility.</td>
</tr>
<tr>
<td>Hide column</td>
<td>—</td>
<td>Choose Hide Column.</td>
</tr>
<tr>
<td>Show column</td>
<td>—</td>
<td>Choose Show Column &gt; column_name.</td>
</tr>
<tr>
<td>Display all hidden columns</td>
<td>—</td>
<td>Choose Reset Columns Order/Visibility.</td>
</tr>
<tr>
<td>Sort table (primary)</td>
<td>Click a column header; each click changes sort order (ascending or descending).</td>
<td>Choose Sort Column.</td>
</tr>
</tbody>
</table>
In node view, the Inventory tab displays information about the ONS 15454 equipment, including:

- **Location**—Identifies where the equipment is installed, either chassis or slot number.
- **Eqpt Type**—Displays the type of equipment but not the specific card name, for example, OC-12 or DS-1.
- **Actual Eqpt Type**—Displays the specific card name, for example, OC12 IR/STM4 SH 1310.
- **Admin State**—Changes the card service state unless network conditions prevent the change. For more information about card administrative states, see Appendix C, “DWDM Administrative and Service States.”
  - IS (ANSI) or Unlocked (ETSI)—Places the card in the In-Service and Normal (IS-NR [ANSI]) or Unlocked-enabled (ETSI) service state.
  - OOS,MA (ANSI) or Locked,maintenance (ETSI)—Places the card in the Out-of-Service and Autonomous, Maintenance (OOS-AU,MT [ANSI]) or Unlocked-disabled,maintenance (ETSI) service state.
- **Service State**—Displays the current card service state, which is an autonomously generated state that gives the overall condition of the card. Service states appear in the format: Primary State-Primary State Qualifier, Secondary State. For more information about card service states, see Appendix C, “DWDM Administrative and Service States.”
- **HW Part #**—Displays the hardware part number; this number is printed on the top of the card or equipment piece.
- **HW Rev**—Displays the hardware revision number.
- **Serial #**—Displays the equipment serial number; this number is unique to each card.
- **CLEI Code**—Displays the Common Language Equipment Identifier code.
- **Firmware Rev**—Displays the revision number of the software used by the application-specific integrated circuit (ASIC) chip installed on the ONS 15454 card.
- **Product ID**—Displays the manufacturing product identifier for a hardware component, such as a fan tray, chassis, or card. The Product ID column displays “N/A” for equipment existing before Software Release 4.6.
- **Version ID**—Displays the manufacturing version identifier for a fan tray, chassis, or card. The Version ID column displays “N/A” for equipment existing before Software Release 4.6.

Buttons at the bottom of the Inventory tab are used to delete or reset a card when a card is selected, or to delete a PPM if a PPM is selected on the table.
Hardware Specifications

This appendix contains hardware and software specifications for the ONS 15454 ANSI and ETSI shelf assemblies and cards.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

B.1 Shelf Specifications

This section provides specifications for shelf bandwidth; a list of topologies; Cisco Transport Controller (CTC) specifications; the LAN, TL1, modem, and alarm specifications; timing, power, and environmental specifications; and shelf dimensions.

B.1.1 Bandwidth

The ONS 15454 has the following bandwidth specifications:

- Total bandwidth: 240 Gbps
- Data plane bandwidth: 160 Gbps
- SONET/SDH plane bandwidth: 80 Gbps

B.1.2 Configurations

The ONS 15454 can be configured for the following dense wavelength division multiplexing (DWDM) topologies:

- Hubbed rings
- Multihubbed rings
- Point-to-point
- Linear
- Linear with optical add/drop multiplexing (OADM)
B.1.3 Cisco Transport Controller

CTC, the ONS 15454 craft interface software, has the following specifications:

- 10BaseT
- Advanced Timing, Communications, and Control (TCC2/TCC2P) card access: RJ-45 connector
- Backplane access: LAN pin field (ANSI only)
- Front Mount Electrical Connection (FMEC) access: LAN connector on MIC-C/T/P faceplate (ETSI only)

B.1.4 External LAN Interface

The ONS 15454 external LAN interface has the following specifications:

- 10BaseT Ethernet
- Backplane access: LAN pin field (ANSI only)
- FMEC access: LAN connector on MIC-C/T/P faceplate (ETSI only)

B.1.5 TL1 Craft Interface

The ONS 15454 TL1 craft interface has the following specifications:

- Speed: 9600 bps
- TCC2/TCC2P access: EIA/TIA-232 DB-9 type connector
- Backplane access: CRAFT pin field (ANSI only)

B.1.6 Modem Interface

The ONS 15454 modem interface has the following specifications:

- Hardware flow control
- TCC2/TCC2P: EIA/TIA-232 DB-9 type connector

B.1.7 Alarm Interface

The ONS 15454 alarm interface has the following specifications:

- ETSI
  - Visual: Critical, Major, Minor, Remote
  - Audible: Critical, Major, Minor, Remote
  - FMEC access: 62-Pin DB connector on MIC-A/P faceplate
  - Alarm inputs: Common 32-VDC output for all alarm-inputs, closed contact limited to 2 mA
  - Control outputs: Open contact maximum 60 VDC, closed contact maximum 100 mA
B.1.8 EIA Interface (ANSI only)

The ONS 15454 electrical interface assembly (EIA) interface has the following specifications:
- SMB: AMP #415504-3 75-ohm, 4-leg connectors
- BNC: Trompeter #UCBJ224 75-ohm 4 leg connector (King or ITT are also compatible)
- AMP Champ: AMP#552246-1 with #552562-2 bail locks

B.1.9 BITS Interface (ANSI only)

The ONS 15454 building integrated timing supply (BITS) interface has the following specifications:
- 2 DS-1 BITS inputs
- 2 derived DS-1 outputs
- Backplane access: BITS pin field

B.1.10 System Timing

The ONS 15454 ANSI has the following system timing specifications:
- Stratum 3 per Telcordia GR-253-CORE
- Free running accuracy: +/– 4.6 ppm
- Holdover stability: 3.7 x 10^-7 per day, including temperature (< 255 slips in first 24 hours)
- Reference: External BITS, line, internal

The ONS 15454 ETSI has the following system timing specifications:
- Stratum 3E, per ITU-T G.813
- Free running accuracy: +/– 4.6 ppm
- Holdover stability: 3.7 exp –7 per day, including temperature (< 255 slips in first 24 hours)
- Reference: External BITS, line, internal

B.1.11 System Power

The ONS 15454 ANSI has the following power specifications:
- Input power: –48 VDC
- Power consumption: 55 W (fan tray only); 650 W (maximum draw with cards)
- Power requirements: –40.5 to –57 VDC
B.1.12 System Environmental Specifications

The ONS 15454 ANSI has the following power specifications:

- Power terminals: #6 Lug
- ANSI shelf: 100-A fuse panel (minimum 30 A fuse per shelf)
- HD shelf: 100-A fuse panel (minimum 35 A fuse per shelf)

The ONS 15454 ETSI has the following power specifications:

- Power terminals: 3WK3 Combo-D power cable connector (MIC-A/P and MIC-C/T/P faceplates)
- Fusing: 100 A fuse panel; minimum 30 A fuse per shelf

B.1.12 System Environmental Specifications

The ONS 15454 ANSI has the following environmental specifications:

- Operating temperature: 32 to +131 degrees Fahrenheit (0 to +55 degrees Celsius); -40 to +139 degrees Fahrenheit (-40 to +65 degrees Celsius) with industrial temperature rated cards
- Operating humidity: 5 to 95 percent, noncondensing

The ONS 15454 ETSI has the following environmental specifications:

- Operating temperature: 32 to 104 degrees Fahrenheit (0 to +40 degrees Celsius)
- Operating humidity: 5 to 95 percent, noncondensing

B.1.13 Dimensions

The ONS 15454 ANSI shelf assembly has the following dimensions:

- Height: 18.5 in. (40.7 cm)
- Width: 19 or 23 in. (41.8 or 50.6 cm) with mounting ears attached
- Depth: 12 in. (26.4 cm) (5 in. or 12.7 cm projection from rack)
- Weight: 55 lb (24.947 kg) empty

The ONS 15454 ETSI shelf assembly has the following dimensions:

- Height: 616.5 mm (24.27 in.)
- Width: 535 mm (17 in.) without mounting ears attached
- Depth: 280 mm (11.02 in.)
- Weight: 26 kg empty (57.3 lb)

B.2 General Card Specifications

This section provides power specifications and temperature ranges for all ONS 15454 cards.
### B.2.1 Power

Table B-1 provides power consumption information for the ONS 15454 cards.

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Card Name</th>
<th>Watts</th>
<th>Amperes at –48 V</th>
<th>BTU/Hr.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common Control Cards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCC2/TCC2P</td>
<td>19.20</td>
<td>0.4</td>
<td>66.8</td>
<td>&lt;</td>
</tr>
<tr>
<td>AIC-I</td>
<td>4.8</td>
<td>0.1</td>
<td>15.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>AEP</td>
<td>3</td>
<td></td>
<td>10.2</td>
<td>&lt;</td>
</tr>
<tr>
<td>MIC-A/P</td>
<td>0.13</td>
<td></td>
<td>—</td>
<td>&lt;</td>
</tr>
<tr>
<td>MIC-C/T/P</td>
<td>0.38</td>
<td></td>
<td>—</td>
<td>&lt;</td>
</tr>
<tr>
<td><strong>DWDM Cards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSCM</td>
<td>Nominal 23</td>
<td>Nominal 0.48</td>
<td>Nominal 78.48</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 26</td>
<td>Maximum 0.54</td>
<td>Maximum 88.71</td>
<td>&lt;</td>
</tr>
<tr>
<td>OSC-CSR</td>
<td>Nominal 24</td>
<td>Nominal 0.5</td>
<td>Nominal 81.89</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 27</td>
<td>Maximum 0.56</td>
<td>Maximum 92.12</td>
<td>&lt;</td>
</tr>
<tr>
<td>OPT-PRE</td>
<td>Minimum 25</td>
<td>Minimum 0.52</td>
<td>Minimum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Nominal 30</td>
<td>Nominal 0.5</td>
<td>Nominal 102.36</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 39</td>
<td>Maximum 0.81</td>
<td>Maximum 88.71</td>
<td>&lt;</td>
</tr>
<tr>
<td>OPT-BST</td>
<td>Nominal 30</td>
<td>Nominal 0.63</td>
<td>Nominal 102.36</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 39</td>
<td>Maximum 0.81</td>
<td>Maximum 88.71</td>
<td>&lt;</td>
</tr>
<tr>
<td>OPT-BST-E</td>
<td>Nominal 30</td>
<td>Nominal 0.63</td>
<td>Nominal 102.36</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 39</td>
<td>Maximum 0.81</td>
<td>Maximum 88.71</td>
<td>&lt;</td>
</tr>
<tr>
<td>32MUX-O</td>
<td>Nominal 16</td>
<td>Nominal 0.33</td>
<td>Nominal 54.59</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>32DMX-O</td>
<td>Nominal 16</td>
<td>Nominal 0.33</td>
<td>Nominal 54.59</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>32DMX</td>
<td>Nominal 15</td>
<td>Nominal 0.31</td>
<td>Nominal 51.21</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85</td>
<td>&lt;</td>
</tr>
<tr>
<td>4MD-xx.x</td>
<td>Nominal 17</td>
<td>Nominal 0.35</td>
<td>Nominal 58.0</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>AD-1C-xx.x</td>
<td>Nominal 17</td>
<td>Nominal 0.35</td>
<td>Nominal 58.0</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>AD-2C-xx.x</td>
<td>Nominal 17</td>
<td>Nominal 0.35</td>
<td>Nominal 58.0</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
<tr>
<td>AD-4C-xx.x</td>
<td>Nominal 17</td>
<td>Nominal 0.35</td>
<td>Nominal 58.0</td>
<td>&lt;</td>
</tr>
<tr>
<td></td>
<td>Maximum 25</td>
<td>Maximum 0.52</td>
<td>Maximum 85.3</td>
<td>&lt;</td>
</tr>
</tbody>
</table>
### B.2.2 Temperature

Table B-2 provides temperature ranges and product names for ONS 15454 cards.

The I-Temp symbol is displayed on the faceplate of an I-Temp compliant card. A card without this symbol is C-Temp compliant.

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Card Name</th>
<th>C-Temp Product Name (32 to 131 degrees Fahrenheit, 0 to +55 degrees Celsius)</th>
<th>I-Temp Product Name (–40 to 149 degrees Fahrenheit, –40 to +65 degrees Celsius)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Control Cards</td>
<td>TCC2/TCC2P</td>
<td>—</td>
<td>15454-TCC2/TCC2P</td>
</tr>
<tr>
<td></td>
<td>AIC-I</td>
<td>—</td>
<td>15454-AIC-I</td>
</tr>
<tr>
<td></td>
<td>AEP</td>
<td>—</td>
<td>15454-AEP</td>
</tr>
<tr>
<td></td>
<td>MIC-A/P</td>
<td>15454-MIC-A/P</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>MIC-C/T/P</td>
<td>15454 MIC-C/T/P</td>
<td>—</td>
</tr>
</tbody>
</table>

---

1. Calculated power; measured power was not available at the time of publication.
B.3 Common Control Card Specifications

This section provides specifications for the TCC2, TCC2P, AIC, and AIC-I cards, the alarm expansion panel (AEP), and the MIC-A/P and MIC-C/T/P FMECs.

For compliance information, refer to the *Cisco Optical Transport Products Safety and Compliance Information* document.

### B.3.1 TCC2 Card Specifications

The TCC2 card has the following specifications:

- CTC software
B.3.2 TCC2P Card Specifications

The TCC2P card has the following specifications:

- **CTC software**
  - Interface: EIA/TIA-232 (local craft access, on TCC2 faceplate)
  - Interface: 10BaseT LAN (on TCC2 faceplate)
  - Interface: 10BaseT LAN (through the backplane)

- **Synchronization**
  - Stratum 3, per Telcordia GR-253-CORE
  - Free running access: Accuracy +/− 4.6 ppm
  - Holdover stability: $3.7 \times 10^{-7}$ per day including temperature (< 255 slips in first 24 hours)
  - Reference: External BITS, line, internal

- **Supply voltage monitoring**
  - Both supply voltage inputs are monitored.
  - Normal operation: −40.5 to −56.7 V
  - Undervoltage: Major alarm
  - Overvoltage: Major alarm

- **Environmental**
  - Operating temperature: −40 to +149 degrees Fahrenheit (−40 to +65 degrees Celsius)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption: 26.00 W, 0.54 A at −48 V, 88.8 BTU/hr

- **Dimensions**
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
  - Depth with backplane connector: 235 mm (9.250 in.)
  - Weight not including clam shell: 0.7 kg (1.5 lb)
– Normal operation: –40.5 to –56.7 V (in –48 VDC systems)
– Undervoltage: Major alarm
– Overvoltage: Major alarm

• Environmental
– Operating temperature: –40 to +149 degrees Fahrenheit (–40 to +65 degrees Celsius)
– Operating humidity: 5 to 95 percent, noncondensing
– Power consumption: 26.00 W, 0.54 A at –48 V, 88.8 BTU/hr

• Dimensions
– Height: 12.650 in. (321.3 mm)
– Width: 0.716 in. (18.2 mm)
– Depth: 9.000 in. (228.6 mm)
– Depth with backplane connector: 9.250 in. (235 mm)
– Weight not including clam shell: 1.5 lb (0.7 kg)

B.3.3 AIC-I Card Specifications

The AIC-I card has the following specifications:

• Alarm inputs
  – Number of inputs: 12 without AEP, 32 with AEP
  – Opto-coupler isolated
  – Label customer provisionable
  – Severity customer provisionable
  – Common 32 V output for all alarm inputs
  – Each input limited to 2 mA
  – Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Alarm outputs
  – Number of outputs: 4 (user configurable as inputs) without AEP, 16 with AEP
  – Switched by opto MOS (metal oxide semiconductor)
  – Triggered by definable alarm condition
  – Maximum allowed open circuit voltage: 60 VDC
  – Maximum allowed closed circuit current: 100 mA
  – Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Express orderwire/local orderwire (EOW/LOW)
  – A-law, mu-law

Note
Due to the nature of mixed coding, in a mixed-mode (A-law/mu-law) configuration, the orderwire is not ITU-T G.712 compliant.
- Orderwire party line
- Dual tone, multifrequency (DTMF) signaling

- User data channel (UDC)
  - Bit rate: 64 kbps, codirectional
  - ITU-T G.703
  - Input/output impedance: 120 ohm
  - Termination: RJ-11 connectors

- Data communications channel (DCC)
  - Bit rate: 576 kbps
  - EIA/TIA-485/V11
  - Input/output impedance: 120 ohm
  - Termination: RJ-45 connectors

- ACC connection for additional alarm interfaces
  - Connection to AEP

- Power monitoring alarming states:
  - Power failure (0 to –38 VDC)
  - Undervoltage (–38 to –40.5 VDC)
  - Overvoltage (beyond –56.7 VDC)

- Environmental
  - Operating temperature: –40 to 149 degrees Fahrenheit (–40 to +65 degrees Celsius)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption (including AEP, if used): 8.00 W, 0.17 A, 27.3 BTU/hr

- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
  - Weight: 1.8 lb (0.82 kg)

### B.3.4 AEP Specifications (ANSI only)

The AEP has the following specifications:

- Alarm inputs
  - Number of inputs: 32
  - Optocoupler isolated
  - Label customer provisionable
  - Severity customer provisionable
  - Common 32 V output for all alarm inputs
  - Each input limited to 2 mA
B.3.5 MIC-A/P FMEC Specifications (ETSI only)

The MIC-A/P FMEC card has the following specifications:

- **Power supply input BATTERY B**
  - System supply voltage: Nominal –48 VDC
    - Tolerance limits: –40.5 to –57.0 VDC
  - Connector: 3WK3 Combo-D power cable connector

- **Alarm outputs**
  - Voltage (open contact): Maximum 60 VDC
  - Current (closed contact): Maximum 250 mA
  - Connector: 62-pin DB connector (common for inputs/outputs)

- **Alarm inputs**
  - Voltage (open contact): Maximum 60 VDC
  - Current (closed contact): Maximum 2 mA
  - Connector: 62-pin DB connector (common for inputs/outputs)

- **Environmental**
  - Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption: 0.13 W (provided by +5 V from the TCC2/TCC2P card), 0.44 BTU/hr
• Dimensions
  – Height: 182 mm (7.165 in.)
  – Width: 32 mm (1.25 in.)
  – Depth: 92 mm (3.62 in.)
  – Depth with backplane connector: 98 mm (3.87 in.)
  – Weight not including clam shell: 0.2 kg (0.5 lb)

B.3.6 MIC-C/T/P FMEC Specifications (ETSI only)

The MIC-C/T/P FMEC card has the following specifications:

• Power supply input BATTERY A
  – System supply voltage: Nominal –48 VDC
    Tolerance limits: –40.5 to –57.0 VDC
  – Connector: 3WK3 Combo-D power cable connector

• Timing connector
  – Frequency: 2.048 MHz ±/–10 ppm
  – Signal level: 0.75 to 1.5 V
  – Impedance: 75 ohms ±/–5 percent (switchable by jumper to high impedance > 3 kohms)

  **Note**
  120 ohms balanced impedance is possible with external matching cable.

  – Cable attenuation: Up to 6 dB at 2 MHz
  – Connectors: 1.0/2.3 miniature coax connector

• System management serial port:
  – System management serial port craft interface
  – Modem port (for future use)
  – Connectors: 8-pin RJ-45

• System management LAN port connectors:
  – Signal: IEEE 802.3 10BaseT
  – Connectors: 8-pin RJ-45

• Environmental
  – Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit)
  – Operating humidity: 5 to 95 percent, noncondensing
  – Power consumption: 0.38 W (provided by +5 V from the TCC2/TCC2P card), 1.37 BTU/hr

• Dimensions
  – Height: 182 mm (7.165 in.)
  – Width: 32 mm (1.25 in.)
  – Depth: 92 mm (3.62 in.)
  – Depth with backplane connector: 98 mm (3.87 in.)
B.4 DWDM Card Specifications

This section provides specifications for the OSCM, OSC-CSM, OPT-PRE amplifier, OPT-BST amplifier, OPT-BST-E amplifier, 32MUX-O, 32DMX-O, 32DMX, 4MD-xx.x, AD-IC-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, and 32WSS cards.

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance Information document.

B.4.1 OSCM Card Specifications

The OSCM card has the following specifications:

- Line
  - Bit rate: 155 Mbps
  - Code: Scrambled non-return to zero (NRZ)
  - Loopback modes: None
  - Connector: Duplex LC
  - Compliance: Telcordia GR-253-CORE, ITU-T G.957

- Transmitter optical service channel (OSC) signal
  - Maximum transmitter output power: –1 dBm
  - Minimum transmitter output power: –5 dBm
  - Nominal wavelength: 1510-nm +/-10 nm
  - Variable optical attenuator (VOA) necessary in the transmit path to adjust the in-fiber optical power level

- Receiver OSC signal
  - Maximum receiver level: –8 dBm at 10^-10 bit error rate (BER)
  - Minimum receiver level: –40 dBm at 10^-10 BER
  - Span budget: 40-dB span budget (about 150 km assuming fiber path loss equals 0.25 dB/km)
  - Jitter tolerance: Telcordia GR-253/G.823 compliant

- Environmental
  - Operating temperature: C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing

- Dimensions
  - Height: 12.65 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.00 in. (228.6 mm)
B.4.2 OSC-CSM Card Specifications

The OSC-CSM card has the following specifications:

- **Line**
  - Bit rate: 155 Mbps
  - Code: Scrambled NRZ
  - Loopback modes: None
  - Connector: Duplex LC
  - Compliance: Telcordia GR-253-CORE, ITU-T G.957

- **Transmitter OSC signal**
  - Maximum transmitter output power: –2 dBm
  - Minimum transmitter output power: –24 dBm
  - Nominal wavelength: 1510-nm +/-10 nm
  - VOA is necessary in the transmit path to adjust the in-fiber optical power level

- **Receiver OSC signal**
  - Maximum receiver level: –8 dBm at 10^-10 BER
  - Minimum receiver level: –40 dBm at 10^-10 BER
  - Span loss budget: 35-dB span budget (approximately 140 km assuming that the fiber path loss is equal to 0.25 dB/km)
  - Jitter tolerance: Telcordia GR-253/G.823 compliant

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing

- **Dimensions**
  - Height: 12.65 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.00 in. (228.6 mm)

B.4.3 OPT-PRE Amplifier Card Specifications

The OPT-PRE amplifier card has the following specifications:

- **Optical characteristics**:
  - Total operating wavelength range: 1530 to 1561.3 nm
  - Gain ripple (peak to valley): 1.5 dB
  - Mid-access loss (MAL) range (for dispersion compensation unit [DCU]): 3 to 9 dB
  - Gain range: 5 to 38.5 dBm in constant power mode, 5 to 28 dBm in constant gain mode
  - Minimum gain (standard range): 5.0 dBm
Maximum gain (standard range with programmable gain tilt): 21 dBm
Maximum gain (extended range with uncontrolled gain tilt): 38.5 dBm
- Gain and power regulation over/undershoot: 0.5 dB
- Limited maximum output power: 17.5 dBm
- Maximum output power (with full channel load): 17 dB
- Minimum output power (with one channel): –1 dBm
- Input power (Pin) range at full channel load: –21.5 to 12 dBm
- Input power (Pin) range at single channel load: –39.5 to –6 dBm
- Noise figure at G² 21 dB = 6.5 dB
- OSC filter drop (channels) insertion loss maximum: 1 dB
- OSC filter drop (OSC) insertion loss maximum: 1.8 dB
- OSC filter add (OSC) insertion loss maximum: 1.3 dB
- Optical connectors: LC-UPC/2

- Environmental
  - Operating temperature:
    C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 85 percent, noncondensing

- Dimensions
  - Height: 12.65 in. (332 mm)
  - Width: 0.92 in. (24 mm)
  - Depth: 9.00 in. (240 mm)

**B.4.4 OPT-BST Amplifier Card Specifications**

The OPT-BST amplifier card has the following specifications:

- Optical characteristics:
  - Total operating wavelength range: 1530 to 1561.3 nm
  - Gain ripple (peak to valley): 1.5 dB
  - Gain range: 5 to 20 dBm with programmable gain tilt
  - Gain and power regulation over/undershoot: 0.5 dB
  - Limited maximum output power: 17.5 dBm
  - Maximum output power (with full channel load): 17 dB
  - Minimum output power (with one channel): –1 dBm
  - Input power (Pin) range at full channel load: –3 to 12 dBm
  - Input power (Pin) range at single channel load: –21 to –6 dBm
  - Noise figure at G² 20 dB = 6 dB
  - OSC filter drop (channels) insertion loss maximum: 1 dB
  - OSC filter drop (OSC) insertion loss maximum: 1.8 dB
B.4.5 OPT-BST-E Amplifier Card Specifications

The OPT-BST-E amplifier card has the following specifications:

- **Optical characteristics:**
  - Total operating wavelength range: 1530 to 1561.3 nm
  - Gain ripple (peak to valley): 1.8 dB
  - Gain range: 8 to 23 dB with programmable gain tilt
  - Extended gain range: 23 to 26 dB with gain tilt uncontrolled
  - Gain and power regulation over/undershoot: 0.5 dB
  - Limited maximum output power: 20.5 dBm
  - Maximum output power (with full channel load): 20 dB
  - Minimum output power (with one channel): –1 dBm
  - Input power (Pin) range at full channel load: –6 to 12 dBm
  - Input power (Pin) range at single channel load: –26 to –8 dBm
  - Noise figure at G = 23 dB = 6 dB
  - OSC filter drop (channels) insertion loss maximum: 1 dB
  - OSC filter drop (OSC) insertion loss maximum: 1.8 dB
  - OSC filter add (OSC) insertion loss maximum: 1.3 dB
  - Optical connectors: LC-UPC/2

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 85 percent, noncondensing

- **Dimensions**
  - Height: 12.65 in. (332 mm)
  - Width: 0.92 in. (24 mm)
  - Depth: 9.00 in. (240 mm)
B.4.6 32MUX-O Card Specifications

The 32 MUX-O card optical specifications are listed in Table B-3.

For power specifications, refer to the “16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes” section on page 16-6.

### Table B-3 32MUX-O Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx filter shape (–1 dB bandwidth)</td>
<td>All standard operating procedures (SOP)</td>
<td>In 1/32—Out beginning of life (BOL)</td>
<td>+/-180</td>
<td>+/-300</td>
<td>pm</td>
</tr>
<tr>
<td></td>
<td>and within whole operating temperature</td>
<td>In 1/32—Out end of life (EOL)</td>
<td>+/-160</td>
<td>+/-300</td>
<td>pm</td>
</tr>
<tr>
<td></td>
<td>range</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insertion loss</td>
<td>All SOP and within whole operating</td>
<td>In 1/32—Out BOL</td>
<td>4</td>
<td>8.0</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td>temperature range</td>
<td>In 1/32—Out EOL</td>
<td>4</td>
<td>8.5</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td></td>
<td></td>
<td>25</td>
<td>dB</td>
</tr>
<tr>
<td>Optical monitor tap-splitting ratio</td>
<td>—</td>
<td></td>
<td></td>
<td>19</td>
<td>21</td>
</tr>
<tr>
<td>on monitor port</td>
<td></td>
<td>—</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Optical monitor port</td>
<td>—</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>with respect to output port</td>
<td>—</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in multiplexer only</td>
<td>—</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td></td>
<td>300</td>
<td>—</td>
<td>mW</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The 32MUX-O card has the following additional specifications:

- Environmental
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent relative humidity (RH)

- Dimensions
  - Height: 12.65 in. (321.3 mm)
  - Width: 1.84 in. (46.8 mm)
  - Depth: 9.00 in. (228.6 mm)

B.4.7 32DMX-O Card Specifications

The 32DMX-O card optical specifications are listed in Table B-4.

For power specifications, see the “16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes” section on page 16-6.
B.4.8 32DMX Card Specifications

The 32DMX-O card has the following additional specifications:

- **Environmental**
  - Operating temperature:
    - C-Temp: −5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent RH

- **Dimensions**
  - Height: 12.65 in. (321.3 mm)
  - Width: 1.84 in. (46.8 mm)
  - Depth: 9.00 in. (228.6 mm)

### Table B-4 32DMX-O Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx filter shape (−1 dB bandwidth)</td>
<td>All SOP and within whole operating temperature range</td>
<td>In 1/32—Out BOL</td>
<td>+/−180</td>
<td>+/−300</td>
<td>pm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In 1/32—Out EOL</td>
<td>+/−160</td>
<td>+/−300</td>
<td>pm</td>
</tr>
<tr>
<td>Insertion loss</td>
<td>All SOP and within whole operating temperature range</td>
<td>In 1/32—Out BOL</td>
<td>4</td>
<td>8.0</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In 1/32—Out EOL</td>
<td>4</td>
<td>8.5</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td>—</td>
<td>25</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td>—</td>
<td>300</td>
<td>—</td>
<td>mW</td>
</tr>
</tbody>
</table>

### Table B-5 32DMX Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Typical</th>
<th>Max</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>−1 dB bandwidth</td>
<td>All SOP and within whole operating temperature range, connectors included, and for maximum VOA operating attenuation.</td>
<td>COM RX =&gt; TX 1, 32 (OUT)</td>
<td>+/−110</td>
<td>—</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>−3 dB bandwidth</td>
<td></td>
<td>COM RX =&gt; TX 1, 32 (OUT)</td>
<td>+/−200</td>
<td>—</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>Insertion loss</td>
<td>All SOP, and within whole operating temperature range, connectors included.</td>
<td>COM RX =&gt; TX 1, 32 (OUT)</td>
<td>—</td>
<td>—</td>
<td>5.5</td>
<td>dB</td>
</tr>
</tbody>
</table>

Note: For power specifications, see the “16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes” section on page 16-6.
### Table B-5 32DMX Optical Specifications (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Typical</th>
<th>Max</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOA dynamic range</td>
<td></td>
<td>COM RX =&gt; TX 1, 32</td>
<td>25</td>
<td>—</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td></td>
<td></td>
<td>300</td>
<td>—</td>
<td>—</td>
<td>mW</td>
</tr>
</tbody>
</table>

The 32DMX channel plan is shown in Table B-6. All 32DMX client interfaces must comply with this plan.

### Table B-6 32DMX Channel Plan

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Band</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>31.2</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td>11</td>
<td>3</td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td>13</td>
<td>4</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td>14</td>
<td>4</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td>16</td>
<td>4</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td>17</td>
<td>5</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td>18</td>
<td>5</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td>19</td>
<td>5</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td>20</td>
<td>5</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td>21</td>
<td>6</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td>22</td>
<td>6</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td>23</td>
<td>6</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td>24</td>
<td>6</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
</tbody>
</table>
The 32DMX card has the following additional specifications:

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent RH

- **Dimensions**
  - Height: 12.65 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.00 in. (228.6 mm)

### B.4.9 4MD-xx.x Card Specifications

The 4MD-xx.x card optical specifications are listed in Table B-7.

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Band</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>7</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td>26</td>
<td>7</td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td>27</td>
<td>7</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td>28</td>
<td>7</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
</tr>
<tr>
<td>29</td>
<td>8</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td>30</td>
<td>8</td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td>31</td>
<td>8</td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td>32</td>
<td>8</td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
</tbody>
</table>

For power specifications, see the “16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes” section on page 16-6.
### B.4.10 AD-1C-xx.x Card Specifications

**Table B-7 4MD-xx.x Optical Specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trx filter shape (–0.5 dB bandwidth TrxBW₂)</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—xx.xx Tx</td>
<td>+/-180</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—zz.zz Tx</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—kk.kk Tx</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>xx.xx Rx—COM Tx</td>
<td>—</td>
<td>1.9</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td>—</td>
<td>2.4</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—zz.zz Tx</td>
<td>—</td>
<td>2.8</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—kk.kk Tx</td>
<td>—</td>
<td>3.3</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss demultiplexer section</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—xx.xx Tx</td>
<td>—</td>
<td>1.9</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td>—</td>
<td>2.4</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—zz.zz Tx</td>
<td>—</td>
<td>2.8</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—kk.kk Tx</td>
<td>—</td>
<td>3.3</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss multiplexer section</td>
<td>All SOP and within whole operating temperature range (two connectors included)</td>
<td>xx.xx Rx—COM Tx</td>
<td>—</td>
<td>3.6</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td>—</td>
<td>3.2</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zz.zz Rx—COM Tx</td>
<td>—</td>
<td>3.0</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>kk.kk Rx—COM Tx</td>
<td>—</td>
<td>2.6</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>25</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>300</td>
<td>mW</td>
</tr>
</tbody>
</table>

The 4MD-xx.x card has the following additional specifications:

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent RH
- **Dimensions**
  - Height: 12.65 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.00 in. (228.6 mm)

### B.4.10 AD-1C-xx.x Card Specifications

*Table B-8 lists the AD-1C-xx.x optical specifications.*
B.4.11 AD-2C-xx.x Card Specifications

Table B-8  AD-1C-xx.x Card Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trx filter shape (–0.5 dB bandwidth) TrxBW₂</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—xx.xx Tx xx.xx Rx—COM Tx</td>
<td>+/-180</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>Rfx filter shape (–0.5 dB bandwidth) RfxBW₂</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—Exp Tx Exp Rx—COM Tx</td>
<td>+/-180</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—xx.xx Tx</td>
<td>—</td>
<td>2.0</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (express section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—Exp Tx Exp Rx—COM Tx</td>
<td>—</td>
<td>2.4 or 1.2</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>xx.xx Rx—COM Tx</td>
<td>—</td>
<td>2.6</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td>—</td>
<td>30</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td>—</td>
<td>300</td>
<td>—</td>
<td>mW</td>
</tr>
</tbody>
</table>

AD-1C-xx.x optical input and output power varies with amplifier output levels and the class of transponder interfaces used. See Table 16-3 on page 16-6 through Table 16-5 on page 16-8 for this information.

The AD-1C-xx.x card has the following additional specifications:

- Environmental
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH

- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.0 in. (228.6 mm)

B.4.11 AD-2C-xx.x Card Specifications

Table B-9 lists the AD-2C-xx.x optical specifications.
**Table B-9 AD-2C-xx.x Card Optical Specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trx filter shape (–0.5 dB bandwidth) TrxBW₂</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—xx.xx Tx</td>
<td></td>
<td></td>
<td>pm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>xx.xx Rx—COM Tx</td>
<td>+/-180</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td></td>
<td>+/-180</td>
<td></td>
</tr>
<tr>
<td>Rfx filter shape (–0.5 dB bandwidth) RxBW₂</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—Exp Tx</td>
<td>+/-180</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exp Rx—COM Tx</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—xx.xx Tx</td>
<td></td>
<td>2.0</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td></td>
<td>2.4</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (express section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—Exp Tx</td>
<td></td>
<td>2.7</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exp Rx—COM Tx</td>
<td></td>
<td>1.6</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>xx.xx Rx—COM Tx</td>
<td></td>
<td>3.1</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td></td>
<td>2.7</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td>—</td>
<td>30</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td>—</td>
<td>300</td>
<td>—</td>
<td>mW</td>
</tr>
</tbody>
</table>

AD-2C-xx.x optical input and output power varies with amplifier output levels and the class of transponder interfaces used. See Table 16-3 on page 16-6 through Table 16-5 on page 16-8 for this information.

The AD-2C-xx.x has the following additional specifications:

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH
- **Dimensions**
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.0 in. (228.6 mm)

**B.4.12 AD-4C-xx.x Card Specifications**

Table B-10 lists the AD-4C-xx.x optical specifications.
AD-4C-xx.x Card Specifications

Table B-10  AD-4C-xx.x Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel grid</td>
<td>See Table B-11. The channel plan for the AD-4C-xx.x card is identical to the channel plan for the AD-1B-xx.x card.</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Trx filter shape</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—xx.xx Tx</td>
<td>+/–180</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>(-0.5 dB bandwidth) TrxBW₂</td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—zz.zz Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—kk.kk Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>xx.xx Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zz.zz Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>kk.kk Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Rfx filter shape</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—Exp Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(-1 dB bandwidth) RfxBW₂</td>
<td></td>
<td>Exp Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—xx.xx Tx</td>
<td>5.5</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—yy.yy Tx</td>
<td>5.0</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—zz.zz Tx</td>
<td>4.5</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>COM Rx—kk.kk Tx</td>
<td>4.1</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>xx.xx Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zz.zz Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>kk.kk Rx—COM Tx</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Insertion loss (express section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>COM Rx—Exp Tx</td>
<td>2.7</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exp Rx—COM Tx</td>
<td>1.2</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>VOA at minimum attenuation; all SOP and within whole operating temperature range (two connectors included)</td>
<td>xx.xx Rx—COM Tx</td>
<td>3.9</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>yy.yy Rx—COM Tx</td>
<td>4.3</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zz.zz Rx—COM Tx</td>
<td>4.5</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>kk.kk Rx—COM Tx</td>
<td>4.9</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td>—</td>
<td>30</td>
<td>—</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td>—</td>
<td>300</td>
<td>—</td>
<td>mW</td>
</tr>
</tbody>
</table>

AD-4C-xx.x optical input and output power varies with amplifier output levels and the class of transponder interfaces used. See Table 16-3 on page 16-6 through Table 16-5 on page 16-8 for this information.

The AD-4C-xx.x has the following additional specifications:

- Environmental
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH

- Dimensions
  - Height: 12.650 in. (321.3 mm)
B.4.13 AD-1B-xx.x Card Specifications

Table B-11 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the eight versions of the AD-1B-xx.x card.

Table B-11 AD-1B-xx.x Channel Allocation Plan by Band

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>Band ID</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-1B-30.3</td>
<td>B30.3</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30.7</td>
<td>195.85</td>
<td>1530.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.1</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.5</td>
<td>195.75</td>
<td>1531.51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32.2</td>
<td>195.65</td>
<td>1532.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td></td>
<td></td>
<td>33.3</td>
<td>195.55</td>
<td>1533.07</td>
</tr>
<tr>
<td>AD-1B-34.2</td>
<td>B34.2</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>34.6</td>
<td>195.35</td>
<td>1534.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.4</td>
<td>195.25</td>
<td>1535.43</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>36.2</td>
<td>195.15</td>
<td>1536.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>37.0</td>
<td>195.05</td>
<td>1537.00</td>
</tr>
<tr>
<td>AD-1B-38.1</td>
<td>B38.1</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>38.5</td>
<td>194.85</td>
<td>1538.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39.3</td>
<td>194.75</td>
<td>1539.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.1</td>
<td>194.65</td>
<td>1540.16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.9</td>
<td>194.55</td>
<td>1540.95</td>
</tr>
</tbody>
</table>
### Table B-11  AD-1B-xx.x Channel Allocation Plan by Band (continued)

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>Band ID</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-1B-42.2</td>
<td>B42.1</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42.5</td>
<td>194.35</td>
<td>1542.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43.3</td>
<td>194.25</td>
<td>1543.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.1</td>
<td>194.15</td>
<td>1544.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.9</td>
<td>194.05</td>
<td>1544.92</td>
</tr>
<tr>
<td>AD-1B-46.1</td>
<td>B46.1</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>46.5</td>
<td>193.85</td>
<td>1546.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47.3</td>
<td>193.75</td>
<td>1547.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.1</td>
<td>193.65</td>
<td>1548.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.9</td>
<td>193.55</td>
<td>1548.91</td>
</tr>
<tr>
<td>AD-1B-50.1</td>
<td>B50.1</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50.5</td>
<td>193.35</td>
<td>1550.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51.3</td>
<td>193.25</td>
<td>1551.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.1</td>
<td>193.15</td>
<td>1552.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.9</td>
<td>193.05</td>
<td>1552.93</td>
</tr>
<tr>
<td>AD-1B-54.1</td>
<td>B54.1</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54.5</td>
<td>192.85</td>
<td>1554.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55.3</td>
<td>192.75</td>
<td>1555.34</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.1</td>
<td>192.65</td>
<td>1556.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.5</td>
<td>192.6</td>
<td>1556.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.9</td>
<td>192.55</td>
<td>1556.96</td>
</tr>
</tbody>
</table>
Table B-11  AD-1B-xx.x Channel Allocation Plan by Band (continued)

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>Band ID</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-1B-58.1</td>
<td>B58.1</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58.5</td>
<td>192.35</td>
<td>1558.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.3</td>
<td>192.25</td>
<td>1559.39</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60.2</td>
<td>192.15</td>
<td>1560.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61.0</td>
<td>192.05</td>
<td>1561.01</td>
</tr>
</tbody>
</table>

Table B-12 lists AD-1B-xx.x optical specifications.

Table B-12  AD-1B-xx.x Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>–1 dB bandwidth</td>
<td>All SOP and within whole operating environmental range</td>
<td>COM Rx—Band Tx</td>
<td>3.6</td>
<td>—</td>
<td>nm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Band Rx—COM Tx</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>–1 dB bandwidth</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—Exp Tx</td>
<td></td>
<td></td>
<td>nm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exp Rx—COM Tx</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to Table B-13.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating environmental range; two connectors included, VOA set at minimum attenuation</td>
<td>COM Rx—Band Tx</td>
<td>—</td>
<td>3.0</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (express section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Exp Rx—COM Tx</td>
<td>—</td>
<td>1.6</td>
<td>dB</td>
</tr>
<tr>
<td></td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>COM Rx—Exp Tx</td>
<td>—</td>
<td>2.2</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Band Rx—COM Tx</td>
<td>—</td>
<td>2.2</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td></td>
<td></td>
<td>30</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td></td>
<td></td>
<td>300</td>
<td>mW</td>
</tr>
</tbody>
</table>

Table B-13 lists the range of wavelengths for the receive (express) band.
B.4.14 AD-4B-xx.x Card Specifications

Table B-13  AD-1B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

<table>
<thead>
<tr>
<th>Tx (Dropped) Band</th>
<th>Rx (Express) Band</th>
<th>Left Side (nm)</th>
<th>Right Side (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B30.3</td>
<td>—</td>
<td>Wavelengths 1533.825 or higher</td>
<td></td>
</tr>
<tr>
<td>B34.2</td>
<td>Wavelengths 1533.395 or lower</td>
<td>Wavelengths 1537.765 or higher</td>
<td></td>
</tr>
<tr>
<td>B38.1</td>
<td>Wavelengths 1537.325 or lower</td>
<td>Wavelengths 1541.715 or higher</td>
<td></td>
</tr>
<tr>
<td>42.1</td>
<td>Wavelengths 1541.275 or lower</td>
<td>Wavelengths 1545.695 or higher</td>
<td></td>
</tr>
<tr>
<td>46.1</td>
<td>Wavelengths 1545.245 or lower</td>
<td>Wavelengths 1549.695 or higher</td>
<td></td>
</tr>
<tr>
<td>50.1</td>
<td>Wavelengths 1549.235 or lower</td>
<td>Wavelengths 1553.705 or higher</td>
<td></td>
</tr>
<tr>
<td>54.1</td>
<td>Wavelengths 1553.255 or lower</td>
<td>Wavelengths 1557.745 or higher</td>
<td></td>
</tr>
<tr>
<td>58.1</td>
<td>Wavelengths 1557.285 or lower</td>
<td>—</td>
<td></td>
</tr>
</tbody>
</table>

AD-1B-xx.x optical input and output power varies with amplifier output levels and the class of transponder interfaces used. See Table 16-3 on page 16-6 through Table 16-5 on page 16-8 for this information.

The AD-1B-xx.x card has the following additional specifications:

- Environmental
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH
- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.0 in. (228.6 mm)

B.4.14 AD-4B-xx.x Card Specifications

Table B-14 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the two versions of the card.
### Table B-14  AD-4B-xx.x Channel Allocation Plan by Band

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>Band ID</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-4B-30.3</td>
<td>B30.3</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30.7</td>
<td>195.85</td>
<td>1530.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.1</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.5</td>
<td>195.75</td>
<td>1531.51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32.2</td>
<td>195.65</td>
<td>1532.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td></td>
<td></td>
<td>33.3</td>
<td>195.55</td>
<td>1533.07</td>
</tr>
<tr>
<td>B34.2</td>
<td></td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>34.6</td>
<td>195.35</td>
<td>1534.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.4</td>
<td>195.25</td>
<td>1535.43</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>36.2</td>
<td>195.15</td>
<td>1536.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>37.0</td>
<td>195.05</td>
<td>1537.00</td>
</tr>
<tr>
<td>B38.1</td>
<td></td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>38.5</td>
<td>194.85</td>
<td>1538.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39.3</td>
<td>194.75</td>
<td>1539.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.1</td>
<td>194.65</td>
<td>1540.16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40.9</td>
<td>194.55</td>
<td>1540.95</td>
</tr>
<tr>
<td>B42.1</td>
<td></td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42.5</td>
<td>194.35</td>
<td>1542.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43.3</td>
<td>194.25</td>
<td>1543.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.1</td>
<td>194.15</td>
<td>1544.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td>44.9</td>
<td>194.05</td>
<td>1544.92</td>
</tr>
</tbody>
</table>
## Table B-14  AD-4B-xx.x Channel Allocation Plan by Band (continued)

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>Band ID</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD-4B-46.1</td>
<td>B46.1</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>46.5</td>
<td>193.85</td>
<td>1546.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47.3</td>
<td>193.75</td>
<td>1547.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.1</td>
<td>193.65</td>
<td>1548.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48.9</td>
<td>193.55</td>
<td>1548.91</td>
</tr>
<tr>
<td>B50.1</td>
<td>50.1</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50.5</td>
<td>193.35</td>
<td>1550.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51.3</td>
<td>193.25</td>
<td>1551.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.1</td>
<td>193.15</td>
<td>1552.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52.9</td>
<td>193.05</td>
<td>1552.93</td>
</tr>
<tr>
<td>B54.1</td>
<td>54.1</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54.5</td>
<td>192.85</td>
<td>1554.54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55.3</td>
<td>192.75</td>
<td>1555.34</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.1</td>
<td>192.65</td>
<td>1556.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.5</td>
<td>192.6</td>
<td>1556.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56.9</td>
<td>192.55</td>
<td>1556.96</td>
</tr>
<tr>
<td>B58.1</td>
<td>58.1</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58.5</td>
<td>192.35</td>
<td>1558.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.3</td>
<td>192.25</td>
<td>1559.39</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60.2</td>
<td>192.15</td>
<td>1560.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61.0</td>
<td>192.05</td>
<td>1561.01</td>
</tr>
</tbody>
</table>

Table B-15 lists AD-4B-xx.x optical specifications.
### Table B-15 AD-4B-xx.x Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>–1 dB bandwidth</td>
<td>All SOP and within whole operating environmental range</td>
<td>COM Rx—Band Tx Band Rx—COM Tx</td>
<td>3.6</td>
<td>—</td>
<td>nm</td>
</tr>
<tr>
<td>–1 dB bandwidth</td>
<td>All SOP and within whole operating temperature range</td>
<td>COM Rx—Exp Tx Exp Rx—COM Tx</td>
<td>Refer to Table B-16.</td>
<td></td>
<td>nm</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating environmental range; two connectors included, VOA set at minimum attenuation</td>
<td>COM Rx—Band Tx 30.3/46.1</td>
<td>—</td>
<td>2.9</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating environmental range; two connectors included, VOA set at minimum attenuation</td>
<td>COM Rx—Band Tx 34.2/50.1</td>
<td>—</td>
<td>3.3</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating environmental range; two connectors included, VOA set at minimum attenuation</td>
<td>COM Rx—Band Tx 38.1/54.1</td>
<td>—</td>
<td>3.8</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (drop section)</td>
<td>All SOP and within whole operating environmental range; two connectors included, VOA set at minimum attenuation</td>
<td>COM Rx—Band Tx 42.1/58.1</td>
<td>—</td>
<td>4.5</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (express section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Exp Rx—COM Tx</td>
<td>—</td>
<td>4.9</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>COM Rx—Exp Tx</td>
<td>—</td>
<td>3</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Band Rx 30.3/46.1—COM Tx</td>
<td>—</td>
<td>3.5</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Band Rx 34.2/50.1—COM Tx</td>
<td>—</td>
<td>2.8</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Band Rx 38.1/54.1—COM Tx</td>
<td>—</td>
<td>2.3</td>
<td>dB</td>
</tr>
<tr>
<td>Insertion loss (add section)</td>
<td>All SOP and within whole operating environmental range; two connectors included</td>
<td>Band Rx 42.1/58.1—COM Tx</td>
<td>—</td>
<td>1.8</td>
<td>dB</td>
</tr>
<tr>
<td>VOA dynamic range</td>
<td>—</td>
<td></td>
<td>—</td>
<td>30</td>
<td>dB</td>
</tr>
<tr>
<td>Maximum optical input power</td>
<td>—</td>
<td></td>
<td>—</td>
<td>300</td>
<td>mW</td>
</tr>
</tbody>
</table>

Table B-16 lists the range of wavelengths for the receive (express) band.

### Table B-16 AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

<table>
<thead>
<tr>
<th>Tx (Dropped) Band</th>
<th>Rx (Express) Band</th>
<th>Left Side (nm)</th>
<th>Right Side (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B30.3</td>
<td>—</td>
<td>Wavelengths 1533.825 or higher</td>
<td></td>
</tr>
<tr>
<td>B34.2</td>
<td>Wavelengths 1533.395 or lower</td>
<td>Wavelengths 1537.765 or higher</td>
<td></td>
</tr>
<tr>
<td>B38.1</td>
<td>Wavelengths 1537.325 or lower</td>
<td>Wavelengths 1541.715 or higher</td>
<td></td>
</tr>
<tr>
<td>B42.1</td>
<td>Wavelengths 1541.275 or lower</td>
<td>Wavelengths 1545.695 or higher</td>
<td></td>
</tr>
</tbody>
</table>
B.4.15 32WSS Card Specifications

Table B-16  AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges (continued)

<table>
<thead>
<tr>
<th>Tx (Dropped) Band</th>
<th>Rx (Express) Band</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left Side (nm)</td>
</tr>
<tr>
<td>B46.1</td>
<td>Wavelengths 1545.245 or lower</td>
</tr>
<tr>
<td>B50.1</td>
<td>Wavelengths 1549.235 or lower</td>
</tr>
<tr>
<td>B54.1</td>
<td>Wavelengths 1553.255 or lower</td>
</tr>
<tr>
<td>B58.1</td>
<td>Wavelengths 1557.285 or lower</td>
</tr>
</tbody>
</table>

AD-4B-xx.x optical input and output power varies with amplifier output levels and the class of transponder interfaces used. See Table 16-3 on page 16-6 through Table 16-5 on page 16-8 for this information.

The AD-4B-xx.x has the following additional specifications:

- Environmental
  - Operating temperature:  
    C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95 percent RH
- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.92 in. (23.4 mm)
  - Depth: 9.0 in. (228.6 mm)

B.4.15 32WSS Card Specifications

The 32WSS card optical specifications are listed in Table B-17.

Note

For power specifications, see the “16.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes” section on page 16-6.

Table B-17  32WSS Optical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Condition</th>
<th>Min</th>
<th>Typical</th>
<th>Max</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>–0.25 dB bandwidth</td>
<td>All SOP and within whole operating temperature range, connectors included, and for maximum VOA operating attenuation.</td>
<td>EXP RX =&gt; COM TX</td>
<td>+/–115</td>
<td>—</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>–0.5 dB bandwidth</td>
<td>—</td>
<td>+/–135</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>pm</td>
</tr>
<tr>
<td>–1.0 dB bandwidth</td>
<td>—</td>
<td>+/–160</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>pm</td>
</tr>
</tbody>
</table>
The 32WSS channel plan is shown in Table B-18. All 32WSS client interfaces must comply with this plan.

**Table B-18 32WSS Channel Plan**

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Band</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>30.3</td>
<td>195.9</td>
<td>1530.33</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>31.2</td>
<td>195.8</td>
<td>1531.12</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>31.9</td>
<td>195.7</td>
<td>1531.90</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>32.6</td>
<td>195.6</td>
<td>1532.68</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>34.2</td>
<td>195.4</td>
<td>1534.25</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>35.0</td>
<td>195.3</td>
<td>1535.04</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>35.8</td>
<td>195.2</td>
<td>1535.82</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>36.6</td>
<td>195.1</td>
<td>1536.61</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>38.1</td>
<td>194.9</td>
<td>1538.19</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>38.9</td>
<td>194.8</td>
<td>1538.98</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>39.7</td>
<td>194.7</td>
<td>1539.77</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>40.5</td>
<td>194.6</td>
<td>1540.56</td>
</tr>
</tbody>
</table>
The 32WSS card has the following additional specifications:

- **Environmental**
  - Operating temperature:
    - C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent RH

- **Dimensions**
  - Height: 12.65 in. (321.3 mm)
  - Width: 1.84 in. (46.8 mm)
  - Depth: 9.00 in. (228.6 mm)

### Table B-18  32WSS Channel Plan (continued)

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>Band</th>
<th>Channel ID</th>
<th>Frequency (GHz)</th>
<th>Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>4</td>
<td>42.1</td>
<td>194.4</td>
<td>1542.14</td>
</tr>
<tr>
<td>14</td>
<td>4</td>
<td>42.9</td>
<td>194.3</td>
<td>1542.94</td>
</tr>
<tr>
<td>15</td>
<td>5</td>
<td>43.7</td>
<td>194.2</td>
<td>1543.73</td>
</tr>
<tr>
<td>16</td>
<td>5</td>
<td>44.5</td>
<td>194.1</td>
<td>1544.53</td>
</tr>
<tr>
<td>17</td>
<td>5</td>
<td>46.1</td>
<td>193.9</td>
<td>1546.12</td>
</tr>
<tr>
<td>18</td>
<td>6</td>
<td>46.9</td>
<td>193.8</td>
<td>1546.92</td>
</tr>
<tr>
<td>19</td>
<td>6</td>
<td>47.7</td>
<td>193.7</td>
<td>1547.72</td>
</tr>
<tr>
<td>20</td>
<td>6</td>
<td>48.5</td>
<td>193.6</td>
<td>1548.51</td>
</tr>
<tr>
<td>21</td>
<td>6</td>
<td>50.1</td>
<td>193.4</td>
<td>1550.12</td>
</tr>
<tr>
<td>22</td>
<td>7</td>
<td>50.9</td>
<td>193.3</td>
<td>1550.92</td>
</tr>
<tr>
<td>23</td>
<td>7</td>
<td>51.7</td>
<td>193.2</td>
<td>1551.72</td>
</tr>
<tr>
<td>24</td>
<td>7</td>
<td>52.5</td>
<td>193.1</td>
<td>1552.52</td>
</tr>
<tr>
<td>25</td>
<td>7</td>
<td>54.1</td>
<td>192.9</td>
<td>1554.13</td>
</tr>
<tr>
<td>26</td>
<td>8</td>
<td>54.9</td>
<td>192.8</td>
<td>1554.94</td>
</tr>
<tr>
<td>27</td>
<td>8</td>
<td>55.7</td>
<td>192.7</td>
<td>1555.75</td>
</tr>
<tr>
<td>28</td>
<td>8</td>
<td>56.5</td>
<td>192.6</td>
<td>1556.55</td>
</tr>
<tr>
<td>29</td>
<td>8</td>
<td>58.1</td>
<td>192.4</td>
<td>1558.17</td>
</tr>
<tr>
<td>30</td>
<td>8</td>
<td>58.9</td>
<td>192.3</td>
<td>1558.98</td>
</tr>
<tr>
<td>31</td>
<td>8</td>
<td>59.7</td>
<td>192.2</td>
<td>1559.79</td>
</tr>
<tr>
<td>32</td>
<td>8</td>
<td>60.6</td>
<td>192.1</td>
<td>1560.61</td>
</tr>
</tbody>
</table>

This section provides specifications for the TXP_MR_10G, MXP_2.5G_10G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10E, and TXP_MR_2.5G cards.
For compliance information, refer to the *Cisco Optical Transport Products Safety and Compliance Information* document.

**B.5.1 TXP_MR_10G Card Specifications**

The TXP_MR_10G card has the following specifications:

- **Line (trunk side)**
  - Bit rate:
    - 9.95328 Gbps for OC-192/STM-64
    - 10.70923 Gbps with ITU-T G.709 Digital Wrapper/forward error correction (FEC)
    - 10.3125 Gbps for 10 Gigabit Ethernet (GE)
    - 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC over 10 GE
  - Code: Scrambled NRZ
  - Fiber: 1550-nm single-mode
  - Maximum chromatic dispersion allowance: 1000 ps/nm
  - Loopback modes: Terminal and facility

⚠️ **Caution**

You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

- Connectors: LC
- Compliance Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.691

- **Transmitter (trunk side)**
  - Maximum transmitter output power: +3.5 dBm
  - Minimum transmitter output power: +2.5 dBm
  - Transmitter: Lithium Niobate (LN) external modulator transmitter
  - Wavelength stability (drift): +/- 25 picometers (pm)

>Note

An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

- Currently available wavelengths and versions of TXP_MR_10G (16 card versions, each covering two wavelengths):
  - 1530.33 to 1531.12 nm (two wavelengths)
  - 1531.90 to 1532.68 nm (two wavelengths)
  - 1534.25 to 1535.04 nm (two wavelengths)
  - 1535.82 to 1536.61 nm (two wavelengths)
  - 1538.19 to 1538.98 nm (two wavelengths)
  - 1539.77 to 1540.56 nm (two wavelengths)
B.5.1 TXP_MR_10G Card Specifications

- 1542.14 to 1542.94 nm (two wavelengths)
- 1543.73 to 1544.53 nm (two wavelengths)
- 1546.12 to 1546.92 nm (two wavelengths)
- 1547.72 to 1548.52 nm (two wavelengths)
- 1550.12 to 1550.92 nm (two wavelengths)
- 1551.72 to 1552.52 nm (two wavelengths)
- 1554.13 to 1554.94 nm (two wavelengths)
- 1555.75 to 1556.55 nm (two wavelengths)
- 1558.17 to 1558.98 nm (two wavelengths)
- 1559.79 to 1560.61 nm (two wavelengths)

- Receiver (trunk side):
  - Receiver input power (no FEC, unamplified, 23 dB optical signal-to-noise ratio [OSNR], BER $1 \times 10^{-12}$): –8 to –21 dBm
  - Receiver input power (no FEC, unamplified, 23 dB OSNR, at +/- 1000 ps/nm BER $1 \times 10^{-12}$): –8 to –19 dBm
  - Receiver input power (no FEC, amplified, 19 dB OSNR, BER $1 \times 10^{-12}$): –8 to –20 dBm
  - Receiver input power (no FEC, amplified, 19 dB OSNR, at +/- 1000 ps/nm BER $1 \times 10^{-12}$): –8 to –18 dBm
  - Receiver input power (FEC, unamplified, 23 dB OSNR, BER $8 \times 10^{-5}$): –8 to –24 dBm
  - Receiver input power (FEC, unamplified, 23 dB OSNR, at +/- 1000 ps/nm, BER $8 \times 10^{-5}$): –8 to –22 dBm
  - Receiver input power (FEC, amplified, 9 dB OSNR, BER $8 \times 10^{-5}$): –8 to –18 dBm
  - Receiver input power (FEC, unamplified, 11 dB OSNR, at +/- 800 ps/nm, BER $8 \times 10^{-5}$): –8 to –18 dBm

- Line (client side)
  - Bit rate: 9.95328 Gbps or 10.3125 Gbps
  - Code: Scrambled NRZ
  - Fiber: 1550-nm single-mode
  - Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In the case of 10 GE, the allowance is up to 10 km of single-mode fiber (SMF) dispersion.
  - Loopback modes: Terminal and facility
  - Connectors: LC
  - Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.697, 10GEBase-LR

- Transmitter (client side)
  - Maximum transmitter output power: –1 dBm
  - Minimum transmitter output power: –6 dBm
  - Center wavelength: 1290 to 1330 nm
  - Nominal wavelength: 1310 nm
  - Transmitter: Distributed feedback (DFB) laser
B.5.2 MXP_2.5G_10G Card Specifications

The MXP_2.5G_10G card has the following specifications:

- **Receiver (client side)**
  - Maximum receiver level: –1 dBm at BER $1 \times 10^{-12}$
  - Minimum receiver level: –14 dBm at BER $1 \times 10^{-12}$
  - Receiver: avalanche photodiode (APD)
  - Link loss budget: 8 dB minimum, at BER = $1 \times 10^{-12}$
  - Receiver input wavelength range: 1290 to 1605 nm

- **Environmental**
  - Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

- **Dimensions**
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
  - Depth with backplane connector: 9.250 in. (235 mm)
  - Weight not including clam shell: 3.1 lb (1.3 kg)

- **Transmitter (trunk side)**
  - Maximum transmitter output power: +3.5 dBm
  - Minimum transmitter output power: +2.5 dBm

---

**Caution**

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

- Connectors: LC
B.5.2 MXP_2.5G_10G Card Specifications

- Transmitter: LN external modulator transmitter
- Wavelength stability (drift): +/- 25 picometers (pm)

**Note**

An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

- Currently available wavelengths and versions of MXP_2.5G_10G (16 card versions, each covering two wavelengths):
  - 1530.33 to 1531.12 nm (two wavelengths)
  - 1531.90 to 1532.68 nm (two wavelengths)
  - 1534.25 to 1535.04 nm (two wavelengths)
  - 1535.82 to 1536.61 nm (two wavelengths)
  - 1538.19 to 1538.98 nm (two wavelengths)
  - 1539.77 to 1540.56 nm (two wavelengths)
  - 1542.14 to 1542.94 nm (two wavelengths)
  - 1543.73 to 1544.53 nm (two wavelengths)
  - 1546.12 to 1546.92 nm (two wavelengths)
  - 1547.72 to 1548.51 nm (two wavelengths)
  - 1550.12 to 1550.92 nm (two wavelengths)
  - 1551.72 to 1552.52 nm (two wavelengths)
  - 1554.13 to 1554.94 nm (two wavelengths)
  - 1555.75 to 1556.55 nm (two wavelengths)
  - 1558.17 to 1558.98 nm (two wavelengths)
  - 1559.79 to 1560.61 nm (two wavelengths)

- Receiver (trunk side)
  - Receiver input power (no FEC, unamplified, 23 dB OSNR, BER 1 * 10 exp – 12): –8 to –21 dBm
  - Receiver input power (no FEC, unamplified, 23 dB OSNR, at +/- 1000 ps/nm BER 1 * 10 exp – 12): –8 to –19 dBm
  - Receiver input power (no FEC, amplified, 19 dB OSNR, BER 1 * 10 exp – 12): –8 to –20 dBm
  - Receiver input power (no FEC, amplified, 19 dB OSNR, at +/- 1000 ps/nm BER 1 * 10 exp – 12): –8 to –18 dBm
  - Receiver input power (FEC, unamplified, 23 dB OSNR, BER 8 * 10 exp – 5): –8 to –24 dBm
  - Receiver input power (FEC, unamplified, 23 dB OSNR, at +/- 1000 ps/nm, BER 8 * 10 exp – 5): –8 to –22 dBm
  - Receiver input power (FEC, amplified, 9 dB OSNR, BER 8 * 10 exp – 5): –8 to –18 dBm
  - Receiver input power (FEC, unamplified, 11 dB OSNR, at +/- 800 ps/nm, BER 8 * 10 exp – 5): –8 to –18 dBm

- Line (client side)
  - Bit rate: 2.48832 Gbps
B.5.3 TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications

The TXP_MR_2.5G and TXPP_MR_2.5G cards have the following specifications:

- **Line (trunk side)**
  - Bit rate:
    - 2.488 Gbps for OC-48/STM-16
    - 2.66 Gbps with ITU-T G.709 Digital Wrapper/FEC
  - Code: Scrambled NRZ
  - Fiber: 1550-nm single-mode
  - Maximum chromatic dispersion allowance: 5400 ps/nm
  - Loopback modes: Terminal and facility

⚠️ **Caution**

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G and TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_2.5G and TXPP_MR_2.5G cards.

- Connectors: LC

---

- Code: Scrambled NRZ
- Fiber: 1550-nm single-mode
- Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In the case of 10 GE, allowance is up to 10 km of SMF fiber of dispersion.
- Loopback modes: Terminal and facility
- Connectors: LC

- Transmitter (client side): Depends on the Small Form-factor Pluggable (SFP) that is used.
- Receiver (client side): Depends on the SFP that is used.

**Environmental**

- Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit)
- Operating humidity: 5 to 95 percent, noncondensing
- Power consumption: 50.00 W, 1.04 A at –48 V, 170.7 BTU/hr

**Dimensions**

- Height: 12.650 in. (321.3 mm)
- Width: 0.716 in. (18.2 mm)
- Depth: 9.000 in. (228.6 mm)
- Depth with backplane connector: 9.250 in. (235 mm)
- Weight not including clam shell: 3.1 lb (1.3 kg)
### B.5.3 TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications

#### Transmitter (trunk side)
- Maximum transmitter output power: +1 dBm
- Minimum transmitter output power: -4.5 dBm
- Transmitter: Direct modulated laser
- Wavelength stability (drift): +/- 25 picometers (pm)

#### Note
An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

#### Currently available wavelengths of TXP_MR_2.5G and TXPP_MR_2.5G (eight card versions):
- ITU grid blue band: 1530.334 to 1544.526 nm (four card versions covering four wavelengths each)
- ITU grid red band: 1546.119 to 1560.606 nm (four card versions covering four wavelengths each)

#### Receiver (trunk side)
- Receiver: APD
- Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at BER = 1 * 10^–12 including dispersion
- Receiver input wavelength range: 1290 to 1605 nm

#### Table B-19 TXP_MR_2.5G/TXPP_MR_2.5G Receiver Trunk Side Specifications

<table>
<thead>
<tr>
<th>OSNR</th>
<th>FEC Type</th>
<th>Pre-FEC BER</th>
<th>Post-FEC BER</th>
<th>Input Power Sensitivity</th>
<th>Chromatic Dispersion Tolerance</th>
</tr>
</thead>
<tbody>
<tr>
<td>22 dB</td>
<td>Off - 2R</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 9 to – 24 dBm</td>
<td>—</td>
</tr>
<tr>
<td>22 dB</td>
<td>Off - 2R</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 9 to – 21 dBm</td>
<td>+/- 3300ps/nm</td>
</tr>
<tr>
<td>21 dB</td>
<td>Off - 3R</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 9 to – 30 dBm</td>
<td>—</td>
</tr>
<tr>
<td>22 dB</td>
<td>Off - 3R</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 9 to – 30 dBm</td>
<td>+/- 1800ps/nm</td>
</tr>
<tr>
<td>23 dB</td>
<td>Off - 3R</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 9 to – 30 dBm</td>
<td>+/- 5400ps/nm</td>
</tr>
<tr>
<td>12 dB</td>
<td>Standard- 3R</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 9 to – 25 dBm</td>
<td>—</td>
</tr>
<tr>
<td>12 dB</td>
<td>Standard- 3R</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 9 to – 24 dBm</td>
<td>+/- 1800ps/nm</td>
</tr>
<tr>
<td>12 dB</td>
<td>Standard- 3R</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 9 to – 23 dBm</td>
<td>+/- 5400ps/nm</td>
</tr>
<tr>
<td>21 dB</td>
<td>Standard- 3R</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 9 to – 31 dBm</td>
<td>—</td>
</tr>
</tbody>
</table>

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.1 nm Resolution Bandwidth (RBW)

#### Line (client side)
- Bit rate: 8 Mbps to 2.488 Gbps
- Code: Scrambled NRZ
- Fiber: 1310-nm single-mode
- Maximum chromatic dispersion allowance: 1600 ps/nm
- Loopback modes: Terminal and facility
- Connectors: LC
**Transmitter (client side)**
- Maximum transmitter output power: –1 dBm
- Minimum transmitter output power: –6 dBm
- Center wavelength: 1290 to 1330 nm
- Nominal wavelength: 1310 nm
- Transmitter: DFB laser

**Receiver (client side)**
- Maximum receiver level: –1 dBm at BER 1 * 10 \(^{-12}\)
- Minimum receiver level: –14 dBm at BER 1 * 10 \(^{-12}\)
- Receiver: APD
- Link loss budget: 8 dB minimum, at BER = 1 * 10 \(^{-12}\)
- Receiver input wavelength range: 1290 to 1605 nm

**Environmental**
- Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit)
- Operating humidity: 5 to 95 percent, noncondensing
- Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

**Dimensions**
- Height: 12.650 in. (321.3 mm)
- Width: 0.716 in. (18.2 mm)
- Depth: 9.000 in. (228.6 mm)
- Depth with backplane connector: 9.250 in. (235 mm)
- Weight not including clam shell: 3.1 lb (1.3 kg)

---

**B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications**

The MXP_MR_2.5G and MXPP_MR_2.5G cards have the following specifications:

- **Payload configuration**
  - FC1G—Fiber Channel 1.06 Gbps
  - FC2G—Fiber Channel 2.125 Gbps
  - FICON1G—Fiber CON 1.06 Gbps (IBM signal)
  - FICON2G—Fiber CON 2.125 Gbps (IBM signal)
  - ONE_GE—One Gigabit Ethernet 1.125 Gbps
  - Mixed configurations up to maximum line rate (for example, if you have a port configured for 2G FC, you cannot use another port at the same time)

- Client ports: 8x SFP
- Performance monitoring (PM) for all interfaces
- Buffer-to-buffer credit management for distance extension
- Line (trunk side)
B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications

- Bit rate: 2.488 Gbps for OC-48/STM-16
- Code: Scrambled NRZ
- Fiber: 1550-nm single-mode
- Maximum chromatic dispersion allowance: 6000 ps/nm
- Loopback modes: Terminal and facility

⚠️ Caution
You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and MXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

- Connectors: LC

- Transmitter (trunk side)
  - Transmit power: +3 +/- 1 dBm with MXP_MR_2.5G card, and +/- 1 dBm with MXPP_MR_2.5G card
  - 50-GHz DWDM migration ready (the wavelength deviation is less than +/- 0.040 nm through wavelocker deployment)
  - Four-channel wavelength tunability at 100-GHz spacing
  - Transmitter maximum return reflectance: –27 dB
  - Chromatic dispersion allowance: 5400 ps/nm, giving an optical power penalty < 2.0 dB
  - Minimum side mode suppression ratio: 30 dB
  - Transmitter is a direct modulated laser
  - Wavelength stability (drift): +/- 25 picometers (pm)

⚠️ Note
An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

- Currently available wavelengths of the TXP_MR_2.5G and TXPP_MR_2.5G cards (eight card versions):
  - ITU grid blue band: 1530.334 to 1544.526 nm (four card versions, four wavelengths each)
  - ITU grid red band: 1546.119 to 1560.606 nm (four card versions, four wavelengths each)

- Receiver (trunk side)

<table>
<thead>
<tr>
<th>Table B-20</th>
<th>MXP_MR_2.5G/MXPP_MR_2.5G Receiver Trunk Side Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSNR1</td>
<td>FEC Type</td>
</tr>
<tr>
<td>17 dB</td>
<td>N/A</td>
</tr>
<tr>
<td>17 dB</td>
<td>N/A</td>
</tr>
<tr>
<td>17 dB</td>
<td>N/A</td>
</tr>
<tr>
<td>18 dB</td>
<td>N/A</td>
</tr>
</tbody>
</table>
B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications

### MXP_MR_2.5G/MXPP_MR_2.5G Receiver Trunk Side Specifications (continued)

<table>
<thead>
<tr>
<th>OSNR</th>
<th>FEC Type</th>
<th>Pre-FEC BER</th>
<th>Post-FEC BER</th>
<th>Input Power Sensitivity</th>
<th>Chromatic Dispersion Tolerance</th>
</tr>
</thead>
<tbody>
<tr>
<td>19 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 23 dBm</td>
<td>+/- 5400 ps/nm</td>
</tr>
<tr>
<td>21 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 30 dBm</td>
<td>—</td>
</tr>
<tr>
<td>21 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 29 dBm</td>
<td>+/- 1800 ps/nm</td>
</tr>
<tr>
<td>21 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 28 dBm</td>
<td>+/- 5400 ps/nm</td>
</tr>
<tr>
<td>22 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 30 dBm</td>
<td>+/- 1800 ps/nm</td>
</tr>
<tr>
<td>23 dB</td>
<td>N/A</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>–9 to – 30 dBm</td>
<td>+/- 5400 ps/nm</td>
</tr>
</tbody>
</table>

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.1 nm Resolution Bandwidth (RBW)

- Receiver sensitivity: –28 dBm, BER 1 * 10 exp – 12
- Receiver overload is equal to or exceeds –8 dBm
- Receiver maximum reflectance of –27 dB

**Line (client side)**
- Bit rate: 1.06 Gbps to 2.125 Gbps per client
- Code: Scrambled NRZ
- Fiber: 1310-nm single-mode or 850-nm multimode
- Maximum chromatic dispersion allowance: 1600 ps/nm
- Loopback modes: Terminal and facility
- Connectors: LC

**Transmitter (client side)**
- Maximum transmitter output power: –1 dBm
- Minimum transmitter output power: –6 dBm
- Center wavelength: 1290 to 1330 nm
- Nominal wavelength: 1310 nm
- Transmitter: DFB laser

**Receiver (client side)**
- Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12
- Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12
- Receiver: APD
- Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12
- Receiver input wavelength range: 1290 to 1605 nm

**Environmental**
- Operating temperature: –5 to +40 degrees Celsius (+23 to +104 degrees Fahrenheit)
- Operating humidity: 5 to 85 percent, noncondensing
- Power consumption (maximum): 60 W, 1.25 A at –48 V, 204 BTU/hr
Appendix B      Hardware Specifications

B.5.5 MXP_2.5G_10E Card Specifications

The MXP_2.5G_10E card has the following specifications:

- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
  - Depth with backplane connector: 9.250 in. (235 mm)
  - Weight not including clam shell: 2.25 lb (1.02 kg)

- Line (trunk side)
  - Bit rate: 10.70923 Gbps (in ITU-T G.709 Digital Wrapper/FEC mode)
  - Code: Scrambled NRZ
  - Fiber: 1550-nm single-mode
  - Maximum chromatic dispersion allowance: +/- 1200 ps/nm (specified penalty)
  - Loopback modes: Terminal and facility

⚠️ Caution

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10E card in a loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10E card. Using direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10E card.

- Connectors: LC

- Transmitter (trunk side)
  - Maximum transmitter output power: +6 dBm
  - Minimum transmitter output power: +3 dBm
  - Transmitter: LN external modulator transmitter
  - Wavelength stability (drift): +/- 25 picometers (pm)

Note

An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

- Currently available wavelengths and versions of MXP_2.5G_10E (eight card versions):
  - ITU grid blue band:
    - 1530.33 to 1533.07 nm (four channels)
    - 1534.25 to 1537.00 nm (four channels)
    - 1538.19 to 1540.95 nm (four channels)
    - 1542.14 to 1544.92 nm (four channels)
  - ITU grid red band:
    - 1546.12 to 1548.92 nm (four channels)
Appendix B  Hardware Specifications

B.5.5 MXP_2.5G_10E Card Specifications

- 1550.12 to 1552.93 nm (four channels)
- 1554.13 to 1556.96 nm (four channels)
- 1558.17 to 1561.01 nm (four channels)

- Receiver (trunk side)

Table B-21  MXP_2.5G_10E Receiver Trunk Side Specifications

<table>
<thead>
<tr>
<th>OSNR</th>
<th>FEC Type</th>
<th>Pre-FEC BER</th>
<th>Post-FEC BER</th>
<th>Input Power Sensitivity&lt;sup&gt;2&lt;/sup&gt;</th>
<th>Chromatic Dispersion Tolerance</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 dB</td>
<td>Off</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 8 to – 20 dBm</td>
<td>+/- 1200 ps/nm</td>
</tr>
<tr>
<td>26 dB</td>
<td>Off</td>
<td>&lt;10 exp – 12</td>
<td>N/A</td>
<td>– 8 to – 22 dBm</td>
<td>---</td>
</tr>
<tr>
<td>17 dB</td>
<td>Standard</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 8 to – 18 dBm</td>
<td>+/- 800 ps/nm</td>
</tr>
<tr>
<td>15 dB</td>
<td>Standard</td>
<td>&lt;10 exp – 5</td>
<td>&lt;10 exp – 15</td>
<td>– 8 to – 18 dBm</td>
<td>---</td>
</tr>
<tr>
<td>14 dB</td>
<td>Enhanced</td>
<td>&lt;7 x 10 exp – 4</td>
<td>&lt;10 exp – 15</td>
<td>– 8 to – 18 dBm</td>
<td>+/- 800 ps/nm</td>
</tr>
</tbody>
</table>

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.1 nm Resolution Bandwidth (RBW)
2. Receiver filter bandwidth greater than or equal to 180 pm (at – 3 dBm)

- Receiver: APD
- Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at BER = 1 * 10 exp – 12 including dispersion
- Receiver input wavelength range: 1290 to 1605 nm

- Line (client side)
  - Bit rate: 2.5 Gbps per port (OC-48/STM-16)
  - Code: Scrambled NRZ
  - Fiber: 1310-nm single-mode
  - Maximum chromatic dispersion allowance: 12 ps/nm (SR SFP version)
  - Loopback modes: Terminal and facility
  - Connectors: LC (optical)

- Transmitter (client side): Depends on the SFP that is used.
- Receiver (client side): Depends on the SFP that is used.

- Environmental
  - Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr

- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
B.5.6 TXP_MR_10E Card Specifications

The TXP_MR_10E card has the following specifications:

- **Line (trunk side)**
  - Bit rate: OC-192/STM-64 (9.95328 Gbps), OTU2 (10.70923 Gbps), 10GE (10.3125 Gbps), 10GE into OTU2 (non-standard 11.0957 Gbps), 10G FC (10.51875 Gbps), or 10G FC into OTU2 (non-standard 11.31764 Gbps)
  - Code: Scrambled NRZ
  - Fiber: 1550-nm single-mode
  - Maximum chromatic dispersion allowance: +/- 1200 ps/nm (specified penalty)
  - Loopback modes: Terminal and facility

Caution: You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

- Connectors: LC

- **Transmitter (trunk side)**
  - Maximum transmitter output power: +6 dBm
  - Minimum transmitter output power: +3 dBm for C-band and +2 dBm for L-band
  - Transmitter: LN external modulator transmitter
  - Wavelength stability (drift): +/- 25 picometers (pm)

Note: An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal value. The allowed drift is +/- 25 pm.

- Currently available wavelengths and versions of TXP_MR_10E:
  - C-band frequency plan (eight card versions, each with four tunable channels on the ITU 100-GHz grid):
    - 1530.33 to 1533.07 nm (four channels)
    - 1534.25 to 1537.00 nm (four channels)
    - 1538.19 to 1540.95 nm (four channels)
    - 1542.14 to 1544.92 nm (four channels)
    - 1546.12 to 1548.92 nm (four channels)
    - 1550.12 to 1552.93 nm (four channels)
    - 1554.13 to 1556.96 nm (four channels)
B.5.6 TXP_MR_10E Card Specifications

- 1558.17 to 1561.01 nm (four channels)

L-band frequency plan (five card versions, each with eight tunable channels on the ITU 50-GHz grid):
- 1577.44 to 1580.35 nm (eight channels)
- 1580.77 to 1583.69 nm (eight channels)
- 1584.11 to 1587.04 nm (eight channels)
- 1587.46 to 1590.41 nm (eight channels)
- 1590.83 to 1593.79 nm (eight channels)

- Receiver (trunk side)

<table>
<thead>
<tr>
<th>Table B-22</th>
<th>TXP_MR_10E Receiver Trunk Side Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSNR1</td>
<td>FEC Type</td>
</tr>
<tr>
<td>30 dB</td>
<td>Off</td>
</tr>
<tr>
<td>26 dB</td>
<td>Off</td>
</tr>
<tr>
<td>26 dB</td>
<td>Off</td>
</tr>
<tr>
<td>17 dB</td>
<td>Standard</td>
</tr>
<tr>
<td>15 dB</td>
<td>Standard</td>
</tr>
<tr>
<td>15 dB</td>
<td>Enhanced</td>
</tr>
<tr>
<td>14 dB</td>
<td>Enhanced</td>
</tr>
</tbody>
</table>

1. Optical Signal-to-Noise ratio (OSNR) defined with 0.1 nm Resolution Bandwidth (RBW)
2. Receiver filter bandwidth greater than or equal to 180 pm (at –3 dBm)

- Receiver: APD
- Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at BER = 1 * 10 exp – 12 including dispersion
- Receiver input wavelength range: 1290 to 1605 nm

- Line (client side):
  - 10-Gigabit Small Form-factor Pluggable (XFP)-based SR
  - Bit rate: 10GE (10.3125 Gbps), 10G FC (10.51875 Gbps), or STM-64/OC-192
  - Code: Scrambled NRZ
  - Fiber: 1310-nm single-mode
  - Maximum chromatic dispersion allowance: 6.6 ps/nm
  - Loopback modes: Terminal and facility
  - Connectors: LC

- Transmitter (client side)
  - Maximum transmitter output power: –1 dBm
  - Minimum transmitter output power: –6 dBm
  - Center wavelength: 1290 to 1330 nm
B.6 SFP Specifications

Table B-23 lists the specifications for available SFPs.

Table B-23  SFP Specifications

<table>
<thead>
<tr>
<th>SFP Product ID</th>
<th>Interface</th>
<th>Transmitter Output Power Min/Max (dBm)</th>
<th>Receiver Input Power Min/Max (dBm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-SFP3-1-IR=</td>
<td>OC-3</td>
<td>–15 to –8</td>
<td>–23 to –8</td>
</tr>
<tr>
<td>15454E-SFP-L.1.1=</td>
<td>STM-1</td>
<td>–15 to –8</td>
<td>–34 to –10</td>
</tr>
<tr>
<td>15454-SFP12-4-IR=</td>
<td>OC-12, D1 Video</td>
<td>–15 to –8</td>
<td>–28 to –7</td>
</tr>
<tr>
<td>15454E-SFP-L.4.1=</td>
<td>STM-4, D1 Video</td>
<td>–15 to –8</td>
<td>–28 to –8</td>
</tr>
<tr>
<td>15454-SFP-OC48-IR=</td>
<td>OC-48, DV6000 (C-Cor)</td>
<td>–5 to +0</td>
<td>–18 to +0</td>
</tr>
<tr>
<td>ONS-SE-2G-S1=</td>
<td>OC-48, STM-16</td>
<td>–10 to –3</td>
<td>–18 to –3</td>
</tr>
<tr>
<td>15454E-SFP-L.16.1=</td>
<td>STM-16, DV6000 (C-Cor)</td>
<td>–5 to +0</td>
<td>–18 to 0</td>
</tr>
<tr>
<td>15454-SFP-200/15454E-SFP-200</td>
<td>ESCON1</td>
<td>–8 to –4</td>
<td>–28 to –3</td>
</tr>
<tr>
<td>15454-SFP-GEFC-SX=</td>
<td>Fibre Channel (1 and 2 Gbps), FICON², GE</td>
<td>–10 to –3.5</td>
<td>–17 to 0 (1FC and 1GE) –15 to 0 (2FC)</td>
</tr>
</tbody>
</table>

- Nominal wavelength: 1310 nm
- Transmitter: DFB laser
- Receiver (client side)
  - Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12
  - Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12
  - Receiver: APD
  - Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12
  - Receiver input wavelength range: 1290 to 1605 nm
- Environmental
  - Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit)
  - Operating humidity: 5 to 95 percent, noncondensing
  - Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr
- Dimensions
  - Height: 12.650 in. (321.3 mm)
  - Width: 0.716 in. (18.2 mm)
  - Depth: 9.000 in. (228.6 mm)
  - Depth with backplane connector: 9.250 in. (235 mm)
  - Weight not including clam shell: 3.1 lb (1.3 kg)
Table B-23  SFP Specifications (continued)

<table>
<thead>
<tr>
<th>SFP Product ID</th>
<th>Interface</th>
<th>Transmitter Output Power Min/Max (dBm)</th>
<th>Receiver Input Power Min/Max (dBm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-SFP-GE+-LX=</td>
<td>Fibre Channel (1 and 2 Gbps), FICON, GE, HDTV</td>
<td>–9.5 to –3.0</td>
<td>–20 to –3 (1FC, 1GE, and 2FC)</td>
</tr>
<tr>
<td>ONS-SE-2G-L2</td>
<td>OC-48, STM-16</td>
<td>–2 to 3</td>
<td>–28 to –9</td>
</tr>
</tbody>
</table>

1. ESCON = Enterprise System Connection
2. FICON = fiber connectivity
3. HDTV = high-definition television

SFP Port Cabling Specifications

Table B-24 provides cabling specifications for the single-mode fiber (SMF) SFPs and Table B-25 provides cabling specifications for multimode fiber (MMF) SFPs that you install into Ethernet cards. The ports of the listed SFPs have LC-type connectors.

Table B-24  Single-Mode Fiber SFP Port Cabling Specifications

<table>
<thead>
<tr>
<th>SFP Product ID</th>
<th>Wavelength</th>
<th>Fiber Type</th>
<th>Cable Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-SFP3-1-IR=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>15454E-SFP-L.1.1=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>15454-SFP12-4-IR=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>15454E-SFP-L.4.1=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>15454-SFP-OC48-IR=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>ONS-SE-2G-S1=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>2 km (1.2 miles)</td>
</tr>
<tr>
<td>15454E-SFP-L.16.1=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>15 km (9.3 miles)</td>
</tr>
<tr>
<td>15454-SFP-GE+-LX=</td>
<td>1310 nm</td>
<td>9 micron SMF</td>
<td>10 km (6.2 miles) for FC 1G, FC 2G, and GE 5 km (3.1 miles) for HDTV</td>
</tr>
</tbody>
</table>

1. Typical loss on a 1310 nm wavelength is 0.6 dB/km.
B.7 XFP Specifications

Table B-26 lists the specifications for available XFPs.

### Table B-26  Multimode Fiber SFP Port Cabling Specifications

<table>
<thead>
<tr>
<th>SFP Product ID</th>
<th>Wavelength</th>
<th>Fiber Type</th>
<th>Cable Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>15454-SFP-200/15454E-SFP-200 Long Reach</td>
<td>1310 nm</td>
<td>62.5 micron MMF</td>
<td>2 km (1.2 miles)</td>
</tr>
<tr>
<td>15454-SFP-GEFC-SX/15454E-SFP-GEFC-S Short Reach</td>
<td>850 nm</td>
<td>62.5 micron MMF</td>
<td>300 m (984 ft) for FC 1 Gbps and 1.2 Gbps GE 150 m (492 ft) for FC 2 Gbps 50.0 micron MMF</td>
</tr>
</tbody>
</table>

### Table B-27  XFP Specifications

<table>
<thead>
<tr>
<th>XFP Product ID</th>
<th>Interface</th>
<th>Transmitter Output Power Min/Max (dBm)</th>
<th>Receiver Input Power Min/Max (dBm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONS-XC-10G-S1</td>
<td>10 Gigabit Ethernet, OC-192, STM-64, 10Gbps Fibre Channel</td>
<td>-1 to -11</td>
<td>0.5</td>
</tr>
</tbody>
</table>

### B.7.1 XFP Port Cabling Specifications

Table B-27 provides cabling specifications for the SMF XFPs. The ports of the listed XFPs have LC-type connectors.

### Table B-27  Single-Mode Fiber XFP Port Cabling Specifications

<table>
<thead>
<tr>
<th>XFP Product ID</th>
<th>Wavelength</th>
<th>Fiber Type</th>
<th>Cable Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>ONS-XC-10G-S1</td>
<td>1310 nm</td>
<td>SMF</td>
<td>10 km (6.2 miles)</td>
</tr>
</tbody>
</table>

1. Typical loss on a 1310 nm wavelength is 0.6 dB/km.
This appendix describes the administrative and service states for Cisco ONS 15454 dense wavelength division multiplexing (DWDM) cards, optical payload ports, out-of-band optical service channel (OSC) ports, optical channel network connections (OCHNCs), and transponder/muxponder cards and ports. States for Software Release 5.0 and later are based on the generic state model defined in Telcordia GR-1093-Core, Issue 2 and ITU-T X.731.

C.1 Service States

Service states include a Primary State (PST), a Primary State Qualifier (PSTQ), and one or more Secondary States (SST). Table C-1 lists the ANSI and ETSI service state PSTs and PSTQs supported by the ONS 15454.

<table>
<thead>
<tr>
<th>ANSI Primary State, Primary State Qualifier</th>
<th>ETSI Primary State, Primary State Qualifier</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (In-Service and Normal)</td>
<td>Unlocked-enabled</td>
<td>The entity is fully operational and will perform as provisioned.</td>
</tr>
<tr>
<td>OOS-AU (Out-of-Service and Autonomous)</td>
<td>Unlocked-disabled</td>
<td>The entity is not operational because of an autonomous event.</td>
</tr>
<tr>
<td>OOS-AUMA (Out-of-Service and Autonomous Management)</td>
<td>Locked-disabled</td>
<td>The entity is not operational because of an autonomous event and has also been manually removed from service.</td>
</tr>
<tr>
<td>OOS-MA (Out-of-Service and Management)</td>
<td>Locked-enabled</td>
<td>The entity has been manually removed from service.</td>
</tr>
</tbody>
</table>

Table C-2 defines the ANSI and ETSI SSTs supported by the ONS 15454.
Appendix C    DWDM Administrative and Service States

Table C-2     ONS 15454 Secondary States

<table>
<thead>
<tr>
<th>ANSI Secondary State</th>
<th>ETSI Secondary State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AINS</td>
<td>automaticInService</td>
<td>The entity is delayed before transitioning to the IS-NR (ANSI)/Unlocked-enabled (ETSI) service state. The transition to IS-NR/Unlocked-enabled depends on correction of conditions. Alarm reporting is suppressed, but traffic is carried. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the Cisco Transport Controller (CTC) Conditions tab or by using the TL1 RTRV-COND command.</td>
</tr>
<tr>
<td>DSBLD</td>
<td>disabled</td>
<td>The entity was manually removed from service and does not provide its provisioned functions. All services are disrupted; unable to carry traffic.</td>
</tr>
<tr>
<td>FLT</td>
<td>failed</td>
<td>The entity has a raised alarm or condition.</td>
</tr>
<tr>
<td>MEA</td>
<td>mismatchOfEquipment</td>
<td>An improper card is installed. For example, an installed card is not compatible with the card preprovisioning or the slot. This SST applies only to cards.</td>
</tr>
<tr>
<td>MT</td>
<td>maintenance</td>
<td>The entity has been manually removed from service for a maintenance activity but still performs its provisioned functions. Alarm reporting is suppressed, but traffic is carried. Raised fault conditions, whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command.</td>
</tr>
<tr>
<td>SWDL</td>
<td>softwareDownload</td>
<td>The card is involved in a software and database download. This SST applies only to cards.</td>
</tr>
<tr>
<td>UAS</td>
<td>unassigned</td>
<td>The card is not provisioned in the database. This SST applies only to cards.</td>
</tr>
<tr>
<td>UEQ (Unequipped)</td>
<td>notInstalled</td>
<td>The card is not physically present (that is, an empty slot). This SST applies only to cards.</td>
</tr>
</tbody>
</table>

Table C-3     ONS 15454 Administrative States

<table>
<thead>
<tr>
<th>ANSI Administrative State (PST,SST)</th>
<th>ETSI Administrative State (PST,SST)</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS</td>
<td>Unlocked</td>
<td>Puts the entity in service.</td>
</tr>
<tr>
<td>IS,AINS</td>
<td>Unlocked,automaticInService</td>
<td>Puts the entity in automatic in-service.</td>
</tr>
</tbody>
</table>

C.2 Administrative States

Administrative states are used to manage service states. Administrative states consist of a PST and an SST. Table C-3 lists the ANSI and ETSI administrative states supported by the ONS 15454. See Table C-2 for SST definitions.

Note: A change in the administrative state of an entity does not change the service state of supporting or supported entities.
C.3 Service State Transitions

This section describes the transition from one service state to the next state for DWDM cards, optical payload ports, OSC ports, OCHNCs, and transponder/muxponder cards and ports. A service state transition is based on the action performed on the entity and any autonomous activity.

C.3.1 DWDM Card Service State Transitions

Table C-4 lists ANSI and ETSI service state transitions for AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, OSC-CSM, OSCM, OPT-BST, OPT-PRE, 4MD-xx.x, 32WSS, 32MUX-O, and 32DMX-O cards.

Table C-4 ONS 15454 Optical Unit Service State Transitions

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI)</td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td>Unlocked-enabled (ETSI)</td>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Reset the card.</td>
<td>OOS-AU,SWDL (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,AINS &amp; MEA (ANSI)</td>
<td>Pull the card.</td>
<td>OOS-AU,AINS &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService &amp; mismatchOfEquipment (ETSI)</td>
<td></td>
<td>Unlocked-disabled,automaticInService &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>If the card is valid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-AUMA,UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the card is invalid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-AUMA,MEA &amp; UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-4  ONS 15454 Optical Unit Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
</table>
| OOS-AU,AINS & SWDL (ANSI) Unlocked-disabled,automaticInService & softwareDownload (ETSI) | Restart completed. | IS-NR (ANSI)  
  Unlocked-enabled (ETSI)  
  OOS-AU,AINS & MEA (ANSI)  
  Unlocked-disabled,automaticInService & mismatchOfEquipment (ETSI) |
| Pull the card.         |                               | OOS-AU,AINS & UEQ (ANSI)  
  Unlocked-disabled,automaticInService & notInstalled (ETSI) |
| OOS-AU,AINS & UEQ (ANSI) Unlocked-disabled,automaticInService & notInstalled (ETSI) | Insert a valid card. | OOS-AU,AINS & SWDL (ANSI)  
  Unlocked-disabled,automaticInService & softwareDownload (ETSI) |
| Insert an invalid card. |                               | OOS-AU,AINS & MEA (ANSI)  
  Unlocked-disabled,automaticInService & mismatchOfEquipment (ETSI) |
| Delete the card.       |                               | OOS-AUMA,UAS & UEQ (ANSI)  
  Locked-disabled,unassigned & notInstalled (ETSI) |
| OOS-AU,FLT (ANSI)      | Pull the card.                | OOS-AU,UEQ (ANSI)  
  Unlocked-disabled,unequipped (ETSI)  
  OOS-AUMA,UAS (ANSI)  
  Locked-disabled,unassigned (ETSI) |
| Delete the card.       |                               | OOS-AUMA,UAS (ANSI)  
  Locked-disabled,unassigned (ETSI) |
| Change the administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI). | | OOS-AUMA,FLT & MT (ANSI)  
  Locked-disabled,failed & maintenance (ETSI) |
| Reset the card.        |                               | OOS-AU,SWDL (ANSI)  
  Unlocked-disabled,softwareDownload (ETSI) |
| Alarm/condition is cleared. |                               | IS-NR (ANSI)  
  Unlocked-enabled (ETSI) |
| OOS-AU,MEA (ANSI)      | Pull the card.                | OOS-AU,UEQ (ANSI)  
  Unlocked-disabled,notInstalled (ETSI) |
| Delete the card.       |                               | If the card is valid:  
  - OOS-AUMA,UAS (ANSI)  
  - Locked-disabled,unassigned (ETSI) |
| If the card is invalid: |                               | - OOS-AUMA,MEA & UAS (ANSI)  
  - Locked-disabled,mismatchOfEquipment & unassigned (ETSI) |
### C.3.1 DWDM Card Service State Transitions

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,SWDL (ANSI)</td>
<td>Restart completed.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,softwareDownload (ETSI)</td>
<td></td>
<td>Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-AU,MEA (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,notInstalled (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,UEQ (ANSI)</td>
<td>Insert a valid card.</td>
<td>OOS-AU,SWDL (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,notInstalled (ETSI)</td>
<td></td>
<td>Unlocked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Insert an invalid card.</td>
<td>OOS-AU,MEA (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td>Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td></td>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Change the administrative state to</td>
<td>OOS-AU,FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td>IS (ANSI) or Unlocked (ETSI).</td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Reset the card.</td>
<td>OOS-AUMA,MT &amp; SWDL (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,MEA &amp; UAS (ANSI)</td>
<td>Pull the card.</td>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td>Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI)</td>
<td></td>
<td>Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Provision the card.</td>
<td>OOS-AU,MEA (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,MT &amp; SWDL (ANSI)</td>
<td>Restart completed.</td>
<td>OOS-MA,MT (ANSI)</td>
</tr>
<tr>
<td>Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
<td></td>
<td>Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-AUMA,MEA &amp; MT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,mismatchOfEquipment &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
</tbody>
</table>
Table C-5 lists the ANSI and ETSI optical payload port service state transitions.

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>The OCHNC end-to-end path no longer exists.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
</tbody>
</table>

C.3.2 Optical Payload Port Service State Transitions

Table C-5 lists the ANSI and ETSI optical payload port service state transitions.

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>The OCHNC end-to-end path no longer exists.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
</tbody>
</table>
Table C-5  ONS 15454 Optical Payload Port Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,AINS (ANSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService (ETSI)</td>
<td>All required OCHNC connections exist.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-MA,MT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,AINS &amp; FLT (ANSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-AU,AINS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,FLT (ANSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-5 ONS 15454 Optical Payload Port Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,LPBK &amp; MT (ANSI) Locked-enabled,loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the IS (ANSI) or Unlocked-enabled (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port or cross-connect in a loopback.</td>
<td>OOS-AUMA,FLT &amp; LPBK &amp; MT (ANSI) Locked-disabled,failed &amp; loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>
### C.3.3 OSC Port Service State Transitions

Table C-6 lists the ANSI and ETSI OSC port service state transitions.

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI)</td>
<td>Delete the OSC.</td>
<td>OOS-AU,AINS (ANSI)</td>
</tr>
<tr>
<td>Unlocked-enabled (ETSI)</td>
<td></td>
<td>Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td>Alarm/condition is raised.</td>
<td></td>
<td>OOS-AU,FLT (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService (ETSI)</td>
<td></td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td>Create the OSC.</td>
<td>IS-NR (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>Locked-enabled,maintenance (ETSI)</td>
<td></td>
</tr>
<tr>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td></td>
</tr>
<tr>
<td>Alarm/condition is cleared.</td>
<td>OOS-AU,AINS (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-enabled,disabled (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OOS-AU,FLT (ANSI)</td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,failed (ETSI)</td>
<td>Unlocked-enabled (ETSI)</td>
<td></td>
</tr>
<tr>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-enabled,disabled (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### C.3.4 OCHNC Service State Transitions

**Table C-7 lists the ANSI and ETSI OCHNC service state transitions.**

#### Table C-7  ONS 15454 OCHNC Service State Transitions

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS (ANSI) or Unlocked-enabled (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in a loopback.</td>
<td>OOS-AUMA,FLT &amp; LPBK &amp; MT (ANSI) Locked-disabled,failed &amp; loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-7  ONS 15454 OCHNC Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
<td>Put the connection in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,LPBK &amp; MT (ANSI) Locked-enabled,loopback &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>
Table C-7 ONS 15454 OCHNC Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS (ANSI) or Unlocked-enabled (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in a loopback.</td>
<td>OOS-AUMA,FLT &amp; LPBK &amp; MT (ANSI) Locked-disabled,failed &amp; loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
<td>Put the connection in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
</tbody>
</table>

C.3.5 Transponder/Muxponder Card Service State Transitions

Table C-8 lists ANSI and ETSI transponder and muxponder card service state transitions.

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI)</td>
<td>Change the administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI).</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td>Unlocked-enabled (ETSI)</td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI) Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI) Unlocked-disabled,notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Reset the card.</td>
<td>OOS-AU,SWDL (ANSI) Unlocked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AU,AINS &amp; UEQ (ANSI) Unlocked-disabled,automaticInService &amp; notInstalled (ETSI).</td>
</tr>
</tbody>
</table>
| | Delete the card. | If the card is valid:  
| | | • OOS-AUMA,UAS (ANSI)  
| | | • Locked-disabled,unassigned (ETSI)  
| | | If the card is invalid:  
| | | • OOS-AUMA,MEA & UAS (ANSI)  
<p>| | | • Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI) |
| | Pull the card. | OOS-AU,AINS &amp; UEQ (ANSI) Unlocked-disabled,automaticInService &amp; notInstalled (ETSI). |
| OOS-AU,AINS &amp; UEQ (ANSI) Unlocked-disabled,automaticInService &amp; notInstalled (ETSI) | Insert a valid card. | OOS-AU,AINS &amp; SWDL (ANSI) Unlocked-disabled,automaticInService &amp; softwareDownload (ETSI). |
| | Insert an invalid card. | OOS-AU,AINS &amp; MEA (ANSI) Unlocked-disabled,automaticInService &amp; mismatchOfEquipment (ETSI). |
| | Delete the card. | OOS-AUMA,UAS &amp; UEQ (ANSI) Locked-disabled,unassigned &amp; notInstalled (ETSI). |
| | Change the administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI). | OOS-AUMA,MT &amp; UEQ (ANSI) Locked-disabled,maintenance &amp; notInstalled (ETSI). |</p>
<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,FLT (ANSI)</td>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI)</td>
</tr>
<tr>
<td>Unlocked-disabled,failed (ETSI)</td>
<td></td>
<td>Unlocked-disabled,unequipped (ETSI)</td>
</tr>
<tr>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-disabled,unassigned (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change the administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI).</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Reset the card.</td>
<td>OOS-AU,SWDL (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Unlocked-disabled,softwareDownload (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Unlocked-enabled (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OOS-AU,MEA (ANSI)</td>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI)</td>
</tr>
<tr>
<td>Delete the card.</td>
<td>If the card is valid:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• OOS-AUMA,UAS (ANSI)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Locked-disabled,unassigned (ETSI)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the card is invalid:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• OOS-AUMA,MEA &amp; UAS (ANSI)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI)</td>
<td></td>
</tr>
<tr>
<td>Change the administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI).</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OOS-AU,SWDL (ANSI)</td>
<td>Restart completed.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td>Locked-disabled,softwareDownload (ETSI)</td>
<td>Unlocked-enabled (ETSI)</td>
<td></td>
</tr>
<tr>
<td>Pull the card.</td>
<td>OOS-AU,UEQ (ANSI)</td>
<td></td>
</tr>
<tr>
<td>Locked-disabled,notInstalled (ETSI)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table C-8  ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,UEQ (ANSI)</td>
<td>Insert a valid card.</td>
<td>OOS-AU,SWDL (ANSI)</td>
</tr>
<tr>
<td>Locked-disabled,notInstalled (ETSI)</td>
<td></td>
<td>Locked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Insert an invalid card.</td>
<td>OOS-AU,MEA (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Change the administrative state to OOS,MT</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td>(ANSI) or Locked,maintenance (ETSI).</td>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-AUMA,FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Change the administrative state to IS</td>
<td>OOS-AU,FLT (ANSI)</td>
</tr>
<tr>
<td></td>
<td>(ANSI) or Unlocked (ETSI).</td>
<td>Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Reset the card.</td>
<td>OOS-AUMA,MT &amp; SWDL (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OOS-AUMA,MEA &amp; MT (ANSI)</td>
</tr>
<tr>
<td></td>
<td>Change the administrative state to IS</td>
<td>OOS-AU,MEA (ANSI)</td>
</tr>
<tr>
<td></td>
<td>(ANSI) or Unlocked (ETSI).</td>
<td>Locked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,MEA &amp; MT (ANSI)</td>
<td></td>
<td>If the card is valid:</td>
</tr>
<tr>
<td>Locked-disabled,mismatchOfEquipment</td>
<td></td>
<td>• OOS-AUMA,UAS (ANSI)</td>
</tr>
<tr>
<td>&amp; maintenance (ETSI)</td>
<td></td>
<td>• Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>If the card is invalid:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OOS-AUMA,MEA &amp; UAS (ANSI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Provision the card.</td>
<td>OOS-AU,MEA (ANSI) Locked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,MT &amp; SWDL (ANSI) Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
<td>Restart completed.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI) Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,MT &amp; UEQ (ANSI) Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
<td>Change the administrative state to IS (ANSI) or Unlocked (ETSI).</td>
<td>OOS-AU,UEQ (ANSI) Locked-disabled,notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Insert a valid card.</td>
<td>OOS-AUMA,MT &amp; SWDL (ANSI) Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Insert an invalid card.</td>
<td>OOS-AUMA,MEA &amp; MT (ANSI) Locked-disabled,mismatchOfEquipment &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI) Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,UAS (ANSI) Locked-disabled,unassigned (ETSI)</td>
<td>Pull the card.</td>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI) Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Provision an invalid card.</td>
<td>OOS-AU,MEA (ANSI) Locked-disabled,mismatchOfEquipment (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Provision a valid card.</td>
<td>OOS-AU,SWDL (ANSI) Locked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td>OOS-AUMA,UAS &amp; UEQ (ANSI) Locked-disabled,unassigned &amp; notInstalled (ETSI)</td>
<td>Insert a valid card.</td>
<td>OOS-AU,SWDL (ANSI) Locked-disabled,softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Insert an invalid card.</td>
<td>OOS-AUMA,MEA &amp; UAS (ANSI) Locked-disabled,mismatchOfEquipment &amp; unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Preprovision a card.</td>
<td>OOS-AU,AINS &amp; UEQ (ANSI) Unlocked-disabled,automaticInService &amp; notInstalled (ETSI)</td>
</tr>
</tbody>
</table>
### C.3.6 Transponder/Muxponder Port Service State Transitions

**Table C-8** ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-MA,MT (ANSI)</td>
<td>Change the administrative state to IS (ANSI) or Unlocked (ETSI).</td>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td>Locked-enabled,maintenance (ETSI)</td>
<td>Delete the card.</td>
<td>OOS-AUMA,UAS (ANSI) Locked-disabled,unassigned (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Pull the card.</td>
<td>OOS-AUMA,MT &amp; UEQ (ANSI) Locked-disabled,maintenance &amp; notInstalled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Reset the card.</td>
<td>OOS-AUMA,MT &amp; SWDL (ANSI) Locked-disabled,maintenance &amp; softwareDownload (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>

**Table C-9** ONS 15454 Transponder/Muxponder Port Service State Transitions

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS-NR (ANSI)</td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td>Unlocked-enabled (ETSI)</td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-9 ONS 15454 Transponder/Muxponder Port Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>IS-NR¹ (ANSI) Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is raised.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>IS-NR (ANSI) Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,LPBK &amp; MT (ANSI) Locked-enabled,loopback &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-9  ONS 15454 Transponder/Muxponder Port Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
<td>Alarm/condition is cleared.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS (ANSI) or Unlocked-enabled (ETSI) administrative state.</td>
<td>OOS-AU,FLT (ANSI) Unlocked-disabled,failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS &amp; FLT (ANSI) Unlocked-disabled,automaticInService &amp; failed (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in a loopback.</td>
<td>OOS-AUMA,FLT &amp; LPBK &amp; MT (ANSI) Locked-disabled,failed &amp; loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>IS-NR¹ (ANSI) Locked-enabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,MT (ANSI) or Locked,maintenance (ETSI) administrative state.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
<tr>
<td>OOS-MA,LPBK &amp; MT (ANSI) Locked-enabled,loopback &amp; maintenance (ETSI)</td>
<td>Release the loopback.</td>
<td>OOS-MA,MT (ANSI) Locked-enabled,maintenance (ETSI)</td>
</tr>
</tbody>
</table>
### Table C-9  ONS 15454 Transponder/Muxponder Port Service State Transitions (continued)

<table>
<thead>
<tr>
<th>Current Service State</th>
<th>Action</th>
<th>Next Service State</th>
</tr>
</thead>
<tbody>
<tr>
<td>OOS-MA,MT (ANSI)</td>
<td>Put the port in the IS (ANSI) or Unlocked (ETSI) administrative state.</td>
<td>IS-NR&lt;sup&gt;1&lt;/sup&gt; Unlocked-enabled (ETSI)</td>
</tr>
<tr>
<td>Locked-enabled,maintenance (ETSI)</td>
<td>Put the port in the IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state.</td>
<td>OOS-AU,AINS (ANSI) Unlocked-disabled,automaticInService (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) administrative state.</td>
<td>OOS-MA,DSBLD (ANSI) Locked-enabled,disabled (ETSI)</td>
</tr>
<tr>
<td></td>
<td>Put the port in loopback.</td>
<td>OOS-MA,LPBK &amp; MT&lt;sup&gt;2,3&lt;/sup&gt; (ANSI) Locked-enabled,loopback &amp; maintenance (ETSI)</td>
</tr>
<tr>
<td>Alarm/condition is raised.</td>
<td></td>
<td>OOS-AUMA,FLT &amp; MT (ANSI) Locked-disabled,failed &amp; maintenance (ETSI)</td>
</tr>
</tbody>
</table>

---

1. The transponder and muxponder cards have both client and trunk ports. To bring up service, it is not necessary for both the client side and trunk side to be in the IS-NR (ANSI)/Unlocked-enabled (ETSI) service state.

2. In a client-side facility loopback, the client port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state and the remaining client and trunk ports can be in any other service state. In a client-side terminal loopback on transponder cards, the client port is in the OOS-MA,LPBK & MT service state and the trunk ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI). For client-side terminal loopbacks on muxponder cards, the client port is in the OOS-MA,LPBK & MT service state and the remaining client and trunk ports can be in any service state.

3. In a trunk-side facility loopback, the trunk port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state and the remaining client and trunk ports can be in any other service state. In a trunk-side terminal loopback, the trunk port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state and the client ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI) for complete loopback functionality. This type of loopback affects all client ports because it is performed on the aggregate signal.
Network Element Defaults

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's path protection feature, which may be used in any topological network configuration. Cisco does not recommend using its path protection feature in any particular topological network configuration.

This appendix describes the factory-configured (default) network element (NE) settings for the Cisco ONS 15454. It includes descriptions of card, node, and Cisco Transport Controller (CTC) default settings. To import, export, or edit the settings, see Chapter 13, “Maintain the Node.” Cards supported by this platform that are not listed in this appendix are not supported by user-configurable NE defaults settings.

To change card settings individually (that is, without changing the defaults), see Chapter 5, “Provision Transponder and Muxponder Cards.” To change node settings, see Chapter 10, “Manage the Node.”

Note: Unless otherwise specified, in this appendix “ONS 15454” refers to both ANSI (ONS 15454 SONET) and ETSI (ONS 15454 SDH) shelf assemblies.

D.1 Network Element Defaults Description

The NE defaults are preinstalled on each Cisco ONS 15454 TCC2 and TCC2P card. They also ship as a file called 15454-defaults.txt (ANSI shelves) or 15454SDH-defaults.txt (ETSI shelves) on the CTC software CD in case you want to import the defaults onto existing TCC2/TCC2P cards. The NE defaults include card-level, CTC, and node-level defaults.

Changes to card provisioning made manually using Change Card Settings procedures in Chapter 5, “Provision Transponder and Muxponder Cards,” override default settings. If you use the CTC Defaults editor (in the node view > Provisioning > Defaults tabs) or import a new defaults file, any changes to card or slot settings that result only affect cards that are installed or preprovisioned after the defaults have changed.

Changes made manually to most node-level default settings override the current settings, whether default or provisioned. If you change node-level default settings, either by using the Defaults editor or by importing a new defaults file, the new defaults reprovision the node immediately for all settings except those relating to protection (1+1 bidirectional switching, 1+1 reversion time, 1+1 revertive, Bidirectional
Line Switched Ring [BLSR] or multiplex section-shared protection ring [MS-SPRing] reversion time, BLSR/MS-SPRing ring revertive, BLSR/MS-SPRing span reversion time, BLSR/MS-SPRing span revertive), which apply to subsequent provisioning.

**Note** Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for the default to take effect. Before you change a default, check in the Side Effects column of the Defaults editor (right-click a column header and select Show Column > Side Effects) and be prepared for the occurrence of any side effects listed for that default.

## D.2 ANSI Platform Defaults

The following sections give the NE defaults for the ONS 15454 ANSI platform. To see defaults for the ONS 15454 ETSI platform, see the “D.3 ETSI Platform Defaults” section on page D-57.

### D.2.1 ANSI Card Default Settings

The tables in this section list the default settings for each DWDM, TXP, and MXP card. For all other cards, including electrical, optical, Ethernet, and Fibre Channel, refer to the Cisco ONS 15454 Reference Manual.

Cisco provides user-configurable defaults for the Cisco ONS 15454 cards, including:

- **Soak Time**—*All cards.* The length of time that elapses between an automatic InService (AINS) port receiving a valid signal and when it automatically changes to in-service status.
- **Port State**—*All cards.* Sets the port to one of the four available states (IS, OOS, OOS_MT, or IS_AINS), depending on whether you need ports in or out of service.
- **SF BER Level**—*TXP and MXP cards.* Defines the signal fail (SF) bit error rate (BER).
- **SD BER Level**—*TXP and MXP cards.* Defines the signal degrade (SD) BER.
- **Enable Sync Messages**—*MXP cards.* Enables synchronization status messages (SSM) (S1 byte), which allow the node to choose the best timing source.
- **Send Do Not Use**—*TXP and MXP cards.* Sends a do not use (DUS) message on the S1 byte when enabled.
- **Payload Type**—*TXP and MXP cards.* Defines the type of client signal.
- **Termination Mode**—*TXP and MXP cards.* Defines the type of termination (line, section, or transparent).
- **ALS Mode**—*TXP and MXP cards.* Sets the automatic laser shutdown (ALS) feature to one of four available states (disabled, auto restart, manual restart, manual restart for test).
- **ALS Recovery Interval**—*TXP and MXP cards.* Sets the automatic laser shutdown recovery time interval.
- **ALS Recovery Pulse Width**—*TXP and MXP cards.* Sets the automatic laser shutdown recovery pulse signal width.
- **FEC**—*TXP and MXP cards.* Enables or disables the forward error correction (FEC) monitoring on the optical transport network.
- **G.709 OTN**—*TXP and MXP cards.* Enables or disables the ITU-T G.709 monitoring on the optical transport network.
• **FEC Thresholds**—TXP and MXP cards. Sets the performance monitoring (PM) parameters for gathering FEC performance data and detecting problems early.

• **Optical Thresholds**—TXP and MXP cards. Sets the PM parameters for gathering physical optics performance data and detecting problems early.

• **OTN Thresholds**—TXP and MXP cards. Sets the PM parameters for gathering OTN trunk-side performance data and detecting problems early.

• **PM Threshold settings**—All cards. Sets the PM parameters for gathering performance data and detecting problems early.

**Note**

For more information about each individual card setting, see Chapter 5, “Provision Transponder and Muxponder Cards.”

**Note**

For more information about the PM parameters, see Chapter 9, “Monitor Performance.”

### D.2.1 MXP_2.5G_10E Card Default Settings

Table D-1 lists the MXP_2.5G_10E card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AisSquelchMode</td>
<td>Squelch</td>
<td>Ais, Squelch</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AlsRecoveryPulseDuration</td>
<td>2.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>100–2000</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.ppmPortAssignment</td>
<td>OC48_PORT</td>
<td>UNASSIGNED, OC48_PORT</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SyncMsgIn</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.TerminationMode</td>
<td>Transparent</td>
<td>Transparent, Section</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
</tbody>
</table>
## D.2.1 ANSI Card Default Settings

### Table D-1  MXP_2.5G_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.config.trunk.AlsRecoveryPulseDuration</td>
<td>100.0 (seconds)</td>
<td>60.0, 60.1, 60.2 .. 200.0 when AlsMode is Disabled, Auto Restart, Manual Restart  80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.trunk.AlsRecoveryPulseInterval</td>
<td>300 (seconds)</td>
<td>200–2000</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>-21.0, -20.9, -20.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>-8.0, -7.9, -7.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 3.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 3.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>-20.0, -19.9, -19.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>-7.0, -6.9, -6.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>-20.5, -20.4, -20.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>-7.5, -7.4, -7.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>-8.0 (dBm)</td>
<td>-25.0, -24.9, -24.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>8.0 (dBm)</td>
<td>1.0, 1.1, 1.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>1.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
</tbody>
</table>
### Table D-1  MXP_2.5G_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>7.5 (dBm)</td>
<td>-24.5, -24.4, -24.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>-24.7, -24.6, -24.5 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.3</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-1  MXP_2.5G_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.FC</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>100000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.AsynchSynchMapping</td>
<td>ODU Multiplex</td>
<td>ODU Multiplex</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.FEC</td>
<td>Standard</td>
<td>Disable, Standard, Enhanced</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>
## Table D-1 MXP_2.5G_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### D.2.1.2 MXP_2.5G_10G Card Default Settings

Table D-2 lists the MXP_2.5G_10G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.ppmPortAssignment</td>
<td>OC48_PORT</td>
<td>UNASSIGNED, OC48_PORT</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE, TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SendDoNotUse</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE, TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transparent, Line</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
</tbody>
</table>
### Table D-2: MXP_2.5G_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>4.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>3.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
</tbody>
</table>
### D.2.1 ANSI Card Default Settings

#### Table D-2 MXP_2.5G_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>3.7 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.3 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.EC</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.EC</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>Default Name</td>
<td>Default Value</td>
<td>Default Domain</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
| MXP-2_5G-10G.otn.otnLines.FEC                                               | Standard      | • Disable, Standard, Enhanced when G709OTN is Enable
|                                                                             |               | • Disable when G709OTN is Disable |
| MXP-2_5G-10G.otn.otnLines.G709OTN                                          | Enable        | Disable, Enable |
| MXP-2_5G-10G.otn.otnLines.SDBER                                             | 1.00E-07      | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| MXP-2_5G-10G.pmthresholds.client.line.farend.15min.CV                      | 212600 (B2 count) | 0–2212200 |
| MXP-2_5G-10G.pmthresholds.client.line.farend.15min.ES                      | 87 (seconds)  | 0–900          |
| MXP-2_5G-10G.pmthresholds.client.line.farend.15min.FC                       | 10 (count)    | 0–72           |
| MXP-2_5G-10G.pmthresholds.client.line.farend.15min.SES                      | 3 (seconds)   | 0–900          |
| MXP-2_5G-10G.pmthresholds.client.line.farend.1day.CV                        | 2126000 (B2 count) | 0–212371200    |
| MXP-2_5G-10G.pmthresholds.client.line.farend.1day.ES                        | 864 (seconds) | 0–86400        |
| MXP-2_5G-10G.pmthresholds.client.line.farend.1day.FC                        | 40 (count)    | 0–6912         |
| MXP-2_5G-10G.pmthresholds.client.line.farend.1day.SES                       | 4 (seconds)   | 0–86400        |
| MXP-2_5G-10G.pmthresholds.client.line.farend.1day.UAS                       | 10 (seconds)  | 0–86400        |
| MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.CV                     | 212600 (B2 count) | 0–2212200 |
| MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.ES                     | 87 (seconds)  | 0–900          |
## Appendix D  Network Element Defaults

### D.2.1 ANSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
## Appendix D Network Element Defaults

### D.2.1 MXP_MR_2.5G Card Default Settings

**Table D-3** lists the MXP_MR_2.5G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2.5G.config.client.AlRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.client.AlRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, ONE_GE, FC1G ISL, FC2G ISL, FICON1G ISL, FICON2G ISL</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.fc.distanceExtension.AutoadjustGFPBufferThreshold</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.fc.distanceExtension.AutoDetect</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2.5G.config.fc.distanceExtension.Enabled</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
</tbody>
</table>

---

### D.2.1.3 MXP_MR_2.5G Card Default Settings

**Table D-2** MXP_2.5G_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.line.nearend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2.5G-10G.pmthresholds.trunk.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
**Appendix D  Network Element Defaults**

**Table D-3  MXP_MR_2.5G Card Default Settings (ANSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.NumCredits</td>
<td>32</td>
<td>2–256</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers</td>
<td>16</td>
<td>16, 32, 48 .. 1200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize</td>
<td>2148</td>
<td>2148, 2152, 2156, 2160, 2164, 2168, 2172</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 whenAlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SyncMsgIn</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
### Table D-3  
**MXP_MR_2.5G Card Default Settings (ANSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
</tbody>
</table>
Table D-3  MXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.CV</td>
<td>1000000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

D.2.1.4 MXPP_MR_2.5G Card Default Settings

Table D-4 lists the MXPP_MR_2.5G card default settings.

Table D-4  MXPP_MR_2.5G Card Default Settings (ANSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
</tbody>
</table>
### Table D-4  MXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, ONE_GE, FC1G ISL, FC2G ISL, FICON1G ISL, FICON2G ISL</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThreshold</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.AutoDetect</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.Enabled</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distancetension.NumCredits</td>
<td>32</td>
<td>2–256</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers</td>
<td>16</td>
<td>16, 32, 48 .. 1200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize</td>
<td>2148</td>
<td>2148, 2152, 2156, 2160, 2164, 2168, 2172</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
</tbody>
</table>
## Table D-4  MXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.line.farend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
</tbody>
</table>
Table D-4  MXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2.5G.pmthresholds.trunk.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

D.2.1.5 TXP_MR_10E Card Default Settings

Table D-5 lists the TXP_MR_10E card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.AisSquelchMode</td>
<td>Squelch</td>
<td>Ais, Squelch</td>
</tr>
</tbody>
</table>
### Table D-5  TXP_MR_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.config.client.AlsRecoveryPulseDuration</td>
<td>2.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>100–2000</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, SONET (including 10G Ethernet WAN Phy), 10G Ethernet LAN Phy, 10G Fiber Channel</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.TerminationMode</td>
<td>Transparent</td>
<td>• Transparent, Line when ppmPortAssignment is UNASSIGNED, SONET (including 10G Ethernet WAN Phy)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transparent when ppmPortAssignment is 10G Ethernet LAN Phy, 10G Fiber Channel</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.AlsRecoveryPulseDuration</td>
<td>100.0 (seconds)</td>
<td>• 6.0, 6.1, 6.2 .. 200.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>-17.0, -16.9, -16.8 .. 30.0</td>
</tr>
<tr>
<td>Default Name</td>
<td>Default Value</td>
<td>Default Domain</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>-9.0, -8.9, -8.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.LowRxPower</td>
<td>-17.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.LowTxPower</td>
<td>-9.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>1.0 (dBm)</td>
<td>-16.0, -15.9, -15.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>1.0 (dBm)</td>
<td>-8.0, -7.9, -7.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-16.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>1.5 (dBm)</td>
<td>-16.5, -16.4, -16.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>1.5 (dBm)</td>
<td>-8.5, -8.4, -8.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-16.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-8.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>-25.0, -24.9, -24.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>8.0 (dBm)</td>
<td>1.0, 1.1, 1.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>1.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>-24.5, -24.4, -24.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
</tbody>
</table>
### Appendix D  Network Element Defaults

#### D.2.1 ANSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>-24.7, -24.6, -24.5 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.3</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-5 TXP_MR_10E Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>500 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
| TXP-MR-10E.otnLines.FEC | Standard | • Disable, Standard, Enhanced when G709OTN is Enable  
• Disable when G709OTN is Disable |
<p>| TXP-MR-10E.otn.otnLines.G709OTN | Enable | Disable, Enable |
| TXP-MR-10E.otn.otnLines.SDBER | 1.00E-07 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXP-MR-10E.pmthresholds.client.line.farend.15min.CV | 85040 (B2 count) | 0–8850600 |
| TXP-MR-10E.pmthresholds.client.line.farend.15min.Es | 87 (seconds) | 0–900 |
| TXP-MR-10E.pmthresholds.client.line.farend.15min.FC | 10 (count) | 0–72 |
| TXP-MR-10E.pmthresholds.client.line.farend.15min.SES | 1 (seconds) | 0–900 |
| TXP-MR-10E.pmthresholds.client.line.farend.15min.UAS | 3 (seconds) | 0–900 |</p>
<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.farend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
</tbody>
</table>
### Table D-6 **TXP_MR_10G Card Default Settings (ANSI)** (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.2.1.6 TXP_MR_10G Card Default Settings

Table D-6 lists the TXP_MR_10G card default settings.

### Table D-6 **TXP_MR_10G Card Default Settings (ANSI)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.mrPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, SONET (including 10G Ethernet WAN Phy), 10G Ethernet LAN Phy</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
</tbody>
</table>
### Table D-6 TXP_MR_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.config.client.TerminationMode</td>
<td>Transparent</td>
<td>• Transparent, Line when mrPortAssignment is UNASSIGNED, SONET (including 10G Ethernet WAN Phy)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transparent when mrPortAssignment is 10G Ethernet LAN Phy</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.alarm.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.alarm.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-17.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-9.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>1.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>1.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-16.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
</tbody>
</table>
### Table D-6  TXP_MR_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>1.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>1.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-16.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-8.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>4.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>3.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>3.7 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.3 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
</tbody>
</table>
### D.2.1 ANSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
</tbody>
</table>
### Table D-6  TXP_MR_10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.otnLines.FEC</td>
<td>Enable</td>
<td>• Disable, Enable when G709OTN is Enable</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>• Disable when G709OTN is Disable</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.otnLines.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.15min.CV</td>
<td>100000 (B1 count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-6 TXP_M10G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.CV</td>
<td>85040 (B2 count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.CV</td>
<td>850400 (B2 count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.CV</td>
<td>100000 (B1 count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
## D.2.1.7 TXP_MR_2.5G Card Default Settings

Table D-7 lists the TXP_MR_2.5G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-2_5G.config.client.AlsRecoveryPulseDuration</td>
<td>40.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart&lt;br&gt;• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-2_5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, OC3_PORT, OC12_PORT, OC48_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer</td>
</tr>
<tr>
<td>TXP-MR-2_5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>TXP-MR-2_5G.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-2_5G.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
</tbody>
</table>
### D.2.1 ANSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| TXP-MR-2_5G.config.client.TerminationMode        | Transparent   | • Transparent, Section, Line when ppmPortAssignment is UNASSIGNED, OC3_PORT, OC12_PORT, OC48_PORT
|                                                  |               | • Transparent when ppmPortAssignment is OC3_PORT, OC12_PORT, OC48_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |
| TXP-MR-2_5G.config.trunk.AINSSoakTime            | 08:00 (hours:mins) 00:00, 00:15, 00:30 .. 48:00 |
| TXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration| 40.0 (seconds) | • 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart
|                                                  |               | • 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval| 100 (seconds) 60–300 |
| TXP-MR-2_5G.config.trunk.SDBER                   | 1.00E-07      | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXP-MR-2_5G.config.trunk.SFBER                   | 1.00E-04      | 1E-3, 1E-4, 1E-5 |
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias | 90.0 (%)     | 0.0, 0.1, 0.2 .. 100.0 |
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower | 3.0 (dBm)  | LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0 |
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower | 3.0 (dBm)  | LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0 |
| TXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower | -21.0 (dBm) | -40.0, -39.9, -39.8 .. HighRxPower |
| TXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower | -15.0 (dBm) | -40.0, -39.9, -39.8 .. HighTxPower |
| TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias | 81.0 (%) | 0.0, 0.1, 0.2 .. 100.0 |
### Table D-7  TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBrn)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBrn)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBrn)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBrn)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBrn)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBrn)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrected</td>
<td>112500 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected</td>
<td>10800000 (count)</td>
<td>0–867227693875200</td>
</tr>
</tbody>
</table>
### Table D-7 TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1giceternet.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gfiberchannel.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gfiberchannel.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gfiberchannel.1day.BitErrorsCorrected</td>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gfiberchannel.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gficon.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gficon.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gficon.1day.BitErrorsCorrected</td>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.1gficon.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gfiberchannel.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gfiberchannel.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gfiberchannel.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gfiberchannel.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gficon.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gficon.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gficon.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.2gficon.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc12.15min.BitErrorsCorrected</td>
<td>56457 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc12.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc12.1day.BitErrorsCorrected</td>
<td>5149872 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc12.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc3.15min.BitErrorsCorrected</td>
<td>15012 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc3.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fceqthold.oc3.1day.BitErrorsCorrected</td>
<td>1441152 (count)</td>
<td>0–867227693875200</td>
</tr>
</tbody>
</table>
### Table D-7  TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.oc3.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.oc48.15min.BitErrorsCorrected</td>
<td>225837 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.oc48.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.oc48.1day.BitErrorsCorrected</td>
<td>21680352 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.oc48.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-7 TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
| TXP-MR-2_5G.otn.otnLines.FEC | Enable | • Disable, Enable when G709OTN is Enable  
• Disable when G709OTN is Disable |
| TXP-MR-2_5G.otn.otnLines.G709OTN | Enable | Disable, Enable |
| TXP-MR-2_5G.otn.otnLines.SDBER | 1.00E-07 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.CV | 5315 (B2 count) | 0–552600 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.ES | 87 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.FC | 10 (count) | 0–72 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.SES | 1 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.15min.UAS | 3 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.CV | 53150 (B2 count) | 0–53049600 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.ES | 864 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.FC | 40 (count) | 0–72 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.SES | 4 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.line.farend.1day.UAS | 10 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.CV | 5315 (B2 count) | 0–552600 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.ES | 87 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.FC | 10 (count) | 0–72 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.SES | 1 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.UAS | 3 (seconds) | 0–900 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.CV | 53150 (B2 count) | 0–53049600 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.ES | 864 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.FC | 40 (count) | 0–6912 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.SES | 4 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.UAS | 10 (seconds) | 0–86400 |
| TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.CV | 10000 (B1 count) | 0–553500 |
### TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–1338600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
</tbody>
</table>
### Table D-7 TXP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.CV</td>
<td>1000000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.oc48.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### D.2.1.8 TXPP_MR_2.5G Card Default Settings

Table D-8 lists the TXPP_MR_2.5G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.AlswT</td>
<td>40.0 (seconds)</td>
<td>2.0, 2.1, 2.2 .. 100.0 when Alsmode is</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.AlswInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, OC3_PORT, OC12_PORT, OC48_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDL_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.config.client.SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
</tbody>
</table>
### D.2.1 ANSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| TXPP-MR-2_5G.config.client.TerminationMode | Transparent | • Transparent, Section, Line when ppmPortAssignment is UNASSIGNED, OC3_PORT, OC12_PORT, OC48_PORT  
• Transparent when ppmPortAssignment is OC3_PORT, OC12_PORT, OC48_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |
| TXPP-MR-2_5G.config.trunk.AINSSoakTime | 08:00 (hours:mins) | 00:00, 00:15, 00:30 .. 48:00 |
| TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration | 40.0 (seconds) | • 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Enabled, Auto Restart, Manual Restart  
• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval | 100 (seconds) | 60–300 |
| TXPP-MR-2_5G.config.trunk.SDBER | 1.00E-07 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXPP-MR-2_5G.config.trunk.SFBER | 1.00E-04 | 1E-3, 1E-4, 1E-5 |
| TXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias | 90.0 (%) | 0.0, 0.1, 0.2 .. 100.0 |
### Table D-8  TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-15.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBrn)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBrn)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBrn)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
### Table D-8  TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrected</td>
<td>112500 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected</td>
<td>10800000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrected</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.UncorrectableWords</td>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc12.15min.BitErrorsCorrected</td>
<td>56457 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc12.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc12.1day.BitErrorsCorrected</td>
<td>5419872 (count)</td>
<td>0–867227693875200</td>
</tr>
</tbody>
</table>
### Table D-8 TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc12.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc3.15min.BitErrorsCorrected</td>
<td>15012 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc3.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc3.1day.BitErrorsCorrected</td>
<td>1441152 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc3.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc48.15min.BitErrorsCorrected</td>
<td>225837 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc48.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc48.1day.BitErrorsCorrected</td>
<td>21680352 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.oc48.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
## Table D-8  TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.Es</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.Es</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.FEC</td>
<td>Enable</td>
<td>• Disable, Enable when G709OTN is Enable</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>• Disable when G709OTN is Disable</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.SDBER</td>
<td>1.00E-07</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.CV</td>
<td>5315 (B2 count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.CV</td>
<td>53150 (B2 count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.Es</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.farend.1day.UAs</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.CV</td>
<td>5315 (B2 count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.15min.UAs</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.CV</td>
<td>53150 (B2 count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.Es</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–553500</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc12.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–133056000</td>
</tr>
</tbody>
</table>
## Table D-8 TXPP_MR_2.5G Card Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1.day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc3.section.nearend.1.day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.CV</td>
<td>21260 (B2 count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.CV</td>
<td>212600 (B2 count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.line.nearend.15min.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.ES</td>
<td>100000 (B1 count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.oc48.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### D.2.1.9 OSCM Card Default Settings

Table D-9 lists the OSCM card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSCM.pmthresholds.line.farend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.15min.CV</td>
<td>100000 (B1 count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.1day.CV</td>
<td>1000000 (B1 count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
D.2.1.10 OSC-CSM Card Default Settings

Table D-10 lists the OSC-CSM card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.15min.CV</td>
<td>1312 (B2 count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.1day.CV</td>
<td>13120 (B2 count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.line.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.15min.CV</td>
<td>10000 (B1 count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.1day.CV</td>
<td>100000 (B1 count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.section.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

D.2.2 ANSI Node Default Settings

Table D-11 on page D-50 lists the node-level default settings for the Cisco ONS 15454. Cisco provides the following types of user-configurable defaults for each Cisco ONS 15454 node:
Appendix D  Network Element Defaults

D.2.2 ANSI Node Default Settings

- Create TL1-Like—Instructs the node to create only cross-connects, allowing the resulting circuits to be in an upgradable state.
- Insert AIS-V on SDP—Instructs the node to insert AIS-V in each VT whenever the carrying STS crosses the signal degrade path BER threshold.
- SDP BER—Defines the node SD path bit error rate.
- Path Protection settings—Set the threshold level for signal degradation and failure for path protection circuits.
- Craft Access Only—Allows CTC connectivity to the node only through the craft access port.
- CTC IP Display Suppression—Prevents display of node IP addresses in CTC (applicable for all users except Superusers).
- Defaults Description—Names the current defaults file on the node.
- Enable Firewall—Enables or disables the use of a firewall for accessing the node.
- Enable Proxy—Enables or disables the use of a proxy server with the node.
- IIOP Listener Port—Sets the Internet Inter-Object Request Broker Protocol (IIOP) listener port number.
- LCD IP setting—Sets the node LCD screen to display the node IP address and use the buttons on the LCD panel, only display the IP address, or suppress display of the IP address.
- Login Warning Message—Warns users at the login screen about the possible legal or contractual ramifications of accessing equipment, systems, or networks without authorization.
- NTP SNTP Server—Sets the IP address of the Network Time Protocol (NTP) Simple Network Time Protocol (SNTP) server to be used with the node.
- Time Zone—Sets the time zone where the node is located.
- Use DST—Enables or disables the use of Daylight Savings Time (DST).
- Use NTP SNTP Server—Enables or disables the use of the specified NTP SNTP server with the node.
- 1+1 protection settings—Determine whether 1+1 protected circuits have bidirectional switching, are revertive, and what the reversion time is.
- BLSR Protection settings—Determine whether BLSR-protected circuits are revertive and what the reversion time is at both the ring and span levels.
- Y Cable Protection settings—Determine whether Y-Cable protected circuits have bidirectional switching, are revertive, and what the reversion time is.
- Security Policy settings—Determine the allowable failed logins before lockout, idle user timeout for each user level, optional lockout duration or manual unlock enabled, password reuse and change frequency policies, number of characters difference between the old and new password, password aging by security level, enforced single concurrent session per user, and option to disable inactive user after a set inactivity period.
- BITS Timing settings—Determine the AIS threshold, coding, framing, State, State Out, and LBO settings for BITS1 and BITS2 timing.
- General Timing settings—Determine the mode (External, Line, or Mixed), quality of RES, revertive, reversion time, and SSM message set for node timing.

Note

For more information about each individual node setting, see Chapter 10, “Manage the Node.”
### Table D-11  Node Default Settings (ANSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.circuits.SendPDIP</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.circuits.State</td>
<td>IS,AINS</td>
<td>IS, OOS,DSBLD, OOS,MT, IS,AINS</td>
</tr>
<tr>
<td>NODE.circuits.upsr.AllowUpsrOverOnePlusOne</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.circuits.upsr.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.circuits.upsr.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.circuits.upsr.STS_SDBER</td>
<td>1.00E-06</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>NODE.circuits.upsr.STS_SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>NODE.circuits.upsr.SwitchOnPDIP</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.circuits.upsr.VT_SDBER</td>
<td>1.00E-06</td>
<td>1E-5, 1E-6, 1E-7, 1E-8</td>
</tr>
<tr>
<td>NODE.circuits.upsr.VT_SFBER</td>
<td>1.00E-04</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>NODE.general.DefaultsDescription</td>
<td>Factory Defaults</td>
<td>Free form field</td>
</tr>
<tr>
<td>NODE.general.InsertAISOnSDP</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.general.NtpSntpServer</td>
<td>0.0.0.0</td>
<td>IP Address</td>
</tr>
<tr>
<td>NODE.general.RaiseConditionOnEmptySlot</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.general.SDPBER</td>
<td>1.00E-06</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>NODE.general.TimeZone</td>
<td>(GMT-08:00)</td>
<td>Pacific Time (US &amp; Canada), Tijuana</td>
</tr>
<tr>
<td></td>
<td>(For applicable time zones, see Table D-24 on page D-114.)</td>
<td></td>
</tr>
<tr>
<td>NODE.general.UseDST</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.network.general.AlarmMissingBackplaneLAN</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.network.general.CtcIpDisplaySuppression</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.network.general.GatewaySettings</td>
<td>None</td>
<td>LeaveAsIs, None, ENE, GNE, ProxyOnlyNode</td>
</tr>
<tr>
<td>NODE.network.general.LcdIpSetting</td>
<td>Allow</td>
<td>Configuration, Display Only, Suppress Display</td>
</tr>
<tr>
<td></td>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>NODE.osi.greTunnel.ctc.OspfCost</td>
<td>110</td>
<td>110, 120, 130 .. 65530</td>
</tr>
<tr>
<td>NODE.osi.greTunnel.ctc.SubnetMask</td>
<td>24 (bits)</td>
<td>8, 9, 10 .. 32</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.Mode</td>
<td>AITS</td>
<td>AITS, UITS</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.MTU</td>
<td>512</td>
<td>512, 513, 514 .. 1500</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.Role</td>
<td>Network</td>
<td>Network, User</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.T200</td>
<td>200 (ms)</td>
<td>200, 300, 400 .. 20000</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.T203</td>
<td>10000 (ms)</td>
<td>4000, 4100, 4200 .. 12000</td>
</tr>
<tr>
<td>NODE.osi.mainSetup.L1L2LSPBufferSize</td>
<td>512 (bytes)</td>
<td>512–1500</td>
</tr>
<tr>
<td>NODE.osi.mainSetup.L1LSPBufferSize</td>
<td>512 (bytes)</td>
<td>512–1500</td>
</tr>
</tbody>
</table>
### Table D-11  Node Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODEosi.subnet.ctc.DISPriority</td>
<td>63</td>
<td>1, 2, 3 .. 127</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.ESH</td>
<td>10 (sec)</td>
<td>10, 20, 30 .. 1000</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.GCCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.IIH</td>
<td>3 (sec)</td>
<td>1, 2, 3 .. 600</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.IIH</td>
<td>10 (sec)</td>
<td>10, 20, 30 .. 1000</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.LANISISCost</td>
<td>20</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.LDCCISISCost</td>
<td>40</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.OSCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODEosi.subnet.ctc.SDCCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODEosi.tarp.L1DataCache</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.L2DataCache</td>
<td>FALSE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.LANStormSuppression</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.LDB</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.LDBEntry</td>
<td>5 (min)</td>
<td>1–10</td>
</tr>
<tr>
<td>NODEosi.tarp.LDBFlush</td>
<td>5 (sec)</td>
<td>0–1440</td>
</tr>
<tr>
<td>NODEosi.tarp.PDUsL1Propagation</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.PDUsL2Propagation</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.PDUsOrigination</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODEosi.tarp.T1Timer</td>
<td>15 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODEosi.tarp.T2Timer</td>
<td>25 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODEosi.tarp.T3Timer</td>
<td>40 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODEosi.tarp.T4Timer</td>
<td>20 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODEosi.tarp.Type4PDUDelay</td>
<td>0 (sec)</td>
<td>0–255</td>
</tr>
<tr>
<td>NODE.powerMonitor.EHIBATVG</td>
<td>-56.5 (Vdc)</td>
<td>-54.0, -54.5, -55.0, -55.5, -56.0, -56.5</td>
</tr>
<tr>
<td>NODE.powerMonitor.ELWBATVG</td>
<td>-40.5 (Vdc)</td>
<td>-40.5, -41.0, -41.5, -42.0, -42.5, -43.0, -43.5, -44.0</td>
</tr>
<tr>
<td>NODE.powerMonitor.HIBATVG</td>
<td>-54.0 (Vdc)</td>
<td>-44.0, -44.5, -45.0 .. -56.5</td>
</tr>
<tr>
<td>NODE.powerMonitor.LWBATVG</td>
<td>-44.0 (Vdc)</td>
<td>-40.5, -41.0, -41.5 .. -54.0</td>
</tr>
<tr>
<td>NODE.protection.1+1.BidirectionalSwitching</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.1+1.DetectionGuardTimer</td>
<td>1 (seconds)</td>
<td>0, 0.05, 0.1, 0.5, 1, 2, 3, 4, 5</td>
</tr>
<tr>
<td>NODE.protection.1+1.RecoveryGuardTimer</td>
<td>1 (seconds)</td>
<td>0, 0.05, 0.1 .. 10</td>
</tr>
<tr>
<td>NODE.protection.1+1.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.1+1.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
</tbody>
</table>
### Table D-11  Node Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.protection.1+1.VerifyGuardTimer</td>
<td>0.5 (seconds) 0.5, 1</td>
<td>0.5, 1</td>
</tr>
<tr>
<td>NODE.protection.blr.RingReversionTime</td>
<td>5.0 (minutes) 0.5, 1.0, 1.5 .. 12.0</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.blr.RingRevertive</td>
<td>TRUE TRUE, FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.blr.SpanReversionTime</td>
<td>5.0 (minutes) 0.5, 1.0, 1.5 .. 12.0</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.blr.SpanRevertive</td>
<td>TRUE TRUE, FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.splitter.ReversionTime</td>
<td>5.0 (minutes) 0.5, 1.0, 1.5 .. 12.0</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.splitter.Revertive</td>
<td>FALSE TRUE, FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.ycable.ReversionTime</td>
<td>5.0 (minutes) 0.5, 1.0, 1.5 .. 12.0</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.ycable.Revertive</td>
<td>FALSE TRUE, FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.dataComm.ctc.DefaultTCCEthernetIP</td>
<td>10.0.0.1 IP Address</td>
<td>10.0.0.1 IP Address</td>
</tr>
<tr>
<td>NODE.security.dataComm.ctc.DefaultTCCEthernetIPNetmask</td>
<td>24 (bits) 8, 9, 10 .. 32</td>
<td>8, 9, 10 .. 32</td>
</tr>
<tr>
<td>NODE.security.dataComm.CtcBackplaneIpDisplaySuppression</td>
<td>(NOT SUPPORTED)</td>
<td>• FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
</tr>
<tr>
<td>NODE.security.dataComm.isSecureModeSupportedOnControlCard</td>
<td>FALSE FALSE, TRUE</td>
<td>FALSE FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.security.dataComm.LcdBackplaneIpSetting</td>
<td>(NOT SUPPORTED)</td>
<td>• Allow Configuration, Display Only, Suppress Display when isSecureModeSupportedOnControlCard is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
</tr>
<tr>
<td>NODE.security.dataComm.SecureModeLocked</td>
<td>(NOT SUPPORTED)</td>
<td>• FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
</tr>
<tr>
<td>NODE.security.dataComm.SecureModeOn (May reboot node)</td>
<td>(NOT SUPPORTED)</td>
<td>• FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
</tr>
<tr>
<td>NODE.security.emsAccess.AccessState</td>
<td>NonSecure NonSecure, Secure</td>
<td>NonSecure, Secure</td>
</tr>
<tr>
<td>NODE.security.emsAccess.IIOPListenerPort (May reboot node)</td>
<td>57790 (port #) 0–65535</td>
<td>0–65535</td>
</tr>
</tbody>
</table>
### Table D-11  Node Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.security.idleUserTimeout.Maintenance</td>
<td>01:00 (hours:mins)</td>
<td>00:00, 00:01, 00:02 .. 16:39</td>
</tr>
<tr>
<td>NODE.security.idleUserTimeout.Provisioning</td>
<td>00:30 (hours:mins)</td>
<td>00:00, 00:01, 00:02 .. 16:39</td>
</tr>
<tr>
<td>NODE.security.idleUserTimeout.Retrieve</td>
<td>00:00 (hours:mins)</td>
<td>00:00, 00:01, 00:02 .. 16:39</td>
</tr>
<tr>
<td>NODE.security.idleUserTimeout.Superuser</td>
<td>00:15 (hours:mins)</td>
<td>00:00, 00:01, 00:02 .. 16:39</td>
</tr>
<tr>
<td>NODE.security.lanAccess.LANAccess (May disconnect CTC from node)</td>
<td>Front &amp; Backplane</td>
<td>No LAN Access, Front Only, Backplane Only, Front &amp; Backplane</td>
</tr>
<tr>
<td>NODE.security.lanAccess.RestoreTimeout</td>
<td>5 (minutes)</td>
<td>0–60</td>
</tr>
<tr>
<td>NODE.security.legalDisclaimer.LoginWarningMessage</td>
<td>&lt;html&gt;&lt;center&gt;&lt;b&gt;WARNING&lt;/b&gt;&lt;/center&gt;This system is restricted to authorized users for business purposes. Unauthorized access is a violation of the law. This service may be monitored for administrative and security reasons. By proceeding, you consent to this monitoring.</td>
<td>Free form field</td>
</tr>
<tr>
<td>NODE.security.other.DisableInactiveUser</td>
<td>FALSE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.security.other.InactiveDuration</td>
<td>45 (days)</td>
<td>• 1, 2, 3 .. 99 when DisableInactiveUser is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 45 (and N/A) when DisableInactiveUser is FALSE</td>
</tr>
<tr>
<td>NODE.security.other.PMClearingPrivilege</td>
<td>Provisioning</td>
<td>Provisioning, Superuser</td>
</tr>
<tr>
<td>NODE.security.other.SingleSessionPerUser</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.passwordAging.EnforcePasswordAging</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.passwordAging.maintenance.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.maintenance.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
</tbody>
</table>
## Appendix D  
Network Element Defaults

### D.2.2 ANSI Node Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.security.passwordAging.provisioning.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.provisioning.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.superuser.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.superuser.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordChange.CannotChangeNewPassword</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.radiusServer.ctc.AccountingPort</td>
<td>1813 (port)</td>
<td>0–32767</td>
</tr>
<tr>
<td>NODE.security.radiusServer.ctc.AuthenticationPort</td>
<td>1812 (port)</td>
<td>0–32767</td>
</tr>
<tr>
<td>NODE.security.radiusServer.EnableNodeAsFinalAuthenticatorWhenAuthenticationEnabled</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.security.serialCraftAccess.EnableCraftPort</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.shellAccess.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure, Secure</td>
</tr>
<tr>
<td>NODE.security.shellAccess.EnableShellPassword</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.shellAccess.TelnetPort</td>
<td>23</td>
<td>23–9999</td>
</tr>
<tr>
<td>NODE.security.snmpAccess.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure</td>
</tr>
<tr>
<td>NODE.security.tl1Access.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure, Secure</td>
</tr>
<tr>
<td>NODE.security.userLockout.FailedLoginsAllowedBeforeLockout</td>
<td>5 (times)</td>
<td>0–10</td>
</tr>
<tr>
<td>NODE.security.userLockout.LockoutDuration</td>
<td>00:30 (mins:secs)</td>
<td>00:00, 00:05, 00:10 .. 10:00</td>
</tr>
<tr>
<td>NODE.security.userLockout.ManualUnlockBySuperuser</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.timing.bits-1.AdminSSMIn</td>
<td>STU</td>
<td>PRS, STU, ST2, TNC, ST3E, ST3, SMC, ST4, DUS, RES</td>
</tr>
<tr>
<td>NODE.timing.bits-1.AISThreshold</td>
<td>SMC</td>
<td>PRS, STU, ST2, TNC, ST3E, ST3, SMC, ST4, DUS, RES</td>
</tr>
</tbody>
</table>
| NODE.timing.bits-1.Coding                          | B8ZS          | • B8ZS, AMI when FacilityType is DS1  
• AMI when FacilityType is 64kHz+8kHz |
## Table D-11   Node Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| NODE.timing.bits-1.CodingOut | B8ZS          | • B8ZS, AMI when FacilityType is DS1  
|                            |               | • AMI when FacilityType is 6MHz                                                  |
| NODE.timing.bits-1.FacilityType | DS1          | DS1, 64kHz+8kHz                                                                |
| NODE.timing.bits-1.Framing   | ESF           | • ESF, D4 when FacilityType is DS1  
|                            |               | • N/A when FacilityType is 64kHz+8kHz                                            |
| NODE.timing.bits-1.FramingOut | ESF           | • ESF, D4 when FacilityTypeOut is DS1  
|                            |               | • N/A when FacilityTypeOut is 6MHz                                               |
| NODE.timing.bits-1.LBO       | 0-133         | 0-133, 134-266, 267-399, 400-533, 534-655                                      |
| NODE.timing.bits-1.State     | IS            | IS, OOS, DSBLD                                                                  |
| NODE.timing.bits-1.StateOut  | IS            | IS, OOS, DSBLD                                                                  |
| NODE.timing.bits-2.AdminSSMI  | STU           | PRS, STU, ST2, TNC, ST3E, ST3, SMC, ST4, DUS, RES                              |
| NODE.timing.bits-2.AISThreshold | SMC         | PRS, STU, ST2, TNC, ST3E, ST3, SMC, ST4, DUS, RES                              |
| NODE.timing.bits-2.Coding     | B8ZS          | • B8ZS, AMI when FacilityType is DS1  
|                            |               | • AMI when FacilityType is 64kHz+8kHz                                            |
| NODE.timing.bits-2.CodingOut  | B8ZS          | • B8ZS, AMI when FacilityTypeOut is DS1  
|                            |               | • AMI when FacilityTypeOut is 6MHz                                               |
| NODE.timing.bits-2.FacilityType | DS1          | DS1, 64kHz+8kHz                                                                |
| NODE.timing.bits-2.Framing    | ESF           | • ESF, D4 when FacilityType is DS1  
|                            |               | • N/A when FacilityType is 64kHz+8kHz                                            |
| NODE.timing.bits-2.FramingOut | ESF           | • ESF, D4 when FacilityTypeOut is DS1  
|                            |               | • N/A when FacilityTypeOut is 6MHz                                               |
D.2.3 ANSI CTC Default Settings

Table D-11  Node Default Settings (ANSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.timing.bits-2.LBO</td>
<td>0-133</td>
<td>0-133, 134-266, 267-399, 400-533, 534-655</td>
</tr>
<tr>
<td>NODE.timing.bits-2.State</td>
<td>IS</td>
<td>IS, OOS, DSBLD</td>
</tr>
<tr>
<td>NODE.timing.bits-2.StateOut</td>
<td>IS</td>
<td>IS, OOS, DSBLD</td>
</tr>
<tr>
<td>NODE.timing.general.Mode</td>
<td>External</td>
<td>External, Line, Mixed</td>
</tr>
</tbody>
</table>
| NODE.timing.general.QualityOfRES | RES=DUS           | • PRS<RES, STU<RES<PRS, ST2<RES<STU, ST3<RES<ST2, SMC<RES<ST3, ST4<RES<SMC, RES<ST4, RES=DUS when SSMMessageSet is Generation 1  
• PRS<RES, STU<RES<PRS, ST2<RES<STU, TNC<RES<ST2, ST3E<RES<TNC, ST3<RES<ST3E, SMC<RES<ST3, ST4<RES<SMC, RES<ST4, RES=DUS when SSMMessageSet is Generation 2 |
| NODE.timing.general.ReversionTime | 5.0 (minutes)   | 0.5, 1.0, 1.5 .. 12.0                               |
| NODE.timing.general.Revertive | FALSE              | TRUE, FALSE                                         |
| NODE.timing.general.SSMMessageSet | Generation 1         | Generation 1, Generation 2                          |

D.2.3 ANSI CTC Default Settings

Table D-12  CTC default settings (ANSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTC.circuits.AutoRoute</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>CTC.circuits.CreateLikeTL1</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>CTC.network.Map</td>
<td>United States</td>
<td>-none-, Germany, Japan, Netherlands, South Korea, United Kingdom, United States</td>
</tr>
</tbody>
</table>
D.3 ETSI Platform Defaults

The following sections give the NE defaults for the 15454 ETSI platform. To see defaults for the 15454 ANSI platform, see the “D.2 ANSI Platform Defaults” section on page D-2.

D.3.1 ETSI Card Default Settings

The tables in this section list the default settings for each DWDM, TXP, and MXP card. For all other cards, including optical, electrical, Ethernet, and Fibre Channel, refer to the Cisco ONS 15454 SDH Reference Manual.

Cisco provides user-configurable defaults for the Cisco ONS 15454 cards, including:

- **Soak Time**—*All cards*. The length of time that elapses between an AINS port receiving a valid signal and when it automatically changes to in-service status.
- **Port State** (config state)—*All cards*. Sets the port to one of the five available administrative states (unlocked; locked,disabled; locked,maintenance; unlocked,automaticInService), depending on whether you need ports in or out of service.
- **SF BER Level**—*TXP and MXP cards*. Defines the signal fail bit error rate.
- **SD BER Level**—*TXP and MXP cards*. Defines the signal degrade bit error rate.
- **Enable Sync Messages**—*MXP cards*. Enables synchronization status messages (S1 byte), which allow the node to choose the best timing source.
- **Send Do Not Use**—*TXP and MXP cards*. Sends a DUS message on the S1 byte when enabled.
- **Payload Type**—*TXP and MXP cards*. Defines the type of client signal.
- **Termination Mode**—*TXP and MXP cards*. Defines the type of termination (line, section, or transparent).
- **ALS Mode**—*TXP and MXP cards*. Sets the automatic laser shutdown feature to one of four available states (disabled, auto restart, manual restart, manual restart for test).
- **ALS Recovery Interval**—*TXP and MXP cards*. Sets the automatic laser shutdown recovery time interval.
- **ALS Recovery Pulse Width**—*TXP and MXP cards*. Sets the automatic laser shutdown recovery pulse signal width.
- **FEC**—*TXP and MXP cards*. Enables or disables the FEC monitoring on the optical transport network.
- **G.709 OTN**—*TXP and MXP cards*. Enables or disables the ITU-T G.709 monitoring on the optical transport network.
- **FEC Thresholds**—*TXP and MXP cards*. Set the performance monitoring parameters for gathering FEC performance data and detecting problems early.
- **Optical Thresholds**—*TXP and MXP cards*. Set the performance monitoring parameters for gathering physical optics performance data and detecting problems early.
- **OTN Thresholds**—*TXP and MXP cards*. Set the performance monitoring parameters for gathering OTN trunk-side performance data and detecting problems early.
- **PM Threshold settings**—*All cards*. Set the performance monitoring parameters for gathering performance data and detecting problems early.
### D.3.1 ETSI Card Default Settings

**Note**
For more information about each individual card setting, see Chapter 11, “Change DWDM Card Settings.”

**Note**
For more information about the performance monitoring parameters, see the Chapter 9, “Monitor Performance.”

#### D.3.1.1 MXP_2.5G_10G Card Default Settings

Table D-13 lists the MXP_2.5G_10G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.ppmPortAssignment</td>
<td>STM16_PORT</td>
<td>UNASSIGNED, STM16_PORT</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.SyncMsgIn</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.client.TerminationMode</td>
<td>Transparent</td>
<td>Transparent, Multiplex Section</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>Default Name</td>
<td>Default Value</td>
<td>Default Domain</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>MXP-2_5G-10G.config.trunk.AlRcvyPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.AlRcvyPulseInterval</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.AlRcvyPulseInterval</td>
<td>8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.AlRcvyPulseInterval</td>
<td>4.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.AlRcvyPulseInterval</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
### D.3.1 ETSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>3.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>3.7 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.3 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400</td>
<td>0–849657600</td>
</tr>
</tbody>
</table>
### Table D-13 MXP_2.5G_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>500 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>500 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
| MXP-2_5G-10G.otn.otnLines.FEC | Standard | • Disable, Standard, Enhanced when G709OTN is Enable  
• Disable when G709OTN is Disable |
| MXP-2_5G-10G.otn.otnLines.G709OTN | Enable | Disable, Enable |
| MXP-2_5G-10G.otn.otnLines.SDBER | 1E-7 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
### D.3.1 ETSI Card Default Settings

Table D-13  **MXP_2.5G_10G Card Default Settings (ETSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–22231200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.client.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-13  MXP_2.5G_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.EB</td>
<td>1000000 (count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10G.pmthresholds.trunk.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### D.3.1.2 MXP_2.5G_10E Card Default Settings

Table D-14 lists the MXP_2.5G_10E card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AisSquelchMode</td>
<td>Squelch</td>
<td>Ais, Squelch</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AlsRecoveryPulseDuration</td>
<td>2.0 (seconds)</td>
<td>2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>100–2000</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.ppmPortAssignment</td>
<td>STM16_PORT</td>
<td>UNASSIGNED, STM16_PORT</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.SyncMsgIn</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.client.TerminationMode</td>
<td>Transparent</td>
<td>Transparent, Regeneration Section</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.trunk.AlsRecoveryPulseDuration</td>
<td>100.0 (seconds)</td>
<td>60.0, 60.1, 60.2 .. 200.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-2_5G-10E.config.trunk.AlsRecoveryPulseInterval</td>
<td>300 (seconds)</td>
<td>200–2000</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>-21.0, -20.9, -20.8 .. 30.0</td>
</tr>
<tr>
<td>Default Name</td>
<td>Default Value</td>
<td>Default Domain</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>-8.0, -7.9, -7.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 3.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 3.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>-20.0, -19.9, -19.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>-7.0, -6.9, -6.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>-20.5, -20.4, -20.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>-7.5, -7.4, -7.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>8.0 (dBm)</td>
<td>-25.0, -24.9, -24.8 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>1.0 (dBm)</td>
<td>1.0, 1.1, 1.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>1.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>7.0 (dBm)</td>
<td>-24.5, -24.4, -24.3 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.5</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>-24.7, -24.6, -24.5 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.3</td>
</tr>
<tr>
<td>MXP-2_5G-10E.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
</tbody>
</table>
### Table D-14  MXP_2.5G_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>8504000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>8504000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-14  MXP_2.5G_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>100000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.AsynchSynchMapping</td>
<td>ODU Multiplex</td>
<td>ODU Multiplex</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.FEC</td>
<td>Standard</td>
<td>Disable, Standard, Enhanced</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>MXP-2_5G-10E.otn.otnLines.SDBER</td>
<td>1E-7, 1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
<td></td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
## Table D-14  MXP_2.5G_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.EB</td>
<td>4 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.EB</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-2_5G-10E.pmthresholds.client.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### D.3.1.3 MXP_MR_2.5G Card Default Settings

Table D-15 lists the MXP_MR_2.5G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, ONE_GE, FC1G ISL, FC2G ISL, FICON1G ISL, FICON2G ISL</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThreshold</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.AutoDetect</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.Enabled</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.NumCredits</td>
<td>32</td>
<td>2–256</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.distanceExtension.NumGFPPuffers</td>
<td>16</td>
<td>16, 32, 48 .. 1200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize</td>
<td>2148</td>
<td>2148, 2152, 2156, 2160, 2164, 2168, 2172</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
</tbody>
</table>
### Table D-15 MXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlSMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlSMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.SyncMsgIn</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseInterval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.config.trunk.AlSRecoveryPulseDuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
### Table D-15  MXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.EB</td>
<td>212600 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### D.3.1 ETSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.3.1.4 MXPP_MR_2.5G Card Default Settings

Table D-16 lists the MXPP_MR_2.5G card default settings.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.config.client.AlRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlMode is Manual Restart, Manual Restart for Test</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.client.AlRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
</tbody>
</table>
### Table D-16  MXPP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>ONE_GE, FC1G ISL, FC2G ISL, FICON1G ISL, FICON2G ISL</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>PPM (1 Port)</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.AutoadjustGFPBufferThreshold</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.AutoDetect</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.Enabled</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.NumCredits</td>
<td>32</td>
<td>2–256</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.distanceExtension.NumGFPBuffers</td>
<td>16</td>
<td>16, 32, 48 .. 1200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.fc.enhancedFibreChannelFicon.MaxFrameSize</td>
<td>2148</td>
<td>2148, 2152, 2156, 2160, 2164, 2168, 2172</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AINSSoakTime</td>
<td>08:00</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 whenAlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>60–300</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.config.trunk.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>3.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
Table D-16  MXPP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>30.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>-40.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
</tbody>
</table>
Table D-16  MXPP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.EB</td>
<td>1000000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>MXPP-MR-2_5G.pmthresholds.trunk.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### D.3.1.5 TXP_MR_10E Card Default Settings

Table D-17 lists the TXP_MR_10E card default settings.

**Table D-17**  
**TXP_MR_10E Card Default Settings (ETSI)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.config.client.AINSSoakTime</td>
<td>08:00</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.AisSquelchMode</td>
<td>Squelch</td>
<td>Ais, Squelch</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.AlsRecoveryPulseDuration</td>
<td>2.0 (seconds)</td>
<td>• 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>100–2000</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.ppmPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, SDH, 10G Ethernet, 10G Fiber Channel</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SendDoNotUse</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.SyncMsgIn</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>TXP-MR-10E.config.client.TerminationMode</td>
<td>Transparent</td>
<td>• Transparent, Regeneration Section, Multiplex Section when ppmPortAssignment is UNASSIGNED, SONET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transparent when ppmPortAssignment is 10G Ethernet, 10G Fiber Channel</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.AINSSoakTime</td>
<td>08:00</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.AlsRecoveryPulseDuration</td>
<td>100.0 (seconds)</td>
<td>• 6.0, 6.1, 6.2 .. 200.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>Default Name</td>
<td>Default Value</td>
<td>Default Domain</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10E.config.trunk.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>-17.0, -16.9, -16.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>-9.0, -8.9, -8.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.LowRxPower</td>
<td>-17.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.alarm.LowTxPower</td>
<td>-9.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 2.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>1.0 (dBm)</td>
<td>-16.0, -15.9, -15.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>1.0 (dBm)</td>
<td>-8.0, -7.9, -7.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-16.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>1.5 (dBm)</td>
<td>-16.5, -16.4, -16.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>1.5 (dBm)</td>
<td>-8.5, -8.4, -8.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-16.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-8.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 1.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>-25.0, -24.9, -24.8 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>8.0 (dBm)</td>
<td>1.0, 1.1, 1.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -8.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>1.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 8.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>-24.5, -24.4, -24.3 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.5</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>-24.7, -24.6, -24.5 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>7.0 (dBm)</td>
<td>2.0, 2.1, 2.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. -7.3</td>
</tr>
<tr>
<td>TXP-MR-10E.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. 7.0</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0-9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0-4724697600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0-867227693875200</td>
</tr>
</tbody>
</table>
Table D-17  TXP_MR_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.enhanced.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>8504000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>8504000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.EB</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
| TXP-MR-10E.otn.otnLines.FEC                                                  | Standard            | • Disable, Standard, Enhanced when G709OTN is Enable  
                          |                    | • Disable when G709OTN is Disable |
| TXP-MR-10E.otn.otnLines.G709OTN                                              | Enable              | Disable, Enable      |
| TXP-MR-10E.otn.otnLines.SDBER                                                 | 1E-7                | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXP-MR-10E.pmthresholds.client.ms.farend.15min.BBE                           | 85040 (count)       | 0–8850600            |
| TXP-MR-10E.pmthresholds.client.ms.farend.15min.EB                            | 85040 (count)       | 0–8850600            |
| TXP-MR-10E.pmthresholds.client.ms.farend.15min.FC                            | 87 (seconds)        | 0–900                |
| TXP-MR-10E.pmthresholds.client.ms.farend.15min.SES                           | 1 (seconds)         | 0–900                |
| TXP-MR-10E.pmthresholds.client.ms.farend.15min.UAS                           | 3 (seconds)         | 0–900                |
| TXP-MR-10E.pmthresholds.client.ms.farend.1day.BBE                            | 850400 (count)      | 0–849657600          |
| TXP-MR-10E.pmthresholds.client.ms.farend.1day.EB                             | 850400 (count)      | 0–849657600          |
| TXP-MR-10E.pmthresholds.client.ms.farend.1day.EB                             | 864 (seconds)       | 0–86400              |
| TXP-MR-10E.pmthresholds.client.ms.farend.1day.SES                            | 4 (seconds)         | 0–86400              |
## D.3.1 ETSI Card Default Settings

### Table D-17 TXP_MR_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.farend.1.day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.1.day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.1.day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.1.day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.1.day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.ms.nearend.1.day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.1.day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.1.day.EB</td>
<td>10000 (count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.1.day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.1.day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.client.rs.nearend.1.day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.1.day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.1.day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.1.day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.1.day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-17  TXP_MR_10E Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.BBE</td>
<td>100000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.EB</td>
<td>100000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.BBE</td>
<td>10000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.EB</td>
<td>1000000 (count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10E.pmthresholds.trunk.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.3.1.6 TXP_MR_10G Card Default Settings

Table D-18 lists the TXP_MR_10G card default settings.

### Table D-18  TXP_MR_10G Card Default Settings (ETSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
</tbody>
</table>
### Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.config.client.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.AlsRecoveryPulseInterval</td>
<td>100 (seconds)</td>
<td>100–300</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.mrPortAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, SDH, 10G Ethernet</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10G.config.client.TerminationMode</td>
<td>Transparent</td>
<td>Transparent, Regeneration Section, Multiplex Section when mrPortAssignment is UNASSIGNED, SDH, 10G Ethernet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transparent when mrPortAssignment is 10G Ethernet</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.AlsRecoveryPulseDuration</td>
<td>4.0 (seconds)</td>
<td>2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td>80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SDBER</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>-17.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>-9.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.config.trunk.SFBER</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
</tbody>
</table>
### Table D-18 TXP_MR_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>1.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>1.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-16.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-8.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>1.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>1.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-16.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-8.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>90.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.HighTxPower</td>
<td>4.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>2.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighRxPower</td>
<td>-7.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.HighTxPower</td>
<td>3.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowRxPower</td>
<td>-24.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.15min.LowTxPower</td>
<td>2.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighRxPower</td>
<td>-7.3 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.HighTxPower</td>
<td>3.7 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
</tbody>
</table>
### Table D-18  TXP_MRI0G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowRxPower</td>
<td>-24.7 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.opticalthresholds.trunk.warning.1day.LowTxPower</td>
<td>2.3 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.15min.BitErrorsCorrected</td>
<td>903330 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.15min.UncorrectableWords</td>
<td>5 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.1day.BitErrorsCorrected</td>
<td>86719680 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.fecthresholds.standard.1day.UncorrectableWords</td>
<td>480 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
</tbody>
</table>
### Table D-18  TXP_MR_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.otnLines.FEC</td>
<td>Enable</td>
<td>• Disable, Enable when G709OTN is Enable</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.otnLines.G709OTN</td>
<td>Enable</td>
<td>• Disable when G709OTN is Disable</td>
</tr>
<tr>
<td>TXP-MR-10G.otp.otnLines.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Table D-18  TXP_MR_10G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.pmthresholds.client.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.client.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.BBE</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.EB</td>
<td>85040 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.BBE</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.EB</td>
<td>850400 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–7967700</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
Table D-18  
**TXP_MR_10G Card Default Settings (ETSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–764899200</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-10G.pmthresholds.trunk.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

**D.3.1.7 TXP_MR_2.5G Card Default Settings**

Table D-19 lists the TXP_MR_2.5G card default settings.

Table D-19  
**TXP_MR_2.5G Card Default Settings (ETSI)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
</tbody>
</table>
| TXP-MR-2_5G.config.client.AlsRecoveryPulseDuration | 40.0 (seconds) | • 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart  
• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXP-MR-2_5G.config.client.AlsRecoveryPulseInterval | 100 (seconds) | 60–300 |
| TXP-MR-2_5G.config.client.ppmPortAssignment | UNASSIGNED | UNASSIGNED, STM1_PORT, STM4_PORT, STM16_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |
| TXP-MR-2_5G.config.client.ppmSlotAssignment | UNASSIGNED | UNASSIGNED, PPM (1 Port) |
| TXP-MR-2_5G.config.client.SDBER | 1E-7 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXP-MR-2_5G.config.client.SFBER | 1E-4 | 1E-3, 1E-4, 1E-5 |
### D.3.1 ETSI Card Default Settings

**Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| TXP-MR-2_5G.config.client.TerminationMode | Transparent | - Transparent, Regeneration Section, Multiplex Section when ppmPortAssignment is UNASSIGNED, STM1_PORT, STM4_PORT, STM16_PORT  
- Transparent when ppmPortAssignment is STM1_PORT, STM4_PORT, STM16_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CL1_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |
| TXP-MR-2_5G.config.trunk.AINSSoakTime | 08:00 (hours:mins) 00:00, 00:15, 00:30 .. 48:00 |  
| TXP-MR-2_5G.config.trunk.AlsRecoveryPulseDuration | 40.0 (seconds) | - 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart  
- 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXP-MR-2_5G.config.trunk.AlsRecoveryPulseInterval | 100 (seconds) 60–300 |  
| TXP-MR-2_5G.config.trunk.SDBER | 1E-7 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |  
| TXP-MR-2_5G.config.trunk.SFBER | 1E-4 1E-3, 1E-4, 1E-5 |  
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias | 90.0 (%) 0.0, 0.1, 0.2 .. 100.0 |  
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower | 3.0 (dBm) LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0 |  
| TXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower | 3.0 (dBm) LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0 |  
| TXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower | -21.0 (dBm) -40.0, -39.9, -39.8 .. HighRxPower |
Table D-19  TXP_MG_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-15.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dB)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dB)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>95.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-7.5 (dB)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-7.3 (dB)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>96.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-24.5 (dB)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.BitErrorsCorrected</td>
<td>112500</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected</td>
<td>10800000</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
</tbody>
</table>
### Table D-19  
**TXP_MR_2.5G Card Default Settings (ETSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm1.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm1.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm1.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm1.1day.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm16.15min.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm16.15min.UncorrectableWords</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm16.1day.BitErrorsCorrected</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecthresholds.stm16.1day.UncorrectableWords</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>15012 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>1441152 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>225837 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>21680352 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
</tbody>
</table>
### Table D-19  TXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.fecThresholds.stm4.15min.BitErrorsCorrected</td>
<td>56457 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecThresholds.stm4.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecThresholds.stm4.1day.BitErrorsCorrected</td>
<td>5419872 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.fecThresholds.stm4.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
## D.3.1 ETSI Card Default Settings

### Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>1000000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.otnLines.FEC</td>
<td>Enable</td>
<td></td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>Disable, Enable when G709OTN is Enable, Disable when G709OTN is Disable</td>
</tr>
<tr>
<td>TXP-MR-2_5G.otn.otnLines.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-19  TXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms farend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms farend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_ms nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.1day.BBE</td>
<td>10000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.1day.EB</td>
<td>1000000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm1_rs nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
### Appendix D  Network Element Defaults

#### D.3.1 ETSI Card Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.EB</td>
<td>212600 (seconds)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-19 TXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.BBE</td>
<td>10000</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.EB</td>
<td>10000</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.ES</td>
<td>5000</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.SES</td>
<td>5000</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.UAS</td>
<td>10</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.BBE</td>
<td>5315</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.EB</td>
<td>5315</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.ES</td>
<td>87</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.SES</td>
<td>1</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.farend.15min.UAS</td>
<td>3</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.BBE</td>
<td>5315</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.EB</td>
<td>5315</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.ES</td>
<td>864</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.SES</td>
<td>4</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.UAS</td>
<td>10</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.BBE</td>
<td>5315</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.EB</td>
<td>5315</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.ES</td>
<td>864</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.SES</td>
<td>4</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.UAS</td>
<td>10</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.BBE</td>
<td>10000</td>
<td>0–553500</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.EB</td>
<td>10000</td>
<td>0–553500</td>
</tr>
</tbody>
</table>
### Table D-19  TXP_MR_2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.BBE</td>
<td>10000 (count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.3.1.8 TXPP_MR_2.5G Card Default Settings

Table D-20 lists the TXPP_MR_2.5G card default settings.

### Table D-20  TXPP-MR_2.5G Card Default Settings (ETSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXP-MR-2_5G.config.client.AINSSoakTime</td>
<td>08:00 (hours:mins)</td>
<td>00:00, 00:15, 00:30 .. 48:00</td>
</tr>
</tbody>
</table>
| TXP-MR-2_5G.config.client.AlsRecoveryPulseDuration                | 40.0 (seconds) | • 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart  
|                                                                 |               | • 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXP-MR-2_5G.config.client.AlsRecoveryPulseInterval                | 100 (seconds) | 60–300                                           |
| TXP-MR-2_5G.config.client.ppmPortAssignment                       | UNASSIGNED    | UNASSIGNED, STM1_PORT, STM4_PORT, STM16_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |
### Table D-20  TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2.5G.config.client.ppmSlotAssignment</td>
<td>UNASSIGNED</td>
<td>UNASSIGNED, PPM (1 Port)</td>
</tr>
<tr>
<td>TXPP-MR-2.5G.config.client.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXPP-MR-2.5G.config.client.SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
</tbody>
</table>
| TXPP-MR-2.5G.config.client.TerminationMode | Transparent | • Transparent, Regeneration Section, Multiplex Section when ppmPortAssignment is UNASSIGNED, STM1_PORT, STM4_PORT, STM16_PORT
• Transparent when ppmPortAssignment is STM1_PORT, STM4_PORT, STM16_PORT, ONE_GE_PORT, ESCON_PORT, DV6000_PORT, SDI_D1_VIDEO_PORT, HDTV_PORT, PASS_THRU_PORT, ETR_CLO_PORT, ISC compat, FC1G_PORT, FC2G_PORT, FICON1G_PORT, FICON2G_PORT, ISC peer |

| TXPP-MR-2.5G.config.trunk.AINSSoakTime | 08:00 (hours:mins) | 00:00, 00:15, 00:30 .. 48:00 |
| TXPP-MR-2.5G.config.trunk.AlsRecoveryPulseDuration | 40.0 (seconds) | 2.0, 2.1, 2.2 .. 100.0 when AlsMode is Disabled, Auto Restart, Manual Restart
• 80.0, 80.1, 80.2 .. 100.0 when AlsMode is Manual Restart for Test |
| TXPP-MR-2.5G.config.trunk.AlsRecoveryPulseInterval | 100 (seconds) | 60–300 |
| TXPP-MR-2.5G.config.trunk.SDBER | 1E-7 | 1E-5, 1E-6, 1E-7, 1E-8, 1E-9 |
| TXPP-MR-2.5G.config.trunk.SFBER | 1E-4 | 1E-3, 1E-4, 1E-5 |
| TXPP-MR-2.5G.opticalthresholds.client.alarm.HighLaserBias | 90.0 (%) | 0.0, 0.1, 0.2 .. 100.0 |
| TXPP-MR-2.5G.opticalthresholds.client.alarm.HighRxPower | 3.0 (dBm) | LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0 |
## Table D-20 TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.HighTxPower</td>
<td>3.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.LowRxPower</td>
<td>-21.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.alarm.LowTxPower</td>
<td>-15.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighLaserBias</td>
<td>81.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighRxPower</td>
<td>2.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.HighTxPower</td>
<td>2.0 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowRxPower</td>
<td>-20.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.15min.LowTxPower</td>
<td>-7.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighLaserBias</td>
<td>85.5 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighRxPower</td>
<td>2.5 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.HighTxPower</td>
<td>2.5 (dBm)</td>
<td>LowTxPower, LowTxPower + 0.1, LowTxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowRxPower</td>
<td>-20.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.client.warning.1day.LowTxPower</td>
<td>-7.5 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighTxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighLaserBias</td>
<td>98.0 (%)</td>
<td>0.0, 0.1, 0.2 .. 100.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.HighRxPower</td>
<td>-8.0 (dBm)</td>
<td>LowRxPower, LowRxPower + 0.1, LowRxPower + 0.2 .. 30.0</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowRxPower</td>
<td>-25.0 (dBm)</td>
<td>-40.0, -39.9, -39.8 .. HighRxPower</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.LowTxPower</td>
<td>-112500 (count)</td>
<td>0-9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.opticalthresholds.trunk.alarm.15min.BitErrorsCorrected</td>
<td>112500 (count)</td>
<td>0-9033621811200</td>
</tr>
</tbody>
</table>
### Table D-20 TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.BitErrorsCorrected</td>
<td>10800000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gethernet.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.BitErrorsCorrected</td>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gfiberchannel.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.BitErrorsCorrected</td>
<td>90000 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.BitErrorsCorrected</td>
<td>8640000 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.1gficon.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gfiberchannel.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.BitErrorsCorrected</td>
<td>180900 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.BitErrorsCorrected</td>
<td>17366400 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.2gficon.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm1.15min.BitErrorsCorrected</td>
<td>15012 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm1.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm1.1day.BitErrorsCorrected</td>
<td>1441152 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm1.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm16.15min.BitErrorsCorrected</td>
<td>225837 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm16.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
</tbody>
</table>
### Table D-20  TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm16.1day.BitErrorsCorrected</td>
<td>21680352 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm16.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm4.15min.BitErrorsCorrected</td>
<td>56457 (count)</td>
<td>0–9033621811200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm4.15min.UncorrectableWords</td>
<td>1 (count)</td>
<td>0–4724697600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm4.1day.BitErrorsCorrected</td>
<td>5419872 (count)</td>
<td>0–867227693875200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.fecthresholds.stm4.1day.UncorrectableWords</td>
<td>96 (count)</td>
<td>0–453570969600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.pm.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
</tbody>
</table>
### Table D-20  TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.farend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–8850600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.FC</td>
<td>10 (count)</td>
<td>0–72</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–849657600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.FC</td>
<td>40 (count)</td>
<td>0–6912</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.g709thresholds.sm.nearend.1day.UAS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.FEC</td>
<td>Enable</td>
<td></td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.G709OTN</td>
<td>Enable</td>
<td>Disable, Enable</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.otn.otnLines.SDBER</td>
<td>1E-7</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
</tbody>
</table>
Table D-20     TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.BBE</td>
<td>5000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.EB</td>
<td>10000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm1.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.BBE</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.ES</td>
<td>212600 (seconds)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.SES</td>
<td>864 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.farend.1day.UAS</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.BBE</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.EB</td>
<td>21260 (count)</td>
<td>0–2212200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
## Table D-20  TXPP-MR-2.5G Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.BBE</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.EB</td>
<td>212600 (count)</td>
<td>0–212371200</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.ms.nearend.15min.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–2151900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.15min.UAS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.BBE</td>
<td>10000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–206582400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.15min.BBE</td>
<td>5315 (count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.15min.EB</td>
<td>5315 (count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.1day.BBE</td>
<td>53150 (count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.1day.EB</td>
<td>53150 (count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.1day.UAS</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm16.rs.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.BBE</td>
<td>5315 (count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.EB</td>
<td>5315 (count)</td>
<td>0–552600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.15min.UAS</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.BBE</td>
<td>53150 (count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.EB</td>
<td>53150 (count)</td>
<td>0–53049600</td>
</tr>
</tbody>
</table>
### Appendix D  Network Element Defaults

#### D.3.1 ETSI Card Default Settings

**Table D-21  lists the OSCM card default settings.**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.EB</td>
<td>53150 (count)</td>
<td>0–53049600</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–553500</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–553500</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.US</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–53136000</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.US</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>TXPP-MR-2_5G.pmthresholds.stm4.rs.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.3.1.9 OSCM Card Default Settings

**Table D-21 lists the OSCM card default settings.**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSCM.pmthresholds.ms.farend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.1day.US</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.15min.UAS</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
### Table D-21  OSCM Card Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSCM.pmthresholds.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.15min.SFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.15min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.1day.SFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSCM.pmthresholds.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>

### D.3.1.10 OSC-CSM Card Default Settings

Table D-22 lists the OSC-CSM card default settings.

### Table D-22  OSC-CSM Card Default Settings (ETSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.farend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.15min.BBE</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.15min.EB</td>
<td>1312 (count)</td>
<td>0–137700</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.15min.ES</td>
<td>87 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.15min.SES</td>
<td>1 (seconds)</td>
<td>0–900</td>
</tr>
</tbody>
</table>
Table D-23 on page D-107 lists the Cisco ONS 15454 node-level default settings for the ETSI shelf assembly. Cisco provides the following user-configurable defaults for each Cisco ONS 15454 node:

- **SNCP settings**—Set the threshold level for signal degradation and failure for subnetwork connection protection (SNCP) circuits.
- **Craft Access Only**—Allows CTC connectivity to the node only through the craft access port.
- **CTC IP Display Suppression**—Prevents display of node IP addresses in CTC (applicable for all users except Superusers).
- **Defaults Description**—Names the current defaults file on the node.
- **Enable Firewall**—Enables or disables the use of a firewall for accessing the node.
- **Enable Proxy**—Enables or disables the use of a proxy server with the node.
- **IIOP Listener Port**—Sets the IIOP listener port number.
- **LCD IP setting**—Sets the node LCD screen to display the node IP address and use the buttons on the LCD panel, only display the IP address, or suppress display of the IP address.
- **Login Warning Message**—Warns users at the login screen about the possible legal or contractual ramifications of accessing equipment, systems, or networks without authorization.
- **NTP SNTP Server**—Sets the IP address of the NTP SNTP server to be used with the node.
- **Time Zone**—Sets the time zone where the node is located.
- **Use DST**—Enables or disables the use of Daylight Savings Time.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.15min.UAS</td>
<td>3 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.1day.BBE</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.1day.EB</td>
<td>13120 (count)</td>
<td>0–13219200</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.1day.ES</td>
<td>864 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.1day.SES</td>
<td>4 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.ms.nearend.1day.UAS</td>
<td>10 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.15min.BBE</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.15min.EB</td>
<td>10000 (count)</td>
<td>0–138600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.15min.ES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.15min.SEFS</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1min.SES</td>
<td>500 (seconds)</td>
<td>0–900</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1day.BBE</td>
<td>100000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1day.EB</td>
<td>100000 (count)</td>
<td>0–13305600</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1day.ES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1day.SEFS</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
<tr>
<td>OSC_CSM.pmthresholds.rs.nearend.1day.SES</td>
<td>5000 (seconds)</td>
<td>0–86400</td>
</tr>
</tbody>
</table>
• Use NTP SNTP Server—Enables or disables the use of the specified NTP SNTP server with the node.

• Linear Multiplex Section Protection (LMSP) settings—Determine whether or not LMSP-protected circuits have bidirectional switching, are revertive, and what the reversion time is.

• MS-SPRing protection settings—Determine whether multiplex section-shared protection ring (MS-SPRing) protected circuits are revertive and what the reversion time is at both the ring and span levels.

• Y Cable Protection settings—Determine whether Y-cable protected circuits have bidirectional switching, are revertive, and what the reversion time is.

• Security Policy settings—Determine the allowable failed logins before lockout, idle user timeout for each user level, optional lockout duration or manual unlock enabled, password reuse and change frequency policies, number of characters difference between the old and new password, password aging by security level, enforced single concurrent session per user, and disable inactive user after a set inactivity period.

• BITS Timing settings—Determine the AIS threshold, coding, framing, State, State Out, and LBO settings for BITS1 and BITS2 timing.

• General Timing settings—Determine the mode (External, Line, or Mixed), quality of RES, revertive, reversion time, and SSM message set for node timing.

Note

For more information about each individual node setting, see Chapter 10, “Manage the Node.”

Table D-23  Node Default Settings (ETSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.circuits.sncp.HO_SDBER</td>
<td>1E-6</td>
<td>1E-5, 1E-6, 1E-7, 1E-8, 1E-9</td>
</tr>
<tr>
<td>NODE.circuits.sncp.HO_SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>NODE.circuits.sncp.LO_SDBER</td>
<td>1E-6</td>
<td>1E-5, 1E-6, 1E-7, 1E-8</td>
</tr>
<tr>
<td>NODE.circuits.sncp.LO_SFBER</td>
<td>1E-4</td>
<td>1E-3, 1E-4, 1E-5</td>
</tr>
<tr>
<td>NODE.circuits.sncp.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.circuits.sncp.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.circuits.State</td>
<td>unlocked, automaticInService</td>
<td>unlocked, locked, disabled, locked, maintenance, unlocked, automaticInService</td>
</tr>
<tr>
<td>NODE.general.DefaultsDescription</td>
<td>Factory Defaults</td>
<td>Free form field</td>
</tr>
<tr>
<td>NODE.general.NtpSntpServer</td>
<td>0.0.0.0</td>
<td>IP Address</td>
</tr>
<tr>
<td>NODE.general.TimeZone</td>
<td>(GMT-08:00) Pacific Time (US &amp; Canada), Tijuana</td>
<td>(For applicable time zones, see Table D-24 on page D-114.)</td>
</tr>
<tr>
<td>NODE.general.UseDST</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.network.general.AlarmMissingBackplaneLAN</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.network.general.CtlIpDisplaySuppression</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
</tbody>
</table>
## Appendix D  Network Element Defaults

### D.3.2 ETSI Node Default Settings

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.network.general.GatewaySettings</td>
<td>None</td>
<td>LeaveAsIs, None, ENE, GNE, ProxyOnlyNode</td>
</tr>
<tr>
<td>NODE.network.general.LcdIpSetting</td>
<td>Allow Configuration</td>
<td>Allow Configuration, Display Only, Suppress Display</td>
</tr>
<tr>
<td>NODE.osi.greTunnel.ctc.OspfCost</td>
<td>110</td>
<td>110, 120, 130 .. 65530</td>
</tr>
<tr>
<td>NODE.osi.greTunnel.ctc.SubnetMask</td>
<td>24 (bits)</td>
<td>8, 9, 10 .. 32</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.Mode</td>
<td>AITS</td>
<td>AITS, UITS</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.MTU</td>
<td>512</td>
<td>512, 513, 514 .. 1500</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.Role</td>
<td>Network</td>
<td>Network, User</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.T200</td>
<td>200 (ms)</td>
<td>200, 300, 400 .. 20000</td>
</tr>
<tr>
<td>NODE.osi.lapd.ctc.T203</td>
<td>10000 (ms)</td>
<td>4000, 4100, 4200 .. 120000</td>
</tr>
<tr>
<td>NODE.osi.mainSetup.L1L2LSPBufferSize</td>
<td>512 (bytes)</td>
<td>512–1500</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.DISPriority</td>
<td>63</td>
<td>1, 2, 3 .. 127</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.ESh</td>
<td>10 (sec)</td>
<td>10, 20, 30 .. 1000</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.GCCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.IIH</td>
<td>3 (sec)</td>
<td>1, 2, 3 .. 600</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.ISH</td>
<td>10 (sec)</td>
<td>10, 20, 30 .. 1000</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.LANISISCost</td>
<td>20</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.LDCCISISCost</td>
<td>40</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.OSCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODE.osi.subnet.ctc.SDCCISISCost</td>
<td>60</td>
<td>1, 2, 3 .. 63</td>
</tr>
<tr>
<td>NODE.osi.tarp.L1DataCache</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.L2DataCache</td>
<td>FALSE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.LANStormSuppression</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.LDB</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.LDBEntry</td>
<td>5 (min)</td>
<td>1–10</td>
</tr>
<tr>
<td>NODE.osi.tarp.LDBFlush</td>
<td>5 (sec)</td>
<td>0–1440</td>
</tr>
<tr>
<td>NODE.osi.tarp.PDUsL1Propagation</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.PDUsL2Propagation</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.PDUsOrigination</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.osi.tarp.T1Timer</td>
<td>15 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODE.osi.tarp.T2Timer</td>
<td>25 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODE.osi.tarp.T3Timer</td>
<td>40 (sec)</td>
<td>0–3600</td>
</tr>
</tbody>
</table>

Table D-23  Node Default Settings (ETSI) (continued)
## Table D-23  Node Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.osi.tarp.T4Timer</td>
<td>20 (sec)</td>
<td>0–3600</td>
</tr>
<tr>
<td>NODE.osi.tarp.Type4PDU Delay</td>
<td>0 (sec)</td>
<td>0–255</td>
</tr>
<tr>
<td>NODE.powerMonitor.EHIBATVG_48V</td>
<td>-56.5 (Vdc)</td>
<td>-40.5, -41.0, -41.5 .. -57.0</td>
</tr>
<tr>
<td>NODE.powerMonitor.EHIBATVG_60V</td>
<td>-72.0 (Vdc)</td>
<td>-50.0, -50.5, -51.0 .. -72.0</td>
</tr>
<tr>
<td>NODE.powerMonitor.ELWBATVG_48V</td>
<td>-40.5 (Vdc)</td>
<td>-40.5, -41.0, -41.5 .. -56.5</td>
</tr>
<tr>
<td>NODE.powerMonitor.ELWBATVG_60V</td>
<td>-50.0 (Vdc)</td>
<td>-50.0, -50.5, -51.0 .. -72.0</td>
</tr>
<tr>
<td>NODE.protection.Cisco ONS 15454.BidirectionalSwitching</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.lmsp.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.lmsp.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.msspr.RingReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.msspr.RingRevertive</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.msspr.SpanReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.msspr.SpanRevertive</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.splitter.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.splitter.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.protection.ycable.ReversionTime</td>
<td>5.0 (minutes)</td>
<td>0.5, 1.0, 1.5 .. 12.0</td>
</tr>
<tr>
<td>NODE.protection.ycable.Revertive</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.dataComm.ctc.DefaultTCCEthernetIP</td>
<td>10.0.0.1</td>
<td>IP Address</td>
</tr>
<tr>
<td>NODE.security.dataComm.ctc.DefaultTCCEthernetIPNetmask</td>
<td>24 (bits)</td>
<td>8, 9, 10 .. 32</td>
</tr>
<tr>
<td>NODE.security.dataComm.CtcBackplaneIpDisplaySuppression</td>
<td>(NOT SUPPORTED)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
<td></td>
</tr>
<tr>
<td>NODE.security.dataComm.isSecureModeSupportedOnControlCard</td>
<td>FALSE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.security.dataComm.LcdBackplaneIpSetting</td>
<td>(NOT SUPPORTED)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Allow Configuration, Display Only, Suppress Display when isSecureModeSupportedOnControlCard is TRUE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
<td></td>
</tr>
<tr>
<td>NODE.security.dataComm.SecureModeLocked</td>
<td>(NOT SUPPORTED)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE</td>
<td></td>
</tr>
</tbody>
</table>
**Table D-23 Node Default Settings (ETSI) (continued)**

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| NODE.security.dataComm.SecureModeOn (May reboot node) | (NOT SUPPORTED) | • FALSE, TRUE when isSecureModeSupportedOnControlCard is TRUE  
• (NOT SUPPORTED) when isSecureModeSupportedOnControlCard is FALSE |
| NODE.security.emsAccess.AccessState | NonSecure | NonSecure, Secure |
| NODE.security.emsAccess.IIOPListenerPort (May reboot node) | 57790 (port #) | 0–65535 |
| NODE.security.idleUserTimeout.Maintenance | 01:00 (hours:mins) | 00:00, 00:01, 00:02 .. 16:39 |
| NODE.security.idleUserTimeout.Provisioning | 00:30 (hours:mins) | 00:00, 00:01, 00:02 .. 16:39 |
| NODE.security.idleUserTimeout.Retrieve | 00:00 (hours:mins) | 00:00, 00:01, 00:02 .. 16:39 |
| NODE.security.idleUserTimeout.Superuser | 00:15 (hours:mins) | 00:00, 00:01, 00:02 .. 16:39 |
| NODE.security.lanAccess.LANAccess (May disconnect CTC from node) | Front & Backplane | No LAN Access, Front Only, Backplane Only, Front & Backplane |
| NODE.security.lanAccess.RestoreTimeout | 5 (minutes) | 0–60 |
| NODE.security.legalDisclaimer/LoginWarningMessage | <html><center><b>WARNING</b></center>
This system is restricted to authorized users for business purposes. Unauthorized access is a violation of the law. This service may be monitored for administrative and security reasons. By proceeding, you consent to this monitoring. | Free form field |
| NODE.security.other.DisableInactiveUser | FALSE | FALSE, TRUE |
### Table D-23  Node Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.security.other.InactiveDuration</td>
<td>45 (days)</td>
<td>• 1, 2, 3 .. 99 when DisableInactiveUser is TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 45 (and N/A) when DisableInactiveUser is FALSE</td>
</tr>
<tr>
<td>NODE.security.other.PMClearingPrivilege</td>
<td>Provisioning</td>
<td>Provisioning, Superuser</td>
</tr>
<tr>
<td>NODE.security.other.SingleSessionPerUser</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.passwordAging.EnforcePasswordAging</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.passwordAging.maintenance.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.maintenance.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.provisioning.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.provisioning.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.retrieve.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordAging.superuser.AgingPeriod</td>
<td>45 (days)</td>
<td>20–90</td>
</tr>
<tr>
<td>NODE.security.passwordAging.superuser.WarningPeriod</td>
<td>5 (days)</td>
<td>2–20</td>
</tr>
<tr>
<td>NODE.security.passwordChange.CannotChangeNewPassword</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.passwordChange.CannotChangeNewPasswordForNDays</td>
<td>20 (days)</td>
<td>20–95</td>
</tr>
<tr>
<td>NODE.security.passwordChange.NewPasswordMustDifferFromOldByNCharacters</td>
<td>1 (characters)</td>
<td>1–20</td>
</tr>
<tr>
<td>NODE.security.passwordChange.PreventReusingLastNPasswords</td>
<td>1 (times)</td>
<td>1–10</td>
</tr>
<tr>
<td>NODE.security.radiusServer.ctc.AccountingPort</td>
<td>1813 (port)</td>
<td>0–32767</td>
</tr>
<tr>
<td>NODE.security.radiusServer.ctc.AuthenticationPort</td>
<td>1812 (port)</td>
<td>0–32767</td>
</tr>
<tr>
<td>NODE.security.radiusServer.EnableNodeAsFinalAuthenticatorWhenAuthenticationEnabled</td>
<td>TRUE</td>
<td>FALSE, TRUE</td>
</tr>
<tr>
<td>NODE.security.serialCraftAccess.EnableCraftPort</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.shellAccess.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure, Secure</td>
</tr>
<tr>
<td>NODE.security.shellAccess.EnableShellPassword</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>NODE.security.shellAccess.TelnetPort</td>
<td>23</td>
<td>23–9999</td>
</tr>
<tr>
<td>NODE.security.snmpAccess.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure</td>
</tr>
<tr>
<td>NODE.security.tl1Access.AccessState</td>
<td>NonSecure</td>
<td>Disabled, NonSecure, Secure</td>
</tr>
<tr>
<td>NODE.security.userLockout.FailedLoginsAllowedBeforeLockout</td>
<td>5 (times)</td>
<td>0–10</td>
</tr>
<tr>
<td>NODE.security.userLockout.LockoutDuration</td>
<td>00:30</td>
<td>00:00, 00:05, 00:10 .. 10:00</td>
</tr>
<tr>
<td>NODE.security.userLockout.ManualUnlockBySuperuser</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
</tbody>
</table>
### Table D-23  Node Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE.timing.bits-1.AdminSSMIn</td>
<td>STU</td>
<td>G811, STU, G812T, G812L, SETS, DUS</td>
</tr>
<tr>
<td>NODE.timing.bits-1.AIThreshold</td>
<td>DUS</td>
<td>G811, STU, G812T, G812L, SETS, DUS</td>
</tr>
</tbody>
</table>
| NODE.timing.bits-1.Coding     | HDB3          | • HDB3, AMI when FacilityType is E1  
|                               |               | • N/A when FacilityType is 2MHz  
|                               |               | • AMI when FacilityType is 64kHz+8kHz |
| NODE.timing.bits-1.CodingOut  | HDB3          | • HDB3, AMI when FacilityTypeOut is E1  
|                               |               | • N/A when FacilityTypeOut is 2MHz  
|                               |               | • AMI when FacilityTypeOut is 6MHz |
| NODE.timing.bits-1.FacilityType| E1            | E1, 64kHz+8kHz, 2MHz |
| NODE.timing.bits-1.FacilityTypeOut| E1           | E1, 6MHz, 2MHz |
| NODE.timing.bits-1.Framing    | FAS+CAS+CRC   | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed when FacilityType is E1  
|                               |               | • N/A when FacilityType is 2MHz  
|                               |               | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed, Unframed–2Mhz when FacilityType is 64kHz+8kHz |
| NODE.timing.bits-1.FramingOut | FAS+CAS+CRC   | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed when FacilityTypeOut is E1  
|                               |               | • N/A when FacilityTypeOut is 2MHz  
|                               |               | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed, Unframed–2Mhz when FacilityTypeOut is 6MHz |
### Table D-23  Node Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| NODE.timing.bits-1.Sa bit     | 4             | • 4, 5, 6, 7, 8 when FacilityType is E1  
• N/A when FacilityType is 2MHz  
• N/A when FacilityType is 64kHz+8kHz |
| NODE.timing.bits-1.State      | unlocked      | unlocked, locked, disabled                                                       |
| NODE.timing.bits-1.StateOut   | unlocked      | unlocked, locked, disabled                                                       |
| NODE.timing.bits-2.AdminSSMIn | STU           | G811, STU, G812T, G812L, SETS, DUS                                              |
| NODE.timing.bits-2.AISThreshold | DUS          | G811, STU, G812T, G812L, SETS, DUS                                              |
| NODE.timing.bits-2.Coding     | HDB3          | • HDB3, AMI when FacilityType is E1  
• N/A when FacilityType is 2MHz  
• AMI when FacilityType is 64kHz+8kHz |
| NODE.timing.bits-2.CodingOut  | HDB3          | • HDB3, AMI when FacilityTypeOut is E1  
• N/A when FacilityTypeOut is 2MHz  
• AMI when FacilityTypeOut is 6MHz |
| NODE.timing.bits-2.FacilityType | E1           | E1, 64kHz+8kHz, 2MHz                                                            |
| NODE.timing.bits-2.FacilityTypeOut | E1           | E1, 6MHz, 2MHz                                                                  |
| NODE.timing.bits-2.Framing    | FAS+CAS+CRC   | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed when FacilityType is E1  
• N/A when FacilityType is 2MHz  
• FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed, Unframed–2Mhz when FacilityType is 64kHz+8kHz |
### Table D-23  Node Default Settings (ETSI) (continued)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
</table>
| NODE.timing.bits-2.FramingOut | FAS+CAS+CRC   | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed when FacilityTypeOut is E1  
|                               |               | • N/A when FacilityTypeOut is 2MHz                  
|                               |               | • FAS+CRC, FAS+CAS, FAS+CAS+CRC, FAS, Unframed, Unframed–2Mhz when FacilityTypeOut is 6MHz |
| NODE.timing.bits-2.Sa bit     | 4             | • 4, 5, 6, 7, 8 when FacilityType is E1               
|                               |               | • N/A when FacilityType is 2MHz                       
|                               |               | • N/A when FacilityType is 64kHz+8kHz                 |
| NODE.timing.bits-2.State      | unlocked      | unlocked, locked, disabled                          |
| NODE.timing.bits-2.StateOut   | unlocked      | unlocked, locked, disabled                          |
| NODE.timing.general.Mode      | External      | External, Line, Mixed                               |
| NODE.timing.general.ReversionTime | 5.0 (minutes) | 0.5, 1.0, 1.5 .. 12.0                                |
| NODE.timing.general.Revertive | FALSE         | TRUE, FALSE                                         |

### D.3.2.1 Time Zones

Table D-24 lists the time zones that apply for node time zone defaults. Time zones are expressed in terms of their relative relationships to Greenwich Mean Time (GMT).

### Table D-24  Time Zones (ANSI and ETSI)

<table>
<thead>
<tr>
<th>Time Zone (GMT +/- Hours)</th>
<th>Location(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT-11:00</td>
<td>Midway Islands, Samoa</td>
</tr>
<tr>
<td>GMT-10:00</td>
<td>Hawaiian Islands, Tahiti</td>
</tr>
<tr>
<td>GMT-09:00</td>
<td>Anchorage - Alaska</td>
</tr>
<tr>
<td>GMT-08:00</td>
<td>Pacific Time (US &amp; Canada), Tijuana</td>
</tr>
<tr>
<td>GMT-07:00</td>
<td>Mountain Time (US &amp; Canada)</td>
</tr>
<tr>
<td>GMT-07:00</td>
<td>Phoenix - Arizona</td>
</tr>
<tr>
<td>GMT-06:00</td>
<td>Central Time (US &amp; Canada)</td>
</tr>
<tr>
<td>GMT-06:00</td>
<td>Mexico City</td>
</tr>
<tr>
<td>GMT-06:00</td>
<td>Costa Rica, Managua, San Salvador</td>
</tr>
<tr>
<td>GMT-06:00</td>
<td>Saskatchewan, Manitoba</td>
</tr>
<tr>
<td>GMT-05:00</td>
<td>Bogota, Lima, Quito</td>
</tr>
</tbody>
</table>
### Table D-24  Time Zones (ANSI and ETSI) (continued)

<table>
<thead>
<tr>
<th>Time Zone (GMT +/- Hours)</th>
<th>Location(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT-05:00</td>
<td>Eastern Time (US &amp; Canada)</td>
</tr>
<tr>
<td>GMT-05:00</td>
<td>Havana</td>
</tr>
<tr>
<td>GMT-05:00</td>
<td>Indiana (US)</td>
</tr>
<tr>
<td>GMT-04:00</td>
<td>Asuncion</td>
</tr>
<tr>
<td>GMT-04:00</td>
<td>Caracas, La Paz, San Juan</td>
</tr>
<tr>
<td>GMT-04:00</td>
<td>Atlantic Time (Canada), Halifax, Saint John, Charlottetown</td>
</tr>
<tr>
<td>GMT-04:00</td>
<td>Santiago</td>
</tr>
<tr>
<td>GMT-04:00</td>
<td>Thule (Qaanaaq)</td>
</tr>
<tr>
<td>GMT-03:30</td>
<td>St. John’s - Newfoundland</td>
</tr>
<tr>
<td>GMT-03:00</td>
<td>Brasilia, Rio de Janeiro, Sao Paulo</td>
</tr>
<tr>
<td>GMT-03:00</td>
<td>Buenos Aires, Georgetown</td>
</tr>
<tr>
<td>GMT-03:00</td>
<td>Godthab (Nuuk) - Greenland</td>
</tr>
<tr>
<td>GMT-02:00</td>
<td>Mid-Atlantic</td>
</tr>
<tr>
<td>GMT-01:00</td>
<td>Azores, Scoresbysund</td>
</tr>
<tr>
<td>GMT-01:00</td>
<td>Praia - Cape Verde</td>
</tr>
<tr>
<td>GMT 00:00</td>
<td>Casablanca, Reykjavik, Monrovia</td>
</tr>
<tr>
<td>GMT</td>
<td>Greenwich Mean Time</td>
</tr>
<tr>
<td>GMT 00:00</td>
<td>Dublin, Edinburgh, London, Lisbon</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>Amsterdam, Berlin, Rome, Stockholm, Paris</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>Belgrade, Bratislava, Budapest, Ljubljana, Prague</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>Brussels, Copenhagen, Madrid, Vienna</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>Sarajevo, Skopje, Sofija, Vilnius, Warsaw, Zagreb</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>West Central Africa, Algiers, Lagos, Luanda</td>
</tr>
<tr>
<td>GMT+01:00</td>
<td>Windhoek (Namibia)</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Al Jizah, Alexandria, Cairo</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Amman</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Athens, Bucharest, Istanbul</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Beirut</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Cape Town, Harare, Johannesburg, Pretoria</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Jerusalem</td>
</tr>
<tr>
<td>GMT+02:00</td>
<td>Kaliningrad, Minsk</td>
</tr>
<tr>
<td>GMT+03:00</td>
<td>Aden, Antananarivo, Khartoum, Nairobi</td>
</tr>
<tr>
<td>GMT+03:00</td>
<td>Baghdad</td>
</tr>
<tr>
<td>GMT+03:00</td>
<td>Kuwait, Riyadh</td>
</tr>
<tr>
<td>GMT+03:00</td>
<td>Moscow, St. Petersburg, Novgorod</td>
</tr>
<tr>
<td>GMT+03:30</td>
<td>Tehran</td>
</tr>
</tbody>
</table>
### Table D-24  Time Zones (ANSI and ETSI) (continued)

<table>
<thead>
<tr>
<th>Time Zone (GMT +/- Hours)</th>
<th>Location(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT+04:00</td>
<td>Abu Dhabi, Mauritius, Muscat</td>
</tr>
<tr>
<td>GMT+04:00</td>
<td>Aqtau, Tbilisi</td>
</tr>
<tr>
<td>GMT+04:00</td>
<td>Baku</td>
</tr>
<tr>
<td>GMT+04:00</td>
<td>Yerevan, Samara</td>
</tr>
<tr>
<td>GMT+04:30</td>
<td>Kabul</td>
</tr>
<tr>
<td>GMT+05:00</td>
<td>Chelyabinsk, Prem, Yekaterinburg, Ufa</td>
</tr>
<tr>
<td>GMT+05:00</td>
<td>Islamabad, Karachi, Tashkent</td>
</tr>
<tr>
<td>GMT+05:30</td>
<td>Calcutta, Mumbai, New Delhi, Chennai</td>
</tr>
<tr>
<td>GMT+05:45</td>
<td>Kathmandu</td>
</tr>
<tr>
<td>GMT+06:00</td>
<td>Almaty</td>
</tr>
<tr>
<td>GMT+06:00</td>
<td>Colombo, Dhaka, Astana</td>
</tr>
<tr>
<td>GMT+06:00</td>
<td>Novosibirsk, Omsk</td>
</tr>
<tr>
<td>GMT+06:30</td>
<td>Cocos, Rangoon</td>
</tr>
<tr>
<td>GMT+07:00</td>
<td>Bangkok, Hanoi, Jakarta</td>
</tr>
<tr>
<td>GMT+07:00</td>
<td>Krasnoyarsk, Norilsk, Novokuznetsk</td>
</tr>
<tr>
<td>GMT+08:00</td>
<td>Irkutsk, Ulaan Batar</td>
</tr>
<tr>
<td>GMT+08:00</td>
<td>Beijing, Shanghai, Hong Kong, Urumqi</td>
</tr>
<tr>
<td>GMT+08:00</td>
<td>Perth</td>
</tr>
<tr>
<td>GMT+08:00</td>
<td>Singapore, Manila, Taipei, Kuala Lumpur</td>
</tr>
<tr>
<td>GMT+09:00</td>
<td>Chita, Yakutsk</td>
</tr>
<tr>
<td>GMT+09:00</td>
<td>Osaka, Sapporo, Tokyo</td>
</tr>
<tr>
<td>GMT+09:00</td>
<td>Palau, Pyongyang, Seoul</td>
</tr>
<tr>
<td>GMT+09:30</td>
<td>Adelaide, Broken Hill</td>
</tr>
<tr>
<td>GMT+09:30</td>
<td>Darwin</td>
</tr>
<tr>
<td>GMT+10:00</td>
<td>Brisbane, Port Moresby, Guam</td>
</tr>
<tr>
<td>GMT+10:00</td>
<td>Canberra, Melbourne, Sydney</td>
</tr>
<tr>
<td>GMT+10:00</td>
<td>Hobart</td>
</tr>
<tr>
<td>GMT+10:00</td>
<td>Khabarovsk, Vladivostok</td>
</tr>
<tr>
<td>GMT+10:30</td>
<td>Lord Howe Island</td>
</tr>
<tr>
<td>GMT+11:00</td>
<td>Honiara, Magadan, Soloman Islands</td>
</tr>
<tr>
<td>GMT+11:00</td>
<td>Noumea - New Caledonia</td>
</tr>
<tr>
<td>GMT+11:30</td>
<td>Kingston - Norfolk Island</td>
</tr>
<tr>
<td>GMT+12:00</td>
<td>Andyra, Kamchatka</td>
</tr>
<tr>
<td>GMT+12:00</td>
<td>Auckland, Wellington</td>
</tr>
<tr>
<td>GMT+12:00</td>
<td>Marshall Islands, Eniwetok</td>
</tr>
<tr>
<td>GMT+12:00</td>
<td>Suva - Fiji</td>
</tr>
</tbody>
</table>
Table D-24  Time Zones (ANSI and ETSI) (continued)

<table>
<thead>
<tr>
<th>Time Zone (GMT +/- Hours)</th>
<th>Location(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT+12:45</td>
<td>Chatham Island</td>
</tr>
<tr>
<td>GMT+13:00</td>
<td>Nuku'alofa - Tonga</td>
</tr>
<tr>
<td>GMT+13:00</td>
<td>Rawaki, Phoenix Islands</td>
</tr>
<tr>
<td>GMT+14:00</td>
<td>Line Islands, Kirimati - Kiribati</td>
</tr>
</tbody>
</table>

D.3.3 ETSI CTC Default Settings

Table D-25 lists the CTC-level default settings for the Cisco ONS 15454. Cisco provides the following user-configurable defaults for CTC.

- Create circuits with the Route Automatically check box selected by default.
- Create TL1-like circuits (instructs the node to create only cross-connects, allowing the resulting circuits to be in an upgradable state).
- Choose a default network map (which country).

Table D-25  CTC Default Settings (ETSI)

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
<th>Default Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTC.circuits.AutoRoute</td>
<td>TRUE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>CTC.circuits.CreateLikeTL1</td>
<td>FALSE</td>
<td>TRUE, FALSE</td>
</tr>
<tr>
<td>CTC.network.Map</td>
<td>United States</td>
<td>-none-, Germany, Japan, Netherlands, South Korea, United Kingdom, United States</td>
</tr>
</tbody>
</table>